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Introduction

Has it been a decade?
In January 1984, millions of viewers watched the Super Bowl. Among the
usual run of forgettable automobile and soft drink commercials, one commercial stood out from the pack. In fact, it changed the wo rld of personal computing as we know it today.
The comm ercial was shown only o ne time. It featured a woman wearing a
Macintosh T-shirt who proceeded to smash an im age that was m eant to depict the enem y, an IBM PC. Thus bega n the advertising campaign that introduced the Mac to an unsuspecting world. (It is ironic that Apple today works
hand-in-hand with IBM o n the PowerPC and other development projects.
How things have changed!)
The original product described in that commercial, the Macin tosh 128K,
seemed an unlikely product to start a worldwide revolution in the personal
computer industry. It housed the computer and a small black-and-white
screen in a single small case. On the surface it didn't look terribly impressive.
It had a single 3-1/2 inch disk drive, and no expansion slots of any kind-not
for additional memory, a hard drive, o r an additional monitor. At a suggested
list price of $2500, some people thought it was too expensive for what it
offered. Besides, aside from the software that was bundled with it, there
wasn't very much else ava ilable.
Many people were skeptical about the prospects for success of this odd little
product. Not only did it look differen t, but it worked di fferently.
Until the Macintosh, experienced computer users did their work by entering
commands in text form on their computer's keyboard. The task of learning
how to use such a computer was truly daunting to beginners. You had to take
special courses, or plough through long, thick, com plex manuals con tain ing
obscure terminology to figure out how to make your computer do what you
wa nted it to do.
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Com pared to these other computers, using the Macintosh was like traveling
to another universe. Its interface was presented to you in images. You did
your work on a desktop, and the software and files you worked with were
represented by icons, featuring fancy artwork that identified the kind of file
you were using. Instead of entering commands on your keyboard, you used a
little plastic pointing device called a mouse to transport a cursor across the
screen, and you clicked on one of the icons to activate a particular function,
such as opening up a program. When you wan ted to organize your files, you
put them in a folder, and when you wanted to get rid of the file, you tran sported (dragged) it to the icon of a trash can on your screen.
Instead of having to seek out listings of the commands needed to operate
your software, you clicked a white bar at the top of your screen to select the
label identifying the type of function you wanted to activate. A pull-down
menu displayed a list of commands to choose from .
To simplify matters, the manufacturer of this product, Apple Computer,
issued strong guidelines to software developers so that their products would
look and feel the same. That way, a novice user, h aving mastered the
essentials of pointing and clicking, could learn new software easily and
become productive in a shorter period of time.
Add itionally, Apple offered a host of opportunities for you to customize the
look of your desktop work area to your personal taste. for example, you could
choose to use icons or to display a directory of titles. This near-infin ite level
of opportunities to customize your work environment gave the computer a
warm, friendly feel, and offered folks who fea red technology an easy path to
learning this technological ma rvel.

The Early Days
It has been written elsewhere (and it's become akin to a modern folklore)

how Apple's engineers in 1979 visited Xerox's Palo Alto Research Center and
had a gander at a computer interface called Smalltalk, which was being used
on a prototype of a never-released product called the Alto. Small talk used
pop-up menus to activate command functions. You used that little plastic
device, called the mouse, to drag files across the screen.
Like all true creative artists, the folks at Apple picked up many ideas from this
unique new computer interface, incorporated ch anges and additions of their
own and, afte r a five year period of gestation, introduced the first Macintosh
compu ter.

The Sincerest Form of Flattery

The Macintosh revolution was slow in coming, and the computer didn't ring
up stratospheric sales overnight.
lt took a few years for "the little computer that could " to g row up. More

memory options were added, hard drives to store additional files became
available. Like the manufacturers of the rival DOS computers, Apple introduced modular Macintosh models with expansion slots. You could now add
video display adapters, network communication boards, and other options.
Color was part of the bargain, too. As software development mushroomed, all
sorts of categories of products became ava ilable on the Mac.

The Word Spreads
One of the firs t fields to embrace the Macintosh was the typesetting industry.
Up through the mid-1980s, a typesetting studio would produce the ir work o n
mini computers costing tens of tho usands of dollars. In order to make the
computers work, you had to enter lo ng chains of complex commands on a
keyboard and then check the results of your labors on a television screen that
consisted solely of text and text-based commands. While a skilled typographer could usually visualize the outcome of all these command line decisions, the true results of these labors were not known until the job was
printed with a photo imaging device. And sometimes things didn't look qu ite
the way they were supposed to look.
The Macintosh bro ught typesetting to the desktop. Instead of requiring
specially trained technicians to work on those high cost, hard-to-use mini
computers, you could do work of simi lar quality on a personal computer.
The Mac's screen would display the exact properties of the printed page befo re you printed a document, thus introd ucing the concept of what-you-seeis-wha t-you-get (or WYSIWYG, for short).
Slowly but surely, that strange looking desktop computer began to replace
those older expensive com position computers.
Yes, the Macintosh had truly arrived.

The Sincerest Form of Flattery
It didn't take long for the folks on the DOS side of the world to take n otice.
Windows and other graphical user interfaces (som etimes called GUI for short)
proliferated, thus legitimizing the Macintosh approach to personal computing as the right one.
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In fact, most personal computers you buy today, even though they are not
made by Apple Computer, use some sort of graphical interface and are
equipped wi th a mouse or pointing device of some sort. Many of the software
products you buy are offered in versions that will work o n a Mac or on a PC
running Windows.
The Macintosh has another important feature that has yet to be matched on
the PC side of the universe-th e concept of plug and play. With a Mac, you
attach a printer, and it's recognized by the computer immediately. If you
want to add memory or storage devices, it can be done within minutes, with
little fuss, and with little need to configure anything to get it all to work the
next time you switch everything on.

A More Complicated World
Long gone are the days when the number of software products you could buy
could be counted on the fingers of one hand, and where the variety of
Macintosh models offered could be accounted for in the same fashion.
Today, t housands of software options and many hundreds of hardware adde ns are available, allowing the Macintosh to perform a wide variety of tasks,
such as digital audio and video (including motion picture special effects);
billing, record-keeping, and schedul ing at a doctor's office; and generating
the pages for many of the most po pular books, magazines, and newspapers.
Whenever you want to buy a new computer, add a printer, or simply upgrade
the equipment you have, you are presented with a bewildering array of
choices-and you don't just choose the software and hardware add-ons.
Apple Computer has adva nced fro m introduci ng one or two models a year, to
as many as half a dozen or mo re every two or three mo nths. You have a
choice of ali-in-one Macs geared for the consumer and educational markets,
mod ular (expandable) Macs providing perform ance that rivals high-priced
computer workstation s, and a li ne of portable models that you can pack in a
small bag and take with you o n the road.
You can buy a new Maci ntosh at a computer reseller, a business supply supermarket, a consum er electronics sto re and even from a mail-order catalog.
So many decisions to make!
Using the Macintosh, Special Edition, is designed to help you cope with this

vastly mo re complicated world of personal computing. Que Publishing has
assembled a group of writers with the collective experi ence of many decades

How This Book Is Organized

in Mac computing to help you learn how to use your Macintosh more efficiently, select the right software with which to do the work you want to do,
and to make the right choices when it comes time to purchase your new
computer, printer, a hard drive and other accessories.
In order to keep you abreast of the newest developments in Macintosh computing, both from the hardware and software standpoint, we've had the
chance to take a first-hand, behind-the-scenes look at the newest developments from Apple Computer and the major software publishers.
We've also provided special coverage about Apple's newest line of PowerPC
computers, and we've even compared them with the fastest PC computers
that use Intel's Pentium chip. There's a preview of the newest version of the
Macintosh operating system, System 7.5, and a complete profile of some of
the newest versions of your favorite software products in the pages that follow.

Who Can Use This Book?
Using the Macintos/1 is designed for both the beginning Macintosh owner and
the experienced user.
This book helps you purchase the right hardware and the right software to
assemble a Macintosh system to do the work you want to do. When it comes
time to customize the look and fee l of your Mac to your own personal taste,
Usi11g tile Macintosh teaches you how. For any problems you encounter along
the way, this book contains scores of tips and tricks and helpful shortcuts to
help you get over the rough spots.
If you're already experienced at Mac computing, you'll find a wealth of new
information that goes fa r beyond what you' ll find in product brochures and
instruction manuals, information that will help make your computing experience more effective, more fun, and as trouble-free as possible.

How This Book Is Organized
We want this book to be easy and fun fo r you to read, so we've organized
Using The Maci11tosll into seven parts, each of which dea ls with a specific area
of Mac computing. You may want to read t his book from cover to cover. Or
you may want to look up specific topics you want to learn more about. This
book makes it easy for you to seek out those topics.
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Introduction
Part I, "About the Macintosh," discusses the Macintosh line, beginning with
the original128K back in 1984, and working up through the present Power
Macintosh models. In addition, this part of the book gives you a few hints
about what sort of models Apple is expected to introduce in the years to
come. An entire chapter is devoted to the interface that gives the Mac its
unique personality and easy-to-use quality.
l'art II, "System 7 Essentials," provides a comprehensive look at the
Macintosh operating system, the software that directs everything you do on
your computer. First, Chapter 4 reviews System 7.5, Apple's newest system
version, and later chapters explain the ins and outs of the Desktop and
Finder. This part of the book explains the simplified system software that
ships with Apple's consumer-oriented computer line, the Performa, and you
get advice on how to organize your files and disks. The other chapters cover
the most effective way to acquire and use fonts and explain how to share data
with other applications. These chapters probe deep into the Macintosh's
unique printing architecture and tell you what Apple has up its sleeve for the
future.
Part III, "Customizing Your Macintosh," tells you how to change the look of
your Mac's Desktop (for now, consider the Macintosh Desktop a blackboard
that you can wri te on and customize precisely to your taste). The chapters in
this part provide easy-to-master techniques for creating and customizing file
icons. The Mac's multimedia capabilities, which allow you to easily work
with music and sound on your computer, are also discussed.
If you' re a fan of the various Star Trek TV shows and motion pictures, no
doubt you're familiar with their ubiquitous talking computers that respond to
spoken commands. Well, Apple Computer has begun to add similar capabilities to some Macintosh models. Part IlJ tells you how you can talk to you r
Mac and h ave it talk back to you (after a fashion). And finally, all those
handy keyboard shortcuts that you can use to traverse your Mac's desktop
without ever touching your mouse are listed. You also learn a little about
how to use macros, which allow you to record a series of steps and then play
them back with keyboard commands.
Your Macintosh can't get any work done without softwa re, so Part IV contains a comprehensive review of hundreds of Mac software products. This
part of the chapter covers word processing, business graphics, spreadsheets,
da tabases, integrated software, desktop publishing, drawing and painting,
digital photography and desktop video, CD-ROM software, utilities, personal
and business management, games and education, and the very interesting

Technobabble?
software gems that are available as shareware. The chapters contain profiles of
the most popular Mac software products as well as our recommendations as
to which ones are best for you.
After you master your Mac and its software, you'll want to con sider joining
the information superhighway. In Part V, "Reaching Out," you learn how to
buy and set up a modem (a device that helps you telecommunicate with a
remote computer or online service). The most popular communications software is described. You tour the major online services-America Online,
CompuServe, and eWorld. You also take a brief tour of the largest online
service in the world, the Internet.
When you use your Macintosh in the workplace, you usually do not work in
isolation. You need to network your computer to other Macs, printers, and
computers running DOS and Windows. Part VI, "The Mac at Work," tells you
the most efficient ways to hook up your Macs to a network. This part of the
book explains such networking schemes as Loca!Talk and Ethernet. After
you're networked, you'll often need to exchange data with DOS and Windows computers, too. This part tells you how. When it comes time to take
your work on the road, you'll want to consider one of Apple's award-winning
PowerBook computers, which is described model by model. The chapters in
this part also offer techniques for staying in touch when you're on the road.
And if you are doing all or part of ypur work at home, you'll want to read the
suggestions for setting up your home office.
The Mac is essentially a trouble-free computer, but with so many installation
possibilities and thousands of sofu.yare products from which to choose, sometimes things just don't work as they should. Part VII, "Troubleshooting and
Preventive Maintenance," provides advice on how to solve common Mac
problems. You also get many tips on preventive maintenance so tha t you can
take steps to help prevent things from going wrong.

TechnQbabble?
It's inevitable that users of a personal computer will use words and phrases
that may seem strange to the novice. We've tried as much as possible to avoid
using terms that are difficult to understand. Where we must use these terms
to describe a particular function of your Mac, or the software it uses, we try to
define the terms. The end of this book contains a compreh ensive glossary so
that you can quickly learn the meaning of the words that may not seem familiar to you.

7
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Introduction
This book is written in a casual, conversational manner. We don't want you
to feel you are in a classroom environment when you read this book; we want
you to feel as if we are sitting across the room talking to you while you explore the many nooks and crannies of Macintosh computing. We are, all of
us, Mac users just like you. We've learned lots of new things about our computers in researching and writing this book, and we hope that Using the
Macintosh will be a source for you to learn more about your Mac. We want
you to learn how to make your Mac run most efficiently and use this knowledge as a jumping point to explore the tremendous creative potential of the
product that literally changed the world of computing.

Gene Steinberg
Scottsdale, Arizona
June, 1994
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Chapter 1

Macs of the Past
by William D. Harrell

This chapter examines the innovations and pitfalls of Apple's rise to greatness
through the development and manufacturing of the Mac. The chapter discusses the following topics:
• The pre-Macintosh Lisa, a bold experiment that set the stage for
Macintosh
• The first Mac, an ail-in-one unit intended to meet the needs of all users
• Developments by other companies that influenced decisions at Apple
• The desktop publishing explosion
• The influence of the Mac PowerBook on the world of notebook
computing

A Decade of Trend Setting
The Mac-the "computer with the smiling face"-began ten years ago as a
self-contained, all-in-ane machine. Since then, the Mac has changed the
personal computing world as well as the personality of computers.
Apple's two-pronged approach to computing-the self-contained unit (keyboard and monitor built-in) and fun, easy-to-use computers-contradicted all
conventional wisdom.
The Mac's graphical interface revolutionized the way we use our desktop.
In fact, it was the Macintosh's use of the desktop metaphor that inspired the
Windows revolution in the IBM-compatible world. Because of the cute little
box Apple called Macintosh, more people use computers, and we all have more
fun and endure less tedium doing so.
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Life Before the Mac
What set the Mac apart fro m other computers was the concept of a humance ntered computer, a machine that works the way people do. The Mac did
away with esoteric commands and dark screens. The hardware and softwa re
behind the tech nology were not new, however.
As ea rl y as 30 years before the Mac's debut, many computer companies experimen ted with graphical interfaces. Perhaps the most sig nifica nt forerunners were pre-personal computers experiments at Xerox's Palo Alto Research
Center. In fact, several accounts of Apple Computer's history and biograph ies
o f Steve j obs, one of the company founders, place him at the Palo Alto Research Center on more tha n one occasion before the development of the
Macintosh.
Apple's first attempt at the human-centered graphical interface was in 1983,
an all-in-one machine the com pany called Lisa. The Lisa was a gra nd experiment, but at $10,000 per unit, it had little chance to succeed.
The Lisa computer, shown in figure 1.1, introduced virtually every feature of
the Mac interface: the graphical user interface (G UI), use of the m ouse, the
desktop metaphor, pull-down menus, graphical dialog boxes and more. But
no t many Lisas were sold. Depending on you r po int of view, it was either an
expensive bomb or a bold experiment. Either way, Apple learn ed some ha rd
lessons from creating and ma nufac turing Lisa, and they used this knowledge
to develop the Macintosh.
Fig. 1.1
The Lisa computer
introduced
virtually every
feature of the Mac
interface.

The Original Mac
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The Original Mac
The original Mac had 128K of m emory. Compared to the IBM-PC's 512K, th is
was small indeed. But remember that most of the Mac's operating system
burned into the system's ROM, which mea nt that a good portion of the 128K
was not available for programs to use. Even by 1984's standards, however,
128K doesn't provide much room fo r program code to stretch out. Quickly
following the 128K came the 5 12K and, a bit later, the 5 12Ke. f-igure 1.2
shows the first Mac.
Fig. 1.2
The fi rst Mac had
128K of memory.
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The memory problem solved, the Mac-billed by Apple as the computer for
the rest of us-was ready to conquer the world. Still, Mac sales were dismal.
Apple soon discovered several other obstacles to overcome. For example, the
first Mac could not boot from a hard disk and lacked a port for connecting to
a hard drive. Apple expected users to connect hard drives through a modem
and start their Macs from a floppy.
Although the Mac made advancements, software vendors had not yet shown
a great deal of interest in the new platform. Few Macintosh programs were
available. To perform meaningful tasks with a computer, you need software,
right? You can't do much without it. Hence another reason Mac sales were so
bad. Without software, the Macintosh was little more than a cute, smiling
nightlight.
In the Meantime: 1983-1986
Today's Macintosh is unique, but it did not (and does not) exist in a vacuum. As
Apple developed and improved the Mac, IBM, Microsoft, NEC, and thousands of
other companies were developing and introducing technology that influenced the
entire computer industry, including the development of the Macintosh. The following list describes some of the significant events between 19B3 and 1986:

•

7983: IBM had sold over 1 million PCs. DOS machines were on the fast track
to becoming the desktop standard. Then Big Blue released the PCjr, a bomb
that proved to be the first loose thread in IBM's unraveling.

•

7983: Microsoft announced a graphical user interface called Windows that
was supposed to revolutionize the PC, making it easy for everybody to use.
Windows didn't ship for another three years, however, and its reception was
tepid. Bugs and a sluggish interface made Windows 1.0 almost unusable.

•

1984: Microsoft announced and released several programs for the Mac,
including Word, Multiplan, File, Chart, Basic, and many others. Vendors
began selling Macintosh software. In 1985, Microsoft released Excel for the
Mac, finally rounding out the platform's business application selection. Desktop publishing came of age that same year when Aldus released PageMaker
for the Mac.

•

1984: IBM released the PC AT, and Hewlett-Packard shipped the HP Laserjet.
Both products went on to become the IBM-compatible desktop standard.

•

1984: Philips announced a CD-ROM for PCs costing less than $1,000. Few
people knew it at the time, but several years later CD-ROM drives would
revolutionize desktop publishing and multimedia.

Desktop Publishing with the Macintosh

•

1984/ 1985: Drive makers developed and released the 3.5-inch floppy disk
drive, which Apple quickly adapted. Shortly thereafter, Sony introduced the
1.4MB disk drive, and about the same time, NEC brought out the fi rst
multisyncing monitor-all of which would greatly increase productivity and
enhance desktop publishing capabilities.

•

7986: Steve Jobs left Apple, and the Mac Plus with SCSI was introduced.
Compaq shipped the first 386 PC, virtually halting IBM's role as PC technology leader. Aldus and other companies announced the Tagged Image File
Format (TIFF), which went on to become the standard in bitmapped and
photograph graphics.

Up from the Ruins
By 1986, Apple had stockpiled a year's supply of Macintoshes. Sales were dead
and the future looked bleak. But fate and a series of o ngoing, lifesaving
events brought the Mac o ut of mo thballs. First, several ma jor software develo pers, including Lotus and Software Publishing, announced commitments to
write programs for the Macintosh, legitimizing the platform and finally providing business-oriented applications. Second, Apple released the Macintosh
Plus, with expandable memory and the SCSI bus, greatly increasing power
and peripheral expansion capabilities. Third, desktop publishing debuted
with the release of PageMaker, the LaserWriter, and other budding technologies.
Finally, the business world had a few good reasons to invest in Macs.

Desktop Publishing with the
Macintosh
More than any other technology, desktop publishing defined and legitimized
the Macintosh.
During the Mac's formative yea rs, IBM-compatible PCs were sell ing like mad.
These serious, arcane, dark-screened monsters were ideal for databases,
spreadsheets, and other unexciting applications. In order to survive, the Mac
had to find a niche.
Many of the major contributing factors making Mac the platform of choice
for page layout and graphics artist were developments by o ther companies,
such as Aldus and Adobe. But the Apple Macintosh provided the key ingredient: a WYSIWYG (what-you-see-is-what-you-get) graphical environment.
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Typography and PostScript
What set the Mac apart from other desktop machines was its graphical user
interface. Its screen rendered fonts much as they would appear when printed.
WYSIWYG had arrived. All that was needed now was a way to get what displayed on-screen onto paper.
The answer came a year after the Mac's debut, in the form of Apple's
LaserWriter printer. Utilizing a new printer language developed by Adobe,
called PostScript, the LaserWriter was the first relatively inexpensive ($6,995)
output device to provide a wide variety of typefaces and have the capability
to print a full page of graphics-at a rate of a whopping 300 dots per inch.
The LaserWriter was also th e first printer introduced with built-in RAM. The
first LaserWriter shipped with 1.5MB of RAM and 512K of ROM containing
PostScript. This large chunk of memory enabled the printer to process not
only pages containing the few fonts built into the printer but also to accept
softfont outlines sent from the computer. Outline fonts allowed for font rendering in virtually any point size. The DOS standard (the Laser]et), on the
other hand, used bitmapped fonts, which could render fonts o nly in fixed
sizes.
PostScript revolutionized publishing. New high-end typesetting equipment,
such as the Linotronic imagesetter, adopted PostScript, as d id most color
printers and 3Smm slide recorders. As a result of the Macintosh-PostScript
revolution, the way we get mass-produced printed material has completely
changed, and a whole new industry- prepress, or preparing documents for the
printing press-has sprung up. Service bureaus, high-tech shops full of fancy
output devices (such as imagesetters, high-resolution lase rs, thermal wax
color printers, dye-sublimation proofing printers, and slide recorders), support desktop publishers and designers around the world.

DTP for Everybody
The desktop publishing revolution was spurred on primari ly by powerful,
easy-to-use page layout programs, particularly Aldus PageMa ker. In those
days, desktop publishing consisted mostly of typesetting. You still couldn't
import images in to your layout, except by using th e most rudimentary clip
art, but the storage capacity of the Mac could not have accommodated large
graphics and photograph files anyway. PageMaker 1.0 was designed to run o n
the first 512K Mac with two floppy drives-one for the program and one for
your document.
Since then, PageMaker and other DTP programs (primarily QuarkX.Press) have
provided page layout to th e masses. Today you can accomplish layout designs
unheard of just a few years ago. Low-cost laser printers have enabled people

Desktop Publishing with the Macintosh
in all walks of life to produce professional-looking documents on their desktops. And the degree of sophistication is ever-increasing. Type and graphics
manipulation continually reach new heights, all the while becoming increasingly easier to master.

Beyond Words
In the early days of DTP, computers primarily set type. When graphics were
necessary, the designer left spaces in the layout and the print shop stripped
the images in. Scanners were not capable of high quality reproductions-only
161evels of gray and no color. Besides, the first Macs could not save and store
th e images, and the first Mac was too slow to render them. Then, in 1987, the
Mac II debuted, changing the face of desktop publishing.
The new Macs enabled users to view up to 256 levels of gray on the monitor,
and they supported larger hard drives, providing storage for large files. The
new Macs were also capable of displaying color. Before long, grayscale imageediting software began to emerge, as d id scanners capable of discerning up to
256 levels of gray. For a few thousand dollars-the price of a Mac, a laser
printer, and a copy of PageMaker-anybody could turn o ut grayscale, blackand-white, or spot-color flyers, newsletters, and broch ures from their desktop.

In Living Color
About the only area of pu blishing still in a critical maturing stage is the use of
photo-realistic color. Getting th e colo rs you see on your monitor to reproduce on a printing press is a tricky business. The technology has come a long
way but is expensive, and the process requ ires a great deal of skill and knowledge. It works reasonably well in the hands of experts but is still not ready for
prime time.
While the Mac II was capable of displaying color, it could handle only 8-bit
color, or 256 colors. Some companies, such as RasterOps, developed 24-bit
graphics NuBus cards, but they were incredibly slow. Photo-realistic colo r
wasn't really viable on the Mac until Apple developed 32-bit QuickDraw in
1989, which allowed graphics card makers to establish a 24-bit color standard
for displaying 16.7 million colors with reasonable speed. (QuickDmw is the
technology Macs use to render images for display on a monitor.) The 32-bit
QuickDraw standard opened the door to a flood of sophisticated graphics and
image editi ng software, as well as many QuickDraw accelerator NuBus cards.
As mentioned previously, the primary problem in color publishing today is
getting m onitor colors to match printed output. Companies such as Apple,
Electronics for Imaging, and Kodak have attempted to solve these discrepancies by introducing color management systems. Another key ingredient fo r
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color processing is hardware calibration products, such as Kodak's ColorSense. These technologies are still expen sive and soph isticated. The day when
practically anybody can prod uce full-color documents on his or her desktop
is on th e nea r horizon, however.

Other Significant Developments
With the release of the LaserWriter came the birth of Appl eTalk, the
Macintosh persona l network. Not only did AppleTalk co nnect Macs to printers, but it also connected Macs to other Macs, allowing companies with more
than one Maci ntosh to share fil es easily, however slowly. In the same year,
AppleLin k (Apple's electronic information service for Macs with modems)
went o n-line, providing Maci ntosh users with an easy way to exchange files,
use e-mail, and get support from Apple Computers.
During the developing yea rs of the Macintosh, Apple entered the modern
corporate world-the era of managers. The remaining cofounder, Steve jobs,
was replaced as CEO by j ohn Sculley, a former president of Pepsi-Co. Jobs,
who was slowly but surely edged o ut of the company altogether, went on to
form Nex t, Inc. Next made an attempt at marketing expensive Mac-like computers but has m et with limited success and acceptance.
It was also in 1987 when Apple introduced the \1ac Plus, the first Mac to

utilize the SCSI expansion in terface m en tio ned earlier. SCSI made adding disk
drives, removeables, and other input devices, such as scanners, easier. In fact,
SCSI was a revolutionary way to add devices to com puters. All users had to do
was connect, o r "chain," one device to another and, in som e cases, install an
!NIT in the System fol der. SCSI supports up to seven devices, which is much
more than most users would ever need. This techno logy was not fully develo ped, however, and complete expansion o ptions were no t realized unti l the
next generatio n of Macs.

Macintosh Comes of Age
Originally, the Mac was su pposed to com e standard with all anybody ever
needed to use it. Th is idea-that the Mac should be an ali-in-one appliancecame from the top at Apple and was made into dogm a by cofounder Steve
Jobs. By 1987, however, it was obvious that different applications required
specific hardware. Because creating a com puter that had all the hardware
every applicatio n req uired would render th e machine too expen sive, Apple
went the way of the DOS-based PC and opened up th e archi tecture to allow
m em ory upgrades, expansion slots, and hard d rives.

Macintosh Comes of Age
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The First Open Macs
The first open Macs were the Mac II and theSE. Both models had BOOK
floppy drives. (Subsequent models would sport the Mac SuperDrive, which,
with the righ t software, can read both Mac and PC disks.) The first SE was
built around the 68000 processor, and the Mac II had the 68020. Both models
were quickly upgraded to the 68030 processor. (The higher the processor
number, the faster the CPU.)
TheSE became the SE/30 and had only one expansion slot. It was also the
first Mac to be released with 68882 math coprocessor for math-intensive
applications, which made the SE about four times faster than the original SE.
The subsequent Mac lis later came out in several additional models, including
the llx and llcx. The Ilx was identica l to the II, except for the faster processor,
and the Ilcx came in a smaller case that had only three expansion slots.
f-igure 1.3 shows the Mac llcx.
Fig. 1 .3
The Mac llcx had
only three
expansion slots.

Before the Mac lis, App le discouraged third-party expansion of Macs. One of
th e more innovative features of the Mac II was the addition of NuBus technology, which, unlike DOS PCs, required no user configuratio n of jumpers or
switches. To add a video card o r other expansion device, all you did was plug
and play. With its new offering, Apple reversed its position , sa nctioning expansion. Finally, the company recognized its d ifferent kinds of customers
(corporate, small business, home, and so o n). This commitment to versatili ty
and expansion continued into the '90s with the introductio n of the LC and
the Mac Classic. Figure 1.4 shows the Mac LC.
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Fig. 1.4

The Mac LC was
versatile and
expandable.

The Fast Track
During period spanning 1990 to 1993, the pace of Macintosh techno logy
remained slow. Several applica tio n-specific models, such as the Macintosh
Portable, Macintosh llci, and tht:! first Powt:!rBuuks, were released, but most
models, such as the llci, had lo ng life spans-up to three years. PCs, on the
other hand, were constantly being upgraded, with new processors and
faster clock speeds being introduced all the time. In 1993, Apple jumped on
the bandwagon, releasing seven differen t computers based on the 68040
processor.
To accomplish this fast-track approach, Apple had to change its design approach. No longer could the Mac sport the cute, unique, hand-crafted appearance that jobs had insisted o n. In 1992 Apple bega n reusing o ne basic design
for several models. The Centris 650, Quadra 800, and Quadra 650, for example, are quite similar in design, as are the LC III, LC 520, Performa 475 and
550, and Quadra 605.
It was also during this period when Apple began to rely on o ther companies

to design and manufacture products and components. Sony, for example,
developed and manufactured the PowerBook 100; Sharp developed the Newton, and Logitech manufactures the PowerBook's built-in trackballs. This new
approach enabled Apple to deliver products to market in a more timely
fas hion.
Over the years, Apple has produced many Macs in vario us configurations.
Table 1.1 provides an exhaustive list of some of these m odels.

Macintosh Comes of Age

Table 1.1

Mac Models through December 1993
Maximum
RAM

PDS/
NuB us
Slots

Model

Processor

Clock
Speed

128K

68000

8

128K

0/0

512K

68000

8

512K

0/0

512Ke

68000

8

512K

0/0

Plus

68000

8

4MB

010

SE

68000

8

4MB

1/0

Portable

68000

16

l OMB

1/0

Classic

68000

8

5MB

010

Mac II

68020

16

8MB'

0/6

LC

68020

16

lOMB

1/0

SE/ 30

68030

16

128MB

1/0

llx

68030

16

128MB

0/6

llcx

68030

16

128MB

0/ 3

llcl/ llcx

68030

25/16

128MB

1/ 3

llvl/ llvx

68030

16/ 32

16MB

0/ 3

llfx

68030

40

128MB

1/6

lis I

68030

20

20MB

1 or 1

Classic II

68030

10

18MB

0

LC II

68030

10

12MB

1/0

Color Classic

68030

16

12MB

l /0

LC Ill

68030

25

36MB

1/0

LC475

68LC040

25

36MB

1/ 0

LC 520

68030

25

36MB

1 or 1
(continues)
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Table 1.1

Continued
Maximum
RAM

PDS/
NuBus
Slots

Model

Processor

Clock
Speed

Centrls 610

68040

20

68MB

1 or 1

Centris

68040

25

68MB

1 or 1

Quadra 605

68040

25

68MB

l /0

Quadra 610

68040

25

72MB

1/12

Quadra 650

68040

33

128MB

1/ 3

Quadra 700

68040

25

64MB

l /2

Quadra 800

68040

33

128MB

1/ 3

Quadra 840AV3

68040

40

128MB

0/ 3

Quadra 900

68040

25

256MB

1/ 5

Quadra 950

68040

33

256MB

1/5

Performa 200

68030

16

8MB

0/0

Performa 400,
405,410,430

68030

16

lOMB

1/0

Performa 450

60830

25

32MB

1/0

Performa 460,
466,467

68030

33

32MB

l /0

Performa 475,
4 76

68040

25

32MB

1/0

Performa 550

68030

33

32MB

1/0

Performa 600,
600CD

68030

33

16MB

1/ 3

1. Mac II can be upgraded to SuperDrive, which also includes upgrade to 512K ROM, allowing
you to use 4MB SIMMS, {or a total of 68MB RAM.
2. Requires adapter. You cm1 use only one or the other type slot. Tile Quadra 610 only has

room for a 7 PDS or 1 NuBus card.
3. Contains DSP chip {or accelerated sound and video. Tile A V comes ready to input and
output TV signals and fu ll-motion video.

Macintosh Comes of Age

The Mac Interface
In m any ways, the Mac interface hasn't changed much. Unli ke Windows, the
Mac system software still looks and feels about the same as it did on the Lisa.
By 1986, before the release of the Mac II, no sound was available and the
display was still black and white. Also missing were HyperCard, MultiFinder
and the use of hierarchical menus, 32-bit Q uickDraw for fast screen redraws,
and QuickTime for running full-motion video. Wh ile most of these components were available by System 6, it wasn't until System 7 that the Mac
reached its current level of maturity wi th the fina l add itio n of QuickTime.
As you read this book, Apple probably has already released System 7.5 and
is working on System 8. Be sure to read Chapter 2 for an overview of the
Macintosh of the future.

In the Meantime: 1987-1993
In six short years, the Macintosh went from innovation leader to performance lagger.
Advances in Intel's 80X86 technology had taken system performance far beyond that
of the cute, smiling computer. Macintoshes were relegated to niche applications,
such as high-end publishing, music composition, and film editing. Windows-based
PCs began to take over business desktops, replacing the DOS-prompt, which is what
Apple had hoped the Mac would do. Mac still had a loyal following, but speed advances, low prices, and graphical user interfaces in the IBM-compatible world caused
many Macintosh loyalists to jump ship. The following events shaped Apple and the
rest of the computer world:

•

1987: Radius introduced the first full-page m onitor-desktop publishing
got easier.

•

1987: The first active matrix LCD screens for portable computers were
introduced .

•

1987: Forethought released PowerPoint, a powerful, easy-to-use presentation
program. PowerPolnt has subsequently been taken over by Microsoft and
remains a leader in presentation software for Windows and the Mac.

•

•

1987: Aldus released PageMaker for Windows, creating the first chink in the
Mac's cornered DTP market.
1988: Adobe and Aldus shipped the first viable drawing programs: Illustrator
and FreeHand. The Mac became the first electronic graphics designer tool.

•

1988: Novell shipped the first version of NetWare for the Mac, making it
possible to network PC and Macintoshes, and provide faster data transfers
among M acs than possible through LocaiTalk.
(continues)
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(continued)

•

1989: The first 486 PC notebooks shipped, enabling users to take Windows on
the road. Windows was still a buggy, unstable mess that most PC users continued to avoid, however.

•

7989: Adobe released font secrets, opening up Type 1 font technology.
Microsoft and Apple already developed TrueType technology, however, which
they released in 1990, both subsequently incorporated as system fonts in
Windows 3.1 and System 7.

•

1989: Adobe released Adobe Type Manager (ATM), providing easy, nearly
foolproof Type 1 font handling for both the Mac and Windows.

•

1990: The other shoe dropped. Microsoft released Windows 3.0. The first
viable challenge to the Macintosh quality standard was unleashed, and a PC
software phenomenon was born.

•

1990: Adobe released Photoshop for Mac. The Macin tosh became the industry
standard for editing and processing photographs.

•

1991: Apple and IBM entered into an agreement to develop and adopt IBM's
PowerPC CPU and other significant new technologies, such as Apple's
OpenDoc. The future was at hand.

•

1991: Microsoft released Windows 3.1 . An explosion of PCs running Windows
occurred, and vendors began porting all their once-proprietary applications
from the Macintosh to Windows.

•

1992: Intel introduced the PCI local bus, a 64-bit 1/0 system. Most major
computer manufacturers, including Apple, agreed to support it.

•

1992: Apple, IBM, Compaq, and other vendors began a major push to provide
value-oriented systems to consumers through departmen t stores, discount
warehouses, and other nonconventional outlets. Apple's response was the
low-cost Performas.

•

•

1993: The first portable document software-Common Ground, Acrobat, and
Replica-were released.
1993: The first Pentiums were released. Intel reinforced its hold on performance and slashed chip prices in anticipation of the 1994 release of the
PowerPC.

Taking Mac on the Road
As people became dependent on computers, the need to take their data on
the road arose. As early as 1989, PC users had true notebook computers, complete with large screens and hard drives, available. But not Macintosh users.

Taking Mac on the Road

25

Apple's approach was the Macintosh Portable-a small, supposedly lightweight unit with a small moni tor (see fig. 1.5). By miniaturization and po rtabili ty standards, however, the Portable was large, heavy, and cum bersome.
The Macintosh Portable was a dismal failure.
Fig . 1 .5
The Macintosh
Portable was large,
heavy, and
cumbersome.

In the mean time, IBM-compatible colo r notebook sales soa red. In October
199 1, Apple released the first PowerBook, and Mac users were finally able to
take their work on the road (see fig. 1.6). The PowerBoo k was a trendsetter.
It was lightweight, had a built-in trackball, wrist rests for ergonomic advantages, and backlit screens capable o f displaying the graphical interface. The
PowerBook also sported the sophisticated power management feature that
debuted in th e Portable. Also important was the PowerBook's built-in support
of AppleTalk, which meant that users could easily connect their notebooks to
thei r home o ffice units or to their o ffice networks.
The PowerBook had a tremendous effect o n th e PC notebook market. Intel
soon released t he 386SL and 486SL CPUs, which incorporated power management, and Microsoft began to include power managemen t tools in DOS and
Windows. Vendors began to build trackballs into their units. Apple was
now not only competing for the desktop but also the laptop. By 1992, the
PowerBook led all other no tebooks in sales, even the popular IBM ThinkPad.
Notebook makers kept releasing new innovatio ns. They released colo r
displays, docking stations, subnotebooks, and several other enhancements.
Apple kept up, but fa iled to lead the innovations. Today's PowerBook is similar to other no tebooks, bu t it runs System 7. In 1993, IBM released the new
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ThinkPad with a radical new pointing device that wooed buyers away from
the PowerBook, and it looks as if Apple doesn't really have anything new
planned until the release of the Power PC PowerBooks in late 1994. As o f this
writing, the company is no t disclo sing an y of the PowerPC PowerBook's special features.

Fig. 1.6
W ith the

Powerbook 140,
u sers could easil y
take their Mac o n
the road.

Since introduction o f the Powe rBook, Apple has released several varieties of
PowerBooks, described in table 1.2.

Table 1.2 Macintosh PowerBooks as of December 1993
Model

Processor

Clock
Speed

Maximum
RAM

Screen
Type

100

68000

16

8MB

10 " backlit
supertwist

5.1 lb.

140

68030

16

6MB

10 " backlit
supertwist

6.8 1b.

145

68030

25

6MB

10" b acklit
supertwist

6.8 1b.

1458

68030

25

8MB

1 0" backlit
supertwist

6.81b.

160

68030

25

14MB

1 0" backlit
supertwist

6.81b.

Weight

From Here ...

Model

Processor

Clock
Speed

Maximum
RAM

Screen
Type

165

68030

33

14MB

10" backlit
supertwist

6.81b.

165c

68030

25

14MB

9" backlit
color passive
matrix

7.0 lb.

170

68030

25

8MB

10" backlit
active-matrix

6.81b.

180

68030

33

14MB

10" backlit
active-matrix

6.81b.

180c

68030

33

14MB

8.5" backl it
color activematrix

7.1 lb.

Weight

From Here ...
From here you may want to consider the next chapter covering the present
and future of the Mac, and the chapters on software. Chapters 16 through 28
cover different categories of software and discuss the leading products in each
to help you get better acquainted with various applications.
• Chapters 3, 4, and S cover the Mac's system software, including the
philosophy behind the Interface, System 7.5, and using the Finder.
ChapterS also shows you how to manage folders and fil es.
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MacPresent and
MacFuture
by William D. Harrell

During the past few years, Windows computers have sh ot past Macintoshes
in processing power. By the end of 1993, Intel's Pentium CPUs were runn ing
performance circles around the fastest Mac 68040-based Quadras and AVs.
Windows, which is strikingly similar to the Macintosh interface, not o nly ran
more than twice as fast o n fast PCs, but it also boasted more than 100 li mes
the available software packages.
To compete, Apple had to break the speed barrier imposed by the Motorola
CISC (complex instructio n set computers) 68000-processors used in conventional Macintoshes. No matter what Moto rola could have done to improve
the chip, the 68000's death knell had become loud and clear. In an attempt
to counterbalance th e Microsoft Windows on-slaught, Apple teamed up with
IBM to adapt the latter's RISC (red uced instructio n set computer) processor,
which has resul ted in the Power Macintosh.
The Power Mac is a powerful new computer that promises to out-run
anything based o n Intel's 80X86 or Pentium CISC-based machines includ ing
the Maci ntosh PowerPC. As I write this, Power Macs have started to show up
in computer sto res. Not only do these new Macs have the potential to run
much faste r than the Pentium, but they also run Windows and DOS software
and allow you to exchange data between the two platforms. As this book goes
to press, Apple, committed to the Power Mac, is systematically phasing out
Macs as we know them. By the end of 1994, you may not be able to find a
new Macintosh based o n the Moto rola 680 XO processor. But take heart- it
will stil l run almost all your current Mac softwa re, altho ugh, depending o n
your current system, a little slowly.

/
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RISC versus CISC CPUs
During the past ten yea rs of personal computing, deskto p com puters were
powered by com plex instruction set computer (CISC) chips, Macs by the
Motorola 680XO, and DOS machin es by Intel's 80X86/Pen tiu m. A few years
ago, Apple realized th at the CISC technology would reach a perfo rmance
plateau. In 1991, the company teamed up with IBM and Motorola to develop
the PowerPC family of reduced instruction set computer (RISC} chi ps. The
idea was that PowerPC performance would start somewhere near the same
rate as the fastest CISC processo rs and then, through the develo pment of
successive RISC generations, shoot through the roof. Power Mac pro mises this
tremendous power surge, while allowing you to continue using existing
Macin tosh software.

RISC: Simply Faster
PowerPC RISC CPUs achieve better perfo rmance by processing instructio ns
fas ter than CISC CPUs. RISC processors use smaller, mo re unifo rm instruction
sets that expedite instructio n fetching. In other wo rds, the processor never
has to pause to retrieve addit ional information to complete a pending
instruction. The reduced set of instructions allows the CPU to process
commands more q uickly. There's sim ply not as much code to read. RISC
processors also address memory qu ickly and do no t include complex calculatio ns and multiple memory references req uired in CISC-based processing.
And these obvio us improvements only scratch the surface-PowerPC CPUs
contain all kinds of adva nced processing power, such as the capability to
process several sets of instructions concurrently in o ne clock cycle.

PowerPC versus Pentium
What does all this tech nical mumbo-jumbo mean in terms of perfo rmance of
o ne platform versus another? Frankly, the Intel Pentium is a screamer and is
by no mea ns dead yet. In fact, it even sports several processing technologies
fo und in the PowerPC. Howeve r, it also contains circuitry to keep it compatible with the 80X86 li ne of Intel CPUs. What that means is that you do n't
have to switch sofn<Vare. The PowerPC, on the o ther hand, is no t com pletely
backwards compatible. Conventional Mac System 7 programs run in emulation mode, making them run more slowly than they would o n the fas test
68000-based Macs. To get the full perform ance boost from a Power Mac, you
must upgrade your soft wa re to native Power Mac versio ns.
RISC processors req uire fewer transistors and less power-and they can be
produced sign ificantly cheaper than Pen tium ch ips. Unless In tel fi nds a way

The First Power Macs
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to make the Pentium more efficient, Apple and o ther PowerPC manufacturers
(such as IBM) have a significant pricing advantage. Despite the lu kewa rm
growth of th e Maci ntosh installed user base over the yea rs, the PowerPC does
seem to have a better lo ng-term advantage. Again, although the Pentium
d oes incorporate some RISC technology to gain speed, it gets bogged down
by maintaini ng its backwa rds-compatibility with the ea rl ier 80X86 line. The
PowerPC RISC CPU is in its first generation and provides Motorola and Apple
with an excellen t platfo rm to build on.

The First Power Macs
If it looks like a Mac and acts like a Mac, it must be a Mac, right? Well, almost. On March 14, 1994, Apple released its first line of Power Macs-the
6100, 7100 and 8100. For all practical purposes, these machines are Power
Mac equivalents to th e Quadra 610, 650, and 800 (see fig. 2.1). In addition to
the PowerPC 601 processo r, however, some significa nt d ifferences amo ng the
models exist. All Power Macs so far have built-in Ethern et networking circuitry and AV configuratio ns through an expansio n card. Even the no n-AV
configurations support telepho n y, speech, and stereo capabilities. All models
also support multisync monitors and on-the-fly resolutio n switching. And all
except the no n-AV 6100 have two video ports.
The new Macs also utilize the o n-board video better, via PDS cards. Non-AV
7100s have cards with 1MB VRAM, expandable to 2MB, which means that
you can get HiColor o n 21-inch monitors, and up to 16.7 million colors o n
smaller, 16- and 17-inch monitors. The non-AV 8100s come with cards
containing 2MB VRAM, expandable to 4MB. With 4MB, the 8100s allow
true-colo r, 16.7 millio n colors o n a 21-inch monitor (and smaller). Several
benchmarks in Macintosh trade publication s have placed the new video cards
at two to th ree times faster than the o n-board video on standard Macs, but
on ly when running nati ve Power Mac software, d iscussed in the next sectio n,
"Power Mac Software."
Until the release of the Power Mac, Mac model names were confusing. For
exa mple, do you have trouble remembering how the CPU speed of a Centris
650 d iffers from a Quadra 650? With the debut o f the Power Mac, Apple developed a new naming scheme. The Power Macs include the CPU speeds in
their names. The Power Mac 6100/60 has 60M hz CPU, the 7100/66 a 66Mhz
processor and the 8100/80 is 80Mhz. If the com pan y were to introduce an
80Mhz 7100, it would be called a 7100/80.

/
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Fig. 2.1
The 6100, 7100,
and8 100are
virtually PowerPC
equivalents to the
Quadra 6 10, 650,
and 800.

The First Power Macs
Fig. 2.1
Con tinued

You will also notice a subtle difference when you start a new Power Mac.
Instead of the chime you're used to hearing when pressing the power button,
the Power Mac gives you a guitar cord strummed by jazz artist, Stanley ]ordan. If there's a problem duri ng bootup, a car crash sounds-cute indeed, but
the best news is that you don' t have to go broke buying a new Power Mac.
Power Macs are currently selli ng for about the same price as their original
Macintosh eq uivalents.

Power Mac Software
Frankly, most software, such as word processors and spreadsheets, already
runs fast enough on existing Macs, especially the later models built around
the 68040 processor. However, speed and performance are critical issues in
applications where graphics, sound, and video are used, primaril y desktop
publishing and m ultimedia presentations. Photoshop users, fo r example, can
use all the power they get, as can the creators of sophisticated multimedia
presentations that feature large sound clips and QuickTime fu ll-motion video.
Here's where the Power Mac comes in.
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When runni ng software written to conven tional System 7 Macintoshes,
however, the Power Mac must emulate the Mac operating system, which
slows down processi ng substantially. Performance degradation is so extreme
that some programs even run slower o n the Power Mac than on higher-end
conventio nal Macs, such as Quad ras. The bottom line: in o rder to reap the
performance benefits of the PowerPC processor, you must run software written specifically for that platfo rm.
This isn 't as bad as it sounds. If you are worried abo ut learning a new
operating system, have no fear. Power Macs run a versio n of System 7 written
especially for the PowerPC chip. In addition, alm ost all compan ies writing
software for the Macintosh, includ ing Microsoft, Ald us, Quark, and Adobe,
have committed to developing for the Power Mac. Power Mac versions of
PageMaker an d QuarkXPress are curren tly going to market-and boy, are they
ever fast.

Running Windows on a Mac
..,.. See "Using
Aldus
PageMaker,"
p. 562
..,.. See "Using
QuarkX Press,"
p. 585

One of the disadvantages of using a Mac in a world dom inated by IBMcompatible PCs is a lack of compatibility with 85 to 90 percent of the inform ation age. Apple and o ther companies have made great strides in closing
the com patibility gaps between the two platforms. Perhaps the most significant step in th is direction was the introduction of the SuperDrive on the Mac,
which allowed Macintosh users to use PC-formatted disks. Aldus, Quark,
Frame Technologies, and several other compan ies have made significant
advancements in writing software that creates documents almost com pletely
compatible across both platforms. None of these solutions are seamless, however.
Power Mac closes the compatibility chasm- almost. Finally, with the
PowerPC chip, a processor fast enough to run Wi ndows emulation software at
a reasonable clip is available. In a n utshell, emulatio n software bridges the
differences in the way PowerPC and Intel CISC chips process data. As of this
writing, th e o nly Apple-endorsed Windows emulatio n solution is Insignia's
SoftWindows.
At present, SoftWindows is by no means a perfect solution . It has several
li mitations- the most severe being that it can only ru n in Standard, or 286,
mode. One of the major benefits of Windows is its capability to multi task,
which requires the operating environm ent to run in 386 Enhanced mode.
Multitasking allows the compute r to perfo rm several operations at once, such
as print in the background o r download a file while you work in your word
processor. You can open two or mo re applications at once in Standard mode,
but you canno t m ul titask.

Upgrading to Power Macintosh
Some applications, such as WordPerfect for Windows (and several others),
require that Windows run in 386 Enhanced mode; otherwise, the program
won't boot. Another serious limitation is the amount of RAM required to run
SoftWindows. To use the software at all, your system must have at least 16MB
RAM, as compared to the 4MB required on a PC. This is a minimum configuration. Som e Windows applications, like their Mac counterparts, req uire additional RAM to run, and many of those that don't req uire more RAM still need
it to perform well.
The first Power Macs built around PowerPC 601 chip can run Windows software at a speed comparable to a 486SX, or an entry-level DOS machine. To
Mac users, this performance level is probably about the same as one of the
slower Quadras, such as the 610. The difference between 486SX performance
and that of a 486DX4 or a Penti um is dramatic-even unacceptable-to Windows power users.
Running Windows applications on the Mac has two advantages, however.
First, despite its d rawbacks, the SoftWindows solution does enable you to
exchange data, such as text and graphics, between the two platforms through
the Clipboard. Second, thousands of Windows applications are currently
unavailable to Macintosh users, and vice versa. The ability to run Windows
on a Mac opens a vast library of applications.
Still, give n the current situation, most dedicated Windows users will not find
the Power Mac Windows implementation powerful enough to justify switching. Instead, the Power Mac is a better solution for Mac users who want to
run occasional Windows sessions. But as the RISC chip gets faster and the
emulation software improves, who knows what might happen?

Upgrading to Power Macintosh
In the recent history (the past 10 yea rs or so) of th e desktop computer, the
PowerPC-based Power Mac is the first to make a complete platform shift- in
other words, to discontinue total backward compatibility at the processor
level. (Remember that by itself, the PowerPC cannot run Macintosh software.
Apple has built System 7 emulation into the Power Macin tosh.) If the Power
Mac takes off, software developers may stop writing versions for the conventional Macintosh system software, even though Apple is commited to con tinue upgrading operating systems as they develop newer versions for Power
Macs (see fig. 2.2) .

35

36

Chapter 2-MacPresent and MacFuture

.,.. See "Hard Disk
Problems,"
p. 1072

Rest assured that the company has not left most Mac owners in the cold .
Most of today's Macs can be upgraded to PowerPCs. Apple has already
planned motherboard upgrades for the most recent Macs, including most
Quadras, Centrises, and Performas. You'll even be able to use existing drives
and peripherals (although some may require driver upgrades), but if you have
an o ld, small, slow hard disk, you should also change it. It makes little sense
to soup up your Mac and then leave it to limp along with a slow hard disk
bottleneck.

Fig. 2.2
The PowerPC.

Initially, Apple has set the m o th erboard upgrade prices to range from about
$1,000 to $2,000, with 8100 AV upgrades being the most expensive. For all
practical purposes, these upgrades turn your existing system into a Power
Mac with the same specs as those listed previously in the section "The First
Power Mac's." In case the Logic Board upgrade price is too stiff, however,
Apple offers another, less expensive option by way of a PDS card that fits into
one of your Macs expansion slots. For about $600 to $700, you can turn your
Mac into a totally compatible 60Mhz Power Mac. In some cases, this method
is a li ttle bit less powerful a solution (the card interfaces with the logic board
at 32 bits, instead of the PowerPC's 64 bits), but it allows you to easily switch
back between Power Mac and conventio nal Mac, which is a great way to
avoid the emulation performance lag while developers upgrade their software.

The MacFuture

End of an Era
A primary difference between the Macintosh and DOS PCs is that for 1 0 years now,
Apple Computer has been the only company to manufacture Macs. DOS machines,
on the other hand, have been manufactured and distributed by several vendors.
Apple has been quite successful at keeping tight reins on its technology-which is
good and bad. Being a proprietary platform has left Apple free of competition. On
the PC side, there has been great competition, which has spurred performance
boosts, innovations and lower prices. Undoubtedly, one reason Macs fell behind in
performance was that Apple didn't have to con tend with other companies in its
marketplace. And until about one year ago, Macintoshes were much more expensive
than comparably equipped DOS PCs.
The advantage of having the same company manufacture all the computers on a
given platform is superior compatibility. Macintosh users do not have to contend
with some of the software and hardware mismatch nightmares that Windows users
pull hair and lose sleep over. Guess what? All that's about to change.
Competition and Apple's quest for survival has spurred the end of this proprietary
trend. Recently, Apple announced a program to license its system software to thirdparty developers. In the near future, you may be able to buy a Power Mac made by a
company other than Apple Computers. It will be strange indeed to see Macintosh
software running on a computer without a bright-colored apple on the front. Life
goes on.
As we move into the PowerPC era, at least one company, DayStar, has already taken
Apple up on its licensing offer. DayStar has released its own version of the PDS Power
Mac upgrade fo r Quadras and Centrise.s. The company said that they will soon release cards to upgrade other Macs. This new trend, third-party Macintoshes, will
probably be a double-edged sword. As in the DOS PC world, competition will spawn
advancements. A diversity of developers will probably create some compatibility
headaches.

The MacFuture
The conventio nal Mac as we know it is on its way o ut. By the time you read
this book, you may not be able to buy a new Centris, Quadra, o r Performa.
This is not to say, however, that the existing machines will not be around for
a while and that you won 't be able to buy software for them. As it stands
right now, most software vendo rs, includ ing the key players, such as Aldus,
Adobe, Quark, and others, have announced commitments to continue developing products for non-PowerPC Macs. How q uickly the installed Macintosh
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base switches to PowerPC will undoubtedly determine how long this continues.
Although the conventional Mac platform is still a contender, over the next
few years, the emphasis will probably switch to the PowerPC. Apple has outlined the future development of the Power Macintosh and other product
strategies, covered briefly in the following sections.

Future PowerPC CPUs

ll>

See
"Power Books
and Duos,"
p.995

The PowerPC 601 chip is just the first of several PowerPC chips planned by
Motorola. The next version is the 603. This chip has several advantages over
the 601. First, the 603 is faster-perhaps two or three times faster. It can process up to three instruction sets per wait state, for example, instead of the
601's one instruction set per wait state. But the real advantage is that it
consumes much less power by shutting down parts of the chip not in usewithout the software knowing about the change. This and other power management features make it ideal for battery-operated computers. Apple plans
PowerPC PowerBooks based on the 603 by the end of 1994.
Another advantage of the 603 is that the chip is smaller and should be less
expensive to manufacture. We'll probably also sec this CPU in h ome and
entry-level Macs. In 1995, we should see a significantly more powerful CPU,
the 604. Expect to see the 604 replace the 601 in midrange and high-end
desktop Macs sometime in 1995. The 603 and 604 should remain in use for
several years. Another chip, the 620, is being designed for workstations. Look
for a few extremely high-end Macintosh workstations and servers based on
this chip in the future.
Also planned is the implementation of technology designed to process data
faster, such as the Peripheral Component Interconnect currently used on
IBM-compatibles, which transfers video and other data along a 64-bit path.
To enhance network performance, Apple plans to turn to a new technology
called QuickRing, which will transmit and receive data at a whopping 200MB
per second.
The MacFuture looks exciting, indeed.

The MacFuture

The MacFuture of Software
Although the outlook for the next year or two of PowerPC CPUs seems clear,
the future of Mac software is not as certain. As the Windows and Mac platforms converge, it's difficult to predict which standards will survive. While
experts don't know which standards will live on, they do seem to agree on
the general direction computer software will take. As demonstrated by the
application suites, such as Microsoft Office, a group of programs consisting of
e-mail, word processing, spreadsheet, database, and presentation software,
the indication is that the future of software is modular.
In other words, instead of buying a full-featured word processor in the future,
you'll buy modules that plug into an open document system. Documents will
exist primarily at or one step above the system level, and you'll use modules,
or plug-ins, to enhance them. Suppose that you need to create indexes for
your documents. Rather than purchasing a full-featured word processor,
you'll simply get a simple indexing module. To edit and import graphics,
you'll use a graphics editing plug-in.
Apple's proposed approach to this system is OpenDoc, a system close to that
described above. The snag in the OpenDoc approach is that currently it is
based on the Macintosh data-sharing convention of Publish and Subscribe.
To become cross-platform compatible, Open Document must also support
Windows' Object Linking and Embedding (OLE) technology. If not, many
cross-platform applications, such as, say, PageMaker or QuarkXPress, will not
be able to transfer documents seamlessly.
Also in question is whether it makes sense to create a standard that includes
two distinctly different modes of data linking-Publish and Subscribe and
OLE. It seems to make little sense, and many experts agree that OLE is by far
a superior standard.
In addition to OpenDoc, Apple seems to be banking on PlainTalk speech
recognition, Audio/Video processing, and making the Mac more capable of
running Windows while also offering the benefits unique to the Macintosh.
Look for an upgrade to the Mac system software sometime in 1995, to System
8.0. However, Apple is remaining tight-lipped about upgrades past 7.5. You
should look for a move toward OpenDoc in System 8.0 software and perhaps
an implementation of OLE. For more information on System 7.5, see Chapter
4, "What's New in System 7.5."

39

40

Chapter 2-MacPresent and MacFuture

From Here...
The decision whether to buy or upgrade to a Power Macintosh may seem
difficult, but it isn't, really. If you're happy with your curren t Mac's performance, hold onto your money for a while. If current trends continue (and
there's no reason to believe they won't), computer prices will continue to
drop. If you're in a graphics or DTP environment and can afford it, go on and
take the plunge. You won't regret it; the performance boost is substantial.
From here you may want to consider Part II of the book and the chapters on
System software. Chapters 3 through 10 cover the Mac interface and how to
use it. In addition, you should consider the following chapters:
• Chapters 16, 17, 18, 19, and the others in Part IV cover using software
applications. You' ll find a wealth of tips on and information on being
more productive with your Mac.
• Chapters 33, 34, 35, and 36 can also help. Networking, data exchange,
and being on the road are all issues related to being more productive
with your computer.

Chapter 3

The Macintosh Interface
Philosophy
by Chris Oakes

As you saw in the first two chapters, Macintosh hardware has experienced
ma jor generational changes over the years. Throughout the Mac's history,
however, the graphical Macintosh user interface-the figurative levers and
pedals that control this remarkable machine-has remained constant. And
along with this unchanging look and feel, common tasks can be performed in
new Macintosh applications the same way as in old Macintosh applications.
The way you copy and paste text in a Macintosh word processor, for example,
is no different in 1994 than it was in 1984. Procedures are also consistent
across applications. You copy text, for example, the exact same way in the
word processor Microsoft Word as you do in Claris MacWrite, another
Macintosh word processor. This consistency among applications and common tasks is what keeps the Mac easy to use.
This chapter explains the following Macintosh interface concepts:
• Macintosh interface philosophy
• What consistency among Macintosh tasks looks like and how it helps
you work better
• Consistency in Macintosh menus
• Consistency in Macintosh menu commands
• Consistency in Macintosh windows
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The Familiar Steering Wheel
The steering wheel is a simple control common to all automobiles. The steering wheel also illustrates why such common controls should be consistently
positioned and used among different machines. To turn a car to the left or
right, every driver knows to use the steering wheel. Turning the wheel to the
left always turns a car to the left, and vice versa. It doesn't matter whether
you're in a Ford or Toyota, a sports car or truck-you know where this important control is located, and you know just how to use it. This standard implementation of common controls and the tasks they perform is what interface
consistency refers to. Used in car design, it lets you hop into even the most
sophisticated of sports cars and cruise out onto the open highway- without
having ever driven that car before. This standardization is also what consistency among Macintosh applications is all about.
Even slight deviation fro m an interface standard can be disconcerting. In
most countries, for example, cars are driven on the right side of the road. But
if you have ever driven in Britain, where cars travel on the left side of the
road, you know how this little variation can throw you off. Instead of operating as you normally do, you must relearn the task at hand. That means extra
time and effort spent on training. Consistency among these common tasks
reduces that.
The designers of the Macintosh wanted people to be as comfortable with the
Mac interface as they were with the steering wheels of their cars. To do that,
they decided that the various elements of the interface-such as menus, windows, and common menu commands-should remain constant throughout
the Finder and all Macintosh applications. Mac users, therefore, would have
familiar tools to use no matter what they were doing.

Apple's Interface Guidelines
At the outset, an Apple document called "Human Interface Guidelines" expressed this ideal of interface consistency. To make sure that Macintosh applications feature similar procedures and characteristics, Apple encourages all
software companies to follow these guidelines. In his book about the creation
of the Macintosh, Insanely Great, Steven Levy notes that these guidelines
came to be known, sometimes derisively; as the Macintosh Religion. But these
guidelines are responsible for making the Macintosh famous for two important assets: ease of learning and ease of use. Levy underscores the effect of the
Human Interface Guidelines on Macintosh software in Insanely Great:

Apple's Interface Guidelines
The entire software base of Macintosh became a coherently created
world in itself, one with an immediate familiarity to anyone who
had mastered the elemental skills of using the machine .... You could
launch a strange application, and accomplish something instantly,
without even touching the manual. After some painless exploration,
and perhaps a glance or two at the documentation, you could probably get serious work done. It was an ambitious plan, and, amazingly, it worked.
In a moment, we'll take a look at these universal interface features and the
tasks they accomplish. After a while, you will become familiar with these
features, the steering wheels and gas pedals of the Macintosh interface, and
you will be ready to jump into any Mac application and take it for a spin. The
following sections examine what happens when such consistency is missing.

Computing without Consistency
Perhaps the best way to see the virtue of universal interface features is to
consider working in their absence. The IBM PC world has long bemoaned
such an absence. Before the Microsoft Windows operating system, DOS-based
programs (programs based on text commands-an interface where users issue
instructions by typing lines of text) hardly even tried to have consistency
among applications. The way you performed tasks differed greatly from one
program to the next. At best, common methods might be found in two software programs from the same company. There was little hope that by learning
one program you were on the road to learning others. More often, learning a
new program meant learning from scratch.

Microsoft Windows
When Microsoft Windows 3.0 exploded onto the PC scene in 1990, part of its
mission was to bring Mac-like consistency to PC software. It certainly helped
the situation, but several conditions prevented it from matching the Mac
completely. For one, Windows was only a shell around DOS, which was still
the underlying operating system that saddled the computer and made it run.
Windows was still bound to many of DOS's unintuitive and difficult-to-grasp
characteristics, such as cryptic file names and confusing file directories.
Second, although it brought a set of common graphical features, many of the
methods for carrying out frequently used commands in Windows still varied
from application to application. The commands to open and close files, copy
text, and other typical functions were not uniform across the board. These
inconsistencies remained largely because developers of Windows software
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weren't deali ng with a set of interface guidelines like those for the Mac. Like
Windows, Windows software had its roots in DOS.
To this day, new versions of Windows strive to remedy this situation. Meanwhile, th e Mac world, though not immune to confusion, has a much stronger
footing in the all-important area of interface consistency. The next section
shows you the features of Macintosh interface consistency.
Note
A new version of Windows, code-named Chicago, makes the strongest effort yet to
escape the problems of DOS. This version works as a full-fledged operating system,
not as a shell around DOS. Consequently, DOS is no longer necessary.

The Familiar Features of Macintosh
Figure 3.1 shows a typical scene in th e Finder, the fi rst thing you see after
your Macintosh finishes its startup process. Now take a look at figure 3.2.
Th is figu re shows what you see after you launch the word processing application Microsoft Word. Notice that the two scenes are pretty similar. Becoming
familiar with one of them brings natural familiarity with the other.
Fig. 3.1
The Macintosh
Finder.
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Fig. 3.2
Microsoft Word.

Which features are common to both figures? First, both screens feature the
Macintosh men u bar alo ng the top edge. And both screens feature windows
(the empty white box in figure 3.2 and the similar, though not empty, box in
figure 3.1).

Note
Both figures 3.1 and 3.2 feature the Macintosh HD and Trash icons, but these icons
belong only to the Finder. Why are they visible in the Microsoft Word screen shot?
Because although Word is in the foreground, the Finder waits idly by in the background. The Finder is still visible and accessible underneath Microsoft Word. It is
possible to hide the Finder with the Performa series of computers or with System 7.5.
This option was added by Apple for novice users who are apt to click the desktop
accidentally and thus exit their active document window.

Altho u gh the applications don't exactly have a boatload of si m ilarities, th ese

few common characteristics make a world of differen ce wh en you learn and
use the Macintosh. Chapter S, "Understanding the Desktop and Finder,"
burrows into the specifics of using these interface elements. In th is chapter,
the building blocks of Macintosh consistency-the com mandments of the
Macintosh Religio n-are summarized to show how t hey make computing
simpler.

.,.. See " Using the
Perform a
Control Panel,"

p.99
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Issuing Commands with the Macintosh Mt!nu

Every user n eeds to talk to his or her computer. Because you c~just speak
to your computer, however, computer designers had to concoct an alternate
method of telling the m achi ne to do som ething. To do something in com puter
lingo is to carry out a command. As discussed in the preceding section, the
Macintosh bro ught its uniq ue graphical style to these commands-a radical
improvem ent on the conventional m ethod of typing out text in order to do
something.
Note
Some Macintoshes recog nize a limited set of speech co mmands. This feature is found
on Power Macintoshes and "AV" models, which are discussed in Chapter 14.

This commo n need to issue commands was th e perfect place to start applying
Macintosh consistency. And so the Macintosh menu bar was created. Recognizable in all Macintosh ap plications, the m enu bar contains menus. Menus
are indicated by words such as File, Edit, and View. Figure 3.3 shows the File
menu, as seen in the Finder's m enu bar.
Every menu offers a visible list of commands, such as Open, Close, and Print.
To view these commands, click a menu with your mouse, hold the mouse
button down and presto!-the list of commands appears. To choose a command, move your mo use over the command and then release the mo use
button . You issue commands this way no t only in the Finder but in every
application written for the Macintosh. just by reading this brief section,
you've gained an understanding of how to issue commands in hundreds of
Macintosh applications. That's the power of consistency.
Fig. 3.3
Th e File menu as
seen in the Finder.
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The language of menus is more like the English language than a computer
language. In some cases, by mentally combining a menu's name-File or Edit,
for example-with one of the items in that menu, you can assemble a logical
English command. Open File, for example. Or Print File. Or View By Icon,
available in the Finder's View menu (see fig. 3.4). In some menus, such as the
Finder's Edit menu (see fig. 3.5), the commands stand alone. You certainly
don't have to construct literal English phrases out of menu commands-but
their familiar, English-like syntax is a helpful touch. In the next section,
menu commands are used in the Finder and Microsoft Word. A simple copyand-paste example illustrates how consistency among menu commands can
keep your work simple.
Fig. 3.4
The Finder's View
Menu.

Undo

... z

Cut
Copy
Pasta
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:leA
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Copying and Pasting: Consistency in Action
Suppose that while working in the Finder, you want to copy the name of a
particular file for use in a memo. In the Finder, you select the file's name.

Fig. 3.5
The Finder's E.dit
Menu.
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To copy the file name, choose Copy from the Edit menu (fig. 3.5). (Chapter 5
discusses these procedures in detail.)
Now you need to paste the file's name into a Microsoft Word document,
where you're crafting your memo. In Microsoft Word, you find the same
menu you used in the Finder-the Edit menu, shown in figure 3.6. When you
open the menu, you find the Cut, Copy, and Paste commands. Notice that
the commands are located in the same place as they were in the Finder.

Fig. 3.6

11m._

The Edit menu in
Microsoft Word.
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The Cut, Copy, and Clear commands are visible but gray. Because you just
made a copy in the Finder, the Mac knows that next you need to Paste. (You
learn more about this capability in Chapter 5.) Other commands that are
exclusive to Microsoft Word also appear in the menu, but the common commands are all under the same menu bar. Th is would be the case in any
Macintosh application that allows you to copy and paste objects.
Note
Although menus offer a nice, visual way to issue commands, sometimes you may
want to use the keyboard shortcut. Keyboard shortcuts are frequently listed in menus
right next to the command. As you get more familiar with Macintosh, you may find
that typing the key combination (such as :J;C-C for the Copy command) is a nice
shortcut. And just like the menu commands, these keyboard shortcuts are usually
consistent throughout all Macintosh applications.

In this section, you witnessed consistent element #1, the Macintosh menu, in
action. In the next sections, you learn about an even simpler consistent elemen t-the Macintosh window.

The Familiar Features of Macintosh

The Macintosh Window
As you've seen in the previous sections, menus perform actions. They can act
upon any of a number of Macintosh objects-a piece of text, a photograph, a
drawing, or even a frame of video. In all cases, these editable contents are
kept in containers known as files. You create and edit files with applications.
For example, you might use a word processor such as Microsoft Word to create and edit a text file. When you open a file on a Macintosh, the fi le's contents are d isplayed in a Macintosh window-and no matter what application
you're using, a window looks and acts basically the same way.
Note
Entire windows and files themselves can be on the receiving end of a command. An
entire file, for example, might be "exported" for use in another application.

Previously, you saw some windows in the Finder and Microsoft Word. In this
section, you examine a FileMaker Pro window. Figure 3.7 shows an open
FileMaker Pro file that contains a database of name and address. (Chapter 20
discusses FileMaker Pro, a database applicatio n from Claris Corporation, in
detail.)
Close box

Fig. 3.7
A Fi leMaker Pro
window .

...........

Scroll bars

Size box
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You probably recognize some common interface elemen ts in this screen shot.
Altho ugh you are dea ling with an entirely d ifferent application, the menu bar
is still visible at the top, as are those two com mon m en us, File and Ed it. Notice tha t the Finder's Trash and disk icons are visible in the background, just
as they were in previo us figures. Finally, notice the window, that d istinctive
rectangle prominent in previo us figures as wel l. The file name, Contacts,
appears at the top of the window, and the file's contents appea r inside the
window. To copy any of the text displayed in this window, you wou ld use
the fa miliar Copy command located in the Edit men u.
Exa mine the window in figu re 3.7. The bar along the top of the window is
called the title bar; it contains the window's title (again, Contacts in this case).
In the wi ndow's upper left corner, there is a small box for closing the window, which puts the file away for the time being. This box is called the close
box. In the window's u pper left corner is a box for maximizing th e size of the
window, called the zoom box. One click on the zoom box maximizes the
window's size, a second restores it to its original size. The double box in the
lower righ t corn er of the window enables you to stretch and sh ri nk the window to any size you wa nt. It is therefore called the size box.
Finally, the window contains two gray bars-on e along th e full length of th e
window's right side and one along most of the window's botto m . Those
bars-with arrows at each end and the box in between-are the scroll bars.
Like a television cam era moving left and right o r up and down, the scroll bars
let you bring hidden window areas into view.
That's the gist of consistent element #2, the Macintosh window. Again, all of
its featu res are the sam e no m atter what application you' re usi ng. As omnipresent as the menu bar, you will see a window around every file you ever
open on your Macintosh. You will therefore recognize and know how to use
this tool in every Macintosh applicati on . In fact, you already know a li ttle
about it. You may want to take a moment to fidd le with some menus and
windows o n your Mac right now.
Note
Many Macintosh programs allow you to open multiple windows. This feature is
convenient because it enables you to easily t ransfer text and other data among files.
You can copy text in one window, for example, and paste it into another one. To
move to another window you just click it.

More Power Than Meets the Eye
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This chapter covered o nly two features-menus and windows. But quite a few
common capabilities are contained within them. Table 3.1 lists the many
commands contained in just the File and Edit menus. If you multiply these
commands by the number of applications you'll use on your Macintosh,
you'll find that you have quite an arsenal of software knowledge.

Table 3.1

Common Macintosh Commands

Menu

Command

Action

File

New

Creates a new file or folder

Open

Opens an existing file or folder

Close

Closes an open file or folder

Edit

Save

Saves changes to a file

Save As

Saves a fil e as a new, separate file

Print

Prints the contents of a file

Quit

Quits an a pplication

Undo

Takes back ("Un-does") your most recent action

Cut

Cuts out a selection (of text, graphic, and so on)

Copy

Copies a selection

Paste

Pastes a selection in a new place

Clear

Deletes a selection

Select All

Selects all the contents of a file or fold er

Now that you understand these common Macintosh features, you will understand other common features more easily. When you read other chapters in
this book, you will witness the Mac's wide use of many consistent features. In
the Finder, you'll see that every file is represented by an icon, no matter
what's in the file. You'll see that you move, delete, and copy all icons in the
sa me way. Fonts, which are covered in Chapter 8, are often d isplayed in a
Font menu. A commo n menu called Style changes font characteristics. You'll
see that dialog boxes change every file's settings-and that they all use a variety of similar-looking buttons. And you'll see that printing fil es follows a
similar routine in every Macintosh program as well.
Consider: A few simple, recognizable menus conta in all the commands listed
in table 3.1. Imagine if you had to memorize typed commands for each one.

...

...

...

See " Icons:
Representi ng
Files, Folders,
and Disks,"
p. 74
Sec "Putting
Files into a
Folder,"
p . 117
See "Printing a
Documen tfrom A-Z,"
p.206
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Then every time you wanted to copy someth ing, you would have to use an
awkwa rd combinatio n of keystrokes. Or worse, you might have to remember
different commands for the same action, depending on which program you
were using. Although the Mac allows you to issue keystroke commands, I'm
sure you'll agree that it's much easier to learn and use these commands by
using a set of fa miliar men us.

From Here ...
In this chapter, you learned about the design philosophy behind the
Macintosh interface. Upcoming chapters delve into the specifics of this interface. The following chapters focus on special in terface features and how to
use them in your work on the Macintosh.
• Chapter 5, "U nderstanding the Deskto p and Finder," specific Macin tosh
features such as folders, icons, windows, and menus- and how they
work together to create that special workspace known as the Finder.
• Chapter 7, "Organizing Your Files, Fo lders, and Disks," shows you how
to carry out common Finder tasks and how to use these tasks to o rganize your files, fo lders, and disks.
• Chapter 11, "Changing the Look of Your Desktop," shows you how you
can make modificatio ns to your Macintosh's interface so that it better
suits your working style.
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Chapter4

What's New in
System 7.5
by Gene Steinberg

When System 7.0 first appeared in May of 1991, it took the Macintosh world
by storm . It offered enhanced Finder capabilities, 32-bit memory addressing
(the 8MB barrier could be exceeded at long last), and features such as File
Sharing, and Publish and Subscribe. System 7.0 also caused a few headaches
along the way as users had to buy software upgrades and update their hard
drives to avoid strange and mysterious crashes.
A year and a half later, System 7.1 gave us WorldScript, for quick adaptation
of the operating system for foreign language use, and System Enablers-the
ability to quickly configure the operating system for use with new hardware
simply by dropping a file into the System Folder.
Apple gave us desktop electronic mail capability with System 7.1.1, better
known as System 7 Pro, which added a few cute Finder tricks too, such as
placing a shaded rectangle around the directory window to which you' re
copying a file.
System 7.5 rolls all the features of previous System 7 versions into one huge
package, cleans up some long-standing bugs here and there, and provides a
number of new features to whet your appetite. In all, Apple promises over SO
enhancements for System 7.5.
The next few pages highlight the salient features of System 7.5. Th en I give
you a few helpful hints you'll want to know before you install it on your
Macintosh.
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Who Can Install System 7 .S?
System 7.5, all by itself, requires a Mac Plus or later running at least 4MB
of RAM. If you opt to add some of the frills, such as QuickDraw GX and
PowerTalk, you want 8MB RAM available on your Mac. And it doesn't seem
so long ago when a 1MB Macintosh could do it all.

System 7 .S Overview
As described in the pages that follow, Apple has assembled many Systemrelated enhancements that you on ce had to buy separately and rolled them
all together into System 7.5. Some of the handy utilities that you may have
used to display a menu bar clock, provide submenus from your Apple menu,
and offer other enhancements are now included as well.
In addition to offering new features, System 7.5 reportedly provides improved
performance. Apple states that Finder-related functions (such as copying files,
launching applications, switching among applications, and accessing items
from the menu bar) will be noticeably faster. These are the areas that System
6 users long touted as superior to System 7. In addition, all of those bug fixes
and en hancements from the System 7 Tune-Up and the various System Software Update packages will be rolled into System 7.5.
The next sections discuss some of the major features of System 7.5.

New Features
On the surface, System 7.5 looks much like previous System 7 versions. But as
you begin to work with the new system software, you' ll find some obvious
and not-so-obvious changes. The following sections describe some of the
highlights.
Apple Guide

System 7's hokey Balloon Help is here, but Apple has found a better way to
guide you through your tasks. It's called Apple Guide, and it's almost good
enough to replace some of the manuals that come with your new Macintosh.
If you are familiar with the context-sensitive help features of some programs,

Apple Guide won't seem so strange to you, although it goes m uch further in
terms of flexibility. Apple Guide offers step-by-step assistance to help you
accomplish a particular function, and the initial help package is available at
the Finder desktop, right fro m the Balloon Help menu. In addition to providing clearly-written text screens, on-screen objects are highlighted, or windows
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are opened and brought to the front, so you can see exactly what's being
described in the text. Figure 4.1 shows the Macintosh Guide, the first Apple
Guide module.

How do I change II em• In the Apple

<•> menu?

You can conttol wha t ~pJ)OUI tn the Apple(~) menu by
du.aa1na ltem.s in or out ot the Apple Menu Items
folder Cln.sicle the System Folder). You can ..00 adjwt
the submenus that appear tn the Apple menu..
Which do you want to do? Click one:

@ ad.d anitem

0
0

remove an Jtem
adjust submenus in

Molle your chcice, thon -

the~plo

menu

the rll;lt 11trow.

Apple Guide is extensible. That means that software developers can include
hooks to it in their software so that the same easy-to-understand learning
environment can be transplanted to your word processing software, your
publishing software, and other software products.
M acint osh Drag and Drop

Th e clunky cut-and-paste routine to transfer files between documents or
from one part of a document to another may soon be a thing of the past.
Macintosh Drag and Drop lets you literally drag a text or graphic object from
one document and move it to another-without having to use the clipboard
as an intermediary. You'll already find some drag-and-drop capability implemented in Microsoft Word, Nisus Writer, QuarkXPress, and WordPerfect.
Wh en software publishers fully support Macintosh Drag and Drop, you'll
even be able to move information from one document to another without
losing formatting. ln addition, you' ll be able to drag graphics and text right
onto the Macintosh desktop and save it as a "Cli ppings" file. This file can
later be dropped into another documen t or simply into another location in
the document you were already worki ng on .
Scriptable Finder

Using AppleScript, you' ll be able to automate Fin der operations and "play"
them back with a simple keyboard com mand. As with macro programs such
as QuicKeys and Tempo II Plus, you can record the operations you perform
and then have AppleScript repeat the steps at your command.

Fig. 4 .1
Apple Guide
is a convenient,
interactive, on li ne
manual for your
Macin tosh.
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Enhanced Apple Menus

Here's on e of those utilities that you used to have to buy as a separate product or download from a BBS as shareware. Enhanced Apple Menus is a Control Panel based on Microseeds HAM (Hierarchical Apple Menu). It generates
submenus of up to five levels deep from your Apple menu. In addition, it sets
aside folders that you can access to launch recently used applications, documents, or file server hookups.
WlndowShade

WindowShade represents another Apple execution of a utility that's popular
on the shareware circuit. After you install this utility, you can click the title
bar of any window to collapse (reduce) it to the size of the title bar itself, as
shown in figure 4.2. Clicking the title bar again (you have the choice of
single-clicking, double-clicking, or triple-clicking in the WindowShade Control Panel) restores the window to its regular size. This feature will be a boon
to people whose Mac desktop gets as cluttered as mine does.
Fig. 4.2
Apple's
WindowShade
allows you to
click away your
cluttered Mac
desktop and leave
just the title bars
in its place.

Desktop Hiding

Apple first introduced this feature (and some of those to follow) in its lowercost Performa line. When you are working in an application, the Finder can
be hidden automatically. That way you can't click out of your document and
return to the Finder by mistake. You can still switch applications from the
Finder's application menu, a number of handy third-party programs, and the
one discussed next.

System 7.5 Overview
Launcher

Launcher is another feature of the Performa line. Like some popular commercial and shareware programs, Launcher puts up a floating palette with icon
buttons representing applications, documents, and folders. It's a handy tool
for quickly opening frequently used files.
Document Folder

The Performa-borne Document Folder sets aside a default location to store
your document files. That relieves you of the task of hunting for files that are
buried in a mass of folders and subfolders. This feature already exists in programs such as Now Software's Super Boomerang (part of Now Utilities) and in
shareware favorites such as Default Folder.
Electronic "Sticky" Notes

If your working area, like mine, is cluttered with little notes reminding you to
do one thing or another, you'll appreciate Apple's Electronic Notes feature. It
allows you to create little notes on-screen and format them in different colors
and type styles. And with Macintosh Drag and Drop installed, you can drag
one note file to another.
New Scrapbook

Apple has at last taken a step towards making the Scrapbook more usable as a
storage place for graphic and text items. The new Scrapbook will be sizeable.
You'll be able to drag pictures right from your document to the Scrapbook
and store them there. And you'll be able to drag items from the Scrapbook
and place them in another document. Of course, some of this will require
programs that support Macintosh Drag and Drop-and you won't see too
many of those for a while.
New Notepad

In addition to Electronic Notes, Apple has made its Notepad a useful repository of text items. Instead of just cutting and pasting your notes into your
documents, you'll be able to print directly from the Notepad desk accessory.
You'll also be able to search out text items, as shown in figure 4.3, and place
those items right into your document by using Macintosh Drag and Drop.
The program in which you're working must support Drag and Drop for this
feature to work.
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Fig. 4 .3
Searching for a
specific word in
a specific note
made easy with
Apple's new
Notepad desk
accessory.
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Time and Date Displayed In Menu Bar

In the past, a lot of Mac users have said that Apple programmer Steve
Christenson' s popular freeware utility, SuperCiock, should become part of
Apple's system software. SuperCiock was one of the first menu bar clock utilities. You can customize the information you want on the clock and even
have it chime (with your chosen sounds) at I S-minute intervals. Well, Apple
has gotten the message, and you'll find all of SuperCiock's functionality incorporated in System 7.S's Date and Time Control Panel (see fig. 4.4).
Flg.4.4
Apple's enhanced
Date and Time
Control Panel
incorporates the
functions of
SuperClock.
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System and Application Folder Locking

Here is another Performa-bred feature. You can click checkboxes in the enhanced General Control Panel (shown in fig. 4.5) and prevent changes from
being made to the System Folder or any application folder. So if your Mac is
being used by a child or novice user, you have a slight measure of protection
against unexpected changes.
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Fig. 4.5
Apple's new
General Control
Panel offers a new
repertoire of
options, many
borrowed fro m the
Performa line.
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M ore Colorful Desktop Patterns

Apple has created a new program, called Desktop Patterns, t hat allows you to
choose fro m up to SO fancy desktop patterns. Figure 4.6 shows one of the
selections.
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The new repertoire of deskto p patterns doesn't qu ite replace the wide range
of choices you have in programs such as Now Fun, UnderWare, or Wallpaper,
but many users will consider it more than satisfactory.
PC Com patibility

The awkward-to-use Apple File Exchange progra m is history. In its place,
Apple is including two programs in System 7.5 that used to be available
separately. First is Maci ntosh PC Exchange, which enables you to mou nt
DOS/Windows disks on your desktop and copy the files to your Mac. If you
have a Mac equivalent of a DOS o r Windows program (such as Microsoft
Word and WordPerfect), you'll be able to open those documents on your Mac
and retai n much of the document formatting.

II
Fig . 4 .6
One of the fa ncy
new patterns you
can create on your
Mac's desktop
under System 7.5.
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The second program is Macintosh Easy Open, which enables you to attach a
specific document file type to o ne of the applications you have. This helps to
eliminate the dreaded message about an application being unavailable. Apple
bundles file format translators with some of their products that will also provide almost seamless translation from a variety of DOS or Windows documents (even if you don't have a Mac equivalent to these programs).
PowerTalk

Apple's desktop electronic mail system will be included as part of System 7.5.
You won't have to buy a separate product, as you did with System 7 Pro.
As the number of PowerTalk-savvy programs grows, you'll be able to include
e-mail fro m a mail server, online service, the Internet, fax, pagers, or voice
mail in a single universal mailbox.

Performance Enhancements
The new features of System 7.5 discussed so far are largely window dressing.
Ma ny of the important parts of the new operating system lie beneath the
surface. The following sections describe some of these features.
Four Gigabyte Volume Support

The Mac is being used m ore and more for multimedia production, both audio
and video, and these files can positively eat up disk space with aba ndo n.
Multi-gigabyte hard drives are common, but the Mac operating system has
only supported a two gigabyte volume until now. If you had a hard d rive
with greater capacity, you just partitio ned it to divide it into smaller volumes.
System 7.5 modifies the file system to accept single volumes of larger capacity. Remember that the minimum file size increases in direct proportion to
the size of the drive, however-so even a small text file can grow as a result.
Keep this in mind if you want to take advantage of this new feature.
Universal Enabler

Apple devised System Enablers so that they didn't have to prod uce a new
system software version every time a new piece of hardware hi t the streets.
Unfortunately, System Enablers have been a curse to many of us. They are
labeled with numbers instead of names, so it's hard to know which file goes
with which machine (such as 088, 040, and so on). With System 7.5, Apple is
going to support all existing Mac models without the need to have those
pesky little Enablers running loose in the System Folder (there will be lots of
other new things, though). Of course, relief is only temporary. When the
next new Macintosh rolls down the pike, the Enablers will be back.

System 7.5 Overvie·
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ptive multitasking gives a program the authority to take over CPU

ts entirely, if needed. In theory, this creates a mo re stable working envi- - --

•vnment. A side effect is that if a program crashes for any reason, the other
programs you' re working on won' t necessary be subject to crashing too, so
you can continue working without restarting.
In practice, applications will have to be updated to support the Threads Manager, wh ich is a first step towards preemptive multitasking, something Apple
plans to offer in fu ture operating systems begin ning in 1995 and beyond.
QulckDraw GX

Chapter 10, "The Printing Chapter," discusses ma ny of QuickDraw GX's enhancemen ts to the Mac's printing archi tecture. The following list h ighlights
some of the features:

• Desktop Printers. When you install Q uickDraw GX, your printers will
appear as deskto p icons. You will be able to mon itor the progress of a
print job by double-cl icking the icon, d rag documents from one printer
to another, and cancel a print job by dragging the icon representing
that job to the trash. You also will be able to print a document by draggi ng the document icon to the prin ter icon.

• New Print Dialog. When you use a GX-savvy program, you'll be able to
select the printer you wan t to process th e job fro m a pop-up list-without having to go to the Chooser.

• Electronic Documents. QuickDraw GX's Portable Digital Document feature will allow you to create documents that can be viewed and printed
on any Mac-even if the source program and fonts are not ava ilable.

• Built-in Adobe Type Manager. ATM is included wi th the GX package,
providing clear display of your Type 1 fonts and good prin t quality with
non-PostScri pt printers.
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•

WYSI WYG Color. QuickDraw GX include ApJ-

ogy, which allows precise color match ing from tl.
•

Advanced Ty~ogmphy. Additional character sets and

~{?c tech

keyboards will be supported by QuickDraw GX . Fancy typ. no/.
effects, such as liga tures, fractions, hanging punctuation, ag:!nter.
alignment will be ava ilable when you use fonts and programs tJ .
GX-savvy.
• New Clipboard Format. The drudgery of converting pictures to formats

such as EPS, PICT, or TIFF will be a thing of the past once GX-aware
applications are available. You'll be able to cut and paste seamlessly.
Macin tosh Drag and Drop will provide an added co nvenience in
moving files fro m o ne document to another.
•

Multiple Page Formats. This feature is, in part, already available in

FrameMaker, the high-end docum ent creation program from Frame
Technologies-at least the ability to use both horizontal and vertical
pages within a single document. QuickDraw GX adds the capability to
use multiple page sizes as well.

System 7.5 Installation Strategies
Chapter 37, "Troubleshooting," explains how to perform a full, clean, system
software installation . If you run into trouble with your System 7.5 installati on, try following the steps presented in that chapter. For most System 7.5
insta llations, however, the fo llowing steps should result in an easy transition
to the new Mac operating system:
1. Restart you r Mac by using the System 7.5 Disk Tools floppy d isk.
2. Run Apple's Disk First Aid o n all your available hard drives.
3. If your Mac has an Apple hard drive, use Apple's HD SC Setup to update
your hard drive.
Note
If you have non-Apple hard drives-or your hard drives are formatted with a
non-Apple program-use that program to update your hard drives. Be sure
that the formatting program is System 7 compatible.

4 . Go to the System Fo lder on your startup disk (usually your internal
hard drive) and remove th e System file. Place it in the Preferences folder

System 7.5 Installation Strategies

or, if you don't want to retrieve any fo nts or sounds from it, move it
directly to the trash. Rename your startup disks System Folder to
Storage.
5 . Restart with your System 7.5 lnstallMeFirst floppy disk. The Installer
launches automatically.
6 . Select the Easy Install optio n or, if you wa nt to add or remove System

7.5 features, use the Customize optio n .
7. After installation has finished, pressing the Quit button on the Installer
application window gives you the option to Restart or Shut Down your
Macintosh. Choose Restart.

Note
Apple has updated the Macintosh file system to allow it to support a larger
hard disk volume size. As a result, the desktop files on all of your hard
drives are rebuilt autom atically when you restart. This is a normal process.

8. After you've restarted your Mac, take a litt le time to adjust Control

Panel settings and to launch a few of your favori te programs to make
sure everything is working okay.
9 . If your Mac is running normally, go to the Storage folder and drag over

special applicatio n folders, such as the Aldus or Claris folde rs, to your
newly created System Folder.

Caution

-

Before you reinstall any of your original Control Panels and Extensions,
check Apple's ReadMe that comes with your System 7.5 upgrade package
for late-breaking information on configuring the new operating system and
compatibility w ith existing software.

10. Restore your non-Apple Extensions to the new System Folder in groups

of two or three, restarting each time to make su re they are working
properly before you restore the next batch.
11. If you have any problems using System 7.5, please read Chapter 37,

"Troubleshooting," fo r further help.
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Note
System 7.5 will also be available on a CD-ROM. If your Mac will boot from a CDROM, you can follow the steps we've outlined above in essentially the same way,
except that your Disk Tools diagnostics will be done right from the CD-ROM, and
you will have to double-dick on the Apple Installer program icon to launch it. If your
Mac cannot boot from a CD-ROM drive, you'll need to change your installation
strategy somewhat. In this situation, we suggest you remove or disable all non-Apple
Extensions in your System Folder (other than those you need to run your CD-ROM
drive), reboot your Mac, and insert your System 7.5 CD-ROM disk. Then launch the
System 7.5 installer and proceed with your system installation. If you have any difficulties in getting your new installation to work successfully, make a set of floppy disks
from the disk image files on your CD-ROM disk, using the Apple Disk Copy program
provided, and install from them, following the steps we've outlined above.

From Here ...
This chapter only covered the basics of System 7.5. Throughout this book, a
System 7.5 icon is placed in the margin next to paragraphs containing features that apply to Apple's new operating system.
What makes System 7.5 special is that almost everyth ing wi ll loo k and feel
very close to what you're used to with previous System 7 versions, o nly it will
work faster and smoother. You should be able to make the transition easily
and with few software difficulties.
• lf you run into any problems installing System 7.5, read Chapter 37,
"Troubleshooting." This chapter will help you get over any rough spots
you might en counter.

System 7.5 Overview

Apple Threads Manager
This feature requires a little explanation. The Mac operating system has
what's called cooperative multil'nsking. That means that your active progra ms
share CPU time, with the foreg ro und program (the one you're working on)
getting the lion's share of the attentio n. This sort of thing works most times,
but when your Mac is working on things in the background (s uch as transferring files via modem o r printing), you'll experience sluggish performance
sometimes. Mouse movement will become imprecise. You'll enter text in to a
document and find that the display cannot keep up with you r typing, just to
cover a couple of examples.

Preemptive multitasking gives a program the authority to take over CPU
cycles entirely, if needed. In theory, this creates a more stable worki ng environm ent. A side effect is that if a program crashes for any reason, the o ther
programs you're working on won't necessary be subj ect to crashing too, so
you can continue working without restarting.
In practice, applicatio ns will have to be updated to support the Threads Manager, wh ich is a first step towards preemptive multitasking, something Apple
plans to offer in future operating systems beginning in 1995 and beyond.
QuickDraw GX
Ch apter 10, "The Printing Chapter," discusses many of QuickDraw GX's enhancements to the Mac's printing architecture. The following list highlights
some of the features:

• Desktop Printers. When you install QuickDraw GX, your printers will
appear as desktop icons. You wi ll be able to monito r the progress of a
print job by double-clicking th e icon, drag documents from one prin ter
to another, and cancel a print job by d ragging the ico n representi ng
that job to the trash. You also will be able to pri nt a document by dragging the docum ent icon to the printer icon .
• New Print Dialog. When you use a GX-savvy program, you'll be ab le to
select th e printer you wa nt to process the job from a pop-up list- witho ut hav ing to go to the Chooser.
• Electronic Documents. QuickDraw GX's Portable Digital Document feature will allow you to crea te documen ts that can be viewed and printed
o n any Mac-even if the source program and fonts are not available.
• Built-in Adobe Type Mnnnger. ATM is included with the GX package,
providing clear display of your Type 1 fonts and good print quality with
non-PostScript printers.
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•

WYSIWYG Color. QuickDraw GX includes Apple's ColorSync techno logy, which allows precise color matching from the screen to the printer.

•

Advanced Typography. Add itional character sets and foreign language

keyboards will be suppo rted by QuickDraw GX. Fancy typographic
effects, such as ligatures, fractions, hanging punctuation, and optical
alignment will be ava ilable when you use fonts and programs that are
GX-savvy.
•

New Clipboard Format. The drudgery of converting pictures to formats
such as EPS, PICT, or TifF wi ll be a t hing of the past once GX-aware
applications are available. You'll be able to cut and paste seamlessly.
Macintosh Drag and Drop will provide an added convenience in
moving files from one document to another.

•

Multiple Page Formats. This feature is, in part, already available in

FrameMaker, th e high-end document creation program from Frame
Technologies-at least the abi lity to use both horizontal and vertical
pages within a single document. QuickDraw GX adds the capability to
use multiple page sizes as well.

System 7.5 Installation Strategies
Chapter 37, "Troubleshooting, " explains how to perform a fu ll, clean, system
software installation. If you run into trouble with your System 7.5 installation, try following the steps presented in that chapter. For most System 7.5
installations, however, the following steps should result in an easy transitio n
to t he new Mac operating system:
1. Restart your Mac by using the System 7.5 Disk Tools floppy disk.

2. Run Apple's Disk First Aid on all your available hard drives.
3. If your Mac has an Apple hard drive, use Apple's HD SC Setup to update
your hard drive.

Note
If you have non-Apple hard drives---<>r your hard drives are formatted with a
non-Apple program-use that program to update your hard drives. Be sure
that the formatting program is System 7 compatible.

4 . Go to the System Fo lder on your startup d isk (usually your internal

hard drive) and remove the System fi le. Place it in the Preferences folder
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or, if you don't want to retrieve any fonts or :;ounds from it, move it
directly to the trash. Rename your startup disks System Folder to
Storage.
5. Restart with your System 7.5 InstaJJMeFirst floppy disk. The Installer
launches automatically.
6 . Select the Easy Install option o r, if you want to add or remove System

7.5 features, use the Customize option.
7. After installation has finished, pressing the Quit button on the Installer
application window gives you the option to Restart or Shut Down your
Macintosh. Choose Restart.

Note
Apple has updated the Macintosh file system to allow it to support a larger
hard disk volume size. As a result, the desktop files on all of your hard
drives are rebuilt automatically when you restart. This is a normal process.

8. After you've restarted your Mac, take a little time to adjust Control
Panel settings and to launch a few of your favorite programs to make
sure everything is working okay.
9 . If your Mac is running normally, go to the Storage folder and drag over

special application folders, such as the Aldus or Claris folders, to your
newly created System Folder.

Caution
Before you reinstall any of your original Control Panels and Extensions,
check Apple's ReadMe that comes with your System 7.5 upgrade package
for late-breaking information on configuring the new operating system and
compatibility with existing software.

10. Restore your non-Apple Extensions to the new System Folder in groups
of two or three, restarting each time to make sure they are working
properly before you restore the next batch.

11. If you have any problems using System 7.5, please read Chapter 37,
"Troubleshooting," for further help.
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Note
System 7.5 will also be available on a CD-ROM. If your Mac will boot from a CDROM, you can follow the steps we've outlined above in essentially the same way,
except that your Disk Tools diagnostics will be done right from the CD-ROM, and
you will have to double-click on the Apple Installer program icon to launch it. If your
Mac cannot boot f rom a CD-ROM drive, you' ll need to change your installation
strategy som ewhat. In this situation, we suggest you remove or disable all non-Apple
Extensions in your System Folder (other than those you need to run your CD-ROM
drive), reboot your Mac, and insert your System 7.5 CD-ROM disk. Then launch the
System 7.5 installer and proceed with your system installation. If you have any difficulties in getting your new installation to work successfully, make a set of floppy disks
from the disk image files on your CD-ROM disk, using the Apple Disk Copy program
provided, and install from them, following the steps we've outlined above.

From Here ...
This chapter o nly covered the basics of System 7.5. Throughout this book, a
System 7.5 icon is placed in the margi n next to parag raphs conta in ing features that apply to Apple's new operating system.
What makes System 7. 5 special is that almost everything will look and feel
very close to wh at you're used to with previous System 7 versions, only it will
work faster and smoother. You should be able to make the transition easily
and with few software difficulties.
• If you run into any problems installing System 7.5, read Chapter 37,

"Troubleshooting." This chapter will help you get over any rough spots
you might encounter.

Chapter 5

Understanding the
Desktop and Fi nder
by Chris Oakes

The Finder appea rs o n-screen each time you turn o n your Macintos h. Its
main purpose is to make it easy fo r you to manage the files you create with
your applications (such as a word processor o r a spreadsheet program).
This chapter explains the major elem en ts of the Finder. These elementswindows, icons, men us, and fo lders-a re simple to understand, and quite
powerfu l in helping you manage your work. By the end of the chapter, you'll
understand the following concepts and procedures:
• Where the Finder fits into your Macintosh work
• The d ifference between applications and documents
• What Icons represent
• Folders and Files
• The pa rts of the Macintosh window
• Poin ting, clicking and dragging with the mouse
• How to use a menu
• How to use Macintosh Guide and Balloon Help
Once you understand these fundamentals of the Finder and the desktop,
you'll be ready to learn how to o rganize your files, folders, and disks-the
topic of Chapter 7, "Organizing Your Files, Folders, and Disks."
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To help you better understand the Finder's wo rkings, watch a demonstration
of a basic Finder task: opening a d ocum ent. This procedure involves many
commonly used Finder elements and provides a context for the specific features covered later in the chapter. Before the demonstration of using th e
Finder to open a document, you should become familiar with o ne concept:
the d iffe rences between applications, docum ents, and files.

Applications, Documents, and Files
An application is a software program, such as a word processor or finan cial
spreadsheet, that applies the ca pabilities of the computer to a specific functio n. Som etimes, applicati o ns are refe rred to as programs, or software. The
word processing application Microsoft Wo rd was discussed in Chapter 4.
When you use an applicatio n to create and edit text, sound, pictures o r o ther
types of information, you crea te and edit a document, which serves as a conta iner for the information. Collectively, documents and applications are often referred to as files. "File" is also often used to refer to a document (see
note).
Note
Files, in the plural form, is often used to refer to a group of Macintosh items. A group
may consist of both documents and applications, as well as other types of fi les that
may reside on a Macintosh disk. File and document are often used interchangeably. In
Chapter 4, the term file was used throughout to keep the concepts simple, but the
more specific term f()r a file created by an application is document.

Demonstration: Opening a Document
The docum ent in this demonstration was created by the application
TeachText. The name of th e document is Read Me. It resides inside a folder
on the hard disk ca lled Macintosh HD. The hard disk appears in the upper
right corner of figure 5.1.

Demonstration: Opening a Document
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Note
The names of items in this demonstration, including the names of fo lders, the document, and the name of the hard disk, are just examples. They do not necessarily
match the names of items on your own hard disk. Nonetheless, the procedures used
in the demonstration apply to all documents, folde rs, and disks, regardless of their
actual names.

Fig. 5.1
The Macin tosh
Finder. The
Macintosh hard
disk is represented
by Macintosh HD,
displayed in the
upper right corner.

To access t he fo lder that contains the document, you need to open the hard
disk by selecting the hard drive and choosing the Open comma nd. The same
procedure is used to open the folder-and finally, the docu ment. The fo lder
containing Read Me is called Apple Files. The following s teps o utline the
procedure.
1. Using the mouse, click on th e ha rd drive to select it. When the hard

drive has been selected, the hard disk becom es darkened. In Macintosh
term s, the object is said to be lliglllig!Jted, as shown in figure 5.2. (Over
the hard disk icon, you see the arrow cursor used to select it. You learn
more abou t the cursor and the mouse later in this chapter.)

11
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Fig. 5.2
Once selected,
Macintosh HD
becomes highlighted.

2. From the File menu, choose the Open command. The hard drive window opens (the box entitled Macintosh HD in fig. 5.3). The open window contains a folder named Apple Files. Because the document you
want to open is inside this folder, you need to open Apple Files next,
just as you opened the hard drive.
3. Select the Apple Files folder and then choose Open from the File menu,
as shown on the left side of figure 5.3. The Apple Files window opens.
This window contains the document Read Me, which is the one you
want to open.
Fig. 5.3
The Macintosh HD
wi ndow and the
Open command,
selected from the
File menu.

4. Using the mouse, select the document Read Me. The document is high-

lighted.
5. From the File menu, choose the Open command. Figure 5.4 shows the
document selected in the Apple Files window. A pause occurs while the
application that created the document launches-TeachText, in this
case. After TeachText launches, the document's contents appear in a
TeachText window (see fig. 5.5).

Demonstration: Opening a Document
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Fig. 5.4
" Read Me" is
selected, and the
Open com mand is
chosen .

ii File Edll
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you need

AppleSh~:~re

server softwere verslon 3 0. 1

APPLE lie CARD SOFTWARE FOR THE MACINTOSH LC II

~

To use the Apple lie Cord Wllh System 7 I on o Moe Intosh LC II, you need version 2 2 of
Apple l ie Cord Soilwore Vou should upgrode to version 2 2 only If you ere using your LC
II with System 7.1. Apple lie Cord Soil ware 2 2 mey elso be used with the origlnel
Moclntosh LC, butll is not required.
You cen obtain the upgreoe package from en euthonzea Apple Reseller In the Un1ted
Slates, you con call the Apple Customer Asslstonce Center ot (BOO) 716 -2333 to
request Appl e lie Cord Soil wore version 2 2 The new soil wore Is olso evalloble on
Applellnk (AppleLink poth Apple Products Apple II: Apple 11 Product Information,
Apple lie Cerd)

INSTALLING SYSTEM 7 I ON A MACINTOSH CUADRA 700 AND 950
To ins toll System 7 I on o Macintosh Cuedro. use the lnstoller progrem"s Eosy Install
option, or choose "Sustem soil were f or enu Macintosh" In the lnstoller's customize
wlnoow If you use the Meclntosh Quodro option 1n the Cu stomize window, some ports

By carrying o ut th is simp le actio n, you have wi tnessed many of the r:inder's
featu res in act ion. A d isk and folder were selected and opened, displaying
windows. A menu command was chosen . Objects were selected with the
mouse. In the rest of t he chapter, you learn what these things are and how to
manipulate them by using the mouse.

Fig. 5 .5
The contents
of the Read Me
document, as seen
in a window in the
appl ication
TeachText.
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The Finder and Its Contents
The preced ing procedure may have seemed natural enough, but if you th in k
about it a little, you might wonder where it all took place. Until the final
step, you weren 't in any application, such as a word processor or a database
program. You weren' t choosing from a sim ple list of fi les or respo nding to a
blinking comma nd prompt. You were just in that "place" first pictured in
figure 5.1.
One of the advantages of the Macintos h is that you do n't have to be in a
specific application to be "somewhere." The designers of the Macin tosh
d idn 't wa nt you to turn on you r computer o nly to be faced with a blan k
screen that waited fo r you to type a command. Th ey made su re that you were
somewhere right away. That somewhere is the Macintosh Finder.
Technically, the Finder is an application. This particular application serves as
a place fo r you to organize and contro l your Macintosh disks, documents,
and o ther applications. The Finder is also a place where you can get your
beari ngs. You can visually perceive the things that reside on your Macintosh
and then decide what you wa nt to do with them . Th is visual o rien tation of
the Finder is central to the Macintosh's famous graphical user in terface. Fo r
the first time, the Maci ntosh Finder gave th e person al computer user a recogn izable, visual enviro nment with which to start working.
Working on the Mac really is not much different than sitting down and
worki ng with the thi ngs on th e top of a desk. That's why the gray area below
the menu bar is called th e desktop. It's also why organizing and manipulating
the disks, folders, and files that reside o n the deskto p is known as desktop
management. This fam iliar scene greets you every time you turn on your
Macintosh.
Not o nly do you find your documents, applications, and disks in the Finder,
but you also find a sense of comfort in knowing where you are and what is
on your Macintosh. In this way, the Finder is li ke you r Macintos h ho me. As
you learn and use your Macintosh, you'll become com for table and reassured
by the Finder, just as you are by yo ur real hom e.

The Finder and Its Contents

What the Finder Is For
The Finder's main function is to provide a location for you to manage your
desktop: where you o rganize and control your disks and the assorted documents and applications you have on them. This process is commonly referred
to as file management. The following are tasks you can accomplish with files
and disks in the Finder:
• View which files are on your hard disk and floppy disks
• Copy files fro m on e disk to another
• Create new places to keep files (called folders)
• Move files to different places on the disk
• Erase files trom disks
• Erase entire disks and reformat them, which enables you to use them all
over again
• Assign special labels to files, indicating such properties as priority and
purpose
• Obtain special information about files, such as their size, when they
were created, and when they were last modified. You can also see which
application created a document fi le.
• Search for files
Those tasks are the primary file management features of the Finder. You also
can perform the following tasks, which don't fall under the file management
category:
• Launch applications and open docum ents, as shown in the demo nstratio n at the beginning of this chapter
• Access special Macin tosh applications and features contained in the
Apple m enu, which is indicated by the little apple picture in the upper
left of the menu bar.

~

See "The
Finder as File
Cabinet,"
p. 110
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Although these lists tell you what the Finder does, you still may not be fa miliar with some of the terms. The following sections examine th e elements of
the Finder in detai l.

System 6 Differences

·

All new Macintoshes run on System 7.0 (or later versions), but some older Macs run
on a version of System 6.0, such as 6.0.4 or System 6.0.8. Many differences exist
between System 7 and System 6, but in keeping with Macintosh interface consistency, they appear and behave in much the same way.
One difference in the System 6 Finder is the absence of the Label menu. Also, color
Macs running System 6 might show a Color menu to the right of the Special menu.
This menu enables you to change the color of a selected object.
Another difference is a less visual one. In System 7, when you deposit files in the
Trash can, they are still there the next tim e you turn on your Macintosh. In System 6,
these files are regularly deleted by the Macintosh-such as when you launch an
application or shut down your Macintosh.

Icons: Representing Files, Folders, and Disks
When you first turn on your Macintosh, you usually see only two objects
on the desktop: the hard disk and the Trash can. These objects are the two
objects visible in figure 5.1. But what are these objects? The little picture
called the hard disk, for example, is not the physical hard disk th at contains
your fi les. The actual hard disk is located inside your Macintosh case. And the
Trash can is not really a trash can but just a picture of a trash can.
You have seen tha t these objects are more than just images. To be fair, they
have plenty of substance to them. You have opened the hard disk and
worked with its files. These files had real contents in them. As you may have
guessed, the images represent actual ob jects. When you do something to the
images, it happens to the objects they represent. The official name for these
images is icons, and they are as important to the graph ical Macintosh interface as windows and men us. They are ano ther way for you to see, and
thereby easil y manipulate, the objects that reside on your Macintosh. Figure
5.6 shows and table 5.1 describes common Finder icons and the objects they
represent.

The Finder and Its Contents
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Table 5.1

Icons and Their Meanings

Icon

What It Represents

Disk icon (1)

An entire hard disk or floppy disk.

Trash icon (2)

File deletion. Files in the Trash w ill be "thrown away" or
deleted.

Folder icon (3)

A container, like a real cardboard folder, for other folders
and files.

Application icon (4)

A Macintosh application, such as a word processor.

Document icon (5)

A M acintosh document, such as a letter. It can also
represent special files that make the Macintosh system
work. Document icons often have the markings of the
application that created them.

Folders and Files
Cha nces are, you are already familiar with folders. just like manila fo ld ers,
Macintosh folders can contain artwork and photographic documents. Any
type of Macintosh file, including applications, ca n reside in a folder. j ust as a
file is a container of text and pictu res, a folde r is a container for Macintosh
files. And like a file, a fo lder can be opened and closed.
You can create and name a folder and put it anywhere in the Finder.
Macintosh fo lders commonly contain docum ents. For exam ple, you can keep
you r letters home in a folder called Home Letters. You can keep monthly
sales-related documents in a fo lder called january Sales Documents. And
better yet, you can put that folder inside another folder called 1994 Sales
Documents. As you can see, a folder in the Macintosh Finder is not much
d ifferent from the m anila folders you keep in your file cabinet.

.,.. See "Creatin g
a New Folder,"
p. 114
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The Window
So far, you have learned abo ut several elements of the Finder- icon s, files,
and folders. This section discusses the Finder window.
If you have read all of Part II so far (Chapter 4 and the fi rst part of this chapter), you have already had quite a bit of exposure to Macintosh windows. As
you learned in Chapter 4, windows are one of the key ingredien ts in the
Macintosh's in terface consistency.
..,.. See "Viewing
Files and
Folders,"
p. 122

In an application, a window displays the contents of a fi le. In the Finder, a
window displays the contents of a d isk or folde r.
There are several parts of the window that let you control its size, position,
and other characteristics. Figure 5. 7 identifies these parts and the following
list describes them:
•

Title bar. The bar along the top of th e window is called the title bar

because it contains the window's title. To move a window, you click
anywhere on the title bar and then drag the image to a new location.
•

Close box. The small box at the left end of the title bar is the close box.

Clicking in the close box closes the window, making it disappear from
the desktop until you reopen it.
•

Zoom box. At the other end of the title bar is a box with a smaller box in

its corner. This box is called the zoom box and is used to maximize and
reduce the size of the window o n the desktop.
•

Size box. The double box in the lower-right-hand corner of the window

is the size box. It enables you to stretch and shrink the window to any
size you want.
•

Scroll bars. The shaded bars along the right and bottom edge of th e

window are the scroll bars. If you click the arrows at each end of the
scroll bars, the currently invisible areas of the window come into view,
while visible areas move o ut of view. Alternatively, the box inside the
scroll bar (called the scroll box) can be moved to scroll left o r right, up or
down. (In the Finder and most applications, if an entire window's contents are already visible, the scroll bars are made inactive. Inactive scroll
bars do not show the gray shad ing and scroll boxes that appear in
active scroll bars.)

The Mouse: Your Virtual Ha nd
In order to manipulate (select, move, copy, and delete) the objects in the
Finder, you need to know how to use the mouse. After you learn how to use
the mouse, you will use it to manipulate the final element of the Macintosh
Finder: the menu.
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The Mouse: Your Virtual Hand
Imagine that the Macintosh desktop were an actual desktop. To move an
object, you would just reach out your hand, grab the object, and move it. Use
a "virtual hand" to manipulate objects on the desktop-the mouse controls
the arrow pointer on-screen.
You move the mouse, the small rolling unit with a cord like a mouse tail,
around your actual desktop. Its position and movement are matched on the
Macintosh screen by the small black arrow pointer. When you move the
mouse, the arrow moves to reflect the movement. Move the mouse left, and
the arrow moves left. Move the mouse straight away from you and the cursor
moves upward on the screen. Any direction you move the mouse is matched
by the movement of the arrow. If you're unfamiliar with these motio ns, a few
minutes of fiddling will make you comfortable with mouse movements.

Pointing, Clicking, and Dragging
Positioning the arrow over a desired object is called pointing at the object.
Suppose that you poin t to an object in the Finder, such as the hard disk, and
want to manipulate it. As you saw in the demonstration, to manipulate an
o bject on-screen, you first must select it. After you point at the object, you
press the mouse button to select it. The mouse button is located on the top of
the mouse, at the end where the cord is connected. To select an object with
th e mouse then, point at the object, and then press mouse button once. This
is called clicking o n the object.

77

78

Chapter 5-Understand ing the Desktop and Finder

As on a real desktop, you can move objects on the Finder's desktop. You may
want to move an object into the Trash, for example.
Figure 5.8 shows the Trash can after it has been moved from its home in the
lower right corner to the middle of the desktop.
To drag an ob ject, use the mouse to click the object, and then hold the mouse
button down. When you move the mouse around, an outline of the object
stays with the cursor (as if it's "in your hand") . When you release the mouse
button, the object appears at the new place on the desktop.
Fig. 5.8
The Finder's Trash
can has been
dragged to the
middle of the
desktop.

There is an interesting variation on the ubiquitous mouse-click. It is the
double-cli ck. A double-click consists of clicking on an icon two times quickly.

This unique action h as the same effect as selecting the icon of any disk,
folder, document or application and choosing the Open command from the
File menu. Many people find double-clicking a nice shortcut for the Open
command, because it reduces several steps to one. Try it-you just might
like it!

The Mouse: Your Virtual Hand
Note . .

,.

·
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Double-clicking is used as a shortcut in Macintosh applications, as well. It's used in
dialog boxes, for example, such as the Open and Save As dialog boxes accessed
within applications. Double-clicking a file or folder in an Open dialog box has the
same effect as in the Finder-it opens the item in one easy step. In fact, doubleclicking is often incorporated into certain features of applications. A lot can be discovered in some applications by "double-clicking your way around." Tool palettes and
icon bars are often good candidates for double-clicking short-cuts. If in doubt,
double-click-you just mig ht learn something new! (Use caution to make sure your
actions won't affect any important document data.)

As you can see, the mouse is a crucial part of using the Macintosh. Before
long, it will feel li ke a natural extension of your own hand. Some practice will
get you comfortable with this virtual hand in no time. Having lea rned the
simple ways of th e Macintosh mouse, you're now ready to see how it's used
to choose a menu command.

Choosing a Menu Command
In both Chapter 4 and in the demonstration at the beginning of this chapter,
menu commands were used to m anipulate objects-to open documents,
launch applicati ons, and copy and paste text. In all cases, the mouse was used
to issue these commands. We'll now look at th e exact procedure for choosing
commands.
To use a menu command, you select it with the mo use. But first you need to
click the menu. When you do so, the menu wi ll appear, but disappear aga in
as soon as you release the mo use button. To keep the menu visible, therefore,
you simpl y hold the mouse button down.
Suppose that you want to select the Open command from the File menu, the
left-most word on the menu bar. You would follow these steps:
1. Poin t and click anywhere on the word File in th e menu bar, holding the
mouse button down after you click. As seen in figure 5.9, a list of commands appears.

Tip
If you have any

problems doubleclicking, you may
need to adjust the
speed. Simply
open the Apple
menu, choose
Control panels and
Mouse. Select one
of the three speed
options available.
The space between
the arrows corresponds to the time
between clicks.
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Fig. 5.9
The Finder's File
menu, after it has
been selected with
the mouse.
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2. Move the cursor down the menu. When you pass over the available

commands, they are highlighted (the command turns white, and the
background turns black). The Open command is shown highlighted in
figure 5.10.
Fig. 5.10
The File menu's
Open command
has been highlighted.
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3. To select the Open command, release the mouse button when the com-

mand is highlighted. The menu blinks, and the selected object opens.
This procedure is applied to any menu selection. After a little practice, choosing menu commands is easy. If you get confused about how to use the
mouse while reading on in the book, just come back and review these simple
procedures.

Using Macintosh Guide and Balloon Help

Table 5.2

Elements of the Finder

Finder Elem ent

What It Does

Icon

Represents a Macintosh application, document, folder, or
disk

Disk

A container for Macintosh files; like a file cabinet

Folder

A categorized container for Macintosh files; Like a manila
folder

Application

A Macintosh program, such as a word processor

Document

A file created with an application; may contain text,
pictures, sound, or video

Window

Displays the contents of a disk or folder

Menu

Displays a list of selectable commands

Trash Can

Holds files you want to throw away

Using Macintosh Guide
and Balloon Help
This chapter's in troduction to the Finder and the desktop helps you gain a
general understa nd ing of the Finder and its various features. The Macintosh
itself ca n help you ta ke this understanding fur th er with a remarkable new
feature included in System 7.5. This feature helps both n ovice and inte rmediate users learn specific tech n iques and concepts relating to the Fi nde r and t he
Macintosh in general. It's called Macintosh Guide.
Whi le System 7.0's buil t-in h elp system, Balloo n Help, h elps you identify
simple Finder fea tures such as icons, menus, and parts of a Macin tosh window, Macintosh Guide goes much furt her by actu ally showing you how to
accomplish specific Finde r tasks.
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Note
To use System 7.0's and 7.1 's Balloon Help, from the Help menu (indicated by the
question mark icon at the right end of the menu bar), choose Show Balloons. Then,
by simply pointing at various items in the Finder, such as icons and menus, you see
informational text contained in small speech balloons (see fig. 5.11 ). Some
Macintosh applications support Balloon Help, too. You turn Balloon Help on in an
application the same way as in the Finder. With Balloon Help active, you can continue to use your Macintosh as usual-balloons will appear and disappear w ithout
getting in your way. The balloons provide basic information about what each particular Finder element is for and how to use it. To turn off Balloon help, from the Help
menu, choose Hide Balloons.
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Macintosh Guide tells you how to perform a tas k, and then actually helps
you complete the task by guiding you to the menus, icons, and oth er elements that the task might involve. The Macintosh circles these elements
much like you'd circle items on a piece of paper using a highlighting ma rker.
(Refer to figure 5.12.) It also guides you by underli ning key me nu items. If
you have a color monitor, it wi ll also make these menu items appea r in red.
The Guide waits patientl y by while you perfo rm each step of a particular task,
and then guides you on to the next step.
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Fig. 5.12
Macintosh Guide
indicates menus
and other items
involved in a task
by actually
marking the item
with a thick circle.
The Apple menu
icon is circled
here.
Jt you know the contrcl ~el you want, you
can c et quick access to lt 'uych(X)Sm& its name

from the submenu to the rlKht ot Control
hnels in the Apple menu. Move the potnter to
Control Panels# then move it to the rf&ht and
dra& up or dawn the hst to the item you wut
to use.

You access Macintosh Guide using the same menu used to access Balloon
Help in early versions of System 7 (see note), although this menu's icon is
now yellow and red in color. In fact, Balloon Help remains available in the
same menu.
To access Macintosh Guide, from the Help menu (indicated by the question
mark icon on the right end of the menu bar), choose Macintosh Guide. The
Macintosh Gu ide window then appears on your screen (see fig. 5.13) You can
view help information by Topic, by Index subjects, or by having Macintosh
Guide look for the information for you. A button for each of these options
appears at the top of the Macintosh Guide window, as seen in figure 5.13.
Click o nce on one of these buttons to make your choice.
Fig. 5.13
Information
viewed by Topic in
Macintosh Guide's
open window.
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Viewing by topic is li ke perusing the table of contents in a book. The main
topic headings appea r in the list on the left, while subheadings fo r each topic
appear on the right. To bring up a topic and its associated subheadings, simp ly click once on the topic's name in the list o n the left. The su bheadings will
appear in the list o n th e right. (There may be a short pause before the subheadings appear.) To have Macintosh Guide show you the steps involved in
one of these subheadings, click on the subheading once and then click the
button marked "OK," which appears in the lower-right of the Macintosh
Guide window. Alternatively, you can simply double-click on the subheading
in the list. To view any additional items in either list, use the scroll arrows in
the scroll bar to the right of the list.
If you know the specific topic you want information about, such as "active

window," "copying," or "desktop," click the "Index" button. It causes an
alphabetical list to appear on the left, much like a book's alphabetical index.
Click one of the items in the list to see its associated subheadings, which
appear in a list on the right (see fig. 5.14). To choose a subheading, once
again you click on the subheading and click the "OK" button-or simply
double-click the subheading. The horizontal bar with the letters of the alphabet at the top of the index list on the left will let you quickly change the
alphabetical letter of the topics that are listed (see fig. 5.14). To quickly move
to topics beginning with the letter "G" simply click on "G" in the slider bar.
If the letter you want doesn't appear o n the bar, click on the last letter o n the
right (or left) and drag your mouse to the right (or left) while holding the
mouse button down. More letters of the alphabet wil l come into view.
Fig. 5.14
Macintosh Gu ide
subjects as seen
after clicking the
Index button.
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If you want Macintosh Gu ide to look for a specific topic, such as "window,"
click the "Look For" button. After you click this button, a small space is provided where you ca n type the name of the top ic to look for (see fig. 5.15).
Once you've done so, click the "Search" button. After a short wait, a list of
subheadings appears in a list o n the right. To choose one of them, click on
the subheading and click the "OK" button, or just double-click on the subheading.
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Once you've chosen the desired subheading using any of these methods,
Macintosh Guide will lead the way from there. Simply read the definitions or
step-by-step instructio ns provided in each info rmational window. Yo u'll find
Macintosh Guide very easy to use and learn.
Note
If you're still unclear about how to use Macintosh Guide, you can have Macintosh
Guide itself provide you with more tips on how to use it. Simply use the "Look For"
button to search for the subject "Guide," Macintosh Guide will appear in the list on
the right. Double-click on it and Macintosh Guide will soon be telling you a little bit
more about itself. (Talk about self-help!)

window allows
you to search for
topics by keywords, such as
" window. "
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Chapter 5-Understanding the Desktop and Finder

From Here ...
In this chapter, you lea rned about the main elements of the Macintosh
Finder and desktop. Upcoming chapters contain more Finder information.
See the following chapters to learn h ow to manipulate and organize the
Finder's files and to learn about special versions of the Finder, System 7, and
System 7.5.
• Chapter 4, "What's New in System 7.5," highlights some of the special
new features of the Finder and the Macintosh in general with the intro duction of System 7.5.
• Chapter 6, "Using System 7 for the Performa and At Ease," shows you
the special features contained in System 7 on Performa Macin tosh models. It also covers the special file management utility, "At Ease."
• Chapter 7, "Organi zing You r Files, Fold ers, and Disks," shows you how
to carry o ut common Finder tasks, and how to use these tasks to organize your files, fold ers, and disks.

Chapter 6

Using System 7 for the
Performa and At Ease
by Kay Nelson

You may be using a specia l kind of Macintosh called a Perfo rma. Performas
are sold in retail stores such as Sears and Circuit City instead of at Apple dealers. A Performa has the same hardware as a regular Macintosh; the difference
between it and other Macs is that it uses a slightly modified operating system
called System 7.P that makes it easier for new users to find their way around.
A Performa usually comes with several different programs already installed on
the mach ine so that new users do n't have to worry about installing software.
This chapter h elps you understand the differences between the Performa and
o th er Macs. You learn the following:
• How to launch programs on a Performa
• How to save documen ts
• How to switch between programs
• How to back up the software that came with your Perfo rma
• How to set up and use At Ease
There are two major differences in the ways you use the Perfo rma's operating
system and the standard System 7:
• You normally launch programs from a special window called the
Launcher that appears when you start your Performa.
• You save documents in a special Documents folder, which makes it easy
to locate all your documents.
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One other difference that expe rienced Mac users wi ll note is that the
Perform a shows you only one program at a time, even if you have several
running. This makes it easy for new users to switch from one run ni ng program to another.
This cha pter assu mes that you know the basics of how to get around on a
Macintosh, such as double-clicking, choosing items from m enus, and opening and closing windows.

Using the Launcher
When you first start your Perfor ma, you'll see a special window called the
Launcher on your desktop (see fig. 6.1). The icons in it represent programs
that were already installed on your Performa, so the o nes you see in figure 6. 1
may not match what you see on-screen, depend ing on which programs you
have. You can add programs to the Launcher or remove them from it, as
you 'll see Ia ter.
Fig. 6.1
The Launcher
appears when you
start a Performa.

Documents
fold er

Launcher
icon

Size
box

To start a program, all you have to do is click its icon in the Launcher window. You'll hear a click, and then the program will start. If the La uncher
window isn't active (with stripes in its title bar), you have to click in its window twice-once to activate the Launcher wi ndow and then again to start the
program yo u' re launching. Here's how to work in the La uncher:

Adding and Deleting Prog rams

• Scrolling in the Launcher. If there are m ore programs sto red o n your
Perfo rma than the Launcher window can display, you ca n scro ll with
the scro ll arrows o r scroll box to see the other programs.

• Resizing tile Launcher. You can also resize the Launcher window. Drag
th e size box in the lower right corner inward to make the window
smaller or outward to make it larger.

• Closing tile Launcller. If you want to close the Laun cher window to get it
out of your way, click its Close box or press
active.

~-W

wh en that window is

Note
You'll also see icons for the Launcher and for a Documents folder on your
desktop. If you close the Launcher window and need to open it again, doubleclick that Launcher icon on the desktop.

• Arranging tile Launcher Window. You can move the Launcher window
around o n your desktop by dragging it by its title bar. If you'd rather
always have it stacked o n one side of the desktop when you start your
Performa, select Vertical from the View menu.

Adding and Deleting Programs
When you work with your computer system, you'll wa nt to add and delete
programs. With the Launcher, adding and deleting programs is easy.

Adding a Program
You need to add any new programs you buy to the Launcher. You can make
an alias (see Chapter 5) of the program so that the o riginal p rogram icon
stays in its o ri ginal folder. Follow these steps:
1. Install the program according to the manufacturer's instru ctio ns. Norma lly, you'll double-click an Installer icon that's o n th e disk the program comes o n. Then follow the instructions o n-screen.
2. When the program has been insta lled, locate its icon on your hard d isk.
It wi ll probably be in a folder that has the same nam e as t he progra m . If
you install ClarisWorks, for exa mple, look for a fo ldername ClarisWo rks, followed by a version n umbe r. You can use the Find command
on the Finder's File menu to find the fo lder; ~ -F is t he sho rtcu t.
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3. Click the program icon to select the folder. From the File menu, choose
Ma ke Alias. Drag the alias to the desktop and then to the Launcher
Items folder in the System Fo lder (see fig. 6.2).
Now your program appears in the Launcher when you start the Performa.

Flg. 6.2
Make an alias of
an y new programs
you get and drag it
to t he Launcher
Items folder in side
the System Folder.

Drag Alias to Launcher Item s folder

ClarisWorks Alias

Note
You can't drag icons to the Launcher window. The buttons in the Launcher window
represent the programs that are in the Launcher Items folder in your System Folder.
You could drag the original icon of a program to the Launcher Items folder if you
wanted, but using aliases enables you to keep the original icon of the program in the
folder with its other program files.

Deleting a Program
To delete a program from the Launcher, drag its icon out of the Launcher
Items fo lder in the System Fo lder. If you' re deleting an alias (its name will be
in italics), you can drag it to the Tras h and get rid of it. If you're deleting an
original program icon , drag it to the desktop and use the Put Away command
(:l=e-Y) on it to put it back where it cam e from .

Working with Documents
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Working with Documents
The Documents folder on a Performa normally holds all the documents you
create. Whenever you save a document, the Performa automatically opens
the Documents folder for you to save it in. That way, beginners can easily
find all the documents they create without looking through a series of folders
for them. There may be other documents that are stored in folders that come
with programs when you install them, so each and every one of your documents may not be in that Documents folder. All the documents you save will
be stored there, un less you take extra steps to store them elsewhere. You'll see
how to do that soon.

Opening Documents
You can open documents in the following two ways:
• By double-clicking a document's icon in the Documents folder

II

• By opening a program's File menu and choosing the Open command
(~-0)

If you use the Open command in a program, you'll be taken to the Docu-

ments folder. just double-click the name of the document you want (see fig.
6.3). The dialog box you see may be slightly different from the one in figure
6.3, depending on the program you're using. This dialog box is for
ClarisWorks.
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If the document you want isn't in the Documents folder, you may need to
look for the folder that it is in. You can click any folder icons in the list to
open them. Click the Desktop button to the right of the list to go to the desktop. Then doubl e-click the name of your hard disk to open it and see the
folders that are stored on it. You can keep opening folders until you find the
document for which you're looking.

Fig. 6.3
Document icons
look like small
pages with o ne
corner turned
down.
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Note
Click the Documents folder name at the top of the dialog box. You'll see Desktop
listed at the bottom of the hierarchy of folders that lead to the folder you're in. Drag
to Deskt op and release the mouse button to go to the desktop. You can also click
the tiny icon next to the name of your hard disk, just to the right of the list in an
Open dialog box, to go to the desktop.

Saving Documents
On a Perform a, whenever you usc a program's File menu's Save As command,
you are taken to the Documents folder to save your document (see fig. 6.4).
(When you choose Save, the document is saved in whichever folder it was
previously saved in.)
Fig. 6 .4
Other programs'
Save As dialog
boxes may look a
little different
from this one
from ClarisWorks,
but they all work
basically the same.
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Note
The first time you save a document, no matter whether you use the Save ()::(-S) or
Save As command, you are taken to the Save As dialog box because the document
doesn't have a name yet.

just start typing to replace the name Untitled; then click Save or press the
Return key. If a documen t with the same name is already in the Documents
folder, you are asked whether you want to replace it with the document
you're saving now. Be sure to give each document you save a unique name so
that you don't mistakenl y replace something you want to keep with something else.
Saving Into a Different Folder

You may not always want to save documents in to the Documents folder, but
it's a good idea to do that if you' re a beginner. You can save a document into
a folder other than the Documents folder in the following ways:

Working with Documents
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• Double-click any folder listed in the Documents folder to open it, and
then save the document in it.
• Click the Desktop button to go to the desktop, where you can doubleclick the name of your hard disk (Macintosh HD in the list in figure 6.5)
and then open any folder on your hard disk and save the document in it.
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You can also save a document onto a floppy disk, as discussed later in this
chapter.
Note
When you become accustomed to your Performa and get more experienced, you
may not want to save all your documents in the Documents folder any more. All you
need to do is change the option in the Performa control panel (see the "Using the
Performa Control Panel" section later in this chapter) or rename the Documents
folder, and the Performa's operating system won't automatically take you there any
more.

Saving a Document under Another Name

To save another version of a document you've already saved, or save the same
document under another name so th at you have two co pies of it, choose Save
As from the File menu and give the document a different name.
Note
You can use the Finder's Duplicate command (l:l:-D) to make a copy of a file. Using
this command is often faster than using the Save As command and renaming the
document. The Finder will automatically add copy to the end of the document's
name so that you know exactly what it's a copy of, instead of trying to remember
which names you gave it and its copy.

Fig. 6.5
Double-click the
name of your hard
disk to open it and
save documents
on it.
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Saving onto a Floppy Disk

Sometimes you may want to save a document onto a floppy disk so tha t you
can take it with you, keep a backup copy of it, o r give it to somebody else. To
save a document onto a floppy disk instead of onto your hard disk, if you' re
running a program, follow these steps:
1. Insert the floppy disk in yo ur disk drive.
2 . from the program's File menu, choose Save As.

3. When you see the Save As dialog box, click the Desktop button. Notice
in figure 6.6 that the floppy disk that's in the drive is listed: New Disk.
Fig. 6.6
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4. Double-click the name of the floppy disk to open it.
5. Save your document.

If you' re at the desktop, instead of running a program, you can sim ply drag
the icon of a document to the icon of th e floppy disk to make a copy of it on
that disk.

Creating a New Document
If you' re running a program on a Performa, you create a completely new
document just as you do on a regular Macin tosh: fro m the File menu, choose
New or press ~ -N for the keyboard sho rtcut. The Open command is fo r documents that have already been saved.
Note
In some programs, like TeachText, you may need to close the window you were
working in before you create a new document because you can only have one document at a time open. If you try to choose New from the File menu, that command
will be dimmed. just click the window's close box or press "J:t.-W to close the window.

Switching between Programs on a Performa
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Switching between Programs on a
Perform a
Another way a Performa's operating system is different fro m that of a standard
Macin tosh is that you see only one program running at a time, although you
may have launched several programs. On a standard Macintosh, it's easy for
your screen to become cluttered with windows from several d ifferent programs.
To move from one progra m to another, all you have to do is click in a window
of that program. This can confuse beginners, so a Performa shows you only o ne
progra m at a time (the on e that's active), alth ough that program may have
several windows open.
The icon at the upper right corn er of your screen, on the far right of the men u
ba r, represents the active program. It changes, depending on wh ich application
is active. This icon is called the Application menu (see fig. 6. 7).

II

To switch between programs that are running, click the Application me nu icon.

Fig. 6 .7
The active
program's icon
appears in the
Applicatio n menu .

All the programs that are running are listed th ere (see fig. 6 .8) . To select a
d iffe re n t program, d rag to highlight th e progra m's name; the n release t he
mouse button when the program's name is high lighted.
Fig. 6 .8
Th e check mark
indicates which
program is active.

Caution
Windows can sometimes cover up other windows. You can resize windows or drag
them by their title bars to see what's underneath.

-
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Starting Programs When Other
Programs Are Running
If you're working in one program, you may sometimes want to start another
program and then switch to it. To do that on a Performa, follow these steps:
1. Choose Finder from t he Application menu.

2. The Launcher window should appear. If it doesn't, double-click the
Launcher alias on your desktop.
3. Click the program's icon to start it.
If the program you want to start running isn't in the Launcher, locate its ico n
in the Finder and double-click it, o r double-click an icon of a document that
the program created.

Backing Up the Programs on Your
Performa
A Performa comes with software already installed; you don't get the programs
on floppy disks because they've been pre-installed o n your hard disk for you.
You may need a copy of these programs on floppy disks if something goes
wro ng wi th your computer. The Perform a also comes with a built-in Backup
utility program, so you sho uld use it right away to back up the contents of
your hard disk.
You' ll need at least 20 high-density floppy d isks to back up what's on your
Performa as it comes from the factory. If you installed new p rograms on your
computer after unpacking it, you'll need more than 20 disks. To start the
backup process, click the Apple Backup icon in the Launcher. Then follow the
d irecti o ns on-screen (see fig. 6.9). You'll be told when to insert a new disk as
each d isk fills up. Be sure to label the disks according to th e directions onscree n.
Note
Lock each disk as soon as it's full so that you don't use it for something else by mistake. Open the tab on the disk so that you can see through the hole. When the hole
is open, the disk is locked, and its contents can't be changed.

Backing Up the Programs on Your Performa
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Fig 6.9
Use Apple Backup
to start backing up
your hard disk.

Use the mouse or trackball to cltck the
Continue button.

Quit

kConllnue ll

Backing Up the System Folder
You can just back up your System Folder instead of backing up everything on
your Performa. If you don't h ave enough disks on hand for a full backup,
back up just the System Folder; you'll n eed only five disks to do that. If something happens to your Performa later and you can't get it started, you'll be
ab le to restore the System Fo lder a nd perh aps get started aga in. W hen you
have en o ugh d isks, back up the wh o le Performa so th at you can restore all of
its progra ms a nd files if n ecessary.

Caution
It is extremely important to make a backup of the System as some Performa models
are sold with only a full copy of the System software on the hard drive.

Restoring Your Programs
If something happen s and you n eed to restore your System Folder, the programs you've backed up, or both, to your Performa's hard disk, turn your
Performa off. Then locate the backup disks that you made, a nd follow these
steps:
1. Put the Utilities di sk t h at came w ith the Performa in the disk drive and
turn on the computer.
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2. Double-click the Apple Restore icon on the Utilities disk.
3. Follow the instructions on the screen to restore your System Folder or

all of your files.
4. Restart the Performa.

Startup Tricks for Advanced Users
If you're already experienced on a Macintosh, you may find returning to the
Launcher to start programs a little cum bersome. Try these tricks to speed up
starting programs on a Performa:

• Start programs by double-clicking their icons outside the Launcher.
Your programs are normally stored in an Applications folder on your
hard disk, and you can double-click their icons or names to start them
from that folder.
• Make aliases of programs and put them anywhere on your desktop. If
there are programs you use freq uently, make aliases of them and store
the aliases out on the desktop or put them in the Apple Menu Items
folder in your System Folder so that they appear on th e Apple menu.
• Put any program you always want to start up inside your Startup Items
folder. Drag a program's icon (or an al ias of its icon) into the Startup
Items folder inside your System Folder. When your Performa starts, all
you have to do is click in the program's window to go to it.
• Start a program running by double-clicking a document that was created in the program.
Documents are stored in a special folder, as you'll see in the section "Working
with Documents" later in this chapter.

Removing the Launcher
As you get accustomed to your Performa, you may decide that you want to do
away with the Launcher so your computer operates more like a regu lar
Macintosh. To remove the Launcher, follow these steps:
1. Open the Apple menu and choose Control Panels.
2. Select the Launcher icon and drag it out of the Control Panels folder.

Using the Performa Control Panel
Don't put it in your System Folder. You can drag it to the icon of your
hard disk to store it there.
3. Close the Control Panels window.
4 . Open your System Folder (you can use the Find command, ;):C-F, to
locate it quickly) .
5. Open the Startup Items folder in the System Folder.

6. Drag the icon of the Launcher alias out of the Startup Items folder. You
can throw it away in the Trash because you can always make a new alias
from the original Launcher icon later.
7. Drag the icon of the Launcher alias on the desktop to the trash.
8. Empty the Trash.
To make the Launcher appear again when you start up, drag its alias back
into the Startup Items folder and drag its original icon back into the Control
Panels folder. Then restart your Performa, and the Launcher window will
automatically appear on startup again.

Using the Performa Control Panel
Rather than remove the Launcher, you may just want to turn some of the
special features on or off. You can customize the Launcher in the Performa
control panel (which is found in the Control Panels folder inside the System
Folder). These features, such as hiding the Finder and establishing a default
folder for your documents, are what separates the Performa system software
fro m the standard versions of System 7.
Following is a description of the capabilities provided in the Performa control
panel. The following four features are active if there's an X in the check box.
Simply click the check box to turn the features off.
• Finder Hiding. When you work in an application, all items on your desk-

top are hidden wh en this option is checked, except for the desktop
pattern you've selected. If you want to switch to the Finder or another
program, you select it from the application menu at the upper right side
of the menu bar.

• Launcher Open at Startup. When this feature is checked, the Launcher
window opens automatically when you boot your Performa.
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• System Folder Protection. W hen this fea ture is checked, you canno t delete
o r rename files in the System Folder.

• Applications Folder. When this feature is checked, you cannot delete or
rename files in the Applications folder.
There are th ree more selections o ffered in the Perfo rma control panel. They
are used to specify a default locatio n for all the new documents tha t you save
for the first time, using the Save As dialo g box. These selections help simplify
the task of find ing a document if you want to work on it at a la ter time. It
also helps prevent your documents fro m being saved in unpredictable locatio ns. Here are the cho ices that are available:

• Default to Folder with Application. Each program you use on your
Pe rfo rma has its own folder that contains the application and some of
its suppo rt files. When you choose this option, all new files you save are
placed in that folder.

• Default to Documents Folder. When you choose this option, all new files
you save are placed in the Documents fo lder.

• Default to Last Folder Used. W hen you choose this option, your new
document is saved to the last fo lder used, no matter what it is.

'

Note
In System 7.5, all o f the features of the Performa control panel (except the
automatic opening of Launcher at startup) become a part of the General
Control Panel and are available to all M acintosh users.

Setting Up At Ease
At Ease 2.0 is a special program that comes with th e Performa. It makes the
computer much simpler to use than System 7 or 7.P, but what you can do is
also m ore restricted. With At Ease on, Applications are in an Applications
folder, documents are represented by butto ns in a Documents folder, and
th ere's no Trash, so nothing can be deleted by mistake. If password protection is o n, th ere's no way to get to the deskto p unless you kn ow the password. As the "owner," or system administrator- even tho ugh your "system "
may be a third-grade class, a few part-time office workers, or a cou ple of
young children in the home- you choose which programs and documents

Setting Up At Ease

101

each user can have access to, whether to display full o r restricted menus, and
how users can open and save documents.
If you're setting up At Ease for others to use, you'll need to read this section.
Later in this chapter, the section "Using At Ease" provides more information
on At Ease.

If At Ease is on, you'll see a screen similar to the one in figure 6.10 when you
start your Performa.
Fig. 6.10
The At Ease startup
screen .
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Note
At Ease can be installed on any Macintosh, not just on a Performa. If you're an experienced user, you may want to purchase this program and install it on any Macintosh
that allows access to small children or the general public or in any other situation in
which users have unrestricted access to a Macintosh.

Turning On At Ease
On a Performa just out of the box, At Ease has been installed but not turned
on yet. If you don't see the screen in figure 6.10 or a similar screen when you
start your computer, you'll need to turn At Ease on.
1. Locate the At Ease Setup icon stored on your hard disk.

2. Start At Ease Setup by double-clicking its icon.
3. Click the On button.
4. Choose Quit from the File menu.
If you can't locate the At Ease Setup icon, At Ease hasn't been installed on
your computer. If you don't have the At Ease setup disks, you need to
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purchase them and double-click the Installer icon that comes with At Ease to
install the program. At Ease is normally supplied pre-i nstalled on a Performa
but is a separate purchase for a regular Macintosh.
After you turn At Ease on, resta rt your com puter so that At Ease will take
effect.

Setting the Administrator Password
The first step in setting up At Ease is to assign an administrator password for
yourself. Only th e users to which you give this password will be able to
change At Ease's setup. Choose Go To At Ease Setup from the Special menu.
Then, fro m th e Options m enu, choose Administrator Password. You'll see the
dia log box in figure 6.1 1, where you can type as many as 15 characters for t he
password and up to 63 characters fo r the clue that helps you remember it.
The clue will appear each time At Ease asks fo r the password.
Fig. 6 .11

Admin istrator Password

Til

~E~nt~e~rn~e~w~p~os~sw~o~r~d:~~~••-.~••====~1
:====~
neen ter new password: 1
.....
I

Assign a clue that
only you can
figure out.

Cl ue: Miss Sm tth•s cot

No~

·

If you forget your password, you can just set another one.
Start the computer with the Utilities disk, if you have a Performa, or the Disk Tools
disk, if you have a regular Macintosh. Then open the System Folder and the At Ease
Items folder inside it. Drag the At Ease Preferences file to the Trash and empty the
Trash. From the Special menu, choose Restart. When the computer restarts, doubleclick the At Ease Setup icon and set a new password.

You can also choose User Greeting (~-G) from the Special menu and type a
perso nalized greeting for your users to see on startup.

Setting Up Users
In t he At Ease Setup window, click New to set up the configuration for each
user who has access to your computer. You can give each user a different
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password if you like, or assign all your users the same password. Unlike the
system administrator password, users can change their passwords whenever
they like.
Click Stay in At Ease if you wan t the user you're setting up to have access
only to the programs and documents you choose, or click Switch to Finder if
you want the user to have unlimited access to everyth ing o n the computer
(see fig. 6.12}.
Fig. 6 .1 2

8

Ne w User

You can set the
level of access and
assign a password
for each person
who will use At
Ease.

User Nome: ~~O=ob= =::;:::=:::;----'
Password: J condy conj
Riter stortup:

® stny In nt rose
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KCHJ

0 switch to finder

This: UUt" vm liSt rindtt' W'lstu j or At h u. Uur will
M•• tun .oc•u to ttw COfY'9Ul~ .nd •11 ot rts tc~t~ttnlJ

Assigning Programs and Documents
If you allowed this user unrestricted access to the compu ter, you don't have
any more setting up to do--click Done. Otherwise, click Next to assign which
applications and documents to which you want users to have access (see fig.
6.13).
~

Add Oppllcnllons
Disk:

Mnctnlosh 110 ,..

Q FontFnker 1.0

<l> Go Moose
Q Hypercnrd Player

Items ror this User:
<l> ClnrlsWorks

~

Q I Li ke Icon

Q ,'1.Y.O.B.

(»

Rdd

» )

Q lnrormont 2.0.1
~

Mouse Ooslcs

Q Pntcher'" 2.0

Fig. 6.13
Add all the
programs to which
you want the user
to have access.

( Rt'mm• t' ]

Q RedAiert 1.0.3
Q Squoshed Moose.seo :j:

~

~ I[

OK

Jl

1. Click Add Applications and th en select the program s you want the user
to use. You can Shift·click to select several program s at once.
2. When you've selected all the programs you want, click Add .

3. To give the user access to documents, click Find Items and en ter the
name of the document for which you want to search (see fig. 6.14).

Tip
If you set up At
Ease for a
group, set up a
user named
Guest. Tell the
group to choose
Guest on the At
Ease startup
screen.
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Click Find to start the search. When the search is done, select the
document's name in the Item s Found o n Disk list and click OK to add it
to the Items for This User list.
4. When you finish adding items, click OK.

Fig. 6.14
You can also give
users access to
documents.
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Deciding Which Menus Appear

Nex t, you'll decide which At Ease menus your user will see. In the next dialog
box, choose Minimal to limit the menus to the most basic commands like
Close and Quit, or choose All to give access to all At Ease m enu commands,
which will allow the user to copy, rename, and delete files (see fig. 6. 15).
Fig. 6.15
You choose which
m enus your user
will see, either full
menus o r minimal
menus.

Menus
@Minlmnl
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Tip
If you click
Speak Butto n
Names, th e
computer will
"speak" the
name of a button when you
point to a button with the
mouse po in ter.
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Setting Up How Users Save with At Ease

At Ease also allows you to be in charge of how users can save their docu-

ments. After you set up which menus appea r and then click Next for the next
screen, you can decide whether this user can save fi les anywhere o n the hard
d isk, only in their fo lder (which will be inside the Documents folder on the
compu ter), or only o n a floppy disk (see fig. 6.16). Choose Only o n Floppy
Disk if you don 't wa nt the user to be able to save anything without inserting
a floppy d isk first. This keeps the computer from filling up with first-time
users' documents, which can pro liferate.
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User " Hor- '-"-"--- - - - - - - _ __

_,.

Fig. 6.16
You also decide
how users will save
their documents.
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You can also mark the Allow Access to Finder check box if you want th is user
to have full, unrestricted access to everything on the computer.

Caution
Marking the Allow Access to Finder check box is the same as checking the switch to
Finder button when you first started setting up this user. If there was a good reason
you d idn't choose unlimited access for that user, the same reason is probably valid
now.

After you fill out this screen, you're through setting up this user. Click Done.
Now you can add another user, o r fro m the File m enu, choose Quit (:I:C-Q) to
leave At Ease Setup.
Attaching Sounds to Buttons
If you're the system administrator, you can attach sounds to buttons so that
when the user clicks a button, the sou nd plays. Record ing instructions by
using your Macintosh's microphone and attaching them to buttons is a good
way to give new users add itional information about using the computer.

To do this, start the At Ease Setup program. From the File menu, select Attach
Sounds. Click the item you want to attach a sound to; then click Import
Sound to attach a sound file that you've already stored on your hard disk or
Record Sound if you' re recording a sound with your Macintosh's microphone. If you're im porting a sound, select a sound file; if you're recording a
sound, you'll see a screen resem bling the controls o n a tape deck that allows
you to record a sound.

Turning Off and Removing At Ease
To turn At Ease off, double-click the At Ease Setup icon o n your hard disk.
You have to be an administrator to turn it off because it will ask you for the
administrator password. Then simply click the Off button. At Ease will be off
the next time the computer starts.

Tip
To change a
user's access
privileges,
select his or
her name in
the At Ease
Setup window
and cl ick
Open. Follow
the same sequence as
described here
to chan ge the
user's privileges.
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To remove At Ease from the compu ter, turn At Ease off. Then take the following steps:
1. Insert the At Ease Install disk 1 and double-click the Installer icon.

2. Click Customize and select At Ease.
3. Press the Option key, and you'l l see the Install button change to Rem ove. Click Remove.

Using At Ease
When your users start the computer with At Ease installed, they'll see a welcome screen with their names listed. After clicking their name, they are asked
for a password, if you assigned one to them. After providing the passwo rd,
they'll see their folders (see fig. 6.17). All they have to do is click a button to
start a program or open a document. Documents they've saved (if you've
allowed them to save without using a flopp y disk) are represented by button s
on their user panel, the one labeled with their name.
Fig. 6.17
The At Ease
desktop.

To switch between folders (also called panels), a user cl icks the tab at the top.
If there are are more items than can fit on one fo lder, a dog-eared tab appears
in the lower right corner of the fo lder on which to cl ick. A user can also click

Using At Ease
in the folder's tab and hold the mouse button down to see a list of all ava ilable fo lders and can go di rectly to a folder by choosing it from that list.
To close a folder, the user clicks the folder's Close button on the tab. Optionclicking closes all the folders.

Note
At Ease has hidden keyboard shortcuts that experienced users may want to know
about. Pressing Tab switches you between the At Ease Items folder and the user
folder. Pressing the left-arrow key and right-arrow key take you forward or back one
page (if you have more than one page), and ~ -l eft arrow and ~-right arrow take
you to the first and last page in the At Ease folders. You can also type the first few
characters of a button's name to move directly to it.

The At Ease Menus
When At Ease is running, the menus your users see depend on whether you
allowed them access to full menus or minimal menus when you set u p At
Ease. For example, with m inimal men us, the File menu contains only two
commands: Close and Quit. With fu ll menus, a user has commands for creating new folders, opening programs, and documents (the Open Other command), renaming, deleting, and finding files, getting information about files
and folders, closing windows, copying files to and from floppy disks, and
quitting. The Edit menu is the same, whether users have full or minimal access. The View men u does not appear with minimal access. The Special menu
consists of Turn Sound Off, Eject Disk, Go To At Ease Setu p, Restart, and Shut
Down if the user has minimal access; with full access the Go To Finder command is also available.

Switching between Programs with At Ease
Users can have several programs running under At Ease if they've clicked
different Application buttons, but onl y one program normally shows at a
time. The Application menu at the far-right corner of the screen lists all the
programs that are running. Users can switch to a different program by choosing it from that menu, just as in System 7 o r 7.P. They can also switch back to
At Ease to start a new program by choosing At Ease from that list.
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From Here ...
For ad di tional info rmatio n relating directly to using your system software on
a Macin tosh, you may want to review the fo llowing chapters of this book:
• Chapter 5, "Understanding the Desktop and Finder," discusses aspects
of the system software common to all Macintosh es, including
Performas.
• Chapter 7, "Organizing Your Files, Folders, and Disks," shows add itional details of how to work with files, fo lders, and disks if you decide
to bypass using System 7.P o r At Ease.
• Chapter 10, "The Printing Chapter," illustra tes how to print documents
o n any Macintosh.
• Chapter 13, "Adding Sounds," discusses recording and working with
sound on you r Maci ntosh .

Chapter 7

Organizing Your Files,
Folders, and Disks
by Chris Oakes

At any workspace-be it a desk, a workbench, or a corral-you do mo re than
work on specific tasks. You also sort out and organize the va rious items used
in getting those tasks done. You sto re tools in drawers, file things away,
gather new materials, and more to prepare for and carry o ut your work. The
Macintosh is a workspace too, and is no different in this respect. It is not only
where you get thin gs done, but also where you organize and manage the
things you do.
These two halves of your daily work on the Macintosh are handled by the
Macintosh application and the Macintosh Finder. The application is where
you work on specific tasks, and as you saw in Chapter S, the Finder is where
you manage them. In mo re concrete terms: You write a letter in a word processing application; you categorize, rename, or move the letter from one
place to another in the Finder.
In this chapter, you learn the following:
• How to create, name, move, and trash folders and files
• Ways to view files and file info rmatio n
• How to clean up and sort files
• How to use labels, stationery, and aliases
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The Finder as File Cabinet
Many Macintosh applications have a recognizable, real-world counterpart. A
word processor is like a typewriter, for example, and an address database can
be compared to a Rolodex file. But is there any real-world object to which the
Finder can be compared?
In fact, there is. The Finder can be compared to the common and fam iliar
storage device known as the file cabinet. The file cabinet, just like the
Macintosh Finder, is meant for the storage and management of files.
Macintosh designers purposefully chose the file cabinet as a model because
it is recognized as a fami liar and easy-to-use tool of our everyday world.
Accordingly, the storage, retrieval, and organization of your Macintosh files
are very much like the storage, retrieval, and organization of the files in a file
cabinet. Indeed, as you well know by now, the things you shuffle around in a
file cabinet-files and folders-even have the same names on the Macintosh:
files and folders. As with so many other Macintosh concepts, before you've
even started, you know a great deal about the Finder-simply by knowing
what a file cabinet is.
The basic parts of the file cabinet have corresponding parts in the Macintosh
Finder. Table 7.1 shows how these parts correspond.

Table 7.1 The Components of the File Cabinet and Their Finder
Equivalents
File Cabinet

Finder Equivalent

File (document, photo, and so on)

File

Folder

Folder

File Drawer

Disk

As you can see, a pretty direct relationship exists between the Finder and the
file cabinet. With the exception of the file drawer, the two systems consist of
identical components. In fact, if you named your hard disk File Drawer
(which is easy to do), the comparison would be even more obvious.
Now that you've seen the relationship between the file cabinet and the
Finder, look at how their individual parts relate to one another. With the file
cabinet, there is a structured order to the file, the folder, and the file drawer.

The Finder as File Cabinet
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This order stipulates that certain items are put inside other items, resulting in
a three-level hierarchy. A file (level 1), such as a photograph or document, is
put inside a folder (level 2). And the folder is put inside a fil e drawer (level 3).
As you know, you can also put one folder inside another folder, adding another level to the hierarchy.
In the finder, the hierarchy is the same: a file goes inside a folder, and a
folder goes inside-or, m ore correctly, on-a disk. And just as you can put a
file cabinet folder inside another one, you can do the same thing in the
Finder.
But th e Finder one-ups the file cabinet by letting you put as many folders as
you like inside other folders. This is part of the Macintosh's multilevel, hiera rchical file system. As shown in figure 7.1, th is capability enables you to get
much more sophisticated in the management of your Macintosh files.
Fig. 7.1
The Finder's
h iera rch ical fi le
system allows for
sophisticated file
organizatio n.

Putting folders and files inside other folders on the Macintosh is called nesting
folders. One folder is nested inside another, wh ich is rrested inside anotherand so on. The deepness of a file or folder refers to how many folders that file
or folder is nested in, or how deep within the file hierarchy it sits.
In a file cabinet, you're limited to the amount of nesting you can practically
do. O n the Macintosh, th e maximum number of nested folders is 64. While
this may appear to be more confusing at first glance, it actua lly helps avoid
confusion by letting you structure your files better. The resu lt is that you can
easily arrange your Macintosh files according to how you work wi th them .
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Note
You can put a file inside a file drawer without any folder, and you can do the same
thing with a Macintosh file. In other words, a file can simply reside on a disk w ithout
being inside any folder-carefree and folderless, so to speak. Any file-or folder, for
that matter- that resides on a disk like this is said to be at the top level of the disk
because it resides at the top of the file hierarchy. (This is also sometimes referred to
as the root level of the disk, confusing though it is.) As you can imagine, however, if
too many files and folders are kept at the top level, it becomes more difficult to keep
track of them. Therefore, the fewer folders and files at this level the better.

Organizing Your Hard Disk
The three items dealt with so far in this chapter-files, folders, and disksmake up the simple building blocks of Macintosh file management. With just
these three simple elements, you can be very organized.
This section examines how you might go about developing an organizational
strategy for your hard disk, the main disk you'll be working with .

Note
This chapter focuses on the organization of the hard disk because m ost Macintoshes
now have a hard disk on which most of its files are kept. The organizational principles
discussed here, however, apply to the organization of floppy disks (or any other disk
for that matter).

When you first turned on your Macintosh, you probably encountered just a
few folders and fi les on your hard disk. You probably found the System
Folder (containing essential software used to run the Macintosh), the application TeachText (or perhaps SimpleText, the updated version of TeachText for
System 7.5), and a document called Read Me. That's a pretty small number of
items, all residing at the top level (or root level) of the disk. It doesn't require
much effort to keep these files organized .
But as you start writing letters, creating spreadsheets, and keeping databases
of information, the num ber of files on your disk starts to, well, explode-to
put it mild ly. This ever-growing load of personal files, and the applica tions
used to create them, call for a more sophisticated system of organization.

Organizing You r Hard Disk
That may sound a little scary, bu t all it really means is keeping your files in
appropriate groups. And the very simple, familiar tool of grouping on the
Mac is, of cou rse, th e fo lder.
The next step in this chapter is to show you how you ca n easily create your
own o rganizatio nal system. After th at, you'll learn the various proced ures
used in creating, moving, and viewing your Macintosh files so that you can
start setting that system up right away.

File Hierarchy in Action
As you've seen in most of the figures so far in this chapter, the hierarchical
file system gives you the freedo m to arrange and grou p things in any order
you li ke.
When you start a new business project, for example, you ca n easily create a
new folder fo r the project in an existing Business folder. Or if you've decided
to abandon your poetry career, you ca n easily drag the Poetry fold er to the
trash. W hatever the change, make sure the current order of your hard d isk
reflects the current order of you r daily work. This keeps your Macintosh work
more orderly and efficient.
Note
Planning your disk organization is a good idea, but you need to be loose enough to
accommodate changes as you go. It's similar to a garden, in which you plant flowers
and plants in an orderly way, but allow for changes as the garden grows. Nothing
dictates a better organizational system than actual patterns of use. So keep an eye on
your habits as you go, and when a clear pattern emerges, make the necessary
changes to accommodate it.

Note
New versions of the Macintosh operating system to appear throughout 1995 ar.d
1996 will add more built-in file management features. Some of the features of the
latest upgrade, System 7.5, are covered in this chapter and throughout the book.

The strategy of organ izatio n that you design is, of course, en ti rely up to you.
Different people have different styles of organization. Some are rigid, some
are lo ose-and some apocalyptic. Witness the file cabi net aga in. The order of
people's file cabinets varies from one person to an other. Some might keep all
t heir files alphabetically, while o thers might d ivide them by topic. To give
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you an idea of some commo n Macintosh ordering strategies, look at table 7.2
for a sampling of these strategies and what they mean.

Table 7.2 Some File Organization Strategies
Strategy

What It Means

Application-oriented

Grouping documents w ith the applications that created
them.

Computer-oriented

Grouping documents by computer task: word processing,
desktop publishing, illustrations, databases, and so on.

Work/Project-oriented

Grouping documents according to work: business,
personal, computer, correspondence, and so on.

Of course, no o ne strategy must be used to the exclusion of others. Ma ny
users like to keep all their applications grouped together, for example, and
then group documents by project. Mea nwhile, they might keep their
Macintosh utility files, meant for the maintenance of the Macintosh, in thei r
own group. Again, after you set up one o r more of these strategies, you can
always modify them as you go.
Before you learn about the basic organizational tools of the Finder, you
should understand where the desktop fits into the Finder hierarch y. You can
drag any file or folder-from its location anywhere on a disk- out onto the
open desktop. (The desktop is the large, usually gray area that fills most of
your Finder's screen.) To the Macintosh, files o n the desktop reside in the
desktop folder. Files in this fo lder reside, like the desktop, at the root level of a
disk's hierarchy. For mo re info rmatio n, see "The Hierarchy of Fi les, Folders,
and Disks," previously in th is chapter.

Note
In Open and Save As Dialog b oxes, click the Desktop button to navigate to an item
that's on the desktop. Alternatively, you can use the dialog box's pop-up menu. The
desktop level appears at the bottom of this menu.

Creating a New Folder
To arrange your files into a sensible o rder, you need to know how to create
the all-important folder. Fo rtunately, this task couldn't be easier.

Organizing Your Hard Disk
Before you learn this one-step procedure, you should be aware of where a
new folder wi ll appear after you create it. If no windows in the Finder are
open, a new fo lder appears on the desktop, usually just below your disk
icon(s). Otherwise, the new folder appears in the active window.
Note
The active window can be identified by its title bar, the bar along the top edge of the
window. When a window is active, its close box and the horizontal stripes o n either
side of the window's title are visible. Inactive windows only display their title-these
other features aren't visible. In fi gure 7.2, the window named Macintosh HD is active.
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Tip
To make a new
folder appea r o n
the desktop when
windows are open,
click the Trash or
any other desktop
icon before creating the folder.

Fig. 7.2
An active wi ndow
can be identified
by its distinctive
title bar. In th is
case, the window
named Macintosh
H D is active.

To make a window active, you just click anywhere on the window. When
you open any disk o r folder, its window au tomatically becomes the active
wi ndow.
To create and name a new folder that will appear on the desktop or in the
active window, follow these simple steps.
1. Choose New Fo lder from the File menu. A new folder called Untitled
Folder will appea r on the desktop or in t he active window.
2 . The name Un ti tled Folder is automatically highlighted. Type a new

name for the folder and press Retu rn.

Tip
To prevent a window from becoming active when
you cl ick it (so you
can move it), hold
down the ~ key
whi le cl icking
o n it.
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Note
Why doesn't this section cover creating a file, the other member of the disk-folder-file
hierarchy? Because you create files with applications themselves, not in the Finder.
But in almost all applications, the command is very similar to creating a folder-you
choose New from the application's File menu. Individual applications are covered in
the chapters of Part IV of this book. Note, however, that you can rename files as well
as folders in the Finder. Naming these item s is covered in the next section.

Naming Folders and Files
If you need to change the name of a file or folder, simply follow the steps
below.
1. Select the folder's or file's name by clicking once anywhere on tbe existing name (which is Untitled Fo lder on newly created folders). After a
brief pause, the name becomes highlighted. Figure 7.3 shows a folder
with its name highligh ted.
Fig. 7 .3
The folder's name
has been highligh ted.

2. Type a new name for the fo lder. The name will replace the existing
name of the fo lder.
Tip
To highlight an

3. Press the Return or Enter key. Alternatively, you can click anywhere
outside of the disk's icon with the mouse.

item's name without enduring the
short renam e
delay, click once
on the file icon
itself, and then
press the Return
key. The icon's

You now know how to create and name a new fo lder. Now you can put any
fi le o r other folder inside your new folder. How to do that is explained in the
nex t section.
Note
You can, if you wish, simply modify the existing name of any folder or file, instead of

name will be

replacing the whole thing. After the existing name has been highlighted, use the

selected im medi-

cursor to select the part of the name you want to change. As with any M acintosh

ately.

text, the characters you want to replace are highlighted as you drag the cursor over
them. You can use the arrow keys on your keyboard to move the cursor. The Delete
key also is handy in renaming items.

Organizing Your Hard Disk

117

Putting Files into a Folder
Now that you have a folder, you're ready to put files-or other folders-inside
it. To do that, you simply select the item and drag it over the folder's icon.
Alternatively, you can open the folder and drag the item into the folder's
window.
The following steps are involved in putting an item (a fi le or folder) into a
folder. The item's original position may be on the desktop or in another
folder.
1. Select the item.

2 . Drag it over the icon of the folder. When the item is positioned correct ly, the folder icon becomes highlighted . Figure 7.4 shows an item
ready fo r dropping into a h ighlighted folder.
3. Drop the item by letting go of the mouse button.
Fig. 7 .4
Drop an item on

to the destination
folder after it has
become highlighted, as seen
here.

Note
You learned how to drag items in the demonstration in Chapter 5. To recap, you
simply hold the mouse button down after selecting the item. Then, when you move
your mouse around, an outline of the item moves as your mouse moves. When
you're ready to drop the item in the new location, let go of the mouse button.

This procedure causes the item to appear in the folder's window. As indicated
previously, the item can also be d ragged directly into the folder's open
window.
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Note
For the most part you, the user, create the folders that appear on your disks. But
under System 7.5, the Macintosh will create one special folder automatically: the
default documents folder. This folder, named Documents, is created on the desktop
as a default place to save documents when working in applications. Its purpose is to
make it easier for new users to keep track of documents. Without this folder, it's
possible for a novice to not be able to find a saved document. Now such users need
only open the Documents folder, w hich sits clearly visible on the desktop. You should
regularly relocate files in this folder, however, to an appropriately categorized folder.
To activate or deactivate the Documents folder in the General Controls control panel,
select the Documents folder option in the control panel's lower-right section. (The
section is entitled "Documen ts.")

Selecting and Moving a Group of Files
When organizing your files, you may want to move several items to a new
folder. You could m ove them o ne at a time, but it's much quicker to move
them as a group. You can do this by selecting them all simultaneously and
then treating the group as you would any individual item.
To select multiple items, they must all be in the same window (or on the
desktop). Follow the steps below once you've picked the group of files you
want to work with:
1. Select the first item.
2. Holding down the Shift key, select the next item. The first item remains
highlighted along with the new item.
3. Repeat step 2 until all items are selected.
To move the group of items after they've been selected, click one of the items
and drag it to the new location. It doesn't matter which item you click-all of
the items will move with that item. just m ake sure you deposit the item you
click into the proper folder-the rest will follow. Here is a quicker, alternative
method for selecting a grou p of files that are close to each other. It works best
when items are in icon view, although it works with list views as well.
1. Click the window (or desktop) just outside o ne corner of the group of
items. Note: Do not click one of the items; click in the white space of
the window. (If the files are o n the desktop, you'd click the desktop
itself.)
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2. Holding the mouse button down, drag the cursor to the opposite corner
of the group of items. A dotted line rectangle is fo rmed as you drag the
mouse. Items within the rectangle are selected as you drag. (Refer to
figure 7.5.) If you drag too far, back up. Any selected items will be deselected as you do so.
Fig. 7.5
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3. Let go of the mouse button when all the items are highlighted. Other
items can also be added to this group by clicking on them while ho lding down the Shift key.
Note also that all the items on the desktop or in a window can be selected by
choosing th e Select All command from the Edit menu. ()-C-A achieves the
same result.)

Caution
It's not probable, but it is possible to accidentally highlight the name of a folder or
file while selecting items. If you do this unknowingly, you risk changing or deleting
the name. If this happens and you notice it immediately, just choose the Undo command from the Edit menu (or press ):(-Z). This will undo the change. Otherwise,
you'll have to rename the file or folder. If the file is a document and you can't remember the name, open the file to reveal its contents, then rename it accordingly.

Trashing Files and Folders
Creating files and fo lders is a central part of organizing your disk. But so is
eliminating them. And th is is just what the Finder's Trash can is for. just as
you should keep your important files in good order, you should also trash the
ones you no longer need. To do so, you simply d rag the folder or file to the
Trash icon .
When the Trash contains items ready fo r the digital d ump, its icon bulges.
(Much like the trash bag under your sink. See figure 7 .6.)

When the dotted
rectangle moves
over an item, it is
sel ected.
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Fig. 7.6
A bulging Trash
icon ind icates that
there are fi les
inside.

You can drag any item-a single file, a whole folder, or an entire group of
folders and files-to the trash at o nce. Unli ke a real trash can, it has no limit.
Digital reality continues to parallel physical reality with the Trash can. I'm
sure you've noticed that the trash can under your sink requires that you
empty it. And so does th e Finder's Trash. (If you use System 6, refer to the
no te following figu re 7.7.) When you want to empty the Trash, wh ich will
delete these files fo r good, you simply choose Empty Trash from the Special
menu. A warning dialog will appea r telling you how many items are to be
trashed, along with the size of this particular heap of trash. When you click
OK, the deed is done. To temporarily avoid this d ialog, press the Optio n key
while choosing the Empty Trash command.

Note
The Trash warning, while important to new users, can become a nuisance if you have
to empty the Trash frequently. Fortunately, there is an easy way to keep it from
appearing. Select the Trash icon, then choose Get Info from the File menu. At the
bottom of the Info window, there is a check box option: Warn before emptying. (See
figure 7.7.) Uncheck this option and the dialog will stop warning you-but be careful
that you don't accidentally t rash important files.

Fig. 7.7
Unchecking the
Warn before
emptying option
will avoid
warning d ialogs
when you empty
the Trash.
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Note
System 7 users have the luxury of emptying the Trash at their leisure. That way, you
know that something isn't really gone until you issue the Empty Trash command. But
under System 6, the Trash will be taken out without you saying or doing anything.
While this may be desirable in real life, it's not always desired on the Mac. System 6's
Finder will empty the Trash when you launch an application, shut down or restart the
computer. System 7, on the other hand, will hold you r Trash until you intentionally
empty it. Thus, you have the opportunity to retrieve an accidentally trashed file.

Un-Trashing Files
As mentioned above, once a file is in the Trash, you have the opportunity to
take it back out-as long as the Trash hasn't been emptied . To do so, simply
select the Trash icon and choose Open from the File men u. You may find it
easier to open the trash by double-clicking on its icon. Either way, the Trash's
window opens up to display its contents just like any other window. Select
the desired item and d rag it to the desktop (or anywhere else you'd like to put
it).

Moving Files to the Desktop and Putting Them Away
It's often handy to move files from a folder to the desktop. You may want to
gather a group of files there to copy them to a floppy disk for example. The
method fo r doing this is o ne you know-you sim ply drag the items from th e
folder's window to the desktop. While it's often conven ient to store them
there temporarily, putting them away later-especially if it's a large group- is
anything but convenient.
To put them away by hand, you'd have to open all the o riginal folders (if you
can remember them) and redeposit the fil es. Fortunate ly, however, the
Macintosh will take of this ugly task for you. All you need to do is select the
items to put away and choose the Put Away command, located in the File
m enu.

Note
If the file or folder was originally created on the desktop, the Put Away command will
have no effect-the file is already put away.
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Note
As mentioned, the desktop can be a convenient place to put files temporarily. If
you' re saving a file in an application and it doesn't have an appropriate fold er yet,
the desktop serves as a temporary holding place where you won' t lose or forget
about the file. But be sure you promptly g ive the file a home somewhere in your
organizational system. Overusing the desktop as a holding place can turn its pretty
graphical interface into graphical chaos.

Viewing Files and Folders
In order to organize your files, you need to look at them, of course. In Chapter S, "Understanding the Desktop and Finder," you already saw how you can
easily open disks and folders to look at and work with files that may be
nested a few folders deep. The disk and folders containing the desired docum ent were selected and opened until the document was visible.
Note

Tip
If you choose one
of higher-level
fo lders in a
window's pop-up
menu while holding t he Option key
(alo ng with the
command key),
the higher-level
fo lder will open
and the curren tly
active window will
close.

If a file is nested very deep, this can create a large number of opened windows on the
desktop, cluttering your view of things. Thus, it is a good ide.a to close windows as
soon as you've opened the target folder contained within the window. The Finder
will do this for you automatically if you ho ld down the Option key as you open new
windows.

Once you get to you r target document or folder, you may need to know
which higher-level folders contained it. (They are higher-level folders because
they are higher in the fi le hierarch y.) Or you may wa nt to reopen one of
those folders. The pop-up menu available at the top of every window serves
this very purpose. To access this menu, simply click on the window's nam e in
the title bar while ho ld ing down the command key. A list showing the names
of higher-level fo lders (if there are any) and the d isk containing them will
pop down. Dragging the mouse down to highlight one will open the window
for that folder or disk.

Viewing Files and Folders
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Note
System 7.5 includes a control panel called WindowShade. Designed to help reduce
desktop clutter, it reduces a window to only its title bar when not in use. To reduce a
window like this, you simply double-click on its title bar. You will hear a short sound
and all but the title bar will disappear. (If you don't hear the sound and want to,
check the Make sounds ... option in the WindowShade control panel.) To view the
window in its entirety again, you just double-dick on the title bar once more. This
feature can make a crowded desktop much more manageable.

Icon and List Views
When you have the window of your target folder o r disk open, what exactly
do you see? If the window is displayed in an icon view, you see documents
and folders, which appear as icons with their names below them. No other
file information (other than the name) is provided in this view. Most figures
so far in this chapter and others have shown the ico n view.

II

But files can also be viewed in a more informative (though less appea ling) list
format. The default format for this kind of view shows a ve ry small icon next
to the item's name. To the right of the item's name appears its size, kind,
label, and the date the item was last modified. (Refer to figure 7.8.) In System
7, a small right-pointing triangle also appears to the left of the folder. This
triangle is discussed later in th is sectio n.)
Fig . 7 .8
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To change the type of view for any window, you use the View menu. Wh ile
the window is active, choose the desired view from the menu.

Viewed i n list
form, windows
display file
information to the
righ t of the file.
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See table 7.3 for an explanation of what you'll see with each of the seven
view types. The first two views (Small Icon and Icon) are graphical views,
while the others show files and folders in a text-intensive list, sorted according to the criterion of that particular view. You can use the sorting ability of
the list views to quickly identify and group large items, items with certain
labels (discussed in detail later in this chapter), items of a certain kind, and so
on . This is very helpful when you are organizing or reorganizing groups of
files. (The section, "Using the Find Command To Round Up Files," later in
this chapter further explains the Finder's ability to help you group and sort
files.)

Table 7.3 Types of Window Views
VIew

What It Shows

Small Icon

Shows folders and files as small icons; a reduced icon size
allows more items to fit into a window .

Icon

Shows items as normal-sized icons.

N ame

Shows items in a list, sorted alphabetically by name.

Size

Lists items, sorted by their size, from bigger to smaller.
(Folders, which don't normally show a size, are listed last
in alphab etical order.)

Kind

Lists items, sorted by the kind of file (application,
document, control panel, and so on).

Label

Lists items, sorted by label (hot, cool, and so on).

Date

Lists items, sorted by the date th ey were last modified;
more recent items at top.

In addition to chan ging the ty pe of view in the View menu, you can also
change the way info rmatio n is presented in each view. The control panel
called Views allows you to make these changes (refer to fig. 7.9). Table 7.4
explains the effect the vario us settings have on a window's view.

Table 7.4 The Options of the Views Control Panel
Option

Purpose

Font for Views

The two pop-down menus let you change the typeface
and size of the font for all disk, folder, and file names.

Icon Views

Affecting the two icon views, these options determine
whether icons are in straight or staggered rows w hen the
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Purpose
Clean Up command is used on a window (discussed later
in this chapter).

Always snap to grid

When you put an item into a new window, this automatically aligns it with the existing items.

List Views

Will display larger icons next to file names in list views.
The various Show ... options determine which file
information is included in list views.

Calculate folder sizes

Includes folder sizes in list views. N ote: this may cause
windows to take longer to open.

Show disk info in header

In list views, displays disk info such as the amount of free
space on disk, which is normally shown only in icon views.

Fig. 7 .9
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Getting More File Information
As you've seen, windows in list view show a good deal o f informatio n about
each file. Sometimes you might want even more informatio n, however. The
Get Info command, located in the File menu, is the way to get it. (This is also
the only way to get file information in icon views.) Simply select the item(s)
you want more informatio n fo r, then choose the Get Info command. An
information window will appear for each item you've selected, displaying a
variety of file data. Figure 7.10 shows th e wi ndow and its information.
The version informatio n in the Info window o f figure 7.10 shows 11/n, or not
applicable. That's because versio n informatio n only applies to applications. If
you have Microsoft Word versio n 4.0, for example, the exact version number,
4.0, wou ld appear here in its Info window.

The Views control
panel.

II
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Fig. 7.10
A file Info window,
accessed via the
File menu's Get
Info command.
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Note
The box labeled Comments in the Info window is intended as a place for you to type
quick notes about a file. Rebuilding the Desktop will erase these comments, so it's
not a good idea to keep important information here. As a result, most users never
use th e Comments box. However, there are shareware programs available that will
restore the Finder comments if you want this option.

Locking Files in the Info Window
You may have occasion to create a file that you want to remain unchanged.
It is easy to prevent such a fi le from being m odi fied (or edited). just use the

Locked o ption in the Info window. Check the Locked box, located n ear the
bottom of the Info window. The result is that the file can be o pened and
viewed in applicatio ns, but it cannot be modified in any way. The Stationery
optio n is a variation on the Locked o ption, and is d iscussed later in this chapter.

Using Folder Triangles to View Folder Contents
You've probably noticed the little right-pointing triangles nex t to folder
names in list views. (Figure 7.11 shows several.) What are they fo r?
When navigating through folders, it helps to minimize the nu mber of
windows you have to open. This reduces the clutter o n your desktop.
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Clicking on this triangle once causes the triangle to point downwa rd and the
folde r's contents to appear in list format beneath it. Thus, that folder's contents can be seen without o pening a new window.
To diffe rentiate the folder's contents from the rest of the window's contents,
the list of its files appears indented fro m the rest. (Refer to figure 7.11.) To
hide th e folder's contents, click on the triangle again.
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Cleaning Up Your Files
When you view a window in a list view, such as view by name, the icons are
always in a straight, orderly list. But in icon views, thi ngs are not always so
orderly. Icons might be overlapping o ne another and instead of neat rows,
you m ight see something that represents abstract art with icons as the medium. To neaten things up, of course, you can shuffle them aro und with the
mouse. But the Finder has a handy little command to take care of the bulk of
the work for you. This is the Clean Up command, located in the Special
menu.
When chosen, it will straighten up some or all of the icons o n the desktop, or
the icons in a window. To clean up the icons o n the desktop, click o n one of
the desktop icons, then choose the Clean Up command from the Special
menu. To clean up th e ico ns in a wi ndow, choose the Clea n Up command
while the window is active. For d ifferent types of clea n ups, there are several
ways of choosing the comm and from the menu. Table 7.5 outlines these
methods. The result of the ac tio n in the left column is shown in th e right
column.

Fig. 7.11
When folder
triangles are used,
a fo lder's conten ts
appear indented
below the fo lder.
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Table 7.5

Clean Up Command Variations

Clean Up Action

Result

Pressing Shift
while choosing Clean Up

Selected icons are straightened.

Pressing Option
whi le choosing Clean Up

Icons are cleaned up al phabetically by name
or by size (whichever view was most recently
chosen in the View menu).

Pressing Option while
performing desktop clean ups

Aligns icons along right edge of the desktop .

Special File Organization Tools
The Finder features some special tools designed ex pressly for easing the task
of file management. Namely, they are Labels, Aliases, Stationery, an d the find
comma nd. This section shows you how to use them.

Using Labels

Tip
If you don 't like
the default label
n am es, you can
chan ge them
using th e Labels
contro l panel.
Click the co lo r o r
name of the label
in the control
panel to cha nge
the label's characteristics.

While the Finder attaches all kinds of its own informatio n to a fi le-its name,
size, a nd so on-you may wa nt to at tach some of your own. More specifica lly, you may want to indicate that a certain file pertains to a certain project
or deadline. This is just w hat the Label me nu of System 7 le ts you do. It lets
you label files, just as you wou ld label a folder or document with a stick-on
color tab.
Th ere a re seven labels available in the Label menu. Each has a colo r associated with it. Ite ms with a particular label will appea r in that color in any
win dow view (on color monito rs only, of course). Each label also has a d efault na me: Essential, Hot, In Progress, Cool, Personal Project 1, and Project 2.
The label name wi ll appear to th e right of the file name in list v iews if yo u so
ch oose. To assign o ne o f these labels to a file or fo lder, fo llow this simple
p roced ure:
1. Select the item

2. From the Label menu, choose the appropriate label.
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Note
On color systems running System 6, you are able to assign colors to files with the
Color menu. While this is not as advanced as System 7's labeling feature, it can be
used for similar purposes. A red item could be considered urgent, green ones low
priority, and so o n.

By assigning labels to your files and folders, you are able to m ake them part
of a group of items-even though those items may not be located in the same
folde r. You'll be able to exploit this grouping power using the Find command
discussed later in this section. The Find command will conduct a search fo r
all files that share the same label, easily locating a scattered group of associated fi les.

Using Aliases
There is a special kind of Macintosh file that doesn't have an obvious counterpart in our everyday world. This is the Macintosh alias, a feature added to
the Macintosh Finder with System 7. To understand what an alias is, consider
the following file cabinet scenario.
Say you keep a folder for your taxes in you r file cabinet, called, of course,
Taxes. Inside, there is an invoice fo r one of your freelance projects. While this
docu men t pertains to the Taxes folde r, it also pertains to a folder you keep
called Freelance Income.
It would be helpful to have the document in both of these folders. This way,

you wouldn't overlook the document when you open the Freelance Income
folder. Used for man y d ual-category files, this would let you much more easily locate and use important files.
To have a file appea r in two folders, you could make a complete copy of the
document and keep it in both folders. But if it happened to be a document
with many pages, or a photograph, making and keeping a copy could be
quite awkward. Besides, you don't wa nt to waste precious space (or paper) in
your file drawer.
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There is a more convenient alternative. Instead of keeping a fu ll copy of the
document in the second folder, you could m ake a short n ote about it on a
small piece of paper. This note would indicate t he na me of the document and
the folde r it is actually located in. You coul d keep such a no te in every folder
whose topic relates to the document.
Thus, wh ile the docum ent would actuall y exist in o nly one place, it would
virtt(ally exist in every folder that contains the note abo ut it . Instead of having a bu nch of space- and paper-wasting copies, you wou ld have these sma ll,
convenient notes referring to-and pointing the way to-the actual document. Macin tosh aliases are just like these notes.

Note
Althoug h there is such a thing as an alias in the real world, its purpose does not
exactly parallel the purpose of a Macintosh alias.

Macintosh aliases, however, bear much more power than sheer reference
notes. Not o nly can you put them anywhere and everywh ere on your hard
disk, but each alias yo u make behaves as if it is the file itself. Tha t means t hat
you can open the actual file using any of its aliases. An alias will also let you
gai n q uick access to the actu al document.
Finally, while the example of a document was used in the explanation above,
aliases can be created for any type of Macintosh file-be it an application,
control panel, d ocument, folder-or even an entire hard disk. An unlim ited
number of aliases can be created for each of these Macintosh file types. The
resul t is convenient access to any type of Macin tosh file from anywhere o n a
disk.
The Alias File

What does a Macintosh al ias look like? When you create an alias on your
Maci ntosh, it looks just like an y o ther Macin tosh file with just one visible
difference: the name appears in italic text. Figure 7.12 shows you the difference between a regular Macin tosh file and its alias. The o riginal file is called
Im po rtant Document and the alias is called Impo rtant Document alias.
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Fig.7.12
A regular file (left)
and its alias
(right).
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As you can see, the icons for both the file and the alias are identical. But the
text that indicates the name, being italic, slants to the right.
Beyond their appearance, the two icons are similar in behavior. That means
that double-clicking on, o r choosing the Open command for either one has
the same effect: it opens the original file. But there is an important difference
between the two as well. The alias takes up much less disk space. Like any
other Macintosh file it has a size, but no matter how big the original file, the
alias is very small. Therefore, you can freely spread the icons around your
hard disk without worrying about occupying large chunks of valuable space.
Creating an Alias
Making an alias for a file is as easy as issuing any other Finder command. You
simply select the item you want an alias for. Then, from the File menu,
choose the Make Alias command. The alias immediately appears in the same
wi ndow, with the same name. (As discussed, the letters are in italic text and
the word alias is attached to the end of the file name.)

Once it's created, you can put an alias in any location you li ke. After it's been
relocated, you may want to rename it. The alias will still be able to open the
original fi le, no matter what its name. For your own sake, it's a good idea to
use a name that indicates what the o riginal file is. Most users just give it the
same name as the original, simply by deleting the word alias.

Note
If you are going to delete alias from the alias's name, you have to wait until after
you've moved it. The Finder won't let you keep two items with the same name in the
same folder.

Places to Keep Aliases
You can, of course, keep an alias anywhere you like. A logical approach is to
keep them in related fo lders and locations that you access most freq uently.

Tip
An easy way to
find an o riginal
file is to open the
Info window fo r
the alias (with the
Get In fo command
d iscussed earlier)
and click the
button named
find Original.
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One of these is the desktop itself. Some users like to line up aliases of their
favorite applications or documents along one edge of the desktop, as seen in
figure 7.13. Thus, these items are always a mouse-click away. Use cau tion,
however, not to clutter the desktop with too many aliases. Otherwise, the
purpose of easily locating items is defeated.

Fig. 7.13
Application and
document ali ases
arranged o n the
desktop for easy
access.

One of the most favo red places fo r aliases is in the Apple menu. Just as th is
menu g ives you quick access to popular tools li ke a ca lculator and a clock, it
can give you quick access to any file o r folder you like. To make you r frequently used items part of this menu, follow this procedure:
1. Make and name an alias fo r the item. (See "Creating an Alias.")

2. Open the System fo lder (located o n you r hard disk).
3. In the System Folder, open the folder called Apple Menu Items.
4 . Drag the alias into its wi ndow. (Alternatively, you can skip step 3 and
drag the alias right to the Apple Menu Items folder icon.)
After completing th ese steps, the item will appear in the Apple menu, according to its alphabetical o rder. Choose the item just as you would choose any
other item in the Apple menu.
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System 7.5 makes its own special additions to the Apple menu. Yo u can easily
open recently used applications and documents by selecting the Recent Applications or Recent Documents items that appear in th e Apple menu. If you
hold the mouse button down while these items are selected, a submenu
appears to the right. The Recent Applications submenu displays a list of
recently used application s. Selecting o ne of them lau nches that applicatio n .
Selecting items in the Recent Documents sub menu will open any recently
o pened documen t. This is much more convenient than navigating through
multiple windows to access frequently used fil es. For more details on these
special Apple menu items, see "Easily Opening Recent Applications and
Documents" later.

Using Stationery
There is one mo re special kind of Macintosh file useful in o rga nizing and
using documents. This is th e statio nery file. A stationery file is li ke a template
of a document. It ho lds contents you regularly include in new documents.
Each time you o pen a stationery file, you open a copy instead of the original.
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It's easier to understand if you compare it to normal office statio nery, which
also acts a template. It may contain preprinted text and graphics that appear
o n every letter or memo you write. Usually the preprinted material would
include a company logo and its address and phone number. Yo u can create a
similar file with a word processing or graphics application with a statio nery
file. To make any fi le a stationery file, check the statio nery option in its Info
window (see "Getting More File Informatio n," earlier in this chapter.)
After a file is turned into statio nery, you'll be asked to name and save a new
copy of the file whenever you o pen it in the Finder. (Refer to figure 7.1 4.) The
appropriate applicatio n then launches to open the copied file. Applicatio ns
that recognize statio nery files, however, will immed iately open a new copy in
an untitled window. You then save the new document as you usually would,
using the Save command. You can edit this new file, adding the text of your
letter and so o n to the existing company logo and address.
You hnue opened n stntlonery pnd, so a
new document will be cre ated.

Typ e o nome for tho new document:
!Memo Template copy

§~ (

Cancel

J~

OK

Fig. 7.14
This dialog is
displayed when
you open a
stationery file in
the Finder. It lets
you name the
stationery's copy
file and save it
where you like.
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Whenever you want to ed it the original stationery file again, you' ll need to
uncheck the stati onery option in the Info window.

Caution
Most new applications recognize statio nery files, so you are able to open them from
within the application. The application will open a copy of the file, usually in an
untitled window. If the application doesn't recognize the stationery, you'll get a
warning that you are about to open (and possibly alter) a stationery file. The safest
way to open a stationery file, therefore, is in the Finder.

Using the Find Command to Round Up Files
As d iscussed at the outset of this chapter, the growing number of files o n
you r d isk can become unwieldy witho ut an o rganizational plan. Even with
such a plan, however, you may have difficulty tracking down items on your
disk. Thankfully, you can put your Macintosh on the job of finding lost files.
Even if they're not lost, the Mac can help you avoid o pening folder after
folder to get to a file. To do this in System 7.1, you use the Find command,
located in the File menu. The dialog displayed in figure 7. 15 will appear. Note
that this Find command is also available in System 7.5. But System 7.5 adds
an improved file-finding utility, called Find File and accessed in the Apple
menu, which is discussed at the end of this section.
Fig. 7.15
The dialog
displayed when
t he Find command is used.

Find
rind: ....__ _ __

_ _ __

__

( Moro Choices )

Tip
The more completely you type
the fil e's name in
the Find dialog,
the fewer guesses
the Finder will
have to make in
locating a matching file.

When you type some or all in the file's name into the empty field and click
the Find button, the Finder starts its search . When it finds a file o r folder with
those letters in its name the Finder d isplays the window containi ng that item.
You can then proceed as usual.
If th e item it finds for you is not the one you're after, you can have it continue to search. To do this, simply choose the Find Agai n command in the
File menu. It wi ll display the next file wh ose name contains those letters. You
can continue this way until you reach the file you want.

Special File Organization Tools
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You may have no ticed the Find dialog's More Cho ices button. (Refer to fig.
7.15.) If you click this button, you are given a broader range of criteria to
search fo r, as d isplayed in fig ure 7. 16.
Find

rind and select Items whose
.... ] rl -c-on7 tn...,.ln-s--,..-.l ' - - - - - - - - - '

nnme

Scorch

I

on "Moclntosh ItO"

•I

0

nllot once

[ Foouor Ch oices J

When periodically sorting out and gathering files for o rganization, t his dialog
can be a great help. Because you can use this feature to search for files by size,
kind, label, date created or modified, version, comments, and locked status.
You may want to search for all your fi les over 1M in size, for example, to
delete the ones you don't need. Or you may wa nt to search for all items with
a Hot label. As mentioned in t he section "Using Labels to Tie Items Together," searching by label gives you easy access to all items associated with a
particular file. Also, to search for all items you modified on a particula r date,
you can search by the date modified criterion. In these ways, the Find comman d can be a very powerful file management tool.
If you want to see a set of found files at once, check the all at o nce optio n.
This optio n causes all fo und items to appear at o nce in a w indow in list view.
The Finder indicates fo und items by selecting them.

Note
To search by more than one criterion, conduct a search by the first criterion with the
all at once option checked. Found ite111s will be shown selected in a window. Next,
choose Selected Items from the Search pop-up menu. Search again by the second
criterion. Repeat the last two steps for all your criteria. The items that meet all the
criteria will be selected in a window when you're done.
To limit the search to a particular disk, folder, or group of folders, use the Search
pop-up menu in the middle of the dialog.

Fig. 7.16
The Find dialog
after the More
Choices button is
clicked.

136

Chapter ?-Organizing Your Files, Folders, and Disks
The standard Find command described previously is also available in System
7.5, but a much improved file finding utility is added as well. To access it,
from the Apple menu, choose Find File. With this new utility, all finding
criteria are immediately available for any search. In the initial dialog, you can
choose a criterion from the pop-up menu and then enter any text, date, and
so on. in the empty field. Each time you click the More Choices button, an
identical search dialog (with pop-up menu and text field} is added below the
first one. Thus, additional criteria can be easily entered. Refer to figure 7.17 to
see how a multiple-criteria search looks.

Fig. 7.17
Syste m 7.5's new
Find comma nd
produces this
improved dialog.
Additional search
criteria are easily
added to a search
by clicking the
More Choices
butto n.
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W hen items are found, they are now displayed all at o nce in an easy to view
list (refer to fig. 7.18). This list can be viewed by name, size, kind, or date. To
open one of the items, choose the Open command from the Fi le menu or
simply double-click on the item. To view an item in its own window, choose
the Open Enclosing Folder command from the File menu.
Fig. 7.18
System 7.5
displays fo und
files in an easy-toview li st.
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Easily Opening Recent Applications
and Documents
With the introduction System 7.5, there is now a convenient way to access
freq uently used applications and documents. A memo o r a recent sales report
are examples of docum ents you might be working with frequently over a
period of days or weeks. It's handy to have quick access to these items each
time you go back to work, without having to open up a series of nested folders. To provide you with this quick access, System 7.5 automatically does the
foll owing:
• Creates al iases of recently used applications and documents
• Keeps these aliases in two special folders: Recent Applicati ons and
Recent Documents
• Makes both of these fo lders available through the Apple menu
To access a recentl y used document, you simply select Recent Documents in
the Apple menu. This opens the Recent Documents folder, which displays
aliases of you r most recen tly used documents. The same procedure is followed for recent applications by selecting Recent Applications in the Apple
menu.
There is an even quicker way to access these recently used items, however,
with another new capability of System 7.5. The Apple menu can now display
submenus for folders contained in the menu such as the control panels and
the Recent Applications and Documents folders. These submenus d isplay the
items contained in each folder.
Note
If your Apple menu is not displaying submenus under System 7.5, use the Apple
Menu Options control panel to turn this feature on. In the section of the control
panel entitled Submenus, click the On option. You can also set how many files should
be shown in the various submenus.

In the case of the Recent Applicatio ns and Documents folders, the items d isplayed in the submenus are the aliases of the recent items. Choosing one of
th ese items in the submen us opens that particular application or docu ment.
(Refer to figure 7.19.)

Tip
System 7.S's Find
window displays a
list of an item's
enclosing folders
(or its file pnt/7) just
below the list of
found items. C licking on one of
these folders (or
the enclosing disk)
opens that folder's
window.

138

Chapter 7-0rganizing Your Files, Folders, and Disks

Ill

Fig. 7.19
A recently used
application being
selected in the
Apple menu's
Recent Applications submenu.
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To change the number of recently used items that are displayed in the
submenus, use the Apple Menu Options control panel. In the section entitled
Recent Items, change any of the defau lt numbers for each folder to the number of your choice. Once you experience the convenience of this new feature,
you may find opening applications and documents this way easier than
opening up several folders at a ti me.
Note
The alias of any folder or disk can be placed in the Apple menu to have its contents
displayed in submenus. This gives you instant Apple menu access to disk and folder
contents up to five folders deep without opening any folders. The contents of any
nested folders appear in a submenu attached to the first submenu-and so on until
the contents of up to five nested folders are displayed. Try placing an alias of your
hard disk in the Apple Menu Items folder (located inside your System Folder) to see
how this works.

Note
Another Recent folder appears below the Recent Applications and Recent Documents
folders in the Apple menu: the Recent Servers folder. This lets you access any servers
that may have been recently mounted over a network just as easily as you can access
recent documents. For more on servers and networks in general, refer to Chapter 33,
"Networking. "

Useful AppleScripts
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Using the Launcher
just as you can add items to the Apple menu, you can now add items to a
special window added to the Finder in System 7.5. This window is called
Launcher. Adding items to the Launcher is just like adding items to the Apple
menu. You simply make an alias of the item (application, document, or any
o ther file) and put it in the Launcher Items folder, which is located inside the
System Folder. These items appear in the Launcher window in the Finder, as
seen in figure 7.20. Each item gets its own big button. Clicking once on the
button opens that particular item.
Fig. 7.20
The Launcher
provides quick
access to applications and docu·
me nts in the
Finder.

Note
If the Launcher window d oes not appear in your Finder, you can make it do so by
opening the Launcher control panel. Doing so immediately causes the Launcher to
appear. To hide the Launch~r window, simply click its close box.

Useful AppleScripts
Since AppleScript is now part of standard system software with System 7.5,
more users have access to its handy automation features. A few such features
are provided with the system software as well, in the fo rm of ready-made
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scripts for performing some common file management tasks. These scripts are
kept, along with an excellent explanation of AppleScript called AppleScript
Guide, inside a fo lder called Apple Extras. The Apple system software installer
locates this folde r at the top level of your hard disk. It's easier to locate the
folder, however, by using the Apple menu, where the installer also leaves an
alias of the Useful Scripts folder. With the submenus option turned on (see
note in "Opening Recent Applications and Documents" previously), you can
instantly access the scripts contained within the folder.
AppleScripts will automatically perform tasks such as making an alias for the
Apple menu, finding an alias's original file, and so on. To use the scripts in
the Useful Scripts folder, you don't really need to know that m uch about
AppleScript, just how to properly use the scripts themselves. Following are
descriptions of the scripts for file management and how they are used.
• Add Alias to Apple Menu. This script automatically creates aliases of any
file or folder and places it in the Apple Menu Items folder, which causes
it to appear in the apple menu. Simply select any item(s) you want in
the Apple menu, then choose this script in the Useful Scripts submenu.
Alternatively, you can open the Useful Scripts folder and drag and drop
the items directly onto the script's icon.
• Close Finder Windows. Select this script in the menu to automatically
close all open windows in the finder. (Personally, I prefer to close one
of the windows with the Option key held down, which accomplishes
th e same thing.)
• Eject All. Select this script to eject any floppy disks, compact discs, and
Syquest or Bernoulli cartridges that may be mounted on your
Macintosh. If file sha ring is active for any of these disks, the script turns
off file sharing, ejects the disks and then restarts file sharing. (Use caution to ensure no users are sharing files on any of the disks before running this script.)
• find Original. If you select one or more aliases in the finder and then
select this script, it will find all the original files for each of the aliases.
•

Hide/Show Folder Sizes. If folder sizes are currently displayed in Jist
views, selecting this script will hide them, and vice versa. (This is an
easier alternative to turning this option on and off via the Views control panel.)

From Here. ..
• Sync Folders. Selecting this script will match up- or synchronize-the
contents of two folders. You may want to make sure a backup folder
you keep on a floppy disk, for example, is synchronized with the original folder on your hard disk. If one folder contains a document that the
other one doesn't, this script copies the document to the other fo lder.
For documents with the same name, the script copies the one with the
more recent modification date to the o ther folder. To use the script,
select it and it will prompt you to show it which two fo lders to synch ronize.

From Here ...
In this chapter, you learned how to use the Finder's main fi le management
features. Of course, you won't have much to manage until you start using
applications to create new files. Many such applicatio ns are covered in Part
IV, "Macintosh Software. " You'll also find a great deal more Finder informati on in Part III, "Customizing Your Macintosh" and Part VII, "Troubleshooting and Preven tive Maintenance."
• Chapter 11, "Changing the Look of Your Desktop" shows you how to
use Apple and other companies' control panels and extensions to
modify the Finder and the desktop to better suit your working style.
• Chapter 12, "Creating and Mod ifying Icons, " plunges into customi zing
that most common feature of the Finder, the icon. You' ll learn how to
make an y icon look just right for the job.
• Chapter 38, "Preventive Maintenance," should not be ski pped. In covering good Mac habits, it wi ll show you what habits should be part of
your regular Finder work. The section on essential utilities will also
show you some key maintenance uti li ties for keeping your files and
disks in tip-top shape.
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All about Fonts

In the days when typefaces were cast fro m lead, a font consisted of a set of
letters, both upper- and lowercase (except for all caps styles), numbers, and
additional characters-all in a single size. Through time, that definition has
become blurred, beginning with the advent of phototypesetting systems in
the 1960s when all of these letterforms were stored on film negatives and
reproduced on photosensitive paper or fi lm. Although some of these early
typesetting machines kept with tradition and had a single set of negatives for
each size, others used a lens assembly to enlarge the image to produce size
changes.
The 1970s brought the digital type revolution, as the contents of these fonts
were reduced to a set of ones and zeros, and contained on floppy disks or
hard drives. Imaging was done with a cathode ray tube assembly that imaged
the letters onto the same photosensitive media used in the earlier generations
of typesetting machines.
When the Macintosh came on the scene in the 1980s, several key developments occurred, sparking the desktop publishing revolution. One was the
invention of PostScript by Adobe Systems, and another was the introduction
of the original Apple LaserWriter, which contained a computer that read
PostScript code. A third event was the arrival of several desktop publishing
software applications that enabled users to view the pages of their documents
WYSIWYG style (what-you-see-is-what-you-get) on-screen. Chapter 21,
"Desktop Publishing," discusses the latest versions of those programs in more
detail.
In this chapter, you Jearn the following:
• What Macintosh fonts consist of
• How to choose the correct font for your document
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• How to cope with bitmap, PostScript, and TrueType fonts
• How to effectively manage your font library
The fonts you buy today for your Macintosh are often derived from the very
same designs that were available to typographers years ago. The wider market
for fonts has also encouraged a new generation of artists to design fonts based
on traditional designs or to create their own designs from scratch. You can
choose from thousands of fonts, ranging in price from less than a dollar, to
fancy packages on CD-ROM costing thousands of dollars.
There is also a confusing dichotomy in font formats. Installing and working
with fonts on your Macintosh isn't always a simple process. Sometimes it's
fraught with pitfalls. The following sections concentrate less on showing you
some of the available fonts and more on how to install and use them more
effectively on your Mac.

Serif Fonts
Fonts are generally divided into two broad categories, although some fancier
designs have characteristics of both categories. The first category, a serif font,
contains little hooks or stems that extend outward from the top o r sides of
the character, as shown in figure 8.1.
Fig. 8.1
Times Roman, a
typical serif font.

How razorback jumping frogs

Al though serif fonts look fine for headlines, they are typically used most
effectively for setting body text. As with all artistic considerations, your taste
is what counts.

Sans Serif Fonts
A sans serif font simply means the font was designed without those little
hooks o r stems, as shown in figure 8.2.
A sans serif typeface is commonly used fo r headlines or large text, although
it can be used in some body text applications.

More Font Lingo

How razorback jumping frogs
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Fig. 8.2
Helvetica, a
popu lar typeface
used for both text
and headlines.

More Font Lingo
When you begin to use fonts, you will encounter some specialized terms th at
aren't a normal part of the English language. Following are some commonly
used terms:

• Point size. A font is m easured by figuring the distance between the bottom part of a character, such as the letter g, known as the descender, to
the top of the character, known as the ascender. A point is roughly a
72nd of an inch. I say roughly because in traditional typesetting there
were 72.27 points to the inch, but this measurement has been rounded
off for the desktop publishing world.
• Leading (pronounced ledding). Sometimes known as line spacing, leading
is the distance from one line of type to the next.
• Monospace font. These are fonts that match the ones you use o n a normal typewriter. All the characters in the font occupy the same space.
Monospace fonts include Courier and Monaco. Figure 8.3 shows a
sample of a monospace font.
How razorback jumping frogs

• Proportional font. These are the fonts used most often for your desktop
publishing or word processing chores. Each character in the font gets its
own custom increment of space. The letter i, for exa mple, occupies less
space than the letter m. Figure 8.4 sh ows a popular proportional fo nt
with wide spacing differences betvveen the narrowest and widest letters.
• Em-space. This is a common measure of space, usually used to indent
text at the beginning of a paragraph. It usually refers to the width of the
capital letter M, which is generally the widest letter of the alphabet in a
proportional font.

Fig. 8.3
Courier, a common
monospace font.
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How razorback jumping frogs

Fig. 8.4
Adobe's Sto n e
In forma l, used
wid ely fo r writing
letters and as body
text in newsletters
to provide a
friendly (or
in fo rmal) fe el.

• En-space. Sometimes an en-space is defined as th e width of a numeral,
but actua ll y it refers to the width of the lowercase 11, wh ich is about half
the width of the em-space.
• Em-dash. This character is a long dash, which looks like- o n the
printed page (an em dash is represented by two hyph ens o n a typewriter, such as-). It is generall y used to indicate a change in tho ught
in the middle of a sentence-like this.
• En-dash. This is a middle-sized dash, which usuall y is used to represent a
range of numbers, such as from 9:30-10:30 PM.
• Ligatures. This is a typesetting tradition that's fa llen into disuse loa
large degree. It involves a single character consisting of two o r more
letters run together, which provides an improved appeara nce. Ligatures
are commonly used with serif typefaces in h igh qua lity books and advertising. The most common use is fo r such combinations as fi or_ or
f1 and _. The other most commonly used ligature, ffl, is not found on
most Macintosh fo nts, except for the Adobe Expert Collection.

Caution
1-

-

If you set your text w ith ligatures, you are apt to fou l up most spelling checkers, which will almost always flag the unusual letter combination and slow
down the spelling checking process . Other than QuarkXPress, w hich automatically recognizes the programs automatic ligature feature, you are best advised
to add ligatures after you spell check your documen t. just do a sta ndard
search-and-replace routine.

• Smart Quotes. When the keyboards in personal computers were designed, they kept some relics of old-fashioned typewriters, such as those
awkwa rd stickup quo tes, which use a single character to represent an
open or closed quote, rather than a separate character. But the typical

Font Formats
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Macintosh font does have those characters, called "curly" or "smart"
quotes. You just have to hunt for them. For a true open quote, just like
th e ones used in this book, press j:(-f. For a closed quote, press :J:C-Shift[. A single open quote is produced with :l=C-], and a single closed quote
or apostrophe is produced by pressing j:(-Shift-j.
Note
Thankfully, most desktop publishing and word processing software has a smart
quotes option, which enables you to type a regular stickup quote and get a
curly quote instead. If your software doesn't have this option, you can use
programs such as the freeware SmartKeys (available on local BBS and the
regular online services) or a commercial product, Thunder 7, an interactive
spelling checker from Baseline Publishing, to provide automatic curly quotes.

• French spacing. With a normal typewriter, with all characters in a font

having the same amount of space, you put two spaces between sentences to make your material more readable. In typesetting, you space
just once between sentences. It's something experienced typists must
get used to when learning the basics of desktop publishing. But there
are times that designers will ask for French spacing, which simply means
that you revert to that old forgotten skill you learned in typing class,
and type two spaces between sentences.

Font Formats
Macintosh fonts come in three flavors: bitmap, Postscript, and TrueType.

Bitmap Fonts
Originally, there were bitmap o r fixed size fonts, which reduced the letters
and numbers in a font to little dots, based on a 72-dots-per-inch (dpi) resolution. These fonts were also known as fixed size fonts, and you needed a separate font for every size. If you didn't have a font in a particular size, your
Macintosh would use its QuickDraw imaging model to build a font from the
sizes you did have, often resulting in a jagged or brick-like aspect to the fonts.
Figure 8.5 shows what a bitmapped font looks like when set in its actual size,
and figure 8.6 shows what happens when you deviate from that size.

II
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Fig. 8.5

How razorback jumping frogs

An 18-poin t
bitmapped font-

HOV¥ razorback
jurnping frogs

Fig. 8.6
The same bitmapped fo nt set
in 72 point.

In the days when Apple's ImageWriter or a similar impact printer were the
only ones you could buy, a bitmapped font was all you had. And considering
the 144-dpi li mi tatio ns in printer resolution, it was sufficient. But when desktop publishing came to the Macintosh in 1985, yo u needed something more.

Note
You can tell a bitmapped font simply by looking at its name and icon, as shown in
figure 8.7. The bitmapped font comes in a suitcase, and the file itself has a name that
includes its size.

~

Fig. 8.7
A typical bitm apped fon t icon.

1 Stone Ser-if 1 2

Enter PostScript Fonts
The folks at Adobe Systems invented a page descri ption language, called
PostScript, that described the con tents of a page in mathematical terms. By so
do ing, they made the file independent of the output resolution of the printer
that was used-the words Adobe used were device i ndependence. So if you
output your job on a standard 300-dpi laser prin ter, you would get 300-dpi
output. If you took the same file and ran it on an imagesetter capable of
3600-dpi, the result would be correspondingly sharper.
PostScript fonts use the same techno logy to describe the outlines of a font.
The printer fills in the spaces between the o utlines and creates a bitmap consisting of the image of the page, fonts and all. A PostScript fo nt is often called
a scalable font because it will print sharp and clear at whatever size you set,
whether 2 point or 720 point o r mo re.

Font Formats
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Type 1 and Type 3

When Ado be created the PostScript font format, it released a Type 3 version,
which was freely available to other fo nt vendors, and a Type 1 specification,
which was tightly con trolled and had to be licensed. Type 1 fo nts, of course,
printed more efficiently; it also had hints, or little programming tricks, that
made it look sharper when printed on a low resolutio n printer in smaller
sizes.
When TrueTyp e fonts, ano ther second scalable fo nt fo rmat, was announced
by Apple and Microsoft, Adobe did two things. First, it released Ado be Type
Manager, a truly marvelous little program described later in this chapter.
Seco nd, it made the Type 1 fo nt for mat freely available, so all fon t developers
could produce as m any Type 1 fo nts as they wished witho ut writing a check
with the name Adobe o n it.
The o utcome was that Type 1 fonts flo urished, and Type 3 fonts languished.
Altho ugh Type 3 fon ts are generally not as useful as Type 1 fonts, they h ave
the advantage of suppo rting complex fills and shadings that are no t feasible
with Type 1 fonts. You are stil l apt to find a Type 3 font here and there containing a truly decorative logo of so me sort.

II

Screen Fonts
The most confusing aspect of Type 1 fo nts is that you need to install two files
to use them. The first file is known as the printer o r outline font. Their icons
vary fro m developer to developer. Figure 8.8 shows two samples.

Sto n~s~r

l:i

BCC~nNor

Th e second file is a fixed size bitm ap fon t, or screen fo nt, that co ntains the
metric (size and width in fo rmation) of the fo nt, including the preset character kerning pai rs (and we'll get to kerning sho rtly). In order to use your
PostScript font, you need both a printer and screen fo nt for each face. Having
either just won't cut it. If you just have th e outline fo nt, that face won't even
show up on your fon t menu. If the screen fo nt is installed, and the printer
font is missing, you'll see the fo nt listed among your available fonts, but the
quality of reproductio n will be poor, the same as if you used those oldfashio ned bitmap fo nts described in the preceding section.

Fig. 8.8
The icons of Type
1 PostScript fo nts
from Adobe
(left) and Font
Company (right).
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Enter TrueType Fonts
The third member of our font trio is a font fo rmat first announced by Apple
under the name Royal, which was designed to be a part of System 7.0 when it
was released in May of 1991. Like PostScript fonts, TrueType was a scalable
font format. The font could be set in any size you wanted. But it had two big
advantages over PostScript fonts. The first was that you didn't need to install
two font files. The bitmap and outline font were combined. True, sometimes
a set of screen fonts would be supplied with TrueType, to provide slightly
faster, sharper screen display, but you did not have to install them if you
wanted to save a little disk space.
The second advantage was that the rasterizer, or font processing software, for
TrueType fonts was a part of Apple's System 7. You didn't have to have a
PostScript printer, and you didn't need to install another Extension, Adobe
Type Manager (or ATM), to make your fonts look good on-screen and print
clearly on a QuickDraw printer.
Note
To use TrueType fonts under System 6, you need to install Apple's TrueType init,
which is part of the TrueType disks available on the major online services, such as
America Online, CompuServe, and eWorld, or from a local user group. This init,
along with Font/DA Mover 4.1, is all System 6 users need to use True Type fonts. The
init is supported by Apple for System 6.0.7 or 6.0.8, but is reported to work with
System 6.0.5 as well.

To the eye, the icon of a TrueType font looks the same as the bitmap font,
with two differences, as shown in figure 8.9.
Fig. 8.9
A TrueType
font icon .

App leG.lramond Bd
The first difference is the design showing three A's, each progressively larger
than the other. This indicates this is a scalable font. The second difference is
the lack of a size in the font's name.

Font Use Priorities
Although it only affects you in a marginal way, your Mac running System 7.0
has built-in font priorities that it uses in bringing images to your screen. If
you have a bitmap font installed, it is used. If you have a TrueType version

Font Formats
and not the bitmap font, it gets next priority, and if the bitmap is generated
by using Adobe Type Manager (covered shortly), it gets next priority. If you're
using a size for which there's no bitmap equivalent, no TrueType font, and
ATM is not installed, th e Mac will generate a screen image based on its best
(and it's none too good) efforts.
Your PostScript printer has different priorities. If a PostScript font is installed
in the printer's ROM (a resident font), that's what is printed, regardless of
whether there's a TrueType version installed on your Mac. If there's no
PostScript printer font available, the TrueType font gets called. When none
of these options are handy, the bitmapped fo nt is used to generate a 72-dpi
image of the text you see on-screen (definitely not recommended).
The priorities are changed with a QuickDraw or non-PostScript printer. If a
TrueType font is available, it's called upon to do its thing first. The PostScript
font, if available, gets called next in order. And finally, when these two are
unavailable, the bitmapped font is used.

PostScript or TrueType-Which Is Best?
When TrueType fo nts first came on the scene, there were h eated arguments
as to which font format would reign supreme. The furor soon died down.
TrueType fonts failed to attract large design studios and service bureaus with
an investment of tens of thousands of dollars in PostScript fonts and high
resolution printers, but they managed to get a new lease on life when
Microsoft decided that Windows 3.1 would emphasize TrueType.
Today both fonts coexist, with more TrueType fonts available in lower-cost
packages, but PostScript fon ts are getting cheaper as well (more about that
later in this chapter).
In theory, TrueType fonts are capable of more sophisticated hinting. But
since font developers usually produce their PostScript and TrueType fonts
from the same set of artwork, the printed q uality is pretty much the same.
TrueType fo nts have a disadvantage at service bureaus, where older imagesetters and high resolution laser printers may need hardware updates to support this font format. Chapter 11 covers printing-related issues.
Mixing and Matching
The choice of which fon t format to use is yours, and you will get satisfactory
results with either PostScri pt or TrueType. You can install fonts in both formats on your Mac, as long as you don't install the same font in both versions.
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If you have, say, a PostScript version and a TrueType version of Helvetica, you

are apt to have a font conflict, with incorrect or missing characters appearing
on-screen or on the printed page.
Which Is Faster?
If you use Adobe Type Manager, the fo nts disp lay more quickly on the screen
than a TrueType font- if you don't have a screen font available in the size
you pick. The reason for this is that ATM stores its screen font bitmaps in a
RAM cache, while System 7 builds a TrueType screen font dynamically as
needed and doesn't store it. (Adobe Type Manage r is covered later in this
chapter.)
..,. See "What is

PostScript
Compatible?"
p. 211

As fo r printing, a PostScript printer generally processes a PostScript fo nt
faste r, unl ess it has a built-in TrueType rasterizer on hand, which will more o r
less place performance on roughly equal terms. The manual for your printer
will explain whet her it does o r not. As far as a non-PostScript printer is concerned, don't expect much of a performance advantage one way or th e other.

How Not to Use Fonts
The watchword in selecting fonts for your document is restrai11t. Too many
styles, too many sizes, and you' ll end up making your document difficult to
read. The simplest way to design your document is to use a serif typeface for
text and a sa ns serif face for headl ines, as shown in figu re 8.10.
Fig. 8.10
A si m ple h eadline
and a paragraph
of body text, u sin g
two popular serif
and san s serif fonts.

Math

&f cllcldng on the Math ButtDn Wlthm the
Tobie Bar, sim ple math !unctio ns (odd, Jib.
t:nlet, mulb.Jiy , cbvide, rum, and awln!ip) 31'0
ollen!d ><ithin tobles. \Jstn g the Math Bar,
you can quickly rum a. :elected row or col·
umn o f nu."'nbec With the dick of a button.

~~ur:~:Ocol~~~~~e!~~fo~~::

tax error:

Remember that you wa nt your document to be easy to read, and you don't
wa nt the design to get in the way of clarity and readability. Using a type
design for body text that is d ifficult to read or meant strictly for headline use
wi ll only make your document less attractive and less apt to be read carefully
by the end user. Figure 8.1 1 shows you what happens when you pick a typeface fo r body text that looks fancy but req uires extra effort to read.

The Mac's Confusing Type Styles

Mat h

Fig. 8 .11
Can you read this
text easily-or at
all?
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The Mac's Confusing Type Styles
just abou t every Macintosh program has a font style menu that displays the

same choices-Roman, Bold, Italic-as shown in figure 8.12. If you select
both Bo ld and Italic, you get Bold Italic. Fonts produced by the major developers carry a fami ly relationship, so if you select the italic va riation, that's
what you get on-screen and on the printed page.
Fig. 8 .12
A typical
p rogram's style
menu.

-'Pi nln
Bold
11111/t:

.ll.nJIJI.tll.n

!lk!JIIIIbxg

The problem occurs when the font has more than four styles-and many do.
You may find variations such as demi-bold, demi-bold italic, extrabold,
extrabold condensed-you get the picture. These additional styles aren't
ava ilable from you r Style menu, so you are left with choosing them from
your regular Font m enu.

Note
One notable exception exists to this four-style rule: FrameMaker's sophisticated
Paragraph Designer and Character Designer features (which are described fully in
Chapter 21, "Desktop Publishing") offer all of the variations available in a typeface
family, whether six, eight, twelve, or more.

Caution
If you d on't have the actual styled variation of a font installed, and you choose that
version from the Style menu, your Mac will try to generate it on-screen, but your
PostScript printer will give you the regular or Roman version-or at worst, you'll get
a doubled image. A QuickDraw printer uses your Mac to process documents and
will usually try to simulate the missing style, but not necessarily with great precision.
If you aren't certain that the correct style is installed, choose it directly from the Font
menu.

-
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Font Menu Modifiers
Normally, your typical Mac program shows each typeface style separately in
your Font menu. This can get confusing wi th some of the older Adobe fonts,
which use oddly labeled styles such as B Times Bold o r J Times Italic. They
don't show up in alphabetical order on your fo nt menu, so picking the right
face sometimes becomes a chore (see fig. 8.13).
Fig. 8.13
Some Mac fo nts
have confusing
names and
don't appear in
a lphabetical order.

Am e rlcon Typ ewriter
B I Slone Se rif Bold
B 2Siono Sons Bold
B 3Siono lnformo l Bold
o nmorlcon TypewrHer Oo ld
B Courier Bold
B Hel uellco Bold
o Now Century Schlbk Bold
B Polo Uno Bold
o Souuenlr Oeml
o nmo s Oold
Bl I Slone Serif Doldll ollc
01 2S ion e Sons Ooldllollc
81 3Sione lnformol Doldllollc
81 Courie r DoldObllq ue
81 ll e luellco BoldObllque
01 Now Cent ury Schlbk Oold ll
81 Polo llno Doldllollc
01 Souuenlr Oe mlllollc
01 nm e s Ooldllollc
Birch

Thankfully, most newer fonts use names that are properly alphabetized. But
even then, your font menu may grow long, especially if you have a smaller
screen or a large number of fonts at your beck and call. There are several
handy programs that keep your font menus o rga nized . O ne is Adobe Type
Reunion, which places all styles in a given font fam ily in a sub-menu. Both
Menu Fonts from Dubi-Ciick Software and WYSIWYG Menus, part of Now
Utilities from Now Software, not only group fonts by family, but show them
in their actual typeface as well (see fig. 8.14) .
Fig. 8.14
WYSIWYG Menus
from Now Software shows fonts
in their true styles.

New York
Palot!no

Ravaa

.11\A)mao
~

Bold
Bold ltalic
Italic

I

Menu Fonts and WYSIWYG Menus have an added convenience. When you're
using a font with all symbols, o r a fancy script font whose name may not
show clearly on a font menu, you can have those fonts display in a generic
font or another typeface.

Kerning
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Kerning
As you increase the size of your type, the space between letters increases as
well. Most publish ing software give you tools to reduce the space between
those letters. It's called tracking, and sometimes range kerning, because it refers
to red ucing white space over more than two characters. The larger the size,
the more you need to red uce character spacing. Figures 8.15 and 8.16 show
you what a difference a little space can make.

It is very logical

Fig. 8.15
Forty-eight point
type, with normal
letterspacing.

It is very logical

Fig. 8.16
Forty-eight point
type, with letterspacing reduced
to give a good
character fit.

Each letter gets its own increment of space; how much depends on the width
of the character. With certain letter combinations, such as the capital T and
the lower case o, you may see a wide gulf between the two characters, which
you' ll want to reduce for a better appearance, especially as the sizes get larger.
The process of reducing the space between just two letters, to tuck one into
the other, as it were, is called kerning, o r pair kerning. Most modern-day fonts
contain built-in kerning pairs that are specified by the font designers, but
they never seem to be enough to meet the exacting needs of many users.
Most desktop publishing and some word processing software wi ll recognize
those kerning pairs and usually provide the tools to refine kerning still
further.
Figures 8.17 and 8.18 show the effect kerning can have on a document.
Where to start kern ing is a matter of personal taste. Most publishing software
set a kerning threshold of 10 point or 12 point, but some desig ners want
everything kerned, however small it is. I have worked in typography studios
where exact kern ing was required in text as small as two points. In one case,
I used a magnifying glass to enlarge it so that I could read it.

II
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Fig. 8.17
Not kerned.

To be or not to be

Fig. 8 .18
Kerned.

To be or not to be
The Lowdown on Low-Cost Fonts
Developing a new font is an exacting job. It can take a designer months or
years to perfect each character of each style of a particular typeface family.
Not only must the letterforms be rendered correctly, but the exact letterspacing from character to character must be tested and refined. It stands to reason
that original font designs can be expensive to produce, and expen sive to
buy. Prices of from $100 to $400 for a single family of typefaces is not at all
uncommon.
In recent yea rs, a number of fonts have hit the market at prices of a dollar or
less each, with the promise of quality to match the high-priced spread.
How do they do it?
These low-cost fo nts aren't necessarily inferior in quality to their brand name
counterparts. They are simply taking advantage of the limitations of the U.S.
copyright laws to produce their products at lower prices. It seems you can
copyright the name of a typeface, such as Helvetica or Times, and the software that contains the typeface, but you cannot copyrigh t the actual character shapes. For example, you could produce a version of Helvetica named
Spack, use different software, but copy the characters exactly and not be in
violation of copyright and trademark laws.
We'll skirt the issue of whether marketing a copy of a typeface without paying royalties to the original designer or fou ndry is a good thing to do. We can
only state that you can find bargains among such fo nt collections, but you
should ask the following questions before you buy:
• Do the fonts have complete character sets? Some low-cost fonts contain
the letters of the alphabet and numbers, but are missing foreign accents
and extended characters.
• If PostScript fonts, are they Type 1 fonts or Type 3? The older Type 3

format is not compatible with Adobe Type Ma nager, and thus won' t
work with QuickDraw printers or produce screen images that are free
of jaggies in sizes for which screen fonts aren't available.

Using Adobe Type Ma nager
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• Are they shareware fonts? While some shareware fonts are produced by
budding type d esigners with exceptio nal abili ties, some are poor imitatio ns of a traditional design.
• Finally, even if the fon ts all have complete character sets and meet all
the ot her criteria, they may be poorly rendered. You might find rough
edges around cu rves, erratic, character spacing, and o ther artifacts of a
product produced with poor qua li ty control.

Using Adobe Type Manager
When you get used to t his nifty little program , it's hard to imagine how o ne
used to get work done witho ut it. W hen Adobe Type Manager, o r ATM, first
appea red on t he scene in October of 1989, it took the desktop publishing
world by storm. Back then TrueType d idn't exist, and t he most popular scalable fon t fo rmat was Type 1 fo nts.

II

Before ATM, your PostScript screen (or bitmap) font was used to generate the
characters you saw o n your Mac's screen. You had a separate screen fo n t fo r
each size. Normally fon t packages would ship with the m os t po pular sizes,
from 9 poin t to 18 poin t, and maybe a few larger sizes t h rown in. If you
chose another type size, you r Mac would scale a QuickDraw image from you r
screen fo n t, and th e resu lts would vary in q uali ty depending o n how far removed in size it was from the original. If you scaled it large eno ugh, it would
take on the aspect of a set of bricks, as shown in figu re 8.19.

To be o1·not to be
ATM is, in effect, a sm all PostScript rasterizer. When you select a point size
for whi ch there's no screen font, ATM intercepts t he call and creates a bit map
font, using the information from your PostScript printer font. The result is
clear, sharp type on-screen as well as on your p rinter (see fig. 8.20).
If you don't have a PostScrip t printer o n hand, you have the ad ded bo nus of
having ATM around to process you r Type 1 fo n ts, so they'll pri n t clea rly, up
to the maximum resolution of your printer. Even the venerable lmageW riter
benefits from ATM .

Fig. 8.1 9
Your text result
when ATM a nd a
bitmap font aren't
available in the
size you choose.
Tip
To save disk space
with ATM installed, discard all
screen fon ts other
than the basic 10
and 12 point text
sizes.

158

Chapter 8- AII About Fonts

Fig. 8.20
The combinatio n
of ATM and Type I
PostScript fonts
clear up the jaggies
on your Mac's
screen.

To be or not to be

ATM builds screen fo nts on the fly and stores them in a little bit of RAM it
sets aside for that pu rpose. It takes roughly SOK of RAM to store each bitmap.
By default, the latest versions of ATM are set up for 256K RAM, roughly
enough to build five different screen fo nts at one time. If your document has
a lo t of fonts o n a single page, you can speed up ATM by giving it more RAM
in the ATM Control Panel, as shown in figure 8.21.
Fig. 8.21
Set ATM's cache in
the handy Control
Panel.
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Installing Fonts
If you have a library consisting of your basic Macintosh fonts, or even the
ones th at come with most PostScript laser printers, you won't have to worry
too much about where to put those fo nts. System 7's Finder was intelligently
designed to know what kind of fonts yo u are trying to install and where to
put th em.

But to avoid the confusing nature of all of the font formats that are available,
we wa nted to tell you where they go, because it depends on which system
versio n you have and what type of fonts you' re using.

System 6 Font Installation
• Bitmap fonts are installed in th e System file using Font/ DA Mover.
• PostScript printer fonts are left loose in the System Folder.
• TrueType fonts are installed in the System file using Font/ DA Mover.

Installing Fonts

Caution
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TrueType fonts can only be used on System 6.0.5 or later, if you have Apple's
TrueType init installed (TrueTypes answer to ATM).

System 7.0 and 7.0.1 Font Installation
• Bitmap fonts are installed in the System file when you drag them to the
closed System Folder icon.
• PostScript printer fonts are installed in t he Extensions Folder (i nside the
System Folder) when you drag them to the closed System Folder icon.
• TrueType fonts are installed in the System file when you drag them to
the closed System Folder icon.

II

System 7.1- 7 .5 Font Installation
• All fonts- bitmap, PostScript, and TrueType-go into the Fonts Folder
when you drag t hem to the closed System Folder icon.
Note
Although you can install fonts in their proper locations manually in System 7.1
or later, letting the Finder do it for you has the added advantage of having them
checked automatically for font numbering conflicts. Because some older Mac applications use font identification numbers to recognize fonts, using the Finder can help
you avoid a font conflict which may result in erratic spacing, displaying, or printing of
the wrong font, or other problems when you try to view or print a document.

Font Folder Limitations
In o rder to allow for optimum performance, Apple's software engineers decreed that the new Fonts folder, first introduced in System 7. 1, would store
128 font resources. A font resource, by their d efin ition, is a bitmap font o r a
TrueType font- PostScript fonts don 't count.

Tip
You can get
around the Font
folder's 128 resource limi tation

Note

by dragging one

Contrary to popular belief, fonts do not use up much RAM unless they are actually

top of another so

font suitcase on
being used. The only RAM they use otherwise is minimal, amounting simply to a

that more fonts

reference to the fonts' availability to the System.

can be installed.
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Font Resource Managers
If you have less than SO or 100 fonts at hand, you don't have to read this
section. Storing your fonts in the usual ways described in the preceding sections will provide satisfactory performance on your Mac.

But if you make a living from graphic design- or like me, you are simply a
type junkie who likes to collect new and fancy styles-no doubt your font
library will soon become unmanageable. Even if you sidestep System 7.1's
Fonts folder limitations described in the preceding section, you will probably
fi nd some applications opening much more slowly when a great deal of fonts
are installed. Font menus will become unbearably large, and selecting just a
single font will take longer than it should.
You can move fonts in and out of the System Folder under System 7 as
needed, but this process is slow, and you still have to quit open applications
and relaunch them for the font menus to be updated.
There are other ways to manage your fonts, and these techniques are used by
large design studios and service bureaus that maintain libraries of literally
thousands of fonts. It involves placing your fonts in locations other than
your System Folder- even on another hard drive or network server-and
using programs that manage resources to load and unload fonts as needed.
The following section discusses these programs. But first, you need to know a
few ground rules to organize your font library so that these programs can do
their magic.

Caution
The following tips require installation of either Masterjuggler or Suitcase. They will
not work without a program such as these, which are described in the following
pages.

Following are a few font organization tips that I've learned while managing
huge font libraries for service bureaus (we're talking of anywhere from a few
hundred to a few thousand fonts here):
• It's a good idea to leave just your standard Macintosh System display
fonts in the proper locations in your System Folder. These include Chicago, Geneva, Monaco, and New York. You may wa nt to add to that list
some of the fonts you use very often, such as Helvetica, Times, or other
commonly used faces.

Font Resource Managers

Caution
When you install your System software, such faces as Chicago, Geneva,
Monaco, and New York are automatically installed. These fonts are all used
to display directories a nd other information on you r Mac's screen. Most
Mac software uses these fon ts for screen display as well-so d on't remove
them .

• All other fonts should be placed in anoth er folder, which I'll call Resource Folder (you can call it whatever you wan t). This Resource Folder
can be placed on your startup disk. You don't have to place it in the
System Folder, however-it can also be placed o n another drive, o r even
on a networked disk.
• When you are using PostScript fo nts, or TrueType fonts with extra
screen fonts, place all the font resources for a particular typeface in the
same folder, not separated by another folder. Otherwise ATM won't
work, and the fonts will not download properly to your printer.
• To keep your Resource Folder from being too large, you can subdivide
your Resource Folder, by creating a separate folder for each typeface
family. An example would be separate folders for each of the following:
Avant Garde, Bookman, Helvetica, Times, and so on .
• Some programs, such as Ald us PageMaker and QuarkXPress, will update
font menus dynamically when you open and close font resources with a
font resource manager. This is especially convenient if you open a documen t, realize you don't have the right font installed, and rush to install
that font using o ne of the two programs described in the following
sections. Installing fo nts the regular way-with the Fonts folder in System 7.1 and later-requires that you close an application and relaunch
it for the font changes to take effect.

Using Suitcase
Steve Brecher's Suitcase, now published by Symantec, was first on the market
with a resource management program in 1988. Even though the Fonts folder
in System 7.1 and later system revisions have made the issue of dealing with
a font library simpler, Suitcase still has its place, because it makes it possible
to open and close fo nts when you need them. It also frees you from reliance
on your System Folder to handle your font library.
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In effect, what Suitcase does is fool the System into thinking that fonts and
other resources are really installed in their correct locations in th e System
Folder, without affecting perfo rmance in any way (except for that occasional
conflict that m ay occur when Apple does a major System upgrade).
Suitcase is a System Extension that loads from the Extensio ns Folder in the
vario us versions of System 7, and lies loose in the System Folder under System 6. The latest versions display your fo nts, DAs, Fkeys, and sounds in two
windows, and gro up your resources in sets fu r easy o rganization, as sho wn in
the Sets and Suitcases window in figure 8.22.

Fig. 8.22
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The program is handy in managing fo nts, but you have to take a little time
working with the program to appreciate its flexibility. Consider the concept
of a Set, for example, which is simply a group of font resources. Each font
resource shown in figure 8.22 represents a single suitcase. That suitcase can
contai n o ne font, one fo nt fa mily, or several different font families.
You can build a font suitcase under System 7 simply by dragging one suitcase
and d ropping it o n another, o r by double-clicking the suitcase to display the
list of ava ilable fonts, and then moving them to another sui tcase, as shown
in figure 8.23 .
Note
Under System 6, you need to use Font/ DA Mover to add to or remove fonts from a
font suitcase.

A single suitcase can contain all the fo nts you need for a particular job, and
you can even label it by an appropriate title, such as one for your newsletter,
another for your business cards, and a third for form letters. Suitcase enables

Font Resource Managers
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you to create a set consisting of several suitcases and then give it a name
appropriate for the job. To create a new set, click th e New Set button, or type
:Fe-N, which opens the dialog box shown in figure 8.24.
Fig. 8.23
Moving fon ts from
one suitcase to
another.

Nnme or now set:

IMoclntos h Boo~
[ Concel lt. ]

I
K

OK

)

After you name your set, you can fill it with font resources by clicking the
Add button or typing ):(-Fin the main Suitcase Sets & Suitcases window,
which opens a regular Open dialog box (see fig. 8.25). You can add fonts to
any existing set by fi rst clicking that set's name on the list.
You can Add one font suitcase in the list or just Add All, wh ich you should
use cautiously if your folder is filled with many font suitcases. I've seen literall y hundreds of fonts added by mistake this way. When you're done, click
the Cancel button.
The Permanent set, which is italicized, shows the list of fonts that will always
open automatically when you boot you r Mac. You can Close any font suitcase individually, or in a batch by Shift-clicking the names. Eac h time you
close a font, you receive a warning notice (see fig. 8.26).

Fig. 8.24
Creating a new set
in Suitcase.
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Fig. 8 .25
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W hen a fo nt resource is closed, it will no longer be underlined in the list. At
this point, if it's in a Permanent (italicized) set, it' ll just be opened aga in nex t
time you restart your Mac. To remove the font suitcase, select it and then
choose Cut from the File men u. You can use th is tech nique to cut and paste
fonts from one set to another.
Caution
Suitcase Sets that are not made permanent will close au tomatically next time you
boot your Mac. This is convenient if you only in tend to use the fonts for that work
session, but not so convenient if your Mac crashes for any reason.

Note
You can make a Suitcase Set permanent simply by double-clicking the Set's name,
which changes the listing to italics. Do uble-clicking the Set's name again changes it
back to normal. The d efau lt Sets, which have keyboard shortcuts listed for them,
cannot be changed in this manner.
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The second window in Suitcase, the Resources window, is used to display all
available resources, whether opened through Suitcase or by virtue of being
insta lled in the pro per places in the System Folder (see fig. 8.27). Clicking a
font's name, by the way, opens a three-letter d isplay showing what the font
looks like.
Resources
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Using Master)uggler
Alsoft's Masterjuggler is the second of the two commercial programs that can
fool the System into thi nki ng that resources such as fonts and sounds are
located in their pro per places in the System Folder. While many users favor
Suitcase, o thers appreciate some of the add itional features available in
Masterjuggler, such as its convenient pop-up menus.
Masterjuggler is an Extension that installs in System 7's Extensions Fo lder or
System 6's System Folder, and is accessed from you r Apple Men u, or by using
a keyboard shortcut you can set in the program's preferen ces. Wh en you
bring up the main Masterjuggler window you'll be able to easily open your
font and sound resources (see fig. 8.28).
To open a font resource, simply select it fro m the list at the to p half of the
wind ow, which shows avai lable files, and then click the O pen button. The
file will then be added to the bottom list, which displays open files. To remove the font resource, select it fro m the list of open files and click the Close
button.
Note
Font resource managers do not work with fonts already installed in their proper
places in your System Folder. They only work with fonts installed elsewhere, using the
techniques previously described.

Fig. 8 .27
Suitcase's Resources ivindow
shows available
fon ts, DAs,
sounds, and Fkeys.
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Fig. 8.28
Masterjuggler's
main window.
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In addition to opening font resource and sounds, Masterjuggler can o pen
DAs, Fkeys, and sounds. It also can display several varieties of pop-up menus,
including one listing fonts in their actual typeface and even a list of available
applications. You can configure the program still further by clicking th e Options button on the main Masterjuggler window, which opens the window
shown in figure 8.29.
Fig. 8 .29
Masterjuggler
Options window
lets you customize
the program.
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The most useful options are the convenient hot keys you can set up to activate the various Masterjuggler lists and windows. Among General Options,
the most important one, which is usually off by default, is Wait for all disks to
mount. As explained previously, you don't have to have your ava ilable fonts
insta lled on your startup disk. You can have them available on external drives
or even a networked server. If you check this option, Masterjuggler will wai t
for those disks to mount before searching for open font resources.

The Future of Fonts

Which One Is for You?
Both Suitcase and Masterjuggler patch the System to provide their magic.
When Apple makes a major change to its operating system, it's not unusual
to find a revision to either of these programs coming along shortly thereafter.
Suitcase's author is also a frequent visitor to the online services and provides
friend ly support and free software update patches whenever it is necessary to
fix bugs that users m ight find in the program. Alsoft has also actively updated
Masterjuggler as new hardwa re and system updates require programming
changes.
In its present form, Suitcase is a better tool to manage your font library, because of the immense flexibility in the way you can set it up, once you get
the hang of it. Masterjuggler has the adva ntage of costing less than Suitcase,
and if you' re choosing a program strictly on price alone, you may prefer it,
even though Masterjuggler's font loading capabilities are nowhere near as
fluid as its competition.

The Future of Fonts
A new variation has been added to the font universe-QuickDraw GX.
Apple's major upgrade to its native imaging technology places many of the
fancier font tricks o n a system level, such as ligatures and character kerning
and spectacular graphic effects with both type and illustratio ns.
In the next few years, we'll see just how the advent of QuickDraw GX will
change font technology. Having new tools to handle fonts may encourage
developers to produce a whole new generation of GXsavvy fonts, containing
additional characters and doing stuff behind the scenes, on the system level,
that will greatly enhance the look of your documents.
In the meantime, your existing font investment will be protected. Your
TrueType fonts will work just fine when you install QuickDraw GX on
your Macintosh, and Adobe is supplying a special font converter with the
QuickDraw GX software that will allow you to continue to use your existing
PostScript fonts.
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From Here ...
This chapter provided the basics of what a Macintosh font is and explained
how to use them most effectively in your document. The chapter even gave
you some helpful hints on using ATM and a font resource manager to help
you get control of your font library.
• Chapter 10, "The Printing Chapter," provides some helpful hints on
printing the documents you create with all those fancy new fonts.
• In case you run into trouble, read chapters 37 and 38, where the steps
you need to take to troubleshoot common problems with your Mac
are described, as well as how you can solve them before they become
serious.

Chapter 9

Sharing Data
Applications

betweefl~

by fo Zarboulos

No Mac is an island. Not any more, that is. A few short years ago, legions of
individual users happily computed away on an individual Mac in an individual space. MacPaint or MacWrite were likely to be their only applications,
the Image Writer their only connection, and the Clipboard their only method
of sharing data. Copying and pasting seemed a major miracle.
Now just a few years but several Mac generations later, we want our files and
applications to share with each other, so we can place an image retouched in
Photoshop inside a newsletter laid out in PageMaker, incorporate an Excel
spreadsheet into a report written in Microsoft Word, import clip art into our
HyperCard stacks, merge an Excel mailing list we purchased with a resident
FileMaker mailing list, and open a colleague's WordPerfect file from our
Microsoft Word application.
All this sharing may be good for our psyches and our bottom lines, but it can
create problems. When we e-mail a file half-way around the world, the recipients may not have the application to read it. We may not know how to edit
our Photoshop image when we place it in PageMaker. The Excel mailing list
may lose its text formatting when we merge it with the FileMaker mailing
list. Our colleague's WordPerfect file may crash when we try to open it from
Word.
The aim of this chapter is to help you understand the various methods of
sharing files between applications so you can choose the methods that work
best in your work situation. The chapter discusses the following topics:
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• Understanding file formats
• Copying and pasting via the Clipboard and the Scrapbook
• Importing and exporting
• Publishing and subscribing
• Linking and embedding

Understanding File Formats
When you want to share data between applications (or share data between
computers as discussed in Chapter 35), you often have to contend in some
way or other with the differences between file formats. It helps to begin by
knowing what a file format is.
A file format is a set of conventions that determines how information is
stored-something like the conventions that determine how human languages are written. A basic convention of English, for example, is that characters are written from left to right. We couldn't read English text if it were
written in a foreign convention-unless we could figure out how to translate
it. If you can read the following words-siht daer ot yrt-you are translating a
foreign convention into your native convention.
Similarly, every application creates, saves, and manipulates data in its own
native file format. When you transfer data in from a different application, the
first application needs to be able to read or translate the foreign file fo rmat.
You might ask, "Why can't there be just one standard file format, in keeping
with the Macintosh philosophy of standardization, consistency, and ease of
use discussed in Chapter 3?"
One reason is that different types of applications store different types of information. A word processor, for example, needs to store such things as fon ts,
sizes, styles, margins, and spacing, as well as the data. A graphics application
using bit-maps needs to store such things as line width, color, and fill, as well
as coordinates for each pixel. A spreadsheet application needs to store the
widths of columns and rows, as well as numbers and formulas. And so on.
When exchanging data, you can deal with different file formats in many
ways. With some methods (embedding in particular), the applications take
care of translating file formats for you. In other methods (importing and
exporting in particular), you generally have to be more involved in the

Transferring Static Data
translation of file formats . In this chapter, information about specific file
formats is given where it is most needed, in the section "Importing and Exporting." Informa tion o n Clipboard formats is given in "Using the Clipboard. "

Transferring Static Data
When you want to transfer some information from one application to another, and you don't plan to update the information or share it over the network, you can choose one of the following methods discussed in this section:
• Copying and pasting by using the Clipboard
• Copying and pasting by using the Scrapbook
• Importing (and exporting first if necessary)

Using the Clipboard
Using the Clipboard is so easy and so basic to the operation of the Macintosh,
that even experienced users tend to forget how useful it can be. They may
struggle with more difficult ways to transfer data between applications when
a simple copy and paste would do.
Consider the Clipboard a temporary storage area where graphic and text
items can be held until you decide where to put then . It's also volatile, meaning that if you restart or shut down your Mac, the data in your Clipboard is
gone.
There are three basic steps you'll always follow in using the Clipboard. You'll
find them in the Edit menu (or you can use the handy keyboard shortcuts
I've listed). Some software products offer additional options for Clipboard use
that are mentioned in the program's manuals, but the steps I'm about to
describe apply to virtually all Mac programs:
1. Cut (or Command-X): This function removes the selected item from

your document and places it in the Clipboard.
2. Copy (or Command-C): This function copies (but does not remove) the
selected item from your document and places it in the Clipboard.
3. Paste (or Command-V): This function places the material from the keyboard into your document.
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As a rule of thumb, when you want to do a one-time transfer of gra phics or
text (or even sound and QuickTime movies) and you' re not concerned that
the da ta will change, try the Clipboard first.
Understanding Clipboard Formatting

When you cut text from one application and paste it into another, the pasted
copy usually retains the fo rmatting style of the source. But sometimes it
doesn't work as expected- the font or its size or style are changed, or you
can 't edit what you've pasted. To make the resu lts more predictable, it helps
to understand how the Clipboard works.
Most applications store the data you cut or copy to the Cli pboard in several
versions, each version in a different format (though only one version is visible in the Clipboard window).
These formats are similar to fil e formats, but designed especially for the Cli pboard. Generally, each application stores one version of the information in its
own native Clipboard format. If you paste within the same application, the
in formation will usually retain its exact formatting.
Other versions of the information can be stored in one of the following standard Cli pboard formats:
• The PICT format. This format stores data, whether a graphic or text, as a

picture (either object-oriented or bit-mapped). Text stored in PICT format is not editable.
• The TEXT format. This for mat stores data as text only. Text stored in

this for mat loses its font and style information.
•

The STYL format. This format stores data as text, complete with font and
for matting information.

•

The MOOV form at. If you have Apple's QuickTime extension installed,

this format is used to store QuickTime movies.
•

The SND forma t. This fo rmat stores sounds-either those supplied with

the system software or those you record yourself-for transferring between applications that support sounds.
Applications store multiple versions of Clipboard data in order to give applications on the paste side a good chance of finding a format they understand,
and thus preserve as much of the original formatti ng instructions as possible.
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Suppose that you are copying cells from an Excel spreadsheet and pasting
them into a Word S document. One of the formats Excel uses in the Clipboard is RTF (for Rich-Text Format), an intercha nge format that WordS understands as well. Word chooses the copy with that for mat and is able to
paste it with the original formatting.
Som e programs, on the other hand, don't understand RTF. Thus if you paste
the same Excel spreadsheet cells into a document created by a non-Microsoft
program, that application may ch oose the TEXT format-and the pasted copy
will lose its font formatting.
Note
In addition to using the standard Apple Clipboard, Microsoft Word maintains its own
private Clipboard. If you are unable to get Word to recognize something you've
copied to the Clipboard from another program, simply switch out of Word to another program or to the Finder, then back to Word. That is usually sufficient to force
Word to update its Clipboard properly.

To get out of the Clipboard wh at you put into it, the destination application
must either understand the source application's native Clipboard format, or
both applications must have anoth er format in commo n.
You can determine the Clipboard formats an applicatio n uses in the following manner. Select some data from a file within the application and then
choose Copy. Open the Scrapbook from the Apple menu and then choose
Paste. The selection appears in the Scrapbook's window. (I' ll tell you more
about the Scrapbook later in this chapter.) The Clipboard for mats are displayed at the bottom right of the window.
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The data is displayed in the Scrapbook in only one format, although the data
is probably stored in others you don't see. Therefore the data may look as if
it's incorrectly fo rmatted. But if the application you paste into can find a
fo rmat it can read, it will restore the original formatting (or as much of the
formatting as the application can read).
Some applications have a Paste Special command (under the Edit menu) that
allows you to choose among the available Clipboard formats. l~or information
about the specific choices in the dialog box, see the application's documentation.
If you are still not satisfied with the results when you transfer data by using
the Clipboard, you may want to try importing. Importing and exporting is
covered in detail later in this chapter.
Did You Know?: Clipboard Tips and Tricks
Many people don't know as much as they think they do about the Clipboard.
See whether you know all these tips and tricks:
• You can transfer entire files via the Clipboard, even large ones. If the
data exceeds what can be held in memory, many applications will save
it to disk. In that case, the size of info rmation you can copy to th e Cli pboard is limited only by the space available on your hard disk.
• You can copy the current time and date from the Alarm Clock desk
accessory and paste it at the beginning of a file.
• You can copy the results of a calculation made with the Calculator desk
accessory, and then paste it into a file.
• You can go the other direction and paste a numerical problem, including common math symbols, from a fi le to the Calculator. The
Calculator's keys flash to reflect what you have pasted, and the answer
appea rs. Then you ca n paste the answer back into your file. (The Calculator beeps for each symbol it doesn' t recognize.)
• You can copy a small amount of text into a file's Get Info box (available
from the Finder) to remind yourself what's in the file.
• If you have the equipment to record sound, you can Copy and Paste
sounds between applications that support them.
• You can tra nsfer Qui ckTime movie frames by using the Cli pboard.

Transferring Static Data
• Sometimes the Clipboard comes up empty when you try to paste between applications. This may be because the receiving applicatio n understands only its own Clipboard. If this happens, use the Scrapbook
instead.
• If you cut or copy something, and then rea lize you want what was previo usly held on the Clipboard, you can press ):(-Z to undo, or return the
Clipboard to its previo us state.

• You can keep what is currently o n the Clipboard by using the Delete
key to remove unwanted items in your document instead of the Cut
command to delete.
• When you want to transfer data from a PostScript application like Illustrator or Freehand to an application that doesn't understand PostScri pt
data, you can transfer through the Clipboard by holding down the
Option key while you choose Copy from the Edit menu.
• MultiClip by Olduvai (Miami, FL) is a utility that gives you multi ple
clipboards, which you can view, edit, or move to the Scrapbook for
more permanent storage.

Using the Scrapbook
The Scrapbook, located under the Apple menu, is often overlooked as a
means of transferring data. Unlike the Clipboard, what you store in the Scrapbook is saved to disk and thus doesn't go away when you paste something
else, quit an application, or turn off the computer. You can paste as ma ny
items as you want- text or graphics.
The Scrapbook consists of two files. First is the desk accessory (or application
under System 7.5) that is available from the Apple menu. The second is the
Scrapbook file itself (located in your System Folder). Consider the Scrapbook
as a library in which you can store frequently-used text or graphic items.
When you first use the Scrapbook, its behavior may seem strange at first because it follows a different set of rules than the rest of the Maci ntosh. Following are the rules a Ia Scrapbook:
• You don't select something from the Scrapbook to cut or copy. You
simply choose Cut or Copy from the Edit m enu while the page you
wan t to cut or copy is displayed and the Scrapbook window is active.
• Each time you paste, you create a new page of the Scrapbook. You ca n't
paste over an existing page. What you paste affects the page before o r
the page after the o ne displayed.
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• The number of the current page is displayed at the bottom left of the
screen, along with the total number of pages in the Scrapbook. You use
the scroll bar to display different pages.
• When you paste a large selection, you can't scroll to see it all, nor can
you resize the window. You just have to have faith that it's all there.
(The size of data you paste into the Scrapbook is limited only by the
size you can copy to the Clipboard, in order to transfer it.)
• As explained in the section on the Clipboard, pasted data is often saved
in multiple fo rmats. The name of the format or formats appears at the
bottom of the Scrapbook screen. (But you can only see one of those
formats in the Scrapbook window.)
Did You Know? Scrapbook Tips and Tricks
Following are some tips and tricks concerning the Scrapbook:

• What you store in the Scrapbook file is kept in the startup volume's
System folder under the name Scrapbook File. You can transfer that file
from on e disk or volume to another.
• You can create and store multiple Scrapbooks and name them according to contents. For example, you might have Scrpbk.dogs and
Scrpbk.cats. You then can use one of these files by renaming it Scrapbook File and moving it into the System folder.
• ClickPaste by Mainstay (Camarillo, CA) is a utility that allows you to
store Scrapbook pages in hierarchical folders. In Version 2, you can
store sounds and play them back before you paste them.
• SmartScrap by Portfolio Systems (Cupertino, CA) lets you store multiple
scrapbooks which you can access without renaming them. You can
select any portion of a stored image for copying, name each page of
each scrapbook, search through the contents by name, and build a table
of contents with thumbnail views of each page. To open a page, you
click on its thumbnail image.
Table 9.1 shows you some ideas for using the Scrapbook.
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Table 9.1 Ideas for Pages to Store in the Scrapbook
Example

Description

SoftwareProductName

Long words (especially interCapped
words) or passages of text you type
repeatedly.

® TM © n a a aee rr.

1'

JE

Symbols you use often, but not ofte n
enough to remember the key
combinations.
Your signature, to personalize
documents you relay via the network,
fax, or modem.
Your company's logo, to use in
marketing and official documents.

Your business card, to uniquely
personalize your faxe s and letters.

Your letterhead, to create instant
stationery you can never run out of.

QQ

A happy face and a sad face you d raw
in a graphics program, to convey
your feelings. (Or if you have a
camera and a scanner, how about
happy and sad portraits of yourself?)

Importing brings data created in o ne application in to another applicatio n. If
your application is not able to accept another applicatio n's data, you need to
save it in another file format first, a process called exporting.
Generally speaking, you import an entire file, rath er than selected data,
though database applications like FileMaker Pro allow you to select the fields
you wa nt to import. (If you want to use importing to bring in selected da ta,
you can do so in a roundabout way: import the who le file, and then cut the
data you don't want.)

Tip
To write
smooth ly with
a graphics
prog ram, write
very large and
then reduce t he
results.
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Depending on your applications, you import a file in one of the following
ways:
• From app lication A, you import application B's file d irectly, using the
Import, Open, o r Place command from the File menu. Application A
must have the built-in ability to read B's file format.
• From application A, you impo rt application B's file, using the Import,
Open, or Place command. Application A must have an installed plug-in
filter to convert B's format to A's native format.
• From application B, you export the file to an intermediate format, usi ng
the Export, or Save As comm and. Then from application A you import
the resulting file. Application A con verts the file to its native format.

Importing Files Directly
Most applications have built-in file conversion capabilities that allow them to
read fi les in certain fo reign file fo rmats directly. Often these are applications
t hat work with a similar type of data, and therefore have similar fi le formats.
For example, Excel and Lotus 1-2-3 can open and save each other's files directly, and so can Word and WordPerfect.
But this does not always work perfectly. Certain fea tures of an application
may get lost in the translatio n, causing unwanted formatting cha nges, or
even crashes. For example, some programs have difficulty opening or importing a Word file that has been saved wit h Word's fast-save feature. (If you
encounter any difficulty, you can resave the Word file with t he fast-save feature disabled.)
'

Note
The kind of formatting information that's recognized w hen you import a file from
another application into your document may vary from program to program. It is a
good idea to check your manuals for information about file conversions. Both Word
and WordPerfect include special text files that explain how well files are translated
from one format to another.

Another problem is that a file you are attempti ng to open may contain portions o f text or a graphic that cannot be read by the application trying to
open it. In such cases, you may want to use a program called Can Opener by
Abbott Systems (of Pleasantville, NY), wh ich can extract any portion o f a file
that is in a commonly used text, graphics, or sound forma t.
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You can tell if an application can open another's files by starting the application and choosing the Open, Place, or Import command. In the d ialog box
that appears, you can navigate through your folders to the files created in
that application. Often you can narrow down t he search by selecting the type
of file you' re looking for. For example, in the Microsoft Word Open d ialog
box shown in figure 9.2, you can select Graphics Files to see only graphics
files, or you can narrow the search fur ther to see on ly those graphics files
saved in PICT format.
Fig. 9.2
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In most applications, when you import (or o pen) a file in a foreign file format, it appears in a new, untitled window. When you save this new file, you
will probably prefer to choose a new name for it, rather than replace the
original file. You' ll probably also want to save t he file in the native format of
your current application. You might want to add a few letters to the end of
the file name to indicate that it's been saved in a di fferen t applicatio n, such
as Status Report.W for a file saved in Word and Status Report.WP for one
saved in WordPerfect.
If you want to incorporate all of t he new file, or any portion of it, in another
file of this application, you can cut (or copy) it and paste it into the other file.
In page layout applications such as PageMaker and QuarkXPress and some
drawing programs, you place text or graphics directly in the active window of
the application, rather than a separate window. Us ually you use the Place
command to d o this. I ~ Qu_arkXPress you choose either the Get Text or the
Get Picture command.

Use Word's Open
dialog box to select
the kind of files
you wish to see
listed in the
directory.
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Using Plug-In Filters
Many applications include small programs with their software, called filters or
converters or translators (wouldn't it be nice if they could standardize the
term!). Each filter enables the application to open files written in a specific
file format. These filters are more extensive than built-in file conversion capabil ities, and therefore cause fewer problems.
Filters are modu lar, so you can install only the ones you need for applications
you use. And you can add new ones as they become ava ilable. Many developers make filters ava ilable for downloading from on-line services like America
Online and CompuServe.
One type of fi lter, developed by Claris, but owned by Apple and used by
many other major developers, establishes a standard design for filters, ca lled
XTND. The standard allows new filters to be designed for translating any
o ther application that supports XTND. A company called Data Viz (located in
Trumbull, CT) sells packages of filters, called MacLink Plus Translators, that
work with any XTND application.
Exporting Files to Other File Formats
When two applications can't read each other's files, you may be able to find
an intermediate format that both applications understand (sort of like an
Italian and a Spaniard using English as an intermediate language to communicate with each other). You export the file in the intermedia te fo rmat, then
open the resulting file from the other application, which converts it into its
own format. Formats designed especially to be intermediate formats are called

interchange formats.
To export a fil e to an interchange format and then open it in another application, follow these steps:
1. Open the file in question in its own application. If you make any
changes, be sure to use the Save command to save the file in its native
format, in case you need it later.
2 . Choose the Export command if it exists. Otherwise, choose Save As.

The dialog box for either of th ese commands should contain a list of
formats to choose from. Figure 9.3 shows the Save As dialog box from
Word.
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3. Choose a format the receiving application wi ll understand. Some common fo rmats for d iffere nt types of applications are described a bit later
in this chapter.
4. Choose a name for the new file, preferably the same name but with a
file extension to indicate the format. For example, you could nam e a
j anuary report saved in RTF january. RTF.
5 . Close the file. If th ere's not enough memory to launch another application, q uit the progra m.

6. Launch the o ther application.
7 . Choose the Open, Import, Place, Get Text, or Get Picture command. In
the dialog box that appears, you may need to select the file forma t o r
type of file you used to save or export the o ther file.
8 . Double-click the file you want to open.

You will probably see a message telli ng you the application is converting the file to the application's native file format.

The most common interchange formats for text, graphics,
and spreadsheets
Text Formats:
•
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ASCII (American Standard Code for Information Interchange) or Text Only.
The most basic of formats, t he one you can almost always use when all else
fails. ASCII (pronounced ASK-key) is a standard set of 256 codes, each
(continues)
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(continued)
standing for a letter, number, special character, or rudimentary formatting instruction, such as a tab or carriage return. All other formattin g information is
stripped away. Most applications that read text understand ASCII, as do all
computers. Many e-mail systems, on-line services, and bulletin boards use
ASCII (Text Only) files.
•

RTF (Rich-Text Format). A good choice for word processing files, since RTF

retains most text formatting and graphics formatting as well. Developed by
Microsoft, it is supported by Word, WordPerfect, WriteNow, PageMaker, and
others.
•

MacWrite. Though this format is the MacWrite word processor's native fi le
format, it is so widely supported that it can serve as an inte rcha n~e format.

Graphics Formats:
•

TIFF (Tagged Image File Format). A standard high-resolution format for bitmapped graphics, TIFF is used by many scanning and image manipulating
applications, such as Photoshop. Files can be large and take a long time to
open.

•

PTNG. This is MacPaint's native format, but it is so common it can be used as
an intermediate format. However, PTNG is severely limited. It stores bitmapped, monochrome images only, which must have a resolution of 72 dots
per inch, and be no larger than 8" x 1 0", with a vertical orientation.

•

PICT and PICT2. These are standard, widely used formats for either objectoriented o r b it-mapped graphics. PICT supports only eight colors and thus is
most useful for black and white graphics. PICT2 supports as many colors as
your monitor allows.

•

MacPaint. Because MacPaint was bundled with the fi rst Macintosh computers
and was the first graphics file format, nearly every Macintosh g raphics, layout,
or word processor program can read this format. Files in this format contain
only low resolution black and white information and have a fixed size of 576
by 720 pixels.

•

EPS (Encapsulated PostScript). EPS is recommended for graphics to be printed

on a PostScript printer. If you use such a printer, this format will best preserve
the attributes of complex graphics, especially if in color. Most important, an
EPS file is device independent, which means that you can scale an EPS graphic
to any size and still have it reproduce at your printer's maximum resolution.
EPS is supported by major graphics and desktop publishing applications like
Aldus Freehand, Adobe Illustrator, Aldus PageMaker, FrameMaker and
QuarkXPress, as well as many word processors.
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Spreadsheet and Database Formats:
•

DIF (Data Interchange Format). DIF transfers spreadsheet data but not the

formulas used to calculate the data. Cell formatting and widths are notretained. The main purpose of this format is to transfer data so that it can be
graphed in a presentation or charting application.
•

SYLK (Symbolic Link). SYLK transfers spreadsheet data and the formulas used to

calculate. It retains some formatting information, including commas, column
widths, and cell alignment, but loses font, size, and style.
•

ASCII (American Standard Code for Information Interchange) or Text Only. As described under the Text Formats section of this list, ASCII or Text Only files lose
text formatting. If you must save in ASCII for lack of another common format
when exchanging a spreadsheet or a database, use Tab-Separated Text or
Comma-Separated Text.

•

Tab-Separated Text or Comma-Separated Text. These are ASCII formats with the

addition of delimiters-carriage returns, and tabs or commas-to tell the
importing application where the rows and columns of the spreadsheet or the
records of the database begin and end.

Transferring Live Data
As usefu l as copying and pasting can be, it has one majo r li mitation: o nce
information is transferred, it's disconnected from its source. If the origi nal
information changes, you have to go back and recopy, and then repaste. If
the info rmation changes frequently, o r if you need to paste it into mu ltiple
files, th is can be a ted ious process. And it can be unreliable, because you
m ight not remember al l the places where the information has been pasted.
Three o ther methods of exchangi ng data address these problems in different
ways: publish and subscribe, linking, and embedding. All three m ethods keep
informatio n connected to its source in some way, and so can be considered
live.

Deciding on a Method
To help you decide which method of transferring live data to use in a particular situation, find the category of information you are dealing with in the
following list and read about the recommended method(s). You might also
want to see table 9.3 for a comparison of the advantages and limitations of
the three methods.
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• Information Subject to Change
You may create files containing information that is subject to change,
such as financial data, product descriptions, and project sched ules. To
keep the files up-to-date wh en the original information changes, you
can use linking o r publish and subscribe. Linking is easier, but it works
only with a single Macintosh, and requires that all source applications
be available. If the information is to appear over the network, use publish and subscribe.

• Information from Other People on the Network
If you want to create a file that includes informatio n created by different people, such as a flyer with contributions from various writers and
graphic artists, use publish and subscribe.
• In for mation to Be Used by Other People on the Network
If you want to create or maintain info rmatio n to be used by others over
th e network, such as a corporate logo, a mission statement or slogan,
and legal disclaimers, use publish and subscribe.
• Cross-References
You can use linking to u pdate cross-references automatically so that
when figures, chapters, or sections are renumbered o r renamed, the
references to them change acco rdingly.
• Information fo r a Specific Document
You may wa nt to create info rmatio n especially for a document, usi ng
another applicatio n. For example, within a sales report, you may wa nt
to include a chart you create in Excel. Use embedding to create the info rmation from within th e sales report document.
• In formation for Transporting by f.lo ppy Disk
If you plan to transfer a document by using a floppy disk, and th e documen t has informati o n from other sources, use embedding, which req uires storing all the information in only one file. If the recipien t does
not need to edit the embedded information, then they do not need the
application (s) used fo r the source information. But they will need to be
able to open th e base docum ent, either by having the application that
created it o r by having another application that understands its file
fo rmat.
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Using Publish and Subscribe
Publish and subscribe is probably System 7's most underutilized feature. Introduced as a "sophisticated Copy and Paste," many users seem to think it's
too sophisticated-that is, difficult to understand and use.
It is a little m o re com plicated than other methods, and its clumsy, non-

intuitive term inology doesn't help. But it can be well worth using, pa rti cularly if you work with information that is subj ect to change or information
that appears in va rio us documents throughout an organization.
Comparing publish and subscribe to copy and paste may help explain how it
works. Publish and subscribe is often called a "live copy and paste." Instead of
copying the source informatio n, you p11blis/1 it. Instead of going to the Clipboard, and thus being held in memory, the published information goes to a
special file called an Edition, wh ich is saved o n disk. Instead of pasting the
information, you th en subscribe to the Edition, causing it to appear in your
d ocument. Table 9.2 shows the similarities between the two methods up to
this point.

Table 9.2 Publish and Subscribe in Analogy to Copy and Paste
Source
Copy

Publish

Holding Area

••

Clipboard,
(in memory)
Edition,
(on disk)

Destination

••

Paste

Subscribe to

After the information you published has been subscribed to, the similari ty to
copy and paste ends. When you paste a fi le in to your documen t from the
Clipboa rd, there is no link to the origi nal file. With publish ancl subscribe,
the items you publish remain linked via the Edition file. When the original
published info rmatio n changes, those same changes appear in the Edition,
either automa tica lly o r on command. In fact, subscribing fil es can be updated
even when they are no t open. You can also subscribe to the same Ed itio n
from as many documents and applications as you want. If you share the Edition over the network, other users can subscribe to it as well.
What Can You Do with Publish and Subscribe?
Clearly, the more places a piece of information appears, or the more times it
changes, the more useful-essential, even- the publish and subscribe method
becomes. Over a network, it can save the time of many people, and ensure
that everyone is working wi th the latest information.
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If you find it difficult to envision how you can benefit by using publish and
subscribe, the following list of possible uses may help you think of some. It is
not meant to be an exhaustive list, or even a logical one. Categories and
items overlap a good dea l, but are designed only to spur ideas.

Publish and Subscribe-What to Use It For
Information subject to regular o r frequent updating:
•

Spreadsheet data (sales figu res, expenses, price lists, and so on)

•

Prod uct d escriptions, product identification numbers, g raphics or
photographs of products

•

Customer databases

•

Employee databases

•

Employee sketches and resumes

•

Corporate or organizational mission statements, slogans, blurbs,
disclaimers, copyright notice

•

Templates for brochures, manuals, memos, status reports, invoices, and so on

•

Meeting minutes

•

Proposals

•

Contracts

•

Schedules, calendars, p roject tracking

•

Employee worksheets, con tract invoices

•

Flow charts

•

Error reports, customer questions and complaints

legal

Work being created at one source but used (or edited) in other locations:
•

Logos, icons

•

Product presentations, internal presentations

•

Screenshots or photographs, descriptions of software or other products under
development

Composite work pulled in from several sources:
•

Flyers, newsletters, brochures

•

Data sheets

•

Presentations
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Information created in one application but used in another:
•

Spreadsheet data used in word processors or page layout applictions

•

Database data used in word processors or presentation programs

•

Graphics used in spreadsheets or databases

•

Data in specialized applications concerned with flow charts, meetings, decisions, presentations, etc. used in another specialized application or a word
processor

Master repositories or catalogs of information subscribed to by multiple users:
•

"Boiler plate" blurbs o r phrases, such as product descriptions

•

Scanned photographs or slides

•

QuickTime movie clips

•

Recorded messages

Home use:
•

Graphic designs you use in multiple places, perhaps as you work to improve
them over time

•

Financial totals and other data updated from one spreadsheet or accounting
application to another, such as from Quicken to MaclnTax

•

Updates from employers or clients over t he modem via Apple Remote Access

Note
Create a graphic or scanned photo, and then subscribe to it any number of times on
the same page. When you edit the original, you get a new design . Do a Save As and
repeat to create different designs. In addition to ed iting or replacing the published
graphic, you can rearrange the subscribers on the page for a variety of effects.

A Publish and Subscribe Scenario
Suppose you are in charge of producing an internal monthly sales report.
Every month you must gather from other staff the latest graph of sales figures, a scanned photograph of the curren t "employee of th e month," and a
column about that person.
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Fig 9.4
A sales report for
the first month.
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Each contributor to the report publishes his o r her information, thus creating
Editio ns you subscri be to from the layout you created in PageMaker. A copy
of each Edition file is placed in your PageMaker document. You can resize the
information if you want.
In May, your report might loo k li ke the one shown in Figure 9.4.
After the report is distribu ted, your PageMaker document will receive updates
(manually o r automatically) made by your contributo rs for the june issue.
After you have received your updates, your report might look like the o ne
shown in figure 9.5.
If you want, you can edit the published information by selecting Open Publisher, an option that launches the other applicatio n and file directly from
your PageMaker document. Or you can leave the editing to your contributo rs,
receiving their updates.
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Fig. 9.5
The sales report
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Applications That Support Publish and Subscribe
Publish and subscribe is o nly a potential capability built into System 7. It
doesn't work if the capability is not implemented by the applicatio ns o n both
sides o f the transactio n.
Some applications implement o nly the Publish feature, and others o nly t he
Subscribe feature. For example, PageMaker S can subscribe but not publish .
QuarkXPress ca n o nly subscribe to graphic items (altho ugh an extra-cost
QuarkXTension will let you subscribe to text too). (A uti lity called Pu blishist,
by Addison-Wesley of Reading, MA, enables users to publish and subscribe
between two programs when o n ly one o f th em has the feature built-in .)
To learn what kind o f support for publish and subscribe an application has,
look in the manual or under the m enus (usually the Edit menu) while running the application for the terms publish, subscribe, o r edition.

Procedure for Publishing Data
When you publish information, a copy o f it is sent to an Edition file, to
wh ich you and others with the relevant access privileges ca n subscribe.
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W hen the publisher (the information you publish) changes, the Edition and
all documents subscribing to it change accordi ngly.
Most applications tha t suppo rt pu blish and subscribe allow you to copy an
enti re fi le o r any po rti on of it. You may want to check you r application's
manual to see if you can do both.
The procedures for publishing may d iffer slightly in the application you are
using, but you should have no trouble following the steps given here.
To publish data, follow these steps:
1. In your document, select the information you want to publish.

2. Withi n the same application, choose Create Publisher. Usua lly the command is under th e Edit menu. (In FileMaker Pro it is under the File
menu's Import/Export submenu.) A dia log box like the one in figure 9.6
appears.
Fig. 9.6
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3. Select a name and location for the Edition file.
The Edition is the intermediary file where the data you publish is kept.

Note
To help you keep track of your Editions, leave the word Edition in the tit le of
the file. You may want to create a new folder to hold all your Editions. Alternatively, you may want to keep your Editions in the same folders as the published information. Consistency is important.

4 . Choose Publish.
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Caution
After an Edition file is created, you can rename it and move it to another location on
the same volume if you wish. However, if you move an Edition to a different volume,
the System will not be able to find it.

Now you or anyone else can subscribe to the Edition you just created. You
may want to choose when changes made to the published in forma tion
(called the publisher) are sent-when you save the document automatica lly
(the default) o r manuall y. (Be sure to save the document that contains publisher, in case you wan t to changed the published information in the future.)
The following section provides mo re info rmation.
Choosing Publisher Options
Most applications have publisher options to enable you to choose when to
send changes to subscribers, and to enable you to cancel all links to the publisher.
To make changes to publisher options, follow these steps:
1. In the document where it was created, put your cursor within the pub-

lisher.
Note
To help you find published information in a document, many applications
surround publishers with gray borders. In some applications, there is an option to Show/Hide Borders in the Edit menu. In others, borders are controlled
by the command that shows and hides other markers, such as paragraph
markers.

2. Choose Publisher Options, usually from the Edit menu. A d ialog box
resembling the one in figure 9.7 appears.
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Note
The options in your application may differ slightly from those pictured here,
which are from Word.

3. Select the o ptio n o r optio ns you want.
The following o ptions are fa irly standard:

• Send Editions/On Save/Manually. If you choose to send On Save,
up-dates will be sent to all subscribers as soon as changes are
saved .
If you choose to send updates Manually, click that button. Then
whenever you want, you can send the changes by clicking the
Send Edition Now butto n.

Note
Sending updates to the Edition is not necessarily the same as having
each subscriber receive them. Final control of when the changes are
actually made is up to each subscriber through the Subscriber Options
dialog box.

• Send Edition Now. This button allows you to send editions whenever you want. If the Manually radio button is selected, this button is the o nly way to send updates. If the On Save button is selected, you can use this button to send an update between saves.
• Cancel Publisher. This button breaks links from this published data
to all current subscribers. The contents of the publisher remain in
your document, and the Edition remains on disk, but changes are
no longer sent to the Edition or to subscribers. If you don't want
users to subscribe to the disconnected Edition as it currently
stands, delete it fro m th e Finder. If you click this button, you will
be asked to confirm that you want to break the link to the Editio n
file.
4. Choose O K.

Transferring Live Data
Editing Published Information
You can edit published information just as you edit any other information in
a document. (But remember, your changes will also be made in any other
locations where the same published information is subscribed to.)

To edit the publisher, open the document that contains it, find the publisher,
and make any changes you want. The changes are sent according to the selection in the Publish er Options dialog box (usually either On Save or Manually). See the section "Choosing Publisher Option s" for mo re information.
If you have difficul ty find ing the publisher in order to make changes, see
whether the application has a Show Brackets command, o r whether brackets
show when you select a command that shows o ther markers, such as Show
Paragraphs.
If you are looking at a subscriber and decide you want to edit its publisher,
there is an easier way to find it. (If the publisher is on another network vo lume, you must have access to it to use this method.) Put your cursor in the
subscriber, and select Subscriber Options, usually from the Edit menu. In the
dialog box that appears, choose the Open Publisher button. The publisher
appears on-screen, allowing you to make changes.

Procedure for Subscribing to Data
If you have previously created an Edition by publishing some infor mation, or
if you have access to an Edition created by someone else, you can insert a
copy of the published information in your document by subscribing to the
Edition .

To subscribe to published data, follow these steps:
1. If the Edition is on another Macintosh, connect to that Macintosh. (See

Chapter 34 for informatio n on file sharing.)
2. Position your cursor in your document where you want a copy of the
Edition to appear.
3. Choose Subscribe To, usually fro m the Edit menu. A dia log box resembl ing the one in figure 9.8 appears.
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Fig.9.8
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4. Navigate through the folders until you find the Edition you want. If the

Edition is located on another hard disk or another Macintosh, choose
the Desktop button first.
Many applications help you find the Edition you want by displaying
the first part of any Edition you select in a small Preview box.
Select the Edition you want.
5 . If there is a choice of file formats, choose the one you want.

The TEXT and PICT formats, similar to those used in the Clipboard, are
usually available, in addition to private formats. (See "Understanding
File Formats" for information on formats.) Don't worry if you don 't
know which format to choose. You can easily resubscribe if the data is
not displayed properly. You can also change the format from the Subscriber Options dialog box.
6. Choose Subscribe.

Now that you have subscribed to an Edition, you may want to choose when
changes sent from the publisher will be made in your document-automatically or when ever you choose to send them manually. See the following section for more information.
Choosing Subscriber Options
After you have subscribed td a copy of published data, you can select several
subscriber options: how changes from the subscriber are made (automatically
or manually), the file format to be used in the subscriber, and whether formatting changes made in the subscriber are to be kept when the information
is updated. You can also open the publisher to edit it, and you can cancel th e
subscriber so no more updates will be sent.
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To select subscriber options, follo w these steps:
1. In the file that subscribes to published data, select that data.

Note that the data is selected as a block, so that you cannot edit it, except for cosmetic font changes, or changes to the size and shape of a
graphic.
2. Select Subscriber Options from the Edit menu. A dialog box resembling
the one in figure 9.9 appears.
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3. Select the option or options you want.
Options like the following are included by most applications:

• Get Editions/Automatically/Manually. If you choose Autom atically,
changes will be made as soon as they are sent from th e publisher.
If you choose Manually, you must access this dialog box again
whenever you are ready fo r an update, and click the Get Edition
Now button. The latest changes will then appear in you r document, if any updates have been sent by the publisher.
Note
Choosing when you get Editions only affects when you receive changes
that have been sent by the publisher. Publisher Options determines
when changes are sent. For more information, see "Choosing Publisher
Options" earlier in this chapter.

• Get Edition Now. Whether you have chosen the Auto mati cally or
the Manually button, pressing Get Edition Now immediately
brings in changes that h ave been sent from the publisher.

Fig. 9.9
A typical Subscriber Options
dialog box (usually
ava ilable from the
Edit men u).
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•

Cancel Subscriber. If you click this button, this particular subscriber
will no longer receive changes from the publisher. The information will remain in your document and you will be able to edit it
norma lly. You will be asked to confirm.

•

Open Publisher. Clicking this button takes you directly to the pu b-

lished data, even if it is in ano ther application. This allows you to
edit the sou rce data if you want.
Caution
When collaborating with other people on a network, be certain that the
editing you do to the publisher is desired by all subscribers.

•

Subscribe with. The TEXT and PICT formats used in the Clipboard

are usually ava ilable, in addition to private formats. See "Understanding File Formats" for mo re information on formats.
The following option appears in Word and a few o ther applications:
•

Keep Subscriber Formatting Ch anges. This option keeps for matting

changes you make to this instance of the publish ed data, such as
font changes, or changes to the size and shape of a graphic, when
the data content is updated. (Such cosm etic for matting changes
are usually allowed only to the whole block of information, not to
parts of it.)
4. Choose OK.

Note
You can cut, copy, and paste subscribed data at will, without losing the connection
to the published d ata.

Editing Subscriber Info rmation
Many applications allow you to do limited cosmetic editing to subscribers,
that is, changes to form but not content. Microsoft Word, for example, allows
you to change fonts and font characteristics in th e subscriber. Generally, the
changes must be to the entire block of information . f o r example, you may be
able to make the entire block of subscriber information appear in boldface
type, but you probably cannot make a single word appear in boldface type.

Transferring Live Data
Changes you make in t he subscriber are usually overridden when the subscriber is updated , unl ess you select a publisher option to maintain the
changes.
To change the content of a subscriber, such as deleting a word from a word
processing application, a line from a graphics application, or a n umber from a
spreadsheet, you must edit the publisher. See "Editi ng Published Information" earlier in this chapter for more information.

Troubleshooting
I have trouble keeping track of Editions-where they are located, who has subscribed to
each one, and which subscribers have been updated ond which haven't.

If you can get hold of a utility called Traffic Controller, most recently marketed by
Olduvai (Miami, FL), you can display an audit trail of Editions and their subscribers.
Unfortunately, the product is no longer being marketed.
Applications compatible w ith OpenDoc (described in the " The Future of Document
Exchange" section at the end of this chapter) will solve tracking problems by creating
and naming Editions automatically whenever information is published. The Editions
are to be stored in the folder where the published information is located.

If you don't have System 7.5 or OpenDoc applications, what con you do to manage the
use of publish and subscribe, short of writing a tracking utility yourself?

Use a consistent system for what to name and where to store Editions, and be sure
everyone understands the system. You might want to w rite a set of rules, such as the
following:
•

Whenever anyone publishes information, they are to send an e-mail message to the entire group of potential subscribers describing what they
publish ed, where its Edition is located, how it will be updated, and in what
documents it should appear. The same rules apply w hen someone changes
published information.

•

(If it fits your situation, the following rule ensures consistency.) Anyone
publishing information is to choose the option Send Editions Automatically.
Anyone subscribing to information is to choose the Get Editions Automatically button.

•

Editions should not be moved or renamed unless there is a good reason to
do so, and everyone is informed of the changes.

The updated information my document receives doesn't always match the publisher
exactly.

(continues)
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(continued)
There may be two versions of the publisher. This can happen in two ways:
1. You or som eone on the network may have done a Save As to save the document
w ith the publisher under a different name. Changes may then be made from both
documents to the same Edition.
2. You or someone else may have copied and pasted information containing a publisher. Changes may then be made from both instances of the publisher to the
sam e Edition.

The publisher may be set to send changes manually, or the subscriber may be
set to receive changes manuall y. Though changes have been made to the
publisher, they either have not been sent from the publisher or received at
the subscriber. To send the latest changes, put your cursor in the publisher
and select the Send Editions Now butto n fro m Publisher O ptions. To receive
the latest changes, put your cursor in the subscriber and select the Get Editions Now button in the Subscriber Options dialog box.

Linking and Embedding (OLE)
With certain applications, you can use another system of live data exchange
called OLE fo r object linking and embedding. As the name indicates, OLE (pronounced oh-LA Y) is actuall y two related techno logies, object linking and
object embedding. In both lin king and embedding, you add objects (text or
graphics) to a document and associate them with the applications with which
they were created.
Developed and owned by Microsoft, OLE is used in some of the most popular
programs for the Mac, namely Microsoft Word, Microsoft, Excel and Aldus
PageMaker 5.0.
Linking
Linking resembles pu blish and subscribe, d escribed previously in this chapter,

in that it updates one or more copies of data when the o riginal data changes.
It resembles copying and pasting even more, and is almost as easy to im plement.
With linking, you copy info rm ation from a source by using the usual Copy
command. Then you paste the informatio n at a destination by holding down
the Shift key as you g ive the Paste command. The linked info rmation appears
to the right of your cursor. Alternatively, you can use the Paste Special command, which allows you to choose a file format before pasting the lin ked
info rmation, as shown in figure 9.10.

Transferring Live Data
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Fig. 9 .10
Use Paste Special to
select a file fo rmat.

Unformotted TeHt
Picture
Word Document

Linking is particularly useful when you want to place a single copy of information within the same document o r gro up of documents as its source. You
can link an entire file or any portio n of it that you can copy to the Clipboard.
Cross-references are probably the best example. By linking figure and table
numbers to references to them in text, such as "see figure 3.3," the references
will remain correct if the figures are rearranged and renumbered. Similarly,
linking references to titles o r chapter headings ensures accuracy if the titles or
chapter headings change.
Linking can also be useful to link two files created by diffe rent applications
on the same machine, but your machine must have enough memory to run
both applications simultaneously. For example, to link betvveen a Word document and an Excel document, you need at least 4 megabytes (MB) of
memory. If you machine doesn't have eno ugh memory, or if yo u want to
link to or from info rmation on another machine, you can accomplish the
same task with the publish and subscribe method. See "Using Publish and
Subscribe" earlier in this chapter for more informatio n.
You can choose to update links automatically or manually-but you can also
choose to never update. (Tha t's intended as a temporary never.) Other link
options, which are chosen on the desti nat io n side of the link, let you cancel
the link, open the source, edit the link, and select a file format.
To help you decide whether linking is the most suitable method of data exchange for your needs, see table 9.3, which compares publish and subscribe,
linking, and embedding.
For specific instructions for us ing linking, look in the m anual that came with
your OLE-com patible software.
Embedding

Embedding is the second half of Microsoft's Object Linking and Embedding
technology. Embedding allows you to add to a document informatio n created
in a different application . The information becomes an embedded object, and
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all the information used to create it, including its file fo rm at, and informatio n about how to display and edit it, is included in the document. The classic example is embedding an Excel worksheet in a Word document.
You can embed an existing object by pasting it into your document with the
Paste Ob ject command, which appears in the Edit menu when you ho ld
down the Shift key. Or you can create a new object for the document by using the Insert Object command. You can embed an entire file or any portion
of it that you can copy to the Cli pboard.
Embedded objects contain not only the information you create, but the code
from the foreign application that lets you display and edit the information.
This allows you to edit in place, without havi ng to leave your current applicatio n to launch the other application.
In an Excel worksheet embedded in a Word d ocument, for exam ple, you
double-click the worksheet to edit it in an o bject wi ndow. All the Excel editing tools are ava ilab le in the window, enabling you to edit just as you would
in Excel itself. When you're fini shed editing, you save and close the window.
The embedded o bject is displayed in your Word documen t with the changes
you just made.
Embedding is a convenient method when you wan t to include inform ation
crea ted especially fo r a specific document. If you are wri ting a presentatio n,
for example, you can create and embed an Excel chart o n the spot to ill ustrate your po int. Unl ike publish and subscribe, the ori ginal document that
created the embedded object is unaffected by changes made to th e embedded
object since it is no longer lin ked to it in any way.
If you plan to transfer your docu ment o n a floppy disk, embedding is probably th e most conven ient method of exchanging data because it requires only
o ne file, as opposed to the two files needed for linking, and three fo r publish
and subscribe. Mo reover, the receiving person o r m achine does not need the
application(s) used fo r embedded information unless the recipient wa nts to
edit it. (However, the recipient will need to be able to open the base document, either by having the application that created it o r by having another
application that understands its file fo rmat.)
As with lin king, embedding requires that you r Mac have enough memo ry to
have both applications open simu ltaneously. To embed information between
Excel and a Word document o r vice versa, for example, you need at least 4
MB of memory. Embedding ca n also increase the size of your document considerably.

Transferring Live Data
Embedding is not a good choice if you wa nt to make more than one copy of
the same informati o n in a document, because you cannot u pdate embedded
objects simultaneously. Each instance of an embedded object has to be edited
individually.
To help you decide whether embedding is the most suitable method of data
exchange for your needs, see table 9.3, which compares publish and subscribe, linking and embedding.

Table 9.3 Comparison of Methods of Live Data
Publish &
Subscribe

Linking (OLE 1.0)

Excha~ge

Embedding (OLE 1.0)

Especially suitable
for information
that occurs frequently or changes
frequently, or
for networked
information

Especially suitable
for cross-references
and other information within the
same docum ent or
group of documents

Especially suitable
for including
information created
in another application, or for documents to be transported by floppy

Works over the
network

Doesn't work over
the network

Doesn 't work over
the network

Multiple files can
be updated simultaneously

Multiple tiles can
be updated simultaneously

Each file containing
embedded data must
be updated individually

File sizes virtually unaffected

File sizes virtually unaffected

File containing
emb edded data can
become very large

Requires three
files, making
transport difficult

Requires two
files, making
transport difficult

Requires one selfcontained file,
fully transportable

Data updated on
save or manually

Data updated automatically or manually

Data updated
automatically

M ultiple copies can
be updated simultaneously

Multiple copies can
be updated simultaneously

Each copy must be
updated individually

Source applications
not needed

All source applications needed

All source applications needed

Renaming or moving
sou rce file or
Edition files OK
on same hard disk

Renaming or moving
source file can
disturb the link

Renaming or moving
source file OK
anywhere

Memory to run two
applications simultaneously not
required

Memory to run two
applications simultaneously required

M emory to run two
applications simultaneously required
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The Future of Document Exchange
System 7.5 will add a new wrinkle to the process of transferring files from o ne
document to another. It's called Drag and Drop, and it allows you to select
and drag a text or graphic item and drop it into another document window
(even into a document created in a different program). You' ll also be able to
place the item you drag from one document and leave it on your desktop (as
a "clipping"), in case the receiving document window is not yet open. Of
course all this requires software developers to support this neat new feature in
their programs.
You can get a brief idea of how drag and drop works (at least for text in a
single document) in some current Macintosh software, such as Microsoft
Word, Nisus Writer, WordPerfect and QuarkXPress.
Another development on the horizon is OpenDoc, which, in effect, frees the
document from its association with a single program. With OpenDoc, when
it hits the marketplace of course, you'll be able to use one mini application to
create the text in your document, then use another mini application (perhaps
by a different software publisher) to create a drawing or a spreadsheet in the
very sam e document. You can get a glimmer on how this sort of thing works
with some of th e integrated software packages, such as ClarisWorks or
Microsoft Works, all of which offer application modules for such functions as
drawing, spreadsheets and word processing. But with these programs you are
still locked into using the modules provided by a single software publisher to
create your document.

From Here ...
Now that you have worked with exchanging data between applications, you
will probably want to learn about other forms of exchanging data. You may
want to read the following chapters:
• Chapter 20, "Integrated Software," covers three integrated applications,
including how data is exchanged between their component mini-applications.
• Chapter 34, "Data Exchange," gives more information on text and
graphics file formats, and includes exchanging files with PCs as well as
working with cross-platform applications.
• Chapter 35, "On the Road," covers PowerBooks, faxing, e-mail, wireless
communication, giving presentations, and so on.

Chapter 10

The Printing Chapter
by Gene Steinberg

When you finish working with your document file (or want to see how it
looks while it's in progress) you simply open the File menu and select the
Print command, or press :l=t-P. In the Print dialog box, click the Print button.
That simple action activates the Mac's Print function, beginning a complex
chain of events that ends with your document coming out of your printer.
This chapter shows you the following:
• How your Mac processes a document for printing
• The differences between QuickDraw printers and PostScript printers
• What Level 2 PostScript means to you
• How to solve common printing problems
• How Apple's new QuickDraw GX imaging technology affects you

How the Printing Process Works
When you activate the Print function, several things can happen, depend ing
on whether you activate background printing (the process allowing your Mac
to print a document while you continue your work). If you select background
printing in the Chooser, the data required to print your document is written
by a program called a printer driver to a special print file (called a spool file)
that is placed in your PrintMonitor documents folder under System 7.
After the document has been created by the printer driver, the data is fed
directly to your printer. This process can take anywhere from a few seconds
for a simple document to many minutes fo r a complex document containing
many pages and illustrations. When the page is fully processed, the printed
page is fed out of your printer.
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Background Printing or Not
Under System 6, you could wo rk in two modes. First was finder mode, under
which you could run one application plus, of course, the Finder. The second
mode (which is in effect by defaul t under System 7) was MultiFinder, which
allowed you to run mo re than one application at a time (if you had en ough
memory installed on your Mac).
In System 7 and System 6, Multi Finder gives you the option to activate background printing. Background printing allows yo ur Mac to process a document for printing while you are working on something else. The process has
its limitations. Background printing can make your Mac seem slower and
result in occasio nally sluggish mo use movement. That's because th e Mac's
CPU is dividing its time between two or more tasks.
'

Note
If you are using System 6 and cannot turn on background printing, even w hen
MultiFinder is active, open your System Folder and look for a file named
Backgrounder. This file provides the background printing capability. If that file is
m issing, you must reinstall it from your system disks.

The other lim itation is memory. Background printing requires an application,
Prin tMonitor (discussed in the next sectio n of this chapter), which uses a
sm all am ount of memo ry to do its stuff. The Mac operating system is also
grabbing additional memory at this time-so it's possible your Mac will put
up a message that there's n ot eno ugh memo ry to print (if you do n' t have a
great deal of installed RAM to begin with).
To turn off background printing, open the Chooser and click on the Off button on the right side of the Chooser window. Under System 7, if not enough
m em ory is available to print a document, you are offered the optio n of turning off backgro und printing just fo r that particular jo b.
Note
With som e printers, such as Apple's lmageWriter, the option to activate background
printing may not be available. You can get background printing capability using a
program such as the now -discontinued SuperlaserSpool by Symantec (you may still
find a copy on some dealer's display racks). Another alternative is one of the
Pow erPrint products from GOT Softworks, which includes a print spooling utility.

PrintMonitor
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PrintMonitor
Your Mac's system software contains a bare bones print spooling utility,
called PrintMonilor. Although you seldom see this program, you activate it
whenever you print a document with background printing turned on. The
program is launched when your Mac fi n ish es crea ting a spool file (a file on
you r ha rd d isk that represents the contents of a docume nt). The program
quits when all your documents have been processed.
Prin tMonitor feeds the print file of your docume nt to the printer, which then
prints your document. A few options are available. You can cancel a print job
or remove it from the list of queued docum ents (the d ocume nts ready to be
printed), as shown in figure 10.1. Or you can postpone a print job to a later
time (or indefinitely).
PrintMonltor ·

I &

Printing
Chepter 11-PnnUng •leserwnter Pn> 630

;I

Walling

Concel Printing

( Set Print nme ...

PrlntlnQ Slotus: Chople r I I - Prlntlnq
Pages To Print· B
Status preparing dele

While printing is in progress, the PrintMonitor window isn't visible unless
you select it from t he Application menu, whi ch under System 7 is located at
the right of the menu bar. If you select Preferences from t he File menu wh ile
the PrintMonitor window is active, you have some more options. The o n e I
always recommend is the option to keep the PrintMonitor window open all
the time (see fig.10.2). I recommend this choice because it enables you to
easily mon itor the progress of your job whi le wo rking on another document-and to know right away if printing trouble is afoot.
Although PrintMonitor has served basic Mac printing needs for several years,
its days may be numbered when Ap p le's new QuickDraw GX tec hnology goes
into gene ral circul ation. The major upgrade of Apple's imaging model is d iscussed later in this chapter.

Fig. 10.1
Click the Cancel
button to remove
your job from the
print queue.
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Fig. 10.2
PrintMonitor's
Preferen ces
window enables
you to con figure
the settings of
Apple's prin tin g
spooling program.

Pref erences. ..

Show the PrlntMonltor wiMow wh en printing:
O No

® Yes

When o print ing error needs to be reported:

C

~
~

• 0
• 0

•

Only dlsploy • In Rppllcotlon menu
Also dlsploy Icon In m enu bur
@ Al so dlsploy olert

When a monunl reed job st art s:
~

0
• 0

61ue no notifica tion
Di splay Icon In menu bur

~ ~ • ® Al so display nlert
( Concel J

Tip
If you receive
warnings of a
printing problem o n your
Mac's screen
while printing
a document,
open the
PrintMonitor
win dow right
away. Even if
the m essage
isn 't t erribly
descriptive, a
d ialog box that
gives you the
chance to try
p rinting again
will a ppear.
.,.. See "Troublesh ooting,"
p. 1051

Fig. 10.3
The p ri nting
process h as begun .
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Caution

-

When you use background printing, make sure that your boot drive has enough
room to contain the print file. A large document with complex graphics can occupy
several megabytes or more of disk space. If drive space is tight and you receive a disk
fu ll message, turn off background printing. This fi x won't work with the new
PostScript Level 2 driver (known as PSPrinter or LaserWriter8) because that driver uses
a two-pass processing scheme, in which a spool file (PrintMonitor document file) is
always created even if background printing is turned off. We discuss the new printer
driver later in this chapter.

Printing a Document-From A to Z
After you choose the Print function, the next action you take depends on
whether background printing is selected. If background printing is selected,
you'll be able to observe som e of the following steps in the PrintMonitor
window:
1. The applicatio n with which you' re working displays a status box showing that printing has begun (see fig. 10.3). While this status box is displayed, the contents of your document are converted by the printer
driver into a file that can be interpreted by your printer, such as a
PostScript file fo r a PostScript laser printer.
Prin ting "Chop t er 11 - Prlntlng••
To cancel, hold down the a key ond type o
period (.J.

Printing a Document-Fro m A to Z
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2. In a few minutes, when the status box disappears, your Mac is again
available for you to resume working.
3. Within seconds, PrintMonitor is launched, and the printer driver
sends a query across your netv<ork to locate your selected laser printer
(see fig. 10.4).
:r;J

Prlnt Monltor

I &

Printing
Chapter 11 -Prlntln~ • Loserwrfler Pro 630

_;1

wallins

I

I

Concct Printing

)

( Set Print Time ...

)

~

Fig. 10.4
Looking for your
selected laser
pri nter.

Printing Status : Chapter 11 - Prlntln g
Poges To Print: 6
Looking ror Loserwrlter •Loserwriter Pro 630.

4. If the printer has not been used for processing a file since you turned it

on, the Initializing

Printer message appears. When the Mac initial-

izes the printer, a laser prep file that contains instructions necessary for
it to process your document is transmitted to the printer.
5. Now that job really starts. Figure 10.5 shows the message displayed in

the PrintMonitor window.
PrlntMonllor

L &

Printing
Chapt er li-Prtnt1ng • Laserwrlter Pro 630
Woltlna

I

I

Concel Printing

)

I Set Print Time ...

)

J

~

Prlnttno Stntu s: Chnpt er 11 - Prfnting

Poges To Print: 5
Status: preparing data

6 . The next message displayed is processing job, which simply means that
the Mac is now downloading to the printer the information needed to
print the document. When the processing stage is complete, the
PrintMonitor window disappears. It may take a while longer for the
document to emerge from the printer, however.

Fig. 10.5
When background
printi ng is turned
off, a status
window below the
menu bar displays
the processing
steps.
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If you turn off background printing to speed up the printing process or to
work with a complex document that you cant print normally, PrintMonitor
is deactivated. The messages described in the preceding paragraphs will appear in a status window below the menu bar, as shown in figure 10.6.

Fig. 10.6

II s t otus: starling job

After the printer is
found and the
laser prep file is
downloaded (if
necessary),
printing really
begins.

QuickDraw versus PostScript
The biggest difference between a QuickDraw printer and a PostScript printer,
aside from the price, is that a PostScript printer (with the exception of some
very expensive color-proofi ng devices) has its own onboard computer. A
PostScript printer therefore doesn't need the Mac to process a document
when a file is sent to the printer, or spooled. A PostScript printer is also faster
because the time it takes to print doesn't depend so much on th e computer
crunching data.
Note
If you get an Initializing Printer message each time you send a new job to your
printer, it probably indicates that different versions of the printer driver may be used
by various Macs on your network (such as the System 6 and System 7 versions). If
you are using both System 6 and System 7 on your Mac network, you can safely
install System 7 printing software on all of your Macs to avoid the repeated initializing messages and improve printer performance. You can generally mix versions of
System 7 printer drivers without a problem.

A QuickDraw printer, such as an ImageWriter, a DeskWriter, or a StyleWriter, uses
the Mac's native imaging model and the Mac's CPU to process documents. The
speed with which your document is handled depends on how fast your Mac
crunches data and how many fonts and graphics are contained in the graphic.
The QuickDraw printer has other limitations besides speed. It cannot handle
PostScript fonts without a program to process (rasterize) those fonts to convert
them into bitmaps that the pri nter can image. Adobe Type Manager or a
PostScript emulator program such as Freedom of Press is required for this
purpose.

QuickDraw versus PostScript
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You also will suffer the limitations of QuickDraw techno logy when you attempt to rotate text and graphics. Although some drawing programs, such as
Canvas, are optimized to offer q uality printing on a QuickDraw printer, other
software will only reward you with jagged edges on picture elements. If a
document includes linked EPS graphics, the printout will represent the low
resolutio n 72 dpi PICT image that you see on your Mac's screen.
PostScript technology was first introduced by Adobe System s in 1985, and it
revolutionized the switch from traditional typesetting to desktop publishing.
Briefly, PostScript printer drivers reduce the content of your document to a
mathematically-based description of what the page looks like, which is why
PostScript is called a page description language. The descriptio n of the page is
independent of the resolution of your printer. You can get 300 dpi printing
on your 300 dpi laser printer. If you take the very same document and image
it o n a 2400 dpi imagesetter, you have a 2400 dpi printout.
The PostScript printer's controller board contains an o nboard CPU that
rasterizes or converts the description of a page into a bitmap that is then
imaged onto paper or film . Because the printer does the processing, the slowdown you experience wh ile the Mac is in background printing mode is reduced. The speed it takes to print your document depends o n the printer's
processor and imaging engine.

Dot Matrix Printers
The do t matrix printer, typified by the App le lmageWri ter series, is the closest
approximation in the Mac computing world to an electronic typewriter. The
d ot matrix printer uses a printer head that strikes a moving ribbon of som e
sort- much like a typewriter's ribbon. Each character is made up of little dots
(hence the name dot matrix). Printers commo nly offer 9-pin and 24-pin capability. Printers with 24-pin capability provide a sharper printout, but the
o utput q uality, even in letter-quality setting, seldom exceeds that of your
garden variety typewriter.

Apple's lmageWriter
Apple's first printer, the ImageWriter, and its various descendants (such as
the Image Writer II), are still in regular use by thousa nds of users. In fact, fo r
certain forms to work, requiring multi-part copies, an impact printer may be
your only cho ice.
When run in its "best" setting, the ImageWriter is capable of a resolution of
160 d ots per inch horizontal, 144 dpi vertical. Although this setting is fine for
text, it does odd things to graphics, which are based on the Mac's 72 dpi

Tip
If you must use

the Tall Ad justed
option, you might
consider horizontally scaling your
text (which can be
done in most
publishing programs) to compensate, or to
print text on a
separate page.
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metapho r. In order to make a circle (and not an oval), for example, you have
to print using the Tall Ad justed option. This fixes your graphics, but has the
disadvantage of reducing the width of your docum ent by approxi mately 11%.
You end up with properly proportioned graphics, but skinny text.

Inkjet Printers
The new family of inkjet printers has pretty much replaced dot m atrix printers for many Mac owners. With prices starting at less than three hundred
dollars, an inkjet printer can provide 300 dp i output o r better. These printers
use little ink-laden cartridges that travel back and fo rth, spraying letters and
graphics across the printed page as it moves through the printer.
Output quality isn' t quite up to laser prin ter standards, however. The ink has
a tendency to smear and spread on the page. Type and graphics aren't as
sharp as laser printer output. And inkjet printers can be slow. Speeds of u p to
two pages per minute are advertised for products from Apple and HewlettPackard, but these models can bog down on complex jobs and take m an y
m inutes to image a single page. Since they are QuickDraw devices, the li mits
in text and graphics handling described above apply here, too. Some
PostScript software fo r these printers is hitting the marketplace, which
will improve the qua lity of your output but not the speed with which it's
processed.

Laser Printers
Even tho ugh the products themselves may bear such names as Apple,
Hewlett-Packard, NEC, or QMS, laser printer engines are often made by the
same manufacturers as copy machines, such as Cano n and Tos hiba, and they
share many components. A laser printer actually uses a low-power laser device that shines a light beam onto a metal drum. Toner particles are att racted
to the drum by an electrostatic process and are then transferred to the paper
by a set of heated or fusing ro llers.
The toner is often co ntained in a cartridge that also contains the drum. That
makes the process of toner replacement fast and clean. Main tenance costs are
kept down because the drum is regularly replaced. Some models include separate toner and d rum cartridges, others supply toner in powder form.
Some printers use a special fine grain toner, made up of very small particles,
as a means to offer higher q uali ty output. But the phenomenon of the toner
spreading slightly as its fused onto the printed page will make laser printer
output suffer somewhat in comparison to an imagesetter (d iscussed later in
this chapter).

What is PostScript Compatible?
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When PostScript laser printers first came out, they often cost as much as a
high-end Macintosh. But as technology has improved, and the price of
PostScript interpreters was reduced, the price of a new printer has fallen below a thousand dollars in some models. Although laser printers are still available as QuickDraw devices, which process documents in the same manner as
a dot matrix or ink jet printer, price reductio ns of PostScript models- and
their higher processing speed and quality-make them the better buy.

Resident Fonts
PostScript laser printers usually come with a sma ll library of fonts stored in
the printers ROM chips (see fig. 10.7). These are known as resident fonts and
usually contain a basic set of 35 fonts (although some printers offer less).
They range from such commonly used styles as Helvetica, Palatino, and
Times, to deco rative styles such as Avant Garde, Bookman, and Zapf
Chancery.
J!J
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Some models also supply additional fo nts on an attached SCSI drive, o r on
separate disks. Because these fonts might cost hundreds of do llars if bo ught
separately, buying a printer with extra fo nts might be a good idea. The basic
laser printer fo nts are overused and abused, and a little va riety is bo und to
spruce up your d ocuments.

What is PostScript Compatible?
A number of laser printers are advertised as "PostScript Compatible." This
phrase indicates that th e printer is no t using a PostScript interpreter licensed
from Adobe. Instead, the printer is using an imaging techno logy that emulates PostScript. Sometimes these are known as clone printers. In the past, a
manufacturer would often be able to o ffer such products at lower cost

Fig. 10.7
This display, from
the LaserWriter
Utility program,
shows some
standard laser
printer fonts.
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because they didn' t have to pay formerly high royalties to Adobe to license
the right to use the rea l thing.
The word PostScript clone or co111pntihle used to put up danger signals in the
eyes of the would-be purchaser. The em ulator programs used by these printers would often choke on TrueType fonts, Adobe's Multiple Master fonts, or
even on complex illustrations. Sometimes the hinting used by font manufactu rers to make their type faces look better in small point sizes at low resolution weren't supported. Printouts of small text were often blurred or chunky,
with fine details of serif cha racters being filled in.
Over time, the quality of th e imita tion PostScript printer has come close to
the real thing. To the naked eye, you cannot tell the difference. But the price
of a true Adobe PostScript pri nter has decreased to the point where there is
little, if any, price differential. Your choice in a printer should probably be
based on price, output quality, and the features that are meaningful to you.

Resolving the Question of Resolution
The very first laser printers offered 300 dpi resolution. Compared to a typew riter or dot matrix output, the printouts were sharp, crisp, and clean, quite

close to what you'd see in some printed material. But when using high qua lity graphics, the limitations of 300 dpi are obvious. At best such a printer is
useful fo r text documents, letters, or inter-office memos.
Improvements in printer engine technology have now brought about a whole
new line of 600 dpi laser printers, costing less than $1500 in some models. To
get a clear picture of what 600 dpi means to you, consider that printer resolutio n is the number of dots that fill a square inch (the total of the horizontal
and vertical specs). A 300 clpi printer puts 90,000 dots o n a single square inch
of a prin ted page. A 600 clpi prin ter (600 dpi horizontal, 600 dpi vertical) puts
360,000 dots on the same square inch-thus you get four times the resolution.
Some printers offer odd resolutio n capabilities, such as 400 dpi, or even 600 x
300 dpi (600 dpi horizontal, 300 dpi vertical), which isn' t quite as good.
When in doubt, look at a printed sample as a means of comparison.
Some laser printers advertise near-imagesetter quality, wi th resolution of 1200
dpi o r greater, for not much more than a few hundred dollars over the cost of
the 600 dpi version. What's the secret?
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Most of these printers use the very same 300 to 600 dpi printing engines as
their lower-resolu tion counterparts. But the printer's controller board uses
software to va ry the size of the dots that make up the image, or even controlling the way the drum turns as it processes a page. The combination of such
techniques results in 1200 dpi interpolated output. While the prin ted copy is
often sharper t han a 600 dpi page, toner particle residue and the limitations
of plain paper often conspire to minimize t he differences.
If you compare the output to that of even a 1200 dpi imagesetter (which uses
an imaging engine designed from the ground up for high resolution and
photographic paper or film), th e differe nces even to the naked eye are still
qu ite noticeable.

Using Hard Disks for Font Storage
A number of laser prin ters offer you the option of attaching a SCSI drive for
font sto rage. Some expensive models are already equipped with a hard drive.
This o ption does have its advantages. You get fas ter printing speed s with
documents that contain a large number of fonts, si nce the fonts no longer
have to be downloaded from your Mac.
There are d ownsides, however. The process of downloading your fonts to the
printer's disk is time-consuming. It can take up to 30 seconds o r more per
fo nt, and with a huge font library, installation can take ho urs o r days to complete. Also, traditio nal hard drive backup and repair tools w ill not support
your p rinter's hard drive. Should the d rive crash, you are left with no recourse other than to reformat the d rive and down load your fonts all over
again.
Another shortcoming affects users of TrueType fo n ts, or PostScript fonts with
Ad obe Type Manager. In order for you to retain th at crisp, sharp screen display o f your type, you must keep t he very same copies of your fo nts on your
Mac's hard drive. Apple's TrueType rasterizer and ATM are not able to retrieve
fo nt o utline informatio n from your printer or its SCSI drive. Whatever conven iences it o ffers, saving disk space is not one of them .

Caution
Apple's LaserWriter Utility and some printers are finicky about the kind of hard drives
they will support. Before deciding to convert or purchase a drive to attach to your
printer, consult the manual or contact the manufacturer as to whether the drive you
want to buy is compatible.
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LaserWriter Utilities and Font
Down loaders
Apple and many other font and printer vendors offer free software that lets
you download fonts to your printer or your printer's hard d rive, format the
drive, print font lists, down load print to disk files, and even activate custom
features from your printer.
This section describes Apple's LaserWriter Utility because it ships with the
system software disks and is also supplied with the installation disks fo r
Apple's laser printers. But these features are often available in no n-Apple
utilities as well. Your printer's manual, o r a simple exploration of the software, will yield some su rprisi ng fea tures. They are described in order here, but
bear in mind that no t every printer will su pport all of these features.
When you run LaserWriter Utility, it probes you r printer first to record informati on about make and m odel and special features. If an item in the menu is
grayed, that item is not supported by your printer.

Caution
If you are presently printing a document, don't launch LaserWriter

~ til ity.

Its modal

(non-movable) dialog box will prevent you from working on your Mac until the
operation is cancelled or all documents have been printed.

• Download Fonts. This feature allows you to send fonts to your printer's
RAM or to a hard drive installed on your printer. The fo nt downloading
process is simple, as shown in figure 10.8. Follow these steps:
Fig. 10.8
Adding fonts to
your laser
printer's memory
or disk.
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1. First you launch the LaserWriter Utility and wait for a few seconds
fo r it to get information about your printer. You then open the
Download Fonts dialog box, and click the Add button.
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2 . A standard dialog box appears, and you select the fonts you want
to add.
3. After you select the fo nts, you return to the main Down load Fonts
window (see fig. 10.9).
4 . Select the destination for your fonts. If you r printer has a SCSI
drive attached to it, the Printers disk{s) optio n will be ava ilable.

5. Click the Download button. Be prepared to wait several minutes
for th e download process to run its course.
Fig. 10.9
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Caution
If you download a font to your printer's RAM, turning off or restarting that
printer causes the font information to be flushed from its memory. Downloading too many fonts simply overwhelms the printer's memory bank or
provides less RAM in which to process a complex document.

• Display Available Fonts. This is a fast way to see just what fo nts are
stored on your printer.
• Initialize Pri11ters Disk. When you install a hard drive o n your printer's
SCSI port, you need to fo rmat th e drive especially for storage of printer
font files.
• Print Font Catalog. Here's a fast and di rty method of providing a catalog
of the fonts stored on your printer. Fonts that are o nl y available on
your Mac's hard d rive are no t included in this printo ut.
• Print Font Samples. This is a font style sheet, complete with a single sentence set in each typeface stored on the printer or printer's disk.

A list of fonts

ready to be
downloaded to
your printer.
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• Name Printer. If LaserWriter Pro 630 or a similar dry description doesn't
appeal to you, here's where you can exercise your creativity, as shown
in figure 10.10.
Fig. 10.10
Personalizing your
laser printer.

nennme the chosen printer:

Current nome: LoserWrlter Pro 630
New name:

IGene's rnuorlte Printer

• Set Startup Page. Turning off the startup page that spews forth from your
printer when you firs t turn it on is a way to preserve our natural
resources. The downside is that the startup page is a useful tool to determine whether the printer is working properly, or if toner is spent.
Consider that before shutting off this feature.
• Get Page Count. If you turn off the startup page, you should check this
selection on occasion if your printer's running up a lot of mileage, to
see whether an overhaul is needed.
• Imaging Options. This selection allows you to turn off special resolution
enhancement features or to switch printer resolution. You can also
change some of these settings in the Print dia log box, under Options, if
you're using the Level 2 PostScript printer.
• Calibrate Printer. On some models, such as Apple's LaserWriter llf and
Jig, you can print sample pages and ad just gray scale reproduction.
• Configure Communication. Some printers allow you to adjust which ports
support which printer emulation in this manner.
•

Print Configuration Page. This o ption allows you to print a page showing
the settings that are active on your printer.

• Download PostScript File. If you have a print-to-disk file, this option
allows you to send it on to your printer for output. just follow these
steps:
1. Select the Download option in the LaserWriter Utility.
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2. A standard dialog box opens, and you can choose the file you want to
download to your printer in the sam e way as you wou ld open any other
file.
3. After the file is selected, you are offered the chance to create a log describing the print process, as shown in figure 10.11.
4. No background printing is in effect when you download a file to your

printer this way (see fig. 10.12}. You just have to wait until the process
is finished.
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Fig. 10.11
C reating a log of
your PostScript
file's printing
process.

Downloading the file " Block oorders
I" to PostScript printer .. l tuorWrlter
Pro 630" •••

• Remove TrueType. This option, supported by some models, enables you
to remove support for TrueType fonts.

• Restart Printer. Th is option is basically the equiva lent o f pressing the
power switch off and on again. The printer goes through its normal
startup routine, and, if enabled, prints a startup page.

• Change Zone. This feature is supported by some models of networked
printers used in multiple zone setups.

• Print Density. Some printer's offer a slider or dial wheel with which to
adjust printer density. O thers do it with software.

• Paper Handling. You can set the printer's default paper tray and other
special features with this option, as shown in figure 10.13.

• Power Saving. Some new printers are Energy Star co mpliant; that is, they
will automatically power down into an idle mode when inactive for a
certain period of time. When a document is sent to the printer, it will
automatically power up again. Since the startup p rocess can take a

Fig. 10.12
A status report
showing the
PostScript file
bei ng downloaded
to your printer.
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m inute or two, if you are sending a great deal of work to the printer,
you may decide to turn th is fea ture off.

Fig. 10.13
Changing t he
default paper size
on a LascrWriter
Pro 630's Mul tipurpose tray.
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Having a Dialog with Your Printer
Depending on the kind of printer you're using, you' ll have a n umber of
choices to make each time you print your docu ment, if you're not just okaying the standard page setup. The dialog boxes described in the following
sectio ns will change, often considerably, from program to program. So if
what you see when you invoke the Page Setu p command doesn't q ui te jibe
with o ur descriptio n, consult your software manual or Help menu for fur ther
assistance.

lmageWriter Setup Options
Yo u don't have too many cho ices here (see fig. 10. 14) . You can select paper
size and o rientatio n (portrait o r landscape). The important options are Tall
Adjusted, which allows illustrations to print in their proper proportions, and
50% Reduction, which offers sh arper output for you r illustration.
Fig. 10.14
An ImageWriter's
lim ited Page Setup
options.
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StyleWriter Setup Options
The standard App le StyleWriter setup (other inkjet printers are sim ilar) enables you to select paper size and orientati on (see fig. 10. 15). You have the
added capability of scaling your document to a particular size. This is useful,
especially if your publication needs to be red uced in size to fit on regular
letter or legal-sized paper.
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Fig. 10.1 5
Your Page Setup
options wi th a
StyleWriter II.
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LaserWriter Setup Options
Setting up your document when you're using a laser printer confronts you
with a number of d ifferent choices that are summarized in this section, as
shown in figu re 10.16.
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Caution

-

If you are using the Level 2 PostScript driver, the printing choices described in the
following paragraphs are available only by clicking the Options button.

Some of the printer options described in the following list are turned on by
default, but you can switch them off if the featu res are of no value to you. In
fact, when you have a problem printing a document, unchecking a few of
these items (which are sometimes called printer effects) may improve printing
speed somewhat. You should select the following printer options:
• First you wan t to choose the correct paper size and orientation.
• Document scali ng should be selected next, if o ther than the standard
100%.

• Font Substitution. This setting is a relic of the early days of the Macintosh. Apple system software typically installs such screen display fonts
as Chicago, Geneva, Monaco, and New York, but until System 7 came
along, there were n o printer fo nt equivalents. You checked font

Tip
If your documents
print in a size
d ifferent from
what you expect,
check your Page
Setup box and see
whether the document reduction or
enlargement
setting is correct.
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substitution to allow Helvetica to substitute fo r Monaco, for example,
and Times to substitute fo r New York.
•

Font Smoothing. In theory, bitmapped fo nts will print sharper o n a laser

printer with th is option selected. Since low-cost PostScript and
TrueType fonts are read ily available, bitmapped fo nts have quickly gone
out of fashio n.
•

Graphics Smoothing . This option supposedly does fo r bitmapped graphics

what Font Sm oothing does for bitmapped fonts; it makes them print
cleaner and crisper. But for most users, this cho ice has li ttle or no effect.
•

Faster Bitmap Print ing. Here's another theory that doesn' t always trans-

late into a practical benefit. The in ten tio n is to optimize bitmap graphics before they are fed to your prin ter to speed up the printing process.
The reality is that the reverse often happens. If you are using the Level 2
printer driver, you will not have this option .
With the standard LaserW riter prin ter d rivers, the following choices are ava ilable only when yo u click the Optio ns butto n (see fig. 10.17):
Fig. 10.17
Optional settings
ror your laser
prin ter.
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• Flip H orizontal/ Flip Vertical. When you prepare a document fo r film

output on an imagesetter, you will often hear req uests such as emulsion
side down . Flip Horizontal is the selection you want to make. As for Flip
Vertical, that's an option I cannot imagine ever choosing.
•

In vert Image. This selectio n changes your positive image to a negative,

usefu l fo r some printing requirements, especially w hen o utputting to a
fil m m aster.
•

Precision Bi tmap A lignment. This featu re is useful when printing

bitmapped graphics o n a laser printer. Since these graph ics are ty pically
72 dpi (or a m ultiple thereof), they wo n't look very clear when printed
on a 300 dpi laser printer. Scaling them down fo ur percent (which affec ts your text, too) will offer crisper printouts.
If your printer offers a resolutio n o ther than 300 dpi, th is fea ture can be
worth less.
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Note
'

The latest versions of Level 2 PostScript driver don't show the 4% reduction
option, because the driver will automatically scale a document to the correct
size even if the target printer is 400 dpi, 600 dpi, or greater.

•

Larger Print Area. In order to conserve memory and allow it to be used

for additional fonts, some laser printers have a preset lim it in page
width. It's typica lly one half lo one full inch. If your document's print
area exceeds that margin (and part of the printout is cut off as a resu lt),
you need to select this option .

Tip
If you are usin g
the Level 2
PostScript driver,
the Larger Print
Area option may

Caution

be grayed, because the stan-

Some printers may require a RAM upgrade to image legal-size pages to the full

dard print area is

printing area. Other models, like Apple's original LaserWriter or LaserWriter

the largest avail-

Plus, may not be able to print documents with this selection at all.

able for the
selected printer.

•

Unlimited Downloodable Fonts. This is a time when one choice doesn't
override another, and it should. If you select this option and Larger
Print Area at the same time, you will probably find your documents
won't print at all. This is a selection you want only as a last resort,
when your printer doesn't h ave enough RAM to process all of the fonts
you a re using in your document.

This option allows the printer driver to down load a batch of fonts into
RAM and then remove or flush them, and download the next batch.
This keeps the printer's memory bank from getting overwhelmed with
font information. It also slows down the printing process, but when
nothing else works, th is may be the only ch oice you have.

Caution
If you suffer from Courier font substitution on a document w ith linked EPS
graphics, turn off Unlimited Downloadable Fonts. Font information from your
EPS graphic may not be downloaded correctly. If you must use this printer
effect, try to convert the font in your EPS graphic to outlines, if your software
offers that choice. If not, use the font itself somewhere in the text area of your
document (even if the text is set to white so it is not reproduced). This little
workaround will often allow the font to be used correctly in your document.
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Okaying the Print Process
The options you have in printing your document depend on the printer
you' re using, and the program from wh ich you're going to print. The dialog
box shown in figure 10.1 8 applies if you're using the Level 2 d river with
Microsoft Word.
Fig. 10.18
When you cl ick
the Print button,
it only represents
the start of the
print process.
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Across the top of the dialog box, you can select the number of pages you
wan t to print and w hether all the pages, o r just a range of pages, will be
printed. Some printers give you the optio n of selecting a paper source, such
as a m ul tipurpose or alternate paper tray. Under System 7 you can choose the
destination for your documen t, whether it is the printer or a PostScript (pri n tto-d isk) file. The o ptions beneath these allow you to choose odd or even
pages. (lleft o ut th e selections at the very botto m of the dialog box, which
are speci fic to Microsoft Word o nly.)

Note
The selection of individual pages varies fro m program to program. Aldus PageMaker
5.0, fo r example, allows you to choose a non-contiguous range, mixing even and
odd pages fro m different parts of your document.

The Lowdown on Level 2 PostScript
In 1991, new printers arrived on the scene with the buzzword Level2
PostScript. Rather than just reflecting som e advertising copywriter's idea of
how to sell a few more products, Level 2 PostScri pt represented a major upgrade to prin ting technology.
The printers themselves used a new line of PostScri pt interp reters that were
designed to process and image documen ts more efficiently, with some neat
new capabiliti es (described shortly).
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If you were on e of the first purchasers into the new techno logy, it really
didn 't offer an y real advantage at first. It took ano ther two years for Adobe
and Apple to release prin ter drivers to support the new technology. The following list discusses what- if an ything-Level 2 means to you:

• More efficient printing. Even if your printer did not support Level 2, the
new printer driver creates mo re efficient PostScript code that results in
somewhat faster p rinting, and a fewer number of aggravating repo rts o f
PostScript erro rs. On a Level 2-equipped p rinter, the speedup would
no rmally be fro m 10% to 30%, d epending on the complexity of the
documen t.

• Compression all(/ decompressio11. In o rder to speed transfer of data across
the network to your p rinter, some program s will actually compress the
da ta. The Level 2 printer ca n decompress this data when it reaches the
printer's contro ller.

• Memory Management. Running out of memory is an all-too-co m mo n
occurrence with PostScript printers. Up until now, your printer's RAM
was split up in little blocks, each performing a specific func tio n, such as
handling tex t o r graphics. A Level 2 printer can tap whatever available
m emo ry it needs in order to process a d ocument.

• Higher Quality 1-lalfto , es. Halftone reproduction can be a problem , even
o n an imagesetter. The Level 2 driver has an improved halftone processing routine that results in improved quality output, free o f mo ire patterns and other un toward side-effects.

• PostScript Pri11ter Descriptions. The newes t model laser p rinters spo rt multiple paper trays, special resolution enhancement techn iq ues, and reso lutio n ad just men ts. The Level 2 d rivers com e with a set o f PPD files
(which are installed in a special fo lder inside System 7's Extensio ns
folder called Printer Descriptio ns) that allow you to tap your printer's
unique features. W ith the correct PPD file installed, you can redirect the
jo b to a differen t paper tray o r change a p rinter's defa ult settings righ t
fro m your Print dialog box.

• Forms and pattern caching. The Level 2 driver is capable of storing freque ntly used fo rms, such as invoices o r pat terns. Although early releases of the Level 2 d river didn't su ppo rt these featu res, it allowed you
to speedily print mo nthly statements and documents containing special
illustratio ns th at are used over and over again.

Tip
If your printer's
PPD file didn 't
co me w ith t h e
Level 2 driver o r
a softwa re package, call t he
manufacn1rer fo r
a copy.
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Caution

-

Turning off background printing with the Level 2 driver will probably not
speed up the printing process. The early releases of the Level 2 driver use a
two-pass processing technique that is d esigned to optimize PostScript code.
The downside is that a printer spool file is created whether background printing is on or off.

Installing the Level 2 Driver
Adobe and Apple's Level 2 d river comes in several flavors. Usually it' s named
PSPrinter (the Adobe edition) o r LaserWriter 8 (from Apple). You can get a
copy of the Apple version with a brand new Apple laser printer, or from
onli ne services such as America Online, CompuServe, or eWorld. The new
driver is bundled with such software products as Aldus FreeHand, Aldus
PageMaker, and Frame Technology's FrameMaker.
The driver is also packaged with a small manual and is available for a modest
price from either Adobe o r Apple. It is also shipping with System 7.5.
Installation is simple. An Installer application on the installation disks deposits the correct files in your System Folder (see fig. 10.19). Under System 7, the
Level 2 driver and a folder named Printer Description s are in your Extensions
folder. They are loose in the System Folder under System 6.
Fig. 10.19
Insta lling the new
Level 2 printer
drive is a snap.
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Level 2 Printer RAM Requirements
Before you install the Level 2 driver, be sure your Mac has enough RAM
and the correct system software version. For System 6 users, you need to be
running System 6.0.7 or 6.0.8 and have at least 2MB of installed RAM. For

Installing the Level 2 Driver
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System 7, RAM requirements are 4MB. (If you have less than 4MB RAM available, you should probably not be using System 7 in the first place.)

Printer Setup
The Level 2 driver comes with a selection of PPD (PostScript Printer Description) files for many popular printers. Apple' s LaserWriter 8 ships strictly with
Apple PPD files. You will find additional selections in some of the software
packages that have bundled the driver. If your printer's PPD is not included,
check the installation disks that came with your model. Sometimes you'll
find a copy there. Or call the manufacturer of your printer. In the meantime,
you can often get by with the driver's internal General PPD. You will probably get satisfactory printing results, but you will miss out on using your
printer's special features through the print dialog box, such as multiple paper
trays and resolution switching.
To set up the driver to support your printers, follow these simple steps:
1. Open the Apple menu and select the Chooser. In the Chooser dialog
box, select LaserWriter 8 (or PSPrinter), as shown in figure 10.20.
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Fig. 10.20
Select the Level 2
driver from the
Chooser desk
accessory.
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2. Click the Setup button in the lower right corner of the Chooser
window.
3. Choose Auto Setup, as shown in figure 10.21. The driver will probe your
Printer Descriptions folder and choose the correct PPD file. If one is not
available, you'll be offered the option of selecting an alternate PPD file.
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Fig. 10.21
For most printers,
the Auto Setup
option is enough
to get you up and
running with the
Level 2 driver.
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4 . If Auto Setup won't work for you, click the More Choices button, which

will allow you to examine your printers RAM setup, PostScript version,
and other juicy details. You'll also have the option of manually selecting a PPD file that may be usable if the automatic option doesn't work.
If all else fails, consult the Help feature for more advice, as shown in

figure 10.22.
Fig. 10.22
If you run into
trouble setting up
the Level 2 driver,
click the Help
button for more
advice.
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Exclusive Level 2 Options
The Level 2 driver makes printing a PostScript file a snap. It also gives you
some new options that are useful if you want to create an EPS graphic from a
program, say an older paint application, that doesn't offer an EPS option.
Because many desktop publishing programs and laser printers choke on a diet
of PICT graphics, this choice may mean the difference between getting the
job done or having to deal with a procession of printer error messages.
To see how easy it is to make your own EPS files with the Level 2 driver, follow these steps:
1. To create a print-to-disk or EPS file, open the File menu and choose

Print.
2 . You have a choice of two Destinations for you r print job. You' ll want to

select File, as shown in figure 10.23.
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Fig. 10.23
Preparing to send
a document to a
PostScript or EPS
file rather than a
printer.

0 Euon Pages Only
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D Prtnt Dock To fro nt

3. You can use the file name selected by the driver or pick one of your
own, along with the destination of the new file.
4 . Open the Format menu to select the kind of file you want, as shown in
figure 10.24. To create an EPS file, you should choose EPS Mac Standard
Preview or EPS Mac Enhanced Preview. The second choice will make a
larger file, but a better screen d isplay when you impo rt or place the EPS
graphic into your document.
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5. If you are going to create a print-to-disk file fo r a printer non-Level 2
printer, you only need to change the file fo rmat settings; otherwise you
can ignore those selections.

6. The Font incl usion pull-down menu allows you to decide whether your
EPS file will contain fonts, as shown in figure 10.25. The usual setting is
None, which keeps your EPS file down to a more manageable size.
You can opt to include All fo nts, which may be useful if you need to select
the Unlimited Downloadable Fonts option in your printer's Page Setup box.
That ought to minimize font substitution problems. If you r EPS file contains
the basic 13 fonts, such as Helvetica and Times, select the fina l font option.

Fig. 10.24
Choosing the file
form at for your
EPS file.
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Fig. 10.25
Deciding whether
your EPS file will
include fon t
information.
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Some Hard-Won Tips on Buying
a Printer
Not too many years ago, a PostScript laser printer was an item that o nly a
large business o r service bureau could afford to buy. The rest of us were content with a dot matri x printer o r a QuickDraw laser printer.
But just as powerful Macintosh computers are now available at prices beginning at less than a grand, the same holds true for a laser printer. If you opt fo r
the small inkjet or bubble jet model, you can get by with a model for less
than three hundred dollars. The following sections offer a few helpful hints
on wha t to look for when you go printer shopping.

How Many Real Pages Per Minute?
In big, bold letters, the ads for many popular laser printers will state their
speed in pages per minute, usually four, eight, sometimes up to 20. And it is
true that the imagi ng engine of your printer is, in theory at least, capable of
performance at that level.
That is, if your are printing a simple all text document with resident (ROM)
fonts, or multiple copies of the same document.
Your real speed limitation is no t the maximum speed of the printer's engine
but of its controller board, the assemblage of components, RAM, ROM, and a
CPU that actually processes your print job. When you compare speed of a
printer, you want to know how long it takes to tackle your document from
the time you okay the print process on your Mac, until the printed page
slides out of your printer.
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Printers using the same engine ca n take d ifferent amoun ts of ti me to actually
print som ething; it all depends on t he capabilities of its controller board in
being able to process data.

Image Enhancement
There are a n umber of techniques used to spruce up the qua lity of laser
printed text and gra phics. They have such nam es as FinePrint or PhotoGrade
(from Apple), RET (Resolutio n Enhancement Techno logy) from HewlettPackard, o r Turbo Gray from LaserMaster. They are all designed to sharpen
text or provide spiffy halfton es by increasing the n umber o f steps o f gray.
When shopping for a new printer, try to look at a sample printou t with and
without these en hancement tech nologies, and see whether you can actually
see the d iffe rence. Some of these featu res may require a RAM u pgrade o r slow
down printing performance to some degree because the p rint files take longer
to process. Be sure to read the fine print.

Networking
Your standard laser prin ter sho uld network to a regular LocalTalk network,
bu t most newer Macintosh models suppo rt Ethernet connectio ns as well.
Some pri nters offer Ethernet standard, others offer an Ethernet option. Ch apter 33, "Networking," describes many of t he possibilities for you in much
more detai l.
Very b riefly, you ca n yield a noticeable perfo rmance boost if you take the
Ethern et rou te. When using background printing, you r Mac will not suffer as
great a performa nce drag whi le a document is being processed. The increased
bandwid th of Ethernet will also keep your netwo rk from bogging d own when
a nu mber of jobs are being fed to several workgrou p pri nters.
Because cross-platfo rm networks are very common, its also necessary these
days fo r printers to speak bo th Maci ntos h and Windows language. Som e
p rinters offer mul tiple active ports, mean ing that Macs and PCs ca n q ueue
jobs to the prin ter without having to push di p switches or make a new software setting.

Plain Paper lmagesetters
Previously in this chapter, 1 described t he resol ution boosting tech n iques
used by printer manufac turers. The lo ng and short of it is that the quality o f
t he text on one of t hese devices may look quite sharp and clea n to the naked
eye, especiall y when you use a high quality grad e of laser printer paper, but it
doesn't quite compare to the output that emerges fro m o ne of the regular
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imagesetters. There may even be a wider gap between the quality of halftones
and other graphics. But for many applicatio ns outside of a slick magazine or
book, the level of reproduction from one of these lase r printers may be more
than sufficient for you.

Paper Size
The standard laser printer can ha ndle traditional letter size (8-1/2 x 11) and
legal size paper (8-1 /2 x 14). Some models accept tabloid (or ledger) size paper
(11 x 17) as well, and a few models can handle 13 x 19 or similar large sizes,
which allows them to support a two-page printer's spread of a letter-sized
page, complete with crop marks. These larger printers carry much higher
price tags, and toner cartridge replacement is apt to be more costly as well. If
you do n't intend to use a larger paper size, you don't need to consider such a
model.

Printer's RAM
Most laser printers are shipped with enough memo ry to support the largest
paper size that the model can handle. Some products, however, require a
RAM upgrade to provide the maximum possible width o n a larger paper size
or to support some image enhancement featu res. Check the manufacturer's
literature o r manuals for the specifics.
Beyond enhancing basic features, a RAM upgrade allows your printer to store
a larger number of downloadable fonts (which o nly yields a slight performance improvement), or even process a very complex document that may
not image properly with a standard RAM configuration. But printer RAM
upgrades-on models where they are available-may be more costly than the
RAM upgrades you buy for your Mac. If you have no trouble printing complex pages with your stock setup-and you don' t need extra RAM to support
special printer features- a RAM upgrade may not really be necessary.

QuickDraw GX
Fonts, graphics, and printing are overhau led with Apple's new QuickDraw
GX technology. The new imaging model wi ll be included with System 7.5,
and will likely be offered separately by Mac publishers to allow you to take
advantage of special features of their software.
The biggest change you are likely to see when you install QuickDraw GX will
be the absence of the fam iliar PrintMonitor wi ndow if you use background
printing on your jobs, and the addition of some neat new ways to organize
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the printing of your documents. You'll see the change the first time you print
a document. After printers are configured in the Chooser, you are offered a
popup menu of available printers in your standard Print dialog box (see fig.
10.26). You don't have to go through a wearisome process revisiting the
Chooser and adjusting Page Setups each time you select a different printer
to process documen ts.
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The following sections provide a few of Qui<.:kDraw GXs im provements to
print technology.

Color Printing
Q uickGraw GX ships with an updated version of Apple's ColorSync Control
Panel, which allows you to calibrate the color image from your monitor, your
scanner, and your color printers. This program allows you to get consistent
color results throughout the production chain. A basic set of color profiles for
Apple products is supplied. It will be up to non-Apple manufacturers to make
available profiles for their own products.

Desktop Printer Icons
When you first select the QuickDraw GX driver and your printer in the
Chooser, you have the option to Create a printer q ueue icon. This icon will
then appear on the right side of your Mac's desktop below the disk icons (see
fig. 10.27). You can create a separate icon for each printer on your network.
You can print a document simply by dragging its file icon to the the desktop
icon representing your printer.

Fig. 10.26
Once you've
selected all your
printers in the
Chooser, you can
switch them on the
fl y in your print
dialog box.
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Fig. 10.27
Your chosen
printers appear as
icons on your
Macs desktop.

Tracking the Printer Queue
To check the progress of your print job, double-cl ick the Printer icon , which
will o pen a window that reports the status of your job (see fig. 10.28). If a
prin ter's queue is backed up with waiting jobs, you can d rag the job to another prin ter's icon o r sim ply reorder the queue to have a job image faster.
Fig. 10.28
QuickDraw GX's
answer to
PrintMon itor, a
printer status
window.
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Type 1 Font Enabler
If you have a library of Type 1 PostScri pt fonts, you need to convert them for
use with QuickDraw GX. Adobe Systems has developed a handy utility, Type
1 Font Enabler, that generates a QuickDraw GX-ready copy of your Type 1
fo nts without changing the original fo nt, which you can still use for regu lar
printing applicatio ns with your original printer drivers (see fig. 10.29).
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Electronic Paper
QuickDraw GX will have its own counterpart to such portable d ocument
creation tools as Adobe's Acrobat or No Hands Commo n Grou nd. Its called a
Portable Digital Document, or POD for short. You'll be able to create a document that can be viewed and printed o n any Mac that has QuickDraw GX
installed, even if you don 't have the fo nts or the application that was used
when that document was created . This development is apt to be a boon for
se rvice bureaus, freeing them of the need to have huge libraries of obscure
fonts and software.

What It Means to You
QuickDraw GX will be demanding of memory (using an additional 1MB of
system RAM) and somewhat demanding of hard drive space. But it promises
to revolutionize th e way you print your jobs, and its fo nt and graphics hand li ng capabilities will make for smaller, more efficient software, o nce software
publishers get into the act.

Preserving the Environment
In add ition to offering energy saving fea tu res on some models, App le,
Hewlett-Packard, and other printer manufacturers offer free mailing tickets
so that you can send your spent toner ca rtridges off to their recycling plant.
Some local business supply sto res will even give you a few bucks if you tu rn
in your used toner cartridges (though not all models are su pported by these
refund programs).
If you really want to preserve natural resources, and maybe save some money

too, you can buy a recycled to ner cartridge. You can find recycling firms in
your local yellow pages, o r in the back pages of such magazines as MacUser
and Macworld. Some of these products are even available at regula r retail
channels.

Fig. 10.29
Adobe's Type 1
Font Enabler.
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Tip
You can stretch
the life of a toner
cartridge by turning down the
printer's density
setting for rough
proofs. just remember to turn it
back up again for
fin al copy.

Following are a few things to consider before you go the recycled cartridge
route:
• Recycled toner can vary in quality. When selecting a vendor for recycled cartridges, ask to see a printed sample to compare output against
what a new cartridge may provide.
• If you cannot get a printed sample, be sure your purchase is covered by
a money-back or exchange warranty if you are not satisfied with the
quality.
• If your laser printer is used only as a proofing device, output quality
may not matter. But service and cartridge longevity are important. If
you aren't satisfied with one supplier, don't hesitate to shop around.
• The toner recycling process isn't always perfect. If output quality is
paramount, and your finished documents will be used as master copy
by your printer, you may wish to stick with a brand n ew cartridge. That
will ensure your documents have consistent quality. Sending your used
toner cartridges in for recycling is still an excellent idea.
Your typical inkjet cartridge costs $20 or more and lasts for several hundred
copies. Sometimes it's possible to stretch the life of these cartridges by giving
them an ink transplant. You can buy kits from jetFill and other manufacturers for roughly half the cost of a new cartridge. Refilling involves using an
ink-filled syringe to inoculate the cartridge with a new ink supply. It's a process best done with care and many paper towels, so as to avoid dirtying a
home or office floor.
Some folks have developed a low-cost home brew technique with water
soluble ink and a syringe from a medical supply store. The same warnings
about the potential m ess the process creates apply here too. But if your inkjet
printer gets a heavy workaround, it might be worth trying a cartridge refill, at
least once or twice, to see whether you can get the hang of it.

Some No-Nonsense Service

Bureau Advice
There are times when the output of a high resolution laser printer isn't sufficient for your needs. Laser printer quality is very high. The newest generation
of 600 dpi (and greater) printers provide output quality that is every bit as
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good as that of o ne of those large, noisy traditional typesetting machines of
15 or 20 years ago. And for many uses, even when used as master copy for a
printing press, you will be quite satisfied with the quality.
If you need high quality colo r separations, o r req uire superior reproduction of
halfto nes and ill ustrations, there is no substitute for an imagesetter and a
visit to your local service bureau.
Caution
Where possible, do not use PICT files in your document. Although PICT is your native
Macintosh format for screen display, laser p rinters and imagesetters do not take well
to processing documents with PICT graphics. To save aggravation later on (and a
panic-stricken phone call from your service bureau), stick with EPS and TIFF.

lmagesetter Background
The modern-day imagesetter is a huge box that doesn't look dissimilar to
those typesetting m achines of old. Rather than paper output, the imagesetter
accepts rolls o r individ ual sheets of photographic paper or film. The material,
called media, moves through the imagesetter and is exposed by its image
generating mechanism (usually a laser beam source, just like your regular
laser printer).
The media is usually spooled into a large plastic cassette and the service bureau technician takes that cassette to a light-tight developing machine that is
closely related to the processing device used by doctors to develop x-rays.
The media is transported through baths of chemicals through an assembly of
racks and rollers. The paper first reaches a bath of a developing chemical that
displays the image on the paper. The image is then stabilized or fixed, just like
it's done with regular photos, so that the image is preserved. The media
moves through a bath of water to clean th e chemical residue off and then
usually through a drying mechanism.
It usually takes from two to three minutes for the fi rst pages to begin to appear at the other side of the developing machine.

lmagesetter Printer Drivers
Despite the d ifference in the cost and material used by the imagesetter, you
will find the process of actually printing to an imagesetter to be very much
like that involved in using a regular laser printer (described previously in this
chapter).
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Most imagesetters use the very same printer d ri vers that you use with your
regular laser printer. Settings such as Page Setu p and the various printer effects settings are quite th e same. The only differences you may encoun ter
result fro m having a diffe rent set of paper size o ptio ns. If you are setting up a
document for service bureau output, contact the service bureau about proper
prin ter and page selectio ns.

Preparing Your Job for lmagesetting
Tip
Si nce service
bureaus will
often output
work at night,
leave a home
telephone number on your job
req uest fo rm in
case a tech n ician needs to
telephone you
about a problem
with your job.

Many service bureaus have info rmation sheets or booklets with helpfu l hints
and advice on preparing your work for imagesetter output. I've distilled some
of those hints fo r this chapter. The importa nt thing to realize is that a service
burea u isn't responsible for your mistakes, so if you provide wo rk that isn't
pro perly organized, and is missing fonts o r graphics, o r has mistakes in it,
you have to pay for fixing those mistakes.
Fo llowing is my ad vice, based o n hard-wo n experience working fo r and sending jobs to service bureaus:
• As you are working o n your job, call your service bureau and ask them
about their requirements fo r setting up work fo r o utput.
• Be sure the service bureau has the same fonts fro m the sam e vendors as
you have. While most of these firms will have a good selection of fo n ts
from the Adobe library, fo nts from o ther vendors, such as Agfa,
Bitstream, Font Company, Image Club, Linotype, Monoty pe, and some
of the discount font suppliers, m ay not be as readily available. Many
vendors will offer fo nts with the same names, such as Futura. But if the
service bureau uses a differen t Futura than you do, you may be in fo r a
rude shock when your work is output. Li ne end ings may be different,
and the actual size of the type characters themselves may va ry, too.
• Befo re using TrueType fonts, ask your service bureau whether their
imagesetters can suppo rt this font fo rmat. Some output devices require
expensive hardware upgrades to support TrueType, and not all service
burea us are willing to m ake the plunge. PostScript fonts are still the
standard fo r high-end output devices.
• Most service burea us will have the latest versions of Aldus PageMaker o r
QuarkXPress at hand. If you are using a program that is no t as ubiquitous, such as Fram eMaker, Publish-It Easy, o r Ready,Set,Go, make sure
that the service bureau has the same programs you do. If you are using
an o lder version of your publishing soft ware, be sure to inform the
service bureau of that fact. Quite ofte n the newer version of such a
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program will alter the appearan ce of a document created in an older
version, or in some cases, not be able to read the document at all.
• If you have a printer, be sure to send the service bureau a clear, crisp

copy of your documents. The service bureau will be able to use that
copy to compare to their imagesetter output for glitches or other problems.
• If you have difficulty outputting that job to your laser printer, expect
it to be all the more difficult on an imagesetter, which has to process
much more information in order to image a page. Consider that a
single 1200 dpi page has 16 times as many dots per square inch as your
300 dpi page (1,440,000, as compared to 90,000). A service bureau will
typically tack on a huge hourly fee for work that takes a long time to
process. It is best to solve your printing problems before the job leaves
your home or office.
• Collect all of the files needed to output your job in a single folder. In
addition to the actual document, you will need to provide a copy of
linked or placed graphics, such as EPS and TIFF files. A missi ng graphic
file may result in poor quality, bitmapped output. Since the service
bureau is not responsible if you fail to send all the files needed to image
the document, you may risk a missed deadline or having to pay to run
the job again to get it right.
If you cannot fit all of the files on a single disk, consider other options,

such as compression or providing the work on several clearly labeled
floppy disks.
If your work contains large graphic files, such as color photographs, it

may be a good idea to buy a removable drive of some sort, such as a
Bernoulli, optical, or SyQuest. Before you make such a purchasing decision, contact your local service bureaus and ask what sort of devices
they use. The issue of compatibility may be more important than the
reliability of a particular removable format. Besides, all of these products are engineered to provide years of trouble-free service, so long as
you don't abuse the removable media.
•

If your job uses process or spot color, ask your service bureau and
printer about their requirements for such work. Such features as trapping are present in the popular desktop publishing software packages,
but complex work requires skilled hands to do right. A mistake may not
show up on a laser print, or even a composite imagesetter print. You
may find it more convenient to pay extra to have someone else take the
color-preparation chores off your hands.
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PostScript Files
Some service bureau s find it convenient t o h ave their cust om ers send their
work as a print-to-disk fi le. Both System 7 and the Level 2 LaserWrite r driver
offer the optio n of p rintin g to a file rather tha n to a printer, ma king the job
sim ple. Because the service bu reau doesn 't h ave to go through a page setup
process on each job, sending a PostScript file can som etimes save you some
cash , but it has som e drawbacks, outlined in the following list:
• Con sider a PostScript file to be etch ed in sto ne. Making even a simple
ch ange m ay require th e service bureau to pour through thousands of
ch aracters of PostScrip t code, if it can be done a t all-and they charge
you by th e h our.
• Ask your service bureau for the correct prin ter setup inform ation befo re
you p ri n t your PostScript file. If the job is setup for the wrong printer, it
will prin t incorrectly.
• Beca use your Mac's screen may not capture the fine de tails of c h aract er
kerning, and the look a nd feel of illustration s, be sure you review a
paper pri n t of your job for an y mistakes b efore making your printer file.
• PostScript files can be huge. Even wh a t seem s to be a relatively simple
docu ment m ay fill several megabytes of space. Review step seven in the
instructi ons on p repa ring work for the service bureau, about compression a nd removable d rive o ptions for st oring your work.

Filling In The Job Ticket
Tip
If you are using
LaserWriter 8, you
ca n reduce the size
of your PostScript
files but not including the fo nt
in formation . just
make sure that
your service
bureau has the
correct fon ts
available.

Most service b ureaus offer a jo b ticket o r info rmatio n form for you to fill out.
\Vhen prepa ring your work fo r o ut put, be sure that all the requested information is filled in accu rately. Even if the questions aren ' t asked, you ought to
provide the following information to keep problem s from h appening la ter
on.
• List the actual file nam e of the d ocument you want printed.
• List the n ames of the fonts used in that document. Also n ame the vendo r or ma nufacturer of the fo nt (such as Ad obe, Agfa, Bitstream, Font
Company Image Club, Linotype, or Mon otyp e). Man y font d evelopers
will have fonts with the sa me names in their p roduct line. But a Futura,
for exam p le, from o ne vendor, will look quite d ifferent from that of a
differe n t ven dor.
• List the names of all li nked or placed gra phics (EPS, TIFF, etc.) u sed in
your docume nt.

From Here...

• Identify the software you used to create your document and the version
number.
• List the kind of prints you wan t, paper or film.
• List the output resolution you want. 1200 dpi output and 2400 dpi
output are priced differently. You can save a few bucks and not suffer
much in terms of quality if you opt for lower resolution. But when
color separations, halftones, and shaded elements are required, order
the best quality output you can.
• State the finished size of the document, especially if it's other than your
standard letter-sized page.
• If the output is to be printed at other than the standard lOOo/o setting,
be sure that fact is clearly noted.

From Here ...
This chapter described how the Mac's printing features work, outlined some
of the n ew advances in printing technology, and described a few things you
might con sider when you are ready to buy a new printer.
• Chapter 8, "All about Fonts," gave you valuable information about
fonts and how to use them.
• For additional advice on setting up a printer on your network, read
Chapter 33, "Networking."
• Chapters 37 and 38 expand upon the steps you need to take to troubleshoot common problems with your Mac and explain how you can solve
them before they become serious.
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Chapter 11

Changing the llook of
Your Desktop
by Carman Minarik

The Macintosh operating system allows almost complete control over the
appearance and functionality of the desktop. Everything from the color and
pattern of the desktop background to the speed at which the mouse pointer
travels across the screen can be changed to suit your needs and preferences.
In this chapter, you learn how to do the following:
• Modify your desktop colors and patterns
• Alter the fonts, icons, and colors used in Finder windows
• Change the appearance of dates, times, and numbers
• Control the fu nctionality of the keyboa rd and mouse
• Create and use customized screen backgrounds, menus, window
controls, and other Finder elements

Control Panels Included with the
Macintosh Operating System
Control Panels are special applications that extend the functionality of the
Macintosh operating system. On Macintoshes running System 7.0 or later,
Control Panels are found in the Con trol Panels folder inside the System
folder.

Ill
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Caution

-

Control Panel files must load along with the other system files at startup time.
The Control Panel files must be located in the Control Panels folder inside the System
folder in order to be activated upon startup. If a Control Panel has been moved from
the Control Panels folder, access to the Control Panel will not b e available. To regain
access, move the Control Panel file into the Control Panels folder and restart the
Macintosh.

The Macintosh operating system provides several Control Panels that enable
you to customize your system. In System 7.5, if you open the Apple menu
and choose Control Panels, you'll be able to select a specific Control Panel
from a sub-menu. In earlier versions of System 7, Control Panels can be ac·
cessed by opening the Control Panels folder inside the System folder or by
selecting the Apple menu choice Control Panels. In earlier versions of
System 7, a window similar to the one shown in figure 11.1 opens.
Fig. 11.1
This window,
viewed b y icon,
sh ows the Control
Pa nels available
for use.
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As with any other application, you launch individual Control Panels
by double-clicking the desired Control Panel's icon.

Under operating systems prior to System 7.0, Control Panels are not stored as individual applications. Instead, they are stored as a special type of startup file called a
CDEV, short for Control Device. The CDEVs are stored in the System folder and
launch as additions to the System file at startup time.

The following sections of this chapter describe the Control Panels that are
supplied by Apple as part of the Macintosh operating system.
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General Controls
The General Controls Control Panel is used to change deskto p settings.
Double-click the General Contro ls icon, and a window similar to the one
shown in figure 11.2 appears.
Genornl Con trols

D"'•'"'"""""''""

~

OPI'"ol~t A"pl~~hons foidtr

~

l

j

Fig. 11 .2
Use the General
Con trols wi ndow
to change the
desktop display,
menu blinking,
and insertion
point blinking.
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Desktop
If the check box labeled "Show Desktop when in background" is activated,
the Macintosh desktop, including open f-inder w indows and disk icons, wi ll
be visible behind any open applicati on windows. If this box is not activated,
desktop items will not be visible when a software applica tio n is active.

Activate th e check box labeled "Show Launcher at system startup" to run an
applicatio n called La u ncher whenever the Macintosh is started . Launcher
represents an al ternative method to launch frequently used applications
and documen ts.
Insertion Point Blinking
Any time you are working with text in any Macintosh software, an inse rtion
po int is visible on-screen. This insertion point indicates where text will appear when you start typing. To increase its visibility, the insertio n point is
designed to blink on the screen.

You can contro l how fast the in sertion poin t wi ll blink in the General Controls d ialog box. Three options for Insertio n Point Blinking are available:
slow, med iu m, and fast. Click the rad io button fo r the ra te you want. The
sample insertion poi nt changes its blinking rate to refl ect the new setting.
The insertio n point in most software wi ll use the rate set in t his Control
Panel.

~

See "The fin der
and Its Contents," p. 72

~

See "New
features,"
p.S6

Ill
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Menu Blinking
~

See "Organizing
Your Hard
Disk," p. 112

Whenever you make a menu choice in any Macintosh software, the menu
option chosen blinks in confirmation of your selection. Options on the General Controls screen enable you to change the number of times the menu
blinks. Choose 1, 2, or 3 blinks by clicking the appropriate button . Choose
Off to disable menu blinking.
Other General Controls

Other options in the General Controls window allow you to protect the contents of your System and applications folder, require the Maci ntosh to inform
you if it was not shut down properly, and control the initial file locations
displayed in Open and Save dialog boxes.

Desktop Patterns
Apple provides several predefined desktop patterns from which to choose.
Open the Desktop Patterns Control Panel to select a new desktop pattern
from the predefined list. A window will open (see fig. 11.3).
Fig. 11.3
The Desktop
Patterns window
allows you to
select from a
variety of screen
backgrounds.

( Set Desktop Pottern )

Follow these steps to choose a new pattern:
1. Click the right/ left arrow of the Pattern Selection bar to browse forward

through the predefined patterns.
2. Click in the left side of the Pattern Selection bar to browse backwa rd
through the predefined patterns.
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3. When you have fou nd the pattern you want to use, click in th e Set
Desktop Pattern box to activate the displayed desktop pattern, o r
double-click in th e Pattern Area of th e dialog box.
The Macintosh wi ll retain the new pattern settings, as well as all other
Control Panel settings, from one sessio n to the next.

Color
The Color Control Panel allows you to change the accent colors fo r your
windows and the color used to highlight text. Double-click the Color icon,
and a window similar to the one shown in figure 11.4 appears.

:oe

**:#¥§ Color ·

1• Block & White • 1-t--

Highlight col or:

r----+ lii!liitilililMI

t- Pop-up lists

ID

Window co lor:

Hig hlight color sample

Standard

liJI.i')l
~

Fig. 11.4
In t he Colo r
window, you
can choose text
highlig ht and
window colors.

Select the desired text highlight and window accent colors from the pop-up
lists.
Choosing Other from the highligh t color list will o pen the color dialog box
containing either a color w heel o r color bars.
An example of the colo r dialog box is shown in figure 11.5.

Or iginal:

New:

Fig. 11.5
From the Co lor
Wheel, you can
select specific
shades from a
palette of over 16
million colo rs.
Color Settings

I More Choices

)

Intensity Level
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To select a desired color in the color di alog box, fo llow these steps:
1. Use the intensity level scroll bar beneath the Color Wheel to set the

overall brightness of the colors.
2 . Position th e mouse pointer over the area o n the color wheel that

displays the des ired color and click.
A sample of the newly selected color is displayed directly above the
o riginal color in the upper-left area of the Color Wheel window.

3. If you know the exact color setting numbers for the desired color, you
can enter them in the color setting boxes.

4. Click OK.

Note
The color dialog box provides two methods to set desired colors-the HLS (Hue,
Lightness, and Saturation) method and the RGB (Red, Green, and Blue) method.
The More Choices button at the bottom of the color dialog box allows you to choose
the method you want to use. The preceding section has described the HLS controls.
The dialog box displays red, green, and blue color bars if the RBG option is selected.
<Ill See "Icon and

List Views,"
p. 123

Views
Use the Views Control Panel to alter the way Finder info rmatio n is presented
in icon and list views. Double-click the Views icon to access a window, as
shown in figure 11.6.

Fig. 11 .6
The Views window
provides controls
for view fonts,
icon sizes, and
o ther aspects of
Finder informatio n display.
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The Views window provides control o ver several optio ns, all of which impact
th e appearance of information in Finder windows.
Fonts
You can choose any fo nt installed in your system for d isplay in Finder windows. Choose the desired font and po int size from the po p-u p lists at the to p
of the Views window. (Chapter 8, "All abo ut Fonts," provides detailed info rmation about different types of fo nts and their uses.)
Note
Though you can select any installed font and point size, choose a font and size for
which a bit-mapped screen font was installed. Bit-mapped fonts produce more
clearly defi ned on-screen characters, especially at smaller point sizes.

For more details on fonts and font ty pes, see Chapter 8, "All about Fo nts."
Icon Views
The Special menu cho ice Clean Up Window autom aticall y arranges the icons
in a window accord ing to a grid pattern. The Views control panel enables you
to choose either a straight or a staggered grid pattern.
Choose the desired grid pattern by clicking the associated button.
Activate the Always snap to grid check box if you want any icon moved into
a window to be arranged to the grid pattern autom ati cally.
List Views
File and folder icons in list views are normally presen ted as small pictures
without much detail. By choosing the radio buttons fo r mediu m or large
icons in the Views window, you ca n increase th e size and detail level for the
icons in list views. The large icon o ption will produce icons which look th e
same as those presented in a n ormal icon view.
The check boxes to the right of the Views window allow you to select the
columns of file and folder information which will appear in list views. Activa te the item s you want to display by clicking in the appropriate check boxes.
Activate the Show disk info in header check box if you want to display disk
size and available space information at th e top of list view windows.
Activate the Calculate folder sizes check box if you want the total size of all
files contained in a folder to be shown as the folder's size in a list view.

Tip
If man y of your
file and folder
names a re lo ng,
a staggered grid
allows closer placement of icons in a
window witho ut
overlapping t he
fi le o r fo lder
na mes.
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Note
If scro lling speed throug h a list window is slow, deactivate the Calculate folder sizes
check box. Calculating fo lder sizes requires more effort when displaying a list view,
particularly w hen the folders co ntain many files o r nested folders.

Labels
<Ill See "Using

Labels,"
p. 128

The Labels capability in System 7 allows you to assig n text labels and associated colors to files and folders in Finder windows. You can use these labels to
organize your desktop more efficiently or to add interest to your screens with
additional colo rs.
To assign labels to Finder items, follow these steps:
1. Select the item or items you want to label.

2. Open th e Label menu.
3. Select the desired label and associated color. The selected files or folders
change color, and the label text is sh own for the selected files and folders in list views.
4. To remove labels from selected files o r folders, open the Labels men u
and choose None.

You m ay want to change the label text or the colo rs associated with the labels. Using the Labels Control Panel, you can change the text and the colo rs
fo r each label on the Label menu.
Do uble-click the Labels icon in the Control Panels folder, and a screen similar
to the o ne shown in figure 11.7 appears.
Fig. 11.7
The Labels Con tro l
Panel a llows you
to change label
text and colo rs.
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• To change label text, drag across the text to be changed and type the
new text.
• To change label colo rs, double-click the color box you want to change.
The color dialog box opens. Use this screen as described previously in
this chapter.
• Changes made to a label's text and color automatically update any
items which have that label ass igned.
Note
In o perating system versions prior to System 7.0, the Labels menu and Labels Control
Panel do not exist. The equivalent function is found on the Color menu- you can
change colors for Finder items, but label text is not supported.

Date and Time
Use th e Date and Time Control Panel to alter the appearance of da te and time
information in Finder windows. Changes made in the Date and Time Control
Panel will impact many Macintosh softwa re packages, as welL
Do uble-click the Date and Time icon in the Control Panels folder to open the
window shown in figure 11.8.
~Cl=

. :

~ Current dote

Q)

I 6/2 8 / 94
(Dote Formots ...

e

Current time

I 8:45:0 1 PM
J

[ Ti me Formots ...

Time Zon e

2:34)

Th• tim. zon• h.u not bttn

Menubar Clock
@On Q Off

s~cifitd .

0

Fig. 11.8

Dote & Tim e

Ooylight Souings Time
[Set Tim e Zo ne ...

J

Clock Options ...

On this screen , you can change th e date and time settings for the Macintosh
system clock.

The Date and Time
window allows
you to change date
and time formats.
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Customized Date s
Click the Date Format button in the Date and Time window, and a screen like
the one shown in figure 11.9 opens.
Fig. 11 .9

~

Use the Date
Format screen
to modify th e
appearance of
dates in Finder
windows.
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At the top of the Date Format screen, you will see a pop-up list of predefin ed
date formats. This list contains predefined date formatting for several different countries. Choose one of the countries on th is list to automatically set
your date formatting for that country.

Custom date fo rmats can also be created. You see a sample of the selected
date for matting options at the bottom of the Date Format screen .
The samples reflect the current date format options in effect.
The rest of the Date Format screen is divided into two main sections-long
date formatting options and short date formatting options. The following list
describes these options:
• Long Date Formattillg is used when date information is d isplayed partly

in words. Follow these steps for long date formatting:
1. Choose the desired option for up to four items to be included in

your long date format from the corresponding pop-up lists. Each
list contains options for Weekday, Month, Day, Year, and None.
By choosing d iffe rent o ptions in different positions, you can create any type of date format you need.
2. You can type separator characters in the prefix boxes which corre-

spond to each pop-up list. Characters entered in the prefix boxes
will be displayed between the items selected in the drop-down
boxes. Using the formatting shown in figure 11.10, for example,

Control Panels Included Wi th the Macintosh Operating System

a comm a will be displayed between the Weekday and the Month,
and another comma will be displayed between the Day and the
Year.
3. Activate the Leading zero for day check box if you want to display
a leading zero for single-digit day numbers.

• Short Date Fonnatting is used when date informatio n is displayed entirely in numbers. To format short dates, follow these steps:
1. Select the desired short date formatting from the po p-up list.

2. Type the separator character you want in the separator box.
3. Activate the check boxes labeled "Leading zero for day" and
"Leading zero" for month if you want to display single-d igit days
or months with leading zeros.
4. Activate the Show century check box to display all 4 d igits of the
year.

Customized Times
Click the Time Formats button in the Date and Time window. The screen
illustrated in figure 11.10 appears.

Pop-up list of
predefined
time formats

Q)

Time Format:

L u.s.

Fig. 11.10
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I
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I

Use th is screen
to m odify time
fo rmats.

~

[I]
( Cancel )

~

OK

l)

Sample of selected time formats

To modify the time formatting in use, follow these steps:
1. The pop-up list of predefined time formats functio ns in the same manner as the list of date formats described previously.
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2 . Select the button for 12-hour or 24-hour time display. If you select
12-hour display, you may also choose whether to display noon and
midnight as 12:00 or 0:00.
3. Enter the before noon and after noon identifying text to be displayed as

part of the time format.
4. Enter the separator character to be displayed between elements of the
time format.
5. Activate the Use leading ze ros for hour check box if you want singledigit hours to be displayed with leading zeros.
Time Zone

Click the Set Time Zone button to open a list of cities from many countries
around the world. Choose a city in your area to set the current time zone.
Activate the Daylight Savings Time check box if daylight savings time is in
effect in your time zone.
Menubar Clock

Turn on the Menu bar Clock option to place the current time on lhe Menu
Bar in all applications.
When you click the Clock Options button, a screen like the one in figure
11.11 appears.
Fig. 11.11
Use this screen
to control the
function and
appearance of the
Menubar Clock.
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Use this screen to choose the font and size for the clock information, whether
the seconds will be visible, whether hourly chimes will sound, and so on.
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Note
The Menubar Clock options in System 7.5 are based on the shareware utility
SuperCiock! If you're using an o perating system prior to 7.5, SuperCiock! p rovides
the same fu nctionality.

Numbers
Use the Numbers Control Panel to m odify the appearance of n umbers in
Finder windows. Cha nges made in the Num bers window will also im pact
many Maci ntosh software applications.
Do uble-click th e Numbers icon in the Control Panels fo lder to access the
window shown in figure 11.12.
Po p-up list of
pre-defined number
fo rmats

$3

Number Forma t:

u.s.

.... I

I

Currtncy

Stp.Jr.J tors

DEl

Decimal:

Thouso nds:c=JEJ

Sample of selected
number formatting
options

Fig. 11 .12

IJ:CJ~~ ~ · = Numbers

sy mbol:

rS•mpl•
I

ll

J

® Before number
0 After number

$ 1,234.56

Use the Numbers
Control Panel to
custo mize t he
appearance of
numbers in Finder
windows.

I

To custom ize your num ber fo rmat, follow these steps:
1. The po p-up list of predefined number formats works in the same manner as the lists fo r date and time formats described in the preced ing
section.
2 . Choose the desired symbols for use as decim al po ints and commas fro m

the pop-up lists in the Separato rs sectio n of the Number window.
3. Type the character you wan t to use for the currency symbol in your
n umber format. Yo u can also indicate whether the currency symbol is
to be placed before or after the nu mber by selecting th e appropriate
rad io button .
Any changes made fo r n umber formatting optio ns will be reflected in the
sa mple box at the bo ttom of the Number window.

Tip
Use the Key Caps
Apple Menu Item
to see ava ilable
currency sym bols
from d ifferen t
cou ntries.

Ill
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Apple Menu Options
The Apple Menu Options Control Panel allows you to control the functionality of the Apple Menu. A window as shown in figure 11.13 opens.
Fig. 11.13
Use The Apple
Menu Options
window to set up
submenus o n the
Apple Menu.

:a ~

Apple Menu Options

0
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181 Remember recently
Documents:

used Items

[gjj]

Applications:

~

Seruers:

[!Q]

• If the submenu option is turned on, Apple Menu items such as Control

Panels and Chooser produce submenus when highlighted. This allows
you to choose a specific option without opening a new window or dialog box.
• The Apple Menu also displays recently used applications, documents,
and file servers. Use the Apple Menu Options controls to set the number of applications, documents, and servers to be displayed.

Shareware
Up to this point, this chapter presented desktop controls that are standard
parts of the Macintosh operating system. Because the Macintosh possesses an
open architecture in its operating system design, almost unlimited additional
desktop controls are possible. Many individuals and companies have taken
advantage of this open system architecture to create applications and Control
Panels which extend your control over the desktop.
This section provides information on some of the popular shareware programs available for desktop control. Shareware programs are available at low
or even no cost from many sources, including user groups and electronic
bulletin boards. (See Chapter 28, "Sh arewa re and Other Cool Stuff, fo r a
detailed discussion of shareware.)
11
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Greg's Buttons
Greg's Buttons is a Shareware Control Panel that allows you to change the
appearance of buttons, check boxes, and radio buttons in all of yo ur applications. The Control Panel also allows modification of the background color of
menus and dialog boxes, and enables you to change the system fo nt for your
Macintosh.
To install Greg's Buttons, drag the Control Panel fi le to the closed System
Folder icon and restart your Macintosh. Upon restart, you will immediately
notice the changes made by Greg's Butto ns. Figures 11.14 and 11.1 5 ill ustra te
the differences in dialog box, font, and button appearance created by this
Control Panel.
!?olorSmart 00 ~

DeskWrllor "DeskWrlte,....
Quality:

I

Copies:

I!MI

•I

Nonnar

Pages: ® All
0 rrom: O

( Cancel

(Preulew]

D Print Back to rront

[8) Print In Grayscale

Print Pogos: ® nrr 0 Odd Poges Only
Section Range: From: t
To: I
D Print llldden TcHt D Prinl Nent rrre

0 Euon Pages Only
0 Print Selection Only

DeakWrltar"'DeakWriter"

!?olorSmart • 0

Qu.Uiy:

I

Copt..:

1•-1

Normal

I

ro:O

•I

liJ Print Bod< to Front

Pages:

® All
O From: O

ro: O

!l!l Print In Groy<nle

Print Pagn:

®All

0

Odd Pages Only

0

Print Hidden Text

To: 1

0

0

Standard print
dialog box from
M icrosoft
Word 5. 1.

CEi}

Fig. 11.15
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Double-click the Greg's Buttons icon in the Control Panels folder to control
the programs modifications to your system.
General Prefere nces
When th e Greg's Buttons Control Panel is launched, the window shown in
figure 11.16 opens.

II
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Fig. 11 .16
This is the first
of four Greg's
Buttons control
screens.
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Activate or deactivate the appropriate check boxes to turn Greg's Buttons on
and off, to show or suppress the Greg's Buttons startup icon, and to show or
suppress the shareware message.
Other Greg's Buttons control screens are accessed by clicking the boxes to the
right of the Greg's Buttons window.
Button Preferences
Click the button preferences box to open the screen shown in figu re 11.17.
Fig. 11 .17
Use this screen to
con trol button
appearance.

To modify button formatting options, follow these steps:
1. Select from 3 check box styles, 3 radio button styles, and 2 push button

styles by clicking the desired options.
2 . Activate the Embossed Push Button Titles check box to create a more

3-D look for button text.
3 . The check box labeled System 7 Color Buttons allows you to activate or

deactivate the button controls in Greg's Buttons.
Color Preferences
Click the color preferences box to display the screen sh own in figure 11.18.

Shareware

~~==C~~~!!!!~
li Finder Window COlor
IiiMenu ear and a.. Btct.
Menullh and Ill• ru
Iii Alelllllld Dialogs( Exclude Appllca!lon>
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Fig. 11.18
Use this screen
to control menu,
window, alert, and
dialog background
color.

l

To change the color settings for your windows and dialog boxes,
follow these steps:
1. Use the check boxes to activa te or deactiva te the control options for
Finder wi ndow, menu, and dialog and alert boxes.
2. Click the color box to the right of each o ptio n to open the color dialog
box, as described earlier in this chapter. Select the color you want fo r
each option.
3. Alert and dialog box color settings may cause problems in some applica-

tions. Click the Excl ude Applications button to access and modify a
list of applications in which alert and dialog box colors will not be
changed.
System Font Preferences
The system font is used for m enu headings, menu text, alert box text, and
dialog box text th roughout the Macintosh system. (See Chapter 8, "All about
Fonts," for informatio n about fonts.)

Click the system fo nt preferences box in Greg's Butto ns to activa te a screen
like the one shown in figure 11.19.

reg's
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Fig. 11.19
Use this screen to
control system
font appearance.
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Follow these steps to change your system font:
1. Select from the six ava ilable system font choices.

2. The check box labeled Substitute System Font allows you to activate or
deactivate the system fo nt contro ls in Greg's Buttons.

Caution

-

All the options in Greg's Buttons require alteration of the System file resou rces to
work. These alterations may cause unpredictable problems with some software applications. Be sure to read all the docu mentation supplied with Greg's Buttons carefully
to avoid unnecessary problems.

Desktop Textures
The Desktop Textures application allows you to choose from a va riety of
interesting desktop background patterns. These patterns provide alternatives
to those available in the Desktop Patterns Control Panel described earlier.
Un like most of the other programs described in th is chapter, Desktop Textures is not a Control Panel. It is a standard application whose function it is
to place a com plex graphic image into the System file as the desktop pattern
resource. The advantage to th is approach is that the software need not launch
at system startup time, and th erefo re req uires no memory.
Installing a Texture

Double-click the Texture Installer icon to launch the application. A window
similar to the one shown in figure 11.20 appears.
Fig. 11.20
The Texture
Installer window
enables you to
view and install
textu res.

Texture name

J~~~~~~~~~§§~

View previous texture

View next texture
Texture sample

To choose and install a texture, follow these steps:
1 . Choose the File menu o ptio n Open to select a particular texture file
with wh ich to wo rk. A standard Open d ialog box appears. Desktop
Textu res com es with fou r textures files from which to choose.

Shareware
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2. Use the next and previous arrow buttons to view the various textures

contained in the texture file. Each textures file contains 10 to 25
different textures from which to choose.
3. Click the Install button to install the displayed texture.
4. Choose the File menu option Deinstall Texture to remove the textu re

currently in use from the desktop pattern, and return to using the
pattern defined in the General Controls Control Panel.
Note
Installing a Desktop Texture does not prevent you from later using the General Controls Control Panel to choose a desktop pattern. You may find that all color options
are removed from the General Controls window if a Desktop Texture file is in use,
however. If this is the case, launch Texture Installer and choose the File menu option
Deinstall Texture. Color options should now appear in the General Controls window.

Randomizing Textures
Desktop Textures comes with a second application called Texture Randomizer. This application will automatically install a different texture each time
the Macintosh is restarted, or at any other time you choose.

Double-click the Texture Randomizer icon to access the screen shown in
figure 11.21.
Fig. 11.21
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To set up random textures for installation, follow these steps:
1. Click the Add button to access texture fi les. A standard Open dialog box

appears.

Tip
Place the Texture
Random izer icon
in the Startup
Items folder inside
the System folde r
if you wan t a
random texture
to be installed
each time the
Macintosh
starts up.

2. All textures in the selected texture file will initially be included in the
random selection process. To remove a particular texture from consideration in the random selection process, select the texture and click the
Ignore button.
3. To reinstate a texture that has been ignored into consideration in the
random selection process, select the texture and click the Select button.
4. When you finish, click OK.

From this point onward, any time you launch the Texture Randomizer application, a random texture from the list will be installed as the desktop pattern.
To access the textures list screen, hold down the Command and Option keys
while launching Texture Randomizer.

Commercial Software
Several commercial software companies produce applications which can enhance your Macintosh desktop. The following sections look closely at the
most popular of these packages, After Dark from Berkeley Systems. Other
packages are briefly described, as well.

After Dark
.,. See "Screen
Savers," p. 728

After Dark is a screen saver utility. The purpose of a screen saver is to reduce
the chance that an image will be "burned into" your monitor screen if your
Macintosh is left running unattended for extended periods. Screen saver
utilities achieve this purpose by placing moving images on-screen, which
prevents a static image from burning in .
The newset versions of After Dark include an Installer that places the various
resources fo r the program in their correct locations
Once AfterDark has been loaded, double-click the After Dark icon in the
Control Panels folder or in System 7.5 select After Dark from the Control
Panel sub-menu to open the window shown in figure 11.22.

Commercial Software
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Fig. 11.22

Image file list

Image controls

Use the After Dark
Control Panel to
select the image
for use as a screen
saver.

To choose a screen saver image, follow these steps:
1. Choose the image you want from the list on the left side of the win-

dow. Any After Dark image file contained in the After Dark Files folder
appears in this list.
2. Varying controls may appear in the box to the right of the image list,

depending on the image file selected. Use the controls that appear to
modify the way in which the screen saver image behaves. In figure
11.22, for example, the number of fish that appear on the screen, their
speed of movement, and the volume of the screen saver sounds can all
be varied.
3. Click the Demo button to see a demonstration of the screen saver in
action.
Click the Off/On button at the top of the window to activate and deactivate
the screen saver.
Fig. 11.23
Use this screen to
confi gure After
Dark to your
preferences.

264

Chapter 1 1- Changing the Look of Your Desktop

Click the When button to access a second screen which provides additional
screen saver controls, as shown in figu re 11.23.
Options o n this configuratio n screen allow you to do the following:
• Enter the number of minutes your system m ust remain idle in order for
the screen saver to activate.
• Set the sleep corners. Moving the mouse pointer into the+ sleep corner
immediately activates the screen saver. Moving the mouse poin ter into
th e-sleep corner prevents the screen saver from activating, regardless of
the length of system inactivity. Drag the sleep corner indicators in to
the desi red positions to set the sleep corner locations.
• Activate or deactivate the check boxes for va rio us screen saver settings.
• Set a password. If you set a password, an activated screen saver image
will not clear until the correct password is entered. This is an easy
method of add ing security to your Macintosh system .

Caution

-

The p assword option in After Dark is not a completely effective security device. If a
user restarts the Macintosh w ith Extensions off or restarts from a floppy disk, the After
Dark system will not load and the password will not be in force.

.,.. See "Now

Utilities,"
p. 719

Now Utilities
Now Utilities is a collection of several applications, Contro l Pa nels, and Extensions that en hance the fun ctio nali ty of the Macintosh operating system .
Two of the components of Now Utilities are designed to modify the appearance of your desktop: Now Menus and WYSIWYG Menus.
Now Menus

The Now Menus Extensio n creates submenu functio nality in the Finder
similar to th at provided by system 7.5.
In addition to providing su bmenus, however, Now Menus also allows you to
change the o rder of appeara nce of your Apple Men u items.
Super Boomerang

This utili ty helps locate recently used files and folders by making a list, which
it places o n the Apple menu. Super Boomerang can find file and folder names
and search fi les by conten t even if the files have been compressed.

From Here...
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WYSIWYG Menus

WYSIWYG Menus is an Extension which causes individual fonts in all font
lists in all applications to display with their actual appearance. Instead of just
seeing a list of font names, you will see each font name displayed in the
actual typestyle for that font. The second major feature of the program is that
it groups fonts into families accessible via sub-menus. Th is feature helps
shorten font menus considerably and makes the process of selecting a font
much easier.

ClickChange
For the ultimate in desktop control, take a look at ClickChange from
DubiCiick Software. This package allows radical modification of nearly every
aspect of your operating environment, including the following:
•

.,. See "System
Enhancements/' p. 711

Cursor Appearance. You can change the appearance of the mouse pointer

and insertion point, and even design animated mouse poi nters.
•

Buttons. Provides controls similar to the button optio ns in Greg's

Buttons described earlier in this chapter.
•

Sounds. Allows you to assign different sounds for each of many defined

events. For example, one sound can be played at startup, another at
shut down, another on insertion of a floppy disk, and so on.
•

Scroll Bars. Provides control over the appearance and fun ctionality of

window scroll bars.
•

Colors. Enables you to chan ge the colo rs of almost all operating system
components, including menus, check boxes, window borders, and
so o n .

•

Windows. Provides several optio ns fo r wi ndow and dialog box
appearance.

From Here ...
This chapter explored some of the ways you can control the appearance of
your desktop. You have used the standard Apple Control Panels, and have
looked at some shareware and commercial programs which provide additio nal contro ls.

Ill
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• For additional information on shareware programs, see Chapter 28,
"Shareware and Other Cool Stuff."
• See Chapter 25, "Utilities," for more information on commercial software packages that can enhance your desktop work environment.
• Read the next chapter, "Creati ng and Modifying Icons," for information
on changing the icons your Macintosh displays.

Chapter 12

Creating an

M

g

Icons
by Carman Minarik

The Macintosh operating system uses icons to represent files, folders, tools,
controls, and many other items. The reasoning behind icon use is that people
recognize better than they remember. It makes sense, therefore, for you to
operate in an environment in which the icons being used are meaningful and
easily recognizable for you.
Several methods are available for your use as you modify the icons used in
your system. In this chapter, you learn the following:
• How to easily replace the icon for any disk, file or folder
• How to create and use your own icons with a drawing package
• The way your Macintosh keeps track of Finder icons
• How to use ResEdit to modify application icons

Copying and Pasting Icons
The fastest way to change the icon for a disk, file, or folder is to choose a picture you li ke, and insert this picture as the disk, file, or folder icon.

Choosing the Picture
The first step in replacing an item's icon is to choose the picture you want
to use and copy it to the clipboard. This picture can come from a number of
sources, including other disk, folder, or file icons, clip art, and original art
created by you.

Ill
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Ico ns f rom Othe r Disks, Folde rs, or Files
To select the icon of an existing disk, folder, or file for use as the icon of a
different item, follow these steps:
1. Select the disk, folder, or file whose icon you want to use.
2. From the File menu, choose Get Info. A window similar to the one
shown in figure 12.1 appears.
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Fig. 12.1
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3. Click the icon in the upper left area of the window. A box outline
appears around the icon.
4. From the Edit menu, choose Copy. The icon is now stored on the

Clipboard.

~

Clip Art
See "The fam iliar Features of
Macintosh,"
p. 44

Nea rly any type of clip art can be used as an icon for a disk, folder, or file.
Keep in mind, however, that the icon size is quite small. Each Macintosh icon
is 32 pixels square. A pixel is the smallest unit that can be drawn on the Macintosh, and is equivalent to one dot on-screen. Any art selected for use as an
icon will automatically be sized to 32 pixels square. If you choose a large,
complex drawing for use as an icon, it may be reduced to the point that its
detail is lost.
To select clip art for use as an icon, follow these steps:
1. Open the document that contains a drawing in a painting or drawing

program in which you are comfortable working.
2. Use the method provided in the painting or drawing package to select

the picture you want to use.

Copying and Pasting Icons

Note
In most d rawing programs, such as MacDraw or Canvas, you select an object
by pointing at it with the mouse and clicking. In most painting programs,
such as MacPaint or HyperCard, you find a Selection tool, often in the shape
of a dotted box, which you must use to d rag around the desired picture.

3. From the Edit menu, choose Copy. The selected picture is now stored
on the Clipboard.
Original Art
You can also create you r own o riginal artwork for use as a disk, folder, o r fil e
icon. Use any d rawing o r painting program you are comfortable with to create the artwork. Remember that the finis hed icon will be 32 pixels square. For
best results, try to keep th e art you are creating close to that size.
When the picture is completed, select it, and fro m the Edit menu choose
Copy. The picture is now stored on the Clipboard.

Inserting the Picture as an Icon
Whether the source of the icon you want to use is an existing disk, folder or
file icon, a picture from clip art, or an o riginal drawing you created, you must
copy the desired picture to the Clipboard. When that is done, follow these
steps to insert the picture as an icon:
1. Select the disk, folder, or file whose icon you wan t to change.

2. From the File menu, choose Get Info. A window like the one in figure
12.1 opens.
3. Click over the icon in the upper left area of the window. A box outline
appears around the icon .
4. From the Edit menu, choose Paste. The previously copied picture will

now be used as the icon for the selected disk, folder, or file.
To return a disk, folder, o r file icon to its original state at any time after its
icon has been altered, fo llow these steps:
1. Select the d isk, folder, or file to be chan ged.

2. From the Fi le m enu, choose Get Info.
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3. Click the icon in the upper left area of the window. A box outline
appears around the icon.
4. From the Edit menu, ch oose Clear. The customized icon is removed,

and the original item icon is restored .

Using ResEdit to Modify Icons
The process outlined to th is point provides a fast, easy way to change the
icons used to display disks, folders, and files. You may want to go beyond
that, however, to take even more control over icons. An application called
ResEdit, created by Apple, provides you with the tools to do more complex
work with icon s.
Using ResEdit, you can perfo rm operations such as the following:
• Directly modify most disk, folder, or file icons
• Change the icon s used in alert and dialog boxes
• Change the appearance of the icons assigned to new files as they are
created from each software application

ResEdit Basics
ResEdi t is an application program whose name stands for Resource Editor.
This na me very accurately describes the function of ResEdit-it is designed to
edit the resources used in your application s.
..,.. See "The Finder
and its Contents," p. 72

All Macintosh files are made up of two components, known as the data fork
and the resource fork. For any given file, both forks may contain information,
or one of the forks might be empty. Application files, fo r example, may contain no information in the data fork.
The resource fork of a file is used to store elements of computer code called
resources. A resource can be used for all types of purposes, such as creating a
men u heading or drawing an icon. Because resources are stored in the resource fork of the file, they are readily available whenever needed by the
application using the file.
ResEdit is designed to provide usable access to the resources in the resource
fo rk of a file. The resources themselves are actually strings of programming

Using ResEdit to Modify Icons
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code which have no meaning to most Macintosh users, but ResEdit provides
editors which allow you to work with many of the resources on terms with
which you are more comfortable.
ResEdit provides access to many types of resources, including fonts, menus,
dialogs, and icons. This section is devoted to using ResEdit to manipulate
icons.
Note
There is no requirement that a file contain anything, including icon information, in its
resource fork. Even application files can contain no resources, and instead store all
icon information in the data fork. If the file does not contain icon information in the
resource fork, ResEdit will not be able to provide access to the icons.

To launch ResEdit, double-click the application icon. Click once to access a
standard open file dialog box. From the File menu, choose Open to access a
standard Open dialog box. Select the file whose resources you want to edit,
and the screen shown in figure 12.2 opens. If the file you select has no resource fork, you are asked if you want to add one.
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This opening screen, called the Type Picker, shows all the types of resources
contained in the fil e. The example shown in figure 12.2 shows several types
of icon resources, such as ics4, ICN#, and ics#. Table 12.1 summarizes the
different types of icon resources a file may contain.

Fig. 12.2
The Type Picker
screen shows the
types of resources
contained in a file.
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Table 12.1

Icon Resource Types

Type

Description

ICON

32 by 32 icon used in dialog and alert b oxes

SICN

16 by 16 small icon lists used in menus

ICN#

32 by 32 Finder icon - black and white

cicn

Color icon

ic14

32 by 32 icon - 16 colors

ic18

32 by 32 icon - 256 colors

ics#

16 by 16 icon - sm all icon used in By Small Icon view in Finder

ics4

16 by 16 icon - 16 colors

ics8

16 by 16 icon - 256 colors

To work with a particular type of resource, point at the desired resource type
on the Type Picker screen and double-click. A screen like the one in figure
12.3 will appear. This screen is called a Reso urce Picker.

Fig. 12.3
The Resource
Picker screen
shows the specific
resources contained in a file.
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This screen shows all the specific resources of the type selected on the Type
Picker screen that are contained in the file.
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Note
Each resource in a file is identified with a resource type code, such as icn#, and a
specific resource number. Resources can also have names, but many do not. The
application using the resources will normally look for the code and the number when
a specific resource is needed.

To select a specific resource to edit, point at the desired resource on the Resource Picker screen and double-click. A Resource Editor for the selected resource type will appear. The Color leon Editor is shown in figure 12.4.

Selection rectangle

Fig. 12.4
The Resource
Editor provides
the tools to
modify the
selected resource.

Open rectangle-+-=~
Open round box -t----1~
Open Oval-t=::::::::::=======~~~===----

This screen provides the tools to change the selected resources. The following
sections will provide specific details on using the icon editors.

Caution
ResEdit makes direct changes to the resources of a file. Resources in many files are
used in complex interconnections, and changing a sing le resource may have wideranging, unpredictable results. Always make changes on a copy of t he file, not the
original.

Using the Icon Editors
The Icon Editor screen is divided into four regions: tools, expanded icon area,
icon types, and normal size icons.
Tools

The icon editor screen provides several tools you can use while modifying
icons. Table 12.2 provides a description of each tool's use.
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Table 12.2 Editor Tools
Tool

Use
Select irreg ular areas

Select rectangular shapes

Erase parts of picture

Draw pixel by pixel

Pick up a color from a drawing area

Fill an enclosed area with a color

Draw a straight line

Draw a filled box

Draw a transparent box

Draw a filled round-cornered box

Draw a transparent round-cornered box

Draw a filled oval

Draw a transparent oval

If you are familiar with a painting package such as MacPaint, these tools work
in much the same way. To use any of the tools, follow these steps:
1. Select the tool you want by clicking it.
2. Move the mouse pointer to the expanded icon area and position it

where you want to draw.
3. Hold down the mouse button and drag to create the shape you want.
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The three boxes beneath the tool palette are pop-up lists of colors and patterns. Use these lists to select the colors you wa nt to use.
Note
The Eraser tool does not actually erase anything; it applies the currently selected
background color to the pixels you drag it across.

Expande d Icon Area
You make the actual changes to the icon in the expanded icon area. This area
allows pixel by pixel modifications to the image.
Because the largest icon size is 64 by 64 pixels, that is the size of the expanded icon area.
Icon Types
The icon types area allows you to move quickly from one icon type to another in the same icon family. An icon family is a group of differen t types of
icons which share the same basic appearance characteristics.
The icon types area can save you the trouble of returning to the Type Picker
screen between each edit of related icons. Click the icon type you wa nt to
edit, and it will be loaded into the expanded icon area.
Norm al Size Ico ns
This area of the icon editor shows the icons in their normal size, as they will
appea r in use.
The left column of icons in this area shows how the icon will loo k when the
file is not selected . The right column shows how the icon will look when it is
selected. Icons are shown for open and off-line files, as well as the normal
icon.
Changes made in the expanded icon area are reflected here.
Menus
Several of ResEdit's menu options are useful when ed iting an icon. The Transform men u, fo r example, provides the following options:
• Flip Horizontal
• Flip Vertica l
• Ro tate
• Nudge (In any direction)

Tip
You can paste
any image from
any pain ting or
drawi ng program into the
expanded icon
area.
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Tip
If you make
changes to several
icons in an icon
family and then
change your mind,
use the Resource
menu o ption
Revert Icon Family. All changes to
icons in the current ico n family
will be reversed.

~

See "Organizing Your Hard
Disk," p. 112

Each of these options will operate on any selected area of the drawing.
The Icon menu provides options for icon background colo r, and the Color
menu allows you to select the color palette you want to work with.

Modifying Finder Icons
All icons are modified in much the same way. You may need to address some
additional issues when modifying Finder icons, however.
The Finder keeps track of files and their associated icons in an invisible file
called the Desktop File. To avoid needless rechecking of this file each time a
Finder window is opened, the Macintosh is designed to reuse the Desktop File
information whenever possible. This means that once the Finder records icon
info rmation for a particular application and its documents in the Desktop
File, it will simply reuse that information for all future instances of that application and its documents.
This system is reasonably efficient and works quite well most of the time. It
creates a problem when you modify your Finder icons, however, because you
may not see any changes in the Finder windows after you complete your
changes.
To ensure that the Finder is aware of the icon changes you have m ade using
ResEdit, you must rebuild your Desktop File. To rebuild the Desktop File,
follow these steps:
1. Close all open applications.
2. From the Special menu, choose Restart.
3. Hold both the

~

and Option keys while the Macintosh restarts.

4. A dialog box appears asking if you want to rebuild the Desktop File.
Click OK.
5 . The Macintosh will now rebuild the Desktop File and update any icons

for which you have made changes.

Caution
Rebuilding the Desktop File will cause any comments entered into the Get Info
window of any of your files to be deleted.

From Here...

From Here ...
ln this chapter, you learned how to copy and paste icon info rmation, and
how to use ResEdit to modify existing icons.
• See Chapter 5, "Understanding the Desktop and Finder," fo r mo re info rmation o n copying and pasting.
• Chapter 11, "Changing the Look of Your Desktop," covers o ther
changes you ca n make to your desktop appearance.
• Chapter 22, "Drawing and Painting," provides info rmatio n o n drawing
and painting applications.
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Music and Sound
by Steve Birchall

Whether you're just beginning to explore music and sound on the
Macintosh, or are ready to start up a MIDI system, or a direct-to-disk digital
aud io recording studio, you shou ld find usefu l information in one or more of
these sectio ns. In this chapter, you lea rn about the following:
• Sound on the Macintosh
• Mysteries of MIDI
• Digital Audio and MIDI Hardware

Sound on the Macintosh
From the beginning, the hardware and softwa re architecture of the

Macintosh has included sound as a basic part of the computer. Its intended
uses are mostly for System beeps, game sounds, and an elementary but effective form of speech synthesis called Macl11Talk. In fact, when Steve jobs first
demonstrated the early 128K Macintosh in public, he carried it o n stage and
plugged it in, and it not o nly displayed hello on-screen, but also spoke it. In
1984, that simple example captured people's attention powerfully and dramatically. Except for some entertainment software, speech synthesis has been
ignored until recently, with the advent of the AV versions of the Quadras and
PowerMacs. To do it even acceptably well requires massive amounts of computational power.
The synthesizer chip in the early Macs was monophonic, but Apple began
using a stereo chip in the Mac II series. You can make m usic with the built-in
synthesizer chip, but you can't do much else with it. For System beeps and
game sounds, however, the chip serves the purpose. Conceptually, it contains
an oscillator with selectable wave forms, plus a spectrum-shaping filter and
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an envelope generator (for attack and decay characteristics). With it, software
developers can create distinctive sounds to alert users to various problems or
simply reinforce the fact that you have invoked a command. This audio feedback remains one of the Mac's most subtle but powerful features.
Game developers, on the other hand, find the synthesizer chip limiting.
Unique and attention-getting sounds can mean the difference between a
successful ga me or a failure in the market. With the competitio n from the
latest 16-bit video game hardware, computer games need striking sound effects. One of the solutions is to use a library of sampled sounds. The concept
is similar to the way wave table synthesizers use sampled sounds. Press a key,
and the sampled sound plays back for you (but without any of the pitch
changing and other alterations).
You can create your sampled sounds in any way. Record natural sounds.
Develop new sounds on a large synthesizer. Alter and manipulate them
electronically in various ways, and even play them backwards. When you're
finis~ed, simply digitize th em and store them as Mac sound files.

Basic Digitizer: The MacRecorder
The most widely accepted tool for this kind of digitizing has been the
Farallon MncRecorrler (now sold by Macromedia). You can think of it as a lowend, inexpensive digital recorder. Its sound quality seems more like a table
rad io than a high fidelity system, but the storage space requirements are reasonable compared to full CD quality sound (COs contain over 600MB of
data). The hardware is contained in a small box that connects to one of the
serial ports o n your Mac. It accepts line level inputs from mixers, pre-amps,
and syn thesizers, and also has a microphone input. The digitizer circuit converts the ana log signals into digital data and sends them into your Mac. It
can record about 10 seconds for each data file. The software allows you to
start and stop the recording, edit the sampled sound, adjust levels, and set
the sampling rate.
Because the digitizer works at 8 bits, it has a signal-to-noise ratio of about 54
dB. Also, its maximum sampling rate of 24kHz means that it can record frequencies only up to about 12kHz. The trick in using devices such as the
MacRecorder is to select a sound that has a narrow dynamic range and record
it at the highest level possible without distortion. On playback, it will rise
above the background noise and sound quite acceptable, either on the internal speaker, or on small external speakers. If you record at too low a level, it
will sound noisy on playback. just try again at a higher level. Also, select
sounds that don't depend on high frequencies for their essential character,
since MacRecorder won't digitize any frequencies above 12 kHz.

Sound on the Macintosh

Newer Macs with Mikes
In the Mac llsi and most succeeding m odels, including the Powerl3ooks,
Apple began including a microphone and System software for digitizing
sounds. The more powerful 68030 and 68040 processor chips in these models
eliminated the need for an external digitizer. Some business-oriented applications (word processors, spreadsheets, e-mail, and so on) allow you to attach
audio notes to your documents. For example, your boss could click a spreadsheet cell in your expense report and hear a verbal explanation as to why you
are claiming a certain amount. Or you could attach a note to a word processing document to remind yourself to rewrite that section. On a Power13ook,
the built-in mike enables you to record random thoughts while you're working on something else. It becomes a dictation machine (with a ten second
limit).
QuickTime movies also have audio tracks, so don't overlook the possibilities
of using sound in them. You can attach them to documents in much the
same way as audio notes, providing the application accepts them. Particularly
when your QuickTime movie is a Mac-generated animated clip, you wan t to
use sound effects and voice-over narration to get your point across. Many
collections of clip sounds, the audio equivalent of clip art, are available for this
purpose, both commercially and as shareware.

Customizing Your Mac with Sounds
The standard System from Apple provides a choice of a handfu l of standard
Alert Sounds-the familiar Boing, Clink-clank, Quack, and other sounds
available on the Sound Control Panel. They can become boring after awhile
but, fortunately, you can change them and also add new sounds.

Changing the Alert Sound
To change the Alert sound, follow these steps:
1. Open the Apple menu and choose Control Panels, and from the sub-

menu choose Sound.
2. Click the sounds in the Sound list box. You will hear the sound th rough
the Mac's speaker.
3. When you have selected the sound you want to use as the Alert sound,
click it before closing the Sound control panel.

281

282

Chapter 1 3-Music and Sound
Adding Sounds

To access the sound recording capability, first open the Apple menu and
select Control Panels; then select Sound from the sub-menu. You see the
Sound control panel open (see fig. 13.1).
Fig. 13.1

So und

T he Sound control
panel.

Droplet
Indigo

'

:!!

;

Simple Deep

Sosumi
Wild Eep

nterl Uolume

~

"

( Rernoue )

If your Macintosh ca n record new sounds, click the Sound In selection from
the pop-up men u. If your Macintosh is eq uipped with recording equipment,
you see sou nd sources displayed in the window. Choose one by clicking its
icon.
Note that the Options button allows selection of a sou nd source. Other sound
recording equipment may provide options that you ca n set (see the equipment manual).
The Sound Out selection on the drop-down list allows the user to select a
playback device for sounds. The user may choose between mono and stereo,
and select either 8-bit or 16-bit playback. The Rate drop-down list allows
selection of playback frequency rate.
The volumes selection on the drop-down list allows playback levels to be set.
Mute check boxes allow muting of playback devices without disturbing preset
levels.
To add sounds to the Alert Sounds list box, follow these steps:
1. Click the Add button.

2. Place the microphone close to the source of the sound.
Note

·

.

·

If you are using a sound source other than the built-in microphone, step 2
may not apply.

Sound on the Macintosh
3. Click the Record button.
You see the seconds timer "thermometer" begin to fill as the sound
length indicator counts upward. This indicates that sound is being recorded. At the bottom of the timer, a number of seconds indicates the
amount of time you have for the sound.
4. Click the Stop button.

To hear the sound and verify whether it was recorded correctly, click
the Play button. If the sound is not to your liking, you can record another by repeating steps 3 and 4.
5. Click the Save button.

You are prompted to name the sound.
6. Type a name, and then click the Save button.
The sound is added to the Alert Sounds list box. You can select it by
clicking it.
As you may have noticed, the buttons of the dialog act like those on a typical
tape recorder. You may already understand that clicking the Pause button
stops the recording temporarily. Click the Record or Pause button to proceed
with the recording.
Click the Stop button to stop the recording. Unlike the Pause button, however, when you next click the Record button, the sound is lost and a new one
recorded.
Removing Sounds
Removing a sound from the Alert Sounds list box is quite simple. Follow
these steps:
1. Open the Sounds control panel.
2 . Click the sound to delete.

3. Click the Remove button.
A dialog appears, asking you to confirm the deletion.
4. Click the OK button or press Return.
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Sound Shareware

Apple's Sound control panel is usefu l, yet limited. To add m ore interesting
sounds to your system try some of the shareware programs, such as the
following:
• SoundStudio Lite allows recording and playback of sounds in many
formats. Features include Drag and Drop playback and the ability to
store a sound as a suitcase inside a HyperCard stack. The shareware
registration fee is $10.
• SoundMaster enables the user to assign sounds to events, key strokes,
and menu choices. Both playback frequency and sound level may be
preset. SoundMaster may be registered for $15.
Kaboom!

An intriguing audio application is Kaboom! by Nova Development. It allows
you to add sound effects to every Finder command and change your System
beeps. It comes with a large li brary of digitized sound effects (see fig. 13.2),
and you can record your own. For example, it will play th e sound of trash
cans rattling, flies buzzing, o r a toi let flushing every time you empty the
Trash.
Fig. 13.2
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Its sound recording and editing capabilities are sim ilar to those on the old
standby, MacRecorder. It also saves sound files in nearly every currently used
format. That allows you to add recorded sounds to multimedia presentations,
QuickTime movies, and custom applications.

Sound on the Macintosh
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Table 9 .1 Typical Mac Sound File Formats
Format

Description

FSSD

A standard sound file format recognized by most Mac sound
editing applications.

System 7

The sound equivalent of fonts, these 8-bit samples are used
for System beeps and similar functions.

AIFF

Audio Interchange File Format, another format recognized by
most sound editors.

Movie

The sound track portion of a Quicklime movie can store
digitized sounds.

The AV Macs
The Quadra AV Macs opened a new door for using both audio and video on
the Mac. With an AT&T 3210 Digital Signal Processing (DSP) chip, som e
modifications in the hardware, and appropriate System software, these Macs
essentially became hard disk-based digital recorders with performance equal
to COs (16-bit quantization, 44.1 kHz sampling rate).
Can you make your own COs on the Mac? Well-yes and no. First of all, the
typical optical disk drives do not use the CD format. Most of them use Write
Once Read Many (WORM) technology, and a data format o ptimized for storing and retrieving database, word processor, and spreadsheet files quickly. A
CD drive must read the data at exactly the right rate to re-create the sound.
That's why CD-ROM drives have no to riously slow data access rates. In additio n, the file fo rmat is optimized fo r the continuous stream of data that is in
a digital audio file. Recently, some optical disc drives that record in the CD
format have been introduced, but they are relatively expensive.
Storing CO-quality digital audio on a hard disk requires a high-capacity drive.
If you want to edit or back up digital audio, you need more drives. You also
need a Fast and Wide SCSI-2 interface to handle the vast amoun ts of data. To
record 60 minutes of stereo, for example, you need a one gigabyte drive.
Suddenly that monster 500MB internal d rive on your new Mac becom es
rather puny. At least it will store you r System Folder and a few applications.
Editing means you must have someplace to store the results, namely another
high capacity hard disk. If you have a great deal of materia l to edit, you will
need more high capacity hard disks to make it instantly ava ilable.

Ill
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The high-end disk-based editing systems in recording studios generally have a
bank of high-capacity, high-speed disk drives connected to them. But if you
are working with relatively short projects (such as radio spots and jingles,
individual songs, and audio for short slide shows, training tapes, or store
demos), you can work on a 250 o r 500MB drive comfortably.
Other capabilities of the AV Macs include integration of phone, answering
machine, voice mail, and fax so that you can use all of these capabilities
without leaving your Mac. Speech recognition (PiainTalk) joins speech synthes is on the AV machines. With PlainTalk, you can implement voice control
by means of third-party softwa re. Also, j abra has developed a PlainTalk-based
application that will transcribe your verbal thoughts into word processor text.
Don't get too excited. Right now, speech recognition works about as well as
the ea rly OCR software, so you r spelling checker wil l get a healthy workout.
For circumstances in which o nly short segments with a lim ited vocabulary
are needed, however, current PlainTalk applications offer a solution .

Sound Assistance for the Handicapped
In addition to the audio feedback portio n of the Mac Operating System, the
game sounds, and all the musical capabilities, the Mac's sound can be greatly
helpful to people with various types of physical disabilities. Clearly, voice
control has applications for those who are not able to operate the keyboard.
Speech synthesis can help those with impaired vision by reading aloud text
that appears on-screen.
Voyager has published many books in Mac form for people who want to read
them on-screen (such as during a plane flight), or ana lyze the text with word
processing tools. With speech synthesis, the Mac can read them aloud. A
library of such books is available from Voyager.
Speech syn thesis also increases the effectiveness of educational software,
especially for pre-schoolers. For speech impaired people, voice synthesis can
help with the process of communicating with other people. Stephen Hawking, the astronomer and theoretical physicist, uses such a device to overcome
his speech impairment. On the AV Macs, speech recognition helps ma ny
people who are unable to type at the keyboa rd to enter data.
What's appropriate varies with the individual you are helping. Remember
that these sound assistance capabilities are an integral part of every Mac ever
made. With some imagination and a little custom programming, you can
implement them. Developments in this field often find their way back to
the main portion of the market because non-handicapped people find them
useful, too.

Mysteries of MIDI
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Mysteries of MIDI
As computer-controlled synthesizers began to gain popularity, the need to
standardize the methods of controlling them became evident. Each ma nufactu rer had its own system, non e of them co mpatible with any others. No
brand of synthesizer could exchange signals with any other brand. The lack
of an industry-wide standard was slowing the growth of the industry and
creating nightmares fo r both manufacturers and musicians. That was in the
heyday of the Apple 11- befo re the Mac existed.
According to legend, three engineers met during the june, 1981 NAM M (National Associa tion of Musical Merchants) Show and tried to find commo n
ground. Dave Smith of Sequential Circuits, I. Kakehashi of Roland, and Tom
Oberh eim of Oberheim Electronics develo ped the basic concepts. After the
meeti ng, Smith actually wrote out the framework fo r the standard and presented it at the AES (Audio Engi neering Society) Conventio n in November. At
the j anuary, 1982 NAMM Show, the ball was rolling. Seeing the convenience
of a cross-brand interface, many o ther manufacturers joined in. They extended and modified the system, seeking to accommodate the needs of all
manufacturers without making it overly com plex. At the june, 1982 NAMM
Show, the manufacturers m et and approved the standard, giving it the name
M11sica/ Instrument Digital Interface (MIDI). During the following NAMM Show
in january, 1983, several companies demo nstrated MIDI-equipped syn thesizers, and the rest is history. In 1984, the industry established an organiza tion
called the MIDI Manufacturers Association to oversee the standard and approve changes.
Over the years, the MIDI standard has been improved and tightened in va rious ways- and it has becom e the o nly standard in the industry. Nothing else
has been proposed to compete with it. Nonetheless, MIDI is no t perfect, and
better systems will replace it in the future (a MIDI-2 version is still under
discussio n).

How MIDI Works
In the simplest, most basic terms, MIDI represents a musical perfor mance
with a sequence of numbers (computer data). MIDI records data about the
setting of nearly every button, knob, foot pedal, and con trol wheel on any
synthesizer. MIDI does not carry digital aud io data, but deals with the control
data needed to re-create that sound. A digital recorder, on the other hand,
samples the actual sound, stores the data, and reproduces the original sound.
The distinctio n is important.

Ill
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With MIDC you can replay a fresh perfo rmance each time, rather than a recorded representatio n of it. That means you can alter that perfo rmance in
many significant ways on every playback. You can request faster or slower
tempos, transpositio n to other keys, o r changes in the instru mentatio n. You
can think of MIDI as an electronic versio n of a player piano. It uses the ones
and zeros of computer language instead of the punched holes in a piano roll
to represent information about which notes to play, when to play them, and
how long to play them. MIDI, like the reproducing piano, goes further and
stores information about expressio n (tempo variations and dynamic changes,
for example) to provide an accurate re-creation of a performance.
Another way to look at MIDI is as a digital extension of the old principle of
voltage control in analog synthesizers. To play a series of notes (change the
frequency of an oscillator), MIDI sends a digital signal that tunes the oscillator to frequency num ber 86, 187, and 255. To reduce the vo lume, it sends a
signal that changes the output amplifier from volume level 139 to volume
level 64. Just repeat this process for every control on your synthesizer, and
you will have a flexible, expandable system. Since MIDI is an 8-bit system, it
has 256 steps available for each control (numbered, in computer fashio n,
from 0 to 255). If you keep sending out the signals often enough, the system
will be able to keep up with the flow of the music. The original MIDI specifications called fo r four MIDI clock pulses per quarter note. Man y of the highend sequencer applications now offer much greater resolution.

MIDI Hardware
To send the sign als, MIDI uses serial communications protocols. The wiring
used in MIDI systems con sists of commo n off-the-shelf (inexpensive) parts.
The connector is a five-pin DIN con nector. They're widely used in Euro pe for
hi-fi system connections. In the US, we use them fo r various special purpose
equipment, such as MIDI, because the connectors prevent us from connecting MIDI o utputs to analog audio inputs with RCA connectors, causing
equipment damage. In a typical MIDI system , with audio, computer, power,
and MIDI cables running all over the place, making this distinction about
sign al types by means of connector types simplifies things. At present, MIDI
uses only pins 4 and 5 for signal, and pin 2 for ground. The o ther two pins
are ava ilable for expanding the MIDI format in the future.
The MIDI cable is ordinary, twisted-pair shielded cable, com mo nly ava ilable
and relatively inex pensive. In fact, LocalTalk cable for your Mac is also
twisted-pair shielded cable. A MIDI cable always has a male DIN connector o n
each end. The female connecto rs reside o n the equipment. The shielding
(wire mesh wrapped around the twisted pair) reduces the possibility of picking up extraneo us signals, o r Radi o Frequency Interference (RFl ).

Mysteries of MIDI
To some degree, every wire acts as a radio anten na and can pick up interference from nearby radio transmitters (usually CBs, taxis, police cars). Your
cables also can pick up hum from light d immers, power transformers, and
similar sources. Look for MIDI cables with "industrial strength" construction
and strain relief o n the connectors.
Don't hesitate to replace faulty cables. Always handle them with care, especially during set-up and d ismantling. Yanking the plugs out pulls the shielding loose fro m the ground pin on the connector, leaving the cable wide open
to RFI. Al so, winding cables tigh tly into a neat package and tucking the ends
in can stress the shielding not only in the middle of the cable, but also at the
connectors.

MIDI-to-Mac Interface
Every Macintosh needs a MIDI adapter to connect it to a synthesizer. This
device connects to o ne of your serial ports (Printer or Modem ) and provides
the electrical interface between the computer and the MIDI system. It has
three connectors, labeled ln, Out, and Thru. A MIDI interface box serves the
same functio n as a LocalTalk adapter but operates at a different voltage.
Simple, basic MIDI adapters usually cost under $100, and you can get them
from Apple and many other vendors. A slightly more elaborate version, called
a MIDI Tllru Box, has several Thru ports.
If you have a large and com plex MIDI system, you might wa nt to consider an
in telligent MIDI interface. The difference is that it contains its own microprocessor. A smart MIDI interface can genera te its own clock signals and keep the
entire system synchronized more effectively than a basic MIDI adapter can.
In addition, microprocessor-equipped MIDI interfaces usually offer SMPTE
(Society of Motion Picture and Televisio n Engineers) Time Cod e, the
industry-standard format for synchro nizing multiple audio, video, and film
devices. Apple does not make an intelligent MIDI interface, but such interfaces are ava ilable from Opcode, Mark of the Unicorn, and other companies.

MIDI Connections
Connecting your Mac to a single MIDI instrument is simple. Plug the MIDI
interface into the Modem or Printer port. Take a MIDI cable, plug one end
into the Out connector on the interface and the other end into the In connector on your instrument. That permi ts MIDI data to travel from the Mac to
the instrument. So far, so good . If you need to send data back to the Mac, you
need to connect the Out port o n the synthesizer to the In port on the interface. Som e MIDI instruments don't have an Out port. The reason for sending
data back to the Mac is to record what you've played on your instrument
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with sequencer software. That's the quickest way to enter musical information into your computer.
If you have more than two MIDI devices (the Mac with its adapter counts as

one of them), you have more choices to m ake. In most cases, you will want a
daisy chain connection, using the Thru ports, instead of the Out ports. Because the MIDI Out port only sends output data from that unit's microprocessor, you won't be able to control the o ther synthesizers in the chain fro m the
first one (the Mac). The Thru port copies the control signals the unit is receiving from the Mac, adds the output data from that instrument, and passes
them on so the next unit can use them. That's generally what you want to be
able to do.
You can daisy chain as many instruments as you want, subject to some practical limitations. Some instruments route the signal through the m icroprocessor before copying it and passing it o n to the Thru port. Th is delays the signal
slightly. The more times th is happens, the longer the delay. After passing
through about four or five such Thru ports, the signal is so late arriving at the
next synthesizer that you can hear the delay. It sounds like everyone's playing off the beat, and it's quite objectio nable. Some instruments have a nondelaying Thru port, enabling you to build lo ng daisy chains. Check the
owner's manual to find o ut.
Still another configuratio n is the star netwo rk, which requires a smart interface, or Thnt Box. The Thru Box provides many Thru ports and sends identical
copies of the signal, all synchronized in tim e, to each of its Thru po rts to
ensure that all instruments are playing at exactly the same time.

MIDI Data Structure
To understand how to use your MIDI chain, you need to know some things
about the data packages being sent around the network and their structure.
MIDI is an 8-bit system, which means that it can express 28 o r 256 values for
each aspect of the music it is describ ing. It transmits those numbers seriall y
(one at a time, in rapid succession).
MIDI uses two types of bytes: Status Bytes and Data Bytes. Every MIDI message begins with the Status Byte and is followed by one or two data bytes
(depending o n what is needed). The Status Byte tells the receiving unit what
control the following data will affect. It could be a Note On message, o r the
setting of a foot pedal, o r a change in a patch . The microprocessor in the
synthesizer sorts it all o ut and sends each signal to the pro per device. Because
it all takes place at a rapid rate, everything fits together and the synthesizer
plays m usic.

Mysteries of MIDI

MIDI Channels versus Sequencer Tracks
If you have more than one MIDI instrument, you need a way to send messages to specific devices. For example, certain messages migh t go to your
main synthesizer to play melody and harmony. Others might go to a drum
machine. Still others might go to another synthesizer to play the accompan iment and bass line.
How do you make sure that the right data gets to the right unit at the right
time? MIDI Channels are the answer. MIDI divides data into two types: System Messages (for every device) and Channel Messages (for a device tuned to
that channel). You can tune each device to receive a differen t channel, and
each one in the chain will respond only to data being sent on that channel.
MIDI provides 16 channels, and certain bits carry the channel information.
To route the data from each track on your sequencer to the rig ht place, set
each track fo r the MIDI channel of the instrument that should receive it.
Polypho n ic synthesizers can receive data from several sequencer tracks.
Of course, you must set each instrument to receive its particular channel(s) .
MIDI Channel Reception Modes confuse many people, and can cause inexplicable problem s when configuring a system for a particular use if you forget
th is detail. You have a choice of four modes, as described in the following
table.

Mode

Channel
Reception

Synthesizer
Operation

Mode 1

Omni On

Polyphonic

Mode 2

Omni On

Monophonic

Mode 3

Omni Off

Polyphonic

Mode4

Omni Off

Monophonic

Omni On means that the device responds to messages o n all channels. In the
Omni Off modes, it responds only to its channel. Both are usefu l.
Mode 1 (O mni on, polypho ni c) works well in most situatio ns and usuall y is
the default setting when you turn on the unit. Because it plays messages sent
o n any channel, you don' t have to worry about what channel to use. In the
polypho nic setting, it plays chords and d ifferent patches simultaneously,
w hich is the typical way of playi ng on a synthesizer. If you have a MIDI instrument that refuses to play, set it to Mode 1 and see whether it responds.
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Mode 2 restricts the synthesizer to playing o ne note at a time, on any channel. You probably won't use Mode 2 except o n rare occasio ns.
Mode 3 (Omni off, polypho nic) is the setting you want wh en you are using
sequencer softwa re. It allows you to play cho rds and multiple patches but
receives o nly on a designated channel. Sequencer software usually provides
16 tracks, imitating o n-screen the multi-ch annel tape recorders used in studios. Thus, you can "record" a saxophone on track/channel 1, a trombone on
track/channel 2, and so on . If you have a polytimbral synthesizer, you can set
each patch to respond to a different channel. In this case, one synth esizer
could handle both the saxophone and trombone parts simultaneously.
Mode 4 works with polytimbral synth esizers, turning them into a group of
monophonic instru ments. In the preceding example, the instrument could
play the saxopho ne and trombon e parts but not at the same time. That can
be useful when you have many polytimbral synthesizers in the chain and
want to use complex patch es for each sound.
MIDI assigns Messages to two m ain categories: Channel Messages, which
apply o nly to that chan nel, and System Messages, which apply to all devices,
wi thout rega rd to channel. A special case, the System Exclusive Message
(SYSEX}, applies to a particular brand and model of MIDI instrument (i. e.
Yamaha DX-7, or Casio CZ-101). It operates effects unique to that device (the
featu res that induced you to choose it over other brands). The End Of Exclusive (EOX) Message signals the end of a SYSEX. The following table shows the
vario us types of MIDI Messages.

Sound and Music Software
Two major classes of software are available. One of them allows you to record
and edit digi tal audio. This software deals with actual sound samples. At the
high end, this software turns your Mac into a multi-track recording studio. At
the low end, it behaves more like an ordi nary stereo tape recorder with some
digital editing capabili ties thrown in. The other class of software allows you
to work with MIDI data, but no t actual sound. These MIDI sequencer applications operate MIDI synthesizers to produce sound. Most sequencer software
uses the o n-screen metapho r of a m ulti-track tape deck, but they only record
and play back MIDI data, rath er than so und.

Sound and Music Software
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The distinction between the two classes of software is becoming blurred because many sequencers now allow you to add digital audio tracks to your
MIDI tracks. For example, you can record a vocal on top of a complex MIDI
arrangement so that the synthesizers accompany the voice in perfect synchronization. Obvio usly, you can record acoustical instruments as well as
voices and add narration to the musical background of a rad io o r TV ad. In
fact, the distinctio n becomes even more hazy when you start to look at multimedia software which blends video, MIDI, and digital audio.
Som e other types of musical software don't quite fit into these categories.
One valuable addition to any Mac-based musical system is a patch editor/
librarian. With o ne of these devices, you can create and edit the patches (instrument definitions) on your synthesizer. With these devices, you can work
on a larger, more legible screen and have a dedicated database manager to
store and retrieve patches.
Automatic compositio n and accompanimen t programs appeal to many users.
Some, such as Band-in-a-Box and Jam, play chords and bass lines with the
stereotypical accompaniment figures of a waltz, march, blues, and so o n (see
fig. 13.3). Others, such as M and Max, will create complex musical structures
similar to the visual process of a ka leidoscope (see fig. 13.4). Finally, some
applications can teach you to play an instrument and tuto r you on music
theory.
Fig. 13.3
Choosing a Style in
Band-in-a-Box.
9
13
17
21
25
29
33
37
41

0
0
0
0

Pop Ballad
Shuffl e Roclc
Light Roclc
0 Bosso Nouo
Medium Rock
0 Ethnic
0 Heouy Rock
0 Blues (Shuffle) 0 Miami Sound
0 Blues (Euen)
0 MIIIy Pop
0 Woltz (Old)
O Funk
Ole

Cancel

O Jozz Woltz
0 Rhumba
0Cho Cho
0 Bouncy 12/ B
0 Irish
0 Pop Bollod 12/B
0 Country 12/B (Old)
0 Reggae
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Fig. 13.4
M creates complex
musical structures.

Evaluating MIDI Sequencers and Notation
Applications
Musicians fight a constant battle against compu ter programmers. Music and
programming are both complicated fields, filled with technical terms and
unique methods of doing things that are difficult for outsiders to penetrate.
As a result, the early music applications for personal computers generally did
not work well for musicians.
If you wanted to use music software, you had to put up with its shortcomings. Often, programmers would ignore the niceties of musical notation, and
musicians would turn away in disgust. Separate eighth or sixteenth notes
with individual flags might be the easy solutio n for the programmer's problems, but they don't convey the same meaning that groups of eighth or sixteenth notes with beams instead of flags convey to a musician. A two-staff
piano score is not the same as a 20-staff big band chart or o rchestral score.

Programmers made similar mistakes in desktop publishing by using the term

fon t fo r typeface, because they didn't take th e ti me to learn enough abou t the
typesetting industry. Although music software develo pers were slow to recognize this problem, they have learned and changed over the yea rs.
The major applicatio ns now at least don' t offend musicians. No netheless,
music software as a category remains difficult to use. The distinction between
computer software fo r music and a musical appli cati o n running on a computer is extremely significant. The best single piece of advice is to try several
brands before you buy o ne. Thei r human interfaces are different, and what
works for you might not work for someone else.

Sound and Music Software

Putting Music into the Mac
Entering musical data poses many problems. No one has found an easy way
to do it. One solution has been to place a piano-like keyboard across the bottom of the screen. To enter notes, you simply click them, and they appear on
the staff. That works for selecting pitches. Now what do you do about durations and rhythms? Dotted notes? Tri plets? Usually, a palette of note values
takes care of that. The downside is that you must constantly move back and
forth between selecting a pitch value and a rhythmic value. It's slow. And if
you're in the white heat of inspiration, it can kill the creative impulse. This
approach works best when you' re transcribing existing music into computer
format.
The other popular method of inputting music is to reco rd MIDI data into a
sequencer application. just play on your synthesizer, let the computer record
all the MIDI data it produces, and you're done. You've captured all the notes,
all the rhythms, and most of the nuances of expression.
This method seems like the ideal solution , but it has its own set of disadvantages. First of all, it will record what you play with too much rhythmic precision. When you try to translate the MIDI da ta into musical notation, you
find that none of the notes you played fell exactly on the beat. As a result,
the notation looks crazy-slightly syncopated 16th and 32nd notes tied
across beats and bar lines in an overly precise attempt to capture the notes
precisely as you played them. Four equal quarter notes will all have slightly
different durations, because you played them that way. The no tated music is
nearly unreadable and unplayable in that form.
The old generation of minicomputer-based synthesizers (such as the
Synclavier, and Fairlight) were plagued by this problem. Most sequencer software now includes an algorithm to average out the duratio n values and put
them squarely on the beat and its subdivisions, with som e latitude for
expressio n . The term for this is quantization, but it is not the same as the
quantization process that a digital sampler uses. It's the same word, but with
completely different meanings.
People who have traditional musical training become frustrated with the
avoidance of musical notation that results from this method of entry. Passport, in Master Tracks, used a workaround kind of bar chart notation . It shows
pitch levels on the vertical axis, and duratio ns as horizontal bars. For many
people, this is mo re than sufficient. For others, it's not especiall y helpful.
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The problem comes when you' re trying to correct wrong notes o r otherwise
improve your MIDI sequence. just where on this chart is that E flat 16th note
in the third beat that should have been an E natural? You can find it, but not
as easil y as on a musical staff. Over time, learning this alternative notation
scheme is no t too difficult, but initially yo u must put forth some effort to
learn it.
Coda addressed this problem with Finale. It allows you to enter notes o nscreen in musical notatio n and hear them played back through MIDI synth esizers. Or yo u can play it o n a keyboard, quantize it, and edit the resulting
notatio n, which is about the best compromise available so far. Some seq uencer applications are now more like integrated office applications. Instead
of combining word processing, spreadsheet, and database appl ications, they
combine sequencing, notation, and patch editing applications under one
roof. Others offer separate applications that can ta lk to each other. Separate
applications can be less expensive than integrated types, and require less
RAM and processor speed. Integrated applications typica lly cost more and
require more computing power. Opcode extended th e integration process
with its Studio Vision sequencer. It allows you to record digita l audio tracks
along wi th the tracks containing MIDI data. O thers have followed suit, but it
remai ns a rather specialized capability, and requires a sound card with a DSP
chip.
Two new solutio ns to the no te entry problem are on the ho rizon. The Niglltingnle no tation applica tio n works with an o ptio nal scanner to input music.
It's something like OCR (Optical Character Recognitio n) for music, wh ich
means that you could write it out on paper and scan it into the com puter,
where the software converts it to notation and MIDI data. The other possibility, though no company has discussed introducing such an applicatio n,
would be to use something like the handwriting recognition on the Newton
to convert notation in to MIDI data.

Evaluating Notation Software
Printing music requires com plex software. Entry-level software simply makes
a screen dump of the graphics. More advanced applications use PostScri pt
symbols and offer page layout capabilities comparable to PngeMaker and
XPress. In fac t, because of the intricacies of musical notation, music printing
applications become even more complex than ordinary layout applications.
The first solution was to use screen dumps, but bitmapped printo uts fo r music look dreadful. Developers saw the need for a PostScript music typeface,
and the Sonata font was introduced. Since then, ma ny developers have
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created their own music fonts, both in PostScript and TrueType formats. The
ability to change the size of th e characters without losing resolution makes
them ideal for musical notation.
Obviously, you need a PostScript or TrueType compatible laser prin ter-even
the least expensive models-for printing music with the clari ty needed. In kjet
and dot matri x printers are totally unsuitable.
Some music printing software can extract parts from a full score, which is a
wonderful time-saving convenience. Look for the capability to transpose
fro m scores in C (all instruments written in concert pitch) to the correct key
for each instrument (Trumpet in B flat, Clarinet in A, Horn in F, and so on).
If you are writing fo r instruments with unusual notation requirements (lute
and guitar, harp, and most percussion instru ments), be sure that the software
will accommodate them. Also, if you're writing vocal music, you must be able
to type in the words in precisely the right locations under the no tes. Complete flex ibili ty with fon ts, point sizes, and typestyles, along with hyphenation and positioning, are crucial. Some applications generate the lead sheets
used in popular music. These have the melody and words only, but all the
chords are indicated both in shorthand chord notation (C dim 7, A min) and
in guitar tablature. Trying to print lead sheets with software lacking this specific ca pability can be frustrating.

For those who are working with non-traditional notation (mostly classical
and jazz composers), the only answer is to create scores with graphics applications (CAD software, with you r own custom library of symbols, would be a
good approach).

Copy Protection
Copy protection can becom e a problem for many musicians, particularly if
you are frequen tly performing outside your studio. Regrettably, the music
software industry has been one of the mo re stubborn holdouts, and copy
protected software is still common. In their defense, they do get ripped off by
musicians who give copies to others. Music is a niche market, and the universe of potential purchasers is not as large as for word processing software.
That leads to higher prices to recover development costs, which leads to more
people stealing software. Look at it this way. If you write music, sell copies,
and someone starts giving it away, you're not getting paid for your work.
In that respect, software development and musical com position are q uite
similar.
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What's aggravating to musicians about copy protection is that it freq uently
conflicts with System extensions to cause system crashes. No one wants to
reboot in the middle of a performance!
The best solution is to use a specially tailored version of the System for music,
especially for live perfor mances. Strip out all but the most essential Extensions, virus protection, and other utilities and you can avoid most of the
problems. Another aspect of copy protection is portability from one Mac to
another. Even though you are using only one copy, you might want to transfer it from the Quadra 840 AV in your studio to a PowerBook, LC, Performa,
or some other more portable Mac fo r use in a live performance. Or you might
need to take it with you to do some sweetening at a recording studio. Shop
carefully, and at least know the practical limitations imposed by any given
copy protection scheme before you buy the software.

Shopping for Musical Software
First, you must decide whether you are a low-end or high-end user, because
that affects what stores you are going to visit. The best known low-end sequencer is Deluxe Music Construction Set from Electronic Arts. Almost any
software boutique, computer store, or mail order catalog that sells computer
games and other educational and entertainment software carries it, or something similar. Many people find this kind of software truly liberating and
don't need or want anything more sophisticated.
It's like th e difference between an en try level paint program and an advanced
PostScript illustration application. Without the knowledge and training in
art, the latter becomes too difficult to learn and use. On the other hand, a
Picasso or a Rembrandt could create a masterpiece with a basic paint program. Typically, low-end sequencers will play music on the Mac's built-in
synthesizer chip, and will drive a MIDI synthesizer (although they might not
operate all its functions).
For serious MIDI work, you will want something like Master Tracks, Performer,
Vision, or Cubase. Many computer stores don't sell them (the market is too
small), so you will have to visit a musical instrumen t store that carries both
MIDI hardware and software or buy it th rough a catalog. Also, the professional audio dealers that sell studio-grade digi tal audio equipment often sell
MIDI software. If you have difficulty locating musical applications, call th e
publishers, and they should be able to recommend dealers in your area or sell
to you directly.
Generally speaking, you can get the lowest price on computer gear through a
mail order or discount dealer. Because of the specialized nature of musical
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applications, however, this ca n become dangerous to your sanity- as well as
expensive. You might pay more through a retail dealer than mail order, but
you will also get th e benefit of some advice on what's best for your needs and
will be able to see it in actual o peration. Spending $100 more to get the right
software can be less expensive than throwing $500 away on something that
you don't like or can ' t use, and having to spend still more to get what you
want.
Some oth er ways to find friendly advice-join one of the user groups in music, or sign up for on-line services with music bulletin boards and conferences. For the really h igh-end products (Sonic Solution s and Digidesign), you
will need to talk with a dealer in professional audio equipment who specializes in computer music. Call th e manufacturers and ask for the names of
dealers near you.
A new wrinkle in software marketing is the try-it-before-yo u-buy-it CD-ROM.
The d isc comes loaded with demo versions of all the software the company
sells. You can try it out and determine whether it's the right software. When
you're ready to buy a full working versio n, you call an 800 number, pay for
the software, and receive an access code that unlocks the full working version. For several years, this techn ique has worked well for CO-ROMs stuffed
with fonts (Adobe Type on Ca ll), and now is beginning to enter the larger
market (Instant Access and Software Access). The prices often are slightly
lower than traditional catalog mail order prices.

Survey: Music Software
This brief survey of the most widely know n musical applicatio ns will introduce you to the range and variety of products available. The following list is
not complete but covers most of the popular products. In sequencer software
with d igital audio, the primary category, the major prod ucts are Cubase, Digital Performer, and Studio Visio n. Computer music is a niche market, but it is
also a fast-moving market. As with trends and fads in popular musical styles,
some computer music products change quickly (they must in order to make
the latest, hottest sounds), but others don't change much at all. Read the
magazines aimed at the computer music market; the m ajor Mac magazines
focus their attention on business products, and m ost music and sound manufacturers don't even advertise in them. Program prices are provided when
available.
Band-in-a-Box
$59 SRP Standard Edition (24 Styles)
$88 SRP Pro Version (75 Styles)
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PG Music, Inc.
266 Elmwood Avenue, Suite 111
Buffalo, NY 14222
905-528-2368 Voice
905-628-2541 Fax
If you remember the accompaniment boxes that piano and organ players

used to use to accompany themselves, you know what Band-in-a-Box can do.
It automatically generates the other members of a small combo (bass, drums,
piano, guitar, and strings), using any of the various styles Oazz Swing, Bossa,
Country, Blues Shuffle, and so on). just enter the chords for a particular song
into the lead sheet-style screen, set the key and tempo, and play along. It's
also great for practicing alone when the rest of the band can't make it.
ConcertWare Pro
$339.95 SRP

Great Wave Software
5353 Scotts Valley Drive
Scotts Valley, CA 95066
408-438-1990 Voice
408-438-7171 Fax
ConcertWare started life as a simple music program for kids, but now has

evolved into a fu ll-fledged notation application. If you have a MIDI instrument, it will transcribe your playing into musical notation (and of course
play it back for you). Notation and printing capabilities include guitar and
percussion notation, automatic beaming, text insertion, and up to 32 staves.
Cubase Audio 2.0
$995.00 SRP

Steinberg
17700 Raymer Street, Suite 101
Northridge, CA 91325
818-993-4091 Voice
818-701-7452 Fax
Cubase Audio integrates a MIDI sequencer, score printing, and digital audio

recording into a powerful h igh-end package. It features a flexible quantization algorithm with six different methods. You can edit on a bar chart or in
m usical notation, and a list edit window Jets you assemble pieces of the
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m usic in the right order. Cubase also provides a drum editor, MIDI mixer,
score printing, wave form editor, and the ability to add digital audio tracks to
the MID I tracks. For digital audio, it suppo rts the Digidesign Audiomedia
sound cards.

Cubase Lite
$149.00 SRP
Stein berg
17700 Raymer Street, Suite 101
Northridge, CA 91325

Cubase Lite, the low-end version of Cubase Audio, offers sequencing and notation but lacks the digital audio capabilities of its big brother. Cubase Lite
works with MIDI instruments but not with the Audiomedia cards. Simpler to
learn and to use, Cubase Lite is intended for musicians who don't want or
need all the professional level functions.
Deluxe Music Construction Set
$129 SRP
Electronic Arts
1450 Fashion Island Boulevard
San Mateo, CA 94404
415-571-7171 Voice
O ne of the earliest music applications for the Mac, Deluxe Music Construction
Set uses the built-in synthesizer chip to create sound. It even runs on a 512 K
Mac. You can enter notes by selecting them from a note palette and d ragging
them onto the staff o r by selecting them from an on-screen keyboard. It offers 26 pre-defined instrument sounds and an editor for creating your own
sounds. It's fun and a great introductio n to music o n the Mac.

Digital Performer 1.4
$895 SRP
Mark of the Unicorn
1280 Massachusetts Avenue
Cambridge, MA 02138
617-576-2760 Voice
617-576-3609 Fax

Performer was one of the first serious sequencers and has gone through many
changes to keep it up to date. It is part of a fam ily of related products (no tation, printing, and so on) that talk to each other, although it is no t formally
an integrated application. Digital Performer adds digital audio capability
(with the Audiomedia cards or Mark of the Un icorn Digital Waveboard) to
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the MIDI sequencer. See the following description of Performer for other
features.
Edit One
$149.95 SRP per editor

Opcode Systems, Inc.
3950 Fabian Way, Suite 100
Palo Alto, CA 94303
415-856-3333 Voice
415-856-3332 Fax
The Edit One library allows you to buy the patch editor unique to your particular instrument(s). That saves the expense of buying patch editors for instruments you don't own. These are the same editors that are in the Galaxy
Plus collection.
Encore
$595 SRP

Passport Designs, Inc.
100 Stone Pine Road
Half Moon Bay, CA 94019
415-726-0280 Voice
415-726-2254 Fax
Encore complements Passport's Master Tracks, providing notation entry and

music printing and layout. For musicians who are accustomed to writing
music the old-fashioned way (with rea l notes on a staff), Encore provides all
the right tools and layout capabilities to make you feel at home composing
on the computer. When you're finis hed, you can play it back through a MIDI
instrument or sound card to hear how your music sounds. Encore accepts
entry from a MIDI keyboard either by recording a performance in real time or
by the step-entry method (one note at a time from the keyboard). Or you can
select notes from a palette. It includes guitar notation, text inserti on, and part
extraction and transposition. E11core supports both PostScript and TrueType
music fonts, includes Anastasia and Frets fonts in both formats, and can export EPS files to use in other applications.
EZ Vision

$99.95 SRP
Opcode Systems, Inc.
This entry level sequencer, designed for those who are just getting their feet
wet, is a subset of Opcode's Vision. It offers a 16-track MIDI sequencer, mixer,
and graphic editing window (li nk sections by connecting them graphically).
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EZ Vision opens and saves MIDI files, and can export data to notation programs for printing.
Finale3
$749 SRP

Coda Music Technology
6210 Bury Drive
Eden Prairie, MN 55346
612-937-9511 Voice
612-937-9760 Fax
Fi11ale takes the notation approach to entering musical data, making it com-

fortable for composers and arrangers with traditional training. You can use a
MIDI keyboard or an on-screen note palette for entry and editing. Finale
offers many notation flexibilities and user-definable symbols to satisfy the
needs of experimental and avant-garde composers. It generates lead sheets,
and will extract and print parts from full scores, breaking multi-bar rests at
rehearsal marks automatically. Its page layout, text insertion, and music
printing functions are second to none. Finale includes special music fonts in
both PostScript and TrueType formats. Finale plays back notated music
through MIDI instruments.
Finale Allegro
$349 SRP

Coda Music Technology
Finale Allegro is the entry-level version of Finale, with all the essential tools

but not the most ad vanced features. Emphasis on ease of use shortens the
learning curve. If you decide to upgrade to its big brother, Finale will convert
Allegro files without loss of data.
Galaxy
$149.95 SRP

Opcode Systems, Inc.
Galaxy is a universal patch librarian and editor compatible with over 140

synthesizers. The PatchTalk programming language enables you to create new
patches and add them to the library with your own names. You can search
on keywords to find them quickly. It supports Publish and Subscribe to make
patches available to Opcode's Vision sequencer.
Galaxy Plus Editors
$399.95 SRP

Opcode Systems, Inc.
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Galaxy Plus Editors enables you to access and modify a patch by clicking its
Edit button, regardless of the instrument. Each of the 55 full-featured customized editors supports a particular synthesizer. If you have several brands and
models of synthesizers in your system, this simplifies operations. It also supports Publish and Subscribe.
M

$199 SRP
Dr. T's Music Software
124 Crescent Road, Suite 3
Need ham, MA 02194
617-455-1454 Voice
617-455-1460 Fax
For the curious and the adventurous, M creates musical patterns based on
ideas you give it. This interactive composing and performing tool enables you
to shape and alter the output while it's working.
Master Tracks Pro 5
$295 SRP
Passport Designs, Inc.

Master Tracks Pro 5 provides the sequencer side of the Passport application
suite (E11core is the notation side). As its name suggests, Master Tracks Pro 5
has been around fo r a long time, so it has been refined and improved
considerably over the years. The MIDI sequencer handles up to 64 tracks
with automated punch-in and punch-out (for editing tracks on the fly), pl us
an on-screen mixer. An important function for multimedia is a link from
MIDI Time Code to SMPT~ Time Code, which allows you to synchronize your
MIDI sequence with audio and video tape, or film. You can edit seq uences
with event lists or graphically. Graphic display for individual controllers and
notes simplifi es editing.
Max

$395 SRP
Opcode Systems, Inc.
This unique application gives you a high-level graphic programming environment. ln other words, with Max, you can represent musical events as icons
and link them together graphicall y on-screen. Think of the possibilities fo r
composing and improvising when you can work with sound modules as
building blocks for larger structures. Named after Max Matthews, one of the
pioneers of digital audio and com puter music at Bell Labs, it enables you to

Sound and Music Software
create a wide variety of applications. Max programs can control synthesizers
and other equipment, and generate music based on ideas you give it. It's
much more flexible than most of the accompaniment software and is not
limited just to accompaniment figures in various styles. If you're skilled in C
programming, you can create your own sound-objects and use them in Max
programs. Custom application developers as well as musicians can benefit
from Max. It can play tracks from COs, laser discs, and so on, to create interactive applications.

MiBACJazz Improvisation 1.5.8
$125.00 SRP
P.O. Box 468
Northfield, MN 55057
507-645-5851 Voice
507-645-9291 Fax
Similar to Band-in-a-Box, this application creates backgrounds and accompaniments. True to its name, it concentrates specifically on jazz improvisation.
If you want to learn to improvise in various jazz styles without annoying
other players, this is a great way to gain experience. It also prints lead sheets.

Miracle Piano Teaching System
$499.95 SRP
The Software Toolworks
60 Leveroni Court
Novato, CA 94949
415-883-3000 Voice
415-883-3303 Fax
Miracle Piano Teaching System combines an electronic piano with instructional

software. Actually, the piano functions as a MIDI synthesizer, with 100 different sounds and a 49-key velocity sensitive keyboard. The software teaches
you how to play the piano, and unlike a human teacher, is infinitely patient
with your mistakes. For people who want to learn to play a keyboard, this
hardware/software bundle offers an inexpensive way of getting started.

Music Mouse
$79 SRP
Dr. T's Music Software
Music Mouse uses the mouse to control one set of parameters vertically, and

another horizontally. You can choose different tonal palettes (diatonic,
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pentatonic, and so on), and different instrumental sounds. You then move
the mouse around and listen to the semi-automated sounds it creates for you.
It's incredibly easy to play, and a lot of fun-a great way to take a relaxing
break from number-crunching or word processing. Music Mouse works with
the Mac's internal synthesizer chip or with external MIDI instruments.
Musicshop
$149.95 SRP

Opcode Systems, Inc.

Musicshop adds notation and printing to the sequencer functions of the EZ
Vision MIDI sequencer.
MusicTime
$249 SRP

Passport Designs, Inc.

MusicTirne offers entry-level composing and notation tools. You can enter
music on-screen with a note palette, and hear it played back instantly
through a MIDI instrument or sound card. You also can record music from a
MIDI instrument (real-time or step-lime) and let MusicTime transcribe it into
musical notation. It creates lead sheets and extracts parts from scores.
Nightingale 1.3
$495 SRP

Temporal Acuity Products
300 120th Avenue NE
Building 1, Suite 200
Bellevue, WA 98005
206-462-1007 Voice
206-462-105 7 Fax
The Nightingale notation program offers many refinements in adjusting symbols. The notes palette contains 86 symbols for note entry. It also accepts
entry through MIDI in real-time or step-time mode. For vocal music, it has a
Flow In tool that simplifies the process. Nightingale extracts parts and saves
them as separate files. The company is developing an intriguing OCR application that converts printed music into notation on-screen.
OvalTune
$79 SRP

Dr. T's Music Software

Sound and Music Software

Ova/Tune combines automated composition with colorful, changing graphics.
It's like a computerized kaleidoscope with sound, providing endless hours of
fun. You can record its output and play it back or use it in other applications.
Ova/Tune works with MIDI synthesizers or from an included library of
sampled sounds.
Performer 4.2
$495 SRP

Mark of the Unicorn

Performer 4.2, the latest version of one of the first sequencers offers all the
capabilities of Digital Performer, except for the digital audio tracks.
Practica Musica
$125.00 SRP

Ars Nova
206-889-0927 Voice
206-889-0359 Fax

Practica Musica teaches you the basics of music theory. It covers topics such as
intervals, chords, scales, keys, and harmonic progressions. It also teaches you
how to hear all of these elements of music, with an integrated ear training
course. Just like a human instructor, it plays examples of chords and their
inversions, so you can learn to recognize them by ear. As the lessons become
more complex, you'll learn to identify chords in harmonic progressions. If
music theory is a mystery to you, this is the way to learn it on your own.
Rock Rap 'N Roll
$59.95 SRP (Floppy Disc)
$79.95 SRP (CD-ROM)

Paramount Interactive
700 Hansen Way
Palo Alto, CA 94304
415-812-8200 Voice
41 5-813-8045 Fax
If you want to see what it's like to play in a band, Rock Rap 'N Roll will give
you a taste of the excitement. Designed for people with absolutely no musical
experience, it allows you to select from a large library of sounds, styles,
and musical phrases. You'll have the thrill of sitting at the console of an
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on-screen recording studio with a multi-track tape recorder as you lay down
all the tracks for sax licks, guitar riffs, drum solos, and vocals, then mix them
into a stereo format. Go for the CD-ROM version because it has more sounds.
Studio Vision
$995 SRP

Opcode Systems, Inc.
Studio Vision has all the tools of a high-end MIDI sequencer, including the

capability to record up to four digital audio tracks. It supports the Digidesign
Audiomedia sound card and includes SMPTE Time Code for synchronizing to
audio and video tape and film. Studio Vision allows you to edit digital audio
with Digidesign's editing software. If you're creating radio and TV ads, or
multimedia productions, or simply need to add live sounds to your MIDI
sequences, Studio Vision is widely regarded as one of the best applications
available.
TimeBandit 1.5
$495 SRP

Steinberg
TimeBandit performs a variety of useful functions for high-end users. It pro-

vides time correction for fitting an audio track into the time length of a
slightly longer or shorter video track without changing the pitch. Or, it can
raise or lower the pitch of an instrument that was out of tune with the other
tracks, but without changing the timing. Another capability is harmonization, or the process of thickening the sound by adding one or more parallel
tracks just slightly out of tune (to simulate the effect of a chorus or string
section). TimeBandit supports AIFF and Sound Designer file formats. It works
off-line, because these bits of magic take time to calculate. If you need these
utilities, this is one of the few such packages available for the Mac.

Trax
$99.00

Passport Designs, Inc.
Trax, the little brother of Master Tracks, uses the same interface, but is simpli-

fied for beginners. Trax lacks the advanced capabilities of Master Tracks, but
it has enough power to satisfy most home users. This MIDI sequencer handles
64 tracks, with punch-in and punch-out, and an on-screen mixing panel. You
can enter notes in real-time or step-time mode, and the editing tools are easy
to use.
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Unisyn
$395 SRP
Mark of the Unicorn
With Unisyn, you can create and edit your synthesizer patches on your Mac
screen. The graphic editing tools make the process quick and easy. When
used with Perfonner, it works in real-time as sequences play, so you can hear
the results as you make changes. Unisyn is compatible with 150 synthesizers,
both current and older models. The database stores and retrieves thousands
of patches, using user-definable keywords.
UpBeat
$199 SRP
Dr. T's Music Software

UpBeat works specifically with drum machines. It simplifies the task of entering percussion patterns, and can record MIDI drum data in real time.
Vision
$495
Opcode Systems, Inc.
Vision offers all the same sequencing features as Studio Vision, but lacks the
digital audio recording capability.

Survey: Sound Editing and Recording
The applications listed below allow you to work with sound samples, rather
than with musical data. You can record sounds, alter various qualities of
those sounds, edit and reassemble sounds in various combinations. To use
these applications, you must have a Mac with a microphone and digitizing
hardware or software, or use external equipment.
Audioshop
$89.95 SRP
Opcode Systems, Inc.
With Audioshop, you can record and edit Macintosh audio, using a familiar
CD player-like interface. It allows you to edit a wave form with an on-screen
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window, where you can cut and paste different parts of the sound, just like
editing text. It also plays tracks from COs on a CD-ROM drive, using a
playlist. lt comes with two disks of sound samples.
Deck II 2.1
S399 SRP

osc
480 Potrero Avenue
San Francisco, CA 94110
415-252-0460 Voice
415-252-0560 Fax
With Deck II, you can turn your Quadra 840 AV into an eight-track digital
audio recorder. On the 660 AV, it provides up to six tracks. OSC developed
the original software for Digidesign, and now markets its products independently. The original Deck recording software required Audiomedia, a NuBus
card with a DSP chip to digitize the sound. This new version takes advantage
of the DSP chip on the Quadra AV m achines. It also works on other Macs
with the Audiomedia card, the RasterOps MediaTime card, and the Spectral
Innovations NuMedia card. Deck allows you to record each of the digital audio tracks independently, or in combination, so you can build up a complete
musical structure by adding more sounds. Punch-in and punch-out let you
start recording in the middle of a previously recorded track to fix fumbles and
wrong notes. With track bouncing, you can mix several tracks down to one
or two (all your vocals or all your drum tracks) and then use the newly freed
tracks for more sounds. Instant access, non-destructive editing enables you to
assemble all the sections of a piece, as well as edit out glitches and bad notes.
The mixing panel controls volume and panning for all channels. It supports
QuickTime movies, displays live video in a window, and imports MIDI Files.

Hyperprism
Arboretum Systems
P.O. Box 470580
San Francisco, CA 94147
415-931-7720 Voice
415-931-7725 Fax

Hyperprism enables you to design your own sound effects in real time. Start
with an effect from its library, and make your own variations graphically onscreen. Hyperprism includes several filters, plus phaser, flanger, delay, ring
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modulator, and many other effects. It also offers a pitch follower and an envelope follow. It requires the Audiomedia sound card.

Kaboom!
Nova Development
23801 Calabasas Road, Suite 2005
Calabasas, CA 91302
818-591-9600 Voice

Kaboom! enables you to add new and more interesting sounds to your Finder
comm ands. It comes with an extensive library of 8-bit samples. For example,
you can have your Mac say "Lucy, I'm home!" instead of chiming at Startup.
Or use the Twilight Zone theme for closing a file. It also has a nice 8-bit sound
editor so that you can record your own samples and use them in QuickTime
movies and multimedia presentatio ns, or as Finder additives. You'll need a
Mac with a built-in microphone to use the recording feature.
MacRecorder
Macromedia, Inc.
600 Townsend Street
San Fransisco, CA 94103
415-252-2118 Voice

MacRecorder combines an external 8-bit digitizer with sound editing software.
Originally sold by Farallo n, it is now marketed by Macromedia. It's especially
useful with older Macs that lack a built-in microphone, but works with any
Mac through a serial port. You'll need a microphone to plug into the digitizer
box.

Digital Audio and MIDI Hardware
If you want to work at the CD quality level (16 bits, 44. 1 kHz sampling rate),
you n eed a high-end Mac. That includes not only a faster microprocessor
chip but also an accelerated SCSI bus and mammoth high-speed hard disk
storage capacity. For complex MIDI configurations, you need specialized
controllers and may wa nt to look at MIDI-operated special effects generators.
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Where to Shop for MIDI Synthesizers
and Sound Cards
Be prepared to shop outside th e usual computer market. Music and digi tal
audio are specialized markets. Most computer shops don't carry MIDI instruments. Large discount department stores may have acres of synthesizers
o n display, but no ne of them will have MIDI capability. To find these
instruments, you must go to the musical instrument dealers. The manufacturers generally want dealers who specialize in music or audio equipment for
musicians as the retail outlets for their MIDI equipment. The same is true of
sound cards for digital audio. Some computer shops may carry sound cards,
but you'll get better advice from the musical instrument and professio nal
audio dealers. They'll also carry the software and peripherals that work in
MIDI and digital aud io systems.

Which Mac Do You Need?
All Macs have built-in sound capabilities, so even an old 512K Mac can run
the entry-level software, especially the musical applications intended for
presch oolers. Many of the low-end MIDI sequencers and 8-bit sound editors
run on a Mac Plus, although you should have mo re than 1MB of RAM . If you
haven't upgraded to System 7, you should do so because more and more
software requires it.
The high-end sequencers and 16-bit recording and editing applications generally require at least the speed of a Ilci and 8MB of RAM and assume that you
are running System 7. Applicati ons at this level generally are over 3MB, and
you'll want to switch around fro m one to ano ther, just as in desktop publishing, where you have large page layout application opens, but m ay need to
have one o r more word processors open, alo ng with a few graphics application s.

MIDI Adapters
You'll need a MIDI interface to use a sequencer application. For most people,
the simple, basic MIDI interface does enough to ge t started. As your system
becomes more complex, you' ll want to look at "smart" M1DI controllers.
Also, MIDI Thru Boxes and MIDI Patch Bays provide greater flexibility in
connecting MIDI equipment.
If you intend to do intricate m ultimedia work beyond the level of QuickTime,
with several audio and tape decks o n line, or transfer audio tracks to film, you
need to consider th e benefits of SMPTE Time Code. This format, developed
by the Society of Motion Picture and Televisio n Engineers puts timing signals
on your tapes and film soundtracks, or embeds them in MIDI data.

Digital Audio and MIDI Hardware
Its purpose is to synchronize all of your equipment. A good example of the
use of SMPTE Time Code is synchronizing dialog with images. Many of the
"smart" MIDI interfaces include SMPTE synchronizati on .

SCSI Accelerators and Sound Cards
For digital audio recording, plan to get as much RAM as you can- massive
amounts of data will be m oving thro ugh yo ur Mac. You will also need more
h ard disk capacity than you ever believed possible. One hour of stereo at
a 44.1 kHz sampling rate with 16-bit quantization occupies 600MB. And you
will want to back it up!
Beyond that, you must have drives with an access time of 18 ms or less, plus
an accelerated SCSI bus. Some of the recent Macs come equipped with SCSI-2,
but you can upgrade older Macs with a SCSI accelerato r card, which is required for CD quality digital audio work. Without the Fast SCSI capability,
your Mac can't transfer data from the hard disk fast enough to play it back.
In additio n to the SCSI accelerator, you must have a digital audio card. Its
function is to convert analog signals into digital audio data, and it's normally
a NuBus card. It will have at least one DSP chip for this purpose. The
Digidesign Audiomedia, Sonic Solutions SSP-3, RasterOps MediaTime, and the
Spectral Innovations NuMedia are the common cards. Most of the available
softwa re supports one o r more of them. A crucial difference between these
cards and the DSP chips built into many Intel-based machines is the signalto-noise ratio. Though a DSP chip may have 16-bit quantization and a 44.1
kHz sampling rate, and may be promoted as having "CD quality," its ac tual
performance may no t be good enough fo r digital audio recording, editing,
and mixing. The less expensive models of these chips suffer from interi or
digital noise that may reduce their signal-to-noise ratio by as much as 10 dB.
So, instead of the 90 dB you might expect from a 16-bit chip, you start
at 80 dB.
Why is this important? As you bounce tracks in the overdubbing process,
the noise starts to build up, just as it does on an analog multi-track recorder.
Also, when you mix down 8 or 16 channels, the noise o n each track gets
added into the stereo mix, reducing the signal-to-noise ratio of your output
well belo w even 80 dB. That's why the software developers require a sound
card with a better quality DSP chip, such as the Motorola 56001. The Quadra
AV machines use an on-board AT&T 3210 chip, which delivers similar perform ance.
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Selecting Synthesizers
The choice is yours to make. Hundreds of brands and models are ava ilable,
each one designed to appeal to a diffe rent kind of musician and a different
set of needs. It's a very personal choice. If you are just beginning to explore
the field, don 't know what you're doing, and don't wan t to spend a lot of
money on something you don't like-buy a used instrument. Go to your
local musical instrument dealer and look for a low-end used MIDI synthesizer. You won't waste your money, because it always will be useful, no matter what other instruments you add to your system. The advantage is that
you can learn what you need to know before you buy the synthesizer of your
dreams. But don't get paralyzed by indecisio n . Buy cheap at first, until you
know what you really want.
The current trend is away from the old style synthesizers and toward wave
table (sampling) synthesizers. Soon the FM synthesizers (like the Yamaha DX7 and its successors) will be antiques, as strange and out-of-date as a Moog
synthesizer seems today. The popular music market pushes for instruments
that are quick to adjust during live performances. Changing patches and
fiddling with adjustments takes time. What a rock performer wants is a bank
of buttons to push . Also, sampli ng techniques have improved, and the price
of memory has dropped, making sampling synthesizers economically practical, and desirable. Today, a typical system would include one or more "black
boxes" loaded with samples (many units provide space for user-downloaded
samples also), plus a keyboard to control the sample boxes. Throw in som e
special effects processors, and you have a modern synthesizer system. Some
sample boxes (such as Digidesign 's Sample Cell) are actually NuBus cards.
Samples do not need to be recordings of actual instruments. They also can
be real sounds which have been altered dramatically with special effects
software. Samples can o riginate from true synthesizers, then further altered,
shaped, and distorted beyond all recognition . In this way, you can have
instant push button access to almost any kind of sound witho ut having to
figure out how to create it. The sampling synthesizer has made electro nic
instruments still easier to play and eliminated the need to learn difficult
sound creation techniques. Most members of this new generation of synthesizers don't provide many sound modificatio n possibilities because the
samples themselves offer all the variations. You'll find a lot of action in the
market in the area of outboard special effects processors, with unique, proprietary sound qualities. It's fast-moving and trendy, reflecting current pop
music styles.

Digital Audio and MIDI Hardware

315

Libraries of samples, many on CD-ROMs, are on the shelves at the musical
instrument dealers. In a sense, samples on a synthesizer now behave like
fonts on a laser printer. Creating a sample has become a specialized skill,
similar to creating a typeface. To do it well requires knowledge and skill, plus
specialized hardware and software. On the other hand, the sound quality of
synthesizers is improving con siderably, and so is their ease of playing.

Keyboard, Wind, and String Controllers
The keyboard itself becomes an important aspect of the instrument, particularly for those who learned to play o n an acoustic piano. The feedback of the
size, weight, and mechanical resistance of the keys makes a great deal of difference to some people, and practically none at all to others. In addition, to
achieve full use of the MIDI system 's expressive capabilities, you may wa nt a
keyboard with advanced features. Velocity sensitive keys send MIDI data
about how hard you pressed them (that is how loud you played that note).
Aftertouch creates data about the way you released the key. Some even have
pressure sensitivity for creating effects like vibrato. Thus, having a single
master controller keyboard makes sense. Often, they have no sound generating capabilities, but simply con trol other instruments. Put all your money
into one high-end keyboard, and play you r o ther synthesizers with it through
MIDI, instead of buying expensive keyboards on all of them.
Alternative controllers, designed for string and wind players also have their
attractions. They are less common than they were a few years ago, but check
the used equipment market. The IWI (Intelligent Wind Instrument),
marketed by Akai was one of the fi rst on the market. Yamaha followed with
their WX-11 MIDI Wind Controller. Guitar synthesizers are available, and
you can even find MIDI violins and cellos.
No matter what you choose as the ultimate instrument of your dreams,
pay attention to the operating controls as well as the feel of the keyboard.
Tiny LCD screens that deliver cryptic infor mation don't make the synthesizer
fun to play. Banks of buttons smaller than your fingertip and too close
together with labels too small to read cause nothing but mistakes during
performance. Be sure that the human interface makes you r job as a player as
easy as possible.

Hard Disk-Based Recording
Storing digital audio data o n a hard disk instead of on tape has truly revolutionized the audio industry in many ways. It has all the advan tages of digital
audio in general (low noise and distortion, the ability to make an exact copy,
and greater accuracy in editing). In addition, it has the inherent advantage of
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disk over tape- nearly instant access to any point in the recording, which
makes editing faster. Because all the operations are taking place on a desktop
computer, software can perform all of the equalization, compression, mixing,
and special effects generation that formerly required an elaborate collection
of equipment in a recording studio. That implies one more benefit, which is
truly remarkable. Editing digital audio becomes as easy as editing a word
processing document. You can make changes without destroying the original,
or any intermediate steps. You can listen to an edit before you commit to it,
or even audition several edits before selecting the one that sounds best.
If you've ever edited analog tapes with a razor blade and splicing tape, you
know all about the dangers of cutting into a master tape (in analog, you can't
work with a copy because of the added noise). Finding the exact location isn't
easy. Cut the wrong place and you can destroy the tape. If the performer
doesn't like the exact way you carried out an edit, changing it is difficult, and
sometimes impossible.
In digital editing, you can specify where the edit takes place, down to the
sample (44,100 of them per second). You can tell the computer to connect
Point A to Point 0 or Point Z without altering your original recording. Also,
you can tell the computer to fade in the beginning of Segment 224 while it's
fading out the end of Segment 86 (cross-fading), and specify how long the
cross-fade should last. That's not possible with razor blade editing. In fact,
you can assemble a finished production by making a list of all the segments
you want to use, in the order you need them, and ask the computer to play it
back for you as a continuous piece. Since all the data is on the hard disk, the
software simply reads the appropriate sectors. That alone has changed the
way film and video production are being done.

Survey of Hardware
For recording 16-bit digital audio on most Macs, you need a sound card to
convert the analog signal from the microphone into a digital signal, and
convert the digital signal back to analog form for playback. The AV Macs
have this capability built into them. For advanced MIDI work, such as synchronizing with film, video, or other external equipment, you need special
equipment described in this section.
Integrated Hardware and Software Systems
Session 8

Digidesign
1360 Willow Road
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Menlo Park, CA 94025
415-688-0600 Voice
415-688-0777 Fax
Session 8 comes with a 16-bit digital audio card and a SCSI accelerator card,
plus the software for direct to hard disk recording. It requires a !lei or faste r.
Features include digital mixing, track bouncing, random-access editing, special effects, SMPTE trigger, and MIDI Time Code. With its internal mi x mode,
all mixing, editing, and signal processing take place in the digital domain,
providing clarity and freedom from noise build-up. An optional hardware
mixer/controller provides the feel of a real recording console, and the ability
to operate more than one fader at a time.

SonicStation II
Sonic Solutions
1891 East Francisco Boulevard
San Rafael, CA 94901
415-485-4800 Voice
415-485-4877 Fax
SonicStationll provides 12 tracks of disk playback, with two channel digital
input and output. It includes two NuBus cards and software. The Sonic Solutio ns equipment is widely used in recording studios, and this is their entrylevel package (others approach $100,000). Generally, it is available only from
specialized pro audio dealers, but they'll be in a position to offer considerable
advice in selecting and setting up a Mac-based professional studio.
SonicStation II offers high performance suitable for those who plan to start a
studi o as a money-making business.
Sound Cards

Audiomedia II
$1295 SRP
Digidesign
Audiomedia II contains a Motorola 56001 DSP chip and the circuitry for digitizing analog audio into digital audio. Digidesign's Sound Designer II software
lets you record, mix, edit, and play back digital audio. The Audiomedia II card
offers high quality 16-bit sound at a 44.1 kHz sampling rate. It's available
either as a NuBus card, or as a PDS card for the LC. (Note: Since the LC has
only one slot, you can expand it with the LC MAX expansion chassis, available by mail order from DGR Technologies, 1219 West 6th St., Suite 250,
Austin, TX 78703. Call 512-476-9855 or fax 512-476-6399 for information.

Ill

318

Chapter 1 3-Music and Sound
The Audiomedia card runs on the LC MAX, and you can have up to three
other cards installed along with it.)
NuMedia
$1 195 SRP

Spectral Innovations
1885 Lundy Avenue
San j ose, CA 95131
408-955-0366 Voice
408-955-0370 Fax
Oriented toward QuickTime users, NuMedia delivers 16-bit stereo performance for QuickTime soundtracks. This NuBus card uses the AT&T 3210 DSP
chip, and also carries out compression and decompression for both audio and
video.
Pro Tools
Digidesign

The Pro Tools digital audio card offers two 56001 DSP chips, and can handle
four channels (up to 16 with expansion capabilities). Intended fo r exacting
studio work, it delivers lower noise than the Audiomedia cards, and has balanced line outputs with XLR connectors.
Sample Cell II
$1995 SRP

Digidesign
Sample Cell II stores downloaded sampled sounds on a NuBus card. It handles

32 voices with eight polyphonic outputs, and you can install additional cards
for more voices. A CD-ROM with an extensive library of sampled sounds, plus
sample editing software comes with it.
Special Effects Processors
NuVerb
$1795 SRP

Lexicon
100 Beaver Street
Waltham, MA 021 54
617-736-0300 Voice
617-891-0340 Fax
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NuVerb brings the outstanding quality of Lexicon's famous reverb systems to
a NuBus card. It has many other effects and interfaces with Digidesign.
Vortex

Lexicon
Vortex does for sound what morphing software does for images. This outboard effects processor tra nsforms one sound into another over a specified
period of time between 0.01 and 10 seconds. It's great for audio effects that
accompany visuals. While an ear of corn becomes a box of cereal, fo r example, a synchronized sound effect can change along with the image. And
that's only the beginning. Vortex has many more capabilities for creating
subtle musical effects with various kinds of delay and modulation transformations.
MIDI Accessories
Apple MIDI Interface
$99 .95 SRP

Apple Computer
The Apple MIDI Interface connects to one of your serial ports and provides
one MIDI In and one Out.

MIDI Time Piece II
$595 SRP
Mark of the Unicorn
1280 Massachusetts Avenue
Cambridge, MA 02138
61 7-576-2760 Voice
617-576-3609 Fax
MIDI Time Piece II includes a 128-channel MIDI interface, with eight independent inputs and outputs, plus SMPTE interface and a MIDI patch bay.

MIDI Translator II
$59.95 SRP
Opcode Systems
An inexpensive, basic 16-channel MIDI interface, MIDI Translator II provides
one MIDI In and three Out, plus LED activity indicators.
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Studio 3
$319.95 SRP

Opcode Systems
Studio 3 offers 32 channels, with two MIDI In and six out, and SMPTE Interface Synchronizer.
Studio 4
$495.00 SRP

Opcode Systems
Studio 4 offers 128 channels, with 8 MIDI In and 10 out, and SMPTE Interface Synchronizer.
Studio 5 LX
$1195 SRP

Opcode Systems
Studio 5 permits you to expand your MIDI system in many ways. It has 240
channels, 15 MIDI Ins and Outs, activity LEDs, and SMPTE to MIDI Time
Code conversion. You can ch ain up to six of them together.

From Here ...
In this chapter, we've described how to add sounds to the Mac and how MIDI
works, and also given you some information about the music software available for your Mac. If you are also interested in voice control or video you
should read the following chapters:
• Chapter 14, "Talking to Your Mac," which explains how to use speech
recognition to give your computer speech commands, and how the
computer can use text-to-speech technology to read text and numbers
to you.
• For more information o n the video capabilities of the Maci ntosh, see
Chapter 23, "Digital Photography and Desktop Video."

Chapter 14

Talking to Your
Macintosh
by Carman Minarik

With the introduction of the Centris 660AV and the Quadra 840AV, Apple
has created an entire suite of aud io and video technologies for personal computers. The speech component of these technologies enables an AV
Macintosh to recognize and respond to voice commands and to transform
text into synthesized speech.
This chapter discusses the following topics:
• The tech nology known as PlainTalk
• The system requirements for use of PlainTalk techno logies
• How to use speech recognition to control your Macintosh
• How to customize and add speech commands
• How to use th e Text-to-Speech technology

What Is PlainTalk?
PlainTalk is a component of the audio/video technology included with the

AV Macintosh computers. These technologies make use of the high-speed
processing power combination of the 68040 CPU teamed with the AT&T
DSP3210 Digital Signal Processor chip. The entire AV sui te includes integrated
video input and output, in tegrated audio input and output, and built-in telecomm un ication arch itecture, as well as PlainTalk speech tech nology.
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The term PlainTalk is actually referring to two distinct capabilities: speech
recognition and text-to-speech conversion.

Speech Recognition
The speech recognition component of PlainTalk is one of the most advanced
implementations of speech technology ava ilable on a personal computer. The
system is speaker-independent and accommodates continuous, natural
speech patterns. Speech recognition is also easily customizable to your
specific needs and preferences.

System Requirements
To implement speech recognition, you will need the following:
• An audio/video enabled Macintosh (Centris 660AV, Quadra 840AV, or
Power Macintosh)
• A minimum of eight megabytes of RAM-16 megabytes is
recommended
• The PlainTalk software
• A microphone

The Centris 660AV and Quadra 840AV incorporate the AT&T Digital Signal Processor
(DSP) chip, which allows the audio/video technology, including PlainTalk, to function. The Power Macintosh systems do not need this chip in order to function as AV
systems. This can cause a problem for Power Mac users, however, since most of the
software available for the audio/video Macintoshes is designed to look specifically for
the DSP chip.

Activating Speech Control

~

Spuch S.tup

Speech recognitio n is activated through use of the Speech Setu p Control
Panel. Choose Speech Setup from the Control Panels submenu on the Apple
Menu, or double-click the Speech Setup icon in the Control Panels folder in
the System folder. A window similar to the one illustrated in figure 14.1
opens.
Click the On butto n to start speech recognition . The computer responds with
the spoken phrase Starting up. Once speech recognition is activated, you will
hear the phrase Ready.

Speech Recognition
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Fig. 14.1
Use the Speech
Setup window to
activate and
control speech
recognition.
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Introduction
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1.0

As part of the speech startup process, the Status window shown in figu re 14.2
appears. This window is always visible while speech recognition is activated
and will automatically position itself in front of any Finder or application
windows you open. As with any other Macintosh window, you reposition
this window by draggi ng its title bar.

Animated representation

indication of the
--+-Text
Speech command status

Name with which
to address the computer

The Status window has the following three sectio ns:
• An animated picture representation of the speech recognition software's
activi ties
• The name by which you should address t he computer
• A text box showing the commands and responses of the speech recognition software

Using Speech Recognition
When speech recognition has been activated, you can give your Macintosh
verbal commands. Keep these general points in mind when speaking to the
computer:
• The PlainTalk microphone sho uld be placed directly in front of you,
from one to three feet away from your mouth.

~

See "The
Finder and Its
Contents,"
p. 72

Fig. 14.2
The Status window
remains open in
front of all o ther

windows as long
as speech recognition is active.
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• Yo u should speak in a continuous, normal speech pattern . Such things
as lo ng pauses and abno rmal emphasis on words are no t o nly unnecessary but will confuse the recognitio n process.
• Excessive background noise will cause confusio n in the speech recognitio n process.
• Always address the computer with its designated name before giving
the co mmand; o therwise, you will not have the computer's attention
and the command will be ignored.
• Watch the Status window carefully. It will provide visual feed back on
commands the recognition software has in terpreted.
• The speech recognition software is designed to recognize specific comm ands. If you add extra words or sounds to a command, the recognition process may become co nfused.

Speech Commands
The speech recognition is set up at the factory to recognize a particular set of
commands, as detailed in the following paragraphs:
Hello. The compu ter will respond Hello , wel come to Macintosh.
What D ay Is It? Th e computer will tell you the date accord ing to its system

clock.
What Time Is It? The computer will tell you the time according to its system

clock.
Zoom Window. Produces the same effect as clicking the Zoom Box window
control on the active window.
Close Window. Wo rks as though you clicked the active window' s Close Box,

o r used the File m enu choice Close Window.
Note

!

The Close Window command will not work when the Alarm Clock is the active
window.

Close All Windows. Equivalent to clicking the Close Box of the active window

while holding down the Optio n key. All o pen Finder windows will be closed.

Speech Recognition
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Note
The Close All Windows command works only in the Finder. It will not work when any
other application is active.

Print... Copies. Prints the requested number of copies of the document in the
active window.
Print From ... To ... Prints the requested page range of the document in t he active window.
Print Page... Prints the indicated page number of the docum ent in the active
wi ndow.
Print Pages ... To ... Prints the requested page range of the d ocum ent in t he
active window.
Note
The Print Pages...To... command will not work if the Print choice is not located on
the File menu for the application in use.

Is File Sharing On? The computer will open t he Sharing Setup Con trol Panel
and report the status o f fil e sharing.
Start File Sharing. The computer will open the Sharing Setup Contro l Pa nel,
activa te File Sharing, and then close the Sharing Setup Control Panel.
Stop File Sharing. The computer will open the Sharing Setup Control Panel,
d eactivate File Sharing, and then close the Sharing Setup Control Pa nel.
Note
The File Sharing commands work only in the Finder; they will not work when any
other application is active.

Open .. . Opens the requested Apple Menu item.
Switch To ... Activates t he req uested applica tion.

~

See " Printi ng a
Documentfrom A to Z,"

p.206
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N~

,

The application must be open in RAM and listed on the Application menu in order for
this command to work.

Command. You can say any men u command in any application rather
than choose the command with the mouse.

Me1111

N~

I

I

This function may not work if the same command appears on more than one menu,
if the menu command contains unpronounceable characters, or if the menu command is currently unavailable.

Dialog Box Button. You can say the name of any button in any dialog box
rather than click the button with the mouse.
N~

I

This command will not work if the button name is unpronounceable. Some dialog
boxes, for example, contain directional arrow buttons or buttons with icons that
represent their action. Also, if the speech recognition Status window is covering the
button, this command will not work.

ltemln The Speakable Items Folder. You can say the name of any item placed in
the Speakable Items folder {located in th e Apple Men u Items folde r in the
System folder).
Restart. The computer will rep ly" Are you sure you want to restart?" If you
answer "Computer, Yes" the computer will restart.
Shut Down. The computer will reply" Are you sure you want to shut down?"
If you answer "Computer, Yes" th e com puter will shut down.

Setting Speech Options
Several options are avai lable to you for controlling the way speech recognitio n works on your Maci ntosh. These options are accessed through the
Speech Setup Control Pa nel.

Speech Recognition
Tolerance Setting
The Speech Setup window provides a Tolerance slider bar at the top of the
window. This control is used to specify how precisely you must speak in order
for the Macintosh to understand and respond to your commands. The further
to the right the slider is positioned, the more precisely you must speak.

If the slider is positioned too far to the right, you may find that commands
must often be repeated. If the slider is positioned too far to the left, inadvertent commands may be issued accidentally.
Choose Introduction from the drop-down list in the Speech Setup window to
access the Introduction to Speech help system. Click the Introduction button
to launch the system. The screen shown in figure 14.3 appears.
Introduction to Speech ~I

-

How to ualk to your MadntOih

r- -

[!] Wbere to put the microphone
[!] Turning: on speech recoanitJon
[!] SpMking d.o1 on4 dan't.JI

Move to topic -

~Who.tyoucanoay

0
0

How to say more
Sett:l.nK optto~

'-- [2] Troubl .. hootlnr;
Move to

<Jdc•'"""'"'"""''.,...."-

screen

I

contents~-~
""~Jill~~u
lttt::jl~·t~~I>~-~Move
to
next screen
Move to
previous
screen

Use the buttons on this screen to navigate through an on-line speech recognition tutorial.
Name Settings
Choose Name from the drop-down list in the Speech Setup window to access
the name settings for speech recognition. The window options will change, as
shown in figure 14.4.
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Tip
Move the slider
only a short
distance at a
time, and test
the results. The
ideal setting fo r
your environment may be
very close to
the initial
setting.

Fig. 14.3
The Introduction
to Speech application provides help
on using speech
recognition
technology.
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Fig. 14 .4
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Use this screen to
enter a name by
which to address
your computer.
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commands you
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Tip
The second
option, Name
required before
commands, is
the safest and
most reliable of
these choices.
The other
options create
more opport unity for erroneous commands
to be processed .

I0

En ter the name by which you want to address the computer in the
edit box. The name you enter will be used to get the computer's
attentio n as you issue speech commands.
The radio buttons o n th is screen allow you to choose the followi ng
options for use of the computer name:
• If you do not wa nt the com puter name to be required before a command, select the Na me Optional before Commands radio button.

• If you wan t the com puter name to be required before a command,
select the Name Required before Commands radio button.
• If you wa nt to say the name after a command, choose the Name Required after Last Speech Commands radio button . Enter the number of
seconds in which th e name must be said after a command is issued.
Feedback Settings
Choose Feedback from the drop-down list in the Speech Setup window to
access the feedback settin gs fo r speech recognition . The window options
change as shown in figure 14.5.

Use this window to change these options:

• Character. Select the animation picture fro m the first drop-down list.
Each option will place a differen t animated picture in left sectio n of
the speech recognition Status window.
• Voice. Select a voice from the second drop-down list. Both compressed
and uncom pressed voices are available. The compressed voices require
significantly less memory space, but do not sound as natural as the
uncompressed voices.
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• Responding. From the third drop-down list, choose a sound for the com-

puter to play when it is responding to a voice command.
• Completed. The fourth drop-down list allows selection of the sound the

computer will play when a command is completed.
Fig. 14.5
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Attention Key Setting

Choose Attention Key from the drop-down list in the Speech Setup window
to access the attention key setting for speech recognition. The window options change, as shown in figure 14.6.
Fig. 14.6

Speech Setup
RuogniUon : - - - - · - - - - ,

® an
0 orr

TolHAnt

Strl<t

c:::::;:::::;"8

1.0

This window provides only one control. The key listed on this screen can be
used to toggle the computer's attention to speech commands on or off. For
example, figure 14.6 shows the Clear Key as the Attention Key. If you want to
set the computer to ignore voice commands temporarily, just press the Clear
Key once. When you want the computer to respond to voice commands, you
just press the Clear Key again.

The Attention Key
screen h as o nly
one setting.
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Set the attention key by pressing the desired key or key combination. The
new attention key setting is shown in the setting box.

Customizing Speech Commands
The Macintosh comes to you from the factory able to respond to many
speech commands, as listed earlier in this chapter. You will probably want
to add your own commands to your computer's capabilities, as well.
Two methods can be used to add speech commands to your Macintosh: adding to the Speakable Items folder and creating speech macros.
Adding to the Speakable Items
The Speakable Items folder is located inside the Apple Menu Items folder
inside the System folder. Saying the name of any item in the Speakable Items
folder will cause that item to open. Since Macintosh file and folder names
can be up to 31 characters in length, the name for these items can be quite
descriptive.

Follow these steps to add a new item to the Speakable Items folder:
~

See "Selecting
and Moving a
Group of Files,"

p. 11 8

1. Select the item you want to open with a speech command.
2. From the File menu, choose Make Alias. An alias of the selected file or
folder will appear.

3. Click the name of the alias to select it.
4 . Type the phrase you want to use to open this item. Use the same guide-

lines for choosing this phrase as you used for choosing the computer
name earlier.
5. Drag the alias into the Speakable Items folder, which is in the Apple

Menu Items folder inside the System folder.
The name of the alias will now be recognized as a speech command, and
when the command is spoken, the associated item will be opened.

N~

I

You must turn Speech Recognition off and then on after adding new speakable items
in order for the Mac to recognize the new items.
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Using Speech Macros
Most current Macintosh computers, including the audio/video machines
equipped with PlainTalk, allow automation of repetitive tasks with
AppleScript. AppleScript is a basic programming tool which allows you to
record a series of mouse or keyboard actions in to a script. The script can then
be played back later, re-creating the recorded steps.

The Speech Macro Editor application included as part of th e PlainTalk system
uses AppleScript tools to create o r edit speech commands.
Launch the Speech Macro Editor by double-clicking its icon. The application
is normally found in the Speech Technology fo lder inside the Apple Extras
folder. A wi ndow similar to the one shown in figure 14.7 opens.

~

Spffoh M•cro Editor

Fig. 14.7
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This window lists the speech macros currently defined and in use. To edit an
existing speech macro, point at the desired m acro in the list and dou ble-click.
To create a new macro, use the Macro menu choice Create New Macro. ln
either case, a window as shown in figu re 14.8 opens.
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To create a speech script, follow these steps:
1 . Enter the name for the command. Use the guidelines described earlier
for speech command names.

2. Select the context for the command from the drop-down list. The context indicates in which applications the command will be ava ilable.
3. Select the scripting tool to be used to create the script. AppleScript and
the newest version of QuicKeys can bo th be used to create speech
scripts.
4. Activate the Ack nowledge check box if you wa nt th e speech recogn it io n
software to play the Respond ing and Completed sounds when the command is used.

5 . Click the Record button.

6 . Perform the steps you want included as part of this speech command.
Any mouse or keyboard actions you make from the time you click the
Record button will be recorded as part of the scri pt.
7. When all the desired com mand steps have been completed, click the
Stop button. You will see the script comm ands in the box Lo the right
of the scripting buttons.
8 . If desired, edit the script commands by changing the text in the scri pt
box.

9. Test the script by clicking the Run button.
10. From the File menu, choose Save. The script will be saved as part of the

speech macro file.
For changes to speech macros to take effect, you may need to turn Speech
Recognition off and then back on again. Th is will reload the speech macros
into the system.
~~

-.

I

The Speech Macro Editor can only record speech macros if the application you are
using supports AppleScript recording . See the documentation for each application
for information regarding its recordability.

Text to Speech

Text to Speech
Text-to-Speech (TIS) tech nology allows the Macintosh to interpret textual
data and read the information in a nearly natural voice.
You can choose from multiple voices and various sound quality levels for the
synthesized voices.

System Requirements
To use TfS, you must have the following items:
• An audio/video capable Macintosh
• A minimum of 8MB of RAM (16MB is recommended)
• The PlainTalk software
• An application that supports T'TS. The version of Teach Text that ships
with any AV Macintosh is one application that supports TIS.

Using Text to Speech
The TIS technology component of PlainTalk is only available in applications
designed to use TIS. You cannot, for example, open a document in MacWrite
and have your Macintosh read it to you. Using the following steps, however,
you can have your Macintosh read nearly any document you want:
1. Open the document you want the Macin tosh to read in the application

you used to create it.
2. Select the part of the document you want the Macintosh to read.

3. Open th e Edit menu and choose Copy.
4. Open a TIS-enabled application, such as the version of Teach Text that

shi ps with PlainTalk.
5. Open the Edit menu and choose Paste.

6. Open the File menu and choose Voices. From Voices submenu select
the voice you want the computer to use as it reads your text.

7. Open the File menu and choose Speak All. The computer will now interpret the text and numbers on-screen and read the information in a
synthesized voice.
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If part of the document is selected, the File menu choice changes to
Speak Selection.
8 . To stop the reading process, open the File menu and choose Stop
Speaking.

From Here...
In this chapter, you have learned about the PlainTalk speech technologies
available on audio/video Macintoshes. You have seen how to use speech
recognition to give your computer speech commands, and how the computer
can use text-to-speech technology to read text and numbers.
• Chapter 7, "Organizing Your Files, Folders, and Disks," for additional
information on managing files, folders, and disks.
• For more information on scripting, AppleScript, and QuicKeys, see
Chapter 15, "Shortcuts."
• For more information on the video capabilities of the Macintosh, see
Chapter 23, "Digital Photography and Desktop Video."

Chapter 15

Shortcuts

Shortcuts enable you to streamline you r Macintosh activities by combining
many actions into one. They also allow you to keep your hands on the keyboard instead of reaching across your desk for the mouse. Using some mouse
and keyboard combinations helps to amplify the capability of point and click
by selectively changing the action that occurs when you point and click.
Macros and scripting can also be powerful worksaving devices. When you
have a routine that you repeat over and over again, a macro allows you to
"record" and then "play back" the seq uence of actions that you've taken. You
do this record activity once, and then you give the sequence a name. You use
this name to set the same sequence of events in motion the next time you're
ready to perform your task.
Scripts are similar in many ways to macros. You combine many steps into a
collection of commands th at perform those steps when certain conditions are
met. You might create a script that dials into your main office every day at
the same time to deliver completed documents and to pick up the day's new
assignments whether or not you're at you r computer in the field office.
Or you might write a script that creates on e type of form letter for 5th-grade
parents, and a different form letter for 5th-grade teachers.
In this chapter, you learn about the following:
• Mouse sho rtcuts
• Keyboard shortcuts
• Finder shortcuts
• Using macros and FKeys
• Using System 7.5 Finder scripting
• Using AppleScript
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Keyboard and Mouse Shortcuts
The Macintosh is known in the collective psyche as "the computer that you
use with a mouse," but in rea lity, you still spend much of your time typing.
When you type, yo ur hands stay over the keyboard (... bear with m e, I know
that's obvious), and when you use the mouse, you still have a free hand that
could be put to good use (A-HA!, see? This could get interesting ... ).
With th e amount of keyboarding and "mousing aroun d" that we inevitably
do every day, adding just a small amount of extra efficiency with keyboard
and m ouse shortcuts can really pay off.

Keyboard Shortcuts
You're blazing away, typing to your heart's content and rus hing to meet an
important deadline. The words just seem to be flowing from your thoughts
directly to the keyboard. Even if you are a two fingered typist, you develop a
certain rhythm and momentum that is easily interrupted if you have to grab
at the mouse across the desk to make a quick menu cho ice to bold the next
few words or to italicize the last few. Keyboard shortcuts enable yo u to work
without this interruption.
Keyboard shortcuts are a combination of keystrokes (usually including one or
mo re of the Shift, Option, ~. or the Control keys in co mbination with other
keys) that allow you to perform an action that wollld otherwise require a
menu selection. Figure 15.1 shows that the Command key ( ~ ), when pressed
at th e same time as theW key (indicated as ~-W) , performs the Close Window Command. This action closes the Working with Windows window
(which, conveniently, is showing a few other helpful keyboard combinations).
Next, figu re 15.2 shows Microsoft Word being used, and the use of keyboard
shortcuts in most Macintosh programs is similar. You choose bold from the
menu, you type unti l you reach the end of the bo ld sectio n, and you then
turn b o ld o ff a t the e n d o f th e phrase.

With a keyboard shortcut, yo u get to keep yo ur hands o n the keyboard, as
follows:
You activate bold by typing ~ -Sh ift-B , you type until you reach the end of
the bold section, and then turn bold off at the end of the phrase by typing
~ -Shift-B again.

Keyboard and Mouse Shortcuts
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Fig. 15.1
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This kind of a command is called a toggle, after the toggle )Witch. When you flip a
toggle switch, it has only two possible states-ON or OFF. The same is true of a
toggle command in a software program. Typing ):(-Shift-B in the previous example
turns bold either off or on at the cursor point, or for the currently selected block of
text.

Fig. 15.2
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also can press ):(Shift-B to select it.
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Explaining this next technique takes much longer than actually doing it. The
power of using these shortcuts may seem minor until some of these commands start to become second nature.
If you're editing a document that already has a name, you press

~-S

to save
your work, and then you can return to typing- just like that. That smoothness alone beats using the mouse when you're entering text from the keyboard.
If you haven't saved the document previously, Word presents you with a
dialog box. The text box for the document name is already highlighted (see
fig. 15.3). Type the name. Notice that the Save button has a double black line
around it-all you have to do to accept the name you typed is press Return.
The entire save operation, including entering characters into a dialog box and
accepting the highlighted Save button, was accomplished without taking
your fingers away from the keyboard.
Fig. 15.3
You could reach
this Save dialog by
selecting File and
then Save with the
mouse, but while
you are typing it is
easier and faster to
type ):(-Sand
accept the
darkened ring
around Save by
pressing Return.
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To print, you can press ~ -P. Figure 15.4 shows the dialog box you get when
you press ~- P . Notice that the number of copies is highlighted. The two
options in this dialog box you will change most often are the number of
copies and the page range (in a multiple page document).
lf you want five copies, after you press :l:t-P, type 5 (see fig. 15.5).

If you also want to print pages 4 through 6 of a 12-page document, just type
Tab-4-Tab-6 (see figs. 15.6 and 15. 7). In either case, the Print button is highlighted. When you're done modifying the print specs, press Return, and your
document will be printed.

Again, this Command involved a dialog box that you had to naviga te
through to get your results-and you didn't need the mouse to do it!
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Fig. 15.5
Type 5 and you
have your desired
number of copies.

Prin t Ncn t File

OeskWr'lter "Desk Writer"
Quality:

-

!?olorSmart se ~

... I

0 Print Back to Front

0

Fig. 15.4
One more example
of how much easier
it is to type a
keyboard shortcut.
Pressing :J:t-P brings
you to this dialog.

Prin t Nent ril e

OeskWr1ter "OeskWrlter"

Quality:

rr-=1

181 Print In Grayscale

Print Back to Front

Section Range: From: I

0

CEQ
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To: 1

Print Nunt l"lte

0

Print Sele ction Only

Fig. 15.6
Tab-4 brings you
across to enter the
starting page
4, (notice that the
selected radio
button moved
down from All in
the last figure to
From in this figure
just because you
typed the number
4 there).

Fig. 15.7
At this point, you
type Tab-6 . The

number 6 ends
your print range at
page 6. You
selected the Print
command and
specified the
number of copies
and the page range
without once
taking your fingers
off the keyboard.
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Although Microsoft Word was used for the preceding examples, most other programs use keyboard shortcuts in a similar way.

When you start using these keyboard shortcuts, fi rst pick a few that you'll use
consciously for a while. Remember how intimidating all the menu choices
seemed at first, until you developed stable Mac habits?
Use ~ -P to print and ~-S to save. Then move on to ~ -X to Cut and ~ -V to
Paste. When you discover the power that using the Shift key with the navigation arrows on your keyboard gives you, there will be no turning back. Try
it-you'll like it.

Mouse Shortcuts
You can use the mouse to select multiple objects (for example, documents on
the desktop or graphic elements in MacDraw) by dragging a selection rectangle around them (see fig. 15.8). If you inadvertently select too many objects, you can click outside the area of the selected objects, which deselects all
the objects, and then try again. Or you can Shift-click the unwanted object
that was selected. The only object that will be deselected will be the object
that you Shift-click.
Fig. 15.8
When you click
and drag across
many icons, you
select all the icons
that fall within
the selection
rectangle.
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Figure 15.9 just might look too fa miliar-all those folders o pen just because
you had to find the folder that was in a folder that was in another folder.
Fig. 15.9
Here is a perfect
example of
open ing a folder to
find the folder that
has the folder
within its folder.

When you're done, you can Option-click in the close box of the last folde r
you opened to make your screen look like figure 15.10.
Fig. 15.10
All it took was o ne
Option-click in the
close box of the
last window that
was opened to
turn the cluttered
desktop in figure
15.9 into this!
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Use Option-double-click on each icon starting from the Boot volume through
each successive folder. When you get to the folder you're looking for, you
will only have that last folder open on your desk (see fig. 15.11). When you
Option-double-click in this manner, each previous window closes when you
open the next one.

Fig. 15.11
This neat looking
desktop is the
result of using
Option-doubleclick to access this
folder.

If you want to work your way back up through the folders, or if you want to

jump directly to one a few levels back, press and hold X and click the active
window's title-then just select the level you want to access (see fig. 15.12).
Fig. 15.12
With one ~ -click
on the folder
name, you can go
directly to any of
the higher folders
with out opening
any others.
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More key combinations such as this one are explained in the Shortcuts window. To view these hints, just select Finder Shortcuts fro m the Balloon Help
menu (see fig. 15.13).
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Fig. 15.13

More than just
balloons are under
the Balloon help
icon.

Using Macros and FKeys
In the Mac realm, FKeys are defined two ways. The first way refer~ to the key
combinations that start with ):(-Shift and the third key held down at the
same time is a number. ~ -Shift-3 puts a screen image on your hard disk in
PICT format, ~ - S hi ft-4 sends a printout to the old Imagewriter printer, and
~ -Shift-1 ejects a floppy d isk.
The second way that FKeys are defined is a carryover from PCs that
have function keys on their keyboards. These function keys can be preprogrammed to perform repetitive tasks at the touch of a key. The Apple
Extended Keyboard has a row of similar keys, but they are generally ignored
by both Apple and commercial program developers.
This setu p allows these extra keys to be used by Macro programs, however.
Macro programs can be thought of as the ultimate in system customization.
Macro programs allow you to auto mate just about any sequence of repetitive
steps so that you can initiate them with one keystroke o r with some other
pre-determined trigger.
An example of a macro program is CE Software's QuicKeys program.
QuicKeys enables you to assign an entire sequence of events to a single key
combination. The sequence can be as simple as opening one fo lder directly
from the Finder that is deeply nested m any folders deep, yet is one that you
access very often during the day.
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Or the sequence can be as complicated as saving your current word processing work on your Great American Novel to your server file, opening
PageMaker and exporting your word processing file into it for complex formatting tasks, and uploading the results to your editor halfway across wherever by modem.
Following is an example of a simple automation task, putting a header at the
top of a ClarisWorks word processing document:
1. Start ClarisWorks and open a new word processing document.

2. Choose QuicKeys from the Apple Menu, as shown in figure 15.14.
When QuicKeys appears, select ClarisWorks from the Sets menu to
define this as a shortcut that will be available whenever you use
ClarisWorks (see fig. 15.15).
Fig. 15.14
The first step in
creating a
QuicKeys Macro is
to select QuicKeys
from the Apple
Menu.
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3. Choose text under the Define menu to show that this will be a text
function (see fig. 15.16).
4. The next screen looks like figure 15.17. Under Text To Type:, type the

text that will be called up every time the assigned keystroke is used.
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Fig. 15.15
Put th is macro in
the ClarisWorks set
by selecting
ClarisWorks fro m
the Set menu.
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Fig. 15.16
The macro wi ll
conta in text.
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5. Still in figure 15.17, type a name for this sequence (in this exa mple, the

name is Header) and type the keystroke that wi ll invoke it (in this example, Contro l-N). Click OK to leave this screen and again to leave the
main QuicKeys screen.
TeHt
Nome:

------l

ILII.:.eo:.:d.:.•:..r

Keystroke:

r
~~H_
t_
to_t~
ypo_:_~---------------, ~
Johnny Rppl eseed
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Seed City, SomeStot e 99999- 0909
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0

Include In OulcKey s menu

[ Cancel )

IC:E:Jl

Fig. 15.17
Type the applicable text in the
Text to Type fields.
Give the macro a
name and put the
cursor in the
Keystro ke box.
Then simultaneously type the
two letter trigger
for the macro
there.
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6. Go back to the ClarisWorks document. In order to be flexible about the
placement of the header, excessive formatting was not recorded into
this macro. In figure 15.1 8, the Insert Header option is selected from
the Format menu, and centered text is selected.

llllmlml

Fig. 15.18
Select the place fo r
the insertion of
the name and
add ress.

Document...
Rulers ...
Col umns ...

Pnrngrnph ...
Tnb ...
{)ICC
{)!iU

Copy Ruler
Rpply Rul er

Scole Selection ...
Insert Brenk
Insert Footnot e {)!Sf

...
Insert Foot er

7. Figure 15.19 shows the result of pressing Control-N.
This header could have been automated way beyond the extent it was in this
example simply by performing more actions. With QuicKeys, you can go
between applications and folders and have all your actions played back quite
accurately.
Fig. 15.19
From now on, no
matter where you
are in ClarisWorks,
simply type the
hvo key code (here
it's Control-N) and
the name and
address appea r at
t he Cursor.
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Recording and Writing AppleScripts
Li ke a macro, AppleScript is a way of saving repetitive steps into a simple
move. In this case, the move is called a script. Think of a play and the actors-how do they know what to do? They follow a script, and so can your
Macin tosh.
The new System 7.5 discs contain everything you need to begin writing
scripts, two of these are the applications Scriptable Text Editor and Script
Editor. The function of each of these is exactly as the name implies. The
Script Editor application is for record ing, saving, running, and editing
scripts- sort of a word processor dedicated to script writi ng.
The Scriptable Text Editor is a word processor-a very small one, but non etheless a word processor. The Scriptable Text Editor is much like TeachText,
another small word processor for writing ReadMe files and such on the
Macintosh.
The major difference between the two is that Scriptable Text Editor is
AppleScript-savvy-you can write scripts that it will follow. TeachText is not
scriptable. That is the one criteria that any application must adhere to in
order for it to understand an AppleScript that you write fur it. It must be
AppleScript-savvy.

Scriptable and Recordable Applications
Applications are not necessarily able to follow a script that you write; they
must be AppleScript-savvy. Many of the newer versions of applications are
ready for AppleScript. QuarkXPress, Adobe products, and others are already
on the market with a version that is able to act out scripts.
There are two levels of AppleScript compliance. The first type is scriptable.
This is an application for which you can write a script. The second type is
recordable. This denotes an application for which you can record a script.
Within these two different script types there are also levels.
Some applications allow scripting to nearly every feature contained within
that application, others already h ave a scripting capability that is altered to
accept AppleScript. With this type of application, you also have to know and
understand the internal scripting of the application as well as AppleScripting.
Scri ptable Text Editor is an example of an application that is both scriptable
and recordable and does not have an internal scripting process that differs
from AppleScri pt.

Ill
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Understanding the Language of AppleScript
If you've worked at all in the different applications of the Macintosh, you
have some idea of how little the d ifferent manufacturers of applications agree
about the way th ings should be done. Just the layout of the menus and the
keyboard shortcuts are a good example. In QuarkXPress, the Style menu is for
changing the attri butes of text, and in Illustrator text is changed in the Text
menu. In QuarkXPress, the keyboard shortcut for changing the view to Fit in
Window is ~ -0, in Illustrator it's ~ -M.
So how do both of these applications interpret AppleScripts in the same way?
They don't. That's where the Dictionary comes in. This is no t th e dictionary
that runs a spelling check on your document, but rather a dictio nary of terms
that a particular application uses in its understanding of AppleScript. Which
words and terms each application understands is completely up to the manufacturer, just as its level of AppleScript recordability or scriptab ility is.
You can view the terms available to you by using the Open Dictionary
command in the File menu of Script Editor, which is covered in upcoming
sections. For now, let's tour Script Editor and find out about writing and
recording scripts.

Recording Simple Scripts
During the installation of System 7.5, you can choose to install the
AppleScript supporting software and documentation (ReadMe files). If you
choose this, you will be installing the applications discussed previouslyScript Editor and Scriptable Text Editor-into a folder called AppleScript
Utilities.
You don' t need the word processor, Scriptable Text Editor, to w rite or record
scripts. It just gives you a place to try out simple scripts while you' re learning.
The documentation has several examples for you to try that are done in this
mini word processor.
Because Scriptable Text Editor is used in later examples, let's tour its window
also. Along with these two applications, a folder called Useful Scripts is installed. This folder contains a few scripts already written that you can use.
Recording an AppleScrlpt
Double-click the Script Editor icon, and the window shown in figure 15.20
appea rs. The upper portion of th e window contains the names o r description
of your scripts as you save them. Below this scrollable list are four buttons:
Record, Stop, Run, and Check Syntax. Record and Stop will begin and end a
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recording session. just as with the buttons on a tape recorder, click Record to
instruct Script Editor to begi n a reco rding session fo r a script. After clicki ng
this button, you perform the steps that you will wa nt to repea t as part of a
script. Click Stop when you fin ish th e steps.
In the following example, you put that to work by creating a small script for
the Scri ptable Text Editor. (Yo u'll need to launch th is app lication fo r t he
example and then m ove both windows side by side to get t he best view of
your progress.)
untitled

tell applteetton "Scriptable Tt.xt £dltor·

Fig. 15.20
Use the application Script Editor
along with its
bu ttons to write
a nd record scripts.

cUvate

aet selection to · rhb h a sample scrfpt ..
tnd ltll

To record a script, follow these steps:
1. Click the upper portio n o f the Script Editor window and type a d escriptive name.
2. Click the Scriptable Text Edito r window to make it active and type a
sen tence.

3. Click Script Editor window to make it active, and click the Record
butto n.
4 . Return to the Scriptable Text Edi tor window and select the third word

of your sentence. Choose Bo ld fro m th e Style menu. Make any additional changes that you would like to incl ude in the script.
5. Click the Sto p butto n in the Scri pt Edito r window.

The comm and s that you record ed are now listed in correct syntax in t he
lower portio n of the Script Edi tor window. Syntax is the structu re with which
a sentence is constructed. A script will on ly operate if it contains pro per syntax. Th is is not a concern if you are recording because the Scrip t Edito r auto matically interprets your moves and records them properly. If you are writing
a scrip t, however, you can use the Check Syntax butto n to ensure that you
have written it correctly.

Ill
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To apply the script that you have written, delete and type a new sentence in
the Scriptable Text Editor window. Return to the Script Editor and click the
Run button. The steps you recorded are applied to the new sentence. You've
completed and applied your first script.
Editing Scripts
YourScript Editor and Scriptable Text Editor windows may look something
like the windows shown in figure 15.21. In this figure, boldface formatting
was added to the third word. If you read the script carefully, you can find
where it states that this will happen. To edit this script, select the word bold
and change it to the word italic. Click the Run button again and watch the
results.

Scriptable Text Editor is a very small and simple-to-use application, but that
doesn't mean you can't write or record scripts for more complex applications.
The simple rules that you've learned here apply to any scriptable or recordable application.
Fig. 15.21
A close look at the
recorded script will
help you to
understand how to
write scripts of
your own.
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Formatting and Identifying the Parts of a Script
The formatting that Script Editor applies to the parts of a script is there to
help you identify each of the component types. You can change the formatting by choosing AppleScript Formatting from the Edit menu. This prompts
the window shown in figure 15.22, where you can edit the formatting by
clicking a line to make a selection and using the Font and Style menus to
choose new attributes. You cannot select single words of your script and
change the formatting; you must make the changes here so that they are
applied globally throughout the script.

There are eight components that are available to use when writing scripts.
Each of these components has a different job. In table 15.1, these components and their functions are listed. Use this table to help you identify the
parts of the script that you recorded. They'll help you even more as you begin
writing scripts.
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Fig. 15.22
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Scripting Terms and Their Functions

Term

Function

New Text

Text added to a script that has not yet been saved, run, or
had its syntax checked. Also text that will not compile or
run due to a syntax error.

Operators

Characters that perform an operation. A + symbols adds,
a - symbol subtracts, and so on. Most operators produce
a result, for instance, 1 +1 (the operator being the plus
symbol) produces the result 2. If you want to view the
results of operators, choose Show Result from the Controls
menu. (The Result window, shown in figure 1 S.23, also is
used to display some error messages, so it's a good
window to have open when writing and recording
scripts.)

Language Keywords

Scripting terms available to all applications that are built
into AppleScript.

Application Keyword

Scripting terms that are available specifically to the
application.

Comments

Descriptive words, phrases, or sentences embedded into
your script that are ignored by the computer and
therefore are not considered when compiling the script.

Values

Characters of information that AppleScript uses.

Variables

Terms (numbers or words) that are used as containers for
values.

References

Phrases used to identify specific objects so that the script
can identify it. For example, word 3 of document 1 is a
reference. References can be pasted into a script by
selecting that object in the source application, copying it,
and pasting it into the script. The reference for the object
appears when you use the paste command (the object
itself does not appear).

The AppleScript
Formatting
w indow allows
you to make global
changes to the
attributes of the
text within a
script.
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Fig. 15.23
The Results
window shows the
results of o perators
but also displays
some error
messages.
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Other applications also have a list of terms that can be used by that particular
application. Each of these terms is ava ilable to you when you write scripts
that will be applied to that application o nly. To view these terms and their
definitions, you need to look at the Dictionary for that applicatio n. While in
Script Editor, choose Open Dictionary from the File menu. This action
prompts the familiar Macintosh dialog box in which you can select a
scriptable application. The dictio nary window fo r that application opens and
from this you can click a term to view its definition. In figure 15.24, the dictionary for QuarkXPress has been opened.
Fig. 15.24
Each scriptable
application has a
dictionary o f terms
that can be used
when writing
scripts for that
application.
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Writing Simple Scripts
Writing an AppleScript is more difficult than recording o ne. With writing
you're actually do ing low-level programming, although some programmers
will have more diffi culty writing scripts than will average users. What progra mmers know that you might not know (if you're not a programmer) is
how to formulate commands, in what order to place commands, and how to
nest commands.
The Check Syntax button is your closest ally in writing usable scri pts, especially for those of you who are new to script writing. When you write a script,
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you attempt to match the type of terminology you saw when you recorded a
script. If you have do ne this correctly and clicked the Ch eck Syntax button,
the steps of the script are formatted and compiled, like those you see on the
left side of figure 15.25.
An improper syntax will leave the text unformatted, like that on the right of
the same figure. A script must be compiled in order to run, but the Run button performs a compile before it applies the script. The first word that does
not follow proper syntax is selected when you press the Check Syntax button.
Replace or delete the highlighted word and press Check Syntax until the
script follows proper syntax and is formatted and compiled. This is your cue
that the syntax is correct. A script containing improper syn tax ca nnot be
saved as a script, only as text.
] Ill
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Saving Scripts
After you have a script, you need to save it. You save a script in the same way
as you save any Macintosh document, but you have three fo rmatting optio ns.
The Save dialog box is shown in figure 15.26. Following are the options: as a
text file (this does not need to have proper syntax or to be compiled but you
do need to hold down the Shift key as you select Save from the File menu), as
a compiled script that can only be opened by Script Editor, or as an application that can be launched on its own like other Macintosh app lications.
When you save a script as an application, you can also choose Stay Open (the
script will remain open after it has been run), or Never Show Startup Screen
(this is a description of the script displayed in a startup screen).

Fig. 15.25
The exa mple o n
the left is of a
script with proper
syntax. The
example on the
right is very
sim ilar, in fact, an
attempt at the
same script. Using
the Check Syntax
button, the first
word in error is
h ighligh ted .
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Fig. 15.26

Use the Save
dialog box to
save a recorded
or written
scripl. Choose the
type of save
method from
the pop-up
menu at the
bottom of the
window.
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Ano ther type of script is a Run-Only Script. These scri pts can be run but no t
opened in Script Edito r. Instead of Save, choose Save As Run-Only from the
File m enu.

Working with Scriptable Finder
Scriptable Finder is an AppleScript-savvy Finder. The first time this became
available was in the AppleScript Developer's Toolkit CD-ROM, but it will be
included in the System 7.5 discs. When you think about exactly what Finder
operalio ns are, you begin to see just a sm all purtiun of the possible power
behind a scriptable Finder. Functions such as copying files to discs, mounting
file servers, making aliases and sorting them, and so o n, are all fu nctions that
you perform m anually by using the Finder. Keepi ng in mind wha t AppleScript can do, think about those steps that you can auto mate.
How about a script that watches a specific folder fo r changes and each time a
file is added or updated wi thin that folder, the Finder automatically logs o n
to a remote file server and backs u p those files? On a g rander scale, wha t
about a script tha t o n a specific day of the mo nth searches for the latest version of a database, opens the documen t, prints labels, opens another document from ano ther application, dumps the current database information into
a mail merge, pri nts statements, and saves the current document with a new
nam e? Or maybe instead of printi ng, it lau nches yo ur interna l fax software
and faxes th e statements to the list of cl ients. Wi th this kind of power it's no
wonder that Apple is encouraging even the passive user of Macintosh to becom e AppleScript aware.
A simple application script that you can write on your own is shown in the
steps below. This script makes an alias of any file you select, then places that
alias inside the Apple Men u items in the System folder. Once the alias has
been placed there you can select it from the Apple Menu to launch the file.

Working with Scriptable Finder
Th is is an exceptionally handy way to launch applications without having to
open several nested folders in search of the application's icon.
To write an application script for your Finder, follow these steps:
1. Double-click the Script Editor icon to launch the Script Editor
application.
2. In the Script Editor window, type:

tell application "Finder'
try
Set thisFile to choose file with prompt "Pick a file to make an
alias of. •
Make alias file with data alias (thisFile) at (folder "Apple Menu
Items " of folder "System Folder" of Startup Disc)
On error ErrText Number ErrNum
If ErrNum is not equal to ·128 then
Beep
Display dialog ErrText buttons {"OK"} default button 1
end if
end try
end tell

3. Go to the File menu and choose Save As. Type a name for the script in
the name field.
4. Choose Application from the Kind pop-up menu. This makes an application o ut of the script you just wrote.
5. Click the Never Show Startup Screen checkbox. This will keep the script
from sh owing an icon when you start your computer.

6 . Choose Desktop as a destination so that you are saving the script loose
on your desktop. (Don't place it in a folder where you' ll have to go
searching for it.)
7. Click the Save button.
8. Choose Quit from the File menu.
Your script is now ready to run. If you double-click the script you will receive
the message surrounded by quotation marks in line three of the script. This
instructs you to click on a file which you wa nt to make an alias of.
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If there is an erro r, fo r any reason, and the Macin tosh iden tifies that error as

a -128 error, you will receive a warning dialog box along with a beep and an
OK butto n to click.
If you're serious abo ut wa nting to write scri pts, th e documentation on the

System 7.5 disks can get you started. The more complex the task, the more
complex the AppleScript wi ll be. Use the documentation and try out the examples. They are designed to introduce you slowly to the co ncept of total automation, but AppleScripting for application s will take some time to master. Try
creating sim ple scripts for printing series of pages or some other fairly easy task,
and then you' ll learn about the syntax through trial and error, and become a
better program mer.

From Here ...
In th is chapter, we've covered a lot of ground! We've gone from maneuvering
around complicated menus and d ialog boxes without using the mouse, to
simple macro automation and the QuicKeys application.
By the time we fini shed th is chapter we used AppleScript fo r low level programming at the system level to take control of the Finder. The system
customiza tion possibilities are o nly bounded by your determ ination and imagination.
To supplement the preceding discussion of task automation in genera l, and the
impact of System 7.5 and AppleScript with the Scriptable f inder in particular,
refer to the fo llowing chapters:
• Chapter 3, "Mac Interface Philosophy."
• Chapter 9, "Sharing Data with Other Applicatio ns."
• Chapters 33- 36, Part VI, "The Mac at Wo rk. "

oy Small I con
./by Icon
by Neme

~rt

E~ Continue'

by Size
by Kmd

IV

~

dJ

by Label

b Date

Su :tem F,_ ldt>t-

Ma~intos
~software
Apple E:! tr

WtHtmg

II

Avnnt'i::utt

Bllo~

flt•dlllfHHdo

OookllhltllU~

At•nnHi,ud~ U~nH

flllenthmdo DeuuflhiHJU"
Bookman UeH•t
Uno} moll Ol•rr•tll,lll
Bt>Ot'lllul\ ! iql
Rttukmun lt:il'fl
' .L.w..
• -----~...!...!:._.!..:....__ __.!.____!__ _=======~
t nunr.•

16 Word Processing
17 Presentation Graphics
18 Spreadsheets
19 Databases
,.r,-

20 Integrated Software Pulls It All Together
21

Desktop Publishing

22 Drawing and Painting
23 Digital Photography and Desktop Video
24 Using CD-ROM Drives and Software
25 Utilities
26 Personal and Business Management
27 Games and Education

I. Set Print
ter 11-Pr inting

uy
·,---; - -

Macintosh

i._j:

14 items

HD - -- --

./by Icon
by Name
by Size
by Kind
by Label
by Date
PrintMonitor

-[Jl.

nContinue~

109.8 t"'18 avan3b

122.1 M8 in dt.d\

..;}

Lrll

~-"'-"

D

Fold~r

System

--

\'lord 5 1

'-

.

D

I

r
I
.I

c11!11P.'f

1••

...

I ll dL L·

GPI Info
ShMtng ...

.

llc-~1

1C

I

ll

1 Make lllios
I
Put fiWOIJ

v

L·':1 :>l?r\ ."ri 1

1•1J

---------

l

>:(,

I

.

i

SC!'lPI!'~t'
.... l

.

~C'hrtl ...
Oe.~ld 011 ...

o-

1~1
"" 'F• .. "'
..

I Pt1ge

L Pnnt

'

A"
~

.

.
..

Hote I Service-;;

... "'"""

-

.- --- - -

1 2 t18 m di:k

~et

r-;-;!---'

'!!'

l/6~~

Apple HD SC Seup

1)1:~ Fir~

I Atd

flc.l
>
'"'

'

I

1ant.dr~.,

-

.-·

l

......

I"JTI

~

t

I

."

.-~

'"
I

...

:

'· '"'''
,.,.,,., t'

'

.-

) l!.!:eumus
) [

r

~1

h'h

,,'1111 • .

,

...'·

NeHt

ITJ

1:.

'

g-.

r'f.'ll·f'

Tr , ·,
'.t

..

"

[]1·'"' Ill

- 1._ Cancel

.~

j

f

't

..

I

I

·~

Prin

1291' av<nlsble

~
c-J

Clli

tl ...... "'f1l0._.

tl""· a-.

Disk Tools

3 items

~

difioa~·l ~t!'wl. tt

-

.__-=-~~}~~
-,--.,._-~ :-_~~--

;;(~port .llttl J\: r:rr.~Uorr

;!'., dio \t1~Htl

l

I

Stetus: prepanng ,jata

System Folder

· trl,

Cancel Printing

Printing Statu\: Chapter 11 -Printing
Peges To Pnnt. 8

~r

Fiml ...

I Ftn!l flgain

•

1 1-Pnr!l.t•ll;!

:,

(lJ!'<o.JI•

I

-

We!:·m~t

~ cj·,ep~.er

l

r I r• l

~

• I!'~·P. t.•.:

-

.0

llPPn

i rr•

I

•

-

I

BllOkmt:3n Ocmllt.lJI(
ltr·~t

-

~fulller "'"

-

-

Ri.t~ntGMdJ• Do:·kflhh ,•J(I
8 thlfttL'uoo Uc1n1
8 unntOanJt! llcmiOhHqua•
0 ·"Dkm .:J!l Dcnu

nlot:tntw

-

Waiting

ii:•nu1Ganl" u;nJk

8 Jot.n:~"l

~

Printmg

Apple Ex'lr.as

¢1

.

-~..J·

;)tnttll lt;Uii

-

Chapter 16
•

Word Proc s1n
by Gene Steinberg

First, there was a typewriter. To correct what you typed, you used an eraser or
one of those messy cover-up liquids. To move text from one place or another
and avoid the fuss and muss, you just started over again.
The arrival of personal computers brought something new to the process of
preparing your documents: a word processor. In the beginning, you'd use a
word processing program simply to edit text and maybe move it around to a
different location in your document. As personal computers grew more
sophisticated, word processing software also received more sophisticated
document processing capabilities. You were offered a host of choices in areas
of document formatting, text formatting, style tags, spell checking, and
other features.
In addition to document handling chores, high-end word processing software
can now also handle tasks such as mail merge and outlining with aplomb.
There are macro capabilities, highly sophisticated search-and-replace capabilities, and elaborate equation and table creation tools. Some of the software
discussed in this chapter adds support for Apple's PowerTalk, QuickTime, and
other fancy system tools.
If you intend to do some desktop publishing work, you just might find that
one of these programs we're about to discuss will be more than up to the task
as well. Such features as kerning and hyphenation and justification settings,
which were once confined to desktop publishing software, can now be found
in word processing programs.

If you just want to write a few letters and other simply formatted documents,
it's quite possible the programs' profiles in this chapter will provide more
flexibility than you need. A program like WordStar's WriteNow, which has
modest RAM and storage space needs, is apt to fill the bill. But if you want to
have a wide range of document creation tools at your disposal, read on.
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In this chapter you learn the following:
• The important features of four major Mac word processing programs
• The best word processing program for the kind of work you do
• Exclusive, hands-on tips and tricks that you won't find in the typical
software manual

Using Claris MacWrite Pro 1.5
MacWrite Pro, from Apple's Claris subsidiary, has a heritage that can be
traced back to that free word processor that shipped with your first
Macintosh in 1984. The program has undergone extensive revision since
then, and, like the other word processors discussed in this chapter, it has
become larger and mo re feature-laden. But it's remained true to its o riginal
purpose as a simple-to-use, no-nonsense product. Hardware, RAM, and storage requirements remain modest, and anything from a Mac Classic on should
run MacWrite Pro without difficulty.

System Requirements
MacWrite Pro's software and hardware needs are modest. It will work on a
Mac Classic or later, with 1MB of RAM under System 6 and 2.SMB RAM for
System 7. The installation will take around 3.SMB of storage space on your
Mac's hard drive.

MacWrite Pro Overview
MacWrite Pro is priced at about half what the other word processors we're
describing in this chapter go for. It offers a simple, accessible interface, with
three floating palettes offering tools for more sophisticated chores. Beneath
its uncluttered work area, however, are such advanced capabilities as
character-based style sheets, table of contents generation, and support for
such fea tures as AppleScript, PowerTalk, and QuickTime.

Using MacWrite Pro's Document Settings
When you first open MacWrite Pro, a blank document window appears onscreen (see fig. 16.1). Simple character formatting is available from the m enu
bar. You don't have to navigate through multiple dialog boxes.
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Fig. 16.1
Back to the basics:
MacWrite Pro's
si mple work
environment.
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Changing document margins is a matter of holding down the Option key
and selecting and d ragging one of the four page guides. The pointer tu rns
into a double-sided arrow, and as you d rag the margins back and fo rth, the
status display bar at the bo ttom of your document window registers the
changes. You can change the margin settings faste r still by opening the Docum ent dialog box fro m th e Format menu, shown in figure 16.2.
Document
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Setting up multiple-colum n docum ents can be done in two ways. The easiest
method is just to click the column button at the bottom righ t of the ruler bar,
as done in figure 16.3. You click the double-column icon to increase th e
number of columns, and you click the single-column icon to decrease the
number of columns.

Fig. 16.2
Changing
document margins
can be done by
Option-cl icking
and dragging page
gu ides, or th rough
th is d ialog box.
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Fig. 16.3
A single click on
the appropriate
column icon can
add to o r decrease
the n umber of
columns in your
document.
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If equally sized columns don't suit your job, you can double-click the number
displayed in the column button to display the dialog box shown in figure
16.4. You can use this dialog box to specify a separate width for each column.
Fig. 16.4
Setting up uneven
column w idths in
your MacWrite Pro
document.
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The setting at the left of the Columns window is a useful tool fo r creating
long documents with multiple section s. You can begin a new section in the
middle of a page or insert a page break to have the section start on another
page. Custom page numbering can be set up with this dialog box as well.

Each page in your MacWrite Pro document can have a different number of columns.
This is useful when you're preparing complex reports and newsletters.

Using Claris MacWrite Pro 1.5

363

Using MacWrite Pro's Text Palette

IV

Text fo rmatting can be do ne in several ways in MacWrite Pro, but the easiest
way is to use the Text palette, shown in figure 16.5. Typeface and size can be
selected from pop-up menus. The twin arrows at the bottom of the palette
enable you to increase or reduce space between selected text by em units.
This is MacWrite Pro's meth od of establishing tracking (or range kerning) to
im prove letter spacing.
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Fig. 16.5
MacWritc Pro's
ha ndy Text
pa lette.
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Using MacWrite Pro's Character and Paragraph
Styles
Style sheets in MacWrite Pro can be set up on both the character and paragraph levels. This is useful if you want to apply local fo rmatting to a paragraph, such as using italic or bold fo r emphasis. You can edit your paragraph
styles using the handy Styles palette, shown in figure 16.6.
Fig. 16.6
Convenient pulldown menus allow
you to edit style
sheets right from
the Styles pa lette.

To create a style based on your ex isting text, you click the File menu of the
Styles palette and choose the New Paragraph Style option. You are asked to
confirm your new style, which is then added to the palette. To modify the
style, hold d own the Option key and click the Style nam e, which displays the
d ialog box shown in figure 16.7.
A style can be specified as character- o r paragraph-based. Each character or
paragraph attribute can be customi zed to your requirements. To apply a style,
click anywhere in the paragraph where you want to apply the style and then
select the style name fro m the Styles palette. It takes effect immediately.
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Define St tes

Fig. 16.7
Editing paragraph
styles is easy in
MacWrite Pro .
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Styles can be imported from another MacWrite Pro document by choosing Open
Custom Styles from the File menu of the Styles palette. You then select the document
from which you want to copy the styles, and they are added to your document.

Using MacWrite Pro's Tools Palette
Most of your basic document and paragraph formatting tasks can be done
using th e simple commands in MacWrite Pro's menu bar o r from the Text
and Styles palette. But you have additional choices available from the Tools
palette, shown in figure 16.8.
Fig. 16.8
MacWrite Pro's
Tools pa le tte.

The following sections discuss the purpose of each tool, from left to right.
Selection Tool

This tool is the tool that's active when you do most of your work in
MacWrite Pro.
Text Tool

This tool is used to create a custom text frame in yo ur document. After you
click the Text tool, you drag the frame across your page and use the status bar
at the bottom left of the document window for accurate size information .
This text frame is unancho red, so the text won't flow automatically from
page to page (which is what normally happens with your standard page
columns) .
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Picture Tool

This tool is used to create an unanchored picture frame (i n the same manner
as you create a text fram e), which you use to import illustratio ns from o ther
programs without actually inserting them into the text. MacWrite Pro imports pictures created in the standard fo rmats, such as EPS, PICT, and TIFF.
Movie Tool

Use th is tool to create an unancho red movie frame, which you can use to
import QuickTime movies.
Note Tool

Create post- it notes in an y portion of your document with this tool. You
create a note by clicking this tool and dragging across your document page to
the desired length and width of your post-it note. You can enter text inside
the note frame in the same way that you enter text in any other part of you r
document.
Table Tool

This tool is used to create a table in your document. W hen th is tool is selected, the Insert Table window appears and allows the user to specify the
number of columns and rows for the new table.
Other Tools

The remaining tools in th e Tools pa lette are used to create fills and lines and
to select fi ll patterns.

Using MacWrite Pro's One-Step Tables
There are two ways to create tables in MacWrite Pro, depending whether you
want to convert existing data to ta ble form, or build on e from scratch. In the
first case, if you've got tab-delimited tex t (text with tabs that are used to separate fields), select the text you wa nt to convert to table form and choose Insert Table from the Frame Menu, which opens the dialog box shown in figure
16.9. You can also build a table fro m scratch and enter the appropriate number of columns and rows in the Insert Table dialog box (or by using the Table
Tool discussed below).
As you change the table formatting, the graphical display in the window
changes to match your changes. You ca n also specify the column width,
although this can be changed later on by selecting the table and dragging the
handles.

IV
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Fig. 16.9

Insert Tobie

MacWrite Pro's
Insert Table
window.
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Tables can also be constructed by clicking the Table tool from the Tools palette and dragging across your document page. After you define the borders of
your table and release the mouse, a dialog box appears asking you to define
the number of columns and rows in your table.

Using MacWrite Pro's Spell Checker and
Thesaurus
MacWrite Pro offers two ways to spell-check your documents. You can perform the usual batch spell-check of your document after you finish working
on it. Or you can turn on interactive spell-checking, which flags possible
spelling mistakes as you type, either by a beep or a flashing menu bar (you
make the setting as part of the application's Preferences).

Claris offers optional spell-checking dictionaries in French, Spanish, German, and
British English, which can be selected separately for custom spell-checking after
installation.

MacWrite Pro's Thesaurus helps you find an alternative for a selected word
(see fig. 16.10).
Fig. 16.10
MacWrite Pro's
Thesaurus in
action.

Word Flndere Thesaurus
thesauru:s:

noun
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You can select one of the choices made by the Thesaurus, and it replaces the
selected word in your document.
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Using MacWrite Pro's Find and Replace
MacWrite Pro's Find/Change dia log box, shown fully configured in figure
16.11, can be used simply to replace one text string with another. If you
check the Use Attributes check box, as shown in the figure, you also can
change character styles by checking the appropriate boxes.
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Fig. 16.11
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In addi tio n to searching fo r text and character-based styles, you can use wild
cards to search for a character combination with unknown letters. You can
also search for invisible characters, which commo nly represent formatting
commands such as tabs and paragraph returns. Although very flexible,
MacWrite Pro doesn't go quite as far in its Find/Change capabilities as Nisus
Writer, discussed later in th is chapter.

MacWrite Pro's Advanced Features
MacWrite Pro may be modest in its RAM and disk storage req ui rements, and
simple to use, but it doesn't prevent the program from offering some heavyduty options to riva l those fou nd in the more expen sive products discussed
later in this chapter. Following are just a few of those features:

• Automatic text wrap. You can create sophisti cated document layouts by
havi ng text wrap around a picture frame. The frame can contain simple
shapes or even irregular o bjects, and you can control the spacing (offset) fro m the illustration to the text.
• Zoomi11g. You can change your document view from 25% to 400%, and
retain fu ll document editing capabilities.
• Notes. We referred to MacWrite Pro's handy post-it notes earlier in this
chapter in our discussion of the convenient Tools palette. lf your Mac
has a microphone, you can also record a message as part of your no tes.

MacWri te Pro's
Find/Change
dialog box .
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• PowerTalk. ff you have Apple's PowerTalk program, which is part of

System 7 Pro or System 7.5, you can write and send e-mail directly
through MacWrite Pro.
• Table of Contents Generation. You can generate a Table of Contents list

by defining paragraph styles as a TOC Style. Any text that has these
styles applied to it can be used to generate your Table of Contents.
•

Fig. 16.12
Hyphenation and
justification
settings in
MacWrite Pro.

Hyphellation/justification settings. As with a desktop publishing program,
you can adjust hyphenation and justification settings by using the
program's Preferences (shown in fig. 16.12). You can specify the number of hyphens allowed in a row and define the n umber of letters befo re
and after a hyphen.
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• Add-It. MacWrite Pro's Add-rt feature makes the program fu lly exten-

sible, very much like some of the desktop publishing programs discussed in Chapter 21. Out of the box, MacWrite Pro incl udes Add-It
modules to play QuickTime movies, add sound to your post-it notes,
and provide table-creation capability.

Getting the Most out of MacWrite Pro: Hot Tips
• increasing Screen Size. To increase your screen real estate, yo u can col-

lapse th e floating palettes by clicking in the Close box. The palette is
reduced to its title bar. A second click expands it to its normal size.
• Changing Application Defaults. You can change your application settings

by fo rmatting a new document and saving it in MacWrite Pro Options
format in the Save As dialog box (you store it in the Claris Folder, inside
your System Folder). After this settings document is prepared, the formatting attributes in that document become a part of each new document you create in MacWrite Pro.

Using Claris MacWrite Pro 1.5

• Keyboard Equivalents. You can display keyboard equivalents in a dialog
box by pressing and holding :7:1:.
• Merge Data Files. If you have a Merge Data File (MDF) opened, you can't
also open this file in the usual way, using the Open command from the
File menu. You get a This file already open alert. To open this file,
you must first close it (by using the Merge palette's Close button or by
closing, rather than collapsing, the Merge Palette) before being able to
reopen it as a standard file.
• Overflow Symbol. You may accidentally overflow a frame (for example, if
you have a text or table frame, and then change the column dimensions, which produces an overflowed frame display). In some cases, the
on ly way to get this "lost" data back is to increase the page size so that
it's large enough to accommodate the overflowed frame. The easiest
way to do this is to include the Scale value in the Page Setup dialog box
(such as 25%).
• Perfomwnce. You can speed up MacWrite's screen display noticeably by
selecting the Hide Pictures feature.
• Low memory. If a rectangle appears on-screen when you try to move an
image, it may indicate that you're running out of application memory.
You can assign additional memory to MacWrite Pro by quitting the
program, highlighting the application icon, selecting Get Info from the
Finder's File menu, and increasing its RAM allocation.
• Show/Hide invisibles. Using this option, as well as changing the view
scale up or down, causes a screen refresh, and your document is
reflowed correctly.
• Text Wrap. To flow text around graphics, you need to set your wrap
frame to transparent. You can set transparency by using the Tools palette or the Modify Frames dialog box.
• Styles. There are four predefined paragraph styles that cannot be removed. These are Header, Footer, Footnote, and Default. There are two
predefined character styles, Footnote Marker in the body of the text
(Superior), and the Footnote Reference Marker (Helvetica, 10 pt, Superior).

Summary
The real charm of MacWrite has been ease of use and an uncluttered working
environment. Without falling prey to the software glut that often occurs
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when you add new features, MacWri te Pro manages to offer most of the capabilities you'd wa nt in a word processing program.

Using Microsoft Word 6
What do you do for an encore wh en you have the best-selling word processing program? In Word 6.0 for the Maci ntosh, Microsoft added fea tures that
help automa te almost every element of the document formatting process. By
letting the program figure o ut many of the steps for you, you're able to get up
to speed quickly. In addition, they've taken existing feat ures and added expanded ca pabilities. Feature for feature, it's hard to find a single program that
does more than Word, but as they say, there's no free ride.

System Requirements
Word 6.0 is in many respects identical to its Windows counterpart, and it
exacts a high price in terms of CPU horsepower, RAM, and storage requiremen ts. Word 6.0 requires a 68020 Mac o r faste r, with 5 to 8MB of installed
RAM, running System 7.0 o r later. The program's Installer gives you several
options for how well-equipped you want your copy of Word to be. If you
choose to install everything, expect to use over 19MB of hard drive space.

Overview of Microsoft Word
If you're familiar with Word 6.0 for Windows, you'll be very m uch at home

with the Macintosh version. The basic interface and features are n early the
same, but specific Mac fea tures such as AppleScrip t, AOCE (PowerTalk), and
Publish and Subscribe are added. If you've used previous Mac versions of
Word, yo u'll find that many of your favorite features appear here in new
settings, and the look and feel of the program is different as well. You'll probably want to spend a little time getti ng used to the program before producing
any heavy-duty pro jects.

Using Wizards
When you create a new documen t, Word offers you a unique option, a Wizard. It's a featu re that allows the program to gui de you step by step through
the process of for matting your docum ent. You 'll be presented with a list of
available wizard templates when you select New from the File menu or press
:Fe-N. If you choose a wizard te mplate, you'll be taken th rough a procession of
d ialog boxes asking you the sort of document you wa nt to create and guiding
you th rough the basic for matting steps. You can opt to use an existing template, or just create a blank document, and format it to your taste.

Using Microsoft Word 6
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In keeping with its goal of letting the software figure things o ut for you as
much as possible, Word 6.0 offers an AutoFormat feature, shown in figure
16.13. By selecting AutoFormat from the Fo rmat menu, you' ll be able to apply a complete set of forma ts to your document.
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Changing your
preset fo rmats
with Microsoft
Word is easy.
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The formats themselves are actually defined in Word's Style Gallery, shown
in figure 16. 14. You can view a display of what a style looks like by choosing
the name of the style.
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Using Word's Toolbars
You can activate most functions in Word by using the menu bar or keyboard
command, or by using its wide selectio n of floating toolbars, each labeled by
fu nction. Word 6.0 offers a grand total of ten too lbars. You can move and

Fig. 16.14
Word's Style
Gallery contains a
set of standard and
user-defined style
sheets.
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reshape them individually or even add them to the top or bottom of your
document window. Figu re 16.15 shows all the toolbars, which, as you can
see, might result in quite a crowded screen if you don't use them judiciously.

Fig. 16.15
All of Word's
standard toolbars
in action.
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In addition to using the standard toolbar sets, you can customize the appearance of each toolbar by selecting whether to display color icons or large
icons. If you hold down the :J::C key and select a toolbar icon, you can drag it
to another toolbar. You can also modify or create your own toolbars fro m a
display of standard Word command icons. This allows you to gain easy access
to your frequently used com mands and features.

Formatting Documents
Before you enter text in your document, you'll want to use the Document
Layout dialog box (from the File menu) to establish page margins, as shown
in figure 16.16 below. You can set the positioning of headers and footers, and
with the Layout sheet, set custom layouts for the first page of your document.
(This dialog box may be slightly different under System 7.5.)

Using Microsoft Word 6
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Fig. 16.16
Setting the layout
of your Word
document.

The Page Setup button at the lower right of the Document Layout dialog box
is used for your standard Macintosh printer setup. Chapter 10, "The Printing
Chapter," describes Macintosh printer settings in more detail.

Formatting Columns
Your Word 6.0 document can have a single column (whic h is standard), or
you can create multiple columns, each with d ifferent wid ths depend ing on
the needs of your project. Figure 16. 17 shows the Columns dia log box.
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By unchecking the Equal Column Width option, as done in the example, you
can define each column separately, plus the amount of space between that
column and the next one. The Preview area at the lower right of the Colu mns
setup box gives you an idea of what your finished layout will look like before
you click OK.

Using Word's Fonts Menu
One thing that wi ll be missing at first glance is a conventional Mac Font
m enu. You can change fonts from the Format toolbar, or choose Font from
the Format menu, which brings up the dia log box shown in figure 16. 18.

Fig. 16.1 7
Formatting a
multiple colum n
document made
easy in Word 6.0.
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Font

Fig. 16.18
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The Font dialog box in Word closely matches the o ne you get in the Windows version of the program. Yo u use it to select basic character formatt ing
such as size, style, and colo r. That little file folder beh ind the Font file folder,
named Character Spacing, allows you to turn on automatic pair kerning,
which enhances the look of your documents.

Multiple Undos
Multiple Undos represents an idea that's been long in coming, which only a
few Mac software products support. You can undo a single action, or, if you
prefer, multiple actio ns, simply by repeatedly selecting the Undo command
from the File menu. In this chapter, the only other word processor discussed
that has a comparable capability is Nisus Writer.

Using AutoCorrect
Word's AutoCorrect utility is not an interactive spell checker like the o ne you
find in MacWrite Pro. Instead, it's a feature that stores your common misspellings, and corrects them o n the fly. Yo u can enter the m istakes you make
most frequently, such as hte fo r the in the example dialog box shown in figure
16.19 .

As soon as you m ake a spelling error-o r at least one you've already defined
in the AutoCorrect setup box-the program intercepts those keystrokes and
inserts the correct ones. It can also be used to insert frequently used text
simply by inserting a sho rtcut to the correct text string.
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Fig. 16.19
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Using Word's Table Editor
Word has an advanced table editing tool that allows you to build your tables
simply by spelling out the number of columns and rows. Or you can use the
program's Table AutoFormat feature, which allows you to choose the kind of
table you wan t from a selected group of templates. Figure 16.20 shows how
the Table Editor works.
Fig. 16.20
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You can choose from a list of templates and preview the table format before
you use it. Or you can take an existing table and modify it to your preferences. You can change such attributes as fonts, borders, shading, and color.
Wh en you select or deselect one or more of these formats, you'll see the preview area change to reflect your selection.

Using Word's Revisions Feature
Large documents are quite often a group effort. That means there are likely to
be a number of versions to a single document before it's actually printed.
Word has a Revision Marks feature that allows you to see who changed what
and when so that changes can be easily tracked (see fig. 16.21).

Word's Table
AutoFormat dialog
box helps you
format a complex
table in seconds.
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Fig. 16.21
Using Word's
Revision Marks
feature enables
you to track the
change history of
your document.
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By turning on Revision Marks, you' ll be able to review suggested changes in
your document and then either accept or delete them separately, or accept or
delete the entire set of changes as your needs require. You can also compare
one version of a document with another to check for differences. The Options button at the lower right of the Revision Marks dialog box shown in
figure 16.21 enables you to select another document for comparison.

Using Word's Drawing Tools
The rather weak drawing tools of Word 5 have been replaced with a Mac
version of Microsoft Draw, the standard Windows drawing program. You can
now put a drawing on any of three graphic layers-first, as part of the document so that text will run around it, second, as an overlay to your document,
and third as a watermark (a backdrop that appears on your document pages).
As shown in figure 16.22, you get a pretty decent selection of drawing tools.
Fig. 16.22
Word's d rawing
tools.
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Word won't replace a high-end drawing program, but it offers basic shapes,
including polygons, tools to insert callouts, layeri ng, grouping, rotating, reshaping free hand or polygon shapes, and a tool to align one object to another, or a selected object to a page. With a little effort, you can probably use
these tools to create many pleasing illustrations without ever leaving the
program.

Using Drop Caps
Adding drop caps to your document provides a fancy look, and Word 6.0
provides a quick, automatic tool to generate them. You just choose Drop
Caps from the Format menu and enter the style information (see fig. 16.23).

Using Microsoft Word 6

Fig. 16.23
Word's Drop Cap
dialog box.
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To insert a drop cap in your paragraph, highlight the first letter in a paragraph, open the Drop Cap d ialog box and select the kind of drop cap you
want from the display in the Drop Cap dialog box. Then specify the typeface,
the number of lines it occupi es, and the space fro m the body text. The drop
cap takes effect as soon as you choose OK.

Word's Advanced Features
Word 6.0 is a major upgrade to the program and adds many new features,
and changes or improves on other features. Following are some of its m o re
advanced capabilities:
• A Mail Merge Helper offers you a series of dialog boxes to guide you
through the process of merging your address list into form letters,
envelopes, o r labels.
• You can add an item in your document to an index simply by highlighting the text and identifying o r marking it for incl usion in the completed table of contents. You make the selection from the Mark Index
Entry dialog box, shown in figure 16.24, which is available from the
Inse rt menu when you select Index and Tables. A table of contents can
be generated based on custom entri es, or by using your existing styles
fo r headlines and subheads.
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Fig. 16.24
Word's index
generation tools
offer you exceptional flexibility.
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• The movable Microsoft toolbar allows you to quickly launch another
installed Microsoft program, such as Excel, simply by clicking the appropriate icon. When you quit that program, you're returned automatically to Word.
• Word 6.0 allows you to create professional quality form s for invoices
and reports.
• Word 6.0's Macro creation feature allows you to record the actions you
perform over and over again, and have the program repeat those steps
via simple keyboard commands. You can use a macro to format a document, enter predefined information in a form, or build an index or
table of contents-just to name a few of the possibilities you'll want to
explore.
• Choose Objects from the Insert menu to open Word's advanced Equation editor to build equations from scratch, or Microsoft Graph, a
handy charting tool. The Object dialog box is shown in figure 16.25.
You can also import QuickTime movies into your Word document and
play them as part of a presentation. (You have to have Apple's
QuickTime installed on your computer, however.)

Fig. 16.25
The Object dialog
box introduces
you to other
handy Word
features.
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Getting the Most out of Microsoft Word: Hot Tips
• To search and replace fonts (without altering text), use the Replace
command in the Edit menu, or type ;):(-H.
• If you've removed the formatting toolbar to save screen space, you can
still change fonts by typing ~ -Shift-0, which opens the font dialog
box.
• You can activate automatic pair kerning in Word 6.0 by selecting the
Kerning for Fonts option in the Font dialog box, under Character
Spacing.

Using Nisus Writer 4
• If you decide to create a shaded background for a paragraph, be sure to
test whether the text is readable or not. You might want to print a
sample page just to be certain before proceeding with similar shading
on a large d ocum ent.
• Use templates if you plan to use the same styles over and over again for
regular projects, such as books or newsletters.
• Use the Replace commanu in the Edit menu to delete text that has been
formatted with a particular style. When you bring up the Replace window, pick from the list shown in the Format menu under Style the
name of the style of the text you want to remove. The Replace box
should be left blank. Click the Find Next button. If the text you wa nt to
remove appears, choose Replace and it's gone!
• To quickly bring up the Document Layout dialog box, double-click the
gray area between your document page and the vertical ruler.
• You can use the Bullets and Numbering dialog box (in the Format
menu) to create formats for bulleted or numbered lists in your document. Word's handy Sort feature allows you to fix the o rder of numbered items if you move them out of sequence.

Summary
With Word 6, Microsoft fulfilled almost anyone's wish list for what should be
in a word processing program. It's not surprising that Word has been the
number one Mac word processor year after year. And if you work in a mixedplatform environment, with Windows PCs working next to Macs, you' ll be
happy to know that the Mac and Windows versions of Word are nearly identical in most respects, and you can switch from one to the other with little or
no training at all.

Using Nisus Writer 4
Nisus owes its origins to a text editing utility called QUED, which was first
introduced in 1987. The program provided text editing tools primarily for
programmers. In 1989, the text engine was incorporated with a graphics layer
and other features were added to create a new all-purpose word processor
known as Nisus Writer. Beginning with version 2.0, Nisus was localized (configured) for international markets and was also sold in such countries as Germany, France, japan, and Korea. By version 3.0, the program shipped to such
diverse locales as Bulgaria, Hungary, Poland, Romania, Russia, and Saudi
Arabia.
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System Requirements
Nisus Writer works on an y Mac running System 6.0.7 o r later, with 2MB or
mo re of installed RAM. The full package uses approximately 6.SMB of hard
disk storage space.

Nisus Writer Overview
Nisus Writer 4 is the latest update of a p rogram with o ne of the most full.featured text editing engi nes you can find among word p rocessing software
products. Not only is there extensive support for multiple language editions,
but the program offers highly sophisticated search /replace tools, drag-anddrop text, macros, multiple clipboards, unlimited undos, and noncontiguous
selection. The following sections discuss some of these features and more.

Using Nisus Writer's Paragraph Rulers
Basic formatting in your Nisus Writer document is done by changing the
settings on the paragraph rul er (see fig. 16.26). Copying the ruler settings to
another part of your document where different formatting is being used wi ll
transfer the formatting of that ruler. The ruler's basic setup is similar to o ther
.\1ac word processing programs: if you drag the arrows representing your page
margins to the right or left, t he margins on your page will change accordingly. If you drag just th e bottom part of the left margin arrow to the left or
right, you can set the indent for the first line of a paragraph.
Fig. 16.26

Nisus Writer uses a
paragraph ruler for
basic document
formatting.
The other settings in t he Nisus Writer ruler control tab stops, justification,
line spacing, and paragraph spacing. The new versio n of Nisus Writer also
adds t he option o f nam ing your rul er, as shown in figure 16.27. After the
ruler is named, it appea rs in a pop-up menu at t he left of the ruler bar, and
you can use this feature to quickly change paragrap h fo rmatting.
Fig. 16.27
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Document layout settings are adjusted in the Layout window, shown in figure 16.28. The page icons to the left of the window are used to choose between a normal page and facing pages. The latter setting allows you to view
your document as a spread, with both the lefthand and righthand pages onscreen.
Fig. 16.28
Cha nging your
document layout
with Nisus Writer's
Layout window.

The numerical settings to the righ t of th e page icons are used to set paper size
and the margi ns for your text area. The icon at the right of these margin
settings allows you to automatically center your text margi ns within a page
(or you can choose Center Page from the Layout menu, wh ich only appea rs
when the Layout window is open). The icon with arrows poi n ting outward
allows you to automa tically expand page margi ns to th e maximum area that
your printer allows.
A convenient way to set up multiple columns is to use the Set Margins and
Columns djaJog box, shown in figure 16.29 . You can activate this window by
double-clickjng anywhere inside the Layout bar o r by ch oosing Set Margins
from the Layout menu.
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You can also set your page margins visually by clicking and dragging along
the dotted Jines that define the margins. Up to eight margi ns of equal width
can be created in your document.

Fig. 16.29
Nisus Writer's Set
Margins and
Columns window
allows you to
quickly customize
your document
setup.
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Using Nisus Writer's Graphics Palette
As I said previously in this chapter, don't expect a word processor's drawing
tools to replace those of a high-end illustration program. Even within their
limits, however, I've seen some well-constructed artwork. You bring up the
graphics window simply by clicking the Show Graphics Palette icon (a stylized drawing) at the right side of your document window. Nisus Writer's
Graphics palette, shown in figure 16.30, can also be used to edit PICT files
imported into your docum ent.
Selection

Arrow

Text

Fig. 16.30
A basic set of
drawing tools for
Nisus Writer.

Drawing

Rectangle

Rounded Rectangle

Polygon

The tools used to create shapes and ru les are at the left of the palette, and
they're similar to what you'd find in most Mac drawing an d word processing
programs. The next three icons are called Object Attribute Menus. They are
used to select how your graphic is to be used. The paragraph icon allows the
graphic to be inserted at the curso r point in your document, essentially as
another character in your text stream. The second icon toggles (click on and
click off) to select whether your drawing will be in a layer above your text or
below it. The latter setting is useful for creating a watermark effect in your
document. The third icon toggles text wrapping on and off. When the icon
shows text flowing around the graphic, you'll achieve the corresponding
effect in your document.

Using Nisus Writer's Find/ Replace Tools
One of Nisus Writer's unique features is its powerful search and replace capability, which allows you to establish complex, multilayered search strings and
set up a replace string equally complex and multilayered. Nisus Writer calls
this search capability PowerSearch, or GREP (short for Global Regular Expression Parser). The Find/Replace window, shown in figure 16.31, provides three
levels of sophistication, depending o n what sort of editing you want to do.
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Note

Nisus Writer's
powerful Find/
Replace capabi lity
lets you search for
al most any
attribute you can
imagine in your
document.

Holding ~. as I did when creating screen shots of Nisus Writer w indows for this
book, displays a set of handy keyboard shortcuts, as well.

I'll give you just a brief example of the sort of stuff you can search for. Basic
search /replace functio ns are done in the same way as m any o th er Mac programs, but you' ll want to read the program's detailed manual before you try
any of the more sophisti cated search routines, because a great deal of specialized syntax is invo lved.
Figure 16.32 shows PowerSearch+ in action. In the example, I look up the
phrase Page munbers (#)follow those items discussed in tile manual. This phrase
will be changed so that the word page appears with the number in parentheses. Note that the page numbers in parentheses are changing each time this
phrase is used, which serves to com plicate the process.
Ill
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Fig. 16.32
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Each of the expressions shown above is selected fro m the various itt:! lll ~ in the
Find/ Replace window's menu bar. In additio n to being able to search through
an open document, you can search and rep lace text strings in closed documen ts. Be warned that this feature requires a bit of reading and some practice
befo re you get the hang of it.

Using Nisus Writer's Multiple Clipboards
As you can see from what has been covered so far, Nisus Writer has several
unique slants to text editing that you don't often find in o ther Macintosh
programs (mo re such slants are described in th e following sectio ns).

An example of
Nisus W riter's
PowerSearch+ in
actio n.
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One of the program's most useful features is its multiple clipboard capability.
The Macintosh operating system gives you but one. When you cut o r copy an
item to the clipboard, it replaces what is already there. Some utilities, such as
Olduvai's MultiCiip Pro, get around this with a System Extensio n of one sort
or another. Nisus Writer supports ten clipboards in the program, and you can
select which one you want to choose from a submenu in the Edit menu, as
shown in figure 16.33.
Show Clipboard

Fig. 16.33
When one
clipboard isn't
enough, Nisus
Writer gives
you ten.

0 1

0
0
0
0
0
0
0
0

2
3
4
5
6
1
0
9

The pull-down menu enables you to choose which of the ten clipboards you
want to use for temporary storage of text or graphic elem ents. If one clipboard is full, you can select another. By using the Show Clipboard o ption in
the Edit menu, you can quickly view the contents of your selected clipboard
before deciding whether to replace them.

Noncontiguous Selection
This sounds like quite a tongue twister, but it's a feature seldom seen o n
Macintosh programs (we saw it once on Taste, a word processing program
from DeltaPoint that's no longer being produced), and it's surely a feature
that can be quite useful when editing co mplex streams of text. It refers to the
capability of selecting separate, unco nnected areas of text in your document
simply by holding down the ;):( and Option keys when you select text. See
figure 16.34 for an idea of how no ncontiguous selection looks o n-screen.

Multiple Undos
This feature should be added to m ore Macintosh programs. In Nisus Writer,
the changes you make to your document are stored in an Undo List, one by
one, in the order in which they were made. Depending on the preferences
you set for the application, you can have literally thousands of undos.
This multiple undo scheme has only one limitatio n . If you have mo re than a
single document open, the changes are still stored in one list. You have to be
careful to be sure you're not undoing a change in a different document.
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Using Nisus Writer's Thesaurus
Nisus Writer's Thesaurus not only helps you locate the correct word when it's
just at the tip of the tongue, but it gives you the definition for the word you
selected as well, as shown in figure 16.35.
Fig. 16.34
Using Nisus
W riter's
noncontiguous
selection feature.
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The Thesaurus also retains a list of the words you have looked up in your
document, in a pull-down menu, in case you want to choose another word
instead of the one you originally selected.

Nisus Writer's Advanced Features
Nisus Writer combines sophisticated text processing tools with a wide range
of features that make it the word processor of choice for many users. The
following list describes just a few of these additional capabilities:

Fig. 16.35
Nisus Writer's
Thesaurus in
action.
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• Multimedia Features. Nisus Writer includes a number of sound and
video-related features, such as the capability to import and play
QuickTime movies, add sound annotation to your documents, and
provide text to speech capability in multiple languages.
• Macros. Nisus Writer has a sophisticated macro editor that allows you to
record repetitive actio ns and play them back through a simple keyboard
command. Macros can be recorded in a catalog and then used in any
open document.
• Graphic and text rotation. Like many deskto p publishing programs, you
can rotate both graphics and text in your Nisus Writer document,
though the capability is limited to 90° angles.
• Tndexing and Table of Contents. You can generate an index o r table of
contents by marking the en tries in your text. Wh en your document is
fin ished, you can quickly generate your index o r table of co ntents in a
new document wi ndow, based on the en tries you've ma rked .
• Drag-and-drop text. Like Microsoft Word and WordPerfect (wh ich are
discussed next), you can select and drag text to a different position in
your document. Holding the Option key while you drag selected text
makes a duplicate copy of th e text rather than moving the o riginal.
• Character spacing. Although automatic pair kerning isn't supported, you
can use Nisus Writer's Set Tracking fea ture to reduce space between two
characters or a range of selected text.
• PowerBook support. If you are using a portable Macintosh, Nisus Writer
puts up a display of remaining battery life in the status bar of your
document window.
• WorldScript support. Nisus Writer supports System 7.l 's use of two-byte
scripts fo r multi-language support. You can easily switch from left-torigh t to right-to-left text entry by choosing a different language script.
• File merging. You can generate fo rm letters by mergi ng the contents of
two or mo re documen ts in your open document window.
• XTend support. Nisus Writer supports Claris XTend translato rs, which
allows you to open o r insert text and pictures in a variety of fo rmats,
including EPSF graphics.
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Getting the Most out of Nisus Writer: Hot Tips
•

If you're using a PowerBook, set the option to load Nisus Writer in RAM

(in the Preferences settings). That will reduce disk access, giving you
more useful battery life.
•

If you :l=C-click on a window title bar, the Windows menu opens, allow-

ing you to select another document window, or stack or tile your open
windows.
• A quick way around handling Nisus Writer's often complex
PowerSearch+ syntax is to first create your search and rep lace fields in
PowerSearch . When you switch to PowerSearch+, the statements in the
search and replace fields will be auto matically translated to the more
sophisticated search language.
• You can save time, when spell checking the same document multiple
times, by o nly spell checking changes. Immediately after a spell checking session, follow these directions:
1) In the document, choose Select All.
2) In the Spell Checking window, choose Ignore.
After that, any new changes you make will be checked, but the text that
has already been checked and ignored will not be checked again, saving
you time.
• If you have used the spell checker and you start running low on application m emory, go to the Catalog and do uble-click the Nisus Dictionary
file. Nisus will reload the dictionary and remove your Skip All cho ices
from memory, thus freeing up more to work with your document. This
is an alternative to quitting and reassigning more RAM to Nisus in the
Finder.

• If you have a very large document o n which you want to perform several Find/Replace actions, first give Nisus as much memory as possible
in the Finder's Get Info box. Then go into Nisus and in the Editing
preferences, set the number of undos to one. Open a copy of your file
(not the original, because you can o nly undo one mistake) and perform
the Find/Replace. That way Nisus will o nly store the last Find/Replace
in the undo list, saving memory and speeding up the process.
• To print page numbers on each page of your document, create a header
or footer contain ing the page number variable. Click your insertio n
point near the to p of the page o n which you would like page numbering to start. Select Insert Header (or Footer) from the Format menu.
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Choose Insert Page Number from the Format menu. The page number
will now print correctly on that and each page that follows in your
document.
• An easy way to copy the format of one section of text to another is to
copy and paste rulers from the ru ler margin. First click the ru ler icon in
the upper-left corner of the master ruler to show the ruler icons. Click
the ruler that appears next to the section of text whose format you
want to copy, and then choose Copy from the Edit menu. Move the
insertion point to the first line of th e section of text where you want to
copy the format, and choose Paste.
• In Nisus, you control the placement of the header by choosing the page
on which to insert the header. To place a header on each page except
the first page, scroll to the second page, click the insertion point in the
first paragraph, then choose Insert Header from the Format menu.
• To adjust tex t flow around a graphic, choose Text Wrap On from the
Grap hics palette, th en choose Set Wrap Border from the Graphics
menu. This dialog box allows you to set the margin (offset) between a
graphic and the wrapped text. En ter 10 in this dialog box for a 10-po int
wrap border.

Summary
Some folks think Nisus is a bit eclectic as wo rd processors go. And it's a sure
th ing that Nisus Software has done its best not to follow the pack in developing this program. But Nisus Writer has a selection of unique text processing
features that you won't find in any other prog ram. While deciding which
program to buy, you should give this one a careful look.

Using WordPerfect
Although WordPerfect has been hugely successful in the DOS/Windows marketplace, the first attempt to produce a Macintosh program did not exactly
set the world afire. WordPerfect 1.0 for th e Macintosh, released in 1988, consisted largely of a direct port of their DOS software to the Macintosh environment, with a ruler added across the top of the document window. It took
several years and several updates fo r the Macintos h version of WordPerfect to
get a tru e Mac interface and develop a style of its own. WordPerfect became
the first high-end word processor to suppo rt Apple's QuickTime, PowerTalk,
and AppleScript and to prod uce a native Power Macintosh version.
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System Requirements
WordPerfect works on a Mac Plus or better, using System 6.0.7 or later, with
2MB or more of installed RAM. The Power Macintosh version of WordPerfect
requires 4.SMB or more of installed RAM. If you install the entire package
(which includes a selection of fonts from Bitstream), expect to use between
lOMB and 11MB of storage space (depending on whether you're using the
regular Mac version or the native Power Macintosh edition).

WordPerfect Overview
WordPerfect has at last come into its own as a viable alternative to Microsoft
Word on the Macintosh. The latest version is a uniquely Macintosh product
that's fully System 7 savvy, with all that entails. WordPerfect has all the
capabilities a high-end word processing program should offer, such as dragand-drop text, grammar checking, an eq uation editor, a table editor, and the
capability to generate a table of contents.

Using WordPerfect's Ruler Bars
Much of the formatting of your WordPerfect documents can be done directly
from its ruler bars. WordPerfect has taken a different approach with these
ruler bars, and has made them easier to understand than the comparable
features of other programs. You can display or collapse them simply by clicking on the appropriate button on the first ruler bar at the top of your document, as shown in figure 16.36.
Fig. 16.36
WordPerfect's ruler
bars, using labels
as well as icons for
clarity.

When you click the button, as done in figure 16.36, the display turns from
gray to white, and the selected ruler bar appears at the top of your document.
Clicking the button a second time causes the corresponding ruler bar to collapse. To ease the task of learning the functions of the various buttons, many
are labeled by name rather than by icon . The following sections describe the
functions of the various ruler bars in this figure, from top to bottom, beneath
the fi rst ruler bar.
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The Merge Bar
This ruler bar is used to activate WordPerfect's document merging feature,
which allows you to combine portions of separate documents, such as when
you create a fo rm letter.
The List Bar
This ruler bar is used to format an index or table of contents, and to create a
list of document cross-reference information.
The Table Bar
This ruler bar is used to edit the tables you've created. The table creation
process begins with the Layout Bar, described below.
The Extended Table Bar
This ruler bar is used to add numbers to your tables. It appears when you
click o n the Math button on the Table Bar.
The Styles Bar
This ruler bar is used to apply style sheets to text in your documents, to edit
an existing style, or to create a new one.
The Font Bar
This ruler bar is used to change fonts and apply character formatting changes.
The Layout Bar
This ruler bar is used for your basic document and paragraph fo rmatting. You
can create columns, change line spacing, and change spacing between paragraphs. You can also use it to create a basic table template.
The Ruler
This rul er bar resembles the ones found in most wo rd processing programs.
You can use it to change left and right m argi ns, column margins, and tab
settings.

WordPerfect's Status Bar
This ruler bar appears at the bottom of your document (see fig. 16.37). It can
be configured using the pop-up menu accessible from the down arrow at the
left of the display. You can display such info rmation as the date and time,
what page and line number your cursor is positioned at, along with its exact
position in inches (or picas o r whatever measurement unit you've selected). If
you're typing text in a table, it can display the number of the cell you're in.
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If you're using a PowerBook, it will also display an ico n showing estimated
battery life.
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Fig. 16.37
Some of the
information
reported in
WordPerfect's
Status Bar.

WordPerfect's Button Bar
The Button Bar is a little closer to the sort of toolbar you find in programs
such as Microsoft Word. Figure 16.38 shows the default Button Bar. It displays common formatting commands. The arrow at the left produces a
pop-up menu that allows you to select alternate bars, one for Graphics
and the other for Equations. You can position the bar at the right, left, top, or
bottom.
Bullet Indent
Flush Right
Find/Change
Border Above

ButtonBar
Pop-up
Menu

Initial Caps
Quick Sort

~~~~==F=~~~==~==~==~~~~~~~~~~~
Spell Check

Remove Indent

Dash Indent

Header

Decrease Point Size

Increase Point Size

If you decide that the Button Bar could use a few changes, you can configure
it to your own taste from a large palette of common WordPerfect command
icons, or create a new one using the particular icons you want. You can also
create custo m Button Bars to store within a single document so that the Button Bar will only be available when that document is opened.

Using WordPerfect's Drawing Tools
WordPerfect is not intended as a replacement fo r your favorite drawing program, but it offers a decent selection of drawing tools. The Graphic Tool palette shown in figure 16.39 provides most of the basic tools you need to create
simple drawings. WordPerfect even has a bezier curve tool to create curve
segm ents.
A graphic can be produced as an overlay on your document, atop the text,
inserted within the text at your cursor, or placed behind the text for use as a

Fig. 16.38
WordPerfect's
infinitel y adjustable Button Bar.
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wa termark. WordPerfect can also import graphic objects created in other
programs in the common for mats, such as EPS, PlCT, or TIFF.
Fig. 16 .39

Pointer tool
Rotate tool
Text tool · ~•-'-'co- Line tool
Rectangle tool
Rounded rectangle tool
Arc tool , _,._,_=jrr- Oval
Curve
Polygon tool
Pen tool
Fill tool
Pen pattern
Fill pattern
Pen color -ll.~li!OI- Fill color

For sim ple
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Using WordPerfect's Paragraph Styles
WordPerfect's Styles ruler bar offe rs an easy way to create o r edit style sheets.
The easiest way to create a paragraph style is to forma t a paragraph, then
select New from the Styles ruler bar, which will d isplay the d ialog box shown
in figure 16.40.
Fig. 16.40
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To modi fy your style, click the Edit button, which will bring up a small text
window at the botto m of your screen, com plete with its own ruler bars. You
can change the fo rmatting to your taste in the tex t window. When you click
the window's close box, the fo rmat is added or modified. The name of your
new style is added to the list displayed in the pop-up men u at the left of your
Styles ruler bar.

Note
A WordPerfect style can be added to a library so that it will be made available to all
the documents you create, or it can be saved wi th your existing document. You
choose this option w hen you are creating or editing a style.
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Using WordPerfect's Table Editor

IV

WordPerfect offers a very flexible, easy-to-use table editor. You can insert a
table directly into your document, or create a separate text box so that the
table can be resized o r moved without affecting the regular tex t. Before I
touch on the highlights of WordPerfect's table creation tools, I'll describe
briefly how a text box is created. First, you choose Text Box from the Tools
menu, which displays the subm enu shown in figure 16.41.

lll!m1l

Fig. 16.41
Create a text box
to build a floating
table in your
WordPerfect
Document.
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If you select New, an empty text box appears at the insertio n point in your
m an uscript. Yo u can click and drag on th e handles of the text box to resize
it (you'll see a status d isplay of its size at the bottom of your document
window).
Once your text box has been created, you can get down to the business of
creating your table. A really quick way to build a table is to click the Table
icon on the Layout Bar and then select the number of rows and columns you
want in your table by dragging your m ouse across the illustration shown in
figu re 16.42. The number of rows and columns are displayed at the top of the
small graphical window.

Cx R

I
lf the preselected graphic doesn 't display the table format you want, you can

choose the Other option and enter the number of column s and rows for your
table in a dialog box. You can also build a table by selecting New from the
Table menu.

Fig. 16.42
Drag your mouse
across this
template to create
a table of the
desired size.
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A WordPerfect table can also use selected text in paragraph form, or tab or
comma-delimited form (used to separate fields), and create a table based on
that text. (lf you decide to convert your table back to text, WordPerfect can do that,
too.)
WordPerfect provides a variety of tools to adjust the width and heigh t of
table cells, and to add borders and fills to your table. The ~ath bar is used to
insert figures and formulas in a table, and the program is able to calculate
totals based on the figures you enter.

Using WordPerfect 's Spell Checker
WordPerfect's spell checker feature, shown in action in figure 16.43, provides
enormous flexibility in a small display. The menu bar atop the spell check
window allows you to choose whether to check the entire document, the
remainder of the document, or just the text you have selected.

-

Fig. 16.43
WordPerfect's
spell checker
examines the
manuscript for
this chapter.
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If you are using WordPerfect's multilingual tools, you can choose different
dictionaries from the Dictionary menu. You even can create a user dictionary
to add words that are not part of WordPerfect's regular d ictionary.

Using WordPerfect's Thesaurus
When you cannot find the exact word for a particular setting, WordPerfect's
Thesaurus, shown in figure 16.44, will help you choose it.
Fig. 16.44
WordPerfect's
Thesaurus in
action.

~

Thesau rus

History Th esaurus
aH•,.n•t• (v) •.altH'
• ch•nqt

Wlttrchln9+
•ro t.att
• fluctu~ot •

r:h.an9• (y)-

::!!:;.rt
• eon'tct

<(}-

~

•mr>dtr\1
n'll.lbtt

Word: l ~hange

~

;=:

[ Replace ) IIIl A ~ IIIli(

~

]I

Look Up

~ ll!i

Using WordPerfect
You can select one of the choices presented by the program, and have it replace the selected word in your document. WordPerfect's Thesaurus window
has another neat option. It can display synonyms and antonyms in separate
windows.

Using WordPerfect's Bullet Indent Feature
WordPerfect makes easy work of creating a bulleted list. Simply select the
text, and click the Bullet Indent button on the Button Bar. A bullet will be
inserted ahead of the selected paragraphs, and the paragraphs will be indented to th e right of the bullet.

Using WordPerfect 's Find/Change Feature
WordPerfect provides a simple Find/Change window, shown in figure 16.45,
but offers menu bar selections that add an enormous amount of flexibility to
this feature. You can do a routine search and replacement of text, but you
can also search by font or style, and add wild cards to the search routine to
cover a range of possible character combinations.

Direction
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Insert

I

Flnd:I_John
[hange To:c.:
l G-'-'
enc_:_
e_

________

~ IChange then find I ([!Iango All I ll

__.jl

Find

n

The program's search capability extends to no n-printing format characters as
well, which include tabs, returns, indents, and page and column breaks. You
can search from your insertion point to the end of your document, back to
the beginning of your document, or restrict the search to selected text.

WordPerfect's Advanced Features
In terms of application size and system and hardware needs, WordPerfect
occupies the middle of the range among the programs described in this
chapter. But the feature list is very long. In addition to the ones described in
detail previously, the following list describes some more of what WordPerfect
can do:

• Macros. This has been a mainstay of WordPerfect for several years. A
small number of pre-built macros ships with the program. You can
create your own si mply by having the program record your actions,
and then play them back with a convenient keyboa rd command.

Fig. 16.45
WordPerfect's
find /Change
dialog box.
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• Zooming. You can change your document view from 25% to 800%, and
retain full document editing capabilities.
• Multi-Language. WordPerfect supports WorldScript and the publisher
will sell you special language modules that allow you to include text in
several languages in your documents.
• E-Mail. If you have Apple's PowerTalk program, which is part of System
7 Pro or System 7.5, you can write and send e-mail directly through
WordPerfect. (This feature is not yet supported in the first release of
WordPerfect for Power Macintosh.)
• Index or Table of Contents Generation. You can generate a Table of Contents or Index list by defining text or paragraph styles in your document. An Index or Table of Contents can be generated easily when your
document is finished.
• Quicktime. You can insert QuickTime movie clips directly into your
document, in the same way you import a graphic file. A built-in movie
controller allows you to click on the QuickTime movie and play it.
• Redline & Strikeout. Text slated for addition or deletion can be marked
while editing your document and be removed with a single keystroke.
• Equation Editor. WordPerfect's handy Equation Editor, shown in figure
16.46, enables you to create and edit equations. You can also easily
display equations created in the DOS, Windows, and UNIX versions of
WordPerfect.
Fig. 16.46
WordPerfect's
convenien t
Equation Editor
appears as a
floating palette
above your
document.

Getting the Most out of WordPerfect: Hot Tips
• You can use WordPerfect's Thesaurus even when the program isn't
active. First open the Language folder (located inside your WordPerfect
application folder). Double-click the Thesaurus icon, which will open
the ST Utility. Enter the word you want to look up, and click the Look
Up button. A list of suggested words appears.

Using WordPerfect

397

• To change th e default font in WordPerfect, select Preferences from th e
Edit menu. Click the Font icon. You can use the popup menu to select
your default font. When you click o n the OK button in the Preferences
window, all new docum ents you create will use that default font. Any
existing font that relies o n the defaul t fo nt will also be changed.
• To change default document settings, follow these steps:
1. Click th e Styles button to bring down the Styles ruler bar.

2. Click the Edit butto n.
3. Highlig ht Document style and click Edi t.
4. A small document wi ndow opens (see fig. 16.47). You change your

defau lt settings by using the ruler bars inside of this window,
which are identical to the ones that display in a regular document
window. For examp le, you can change the document m argin
settings, typeface size, tabs, columns, and so o n.
Fig. 16.47

Changing your
default styles in
WordPerfect.

5. Click th e Close box of th e window.

The changes you m ake will apply to all documents that rely o n
the defa ult document style.
• To select text by using the numerical keypad, do the following: Press
Shift-8 to select upwards o ne line at a time, Shift-2 to select downwards
a line at a time. Option-Shift-4 selects one word at a time to the left;
Option-Shift-6 selects on e word at a time to the right. Command Sh ift-4
or Command Shift-6 selects from th e insertio n point to either end of
the line. Command Shift-8 o r Command-S hift-2 selects from the insertion point to the top or bottom of the screen. You can substitute the
directio nal arrows for the keypad, if you prefer.
• When your cursor is in a table and you are display ing the Table ruler,
you can see what look like capital letter T' s above each column line.
Dragging the m ain vertical part of the T m oves that column line, and
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all columns to the right. Dragging the left or right serif, or small vertical
line forming the tip at either end of the top of the T, moves the margins
of the columns. You can drag and drop text and nu mbers from one cell
to another just as you would move text outside of a table (or Optiondrag to make a duplicate copy).
• Here's how to add a row to an existing table: when you're in the last
cell of the last existing row, just press Tab. To move the cursor to a tab
set within a table cell, use Option-Tab. (Option-Tab indents, outside of
a table.)
• While you'll do most of the formatting of cell contents using the Table
Number Format menu on the Math bar, one useful format for numbers
is to align them flush right. Just use the Alignment menu on the Layout
bar.
• You may want to run a macro each time you open a new document to
create, for example, a customized letterhead or form where the macro
pauses for user input. Here's how: title the macro OnOpenDocument
and save it in a blank document as stationery (in the Save As dialog
box). The macro will run any time you create a new t'ile using that stationery as a template. To run the macro with ev~ry new file you create,
place the macro in the stationery document titled New Document Stationery and save it in the Stationery folder (located in the WordPerfect
application folder). You can also title a Library macro "OnStartUp" and
it will run eyery time you open WordPerfect. If OnOpenDocument is
put in the Library, it will run when you open any existing document.

Summary
WordPerfect has not just cloned its PC and Windows products and put a
Mac menu bar on them. WordPerfect has created a feature-filled, uniquely
Macintosh program that has developed a strong following. WordPerfect also
has been first on the block with a native Power Macintosh word processor,
and has been very aggressive in offering regular upgrades with new features
and performance enhancements. A comprehensive Help menu and the ability
to print out your help text also makes it easy to get up to speed on this
program.

Conclusions and Recommendations
There is no doubt that any of the programs discussed in this chapter will
meet most of your document processing needs smoothly and efficiently. Each

From Here ...
program has specific strengths that may be better suited to your purposes.
Following are some thoughts to con sider:
• MacWrite Pro has most of the features of the high-priced competition,
with a simple, accessible interface and a very low purchase price. It adds
to the mix some tools generally the province of desktop publishing
software, such as automatic kerning and the ability to set hyphenation
and justification parameters. If some of the specialized features offered
by the competition don' t appeal to you, MacWrite Pro may be all the
word processing power you need.
• What can I say? Microsoft Word became number one in the marketplace not just with fancy advertising, but because the publisher has
tried to understand the needs of users and respond to them. Word 6.0 is
big and fat and requires large reserves of RAM and storage space. But it
answers just about anyone's wish list for the ideal word processor. If
you're an experienced Word user, and you have the right Mac hardware, you' ll have little reason to change.
• Nisus Writer is fast, slick, and innovative. It has features that should be
a natural part of word processing software, such as its multiple clipboards, multiple undos, and almost limitless find/search capabilities,
but they remain exclusive to this program. It's a little different from the
pack, and an acquired taste to some, but once you get used to it, there's
no turning back.
• WordPerfect stumbled badly when it first came to the Macintosh , but
the publisher learned its lessons well. This program is designed to meet
the competition from Microsoft Word head-on, and offers its own
unique package of features. It is a big program, though not quite as big
as Word, with less stringen t hardware requirements. It has a familiar,
friendly interface, and it's relatively easy to use. It's surely worth
consideration.

From Here ...
This chapter discussed the most popular Macintosh word processing software
products ava ilable and offered a few ideas for which one to choose for your
document processing chores. Although these programs all have sophisticated
document creation capabilities, you might find you need a true desktop publishing program instead (or you might want to use both, depending on the
demands of the project).
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• Chapter 8, "All about Fonts," offers helpful hints on getting around in
the Mac's confusing world of multiple font formats, and suggests ways
to help you manage a font library.
• Chapter 21, "Desktop Publishing," contrasts the capabilities of a true
publishing program to word processing software, and gives you some
suggestions as to which to choose.
• If you encounter any difficulties along the way, read Chapters 37 and
38. These chapters describe how to troubleshoot common problems
with your Mac and how you can solve those problems before they
become serious.

Chapter 17

Presentation Graphics
by Dave Plotkin

Graphics are an important part of doing business today. Graphics help communicate ideas-from charts and graphs to timelines, flow charts, calendars,
and general illustrations. Graphics play an important part in presentations
designed to convince an audience to follow a new project plan, create and
market a new product, or pursue a new course of action.
Creating business graphics presents a dilemma to the average person. On the
one hand, business graphics are often created in a hurry, usually for some
tight deadline. Further, they are most often created by people who have little
artistic talent-or lack the time to exercise that talent even if they do have it.
And yet, ideas and projects, even careers, can be markedly influenced by the
quality of these graphics. Business graphics are often used in presentations to
managers, potential customers, and other people who can have an important
impact on the rest of your life. If a presentation is inadequate, it can accentuate the natural "stage fright" that many people feel when they are called on
to present information to a group.
This chapter provides some background information about computer
graphics and then discusses the features and capabilities of the following
widely used graphics packages:
• Claris Impact
• DeltaPoint DeltaGraph
• Microsoft PowerPoint
• Gold Disk Astound
• Aldus Persuasion
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The Evolution of Computer Graphic
Packages
Computer-based graphics and presentation packages help busy business
people put together presentations quickly. By providing a combination of
text tools, drawing tools, a collection of clip art, and ways to arrange and
rearrange the order of slides, these packages ease the creation of graphics and
presentations. Presentation graphics packages make it possible to do more
than simply lay out text in a word processor and print the results.
Business graphics and presentation packages have evolved over the years. An
older, less friendly package could cause some head scratching if you hadn't
used the package in a while. Graphic objects (such as the aforementioned
flow charts) had to be built laboriously by hand, using rudimentary graphic
tools. While it was not especially hard to construct, say, a calendar, from
rectangles and the text tool, it was very time-consuming. Still, the increase in
productivity over using less specialized tools, or even drawing the graphics
and slides by hand, was so marked that people wholeheartedly adopted the
new packages. The market grew, and as it did so, more graphics and presentation packages entered this profitable market. As with so many other things,
competition drove the packages to improve.
Ma ny of the newer graphics and presentation packages are easier to use, even
when returning to them after an extended absence. Many of these packages
use status-line messages and balloon help to remind you what to do next.
This constant "hand-holding," coupled with tips on how to more effectively
build graphics and presentations, increases you r productivity and decreases
your frustration in th e process. In addition to the extra help, the tools have
gotten more powerful. With some packages, it is possible to build a common
business object (for example, an organ ization chart) with just a few mouse
clicks. This enables you to focus more on the content and less on the mechanics of producing the presentation.
The new tools also make it easier to build more professional-looking presentations. Most packages come with carefully matched sets of templates. These
sets of templates provide a common background for all your slides, as well as
matched sets of font sizes. The templates are designed by graphic artists, and
you may select from a wide va riety-depending on the message you are trying to send. You can use a template that includes bright colors and bold fonts
fo r a young, dynamic audience. Or, you can use muted colors and more traditional fonts for a more conservative audience. Either way, gone are the days
when a mismatched set of colors and fo nts could ruin an otherwise good
presentation .

Claris Impact
Many of the newer presentation packages also include som e fancy features to
dress up your presentation with very little additional work. These features
include eye-catching transitions between slides, QuickTime animations, and
sound. These more advanced features generally require more capable hardware. Of course, fancy effects and animations only work when you intend to
use your Mac to make the presentation. Most presentations today (about
80o/o) are still delivered using printed media: either paper handouts or overhead projector slides. Most printed presentations are still in black and white,
although th is is slowly changing as the cost of color printers comes down.

What Is Out There
The Macintosh business graphics/presentation package market was
o nce dominated by only two packages: Aldus' Persuasion and Microsoft's
PowerPoint. These two old-timers are still around, and they have been much
improved. They have been joined by some very able competitors, however:
Gold Disk's Astound, Delta Point's DeltaGraph, and Claris' Impact. All these
programs include special features that set them apart from one another. They
all try to combine ease-of-use with lots of power, and som e are more successful than others at this most difficult of balancing acts. In the following pages,
we will look at the features of each of these packages, and provide you with
enough information to decide what package you want to invest your time
and money in.

Claris Impact
Claris Impact combines considerable power with some un ique features that
make the creation of business graphics very straightforward. A Windows
version of Impact is due late in 1994, the files will be interchangeable between the Macintosh and Windows versions of the product. Impact is one of
the newer business graphics packages around, but it shows Claris' long heritage of building Mac programs. For example, the word processing portion
of the package is highly reminiscent of Claris' word processing package
MacWrite. While this package is light on the fancies such as slide show transitio n effects, it is easy to learn and use and a great dea l of fun as well.

System Requirements
Impact comes packaged on five disks. The exact amo unt of hard drive space
required depends on which options you install, but a fu ll installation (all
fo nts and templates) requires 13.2 megabytes. Impact will run with either
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Tip
For a m ore
effective presentation, use a
simple font:
preferably a
sans- serif font.
Fancy fonts
tend to distract
your audience
from the
message.
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System 6 (6.0.7 or later) or 7, although you must have at least 2MB for System
6, and 4MB for System 7. System 7 is n eeded to use features such as Publish,
Subscribe, QuickTime movies, and Balloon Help.

The Drawing Document
Claris Impact is based around three document types. The first document type
is simply called a "drawing" (see fig. 17.1). A "drawing" is just that-a blank
sheet that you use to create diagrams using Impact's powerful drawing t ools
and "models" (more on these in a moment).
Style Bar
I

Fig. 17.1
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Using the Style Bar
Across the top of the screen is the style bar. The style bar includes buttons fo r
specifying the fill pattern and color, as well as a variety of gradient shading
options (including a user-defined gradient). The style bar also includes controls for setting the color, line style, and arrowhead style fo r th e pen tool.
The last set of buttons enables you to set the color, font, style, and size for
freeform text.

Claris Impact
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Most of the menus that Impact makes available from the style bar can be to rn off the
style bar so that they remain open in the workspace. This capability to tear off a
menu makes it easier to access the menu if you have to repeat the same operation
multiple times (see fig. 17.2).

Fig. 17.2
Tear-off menus
make it easier to
repeat functions
on a drawing.

Using the Toolbar

The left side of the screen includes the tool bar-a set of buttons that make a
variety of powerful drawing tools available. As with the style bar, you may
tear off any palette to create a free-floating window that makes it easier to
reuse the objects in the palette. The Shapes tool makes a palette of shapes
available. These shapes include arrows, recta ngles, cubes, stars, and other
selections. You may select one of these shapes and use click and drag to
locate and size the shape on the screen. The shapes may be filled with a pattern, color, or gradient. You may also change the color and weight of the
border lines, and add a drop shadow. You may use the Reshape menu option
to reshape the items in the shape palette. When you choose to reshape an
object, Impact places additional highlighted points around the boundaries of
the shape. Reshaping is easy-just click and drag the highlighted points on
the shape to create you r own shape.
The Draw tool palette includes lines and curves, rectangles, ovals, bezier
curves, and free-form shapes. As with the items in the Shape palette, you can

Tip
If Impact's
Shape palette
doesn't include
the shape you
need, you can
use reshaping
to create your
own shapes
from the supplied shapes.

406

Chapter 17-Presentation Graphics
add fills (including gradient fills), color, and a shadow. Draw objects may not
be reshaped, however. Also included in the Draw tool palette are two connection tools (lines with small square dots on the ends) . The connection tools
may be used to join any two Shape palette objects with a line. Establishing
this connection is a little tricky because you must drag the connector from
the edge of one shape to the edge of the other. After you have done so, the
connection remains attached to the shapes when you drag them around onscreen (see fig. 17.3). The two connectors either connect the shapes using
lines with 90-degree angles or straight lines.

No~

I

You cannot use the connector tools to join objects from the Draw palette. You may
draw the line using the join tools, but the connection is not preserved if you move
one of the draw shapes.

Fig. 17.3
Connectors join
Shape palette
objects-even
when you move
the objects.

Using the Rest of the Tools
After you have placed Shapes and Draw objects on the page, you may use
Impact's menu-based tools to arrange and align the objects. Objects on-screen
are arranged in layers, with more recently placed objects hiding objects of
which they are on top. You may change the order of these layers to display
an object that is entirely or partially hidden. You may also align the centers,
left, right, top, or bottom edges of multiple objects. You can rotate objects
by any amount, flip them horizontally or vertically, and scale them any

Claris Impact
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percentage. This scaling can be done independentl y in the horizontal and
vertical direction.
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You can customize most of the tools in Impact. For example, you can create
your own fill pattern by modifying any of the supplied patterns. However,
you cannot add more patterns to the pattern palette. You can create your
own color gradients, defining not o nly the shading pattern and direction
but also the colors used in the g radient. The pattern and gradient editors are
easily ava ilable from the Layout menu.
Using Models

One of the features that really sets Impact apart from o ther business graphics
tools is its models. Models are essentially templates fo r common business
graphics, such as organizatio n charts, flow charts, timeli nes, calendars, tables,
numeric charts, and text o utlines. To start creating one of these models, you
select it from the toolbar at the edge of the screen. Click and drag on-screen
to define the extent of the model (see fig. 17.4), and you are ready to start
customizing. And can you ever customize!
Text outline
Table
Numeric
chart
Organization
chart
Flow chart
Timeline
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The first thing you can do is select a style for a model. Styles set background
colors, fonts, line styles, and other attributes. The pre-built styles are available
fro m a list, and in general are eye-catching. If none of the pre-built styles suit
you, however, you can customize just about everything about a model. For
example, even for a simple table, you may set the column wid th and row

Fig. 17.4
Producing a
complex business
ob ject is as easy as
click and drag.
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heigh t, d efault tex t font and size, the grid display and color, and the number
of rows and colu mns. You can also mo di fy individ ual elements o f the model
wh ile you are working on it.
No~

'

As you work w ith each model (you can have multiple models on a page), the toolbar
changes to provide the tools appropriate for that model.

Claris has really do ne a nice job on the mod els. Fo r example, the o rga nization chart enables you to add coworkers, assistants, managers, and subordinates (see fig. 17.5). You may select from a va riety of styles fo r d isplaying
trees in th e o rg chart and individu all y select box backgroun d, bo rder color
and weight, font size and style, and the types o f information to be displayed
in each box. Rearranging an organiza tio n is as simple as dragging a box to a
new loca ti on. Depend ing on where you dro p the box in relatio n to an existing box, the person will be a subo rdin ate, coworker, o r o ther. You ca n ad just
the size of boxes, and decide whether all boxes o n the same row will adjust to
have t he same width and height. You ca n eve n specify that all boxes that are
higher o n the orga nization chart also ad just th eir width and height as well.
Note
Positions on the organization chart can include only the name and title-you may
not add more fields.

The timeline is simple to use but works well. You may add timeline tasks, and
instruct Impact to automaticall y crea te the time incremen ts across the top of
the timeline. This model understands ea rly and late fini sh and lin ked tasks. If
you reschedule tasks, Impact will autom atically reschedule tasks t ha t depend
on the reschedu led task. You may customize the line styles, specifying your
own choices fo r th e du ration, slack, and percent-done lines (see fig. 17.6).
You can also speci fy the colors, pattern s, and shapes to use for the start and
finish symbols. If you are more comfo rtable wo rking with a table of n umbers,
you ca n modify the timeline using a table. You can click and drag task rows
to reschedule, but this swaps the two rows-th ere is no way to grab a row
from one place and drop it into th e table.

Claris Impact
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Fig. 17.5
The Organization
Chart can represent
a complex
organization.
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You may customize all the markers
for a timeline .

libl

- .-± - - - - -

...... ..,.~
.....,_ . ...

-

BtlrDit DIIU
Modify Bar

I IICIOhl ~~~~~lph.l

Oe'l:l*t pflll'lb

c-

''"'

:~

- --

~

I

---

( Concel

I

ICEJ

"'

Claris Impact doesn' t fo rget a bout c h arts built fro m numbe rs. It ca n import
spreadsheet data, o r you can typ e info rm atio n into a table. This table enables
you to easily custo mize the chart title, ax is la bels, and th e legend labe ls.
Impact ca n b uild 12 d ifferent types o f cha rts- incl uding such staples as bar
charts, stacked ba r c ha rts, pie charts, pictogra m , line, and sca tte r charts.
1\.s with othe r mode ls, you pick fro m the p rovided styles or custom ize your
own. After you have built a chart, you can customize its loo k with th e mouse.
Fo r example, you ca n select sections of a p ie c hart and pull them o ut. You
ca n also chan ge all c ha rt colors, fill pa tterns, the 3-D angle, and other
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attributes of the chart. You can customize the legend , its placemen t, and axis
labels, use pictograms instead of staid bars, and add m ultip le number series.
The calendar model is really impressive. You may select a style for the whole
calendar, as well as special styles to be applied to days (even separate styles
for weekdays an d weekends). In fact, you can select individual styles for a
specific day of the week. For example, you can apply a somber style to
everyone's favorite workday: Monday. You can select any individual day of
the mon th and change the background, border style, font, style and size of
the date number. Yo u can add messages and attach clip art to a day as well.
You can even schedule events on a day o r set up events that stretch across
multiple days (such as vacation) (see fig. 17. 7).

Fig. 17.7
You can customize
a calendar just
about any way
you want.

Tip
Impact can
tran slate one
type of model
into another.
For example,
you can turn a
number table
into a chart
insta ntly, or
convert a
multi-level
o utline in to an
o rganization
chart. Impact
builds the
levels of the
chart based on
the outline
levels.
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Even a simple table has considerable fu nctional ity. In addition to adding text
and numbers in any "cell" of the table, you may highlight a range of cells
that includes a blank cell at the end and click the "sum" tool. This places the
sum of the highlighted cells in the forme rly-empty cell. If you change any of
the numbers in the range, the sum is updated to match.

The Report Document
The second type of document is called a "report ." A report includes a decent
word processor, reminiscent of Claris' MacWrite (I wonder why). You may
create word-processed documents and include graphics and models. Of
course, you can use text blocks in a Drawing, but the Report provides far

Claris Impact
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more structure and text editing tools. A report works much better than a
drawing if you r creation is primarily text. If you add shapes, models, or draw
objects to a report, Impact flows the text around these obstructions automatically (see fig. 17.8). The text automatically reflows if you drag the graphics to
a new location. However, addi ng graphics objects to the text slows down the
keyboard response considerably-most people will be able to out-type Impact
when it is attempting to flow the text. Ideally, you should import or type
your text and then add in the graphics.
Fig. 17.8
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You have considerable control over text in the report, although not as much
as you would with a dedicated word processor. A graphic ruler across the top
of the screen enables you to easily set margins and tabs (left, right, center,
and decimal). You may adjust the text alignment using a set of buttons. Still
another set of buttons enable you to vary the spacing between lines in increments of .5 lines. You can even double-click the alignment indicators to
specify paragraph formatting such as left indent, first line indent, right indent, line spacing, and spacing before and after the paragraph. Spacing can
be set in lines, inches, picas, or centimeters. You can even split the document
into a user-defined number of columns, specifying the width of each column
and the distance between columns. Page breaks, date, time, headers, and
footers are all available to customize you r document. Of course, you can
change the font, size, style, color, and effects for any text.
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The Presentation Document
The third document type is Presentation. This is essentially a slide show.
You may choose a style from the color or black-and-wh ite styles. There
aren't as many styles available in Impact as in presentation packages such
as PowerPoint, but there are enough for most purposes. You choose a style
from a dialog box that shows you a preview of the master slide (see fig. 17.9).
At any time, you may change the master style and even filter out various
parts of the master slide, such as the title, body, and background. Each style
includes only a master slide. As with drawings and reports, you may add
models, shapes, text, and draw objects to any slide and customize them in
the same way. You may also modify an individual slide by clicking and dragging the text box (which contains any bulleted text items) to a new position.
Adding a new slide is as easy as clicking a button, and you can access any
slide in the presentation from a convenient pop-up list.
Fig. 17.9
The Preview dialog
box makes it easy
to pick a Presen tation sty le.
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You can change the look of every slide in the presentation by modifying the
master slide. If you relocate the text box on the master slide, for example,
Impact reformats all slides in the presentation to match th e new location.
Any objects that you add directly to the master slide will appear on every
slide in the presentation. All of Impact's tools are available for modifying the
master slide, but you can't save the modified slide style as a new master slide.

The Slide Manager
Impact's tools fo r arranging slides is not very sophisticated, one of the few
places where this program doesn't quite measure up. The Slide Manager is a
textual listing of the slides in your presentation. You may drag these text
descriptions around to rearrange the slides and hide a slide so it doesn't show
up in the presentation. There is no miniature graphical representation of the
slides in the presentation, however.

Claris Impact
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Putting It All Together
When you have created a graphic o r model that you want to use elsewh ere,
you can include it in a library. A library is a palette of saved objects. For example, the excellent tutorial has you create five different models using the
drawi ng document. As you create each model, you add it to the library, and a
miniature versio n of the model appears in the library palette. Later, you click
and drag the miniature fro m the library palette to paste a copy of the model
into a presentation. After you paste the object into a document, you can
customize it as usual. Libraries are very handy fo r objects that you reuse frequently.

Presenting Your Work
Impact includes a spell checker for cleaning up your presentation. You may
add unrecognized words to a personal dictionary. The spell checker ma kes
suggestions for any words it doesn 't understand .
After you have built a slide show, you may display it on-screen. Impact has
a very limited number of options fo r customizing the actual presentation of
the slide show. For example, it lacks the fancy slide transitions (wipes, rain,
blinds, and so on) that dedicated presentation graphic packages include. You
can choose the pointer to display during the show, select the slide and border
color, use a fade between slides, and control the time between slides (or advance to the next slide manually). You can also set the slide show to loop
continuo usly. You can instruct Impact to use Progressive Builds on text slides.
This option instructs Impact to display one item of bulleted text at a time.
This effect can dramatize your points, and you don't have to build the slides
individually. However, Impact does not dim the old bulleted text whe n it
displays the new item, as do some other packages.
Note
One big advantage of the Impact's simple slide show is that it is very fast- the next
slide in the sequence is available almost immediately.

Impact does not include a slide viewer, so you can run a slide show o n ly on a
Mac o n which Impact is installed.
You may print out your presentatio n fo r your audience. You can print the
full-size slides o r handouts. The ha ndouts can fit between two and six slides
per page but do not make allowances for areas o n the handouts fo r notetaking.
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Getting the Most Out of Impact: Hot Tips
• To quickly add a drop shadow to a shape, click the shape, and then
click the Shadow tool near the right end of the toolbar. To easily
modify the properties of the shadow, ~-cl ick the Shadow tool. This
action opens a dialog box from which you can set the shadow offset
and color.
• It can get very tedious to add new workers to an organization chart one
at a time. If you need to attach multiple workers to one individual, click
that individual. ~-click one of the indicators (subordinate, coworker, or
other). Type in the number of workers to add, and click OK.
• Impact comes with a great deal of clip art, arranged into libraries. You
can use the Libraries tool on the toolbar to open a clip-art li brary onscreen and then click and drag clip art from the Library window. You
can use Impact's tools to modify the clip art on-screen or to create a
new piece of art. To add this clip art to a library, expand the Library
window by clicking the expand arrow. Highlight the clip art in your
drawing and click the Add button. You can also rename clip art by using the Rename button .
• Impact includes many flow chart symbols, but if the one you need isn't
there, you can create your own. Select the Flow Chart tool and click the
document to place a single symbol and open the flow chart library.
Expand the library window by clicking the expand arrow. Click a supplied symbol (try to choose one whose design is similar to the symbol
you need), and then click the New button (or click the Edit button to
edit that shape). The selected symbol is opened in an editor window.
You may use all of Impact's drawing, fill, alignment, group, text, and
shape tools to customize the shape any way you want. Click OK to save
the new or edited shape back into the Flow Chart library.

Summary
Claris Impact is an excellent product. A tremendous amount of effort has
gone into making it easy to use. It doesn't have all the bells and whistles that
the specialized presentation packages have, but the models are extremely
useful. If you need an integrated graphics and presentation package for the
Macintosh, this one is definitely worth looking at.

DeltaGraph Pro 3

DeltaGraph Pro 3
DeltaPoint's DeltaGraph started out as the foremost charting package fo r the
Macin tosh. Its strong suit has always been a huge ensemble of chart types,
including some esoteric styles that o nly a scien tist o r statistician could love.
However, most people who purchase and use the product use just a few of the
many chart types available.
As presentation packages such as PowerPoint have matu red, their publishers
have added a variety of ch arts to th ese products. In late 1993, DeltaPo int
responded to this by adding presentatio n package features to DeltaGraph.
The result was DeltaGraph Pro 3. This prod uct combines power-charting
features with a good selectio n of too ls designed to make it easier to present
those charts. Unfortunately, some of the features are not as easy to use as
they could be, resulting in a steeper learning curve than with other products
reviewed here.

- Caution
DeltaGraph Pro 3 contains some annoying bugs that can cause the product to terminate unexpectedly o r lock up your Macintosh . If that happens, all work since the last
save is lost.

System Requirements
Like Claris Impact, DeltaGraph Pro 3 is a big program. It com es packaged on
five high density d isks, and a full install requires 13MB of h ard drive space.
Using charts in the product requires a Macintosh with a m inimum of a
68020, but a 68030 and a math coprocessor are recommended for anything
but the simplest applicatio ns. DeltaG raph Pro 3 req uires at least system 6.0.2
with a minimum of three megabytes of free memory. System 7 is needed to
use fea tures such as Pu blish, Su bscribe, QuickTim e movies, Applescript, and
Balloon Help.

Making Charts
W ith DeltaG raph's heritage, you would ex pect that it enables you to construct powerful charts, and that is one of its strongest features. You use two
of four available views in DeltaGraph Pro 3 to construct charts.
Getting the Data Together

The first step in creating a chart is to lay out the data. Using the Data View,
shown in figure 17.10, you may type data that will be converted to a chart,
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o r you may import data from a variety of sources, such as an Excel or Lotusformat spreadsheet, delimited text files (tab, space, or comma-delimited), and
Cricket Graph . The Data View looks much like a standard spreadsheet, with
the data arranged in rows and columns. You use the first row and first column for the ax is labels. You may widen the columns in the Data View by
clicking and dragging the column divider lines. You may change the text
formatting of data in the Data View, adjusting the font, size, and style, but
the fo rmatting is applied to all text in all <.:t!lls- you cannot adjust just the
contents of a single cell or a highlighted range. You may insert a blank row or
column in the Data View; however, you cannot insert a single blank cell and
force o ther cells to either move down o r shift right to make room. You can
tra nspose the positio ns of the rows and columns.

Fig. 17.10

You use the Data
View to collect
data for a chart.
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The Data View provides a certain amount of formatting control. You may
format numbers with a fixed number of decimal places, as currency, percent,
or in scientific no tation (fo r example, 1.02E+03 is the equivalent of 1020).
Date formats include MM/00/YY, weekdays, year and mo nth, and many
others. You may sort columns o f da ta into ascending or descending order.
The Data View contains an expression builder that enables you to apply functions to columns of data. For example, yo u may com pute a running total of
the contents in a column. The results of the calculations are stored in an
empty, unused column. After the calculation has been performed, the results
can be used when constructing a chart.

DeltaGraph Pro 3
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Caution
Results in a calculated column are not updated if you change the numbers in the
column upon which the calculation is based. You must manually request a recalculation in order to update the results.

The expression builder includes a large number of powerful functions, such as
squa re root, sum, average, standard deviation, transcendental (sine, cosine,
arc tangent, and so on), logarithmic, exponential, differential, fill, and filter.
Building Charts from the Data
After you have all the data, the next step is to select and build the actual
chart. To turn the data in the Data View into a chart, you m ust select the
chart gallery. The chart gallery displays small samples of all the charts available (see fig. 17. 11).
Fig. 17.11
The Chart Gallery
enables you to
pick the chart type
you want.

To build a chart, select the chart type you wa nt, set the options, and click OK.
Altern atively, you can ask the Chart Advisor to suggest the type of chart that
goes best with the format of data you have. Either way, DeltaGraph Pro 3
constructs the chart in a new chart view (see fig. 17. 12).
Fig. 17.12
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You can construct multiple charts from a single Data View page. For example, you may
want to plot all the data in one chart, but only plot certain columns in another chart.
You can highlight just those columns prior to constructing the chart and then create
the chart as described above. The chart then includes only the selected columns.

DeltaGraph Pro 3 is capable of constructing 57 different kinds of charts, and
can do sophisticated scientific analysis on your data, such as curve fitting.
Charts are grouped into three categories: Business, Technical, and Statistical.
In the Business category, you may view all the charts, o r select from just
areas/pies, lines/scatters, bars/columns, and table charts. The Technical category is split into Lines, Contours, Vectors, and Scatter charts. You may look
at either 2-D or 3-D charts. Available charts include pie, ba r, stacked bar,
surface, spider, timeline, table, high-low, line, scatter, polar, area, range, step,
and dozens of other types.
One of the more confusing things about DeltaGraph Pro 3 is that charts are
not automatically updated when you change the data on the matching data
page. You can update the data in the Data View and then click a button to
update all charts based on that Data View page. Alternatively, you can use a
button to jump from a chart to the matching Data View, make changes, and
click a button to update the chart attached to the Data View. If the change
you are making includes changing exactly which columns are plotted in the
chart, you must make the revision in this second manner. This manner of
updating charts is quite confusing because changing the datasheet doesn't
necessarily change the chart.
Customizing the Chart
After you have built the chart, you can custom ize it directly in the Chart
View. You can customize the chart in the following ways:

• Add a Heading and Axis Titles.
• Change the text size and formatting of any text. You can change all the
axis text in one step o r customize each individual label.
• Change the color and style of any line, including grid lines. You can
also ch ange the grid line spacing.
• Ch ange the color, gradient fill, and fi ll pattern of any portion of the
plotted graph . For example, an area curve has three colored areas: the
side, end, and top. You can individually change any of these areas.

DeltaGraph Pro 3
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• Change a wide variety of o ptio ns, depending on the chart type.
For example, you can change the shape of the bars used in a bar chart,
which planes are displayed in a 3-D chart, the width and height of bars
in a bar chart, and the location of the ticks and labels o n the chart.

IV

• Show a legend, setting the symbol width and height, as well as the
location in relation to the chart.
• For 3-D charts, you have complete control over the orientation of the
chart. From a dialog box (see fig. 17.13), you can set the orientation
(elevation and rotation), front-to-back perspective, and the vanishing
point (vertical, horizo ntal, and depth effect). As you make adjustments
to the settings, a 3-D rendering of a cube adjusts to show you the effect
of your changes'.
Fig. 17.13
You have co mplete
con trol over the
representation of a
3-D cha rt.

Building a Presentation with the Chart View
The Chart View is where you do most of your work to create a presentation.
As discussed above, pages in the Chart View display any charts you have
made, but there is fa r more you can do to create an eye-catching presentation. As with most other presentation packages, DeltaGraph Pro 3 makes
matched sets of backgrou nds and template layouts available. These sets are
called Layout Sets.
Using Layout Sets
A Layout Set consists of a background and a set of about 12 different slide
tem plates. These tem plates incl ude Basic Layout, Title, Chart and Title, Two
Charts and Title, Bullet Text and Title, and so on. Each time you create a new
slide in the presentation, you can select on e of these templates to set the
layout of the slide. If you choose the Chart and Bullet Text tem plate, fo r example, the resulting slide consists of a rectangle fo r the chart and a rectangle
for the bulleted text. At any time, you can change the template associated
with a slide to change the slide's layout.
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You ca n load a Layout Set when you first start creating a presentation or load
it later-modifying all slides in the presentation to give the m th e new background a nd ad justing the layout of the slides to match the new slide tern·
plates. The dialog box used for loading Layout Sets gives you a miniature
preview of the Layout Set (see fig. 17.14).

Fig. 17.14
Preview of the
Layout Sets makes
it easy to pick one.
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After you select a template to use, you can start filling in the information in
the template. For templates that include a chart block, you can double-cl ick
the cha rt block, and DeltaGraph Pro 3 automatically open s the ch art ga llery
so that you ca n select a chart type. After you select a chart from the gallery,
the last-used Data View is opened so that you can pick the data to associate
with the c hart. You can either select data from that Data View page, switch to
another Data View page, or create a new Data View page. Alternatively, you
can instru ct DeltaGraph Pro 3 to use a set of sample data instead. You ca n
then revise the sa mple data for your own use.
For text blocks on slides, you can start typing in th e Bulle ted Text block to
create a text chart of bullet points. The text chart consists o f levels (m uch like
an o utline). The Layout Set sets the attributes o f bulle ted tex t blocks-includin g font, style, size, bullet style, and colo r for each level of text.
Modifying the Slide Layout

You can m odify the layout of a slide in two ways. To modify just a n individua l slide, you ca n click and drag various compone nts o f the slide around.
For example, you can c lick and drag a bulleted t ext b lock lowe r on the page.
You can also add and resize o bjects, including charts, and directly cha n ge the
fo n t, size, style, and color of text- both freeform and text located in text
blocks.
You ca n also d irectly m odify a template in the Layou t Set. If you m odify a
te mplate, all slides that use t h at template are automatically modified. Ch anging a template works exactly like changing any other type of slide. Yo u can
modify a templa te o r create a n ew template using a special toolba r that includes tools such as Bulleted Text b lock, c hart, organization ch art, text,
graphic, and background tools.

DeltaGraph Pro 3
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Be careful about modifying templates. If you have changed the layout of an individual slide, changing the template for that slide w ill cause the slide to change to
match the modified template.

For text blocks, you can modify the font, size, style, and color, as well as the
bullet style and color. There is a special template in each Layout Set called the
"Master Background." Any changes you make to the Master Background are
reflected on all slides, regardless of the template they use. This is very useful
for adding graphics (such as your company logo) that you want to appea r on
every slide. To save your changes, you need to save the Layout Set. You can
either save over the original or create a new layout set. Any new templates
you create are only available in that one Layout Set.
Using Graphic and Text Tools
DeltaGraph Pro 3 h as a floating pa lette (see fig. 17.1 5) that con tai ns a va ri ety
of tools for customizing slides. These tools are available both for customizing
individual slides, and modifying templates and backgrounds.
Fig. 17.15
The floating
palette contain s a
variety of graphic
and text tools.

There are tools for text, lines, curves, bezier curves, polygons, arrows, circles,
a variety of rectangles (included rounded rectangles), and freehand drawing.
Most shapes can be filled with color and pattern, and you can modify line
color, style, and weight. You can also apply a drop shadow to a shape, fill it
with a color blend, and use the eyedropper tool to transfer the style of o ne
object to another object.
Note
If you select the text tool, DeltaGraph Pro 3 displays a graphical ruler. The ruler includes tools for setting tabs, text alignment, paragraph and line spacing, and margins.
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Tip
If you construct a very
wide li ne, you
can usc fi ll
patterns o n
these wide
lines.

The three buttons at the bottom of the palette provide drop-down palettes
when you click them. These palettes enable you to directly set fill color and
pattern for the foregro und and background of drawn objects an d lines.
You can use another drop-down palette to make a line very wide.
Aligning, Grouping, and Layering Graphic Objects

DeltaGraph Pro 3 has a full com plemen t of tools for aligning, grouping, and
layering objects. The Align dialog box enables you to align objects by their
edges (top, bottom, left, and right) or their centers (up/down or left/right).
You can also align objects to the grid and set the fineness of the grid . You can
group objects together. Once you have grouped a set of objects, you can
move and size them as a single object. You can ungroup objects if you need
to modify the component objects. When objects overlap each other, you can
move an object in front of or in back of another object You can also rotate
objects in 90-degree increments.
Using Libraries

Libraries are especially helpful in Chart View. A library is a collection of objects that are available in a window. You can use a library object by clicking it
and dragging it to the active Chart View window. DeltaG raph Pro 3 comes
with libraries of clip art and pictures, and you can create your own libraries of
specially formatted charts.
'

.

.

Note
Clip art can be used fo r the shapes in pictogram charts, and the clip art provided is
fu lly scalable witho ut loss of resolution.

Using the Outline View
DeltaGraph Pro 3's Outline View presents the slides in your presentation in
the form of an outline (see fig. 17.16). Slides that just contain graphics or
charts simply display their titles, but slides that contain bulleted text display
that bulleted text.
You can edit the titles of slides, as well as the bulleted text. Any content
changes you make to the text in the Outline View show up in th e slide text.
The levels of bulleted text are displayed as outline levels, and you can ch ange
the levels of the text using the tools in the Outline View. You can also convert sublevels into bullets, and bullets into sublevels. Oddly, there is no direct
way to create a new slide in the Outli ne View, although you can convert a

DeltaGraph Pro 3
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bullet or sublevel into a Page title- effectively creating a new slide. You can
collapse the levels of the o utline and add speaker notes to any slide. These
speaker notes may be hidden or displayed in the Outline View. You can click
and drag a small icon alongside each slide number to rearrange the slides in
the presentation. You can modify the font, size, and style of all text in the
Outline View, but this change does not affect the actua l slides. Any text style
changes you make in the Outline View affects all the text in the Outline
View-there is no way to adj ust o nly a portion of the text.
Fig. 17.16
The Outli ne View
displays just slide
text.
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Using the Slide Sorter View
DeltaG raph Pro 3 also contains a Sorter View. The Sorter View is capable of
displaying all the slides in your presentatio n in two ways: a textual list (see
fig. 17.17) and a set of thumbnails (see fig. 17.18). In the textual list, you can
rearrange the slides by dragging them within the list, remove them from
displaying in the presentation, and pick a slide transition fro m a pop-up list.
The thumbnail view displays miniature views of the slides. You can rearrange
them or add/ rem ove them from displaying in the slide show.
Oue l oole t hm
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Fig. 17.17
The Sorter View as
a textual list.
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Fig. 17.18
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You can set the transition effects between slides only from the Sorter View. In
addition to picking the transition from a pop-up list as mentioned above, you
can select the transitions and other d isplay effects from a dialog box. There
are nine basic effects, such as wipe, window shade, iris, comer, and rain.
Many of these effects have suboptions. ror example, when you use the corner
effect, you can select which corner the slide appears from. You can select a
main effect and a suboption, and save th is combination in a "Named Transition " list for easy reuse. When you choose a transition, you can preview that
effect in the dialog box.
The Transition Effect dialog box also enables you to choose the d uration for
the slide on the screen or change slides manually. You can also attach or
record sou nds that play wh en th e slide appears.

Presenting the Material
DeltaGraph Pro 3 has a spell checker for cleaning up your text. You can selectively check any of the views and add unrecogn ized words to a personal dictionary. The spell checker will make suggestions for replacements for words.
You can d isplay your presentation on any Macintosh on which the program
is insta lled, but there is no runtime versio n of the product for displaying the
presentation on Macs that do not have th e product. You can con trol your
slide show either by setting the automatic options for th e slides (i ncluding
automatic loop-back) or by using a small o n-screen control panel to move
between slides. You can print the presentatio n o ut in fu ll size or in 10 different forma ts of handout, including one that fits 15 miniature slides on a page.
Some formats include areas for taking notes right on the handout, which is
very handy for your audience.

Bugs and Problems
There are, unfortunately, q uite a number of small bugs in this program, as
well as things that are difficul t to use. Bugs include:

DeltaGraph Pro 3
• When you change the slide tran sition , the p review of th e transition
effect continues to sho w the old effect.
• When you display the combination Cha rt View/Data View, th e Data
View displayed does not always m atch the Chart View.
• The Command Bar in the Data View is not redrawn properly after us ing
the Expression Builder.
• If you cut rows or columns of data from a Data Page, a crash can result,
closing DeltaG raph Pro 3, and losing all wo rk since the last save.
In addition to bugs, there are some things that make the product hard to
learn and use. These include:
• The Chart Advisor often suggests a chart for which there isn't eno ug h
data in the Data View page. If that happens, you are o n your own fo r
picking a chart.
• Even if there is just a single chart on a page, you must select the ch art
before you can make any chart modifications.
• The whole con nection between a chart in the Chart View and the Data
View page is difficult to learn and tedio us to use.

Getting the Most Out of Delt aGraph Pro 3: Hot Tips
• Prepare DeltaGraph Charts for Color Separation: you can prepare charts
to use in co lo r separati o ns. To do so, create the chart, then select Colors
from the Edit menu. In t he Colors dialog box, select CMYK (Cyan, Magenta, Yellow, Black) in the Color Model m enu and Custo m Colors in
the Co lor Set menu. You can then edit each of the colors to the exact
percentage specifications of your process color system guide, such as
Pan tone's guide. Once you enter the exact percentages, click the "Save"
button to save the palette. The colo r will then show up in the toolbox
color palette when you exit the Colors dialog. Apply the custom colors
to your chart.
• Link DeltaGraph Charts to DTP and Word Processor Documents:
DeltaGraph su ppo rts EGO (Edit Graphic O bj ect), which provides a dynamic link to DTP and word processor docu ments (System 7 is requ ired
for this) . Ho ld down the Optio n key while copying or exporting a
graph. This tells DeltaGraph to embed add itional information it needs
in order to edit PJCT when it is passed back from the word processor or
other client ap plication. Once the EGO PICT has been created, paste or
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import it into any client that supports EGO, such as WordPerfect.
Double-clicking the graphic in the client will launch and pass the chart
to DeltaGraph (the server) for editing. When the editing is com plete
and the DeltaGraph window is closed, the modified graphic is automaticall y passed back to the client.
• Avoid Repetitive Chart Formatting with Templates: Templates can save
you a lot of time if you tend to do the same charts over and over, formatting them to the same specifications for text font, size, and style,
title placement, and data series colors and patterns, label styles, or the
settings on grids, ticks, and axes. Templates are stored in Custom Libraries, which you can open or create by clicking and holding the Library
icon in the Command bar or choosing Libraries from the File menu. To
add a chart to a library, simply select and drag it into the library window, wh ere it will appear as a thumbnail icon. The chart can be saved
as a tem plate or with its data.
• Display Chart Templates: DeltaGraph will automatically open your
libraries and display your chart templates in the Chart Gallery if you
place your libraries in the "AutoLibrary Folder," which is located in the
application folder.
• Interrupt Drawing: You can interrupt drawing to save time. This feature
allows you to suppress redraw of graphics and charts until you have
made all the desired changes. In the Preferences dialog box, select
Drawing Preferences from the Option menu and make this selection
from the Drawing Options. During redraw, simply hold down the
mouse button to interrupt and ma ke other changes before redraw continues.
• Reusing a Tool from th e Toolbox: If you double-click a tool in the
toolbox, it will stay active rather than reverting back to the pointer after
the firs t use.
• Fix Data Gaps in Line Charts: If you have blanks in your data and try to
plot a line chart, the lines will stop at the blanks. You can select Span
Gaps in the Options dialog box and the points will be connected across
the blan ks.
• Quicker Access To Formatting: Control-click any draw, text, or chart
object in the chart view to display a dialog box changi ng a variety of
attributes. Only the appropriate att ri butes for the object show up in
the dialog box.
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Summary
DeltaGraph Pro 3 has the strongest charting of any of the packages looked at
here. However, there is a price for all this power: DeltaGraph Pro 3 also has
the steepest learning curve. There are a lot of confusing things about this
product as well, including the multitude of hard-to-interpret icons on the
command bar and the imposing array of options in the icons and the menu
options. I suspect that users coming back to this product after not using it for
awhile (many people produce presentation infrequently) will take some time
to get back up to speed.

Microsoft PowerPoint
Microsoft's PowerPoint first appeared about five years ago, making it one of
the oldest presentation packages around. It is one of the easiest to learn to
use, primarily because of its simplicity. It does not include many of the
special features that provide both power and complexity to other packages.
However, for a package you can pick up quickly and relearn after an extended
absence, PowerPoint is superb. Unlike most of the competition, PowerPoint
presentations can be played back on Macintoshes that do not have
PowerPoint installed.

System Requirements
PowerPoint comes on four disks, plus a two-disk set of true-type fonts, and a
disk containing the PowerPoint Viewer. A full installation of PowerPoint uses
8.4MB of hard drive space, including the Viewer. How much additional hard
drive space is taken by the true-type fonts depends on how many of the fonts
you have already. PowerPoint requires System 7.0 and 4MB of memory.

Using the Slide View

Tip
Power Point
can not run on a
Mac with System 6, unlike
many of t he
other packages
in cl uded here.

You use PowerPoint's Slide View to build individual slides. The Slide View
provides a variety of tools, including text tools, graphic tools, and a tool for
constructing graphs (see fig. 17.19).
Tip
Using Templates
PowerPoint supports "templates"-color schemes for the background of the
slides in a presentation. PowerPoint provides 160 different templates, arranged into groups based on the type of medium you will be using for the
presentation. Template groups include B&W overheads, Color overheads,
video screen, and 3Smm slides. As with other products that provide templates, PowerPoint's templates provide a con sistent color scheme, font set,

Power Point does
not have the
option of choosing from the
variety of layouts
that are available
in DeltaG ra ph
Pro 3.
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bullet style, and backgroun d throughout a presentation . However,
PowerPoint templates include only a single master slide.

Fig. 17.19
PowerPoint's Slide
Viewer provides
the tools to build
Slides.

You can load a new template at any time; however, only a single tem plate
can be used in a presentation . The dialog box for loading templates provides
a min iature preview of the templates.
Modifying the Slide Layout
You can change the layout of a slide in two ways. First of all, you can modify
each individual slide by clicking and dragging items on the slide to resize or
reposition them. You can also individually adjust the text font, size, and style
of any highlighted text. You cannot adjust bullet attributes from the slide
view.

Tip

The second way to adjust the layout of a slide is to change the master slide.
Each tem plate incl udes a Master Title block and a Master Body block (see
fig. 17.20) .

PowerPoin t
enables you to
decide whether
to apply a
change in the
Master slide to
slides on which
you have modified the formats.

The Master Body block sets the location and text attributes of bulleted text
on the slide. You can change the size and location of both blocks, the color
and style of bullets, and the font, size, and style of the text. Once you make
changes to the master slide, most slides are adjusted to match the n ew
template. However, PowerPoint does not override changes you have made
directly on a slide. If you want the master slide changes to apply to a slide
you ad justed yourself, you can use the menu option to reapply the master
to a slide. You can save changed master sUdes as a new template.
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Fig. 17.20
The Master Slide.

Adding Text to a Slide
To add text to a PowerPoint slide, you simply click in the title block or body
block and start typing. The Tab and Shift-Tab keys adjust the level of text and
bullets. You can click and drag bullets to rea rrange text on the slide. If you
move a bullet, all text levels below that bullet move as well. This makes it
qu ick and easy to rearrange text on a slide.
Adding Graphics to a Slide
PowerPoint has a good selection of graphics tools for customizing a slide.
These include rectangles, circle/ovals, curves, lines, and a free-form shape
tool. You also have a palette of specia l shapes, such as stars, arrows, triangles,
text balloons, and others. To add a shape to a slide, simply click the shape
and then click and drag the pointer on the slide.

Note
Once the shape is on the slide, it is difficult to move. You must click the shape's
edge-clicking inside the shape doesn't work.

You can add text to all shapes except lines simply by doub le-clicking the
border of the shape and typing in the text. This is handy for labeling shapes,
as the text moves when you move the shape.
You can apply a variety of fills to all shapes except lines. Thirty-six fill patterns are available, and you ca n independently choose the foreground and
background colors for the fill. However, you ca nnot create your own fill. You
can also fill a shape with a shaded background. Powe rPo int builds a shaded
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background from a single fi ll color. One "end" of the fill is set by the fill
color, the other end is set according to the intensity of the color that you
select. For example, you can choose a shade from a medium maroon to a very
dark maroon. The shad ing dialog box enables you to pick the fill color, the
shade of the fill color to fill to, seven shading directions (vertical, horizontal,
diagonal right, etc.) and one of four variations on this fill (see fig. 17.21).

Fig. 17.21
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You can set the weight and color of li nes for both lines and other graphic
objects. Any line attributes you set for non-line objects apply to the object's
borders. For lines, you can also set a style for any arrowheads you want to
use.
You can apply a drop shadow to graphic objects, setting the color and offset
of the shadow. Interestingly, if you have added text to an object, PowerPoint
applies a shadow to the text as well.
You can align the edges o r centers of multiple graphic objects. You can also
group objects together in order to move and size them as a single object.
PowerPoint en ables you to layer objects by sending objects to the front or
back. By using this tool, you can select which overlapping objects are visible
on top of other objects.
A series of toolbar buttons across the top of the screen enable you to set
exactly what attributes of a graphic shape you want PowerPoint to display.
The fill button determines whether a shape (and its shadow, if it has one) are
filled with color or transparent. The line button determines whether the line
border of a graphic shape is visible, and the shadow button determines
whether a shape's shadow is visible.

Building Graphs
Power Point's graphs are very simple, although they will serve the purpose for
most people. To create a graph, you must select the graphing tool from the
toolbar on the left side of the screen. When you click and drag an area on the
slide, PowerPoint o pens the graphing tool. All graph actions must be made in
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this separate program, which is somewhat more clumsy than making changes
directly on the graph in the slide.

Note

·

"

·

If PowerPoint is not properly installed, the OLE resources necessary to run the Graphing Program may not be available-preventing the graphing tool from working .

The graphing too l consists of two separate windows (see fig. 17.22). The first
window is a 'datasheet. Much like a spreadsheet, the Power Point datasheet is a
grid of rows and columns. The first row and column are used for labels, and
sample labels and data are always presented in a datasheet to get you started.
You can change the number in a cell (intersection of a row and column) by
simply typing over th e sample data. You can also widen the columns by clicking and dragging the column dividers.
Fig. 17.22
PowerPoint uses a
separate graphing
tool.

The second window in the graphing tool displays a sample graph. This window is where you make modifications to the d isplay characteristics of the
graph. You can size the graph window to make it easier to work with.
PowerPoint has a small gallery of graphs. These include area, bar, column,
line, pie, scatter, and combo. You can also choose 3-D versions of the area,
bar, column, line, and pie graphs. Each category of graph has several options
(up to 10). For example, if you choose a line graph, you can select from options th at display the plotted points, connecting lines, a logarithmic scale,
and others.
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You can add titles to the graph or to the axes. Once you add text, you can
modify the font, size, color, and style. You can set how the data labels display
and even add a line with an arrow to highlight certain points.

You cannot add text to the chart to use with the arrow!

Charts can have a legend, and you can set the line weigh t and style of the
legend border, as well as the fill color and pattern for the legend background.
You can also set the font for the labels in the legend. You can specify the
locat ion of the legend either by clicking and dragging or by specifying the
location in a dialog box.
You can custom ize the graph by setting major and minor grid lines, and
specifying how the tick marks are displayed. You can also set the line weight
and style for any axis. You can customize the data series by setting the line
weight and style, as well as the fill color and pattern.
Much as with DeltaGraph, you have quite a bit of control over 3-D graphs.
You can set the elevation and rotation from a dialog box that uses a wire
frame model to display how the changes affect the graph.

Tip
Unlike most
other packages,
you have full
control of the
text in the
Outline View,
and changes
you m ake to
the text style in
th e Outl ine
View do affect
the text on the
slide.

When you are finished working on a graph, you must exit the graphing tool
and return to PowerPoint. When you exit the graph program, you must
choose whether to update the PowerPoint presentatio n with the changes you
made in the graph tool.

Using the Outline View
PowerPoint's O utline View displays the text of the slides (see fig. 17.23). Each
slide in the presentation is represented by at least a title line in the Outline
View. Slides that contain bullets display aU their text, with the bullet text
arranged in levels in the outline. The text in the Outline View shows the
font, size, and style of the text on the slide.
You can click and drag bullets to rearrange the text. All levels below theselected bullet move with t he bullet. You can also use tools in the toolbar to
adjust the text characteristi cs. You can promote or demote a selected bullet
one level. If you promote a first-level bullet, PowerPoint automatica lly creates
a new slide. You can also create a new slide by clicking the new slide button.
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Fig. 17.23
The Outli ne View
displays the text
o n your slides.
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Note
Double-clicking the small slide icon alongside each slide title returns you to the slide
view to edit that slide.

Using the Slide Sorter View
The Slide Sorter View displays the slides in you r presen tatio n in min iature
(see fig. 17.24).
Fig. 17.24
The Sl id e Sorter
View.

!Ide \oner

You ca n rearrange the slides in th e Slide Sorter View by clicking and dragging
them . You can also create new (blank) slides. For each slide, you can set a
transition effect that d isplays wh en PowerPo int moves the slide onto the
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screen du ri ng a slide show. There are a wide variety of effects, and you can
preview the effect from a d ialog box. PowerPoint is very fast, and the effects
add pizzazz to the screen show without getting in the way.

Tip
You can leave
the notes area
blank and
distri bu te the
hando uts,
giving your
audie nce a
place to keep
their own
notes.

You can also set up PowerPo int to do "Builds" in the Slide Sorter View. A
Build displays first-level bulleted text (and all bullets in lower levels below the
displayed bullet) one bullet point at a time. You can set PowerPoint to "dim"
earlier displayed bullets when it displays a new bullet, and even display the
new bullet using any of the transition effects available for slide transitions.
However, you can use only a single transition for all the bullets o n a slide.

Using the Note,s View
The Notes View is unusual and very useful. This view presen ts a miniature of
the slide at the top of the page and an area to type notes below the slide (see
fig. 17.25). You can add explanatory notes and hand these pages out to your
audience, or you can type your speaker notes in the Note View for your own
use.

Fig. 17.25
The Notes View.
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Modifying the Masters
All of the special views in PowerPoint (Slide, Notes, Handout, and Outline)
have a master slide that sets the format of the view. Much as with Master
Slide View (discussed earlier), you can modify the masters for these other
views to customize the layouts. For the Note View, you can size the slide
miniature and adjust the note area and text font, as well as add text and
graphics. In the Outline View and Handout View, you can only add graphics
and text to the Master-you cannot change the actual layou t o r fonts.

Microsoft PowerPoint

435

Presenting the Material
PowerPo int enables you to print out slides on a single page o r use the Note
V iew. You ca n also print ou t hando uts with two, three, or six slides to a page.
You ca n clean up your presentatio n using a capable spell checker.
PowerPo int is o ne of the o nly presentation packages that does not require
that PowerPo in t be installed on the Macintosh used fo r the presentation.
Instead, the PowerPoint Viewer can be freely installed on other machines.
This is an important consideration fo r people who need to make presentations o n a large number o f machines (perhaps at d ifferent sites).

Hints and Tricks
• Create Slides Quickly: PowerPoint includes a few keyboard shortcuts for
people who want to get their thoughts do wn quickly. First, when you
create a new slide, you ca n add a title by just typing-anything you
type will automatically flow into the title box . After you've typed a title,
press option-return to automatically switch the focus to th e body. As
you type now, your text is entered into th e body of the slide. Press
optio n-return again, and you automatically get a new slide, w ith th e
focus on the title. You can use option-return to create title/bod y/title/
bod y in either slide o r outline view.
• Create presentations fro m existing reports: If you have a report created
in MS Wo rd, and you'd like to consolida te it in to a presentation , si mply
open the document in PowerPoint. PowerPoin t will auto matically distill
the o utline levels used in the document into a presentation.
• Instant d uplicates: To duplicate any object instantly, ho ld down the
Option key, then select t he o bject you wish to duplicate and drag off a
"duplicate" of the ob ject. Positio n the duplicate version where you
want it. If you want another copy made using the same relative position
offsets, select Dupli cate Again from the Edit menu o r use Option-D.
• Changing Drawing Defaul ts easily: Draw an object like a rectangle, and
give it t he line, fill, line style, shadow, etc., properties t hat you want for
your defaults. W ith this object selected, click th e Pick Up Styl es
(eyed ropper) button o n the toolbar. Now unselect al l objects o n t he
slid e and click the Apply Styles (eyedropper) button o n the toolbar.
When yo u use apply styles with no object selected, it applies the attributes to the p resentatio n defaults.
• Select the object you want: If you're having trouble selecting exactly the
object you wa nt in a complex drawing, use the Tab key to sequentially
select each object on the slide.
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• Repair freehand drawings: At any time when you are drawing with the
Freeform tool, you can hold down the Delete key to back up any drawing you did and "erase" part of your work. Erase back to the point
where you were satisfied with the drawing and then continue drawing
again.
• Quick-Draw in Slide Sorter: If you don't want to see each slide drawn in
miniature in the slide sorter, press the Esc key while PowerPoint is
drawing the miniatures. Any miniatures drawn after the Esc key is held
down will be quickly drawn as slides with a large X across them.
• Position Objects Precisely: PowerPoint has a "magnetic grid" which is
usually on. This grid helps you align objects quickly and easily. There
are times, however, when you want to temporarily ignore the grid. This
can be accomplished by holding down ~ . While you hold down ~. the
grid is temporarily turned off.
• Adding text to a graph: It would be handy to add text to a graph, especially for labeling arrows. However, th e graph tool doesn't let you do
this. Instead, you can use the text tool to add text blocks on top of the
graph. Once you have typed in yo ur text block, select the text block
and the graph and use Group from the Arrange menu to group them
together.

Summary
Microsoft's PowerPoint is on e of the simplest presentation graph ic tools
around, but that doesn't mean it won't do the job for many people. This
product is so easy to learn that most people won't need the excellently written manual, and the fact that it offers a Viewer module makes it attractive to
people who m ust do presentations at multiple sites.

Astound
Another new challenger in the business graphics field is Gold Disk's Astou nd.
Available in both Windows and Mac versions, Astound files are not only
compatible between the products but even include players for creating a
stand-alone presentation for both versions. Astound's charting mod ule is
not very strong, but this package excels in the special effects depa rtment,
enabling you to easily incorporate more transitions than any other package
reviewed here. Astound also makes it easy to incorporate sound and
QuickTime movies and includes some of the friendliest documentation
available fo r computer software products.
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System Requirements
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Perhaps because of all the sounds, clip art, and QuickTime movies included
with this package, Astound is BIG. The package comes on nine disks, and a
full install consumes nearly 21MB of disk space. The package requires System
6.0.8 or later, and 2MB (4MB recommended) of memory. You should also
have a 68020 or faster microprocessor. System 7 support includes Publish and
Subscribe, Balloon help, and QuickTime 1.5 compatibility.

Building Slides
When you first create a presentation, you have the option to choose a template for the slides. Astound is packaged with matched sets of templates that
control the color scheme as well as the font styles used for text levels on the
slides. The dialog box provided for selecting the templates displays a thumbnail preview of th e slide styles included in the template (see fig. 17.26). You
can apply a new template at any time, but the new template applies to all the
slides in the presentation. Each template has about a dozen slide styles. These
styles contain various placeholders for charts, title text, graphics, and bullet
text. Each time you create a new slide, you ca n select from one of the available slide styles in the template or create the slide with no master (e.g., a
blank background).
Switch hmpl•te

~~§§;:;:!,., =.._....., ... ~(De<tlop)

Modifying the Slide Structure

You can change the layou t of a slide in two ways. The first way is to directly
modify the slide. You ca n click and drag the placeholders to new positions on
the slide, as well as add new placeholders to the slide. The placeholders can
include a title, bulleted text block, charts, etc. You can apply new background
schemes (solid colors, color gradients, picture, etc.) and change the font, size,
and style for any text o n the slide. There are two ways to change t he style of
text on a slide. First of all, you can select the text and make selections from
the Text menu. You can also double-click the text level indicators in a
bulleted text block.

Fig. 17.26

You can see
thumbnails of the
slides when you
select a template.

438

Chapter 1 ?-Presentation Graphics

Tip
If you modify
the properties of
a text level by
clouble-cl icki ng
the text level
indicators in
the text block,
you can modify
the symbol that
Astound uses
for a bu llet, the
bullet color, and
the paragraph,
line, and character spacing.

The second way to modify the structure of a slide is to directly modify one of
the slide masters. You can use any of the slide modification techniques mentioned above.
If you modify a master, any slide that uses that master will be changed to
match the new arrangement. You should make any changes to master slides
prior to building slides that use tha t master, since changes you make to a
master override any changes you have made to the slide itself. Astound is less
versatile in this respect than PowerPoint, which preserves any changes you
have made to a slide unless you specifically reapply the master.
Note
Astound lacks a slide on which you can make changes that are applied to all masters.
Thus, to add a graphic to the background that will appear on all slides, you must add
the graphic to all the master slide types.

Adding Gra ph ics and Text t o a Slide
You can add graphics and text to any slide in your presentation. Astound
includes tools to easily customize text and graph ics as well.
Tip
Astound incl udes m o re
pattern fi lis
than any other
package.

Astound's Text tool enables you to add text to a slide. When you click the
slide with the text tool, Astound provides an instant text block tha t you can
type in (see fig. 17 .27). The text block includes tools for selecting the text
level, alignment, tabs, indents, and margins. You can also set the text level by
pressing the Tab key to increase one level, and the Delete key to decrease one
level. Once you have added text to the block, you can change the font, size,
and effect for either the entire block or just for any text you high light. You
can apply a pattern fill (selecting from 60 patterns) or a color gradient to the
text in a text block. However, you cannot apply the pattern fill or color gradien t to the text block background.
Astound provides a palette of graphic shapes you can use. These shapes
include the standards (rectangles, rounded-corner rectangles, circle/oval,
triangle) as well as some unusual shapes, such as stars, text balloons, arrows,
free-form shapes, and free-form curves. You can add a shadow to any shape,
and set the shadow offset from a well-designed dialog box that enables you to
simply click and drag the shadow. You can set the shadow color, inside fil l
color, and border color, as well as the weight of the border li ne.
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Fig. 17.27
Astound's text
block includes
many text
fo rmatting tools.
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Adding Charts to a Slide
Astound's charting tool is simple but should meet th e needs of most people
(see fig. 17 .28).
Fig. 17.28
Astound has a
simple charting
tool.
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Tip

As with o ther business graphics packages, you can enter da ta in a spreadsheet-like datasheet or im port data from Excel, Lotus, o r Delim ited tex t fil es.
You use the first row and col umn of the datasheet for t he axis labels. You can
resize the column widths by clicking and dragging.

Unli ke
DeltaGraph Pro
3, Astound does
not include any
functio ns for
sum ming data.
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Once you have created a datasheet, you can highlight the data you want to
include in a chart and create the chart. Astound includes 13 chart types, including bar, 3-D bar, pie, 3-D pie, line, area, high/low, and stacked bar. You
can also create pictograph charts using clip art.
You can customize a chart in many ways. You can adjust the color, spacing,
depth, and width of data series, set the number format, and the typeface used
(font, size, and style) for each axis, as well as the legend and title. You can set
the type of legend, as well as its location. You can also determine whether to
show the floor panel, labels, ma jor and minor grid, inside or outside tick
marks, and the maximum and minimum for each axis. You can set the properties of grid lines (weight and colo r) individually, as well as any text labels.
Once you have everyth ing set up the way you want, you can even save a
chart format for reuse later.
Caution

-

You should set the text label formatting options before making changes to the individual text labels using the text format tools because the text label formatting will
override your individual changes.

Astound can also display a table containing the selected results from your
datasheet. For this table, you can customize grid-line size and colo r, the border size, the typeface used for row and column titles, as well as the typeface
used fo r the chart title and chart values. You can also set the number format
and the table's interior color.
Adding Clip Art to a Slide
Astound comes with over 500 pieces of "clipmedia," arranged into libraries.
To add a piece of clipmedia to a slide, you must open the library. The library
window displays the images included in the library. Once the library is open,
you simply click and drag the image onto the slide. You can change the size
of clipmedia wi tho ut affecting the quality of the image, but you cannot
change the color or other properties. Unlike some other products, you cannot
ungroup the parts of a piece of clipmedia so that you can modify the individual parts.
Adding Actors to a Slide
Another unique feature of Astound is its use of Actors. Actors are small animations that play when the slide that contains them is displayed during a slide
show (see fig. 17.29). You can choose whether the Actor will play through its
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an imation sequence just o nce or anim,ate continuously while the slide is on
the screen. Astou nd includes about 20 Actors.

IV

Note
To create your own Actors, you must purchase a copy of Gold Disk's "Animation
Works."

Fig.17.29
Actors are sm all
animated characters that move
during your
sli deshow.

You can estabHsh a path for the Actor to follow. If you do, the Actor will
move across the slide, following the path as it an imates. The path is a simple
straight line; however, you can create both an entrance and exit path for the
Actor using an intera ctive dialog box.
Adding QulckTime Movies to a Slide

Astound comes with a variety of QuickTime movies. You can add a movie,
and the movie will play when the slide it is o n is displayed during a slide
show. Astound even includes a QuickTime editor, which you can access by
d ou ble-clicking a QuickTime movie. The editor enables you to choose
w hether the movie plays just o nce o r loops continuously, set the loo p direction (only forward, or play forward, then backward), set the sound volume,
and set the animation speed. Using the editor, you can also view any frame of
the animatio n and decide which static frame to display on the slide when the
slide show is not playing.
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Adding Sound to a Slide
Astound handles sounds as easily as it handles movies. The Sound tool enables you to load a sound, edit or play a loaded sound, record a new sound
(provided you have at least a microphone), and attach the sound to a slide.
Once a sound is attached to the slide, you can set its volume, determine
whether it should play just once or loop continuously, and decide exactly
when the sound should play (e.g., the sound should play during the last
three seconds that the slide is on-screen). Astound comes with a collection of
sound effects and music.

The sound editor displays the sound waveform in a window. You can display
th e waveform in various ways and change the waveform magnification to
make it easier to work with. The sound editor enables you to cut, copy, and
paste portions of the sound waveform.
Astound also enables you to add narration to either the current slide or to the
entire slide show using the sound tool. When you add narration, Astound
plays either just the current slide or the entire presentation. You can speak or
input a music soundtrack wh ile the slideshow is playing. Astound then automatica ll y synchronizes the slideshow to the "narration." This is very handy
for a self-running presentation. You can even select the sampling rate,
whether the sound is mono or stereo, the amount of compression, and the
number of bits (8, 16, or 32) used for sampling.

~~
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I

Adjusting these settings enables you to trade sound file size for recording quality.
For example, you can easily use a 5 kHz sample rate, 8-bit sampling, mono, and 3:1
compression for voice with little loss in quality. However, a music sound track would
require at least a 22 kHz sampling rate and a 16-bit sample size in order to reproduce
accurately.

Tip
Astound's color
gradient tool is
more powerful
than any of the
others because
it can use mul-

tiple colors.

Using the Color Gradient Tool
Astound's color gradient tool is especially versatile (see fig. 17.30). You can
create a gradient from a single color or select multiple colors that the gradient
moves through. For example, you could select a gradient that starts with red,
moves through blue, and ends up at green. You can select from six pattern
directions fo r the gradient, such as up/down, upper left corner to lower right
corner, from center, and so on. You can even cause the gradient to "burst"
from a selected object on the slide. Once you have creafed a gradient, it is
available for reuse from a pop-up box on the slide. You can also recall a gradient and make changes to it fro m the gradient editor.
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Fig. 17.30
Astound's color
gradient tool
enables you to
create a multitude
of gradient effects.
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Using Fill Patterns
Astound's fill tool provides 60 different fill patterns but does not provide any
way to create your own pattern. However, you can set the foreground and
background colors independently fro m a pop-up "color-picker," ava ilable
from sm all buttons at the bottom of the screen.
Using Libraries
As mentioned earlier, clipmedia is packaged in libraries. Opening a library
displays a window containing the contents of that library. In addition to
clipmedia, you can open libraries of QuickTime movies, sounds, and Actors.
You can also create your own libraries of reusable objects. To add an object to
a new o r existing library, you click and drag it to the library windows. Oddly,
although prepackaged objects have a name that appea rs below the object in
the library window, there doesn't seem to be any way for you to add a name
to your own objects or rename the objects in a prepackaged library. You can
open any presentation you have created as a library, enabling you to reuse
slides from that presentation easily.

Using Buttons and Interaction
Another powerful feature of Astound involves Interaction. You can set any
object on the screen to perform a prespecified action when you click the
object. These actions include m oving to a predetermined slide, moving to the
first or last slide, restarting the slide show, going back o r forward o ne slide,
or stopping the slideshow (see fig. 17.31).
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Fig. 17.31
Astound's
interactive fea tures
enable you to
closely control
your slides.
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To help you use Interaction, Astound provides a Button tool. You can attach
interaction to a button just like any other object, but since you expect to be
able to click a button , it is more natural to attach interactions to buttons.

Making Transitions
Of all the packages reviewed here, Astound easily does the most outstanding
job on Transitions. There are 22 slide transitions, including wipes, dissolves,
tiling, snaking, and roll-ins. For most transitions, you can specify an edge or
corner for the transition to start from. When you select a transition, Astound
displays a preview using a miniature of the slide.
Slide transitions are just the smallest part of what Astound is capable of.
You can apply transitions to text blocks, graphics, titles, QuickTime movies,
Actors, charts, data series in charts, and sounds. Except for sounds (where the
transitions are limited to fade in and fade out), you can apply about 20 diffe rent transitions to an object, and use separate tra nsitions for entry and exit.
These transition s include wipes, dissolves, fades, pixelates, zooms, and many
others. The Select Object Transition dialog box enables you to see a preview
of the transition you choose (see fig. 17.32).

Fig. 17.32
Astound's
transitions are
one of its most
rema rkable
featu res.
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In addition to the normal transitio ns, you can apply special text transitions
to blocks of text, including title blocks. Using these text transitions, you can
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cause blocks of text to move onto or off the screen one letter at a time, one
line at a time, or one paragraph at time. You can set the entry point (top,
lower left corner, etc.) and an additional special effect, such as whether the
text bounces slightly when it reaches its destination. You can also force
Astound to wait for a mouse click between text transitions.

IV

Note
By combining the wait for mouse click with single line transitions, you can build the
text block on a slide one line at a time. This gives you the ability to discuss each
bullet point before moving on to the next one. Unfortunately, Astound cannot automatically dim previous bullet points.

Using the Timeline
With all the transitions, movies, and sounds you can apply to a slide, you
need a way to coordinate the effects. For example, if you attach two sounds
to a slide, how do you ensure that they don't play at the same time? Using
Astound's Timeline tool, you can determine exactly when each action should
happen and synchronize items (such as a text bullet and a sound)
(see fig. 17.33).
Fig. 17.33
The Astound

Timeline Window.

What Is a Tlmeline?

Each time you add an item to a slide, you can adjust the timeline for that
item. The overall timeline indicates the user-defined length of time that the
slide will be on the screen during a slideshow. The length of time that the
object is displayed o n the slide is represented by a solid blue bar. If the blue
bar is of shorter duration than the overall slide, you can click the blue bar
and d rag it-positioning the appea rance of the object at a different place in
the time sequence. For example, if you place a 5 second sound on a 15 second slide, you can drag the sound's bar so tha t it plays when the slide is first
displayed, at the end, o r anywhere in between.
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Transitions and the Tlmellne
In add ition to the "no rmal display" blue bar, an object's timelinc has two
other parts: the entry transition and the exit transition. These tra nsitio ns are
d ispla yed as striped blue bars, and you can click and drag special indicators to
set the amount of ti me used for the entry and exit transitions.
I

,

Note
If you allow no time for the transitions, then the set transitions will not play.

The speed of the transitions depends o n how much time you allow fo r them.
If you allow a lot of time, the transitio n plays slowly. If you allow o nly a
sh ort time, the transition must occur very fast and may appear jerky as a
result. You can ask Astound to set the best transition time, based on the
complexity of the transition.

Synchronizing Items on the Tlmellne
Astound's Timeline tool displays a small window containing timelines for all
the objects on the slide. At the left end of each timeline is a small icon that
indicates what type of object each timeline is fo r. If you click the icon, a
small preview of the item appears in the upper left corner of the dia log box.
You can individua lly adjust each timeli ne, includ ing the entry and exit transition times. The Timeline tool enables you to synchronize th e effects and
ensure that they work well together. For example, it is easy to en sure that two
sounds don't play at th e sam e time.

Using the Outline View
The Outline View presents each slide in your presentatio n in the fo rm of a
textual outline (see fig. 17.34).
Astound displays the title of the slide in bold, and any text on the slide is
displayed just below the title. Differen t types of text (e.g., bulleted text blocks
and the title) are separated by a line. Bulleted tex t is sh own as an o utline,
with the va ri ous bullet levels represented as o utline levels. You can collapse
th e text under a slide title so that just the title is d isplayed, and you can click
and drag a small arrow indicator to move a line of text. Unfortunately, you
can move o nly a single line of text at a time-text sublevels do not move
automaticall y w hen you move the level that the text sublevels belong to.
You can add text at any level in th e outline, and that new text is reflected
on the slide. Although the Outline View does no t display text format ting
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(e.g., style, size, etc.), you can determi ne the text formatting by highligh ting
the text yo u are in terested in and using the Text menu to check the typeface.
You can change the ty peface using the Text menu, and the slide will reflect
the change even tho ug h you can' t see the change in the Outline View.
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Using the Slide Sorter View
As with most other business graph ics products, Astound enables you to view
your slides in a miniature Slide Sorter view. You can click and drag the slide
miniatures to rearrange them, view the slide's timeline, and double-click any
slide to return to the slide view with that selected slide on the screen.

Presenting the Material
You can check the spell ing of words in your presen tation with Astound's spell
checker. You have the option to spell check just a single slide, or the entire
presentation . The spell checker presents suggestio ns fo r words it doesn't recognize. Unfor tunately, common abbreviatio ns are not in the main dictionary,
so you will have to add them.
Astound makes it very easy to test your presentation . The slide view contains
a button that plays back just the curren t slide- this feature is very handy fo r
testing transition s. You can use the built-in slideshow to play back the entire
presentatio n, just the current slide, o r the presentation from the current slide
fo rward. You can set the slide duratio n to the no rma l slide d ura tion (you can
set this qua ntity fro m the slide view) o r an override d urat ion (e.g., three
seconds per slide). This is also handy for moving quickly th rough the
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Fig. 17.34
Asto u nd's Outl ine
View.
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presentation. You can set the presentation to wait for a mouse-click before
advancing to the next slide, adva nce whenever the mouse is clicked (overriding all time durations), loop back to the start when the presentation is done,
and show the cursor.
Astound also supports 4 "nota tion pens," each with a differen t color. During
a slide show, you can use the mouse to draw on a slide by pressing a number
key to set the color and then clicking and dragging to draw on the slide (see
fig. 17.35). Since one of the presentation settings tells Astound to advance to
the next slide when you cl ick the mouse, you can use the space bar to pause
the presentation, allowing you to click and draw on the slide at any time.

Fig. 17.35
You can draw on a
slide using the
notation tools.
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Astound can print slides, notes, the outline, and handouts. You can add notes
to each slide in the special note view. You can select from six handout formats-ranging from one to six slides per page. Astound provides a lined area
adjacent to each slide for taking notes.

Getting the Most from Astound: Hints and Tips
• A powerful and easy-to-use function that many users don't take advantage of is the Distribution button in the Timeline window. Use this
button to create an even distribution of selected ob ject entrance and
exit transitions. Simply select the objects you want to distribute over
time, click the Distribution button, set the total time for transitioning
all of the selected objects, and select the icon that represents how much

Astou nd
overlap you would like between the object transitions. Astound then
automatically calculates the proper timeline for each object.
• By default, Astound assigns the same entry transition to each element
of a chart, but it's easy to override the default transition. Double-click
the chart element you would like to edit, and then open the Object
Transition dialog to select a new entrance transition. Using this
method, it's easy to have each bar in a bar chart appear in a different
manner.
• Normally, grouped objects are displayed in a timeline window as a
single object. If you double-click a grouped object's icon in the timeline
window, you can display the individual timelines for all of the objects
in that group. This allows you to adjust the transition, timing, and
other aspects of any object without disturbing the entire group.
• The button tool is great for creating interactive buttons with a 3-0 look,
but many people like to use the button tool for creating interesting
graphic backgrounds. By adjusting the beveled edges on the button,
you can create an object that looks like a raised plaque or a carved inset
on your background.
• Because Astound allows you to set an entrance time as well as an exit
time for each object on a slide, you can find that it is sometimes useful
to combine what would be several slides into a single slide in which
text, charts, and graphics appear and disappear at different times. This
can sometimes result in a presentation with more continuity, and it
also allows you to have fewer breaks in your sound effects. If you end
up with object on top of each other, you can easily select the object
underneath using the Timeline window.
• To cause an object to fade into the background, draw a box on top of
the object you want to fade out. Use a shade of gray for the box color.
Select an Ink mode of Whiter or Blend from the Object menu. These
modes can make objects appear more faint, but still be visible. Using
the Timeline window, make this box appear on the slide at the time
that you want the graphic underneath to fade.
• Some complex objects can appear jerky when you apply transitions
to them. Objects with gradient fills are especially hard to animate. A
simple solution is to use the Convert to Bitmap command in the Object
menu. Once the object has been converted to a bitmap, it will display
much faster. You should also use Convert to Bitmap on existing
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bitmaps that you have resized in Astound. If a bitmap is not displayed
on the slide at its original size, then Astound needs to scale it each time
it gets displayed, hampering performance. Applying the Convert to
Bitmap command creates a copy of the original bitmap at the new size,
resulting in much faster playback.

Summary
Astound combines excellent multimedia support (movies and sound) with a
remarkable range of transition effects. The Timeline support is unique among
the packages reviewed here. The charting support is a little weak, and there
is no support for the types of business objects ("models") that make Claris
Impact such a strong contender.

Persuasion
Aldus Persuasion was one of the original presentation packages available for
the Macintosh. It is still one of the most powerful, although the charting
module is a little weak, and there are some usability problems-quite a few of
the operations in Persuasion are not very intuitive. There are also some items
that simply don't work, such as the Organization Chart module, which absolutely refuses to appear on a slide. Thus, if you need organization charts,
you' ll have to choose something else. ·However, the slide transitions, while
not as strong as those in Astound, are more powerful than most of the other
packages.

System Requirements
Persuasion comes on nine disks, and takes up 34.8 megabytes of disk space.
This makes it the biggest package looked at in this chapter. Strangely, except
for some clip art, Persuasion does not come with a lot of extra material, so
there isn't really any way to cut down on the disk space used. The install
procedure requires rebuilding the desktop-so if you use Persuasion, you will
lose any desktop notes. Persuasion requires at least System 6.0.4 and SMB,
but many features are not supported with this minimal configuration. To
make full use of Persuasion, you need at least System 7 and 8MB of memory.
Even with this configuration, some operations may fail because of a lack of
memory. System 7 support includes Publish and Subscribe, Balloon help, and
QuickTime 1.5 compatibility.

Building Slides
Prs supports "Autotemplates"- standard slide configurations that you can use
to give a common look to your presentation. Each autotemplate consists of at
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least five masters" and a background. Masters are commonly used layouts,
such as a title block and body text, title and chart, and so on. When you first
install Persuasion, you can choose a default autotemplate. This default template is opened automatically whenever you create a new presentation. While
it is not hard to choose a new autotemplate in place of the default template,
it is an extra step you must take every time you create presentations.
Unlike other packages, Persuasion does not prompt you automatically for
an autotemplate. Changing the default autotemplate is quite an involved
process. This is just one example of where Persuasion could benefit from
improved usability. If you do choose to change the autotemplate, you can
preview the available autotemplates from a dialog box.
I/

Modifying the Slide Structure
You can directly modify the structure of a slide by clicking and dragging text
blocks, graphics, charts, and other objects on the slide. Oddly, you can't click
and drag a text placeholder until you have actually entered text into the
placeholder-every time you click the text placeholder, Persuasion switches
to the text tool so that you can enter text. This is another usability problem.
You cannot apply a new background scheme directly to a slide, although the
manual gives the impression that you can. You can modify the font, style,
color, and effects for any text using a variety of palettes (see fig. 17 .36). You
can reapply the master to a slide to return to the default formatting for that
master.
Fig. 17.36
You can use
Persuasion's
palettes to
modify a slide.
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You can also modify the slide structure by directly modifying a master. You
can add placeholders to the master and rearrange the position of items on the
master. If you modify the text properties, Persuasion uses the specified properties for bulleted text on the slide. You can create new masters and name
them or import masters from other Autotemplates.
Persuasion does a better job of enabling you to modify backgrounds for slides
than just about any other package. You can modify the standard background
for an autotemplate; that change is reflected on all slides. You can add graphics and page numbers to a background, but you cannot add placeholders, so if
you want a text block placeholder on every slide, you must modify each master. You can import a color scheme from another autotemplate, and either
replace the current background or add the new background to a list of available backgrounds. You can also create a new background using the fill and
drawing tools available in Persuasion. Once you have created new backgrounds, you can apply any available background to a master.
Adding Graphics and Text to a Slide
Persuasion has a whole palette of text and graphics tools for customizing
a slide. You can use the text tool to add text blocks, and set the font, size,
color, and effects for the text. You can also add a shadow to the characters in
a text block, making for an excellent 3-D effect.

Graphics tools include rectangles, lines, ovals, freeform shapes, and freeform
curves. You can fill the interior of a shape with a color, or a gradient fill.
Oddly, patterned fills don't seem to be available. A line tool enables you to
easily pick line thickness and type, as well as the arrowhead style for the line.
You can choose multiple objects and align them vertically or horizontally.
You may also distribute them evenly along a line. You can group multiple
objects into a single object and flip or rotate any object.
Persuasion's color palette tool is not very intuitive. The colors are labeled
with object names (for example, Title or Body), but you can pick any color for
any object. The buttons across the top of the palette enable you to pick colors
for lines, background, text, and shadow, but they are poorly labeled and hard
to figure out. You can also double-click any color to open a color-definition
tool (see fig. 17.37). After opening the color-definition tool, you can copy and
paste a color from the palette of available colors to replace a color in the color
palette. It would have been easier to allow the user to simply click a replacement color.
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~~~~~-------------~
nHTA~nH~~ ~
~
~
~
R: D

453

Fig. 17.37
Persuasion's Color
Definition Tool.

'1.

G: 67

'4

8: 62

'4

You can import QuickTime movies into a slide. Unlike Astound, you have
very little control over when movies play-they play automatically when the
slide is displayed during the slideshow.
Adding Charts to a Slide
Persuasion includes a simple chart builder that should meet the needs of
most people (see fig. 17.38). Unfortunately, the charting application is a separate OLE (object linking and embedding) application, and it takes a long time
to open. You must reopen the application each time you want to modify the
chart.

Tip
For complete
control of
QuickTime
movies, Astound does a
better job than
Persuasion.

Fig. 17.38
Persuasion's Chart
Application is
simple but
effective.

Persuasion 's chart gallery includes basic types of charts, including bar, pie,
histogram, high/low, line, area, scatter, polar, radar, and spectral. Many of
the basic types have additional options, and Persuasion presents a thumbnail
preview of the chart type as you move the mouse pointer over each type of
chart.
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After you choose a chart fro m the gallery, Persuasion draws a sample on the
screen, using sample data. You can edit the data in a spreadsheet-like table.
You can also import data from Microsoft Excel and several standard formats,
such as CSV files. You enter the title, subtitle, and axis titles in the first few
rows of the datasheet, but once again, the controls fo r the datasheet are not
very intuitive. In fact, despite the fact that the datasheet visually displays
where axis titles are going to be placed, no combination of the many poorly
explained controls could convince Persuasion to actually place the axis titles
in the righ t place! As a result, the charting module gave disappointing results.
1 finally had to resort to manually clicking and dragging the axis labels where
I wanted them.
You can modify text attributes, but only for all text of a particular type. That
is, you can select any piece of text (e.g., one of the x-axis labels) and change
the attributes, but the attributes change for all the text of that type (e.g., all
the x-axis labels change). You can change the color of all grid lines and any
of the data series, as well as the color and gradient fill pattern for any "walls"
that appear in back of the data series. You can even apply gradient fills and
picture fills to any object.
Persuasion has very complete 3-D chart controls. You can rotate the chart
around any of the axes, move the chart in any direction, zoom in and out,
pan, and adjust the perspective. The 3-D control dialog box previews the
changes as you make them, and it's actually a lot of fun to play with these
controls.
Adding Clip Art to a Slide

Tip
Astound lets
you attach a
Jum p action to
a button, in
addition to
other screen
objects.

Persuasion comes with about 500 pieces of clip art, arranged into groups such
as arrows, buildi ngs, communications, computers, and people. You must
import the clip art from a dialog box that does not actually show you a preview of the clip art unless you click a button to build a thumbnail preview.
Depending on the complexity of the diagram, building a preview can take up
to 15 seconds. However, once you have built a preview, it is available whenever you look at that piece of clip art. You can ungroup the clip art sh apes
and edit them using Persuasion's drawing tools.

Using Jump
Persuasion enables you to assign various jump action s to any object on the
screen (see fig. 17.39). Clickin g the object during a slide show causes Persuasion to take the specified actions. Actions can include jumping to the next
slide, jumping to a specific slide, and opening an app lication or document.
While not as powerful as Astound, the Jump feature is not as common in
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Macintosh business graphics packages as it is in Windows, so this is a
welcome feature.
Fig. 17.39
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Making Transitions
Persuasion does an excellent job with special effects, including slide transitions. You can assign each ob ject on a slide to a layer, and add one of 15 transitions to each layer. The layers are animated in layer number order. Thus,
you can cause various objects on the slide to appear using different effects.
Transitions include Fade, Glitter, Wipes, and Dissolves. You can attach a
sound to each layer transition. Oddly, you can assign o nly the first layer transition and sound from the slide. To assign transitions and sounds for other
layers of a slide, you must use the Transitions dialog box (see fig. 17.40).

Fig. 17.40
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Autolayer is a very handy feature of Persuasion. When you click a text block
and select Autolayer, Persuasion breaks up the block of text by paragraph or
topic (e.g., major bullets). Each layer or topic is placed into a separate laye r
automatically. Since Persuasion places each layer on the screen one at a time,
the effect of autolayering is to bring each point you want to make onto the
screen individually. You can choose a "dimming" color so that earlier layers
are dehighlighted when Persuasion places new layers on the screen. You can
also assign a transition to each layer. The combined effect of a new paragraph
or topic, coupled with the transition, is sure to catch your audience's attention.

The Transitions
dialog box enables
you to set
transitions for
each layer of a
slide.
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Tip
Unlike Astound,
you canno t
specify an exit
autoanimatio n .

Another attention-getting feature is autoanimate. Autoanimate enables you to
select any object and have it move onto the screen. The effect is very
simple-you can only choose the edge from which you want the object to
appear. The object moves across the screen to its dest ination.

Using the Outline View
The Outline View presents each slide in your presentation in the form of a
textual outline, with bulleted text levels displayed as levels in the outli ne.
You can promote and demote levels and move levels (with all their sublevels)
around in the outline. You can also collapse the text under an outline so that
only the major headings are shown. You can change the text attributes in the
outline, but those changes are not reflected on the slide. You can add text at
any level in the outline, and the n ew text is displayed on the slide.

Using the Slide Sorter View
As with most other business graphics products, Persuasion enables you to
view your slides in a miniature Slide Sorter View. You can click and drag the
slide miniatures to rearrange them and double-click any slide to return to the
slide view with that selected slide on the screen.
One unique feature of Persuasion's Slide Sorter is that you can create a new
slide and demote other slides under it (see fig. 17.41). If you do, the headings
of all those other slides appear on the new slide automatically. This is great
for an opening agenda slide. If you modify the other slide titles, Persuasion
automatically makes the changes on the agenda slide.
Fig. 17.41
The slides in this
presentation are
"demo ted" below
the first slide. As a
result, the titles of
all slides appear as
bullet tex t on the
first slide.

Presenting the Material
You can check the spelling of words in your presentation with Persuasion's
spell checker. You have the option to spell check just a single slide or the
entire presentation. The spell checker presents suggestions for words it
doesn't recognize.
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Persuasion 's slide viewer is very useful. You can preview just the current slide
or play the entire presentation. You can set the delay between slides, but you
must set a time- you cannot leave a slide on the screen until you click the
mouse or press a key. You can set the entire presentation so that all slides
wait for a manual advance, but you must do this every time you run the
slideshow.
Persuasion contains a note master that you can modify. The note master
displays a miniature of a slide and provides space to type notes below the
slide. You can modify the note master by changing the position of the slide
and the text attributes of the note space. You can also add objects (such as a
page number) to the background. Persuasion also has a handout master fo r
printing audience handouts (see fig. 17.42). The handout master contains
o nly a basic layout with three slides and lines for taking notes adjacent to
each slide. You can add m ore slide placeholders, but this is tedious because
you must manually edit everything on the hando ut master (each line in the
note area is a separate object) to make room for the new slide.
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Persuasion comes with players for bo th the Macintosh and Windows,
so you can play your presentation on any machine, even if Persuasion is
not installed on it.

Getting the Most from Persuasion: Hints and Tips
• To change the default settings for font, point size, style, alignment, or
character and line space settings, choose Text Forma t from the Edit

Fig. 17.42
Persuasio n's
Handout Master is
hard to modify.
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menu, and make your changes. Then, in the Text Format dialog box,
click the Set Default button.
• If your presentation has a dark color scheme, change the color system
to Inverse Grayscale or Black and White before printing proofs on a
laser printer.
• To change the background of a slide, first switch to that slide's master
using Slide Master from the View menu. You can only adjust the background of slide masters.
• Use the arrows or the edit boxes on the nudge palette to move objects,
text, and shadows incrementally.
• To easily line up objects on separate slides in the same position, drag
guides onto a new background you create. If the guides aren 't visible,
choose Guides fro m the Show menu, and then check Show Guides
on the submenu.
• To change any colored Autotemplate to black and white, choose Color
System from the Show menu, and then choose Black and White from
the submen u.

Summary
Using Persuasion can be a constant battle to make it do what you want. Many
actions appear to be sim ple, but you are often blocked from performing common actions for no apparent reason. A good example is the fact that you
can't change the background of a slide without first en terin g the slide's master. The manual doesn't help: it is difficult to read because it is broken up
into chun ks that are hard fo r the eye to follow. The manual organization is
also very poor-the manual covers the complexities of creating new masters
and backgrounds before it tells you how to perform simple actions such as
creating new slides and working with text and graphics. Finally, the failure of
th is product to produce organization charts, despite having slide masters that
display them, is perplexing.

Conclusions and Recommendations
The business graphics packages available today for the Macintosh span a wide
ra nge of power and complexity. Which on e should you use? That depends on
your goals:

Conclusions and Recommendations
• If you need a package that has dynamite specia l effects, easy support for
sound and graph ics, animated Actors, and the ability to run on a PC,
Astound is an excellent choice. Persuasion is also a good package but is
hampered by bugs.
• If you need a package that packs full word processing with powerful
and easy-to-use business objects (calendars, timelines, and so on), Claris
Impact is the one you want. The Reporting document is unique in its
text controls.
• If you want a fast, very simple package that you can pick up and use
with vi rtually no training at all, you can't go wrong with Microsoft's
Power Point.
• If you need the ultimate in charting power, DeltaPoint's DeltaGraph
Pro 3 is the one fo r you.
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Spreadshee
by Mark Bilbo and Shelley 0 ' ara

The handwritten ledger has been used in business for literally hundreds of
years. pouble-entry accounting alone has a history of about three centuries.
The spreadsheet, for all its high-tech n ewness, is a very old idea; essentially,
it's a sheet of rows and columns that contain tabular data.
Spreadsheets made their appearance on the personal computer scene in the
early 1980s when the program VisiCalc was introduced. By today's standards,
the program was simple and had few features. But, VisiCalc was wildly successful and became, in many cases, the reason for a business to purch ase a
personal computer.
While computers h ad been "number crunchi ng" (performing mathematical
calculations) for many years, VisiCalc enabled users to enter numbers on a
screen in tabular form for the first time, add a few formulas, and have the
computer do the math automatically-even when the numbers in the tables
were changed .
In the years that have passed, the power of personal comp uters has grown
and, along with them, the power and capabilities of spreadsheet programs.
This chapter provides an overview of the two most popular spreadsheet programs for the Mac:
• Microsoft Excel
• Lotus 1-2-3
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Evolution of Spreadsheets fo1r the
Mac
Lotus 1-2-3 became the dominant spreadsheet program on IBM PC and PC
clones, thus becoming as much of a standard in the business world as the
pencil. Over the years, 1-2-3 brought powerful options to spreadsheets including macros for automating tasks, three-dimensional spreadsheets, "addins," and other features.
While 1-2-3 was almost monopolizing the DOS world, Microsoft introduced
Excel on the Macintosh shortly after the computer's introduction in the mid80s. While less powerful than 1-2-3 in relative terms, Excel took advantage of
the Macintosh's graphic interface to take the spreadsheet another step forward due to its ease of use.
Lotus did not ignore the Macintosh, but seemed unable to bring their juggernaut of success into the graphical Macintosh world. The program Jazz fizzled
and users continued to ask when 1-2-3 would come to the Macintosh.
Because it was the first to bring a spreadsheet program to the Macintosh,
Microsoft became almost unstoppable. Excel continued to grow in power,
adding analysis tools, extensive charting capabilities, macros, add-ins, formatting tools, and other features.
Ironically, with the growth of Windows on the PC, Excel began to invade
Lotus 1-2-3's territory, even before 1-2-3 finally came to the Macintosh in
1992.

Microsoft Excel
Excel remains the leader in Macintosh spreadsheet programs. Excel has become one of the standard programs that almost every Macintosh user has and
uses. At the same time, Excel is a very large and complex program; sometimes
it's difficult to use.

System Requirements
Excel 5.0 comes on BOOK disks. You can choose to do a typical installation, a
minimum installation, or a custom installation. If you know which modules
you need, you can do a custom installation and choose which parts of the
program to install.
Excel runs on any Macintosh from the Plus on up and requires System 6.0.2
or higher. You need at least 2MB of memory to run the program and 4MB or

Microsoft Excel

more with MultiFinder or System 7. Keep in mind, however, that Excel's
preferred memory size is 4MB and System 7 is around 2MB itself. So, a 4MB
or more memory configuration is probably your best bet.
Excel takes advantage of, but does not require, a Floating Point Unit.

The Worksheet
Excel, like any spreadsheet program, uses a worksheet made of rows and columns. Customarily, spreadsheets use letters to indicate columns and numbers
to indicate rows. Excel follows this convention (see fig. 18.1). Excel enables
you to have several worksheets, all stored together in a workbook. Worksheet
tabs appear at the bottom of the worksheet to indicate the current sheet.
Menu bar

Fig. 18.1

Toolbars

The Excel
worksheet.

Worksheet tabs

Scroll bars

The intersection of a column and row (the rectangles in fig. 18.1) are called
cells. Data and formulas are entered into cells. Formatting and other commands are applied to individual cells or groups of cells.
Entering Data

Data is entered into a cell by clicking on the cell with the mouse and then
typing. The data typed appears in both the cell and the Formula bar. When
data is entered, the Enter and Cancel boxes appear in the Formula bar (see
fig. 18.2).
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Fig. 18.2
Entering data
in a cell.

You also may confirm an entry of data and move to another cell by pressing
the Enter key, the Return key, the Tab key, an arrow key, or clicking another
cell. The diffe rence with each of these lies in which cell is selected next. Enter
leaves the current cell selected, Return selects the next cell down, Tab selects
the next cell right, and clicking- as you may expect-selects the cell clicked
on.
To cancel an entry from the keyboard, press Escape.
Two additional buttons are available. You can click the Funct ion Wizard
button to use the Function Wizard (see th e "Entering Functions" section later
in this chapter fo r information on this feature). Or you can click the Name
box to insert a name in the formula or cell.
Using AutoFIII

Tip
As you drag the
fill handle, watch
the Name box in
the Formula bar
that displays the
current value of
the series. This is
how you know
when to stop and
release the mouse
button.

One feature unique to Excel that is enormously handy is the AutoFill feature.
To use AutoFill, you type the first few entries in a series Oanua ry, February,
March, for example). Select the entries by dragging the mouse pointer across
the cells. Then drag the fill handle, the lower-right-hand comer of the selection rectangle, to automatically extend the series (see fig. 18.3).
Excel shows a great deal of intelligence in AutoFill. You can enter entries such
as "Month 1," and "Month 2," and Excel's AutoFill will extend the series as
"Mon th 3," "Month 4," and so on.
Dragging down or to the right creates increasing series {1, 2, 3, an d so on, for
example). Dragging to the left or up w ill create decreasing series (5, 4, 3, and
so on, for example).
The fill handle is best for quick entries of linear series. You can quickly en ter
sequential series of months, days, and numbers using the tool.
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Fig. 18.3
Creati ng a column
of month names
by usi ng the fill
handle.
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Auto Fill doesn't need much in the way of "example" enlrie~ to do obvious serie~. If
you need to enter the days of the week, for example, you can type "Monday," press
Enter to confirm, then drag the AutoFill tool. AutoFill knows to enter "Tuesday,"
"Wednesday," and so forth.

AutoFill is a g reat time-saver a nd one of Excel's commendable features; it's
s imple, s traightforward, and handy.

Using Fills and Series
Entering data can be repetitious. One test of a spreadsheet p rogram's worth is
the available tools tha t enable you to reduce the amount of data e ntry wh e n
usin g the worksh eet.
Excel provides two fil l comma nds Fill Down and Fill Rig ht, in the Edit men u
for entering re peated data. You a lso can use the Fill, Series command, also in
the Edit menu, for more complex data entries.
To re peat the same text or data in a column, for exa mpl e, you ente r the value
to be repeated . Then drag to select the cells in the column, making sure to
select the firs t entry . f-rom the Edit menu, choose Fill Down (or press :1=C- D) to
copy the firs t cell 's entry t o the other selected cells (see fig. 18.4).

Tip
If you go too fa r,
say dragging until
reaching july
when you wanted
the series to be
only to june.
don't release the
mouse button.
Move the mouse
back up until the
Formula bar
indicates that
june is the current va lue.
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For more complex fills, Excel has the Fill Series command in the Edit menu.
After choosing the Series command, the Series dialog box appears with several options. The Series dialog box can be used to create linear, growth, and
date series (see fig. 18.5).

Fig. 18.4
Filling a column
using the Fill
Down command.
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Fig. 18.5
Creating a series
using the Series
dialog box.
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Series can be entered into rows or columns. You may choose the Linear option, in the Type area, to add the Step Value repeatedly to create the series (a
step of 2 could create a series of 1, 3, 5, 7, and so on). Use the Growth option
in the Type area to create a series in which the Step Value is multiplied repeatedly (a step of 2 could create a series of 1, 2, 4, 8, and so on). Use the
Date option in the Type area, and the options in the Date Unit area to create
a series of days, weekdays, months, or years. Choosing the AutoFill option, in
the Type area, creates a linear series based on an example that's similar to
dragging the AutoFill tool.
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The Trend option check box enables you to create a linear or exponential
growth series based on the example entries in your selection. The Trend option overrides the Step Val ue and calculates the step from the example values
in the selection. You can use the Growth option in the Type area with the
Trend option to create exponential series such as repeated doubli ng (2, 4, 8,
16, and so on, for example).

IV

Creating Custom Fills
In addition to the Fill commands, you also can create a custom fi ll by using
the Options command in the Tools menu, then clicking the Custom Lists tab.
For example, you can create a list of parts or a list of customer names. Once
the list is created, you can enter the first value and then drag the fill handle
to fill in the remaining values.
Editing Data
You can edit data in the Formula bar or directly in the cell. To edit the contents of any cell, click that cell. You then use the standard Macintosh editing
techniques to edit the data.
Using Cut, Copy, Paste, and Clear
The Edit menu's Cut, Copy, Paste, and Clear commands in Excel are slightly
different from those of the Macintosh and there are more o ptions available
than you might expect.

You use Cut and Copy by starting out in the usual manner: select the material you wish to cut or copy. As you may expect, you d rag through those cells
you wish to select just as you normally make selections with the mo use.
After making the selection, you open the Edit menu and choose Cut or Copy,
or use the standard keyboard equivalents. You can also use the Cut and Copy
buttons on the Standard toolbar.
At this poin t, Excel acts differently than other Macintosh programs. The
selection is highlighted with a moving, dashed box. The Status bar informs
you that you may choose the destination, then press Enter or choose Paste to
paste the selection (see fig. 18.6).
To complete a standard Macintosh cut-and-paste or copy-and-paste sequence,
you click where you want the selection to be pasted and press Enter, or open
the Edit menu and choose Paste.

Tip
To duplicate a
selection in differen t locations of
your worksheet,
ust: tht: Pastt:

command rather
than the Enter
key. Enter clears
the Clipboard of
the selection, but
Paste leaves the
copied selection
on the Clipboard.
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Fig. 18.6
Ready to paste a
cut selection.
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Excel offers, in the Edit menu, a Paste Special command that enables you to
paste va rious parts of the selection, perform mathematical operations on the
pasted data, and even eliminate blanks or transpose columns and rows (see
fig. 18.7).
Fig. 18.7
Paste Special offers
several useful
options.
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The default All option, in the Paste area of the Paste Special dialog box, performs a regular paste, pasting the entire selection. Use the Formulas option in
the Paste area to paste the data and formulas from the selection, but not the
fo rmatting (such as Bold, Italics, and the like). The Values option in the Paste
area will paste the text and numerical data, but will not paste the formulas in
the selection.
Tip
To copy fo rmatting, you can
a lso use the
FormatPainter
button on the
Standard toolbar.

The Formats option in the Paste area is useful when you have performed a
complex formatting of a table or other arrangement in your worksheet and
wish to for mat another table in a similar manner. You use the Copy command, then the Paste Special, Formats command to copy just the formatting
from one selection to the other.
The Notes option in the Paste area pastes only the cell notes from the selection. Excel offers the option to annotate cells with text or even sound. This
Paste Special option enables you to copy notes to other locations in your
worksheet.
The Operation area enables you to do simple matrix types of operations by
adding two tables together, subtracting one fro m another, multiplying, or
dividing their values. You use these options by selecting the data, choosing
Copy from the Edit menu, then selecting the table of data with which you
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want to perform the operation. Then choose the Paste Special command from
the Edit menu. The Paste Special dia log box appea rs. Choose the option you
wish to perform from the Operation area.
The Skip Blanks check box, wh en selected, enables you to paste a table, eliminating the blanks within it. Selecting the Transpose check box switches the
rows and columns, "flipping" the table.
Excel also offers several options that apply to the Edit menu's Clear command. To access the Clear options, choose the Clear command fro m the
menu. From the submenu, you can then choose to clear All (a standard Clear
command), clea r the formatting of the selection (eliminating such effects as
bold, italics, and the li ke), clear the contents (which also will clear the values), or clear the cell no tes.
Using Drag and Drop

One very useful editing technique Excel offers is Drag and Drop. An entire
selection of data can be moved quickly from one location to th e o ther just by
dragging an edge of the selection box. You may have to practice using this
o ptio n a bit with the mouse poin ter; you need to be careful not to
inadvertantly drag the fill handle. Overall, however, this option is very useful; you can "grab" a selection, then drag the selection w herever you need it,
avoidi ng the several steps of Cut and Paste (see fig. 18.8).
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Using Select Special

Excel offers a powerful selectio n command that gives you a number of
optio ns in making selections. Select the Go To com mand from th e Edit men u

Tip
When doing
complex fo rmatting, the Clear,
Formats command is ext remely useful fo r
clearing all form atting from
cells while leaving the formulas,
values, text, and
other data intact;
this enables you
to redo your
fo rmatting.

Fig. 18.8
Moving a table
with Drag and
Dro p.
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and then click on the Special button. You see a dialog box containing several
selection options (see fig. 18.9).

Fig. 18.9
The Go To Special
dialog box offers
numerous
selection options.
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The Go To Special dialog box has so many different options that all of them
cannot be fully discussed in a short chapter section. However, a few of the
more interesting options are worth noting.
For example, the Formulas option in the Select area enables you to select
erroneous formulas in a worksheet for correction. Because formulas are only
displayed when the cell in which they are located is selected, you may find it
difficult to track down erroneous formulas in a complex worksheet. This
selection option can aid you.
Blanks is an interesting option in the Select area that is useful in formatting a
table. You can select the table, then open the Edit menu and choose the Go
To, Special command to select just the blanks in that table and apply formatting to the selected blanks.
The Row Differences and Column Differences options in the Select area enable you to select values in a row or column that differ from the one value
you select before choosing the command.
Note

I

·

Excel also provides auditing commands and an Auditing toolbar tor tracing precedents, dependents, and errors. Precedent5 are cells that are referred to by the formu la
In the active cell. Dependents are cells that contain formulas that refer to the active
cell.

The Visible Cells Only option in the Select area is very useful in copying parts
of tables. You can hide cells by using the column width or row height options, then use the Select Special command to select only the visible cells.
Then use the Copy command from the Edit menu to put only the selection
on the Clipboard for later pasting, leaving the hidden cells behind.
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Select Special is rather complex. Fortunately, a Help button is available to aid
you in learning how to use the many options.
Entering Formulas
Formulas are the mathematical or logical equations you enter into cells to

calculate various values from your data. In Excel, you enter a formula by
selecting a cell and typing an equal sign (=) to indicate that a formula is being
entered (otherwise, your typing will be interpreted as data).
Tip

A cell address is entered into a formula by typing the letter and number that
indicate the column and row of that cell. For example, to enter a formula
that adds the values in the cells in column B, rows 2 and 3, you would type
=B2+B3

and then press the Enter (or Return) key to confirm the formula en try. The
formula is automatically calculated and the resulting value appears. Figure
18.10 shows a column of numbers with an addition formula .
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Addition formula

The basic mathematical operations, such as addition(+), subtraction (-), multiplication (*), and division (/), are offered. Many functions also are offered
that can perform many complex calculations.
You do not have to actually type the addition operator in many cases. To
enter a simple addition formula, you can press the equal sign (=), then click
in sequence the cells you want to add. Excel automatically assumes the cells
are to be added.

To enter a cell
address without
having to type,
click the cell
while entering a
formula. The
cell's address is
automatically
entered.

Fig. 18.10
Entering a simple
formula to add a
column of
numbers.
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Remember that once you have entered a formula into a cell, you then can use the fill
handle to duplicate that function into other cells. This is very handy in tables that
sum columns or rows of numbers, because you can enter a summation formula and
then drag the fill handle to duplicate that formula across the row or column.

Entering Functions

Excel o ffers a number of functions that perform many useful and powerful
calculatio ns and operations. A fun ction, essentially, takes the arguments (values, cell addresses, text, and other data), performs an operation, then prod uces a resulting value. Excel has so many functions available t hat a separate
reference manual is devoted to listing and detailing the functions.
You may enter a function in one of two ways: by typing the functio n name
into an equation, o r by using the Functio n Wizard. The Function Wiza rd
enables you to select the function that you want. Then the wizard leads you
step-by-step through the process o f creating the function (see fig. 18.11).
Fig. 18.11
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Note
To quickly enter a formula that adds a row or column of numbers, click the cell that
will receive the formula, then click the AutoSum button in the Standard tool bar (the
button with the sigma symbol). Excel will even select the column or row for you, so
you only need to press the Enter key to finish the formula.

Microsoft Excel
To use th e function Wizard, click th e Function Wizard button. A Function
Wiza rd dialog box appears that gro ups the functions by category. Click the
category (Math & Trig, for example) to view the functions o f that type in the
right-hand scroll box.
After you have selected the function you need, click the Next button. A second dialog box appea rs and Excel prompts you to enter the arguments for the
fu nctio n (see fig. 18.12). You ca n type the argum ents directly in the dialog
box or click the cells in the worksheet. After you enter all the arguments,
click th e Finish but ton.
Fig. 18.12
Entering the
arguments for
a function .
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Editing the Worksheet

You can edit the worksheet itself. You can adjust column wid ths and row
heigh ts, as well as insert and d elete cells. You can hide columns and rows so
that they do not d isplay in the works heet (but they still retain their va lues
and formulas).
You can insert a col umn or row by selecting the entire column or row. (To
select an entire colu mn, click the column letter. To select an entire row, click
the row number. ) Then open the Insert menu and select the Col umns command to insert a col umn, or th e Rows command to insert a row.
To delete a column o r row, select it. Then o pen the Edit m enu and choose the
Delete command.
You can insert cells by selecting the number of cells you wa nt to insert. Then
choose t he Insert Cells command.
You can adjust the width of an y colum n or row by dragging th e bo rder
between the column letters or row numbers (see fig. 18.13).
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Fig. 18.13
Adjusting column
width by dragging.
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For more precise adjustment, open the Format menu and choose the Row
Height or Column Width commands. Each command has a submenu. To
change the column width, for example, select the Column Width command
from the Format menu. Enter the value in the Column Width dialog box (see
fig. 18.14).
Fig. 18.14
Ad justing column
width by typing a
value.

Tip
A shortcut for
setting a column
width or row
height to its
"best fit" is to
double-click the
divider to the
right of the
column or below
the row.
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Both submenus also include Hide and Unhide commands which enable you
to hide the selected rows or columns. You can unhide the column or row and
see that the data in the column or row remained intact.
Using t he Toolbar

Above the worksheet, and just below the menu bar, you see two toolbars.
Too/bars contain buttons and menus which enable you to perform many
functions by clicking the mouse. You can customize the toolbars, and you
can create your own. By default, you see two toolbars, the Standard toolbar
and the Formatting toolbar (see fig. 18.15). Tables 18.1 and 18.2list the buttons with a short description.
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Fig. 18.15
The Standard and
Formatting
toolbars in Excel
contain shortcuts.

Formatting toolbar

Table 18.1

Standard Toolbar Buttons

Button

Description

[Q]

Creates a new workbook

~

Displays the Open dialog box so that you can
open a workbook

[;I
[II

Saves the workbook

~
~

Prints the workbook
Displays a print preview of the worksheet
Starts the Speller

[K1

Cuts the selection

~

Copies the selection

[11
~

Pastes the cut o r copied selection

El
EJ

rn

Copies formatting
Undoes the last command
Repeats the last command
Creates a SUM function

~

Starts the Function Wizard

mJ

Sorts the selection in ascending order

m1

Sorts the selection in descending order

~

Starts the ChartWizard
(continues)
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Table 18.1

Continued

Button

Description
Draws a text box on the worksheet
Displays the Drawing toolbar

18

110 0%

Enables you to zoom the worksheet display
Displays tip information
Enables you to get context-sensitve help

Table 18.2 Formatting Toolbar
Button

Description

18

!Geneva
110

18

Displays a drop-down list of font selections
Displays a drop-down list of font sizes
Makes the selection bold
Makes the selection italic
Underlines the selection
Aligns the selection w ith the left edge of
the cell
Centers the selection
Aligns the selection w ith the right edge of
the cell
Centers the selection across multiple
columns
Formats the selection as currency style
Formats the selection as percent style
Formats the selection as comma style

Microsoft Excel

Button

Description

~

Increases the number of decimal places
displayed

~

Decreases the number of decimal places
displayed

[(§]8

Displays a palette of border selections

Ul
lE

Displays a palette of colors. You can use
this palette to change the cell color.

477

IV

Displays a palette of colors. You can use
this palette to change the color of the text
in the cell.

Tip
To see the name
of a button, put
the mouse
pointer on the
button. The tool
name, called a
Too/Tip, pops up.

You can display oth er toolbars by using the Toolbars command from the
View menu. To display a toolbar, select the check box next to its name (see
fig. 18.16).

Fig. 18.16
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Hide a toolbar by deselecting the box.
Toolbars can be customized an d you can add toolbars of your own. Excel's
customization options are discussed la te r in this chapter in t he "Customizing
Excel" section.

Understanding the Status Bar
The Status bar, below th e worksheet, aids you by giving you one-line help
information, displaying the program's current action, and displaying the
keyboa rd m o de (see fig. 18.17).

Choosing to
display another
toolbar.

'
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Fig. 18.17
The Status bar
displaying help.

Help displayed
for Format

In the left side of the Status bar, you normally see the word Ready, indicating
that Excel is otherwise unoccupied and awaits your instruction. A one-line
description of commands and buttons is also displayed here.

Note
To obtain one-line help for a menu command or button, place the mouse pointer on
the command or button, then press and hold the mouse button. If you wish to
execute the command, release the mouse button. If you do not want to execute the
command, move the mouse pointer off the button or command.

Five mode indicators are used in Excel for the Macintosh. (A sixth is present
on the screen, but only used in the Windows version of the program.) These
indicate such th ings as when the caps lock is on, when the scroll lock is
active, whether the fixed decimal size option is active, and other keyboard
related modes.

Using Formatting
There are a great number of formatting options available in Excel to improve
the appearance of your worksheet. Number forma tting enables you to set the
number of decimal places for numerical data, add dollar signs (or other currency symbols), and set date and time formats, fraction formatting, scientific
notation, and the like.
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For text, you have available all of the usual Macintosh formatting such as
bold, italics, various fonts and font sizes, and the like. You can combine this
formatting into Styles which enable you to apply combinations of formatting
with a single menu choice.

IV

You also can add borders to cells, you can shade cells, and you can apply
patterns and colors.
Using and Defining Number Formatting

Applying number formatting requires a couple of steps in Excel. First you
select the cells containing the numbers you wish to format; then choose the
Cells command from the Format menu. The Format Cells dialog box appears.
Click on the Number tab. In the Number tab, you see a list of the formatting
categories to the left and the list of formatting codes available for the selected
category to the right (see fig. 18.18).
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Fig. 18.18
Choosi ng a
currency format.

=s

3

COde boot,

Excel uses format codes with pound signs(#) to indicate digits, commas to
indicate comma separators that will be used, parentheses to indicate that
negative numbers are placed within parentheses, and other similar notations.
While it is not strictly necessary to understand the formatting codes in order
to format numbers, it is useful to learn them so that you can create custom
formats.
When you choose a format, the codes for that format appear in the Code box
(you may, at this point, edit the formatting to customize it). You also see a
sample of the formatting below the Code box.
If you want more help on number formatting, click the Help button in the
dialog box.

Tip
A quick way to
apply common
fo rmatting is to
use one of the
style buttons on
the Formatting
tool bar.
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Note

·

Some foreign currency symbols are available in standard Macintosh fonts and can be
inserted into custom number formats. Usually, you press the Option key to access
these symbols. Choose the Key Caps desk accessory from the Apple menu to find the
symbols you need.

Applying Text Formatting

The standard Macintosh text formatting o ptions, with addi tional o ptions
useful fo r spreadsh eets, are available through the Fo rmat menu. Text alignment options are accessed by opening the Format menu and choosing the
Cells command. Then click the Align ment tab of th e Format Cells dialog box
that appears (see fig. 18.1 9).
rormot Cell s

Fig. 18.19
Setting text
alignment.

Nutnl>tr
Htr1:zoatt1

TAll• • - •• T
-

r-Y trlical

('Top

61 Geoerol

I

ll rten"r

C Lon

() Centtr

r

fool

(i

Bottom

C'_:usttrv

Rt9M

C"Ftll

c

,.lectlon

-

If you wish to use
a particular font,
font point size,
an d style a~ the
default (or "normal") font for
the worksheet,
click the Normal
Font check box
before cli cking
OK.

l

~

Border

T Patter., TPrott<llon

Ori ntatln

II

Text

I (

IID§01

OK

(

Ctncet

(

Help

•I
I

JU)atfv

(' Cet\ttr term

Tip

T

CWnpTex1

....J

One particularly useful al ignment oplio n is the Wrap text option. You ca n
use this option to wrap a paragraph o f text within a cell. Press ):C-1 to select
the Cells command from the Format menu. Click o n the Font tab. The fon ts
installed in you r System fi le, their avai lable point sizes, and the usual Macintosh style optio ns (bold, italics, and so o n) are ava ilable on the Fon t tab in
the Format Cells di alog box (see fig. 18.20) .
Applying Cell Formatting

Excel offers many formats that can be applied to cells to add borders, patterns, shading, colors, and the like to improve the appea rance of your
worksheet.
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Fig. 18.20
Choosing a fo nt
fo r the selected
text.
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You can select the Cells command from the Format men u and then use two
of the tabs for applying borders or patterns: Border and Patterns. You can
apply borders to cells by selecting the cells, selecting the Cells command
from the Format menu, and clicking the Border tab of the dialog box that
appears. The Border tab enables you to choose the thickness of the border,
whether to use dashed lines, the sides of the selected cells that the border will
be applied to, color for the border, and shading for the cells (see fig. 18.21).
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You can apply patterns by selecting the Format menu's Cells command. Then
cl ick the Patterns tab of the Format Cells dialog box. From the Patterns tab,
you can choose a pattern, a foreground color-which is app lied to the pattern
itself, and a background color-which fills the cell behind the pattern (see
fig. 18.22).

Tip
Click the Borders
button to display
a pa lette of commonly used borders. Click the
style you want.

Fig. 18.21
Adding a border to
selected cells.

Tip
You can apply a
pattern by clicking
the Color button
on the Formatting
toolbar. From the
palette that appears, click the
color or pattern
that you want to
use.

IV
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Fig. 18.22
Choosing a
pattern and colors
to apply to the
selected cells.
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Using and Defining Styles
A style is a collection of fo rmatting such as font, font point size, font styles,

borders, patterns, colors, and the other formatting discussed so far. The fo rmatting is collected under a single style name and can be applied by o pening
the Fo rmat menu and choosing the Style command.
After you have formatted a table or other section of your worksheet, you can
create a style "from example" by selecting the fo rmatted cells, opening the
Format menu, and choosing the Style command. The Style dialog box
appears. Type a name for the style in the Style Name drop-down list box
(see fig. 18.23).
Fig. 18.23
Creating a
Table style.
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You will want to choose certain check boxes, in the Style Includes (By
Exa mple) area, to determine which types of fo rmatting the style includes. For
example, if you wish to create a style that on ly adds the borders and patterns
you created, you wi ll want o nly the Border and Patterns check boxes to be
marked.
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To modify the style, click the Modify button. You see the Format Cells dialog
box. You can select which tab you waGt (Number, Alignment, Font, Border,
Patterns, o r Protection) and then make the appropriate change.

IV

Once you have defined a style, you can apply that style to other selections by
opening the Format menu and choosing the Style command. Select th e style
you want from the Style Name d rop-down list box in the Style dialog box (see
fig. 18.24).
Fig. 18.24
Applying a defined
style to a selectio n.
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Using Autoformat

One feature that Excel provides which is extremely helpful in formatting
tables is AutoFormat. You can apply predefined styling to a selection by using
the AutoFormat command in the Fo rmat menu. An AutoFormat dia log box
appears listing format options and showing samples of the o ptions (see
fig. 18.25).
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Charting Data
Excel offers the ChartWizard to simplify creating a chart. You usc
ChartWizard by first clicking th e ChartWizard button o n the Standard
toolbar. You then draw a frame in the worksheet to hold th e chart.
ChartWizard then leads you through a series of five dialog boxes in wh ich
you set various charting options (see fig. 18.26).

Fig. 18.25
The selection of
AutoFormats that
are ava ilable.
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Fig. 18.26
Chart Wizard
takes over.
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You go through the dialog boxes, indicating your charting preferences, then
Excel draws the chart in your worksheet (see fig. 18.27) .
Fig. 18.27
A completed chart
created with
ChartWlza rd.
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Tip
Heavily formatted tables do not
go well with
ChartWizard.
If you will be
charting your
table, keep the
for matting to a
minimum to
avoid heavy
editing.

Once a chart is created, you can edit the chart by double-clicking on the
chart. Excel opens the chart in a separate window. The Chart toolbar is displayed (see fig. 18.28). Some d ifferent commands are also available on the
Insert and Format menus. A dialog box is displayed listing format options
and showing samples of the options.
You can use the Chart tool bar to change from one type of chart to another.
You also can use the Chart toolbar to return to the default chart type.
You can change many other items by double-clicking the item in the ch art.
For example, to change the chart plot area, double-click the plot area. To
change the pattern used fo r a particular series, double-click the series you
want to change.
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You can add a series to the chart by dragging it from the worksheet to the
chart. Because the chart and the worksheet are linked, th e chart is automatically updated whenever you m ake a change to the worksheet data. Likewise,
you can drag a data point o n the chart, and the correspondin g worksheet
value will be updated.
The chart is an object on the worksheet. As such, you can move it by d ragging the border and resize it by dragging a selection h andle.

Using Databases
Excel offers extensive database capabilities that enable you to manage lists of
info rmatio n. The Data m enu contains several database commands, including
the ability to create a data form for entering and editing records in a database, searching for records by using criteria, o r just browsing thro ugh the
database (see fig. 18.29).
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The Data menu also includes commands for filtering records from a database
using criteria wh ich must be satisified. Over a dozen database functio ns
are ava ilable fo r use in worksheets. These enable you to extract and use
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Fig. 18.28
A chart and the
Chart toolba r.

Tip
Try creating a
si mple chart and
experiment with
maki ng changes.
Though editing
charts can be
difficult, you can
learn how to
format charts
with some experimentation.

Fig. 18.29
Browsing a
database of clients
using the Form
command.
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information from a database in your formulas, as well as perform various
statistical ana lyses of data in the database.
Setting up a database in Excel is one of the easier procedures in the program.
You enter the data in a tabular form. The first row contains the fi eld names.
Subsequent rows contain individual records. Each column is a certain field.
For example, you can have fields for FIRST NAME, LAST NAME, ADDRESS,
CITY, STATE, and so on.
Excel may not be able to completely take the place of a database program if
you have large amounts of data to manage. However, for many users, Excel is
sufficien t for managing contact lists, small employee databases, mailing lists,
and the like.

Sorting, Filtering, and Subtotaling Data
You can use the Data menu's Sort command to sort your database. In the Sort
dialog box, you can sort a client database by last name or by Zip code, for
example (see fig. 18.30).
Fig . 18.30
Sorting a
worksheet.
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In addition to sorting, you can filter the database so that only certain records
are displayed. For example, you can filter the data so that only clients in a
particular state are displayed. Excel hides all the other rows that do not
match the criteria you select (see fig. 18.31).
Fig. 18.31
Filtering a
worksheet.
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Open the Data menu and choose the Subtotal command. The Subtotal dialog
box appears. Here, you can automatically create subtotals for a report (see
fig. 18.32).
Fig. 18.32
Creating subtotals.
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Using Outlining
Excel enables you to use outlining in your worksheets. Outlining is the ability
to hierarchically nest data and display the data of the desired depth. This
enables you to have great detail in your worksheets, while still being able to
collapse" the detail to summary levels to get an overall view.
If

When you have created a worksheet, Excel displays buttons along the topand left-hand sides of the worksheet. You can click these buttons to set the
level of detail you want displayed.
In addition to outlines, you can create pivot tables to summarize and analyze
data.

Using Macros
Excel can record and execute a series of commands in a macro. This ability to
automate tasks can be extremely useful in reducing repetitive work.
Excel's macro language is actually a programming language and is very sophisticated; you even can create new functions for use in your worksheets,
and an application is included that enables you to create and design your
own dialog boxes.
You do not have to spend hours of study, however, before using the macro
feature. Excel has a Record command that enables you to record and store
your steps as a macro as you take them (see fig. 18.33).
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Fig. 18.33
Preparing to
record a new
macro in Record
New Macro dialog
box.
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Excel keeps macros on a separate worksheet in the workbook (see fig. 18.34).
Fig. 18.34
An Excel macro in
the macro sheet.
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Tip
As you become
more sophisticated in your use
of Excel, you
may want to
learn the macro
language. One
way you can start
is by recording
simple macros,
then reviewing
the steps in the
macro sheet.

Fig. 18.35
The Drawing
toolbar.
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T he steps of the macro language that Excel uses to execute the macro are
listed in the macro sheet columns a nd you can edit these steps to correct
errors o r make changes to the macro.
Macros can be ass igned to objects to c reate interactive worksheets and presentations. You a lso can assign m acros to buttons in a custom toolbar for easy
access.

Using Drawing
Drawing can add to your worksheets, improving their appearan ce and emphasizi ng information. Excel offers several Drawing tools that enable you to
add, style, and edit graphical objects to your worksheets. You access the
Drawing tools by clicking the Drawing button. Doing so displays the Drawing
toolbar (see fig. 18.35).
l'loloJ)Ial~ll~l'~ l•l• l•l•l
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Microsoft Excel
Excel's Drawing tools are object oriented. That is, you create objects: rectangles, ovals, lines, arrows, and the like. Tools and commands are provided
that enable you to group objects, arrange their stacking order, and change
their properties. You can add shading, patterns, and color to many of the
objects.
While Excel is not a full-featured graphics program, you can use the Drawing
tools to en hance your worksheets quickly and easily (see fig. 18.36).
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Tip
To quickly access
the Properties
dialog box for
any object,
double-click that
object in the
worksheet.
Fig. 18.36
A simple
worksheet
improved in
appearance with
the Drawing tools.

Customizing Excel
The mai n method of custo mizing Excel is to alter existing toolbars o r create
new on es. Because you can even create macros to assign to toolbar buttons,
you can customize almost any feature in Excel to suit your needs.
The basics of customizing a toolbar are quite simple. From the View menu,
you choose the Toolbars command. A dialog box listing the toolbars is displayed. You first display the toolbar you wa nt to customize, and click the
Customize button. You see the Custo mize dialog box with va rious buttons
(see fig. 18.37).
Simply d rag buttons o n o r off the toolbar to add or remove a functio n in the
toolbar. You can even customize the Standard and Formatting toolbars,
which are the initial toolbars displayed.
In the Toolbars dialog box, you also can create a new toolbar by typing the
toolbar name, rather than by ch oosing a toolbar to edit and clicking the New
button.

Tip
To obtain a
small separation
between toolbar
buttons, drag a
button on the
toolbar just
slightly to the
right or left. Excel
places a space
between the
button and its
neighbor.
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Fig. 18.37
Customizing
toolbars in Excel.
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Note that some toolbars other than the Standard and Formatting toolbars are
displayed as floating palettes (see fig. 18.38).
Fig. 18.38
A toolbar as a
floati ng palette.

Tip
You can switch a
toolbar to or
from a floating
pa lette by
double-clicking
the toolbar (but
not the buttons
on the toolbar).
Even the Standard toolbar can
be changed to
and from a
floating palette
by doubleclicking it.
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Toolbars that are floating palettes remain in front of your worksheet. You can
drag these toolbars around and resize them. Note that if you drag the toolbar
above the title bar of the worksheet, the toolbar will move up to below the
menu bar, along with the Standard and Formatting toolbars.

Microsoft Excel

Getting the Most Out of Excel: Hot Tips
• Make use of the too/bars. Even though Excel can be a complex and difficult program to run, toolbars are easily customized and can give you
one-click access to Excel commands and features.
• Make macros of the tasks you repeat often and spend some time learning the
basics of the macro language. You do not have to know the entire macro
language to do some creative editing of macros that will enhance their
usefulness.
• Do formatting as the last step in creating worksheets. Formatting often has
to be redone after you edit data and cells, adding extra work. Also, if
you are planning on charting your data, keep the arrangement and
formatting simple and use the ChartWizard-ChartWizard can save a
n umber of steps, but it is often confused by heavy formatting. You can
add formatting after the chart has been created to enhance the table's
appearance.
• Resist the temptation to use tons of colors, patterns, borders, fonts, and other
formatting. Impressive looking tables and presentations can be created
with a few judiciously applied formatting choices. Check out the
AutoFormat command in the Format menu; often the formatting done
by this command is sufficient.
• Use the fill handle. Not only can the fill handle create a number of useful
and frequently used series, it also can duplicate formulas, thereby saving you a considerable amount of time.
• Display a shortcut menu of commands, by pointing to the item you want to
work with. For example, to display a shortcut menu of toolbar commands, point to the toolbar. Hold down the Ctrl key and click and hold
down the mouse button. You see a shortcut menu.
Excel includes many keyboard shortcuts. If you like to use keyboard
shortcuts, you can use on-line help to display a list of keyboard shortcuts. Select Reference Information from the Help Contents window and
click Keyboard Guide. Select the topic for which you want to see shortcuts.

• Store similar worksheets together in a workbook. You can add or delete
worksheets as needed. To name a worksheet, double-click the worksheet
tab and then type the worksheet name.
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• Create range names to make formulas easier to understand and easier to
create. For example, you may have ranges named SALES and EXPENSES.
You can create a formula that subtracts EXPENSES from SALES. You can
create a range name by selecting the range and by typing the name in
the Nam e box next to the formula bar.
• Run the Speller so that you are sure your worksheet does not contain any
spelling errors. You can do so by clicking the Spelling button in the Standard toolbar. Excel compares all the words in your worksheet to words
in its dictionary and then flags any words it cannot match. You can
choose to replace the word with a suggested spelling, edit the word, or
ignore the word.
• Use Excel's Find File command to help you manage files. This file management feature shows you a preview of yo ur worksheets. You can choose
to delete, print, o r copy worksheets using Find File.

Summary
Excel is an excellent choice in spreadsheet programs, especially if you are
working with other Macintosh users and need to share spreadsheets with
them. However, you wiU want to consider Excel's strengths before deciding
on your spreadsheet purchase.

Lotus 1-2-3
The dominant spreadsheet program in the DOS word for a lor:tg time, Lotus
1-2-3 finally came to the Macintosh in 1992. While Lotus had faltered with
the now defunct Jazz spreadsheet program, users were pleased when 1-2-3
came to the Macintosh. 1-2-3 for the Macintosh not only delivered the well
respected power of 1-2-3, it also conformed well to the Macintosh user interface.

System Requirements
Lotus 1-2-3 comes on three 800KB disks and requires about 4.5MB to install.
The Guided Tour, which comes with the program and introduces you to the
spreadsheet, comes on two 800K disks and requires about 3MB of space to
install.
1-2-3 requires 1.8MB of memory to run and will run on any Macintosh from
the Mac Plus up. Note that with System 7, a 4MB minimum memory configuration is probably you r best bet.
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Using the Worksheet
Like other spreadsheet programs, 1-2-3 follows the conven ti o n of naming
rows with numbers and columns with letters (see fig. 18.39).
Range Graph Da t a Style Tools Window

Fig. 18.39
The Lotus 1-2-3
worksheet.

Drawing

palette=lif~~~~~~~!~~~~~~~~~~;
Untitled

Selected cell
Pointer
Style palette

Console

Status window

As with Excel and other spreadsheet programs, the intersection of column s
and rows are cells which are referred to by their addresses (column letter and
row number).
Entering Data

1-2-3 follows the same basic procedure as other spreadsheets in that you enter
data into a cell by clicking the cell to select it, then typing. The data appears
both in the cell and in the Console (see fig. 18.40).
•

File £dlt

.,\!£:vb Ill

Worksh eet Range Graph Oala Style Tools Window
"Household buget worksheet

A 82

[A;~ ~ ~1!11!1 1 ~ ~ I
...._ ..... ...,.

Untitled

Confirm and Cancel buttons appear in the Console, enabling you to click to
enter or delete the data you type. You also can press Enter to enter the data
and leave the same cell selected; Return to enter the data and move to the

Fig. 18.40
Confirm and
Cancel buttons
appear.
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The 1-2-3 Fill command is not nearly as sophisticated as Excel's, and the lack
of AutoFill or a similar feature is unfortunate. Still, basic series can be done
quickly and easily. More sophisticated series also can be accomplish ed by
creating macros.
Editing Data
1-2-3 has available the basic spreadsheet convention of editing data in a Console. Click to select the cell to be edited and the data or formu la in the cell
appears in the Console; you can use the standard Macintosh editing techniques.
One standout feat ure of 1-2-3 is in cell editing. You do no t have to use the
Console for editing cell conten ts (though in cases of lo ng for mulas or busy
spreadsheets you may want to do so). Following the Macintosh interface,
1-2-3 enables you to double-click a cell to open the cell for editing so that
you can make changes right in the cell using standard Macintosh editing
procedures (see fig. 18.43).
Grnph

Dolo Style Tool s

Fig. 18.43

Window

"H ousehold buget wo rksh eet

Correcting text
within cell editing.
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Using Cut, Copy, Paste, and Clear
1-2-3 follows Macintosh conventions with the Edit menu's Cut, Copy, Paste,
and Clear commands. Unlike with Excel, these commands behave exactly as
you would expect based on your experience with other Macintosh programs.
Special move, copy, paste, and clear features are performed by choosing separate commands in the Edit menu. Paste Special and Clear Special have nested
menus that enable you to choose whether to paste or clear the contents,
formats, or styles o f a cell.
Even tho ugh Quick Copy has been discussed, one more men tion of the feature is justified. Lotus has designed the Quick Copy (a nd Move Cells) co mmands to be independent of the Cli pboard. You can use the Quick Copy and
Move Cells commands from the Edit menu without affecting the contents o f
the Clipboard.
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T ip

Quick Copy and
Move Cells are
very handy
when you need
to copy or move
cells across large
worksheets. You
can scroll the
worksheet while
the dialog boxes
are on-screen or
type a cell range
directly into the
dialog boxes.

Move Cells enables you to do a "cut and paste" operation quickly and without affecting the Cli pboard's contents. Select the cells you wish to move,
choose the Move Cells command from the Edit menu, click to indicate a
d estination, then press Return. The cells are moved.
Using Drag and Drop

I first saw the drag and drop feature in Microsoft Word, though I'm uncertain
that this was the feature's first appearance. In any case, in m y personal opi nio n, th e creator(s) of the featu re deserve a h ats off for this logical exte nsion of
the Macintosh interface.
1-2-3 im plements drag and drop with an inte resting pointer effect. When you
place the pointer at the edge of th e selected cells to be moved, the pointer
becomes a hand indicating that you can now "grab" the selection. Press the
mouse button and the hand "clenches," indicating the selection has been
"grabbed" and is read y to be moved to a new location in the worksheet.
This feedbac k is helpful in that drag and dro p in other programs can be confusing at times when the program merely uses the standard pointer. A clear
indication of the feature's function ing helps the user avoid errors in trying to
move a selection. Give Lotus a gold sta r for making a great feature even easier
to use.
Entering Formulas

1-2-3 begins fo rmula entry with an addition sign (+). However, you also can
use th e equal sign (=)and the program will a u tomatically convert. Like Excel,
you can click a cell to enter the address of that cell into your formula. Un li ke
Excel, clicking another cell with out entering an operator will not enter an
addition sign, but rather will change the cell address to the last clicked.
This " lack of feature" is a feature in my mind in t h at I've run into too many
cases in which I've clicked a cell, changed my mind, and clicked another only
to find Excel thinking I mea n to add everyth ing together. 1-2-3 d oesn't make
the addition assumption, but rather waits for the user to choose th e operator.
Entering Functions

1-2-3 begins functions with an at sign (@).To e nter a Sum function, you type
@Sum followed by the cell range to be summed. In the Console, 1-2-3 offers
a pop-u p Function m enu that enables you to choose and paste the fun ction
into th e cell, rath er than having to type th e fun ction name.
The Sm a rtSum command is much like the Excel Sum tool. You click to the
right of a row or below a column. Then choose SmartSum from the Function
menu. The sum formula is automatically entered a nd the cells are totalled.
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Note
A truly g reat time-saver when you are building tables is that the SmartSum enables
you to select a range of cells and enter sum formu las in the entire range. For example, if you have several columns of figures, you can create a totals line by selecting
a row of cells below the columns and then by choosing SmartSum .

Editing the Worksheet

The worksheet itself can be edited: rows and columns can be adjusted in size,
inserted and deleted, hidden or shown, and the basic worksheet colo rs can be
changed.
1-2-3 combines the worksheet-related commands into a single Worksh eet
menu for conven ient access. You can set global defaults for all your
worksheets by choosing t he Global Settings com mand fro m this menu a nd
selecting optio ns in the Worksh eet Global Settings d ialog box (see fig. 18.44).
Worksh ee t Globnl Sottlng s
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Fig. 18.44
Setting the defaults
for all 1-2-3
worksheets.
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Align t ent:~
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Like Excel, 1-2-3 enables you to adjust column width or row h eight by dragging in the column o r row labels.
For more precise ad just me nt, the Worksheet menu 's Column Width a nd Row
Height commands invoke d ialog boxes that enable you to set the size o f the
selected columns or rows. The Hit!e/Sh uw com mand e nables yo u tu hit!e ur
display selected columns or rows.
The Worksheet me nu's Insert and Delete commands enable you to insert o r
delete columns, rows, selections, numbered amoun ts of cells, or whole
worksh eets (for three-d imensional spreadsheets).
You select one or more cells in the area to be inserted or deleted, then choose
the appropriate command. A dia log box appea rs en abling you to indicate
h ow you want the insertio n o r d eletion to be h andl ed (see fig. 18.45).

Tip
To automatically
set a column o r
row to t he best fit
fo r the con tents
of the cells,
do uble-click the
divider between
column or row
labels.
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Fig. 18.45
Inserting new
colum ns in the
worksheet .

Tip
To q uickly
insert or delete
a row or co lumn, first click
in the row
number label
o r the column
letter label a nd
then choose
t he ap propria te
command.

Work shee t Insert
®Co lumn

Ouontlty:

O now

0

IQJ

l:il) lnsert select ed ronge

Sheel
O!lolore
@ Ri t er

Yo u also can ad just the colo rs used in the wo rksheet for displaying gridlines,
negati ve numbers, the backgro und, and other aspects of th e worksheet itself
by using the Adjust Colors command. Because staring at a m onito r screen all
day can be tiring, this is a nice feature to have. Being able to set the
worksheet color combinatio n to something you find easier o n the eye is a
welcom e fea ture.
Understanding the Status Window
The 1-2-3 Status window is no t as info rmative as the Excel version, but it does

info rm you what the progra m is do ing at the moment:
Ready appears in the Status window to indicate that 1- 2-3 is read y to
accept a command.
c alc appears when 1-2-3 is doing a calculation.
Label appears when you are entering a text label.
Va l ue appears w hen yo u are entering data or formu las.

A pop-up m enu in the Status window enables you to also d isplay the date,
tim e, o r available memory in the window (see fig. 18.46).
Fig. 18.46
Choosing to
display t he curren t
time in t he Status
window.
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Using Formatting
There are many 1-2-3 formatting features. You can format numerical values,
align text, add colors, draw borders around cells, and perform a great many
other enhancement operations on your worksheets.
Using and Defining Number Formatting

To apply a format to cell contents, you select the cells to be formatted . Then,
from the Range menu, choose the Format command. The Range Format dialog box appears, enabling you to select the format to be used and set options
for that format (see fig. 18.47).
Fig. 18.47
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Tip

1-2-3's formatting can be customized to some extent. You may set the number of decimal places, whether negative values are colored, and whether to
add a text prefix or suffix.
Applying Text Formatting

The standard Macintosh text formating-fonts, font sizes, and font stylesare accessed through the Style menu's Font command. The command
invokes the Style Font dialog box through which you make your selections
(see fig. 18.48).

Fig. 18.48
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Tip
Add commonly
used font formats
to the Styl e
menu by clicking
the Show in
Menu button.

Quick access to the Plain, Bold, and Italics font styles is provided by buttons
on the Style palette at the left of the screen. Select the cells whose contents
you wish to format, then click the button.
Colors can be applied to the contents of cells through the Style palette. Select
the cells, then choose a color from the Text color pop-up menu (see fig.
18.49).

Fig. 18.49
Colorizing the
contents of a
selection of cells.
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Note that the color pop-up menus will be different depending on the color
capabilities and settings of your monitor. In the area of color, 1-2-3 gives
much easier and more direct access to color than Excel using pop-up menus
with up to 256 colors. Note that these pop-ups will look different if you have
less than a 256-color capability.
Note
Avoid getting too adventurous with text coloring; few colors are actually that useful
for text and some even make the text harder to read. Take background color into
account also; for example, a blue background with red text causes a disturbing
"jitter" effect when viewed.

Alignment of cell contents is available through the Style menu's Alignment
nested menu. You have fou r choices: left, center, right, and general. General
is the default alignment which right-aligns numbers and left-aligns text.
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Applying Cell Formatting
You can add borders and colors to cells. 1-2-3 offers seven border options
(eight if you count None) and up to 256 colors each for the fo reground and
background colors.
You can q uickly access borders through the Border pop-up menu in the Style
palette. You also can use the Style men u's Border command (see fig. 18.50).

Fig. 18.50
Adding a border to
selected cells.
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0
0
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Interestingly enough , apparently the o nly way to add colo r is through the
color pop-up menu in the palette; there is no menu command eq uivalent.

Graphing Data
1-2-3 truly shines in the graph department. If you work with graphs a great
deal, the ease of use of 1-2-3's Graphing feature m akes the program a top
choice.
Against Excel's rather clunky way of doing graphs (or in Excel terms, charts),
l-2-3's graphing featu re feels like magic. Simply select the data, then choose
the graph type you want (see fig. 18.51).
The graph appears almost instantly, ready for titling, and need ing very little
editing (see fig. 18.52).
Editing a 1-2-3 graph is a snap. You can drag the graph where you want it to
be in th e worksheet, resize it by dragging (just as you would expect to resize
an object in a Macintosh program), and edit any element in the graph by
double-clicking the elem ent (see fig. 18.53).

Tip
While the pop-up
Border menu is
useful for quickly
adding a border to
cells, editing the
borders is easier
with the Style
menu's Border
command.
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Fig. 18.51
Gmphing d ata is
easy as l -2-3.

Fig. 18.52
A column graph o f
budget figures.
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As you would expect in a Macintosh program, you can do such things as
make fo nt, font size, and font style changes to text in a graph by clicking the
text to select it, and then by making font choices from the menus. Colors of
the graph's bars, lines, boxes, and the like are easily changed by clicking the
element to select it, and then by using the Style palette.
Changing ranges is about the only thing in 1-2-3 that gets to be annoying.
This has to do with a rather strange side effect of 1-2-3's attempts to be as
user friendly as possible and to redraw as you work. Often , when you are
working with the Graph Ranges dialog box invoked through the Graph
menu's Ranges command, the worksheet and dialog box are flipping madly
about and selections are popping up and changing around crazily. It's
enough to make you dizzy when all you wanted to do was change a cell range
for a bar graph. But, if things get too confusing, sit back and wait. 1-2-3 will
calm down presently.
Note
You can "tear off" the nested New Graph menu to make a Graph palette. Changing
graphs from one type to another then is only a matter of clicking to select the existing graph, and then clicking the new type in the Graph palette. You also can display
the Graph palette by choosing the Show Graph command from the Hide/Show
submenu. (The Hide/Show submenu is located in the Window menu.)

All graph-related commands are also grouped in the Graph menu.

Using the Drawing Layer
1-2-3 has an invisible "layer" above the worksheet that you can draw on to
enhance you r worksheet's appearance. You can draw arrows, rectangles,
rounded rectangles, ovals, arcs, and shadowed boxes on your worksheet.
Pictures from the Clipboard, copied from graphics programs (or elsewhere)
can be pasted in, as can QuickTime movies. Text boxes can be placed to add
explanatory text (see fig. 18.54). The Draw palette contains the various tools
you need to draw on your worksheet.
You also can choose whether to include drawn objects when you print your
document. The File menu's Print Options command enables you to select
which items will be printed.

Tip
A very nice effect
is achieved by
clicking the
graph, and then
by choosing to
add a thin
shadow frame (by
choosing from
the Style palette's
Frame pop-up
menu). Also,
using a light
shade of gray for
t he gra ph's enclosing box sets
the graph off
well.
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Fig. 18.54
Arrows and text
boxes can be
added to a
worksheet.
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Using Databases
1-2-3 enables you to create and manage databases in ways similar to Excel,
but 1-2-3 also can connect to and work with external databases created in
such programs as FoxBase.
Creating a basic database in a worksheet is simple. You enter the data in
columns, select the cells containing the information (column headings
included), then choose the New Fo rm command from Data menu.
Immediately, you are able to browse, enter, and edit records in your database
(see fig. 18.55).
Fig. 18.55
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You can access your database from other parts of your worksheet by using the
Database functions in the pop-up Functio n men u's Database submenu.
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1-2-3 enables you to connect your worksheet to external data bases with the
Data menu's Connect to External command (see fig. 18.56).
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Fig. 18.56
Connecting to a
Fox Base database.
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This ability to connect to external databases should appeal greatly to business
users who have large employee databases o r other information databases,
especially those on network systems. 1-2-3 can connect worksheets to remote
databases, send commands to them, periodically update the worksheet
(refreshing the data), and even do the translation from IBM to Macintosh
character sets.
Once connected to the external database, 1-2-3 treats the database as if it
were part of the worksheet. All the commands used fo r working with a
worksheet database apply to working with the external database.

Analyzing Data
Excel has, by far, a great deal m ore analysis tools available. But, 1-2-3 is not
without features in this area. Unless you need the heavy-duty statistical
analysis featu res of Excel, 1-2-3 may be sufficient for you r needs.
The Data menu contains the Distributio n and Regression commands. Both
commands invoke dialog boxes that enable you to select cell ranges fo r the
in put and output data (see fig. 18.57).
-
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Using the statics functio ns in the Function menu of the Con sole, you can
also o btain averages, sums, sumproducts, variances, maximums, minimums,
counts, and standard deviatio ns.

Fig. 18.57
Preparing to do
a distributio n
a nalysis.
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Using Macros
1-2-3 uses a unique approach to macros. The program continuously records
your actions in the Macro Transcript dialog box which you can access
through the Tools menu's Macro submenu. The Show Transcript command
displays the listing of the commands that correspond to the actions you have
taken (see fig. 18.58).
Fig. 18.58
Viewing the Macro
Transcript.
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You use the standard Macintosh cut and paste tech niques to incorporate
command lines into your macro; then paste the Macro into a worksheet you
intend to use for storing your macros.
You then select the cells contai ning the macro. Open the Range menu's
Name submenu and choose the Create command. Name the cell range with
the name you wish to use for the macro.
The macro can be added to your Tools menu or invoked through the Macro
submenu's Run Macro command.

Working with 3-D Spreadsheets
You can have more than one worksheet within the worksheet window. This
enables you to have three-dimensional spreadsheets. You can visualize this by
imagining the worksheets as being "stacked" on top of one another (see fig.
18.59).
The view shown in figure 18.59 is a perspective split view, which is available
by using the Split command in the Window men u. While good for viewing
three-dimensional worksheets, this view is not easy to work wi th. Normally,
the three-dimensional worksheet looks pretty much like any other. You can
access the other layers of the worksheet by using the pop-up menu (click the
triangle) in the upper-left-hand corner of the window (see fig. 18.60).
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Three-dimensio nal spreadsheets are created by using the Worksheet menu's
Insert command. You have the option of inserting a number of other sheets
either before o r after th e current o ne.
The true power of three-dim ensio nal spreadsheets is that your form ulas can
refer to other sheets. By preceding a cell reference with the sheet letter, you
reference the cell within that sheet. In the figure, for example, cell FS o n all
the sheets contain the Year to Date sales. To total the year's sales fo r all th
years, you would en ter a formula such as:
+@SUM(A:F5, B:F5, C:F5, D:F5)
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Fig. 18.60
Accessi ng
worksheet C.
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Three-dimensional spreadsheets are part of the reason 1-2-3 has been a longstanding favori te in the DOS world. And the ability to create com plex,
three-dimensional spreadsheets is an att ractive feature for the Macintosh
spreadsheet user as well.
Excel provides for a linkage between workshee ts, but 1-2-3 is much easier to
use in this respect.

Getting the Most Out of 1-2-3: Hot Tips
• DOS users of 1-2-3 who are new to the Macin tosh world will be happy
to find that they may press the slash key(/) and 1-2-3 Macintosh will
perform in a sim ilar m anner as DOS. This can help ease the transition
between platforms.
• Remember that 1-2-3 keeps a ru n ning tra nscri pt of your actions and
you can tu rn almost anything you have done into a macro by copying
the macro commands in the transcript.
• Viewing the macro transcript also can aid you in learning the 1-2-3
macro command language.
• If you work with 1-2-3 DOS users, keep your for matting fairly simple.
Tho ugh 1-2-3 Macintosh can translate between the two versions, some
formatting can be lost.

Summary
Lotus 1-2-3 remains my personal favorite in the spreadsheet category because
of the program 's ease of use. Unfortunately, d ue to the length of time Lotus
took to bring the program to the Maci ntosh world, Excel remai ns the dominant and most popular spreadsheet amo ng Macintosh users. Therefore, the
1-2-3 user is at somewhat of a disadvantage when it comes to com patibility
within the Macintosh world. At the same ti me, 1-2-3 is so widespread in the
DOS world that Macintosh users who deal with DOS 1-2-3 users will likely
prefer the program d ue to the compatibility with DOS 1-2-3.

Conclusions and Recommendations
The past couple of yea rs, the Macintosh spreadsheet world has been something of a "battle of the titans." Other spreadsheet programs have come and
gone. A few have h ung on, but there is no q uestion tha t Excel and 1-2-3 are
currently the d ominant spreadsheet programs.

From Here.. .
Both are excellent choices for busi ness and personal use in terms of featu res
and performance. However, as Lotus recently announced, it will not continue
to revise 1-2-3 for the Mac; Excel has become the o nl y optio n.

From Here ...
Consider these chapters for more informatio n:
• Chapter 17, "Presentation Graphics." Spreadsheets and graphics often
go hand-in-hand in business. This chapter can show you ava ilable software for creating business presentations.
• Chapter 19, "Databases." 1-2-3 interfaces with database software
enabling you to access large amounts of information. The programs
that create and maintain these large pools of data are d iscussed in this
chapter.
• Chapter 26, "Personal and Business Management." While a spreadsheet
program can be used to m anage finances, schedules, and contact lists,
you may need software specifically geared in these d irections.
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Databases
by Dave Plotkin

If you stop to think about it, the most va luable thing you have on your com-

puter is your data. Whole industries are built on the gathering, exchange, and
manipulation of data. In o rder to manage your data properly, you need a
d atabase. A database is an o rganized collection of related informatio n . Two of
the p rimary ways of storing database info rmation are on paper or in a computer. An exa mple of a database stored on paper is an address book. Of
course, an address-book type of database can also be kept in a computer.
This chapter introduces you to the two most popular databases used on the
Mac:
• Claris Filemaker Pro
• Microsoft FoxPro Mac

What is a Database?
The information in a computerized database is usually stored in th e form of
tables, with rows and colu mns in each table. Figure 19.1 ill ustrates the rows
and columns in an address-book type database. Each row in table 1 contains a
set of columns: Name, Address, City, State, Zip Code, and Phone Nu mber.
Rows in such a table are called records. The columns represent categories of
related information that are present in each record (row). Each of these categories is called a fielrl.
The information that pertains to one person is one record. The address-book
database t hus contains many records-one for each person you've noted.
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Each record contains many fields, such as the person's name, address, phone
number, and so on.
In addition to the address book mentioned in the preceding section, you can
create all kinds of useful databases at home or in you r business. These databases can include a list of your record collection, household inventory, a list
of customers, invoices, orders, and inventory. Thousands of computer applications have been built that track and manipulate lists of information.
Computerized databases provide far more functionality th an just storing
information in tables, however. They can be used to design fancy forms for
inputting and va lidating data, sophisticated reports for printing out the data,
and queries that return only the data that matches specified criteria. Some
databases have their own programming language so that a developer can
create a complete application.
Two general kinds of databases exist: Flat-file and relational databases. Flatfile databases are simple lists. Your address book is a good example of a flatfile database. Relatio11al databases are much more powerful. They are used to
link information stored in more than one table or file. For example, you can
have one table that contains a list of your customers and another table that
contains a list of orders that those customers have placed. By linking these
tables, you can include the customer names and addresses on a form that also
shows the order informatio n.
While it is certa inly possible to keep databases on paper, large databases
quickly become unwieldy when you try to maintain them on paper-and you
can never find the data you are looki ng for.
Keeping your database on a computer has some significant advantages over
the man ual method:
• You can store a huge amount of inforf!lation in a relatively small
amount of space.
• You can instruct the computer search for that informatio n quickly and
efficiently.
• You can instruct the computer to print reports, mailing labels, and form
letters from the results of such a search.
• You can create forms for data input.
• You can reorganize the database based o n a different piece of information (field).

Filemaker Pro
A computer-based database frees you from having to keep all your records on
paper and lets you do more creative things with your time.

What is Out There
The Macintosh database market is largely ruled by two products: Claris'
Filemaker Pro and Microsoft's FoxPro Mac. These are very different prod ucts,
appea ling to a very different set of audie n ces. Filemaker Pro is a simple, flatfile da tabase that is easy to learn and use but lacks certain feat ures. Fox Pro
Mac is a monolith with a programming language and a fairly steep learning
curve. As such, it wi ll probably appeal more to programmers and developers
than to end users, but those that need the power of foxPro Mac should check
it o ut.

Filemaker Pro
Filemaker Pro is a simple database that gives up true rela tional capabili ties for
simplicity. However, Filemaker Pro does manage to provide the most-often
used tra its of relational databases successfully, making it an excellent choice
for many database users. Filemakcr Pro is available for Windows as well, making it also a good choice for developers who need an a pplication that runs on
mu ltiple types of computers.

System Requirements
As database applications go, Fi lemaker Pro is not very large. It is packaged o n
four disks and takes up only about 4 MB of disk space for a complete installation. You on ly need 1.2MB to install the application itself, without any exa mples or the help fi les. Your Macintosh must also be at least a Mac Plus with
System 6.0 and 1 megabyte of memory (2MB with System 7).

Setting Up a Database
The first step in settin g up a database in fil emaker Pro is to select New from
the File menu and name the database. Next you define the fields using the
Define Fields dialog box. You define each field by typing the name into the
Name text box, and selecting a field type from the Type radio buttons. Types
of fields include text, number, date, time, picture or sound, calculation, an d
summary fields. As you add fields, they appear in the Define field dialog box
(see fig. 19.1). You can sort the fields by order of creation, field name, field
type, or in a c ustom order. If you choose to view the fields in a custom
order, you can click and drag on the small arrow to the left of each field to
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rearrange the fields. You can also click an existing field and change any of its
specifica tions.

Fig. 19.1
The Defi ne Fields
dialog box is where
you define the
fields for a
database.
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Filemaker Pro enables you to enter auto-entry and validatio n options
fo r each field in the Entry options dialog box (see fig. 19.2). Auto entry
options include Creatio n date or time, Modificatio n Date or time, or the
creato r o r modifier name. You can enter a serial number and specify the starting number and increment for the data. You can also enter a data constant.
Validation s include checking that the field is not empty, ensuring that the
value entered is un ique across the database, ensuri ng that the value already
exists in this field in the database, making sure that the data entered is of a
certain data type, or that the entered data falls in a range between two values.
You can combine some of these options. For example, you can specify that a
value is uniq ue and fa lls withi n a range.
Filemaker Pro has some other powerful field-specification tools available fro m
the En try Options dialog box. If a field contains frequently-used values, you
can define those values as a list to be displayed as a pop-up menu, pop-up
list, check boxes, o r radio buttons. You can also look up information in another Filemaker Pro file and copy it into the current field as you add or edit
records. To look up a field in ano ther file, you m ust tell Filemaker Pro what
field in your curre nt file m ust match the conten ts of a specified field in ano ther file. Wh en Filemaker Pro finds a m atch, it copies the contents of the
lookup field you specify in the other file in to the current field. You can even
specify what h appens if Filemaker doesn't find an exact match : you can copy
the next higher o r lower value, leave the field blank, o r use a constan t value
that you specify. Lookups are very powerfu l, but they do h ave some limits. If
you change the value in the trigger field (the field used to match a value in the
other database), Filem aker Pro will look for a new ma tch . Filemaker Pro does
no t au tom atically look fo r a new match if you change the value in the lookup
field of the o ther database, however.

Filemaker Pro

Fig. 19.2
The Entry Options
dialog box.
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Filemaker Pro incorporates a very powerful type of field called a repeating field.
A repeating field enables you to attach multiple occurrences of fields to a
single record. If you have a database that contains invoices, for example, you
can create repeating fields that represent the line items on the invoices. These
fields might be the item number, description, and the unit price. To set up a
repeating field, you need to specify the field as repeating in the Entry Options
dialog box and determ ine the n umber of repeats allowed. Although Filemaker
Pro enables you to use up to 1000 repeats, you must leave room on your form
for all the repeats-you can't display a smaller number and scroll through the
repeating fields. Th is is an unfortunate limitatio n.
Fields can be calculated or summary fields. If you select a calculated field,
Filemaker Pro opens a dialog box for defining the calculation formula. You
can type the form ula into a text box, or select field names, arithmetic operators, and fu nctions from scrolling lists to build the fo rmula in teractively. The
operators include common functions such as plus, minus, multiplication, and
so on. They also incl ude Boolean operators such as AND and OR. You can
choose from about 80 functions, including statistica l, trigonometric, logari thmic, and data type conversion (convert data to text).
Summary fields enable you to perfo rm operations across the records in your
database. For example, you can determine the total, average, o r count of a
field in your records. You can also create a running field (a running total or a
run ning count) that performs the select operatio n on all records from the fi rst
record through the currently viewed record.

Building a Layout
When you are done defining the fields in a database, Filem aker Pro builds a
default layout fo r data entry (see fig. 19.3) . Unlike many other database products, Filemaker Pro makes no distinction between forms and reports. This can
be handy-you can enter data right on m ultiple-record report layout. There
are various styles of layouts, including single record (form), colu m nar (tabular), multiple-record (report), maili ng label, and an envelope template.

Tip
Use Edit Relookup
to resyncho nize
the lookups if you
suspect that the
value in the
lookup field has
been chan ged in
the other database.
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The mailing label layout enables you to pick from Avery label numbers or
specify the margins, labels across, and label dimensions for custom labels.
You may pick a new layout style at any time by selecting New Layout from
the Edit menu.

Fig. 19.3
Filemaker Pro
creates a default
form when you
define a database.

You can use the default layout that Filemaker Pro provides or create a new
layout. You can rename the layout at any time. If the data you are displaying
is narrow (doesn't take up the full width of the layout), you can specify multiple columns on the layout.
Defining the Parts of a Layout

Each layout is a collection of bands, or parts. These part include headers,
footers, the body section, and summary parts. Summary-type parts include
leading and trailing grand summaries, as well as summaries within the layout. To use a summary within a layout, you must specify a field to summarize
on. Filemaker Pro sorts the records on the selected field. You can add summaries within summaries.
To add a part to a layout, click and drag the Part tool onto the layout.
Filemaker Pro open s the Part Definition dialog box (see fig. 19.4). In addition
to picking the type of summary and the field(s) to summarize on, you can
choose when to provide page breaks and whether to allow summarized sections to go across page breaks.
Fig. 19.4
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Filemaker Pro
Working with Fields In a Layout

You can add fields to a layout by clicking the Field tool and dragging it onto
the layout. If you drag a field onto the form, Filem aker Pro pops up a New
Field dialog box so that you can choose the field you want. You can have
Filemaker Pro also create the field label at the same time, or create it yourself
by using the Text tool.
All the fields in the database are d isplayed as text boxes by default, but you
can customize the way fields are displayed and the data for mat of the fields.
For example, you ca n customize the database in the fo llowing ways:
• Increase the number of d isplayed lines in a text field. Text fields can
ho ld up to 64,000 characters, so you m ay want to display more than
the default single line. To increase the size of field, click the field to
show the sizin g handles, and then click and drag the handles to adjust
the field size.
• Display a field with a valid list as a pop-up m enu or pop-up list. A popup list displays the field's values in a window that appears when you
click the field. A pop-up menu displays the valid values in a drop-down
list with a scroll bar when you click the field. Either of these two optio ns works well when there are a fa irly large number of valid values
(more than about five values). You can add an "other" optio n to a popup list. If you click the "other" o ption in browse mode, you can type
the alternate value into the dialog box that appears.
• For a small number of valid values, you may want to display the values
as check boxes or radio buttons. If you display check boxes, Filemaker
Pro creates a check box for each valid val ue in the list. When you are
entering data, you can click any check box to select the value. One
d ifficulty with check boxes is that you can click mu ltiple check boxes
on the fo rm, but o nly a single va lue is stored in the database. If you
d isplay radio buttons, Filemaker Pro creates a rad io butto n fo r each
valid va lue in the list. If you click a radio button, Filemaker Pro deselects any other radio button. You can add an "other" option to either
radio buttons or check boxes as well.
• For repeating fields, you can choose how many repeating occurrences
you want to display on th is fo rm. You can include any number of repeats up to the maximum number defined when you created the database. However, any occurrences you don't display can 't be entered on
the form.
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Tip
I f you plan to use
multiple repeat ing
fields to si mulate a
one-to-many
relationsh ip, align
the fields next to
each other to form
a table of repeating val ues.

Fig 19.5
The Filemaker Pro
tool bar.

Formatting the Objects on a Layout
Filemaker Pro has a powerful set of formatting tools to customize a layout.
You can add text blocks, lines, rectangles, rounded rectangles, and ovals to a
form from a drawing toolbar (see fig. 19.5). To add a graphic shape, click the
shape you want, and then click and drag on the layout to define the position
and size of the object. You can choose the fi ll color and pattern, line color
and pattern, and the line thickness of the graphic object from a set of dialog
boxes that appears when you click the formatting buttons. You can add a
page number, time, or date to a text block.

Drawing tools
New Field -t!!!!!!:=:JI
Part Definitions

Fill Color
Line Color
Line Width

You can independently format the text that will appear in a field and the text
format of the field's label. You can choose the font, size, style and effect,
alignment (left, center, or right), and text color. Styles include shadow, hollow, bold, underline, italic, and several styles of underline. You can combine
the styles to get some striking effects. You can also format the line thickness,
style, and color of the field borders.
Filemaker Pro provides a large number of formatting gadgets to help you Jay
out your form. You can display ru lers, use a snap-to grid with adjustable dimensions, align objects horizontally or vertically to each other, group multiple objects together so that you can work with them as a single object, and
set the exact location and size for an object using the Dimensions dialog box.
Another handy tool is the t-square. Looking much like the drafting tool of the
same name, the t-square shows a set of crossing lines, making it very easy to
align objects to a certain point on-screen. You can also use Filemaker Pro's
Slide tool to close up "holes" left by unused fields (unused second address
lines, for example) or by fields whose contents don't entirely fill the space
available on the layout. Finally, you can adjust the order in which the cursor
moves between fields when you press the Tab key (see fig. 19.6). Adjusting
the order is sometimes necessary when you rearrange the fields on the layout.
Filemaker originally orders the fields from left to right within a row, and from
top to bottom. If you rearrange the fields, however, you can find the field
focus jumping around on the screen. By rearranging the tab order, you can
have the field focus move in a more orderly manner.

Filemaker Pro
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Fig. 19.6
Adjusti ng the tab
order of the fields
on a form.
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Formatting Field Display Values
Filemaker Pro offers many options fo r formatting field values. For example,
you can format a time field value as 12 o r 24 hour, specify the exactness of
the time displayed, and choose the separator character. Field displays don 't
change how the data is stored in the database. When you edit a field, it
shows you the exact data you are entering. However, when you move the
focus away from the fi eld, Filemaker Pro redisplays the field in the specified
format. When you set the field format, you can set the format of the text for
the field. You can also set the text fo rmat from the Format menu.
You can set the format for numeric fields. You can choose the number of
decimal places, use percentage or currency, and use a thousands separator (for
example, a comma). For decimal numbers, you can specify the currency symbol, the thousands separator symbol, and th e decimal point symbol. You can
format negative numbers with a negative sign, parenthesis, o r a "CR" symbol.
You can also prin t negative numbers in a different color.
You can format a number as a Boolean value. If you format the number as a
Boolean value, you can specify zeroes as o ne value (either Yes or No) and
non-zeroes as the o ther value.
Date field fo rmatting is very versatile. You can format the date in a variety of
different o rders, and with different abbreviations for the month, day, and
year. If none of the predefined formats suit you, you can define date forma t
completely from scratch, defining the day, month, date, and year formats

Tip
To keep the
field and its label
together as you
rearrange items on
the layout, group
them togeth er.
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independently. You can choose to show the month and day number with a
leading zero if the number is only a single digit. You can also choose the
separator character.

Navigating Through Your Layouts and Records
Moving through your layouts and records is straightforward, if somewhat
different from other Mac applications. To switch layouts, you can click the
layout selecto r in th e upper left corner of the screen (see fig. 19.7) . Filem aker
Pro presents you with a list of layouts to pick from (see fig. 19.8).

Fig. 19.7
The Layout
selector allows you
to switch layouts.

Fig. 19.8
The rolodex makes
it easy to move
through records
and layouts.
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The rolodex symbol just below the layout selector enables you to switch
between records. To move through your records one at a time, just click the
top (to move forward) or bo ttom (to move back) rolodex page. You can use
the small tab sticking out to the right of the rolodex sym bol to move through
records as well. To move through the records, click and drag the tab to the
record you want. Filemaker Pro d isplays the number of the currently selected

record below the rolodex. You can click this number and type the number of
the record you wa nt.

Finding and Sorting Your Data
You can sort the records in your database using the Sort records dialog box
(see fig. 19.9). You can select the fields to sort o n from th e Field List on the
left side of the dialog box, and move the fields into the Sort Order list o n the
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right side. Yo u can sort o n m ultiple fields at a time. For exam ple, you can sort
o n last na me, and fo r people with the same last name, sort o n first name. Yo u
can reorder the fields in the Sort Order dialog box by clicking and draggi ng
the small arrow at the left side o f the field. You can sort an y field in ascending or d escending order. If you choose to sort on a field with a value list, you
can even sort t he records in the same o rder as the va lues in the value list.
~

s;ort Records

sort Order
( creul\11 ) • l ast Neme
• n n t N• me
~ • \ tate

rleld l ht
l ii SI Name
rln t Name
~ tr·ee t

City
St ole

Fig. 19.9
The Sort Records
dialog box.
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Filemaker Pro makes it simple to locate records that meet sea rch criteria.
In Find mod e, you simply type the information yo u are looking fo r in to t he
field s on a layout. When you type a find criteria into a field, Filemaker Pro
finds all the records w here the fields start with the text string you ty ped. You
can also specify an exact match, where the field contents must exactly match
what you typed. You ca n use special symbols to sea rch fo r reco rds where th e
field con ten ts are greater t han, less tha n, or between the values you typed.
For exam ple, you can type A... M in to th e Last Name field and Filemaker Pro
retrieves all the reco rds with last names that start with the letters A
through M.
You can use wild cards to substitu te for eit her a single letter o r a string of
letters. If you type find criteria in to multiple fields, Filem aker Pro does an
"and" find: it on ly bri ngs back records where all fields match the criteria you
typed. Do ing an "or" search is mo re d ifficult. In o rd er to have Filemaker
Pro bring all reco rds t hat match any o f the find criteria, you must use multiple req uests. This ca n get quite tedious if you are looking fo r a lot o f criteria.
You have the o ptio n to b ring back o nly those records that do NOT meet your
fi nd criteria.
Once you have executed a Fi nd, you can switch back to Browse mode and use
just t he "fou nd set" (results o f the find). You can delete t he fo und set, ed it
the values, and switch to another layou t (such as a ma ili ng labels layout). To
return to workin g with all the records, select Find All from the Select menu.

Tip
To sea rch for blan k
fie lds, use the
exact match character (=) all by
itself. To search for
nonbla n k fields,
use the exact
ma tch character
a nd select the
"omi t" option for
the fin d.
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Writing Scripts and Using Buttons
Filemaker Pro supports buttons. A button is any graphic object you p lace on
the screen. When you click a button in Browse mode, it executes a command
that you select from the Define Button dialog box (see fig. 19.10). To define a
button action, you must be in Layout mode. Select the object you want to use
as a button, and then choose Define Button from the Scripts menu. Available
commands include re-executing the Find or Sort that was active wh e n the
button was created, paging up and down, moving through fields, running the
Spell checker, changing to Browse, Find, or Preview mode, duplicating a
record, adding or d eleting a record, printing the record or found set, de leting
the found set, and virtually any of the m enu commands available in
Filemaker Pro. A button can also be configured to run a script.
Fig. 19.10
The Define Button

dia log box.
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One df Fllemaker Pro's more powerful features is the Scriptmaker. Scripts
e nable you to automate tasks that you or your users perform on a regular
basis. These scripts might, fo r example, do a Find, switch to a mailing label
tem p late, and print the results. You can attach display scripts in the menu
bar, or attach them to buttons (see previous paragraph). To create a script,
you must first n ame the script in the Define Script dialog box. This dialog
box also enables you to delete script, duplicate scripts, edit scripts, and
rename scripts.
A script is a series of commands that Filem aker Pro executes wh e n ever the
script is run. A script can run all the commands men tion ed above fo r a button (inducti ng finds and sort), as well as add itional commands, suc h as doing
a relookup, sending an App le event, impo rting and exporting records, a n d
doing page setup. A script can also run another script. To create a script, you
select the commands you want to use from the Available Steps list in the
Script Definition dialog box (see fig. 19.11). Yo u ca n double-click the step or
click it and then click the Move button to move the step to script command
list. You can click a nd drag the steps in the script command list to rearrange
the m a t any time.
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Some script commands need additional information in order to work properly. For example, if you select the Go to Layout script command, you must
specify the layout to go to. When you select a command that requires additional information, Filemaker Pro modifies the Options section of the Script
Definition dialog box to request the specific needed information.
Fig. 19.11
The Script
Defin itio n dialog
box.
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Using Filemaker Pro's Security
Filemaker Pro can be installed on a network, and you can define security for
multiple users. Security access is defined in terms of a group, to which you
attach specific users. You can define the layouts accessible to a group. You
can also define field properties: which fields are accessible, which fields are
hidden, and which fields are available as read-only. A set of passwords can be
placed in a group so that different users (with different passwords) can share
the same security access. As with everything else, the security dialog box is
straightforward and easy to understand (see fig. 19.12).
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Fig. 19.12
The Access
Privileges dialog
box .
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Getting the Most Out of Filemaker Pro: Hot Tips
• To calculate a person's age from a field containing their birth date
(Birthdate), use the following formu la:
Year(Today) - Year(Birthdate)-If(Today < Date(Month(Birthdate),
Day(Birthdate), Year(Today)),1,0)
• You can use Filemaker Pro's calculations and string-h and ling functions
to format phone numbers. This formu la uses the If function to format a
7 d igit phone number differently from a longer phone num ber that
contains an area code. Finally, if the phone number is longer than 10
digits (for example, an international phone number), the phone number is left as entered: If (Length(Abs(TextToNum (PhoneNum))) = 7,
Left( Abs( TextToNum (PhoneNum)),3)& "-" & Midd le (Abs
(TextToNum (PhoneNum)), 4, 4), If (Length (Abs (TextToNum
(PhoneNum))) = 10, "(" & Left (Abs (TextToNum (PhoneNum)),3) & ")"
& Middle (Abs ITextToNum (PhoneNum)), 4, 3) & "-" & Middle (Abs
(TextToNum (PhoneNum)), 7, 4), PhoneNum)).
• To change a field on a Layout to a different field, press the Option and
;}::( keys, and then double-click the field. This brings up th e new field
dialog box. Select the field you want to replace the selected field wi th.
This action replaces the field, but retains the field formatting.
• You can separate check boxes and radio buttons in a set with a blank
line by placing a blank line in the value list. You can also separate
scripts in the script menu with a separator by creating a script with the
name "-".
• If your database contains duplicate records, but you want to generate
only a single form letter for each set of duplicate records, use a
subsummary. For example, if you have a database in which you record
donors of artwork, you might have a person in the database multiple
times if they have don ated mu ltiple pieces of art. Set up the form letter
with the name and address fields at the top of the letter along with any
initial portion of the letter. Any references to fields with different values
(such as the references to the artwork donated) are located in a leading
subsummary by donor name part. Any additional remarks and the closing of the letter should be in a trailing subsummary by donor name
part.

• To add serial numbers to an existing database, add a field to the database that uses the serial n umber option for field formatting. The serial
number field will be blank in all records. Use the export function to

FoxPro for Mac
export the database in Filemaker Pro format. Import the database back
into Filemaker Pro. During the import process, Filemaker Pro will number the records and assign sequential serial numbers.

Summary
Filemaker Pro is a powerful flat-file database that gets around some of its
limitations by using repeating fields and lookups. The long text data fields
and the easy creation of layouts contributes to its ease-of-use. However,
Filemaker Pro is not a relational database, and if you need more than just a
few repeating fields, or the ability to do true relational joins, you will need to
look elsewhere.

FoxPro for Mac
Microsoft's FoxPro for Mac is at the other end of the spectrum from Filemaker
Pro. Where Filemaker Pro is a flat-file database, FoxPro Mac is truly relational.
FoxPro for Mac also includes a full programming language/development
environment in the form of the venerable xBase programming language.
Many things that are fairly simple to do in Filemaker Pro require writing a
program in FoxPro Mac. On the other hand, you can achieve many things
with FoxPro Mac you would never be able to do with Filemaker Pro. Just be
prepared to spend time learning to use this product effectively.
FoxPro Mac evolved from the Windows product, which itself was an offshoot
of its DOS-based predecessor. Files can be easily be exchanged between the PC
and Mac versions of the product, and FoxPro Mac adheres to most of the Mac
user interface correctly. FoxPro Mac includes a powerful report writer, screenbuilding tool, query builder, and expression builder.

System Requirements
FoxPro Mac is big, shipping on 8 disks and installing 725 items on your hard
drive for a total of 17 M. FoxPro Mac also requires at least 4 MB of memory (8
is recommended) and System 7.

Building a Table
The first step in defining a database application in FoxPro Mac is to define
the structure of the tables you will be using. The New dialog box enables you
to build new tables, programs, files, indexes, reports, labels, screens, menus,
queries, and projects. If you choose to build a n ew table, Fox Pro Mac opens
the Table structure dialog box (see fig. 19.13). You use the Table Structure
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d ialog box to enter the field defi nitions for th e database. You can select the
field name, type, width (size), and number of decimal places. You can rearrange th e fi elds in the dialog box by clicking and dragging the button to the
right of each field.

Fig. 19.13
Definin g a Table

Structure.

Fox Pro Mac supports a wide va riety of field types, includi ng character, floa ting point, numeric, date, logical, memo, and general. You can store almost
anything in a general field, includ ing graphics. Character fields can be up to
255 characters. If you need more room th an that, you must use a memo field,
which can hold large amounts of text.
You can use the Setup menu option in the Database menu to define indexes
fo r the da tabase. An index is a way to establish the o rder of the records in the
database. If you don't establ ish an index, th e records are d isplayed in the
o rder in which you entered them . The index presents the records in order of
the fields you select. For exam ple, you could define a custo mer database that
is indexed on Lastname and Firstname. You can defin e multiple indexes fo r a
database and select between them, instantly modifying the order in which
records are displayed. An index can be ascend ing o r descending, and you can
require that the values in the index fields be un ique. You can also filter
records on the index fields. FoxPro Mac's excellent expression builder m akes
defining index filters very straightforward. You can ch oose from over 100
string, logical, math, and date fu nctions. You can also use system variables.

FoxPro for Mac
After you define your table, you have the option of immediately entering
records. FoxPro provides a very simple form that displays all your fields in a
stacked format.

IV

Working with Your Data
FoxPro Mac enables you to work with your data using either a custom-built
screen o r Browse mode. Browse mode presents the data in a spreadsheet-like
format, with records in rows and fields in colum ns. You can adjust the width
of a column by clicking and dragging the border between colu mns. You can
also rearrange the columns by clicking and dragging the colu mn headings
and set the font for the entire grid . Unfortunately, there is no way to save
this layout. You can edit the information in Browse mode by typing in the
new or modified information into the fields. You can also split th e Browse
mode window into two parts which can either scroll together (synchronized)
or separately (unsynchronized). You can activate Change mode, which displays the records in the database in a simple, vertically stacked arrangement
of fields (see fig. 19.14).
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FoxPro Mac is a relational database, and it is very straightforwa rd to join
tables so that you can use the fields from multiple joined tables on a single
screen. FoxPro Mac will even suggest the join condition if the join fields in
the two tables are named the same (though they don't have to be) . However,

527

Fig. 19.14
The Change
window of
Browse mode.
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although it is possible to create a one-to-many join between tables, FoxPro
Mac lacks a repeating panel (or Filemaker's repeating fields) to show the results of that join on a screen. It is possible to include a browse window (see
the Hot Tips section) to display the many side of the jo in on the screen, but it
takes quite a bit of code-writing to accomplish th is.
Building a Custom Screen
f oxPro Mac's custom screen builder makes designing data input screens fun.
It includes a wide variety of tools for customizing the screen and making it
attractive to the user. The first step in creating a new screen is establishin g
the general layout. The Screen Layout dialog box (see fig. 19.15) enables you
to establish the size and location of the screen on the desktop. You can click
and drag an image of the screen, or adjust the position and size using spinner
controls. You can set the title and name of the screen, and change the color
of the screen background. You can even specify a graphic file to use as a background for effect.

Fig. 19.15
The Screen Layout
dialog box.
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You can set many options for a custom screen design. The Window style
button enables you to set various window attributes. These include wh ich
objects appear in the window (close box and whether the window is moveable), border style (none, single, double, panel, o r system), and the overall
window type (system, dialog, alert, or user).
Tip
To present you r
user with a message, use an alertstyle window that
pops up under
program control.

The Code option in th e Screen Layout dialog box enables you to attach snippets of program code to the screen. You use the Screen Code dialog box to
write th e code that execu tes when the screen opens, closes, and when you
click the window. The code must be written in xBase, FoxPro Mac's built-in
programming language (see "Programming Fox Pro Mac," later in this chapter).
When you have the basic screen size, color, code, and so o n, it is time to add
objects to the screen. You can quickl y prototype a screen by using the quick
screen feature on th e Screen menu. You have the option to choose a horizonta l or vertical layout, and a maximum field width. From the quick screen, you
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can choose which fields to place on the screen, although th e d efa ult of all
fields in the database often works well (see fi g. 19.16).

IV
Fig. 19.16
Building a screen
layout in FoxPro
Mac.

Adding Fields to a Screen

You can also add fields to the screen by using the tools in the toolbox along
the left side of the screen (see fig 19.17).
Fig_ 19_1 7
Text block
Field
Scrolling text field
Command button
Radio button
Check box
Drop-down list
Value list
Spinner
Line
Rectangle
Oval
Graphic

The field tool lets you click and drag a rectangle on the screen to define a
field. When you release the mouse, FoxPro Mac pops up the Field dialog box.
You can select whether the field is an input field (field or va ri able from th e
database) or an output field. An output field is an expression that you can
build to display a result based on a for mula that can use fields, variables, and
all the FoxPro Mac functions. From the Field dialog box, you can also set the
field style, including 3-D style, whether the field is selected o r disabled when

Add fields to the
screen by using
the tools in the
toolbox.
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you enter the form, a va lid range of values, a nd t he field forma t. You establish the range of va lues by entering a proced u re (written in xBase) or an
express ion to set the low end of the range and the h igh end of the range.
Expressions are built using the Expression editor. Th e field format lets you
specify a variety of formatting options, depend ing on the type of field. For
text fields, you can specify a lp h a o nly, a ll u ppercase, the text alignment, and
rem oving the extra spaces (trim). For numeric fi elds, you can left justify,
suppress leading zeroes, use curren cy o r scie ntific fo rmat, set the format
whe n the nu m ber is negative, a n d suppress the n u mbe r if it is zero.
The Clause section of the Fie ld d ialog box enables you to enter snippets of
code for the field. There are four cla uses avai lable: W h en, Valid, Message, and
Erro r. The When clause con trols w hat happen s when a fie ld is selected. If the
code in t h e When clause doesn't return a .T. (true), you can't access t he field.
The Va lid clause controls the code t hat is executed w h en you attem pt to exit
a field. If the code doesn't return a .T. (true), you can't exit the field. This
code snippet can thus be used to ensure that a valid value is entered in to t he
field. The Message clause enables you to write a message that Fox Pro Mac
displays o n the status line when you enter the field. Finally, the Error clause
lets you code custom error m essages to be d is played if the code you add returns a .f . (false). Altho ugh these cla uses give you m ore flex ibility an d power
tha n Filemaker Pro's automa tic entry a nd fie ld valida tion optio ns, they a lso
requi re considerably more effort to use.
In add ition to fie lds in a text for mat, you ca n add fie lds to the form as dropdown list, check box, radio but to n , spin n er, pop-up list, or pop-up list wi th
text box. For a c h eck box, you ca n specify th e check box prompt, whether the
ch eck box is in it iall y checked, an d w hethe r to disable it. You ca n use When
and Valid cla uses to modify the ch eck box beh avior if you like. Check boxes
are only available for Boolean (true or fa lse) fields or numeric fields.
Radio buttons are groups of circles with labels. When you select one of t he
radio buttons in a set, any othe r selected radio button is deselected. You can
attach a rad io bu tton to ch aracter or n u meric database fie lds. You specify t he
prompts (text next to each rad io bu tto n), as well as wh eth er the radio
buttons are laid out horizon ta lly or vertica ll y, and the space between radio
bu ttons. Once aga in, you can use the W hen and Va lid clauses to m odify t h e
rad io button behavior.
Pop-u ps are used for setti ng values or choosing from a list of rela ted ite ms.
You can type prom pts in to the Popup d ia log box, a n d a ttach the pop-up to a
ch aracter or numeric field. You ca n a lso draw the prom pts from an array, a
field in another file, or from a da tabase structure.
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You can define spinners for a numeric or text database field. For a spinner,
you can define the minimum and maximum values and the increm ent values. You can also use formulas to define the upper and lower ends of the
spinner range. Using formulas is handy-you can change the spinner ra nge
based on values in other fields.

IV

Adding Graphics to a Screen
You can add lines, rectangles, rounded rectangles, pictures, and butto ns to a
screen. For lines, you can specify the line thickness, style, and colo r. For rectangles and rounded rectangles, you can specify the bo rder th ickness, style,
and color, as well as the fill color and pattern. For a rounded rectangle, you
can also set the amount of rounding at the corners. For a picture, you can
load a graphics file or display the contents of another field. If the picture is
not the right size for the area you allo t to it, you can clip the pictu re (if it is
too big) or scale the picture to fill the frame or retain its shape (if it is too
small).

You can attach code to a button. Buttons can be text, graphics, or even invisible. When you click the button with the mouse, the attached When clause
code executes.
Using Other Screen Design Tools
The screen builder in FoxPro Mac has many other tools to help you with yo ur
layout efforts. You can display rulers across the top and down the side of the
screen. A line o n the ruler shows the current mouse pointer position. You can
also turn on a snap-to grid to help you align objects. Unfortunately, you ca n't
align objects to each other. You can gro up objects together so that you work
with them as a single object. You can also change the stacking order of
objects to determine which objects are on top when objects overla p. You ca n
use the Object Order dialog box to set the o rder in which objects are accessed
on-screen when using the keyboard. The Object Order dialog box co ntains a
list of all objects except graphic and text objects. These o bjects are listed in
the order they will be accessed on the screen. To change the order, click and
drag the o bjects in the list. You can also arrange objects by column or by row.
Testing a Screen
One of the difficulties with FoxPro Mac is that you can' t just switch fro m
Design mode to Test mode to check out how a screen is going to work.
Instead, you must instruct FoxPro Mac to generate the screen so you can then
run it. On a simple screen, this process takes about 15 seconds as th e application generates the necessary code. As screens get m ore complex, the compile
time goes up. This compile/test/fix cycle must be repeated every ti me you
make a screen change.

Tip
To place a circle o r
oval on a form,
select the rou nded
rectangle and
choose the circula r
shape fro m t he
palette of shapes
avai lable.

Tip
To use a large area
of the screen as a
button, create an
invisible butto n
a nd place it over
the area of the
screen you want.
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Running Queries
Fox Pro Mac has a robust q uery builder that enables you to set selection criteria fo r retrieving your data. The query builder is called RQBE (relational query
by exam ple). RQBE is based on the concept that you should be able to
retrieve data in a query by giving an example of the type of data you want.
The RQBE window provides a multitude of options (see fig. 19.18). The tables
list enables you to pick the tables you want for the query. Once you select a
table from the list, you can click the Fields check box to bring up a list of
fields in that table. You can select the fields you want to incl ude from the list.
You can also build functions that include the fields in the table, and add
these to the list as well. For example, you can specify a summary function to
appear in the query result. If you click the Add button, you can add more
tables to the q uery. All tables after the first table must be related to o ne of the
existing tables in the query. When you add a table, FoxPro Mac requests the
join condition in a dialog box. This join condition is then added to the Selection Criteria area near the bottom of the window.
Fig. 19.18
The RQBE
Window.
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Clicking the Order By check box enables you to use some of the o utput fields
to set the order of the records in the query result. You can sort the output on
these fields in either descend ing or ascending order. You can also rearrange
the order of the Order By fields by clicking and d raggi ng them in the list.
Clicking the Group By check box enables you to designate the fields you
wa nt to group the output by. For example, you might order records by Last
Name, but you might group the records by State. The resu lts of the query
wou ld show groups of records for each state, and within each state, ordered
by Last Name. You can even specify the condi tions under which a particular
group will be included in the q uery resul t. For example, you might want only
certain states included. Setting the group criteria is done by clicking the Having check box. The criteria you set for Having can include formulas and summary functions.

FoxPro for Mac
The Selection Criteria area near the bottom of the RQBE window is where you
set the actual cri teria for including records in the query. As mentioned earlier,
any join conditions between related tables appea r here as well. The selectio n
criteria can include fields, constants, comparison operators {Like, Greater
than, and so on), and expressions.
The Option s check box enables you to set options for the query. You can
select the form name, create a quick report, suppress the report details and
just see any summary expressions you have defined, suppress column headings, and output th e qu ery results to a file or the printer. The quick report is
very handy-it displays the query o utput in simple list or columnar repo rt
format.
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Tip
To order by a field
you don't want to
show in the query,
add the fie ld to the
Output Fields,
select the field to
be ordered by, a nd
then remove it
from the list of
Output Fields.

You can output the q uery in a number of different formats. As mentioned in
the last paragraph, you can output a report (see fig. 19.19). You can also output the results in a Browse window, graph, and even a new table. Unfortunately, the results of a q uery are read-only: even in Browse mode, you cannot
edit the query's output. This puts FoxPro Mac at a disadvantage to Filemaker
Pro in this regard.
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When you build a query, FoxPro Mac creates an SQL (structured query language) statement in the background. Although you can' t edit this SQL, you
can copy it into your own programs, thus enabling you to produce the same
results as the query in your own program.

Fig. 19.19
Outputting the
results of a query
as a report.
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Building Reports
FoxPro Mac includes a powerful report writer. You can create a report from
scratch, or modify a report created through the use of a query (this is much
easier). You can also open a new report and instruct FoxPro Mac to create a
qui ck report that you can then use or modify. However, if you must join the
resu lts of more than one table together, you must start from a query or use
the table join function so that you can establish the join conditions.
The Report builder includes most of the tools ava ilable in the screen builder,
including the Field tool, Text tool, Graphic tools (rectangle, line, rounded
rectangle), and Picture tool. You cannot place check boxes, spinners, lists,
and so on, on a report. You also cannot edit data on a report, unlike
Filemaker Pro.
The primary difference between a report and the screen builder (other than
that you can't enter data in a report) are objects called bands. Bands break up
a report into clearly defined areas. Examples of bands include page headers
and foo ters, group headers and footers, and the detail band. A default report
includes all the bands except the group band. To create a group band, you
must specify the field(s) to group by. FoxPro Mac automatically adds the
necessary group band to the report. For example, the report layout shown in
figure 19.20 groups records by Company. You probably will want to create a
calculated or summary field to total any numeric fields that appear in group
bands (see fig. 19.21). You can force a report to move to a new page when a
group changes, and even reprint the group band on subsequent pages.
Fig. 19.20
A report defi n ition
that includes a
group band
(grouped by
Company) .
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You can specify a summary header and footer for the report as a whole, and
use mul tiple columns in a repo rt if the data you need to show is not very
wide. You can use the Print When dialog box for any field to suppress repeating values. You can also print the field when the group changes, and only
print the field when an expression is true. Unfortunately, you must set the
Print When properties field by field .
Note
Fox Pro Mac supports the creation of mailing labels. When you open a new mailing
label fi le, you are given the chance to select from various sizing of Avery labels.
FoxPro Mac then places you in the report writer with an appropriately sized template
available for you to customize.

Creating Your Own Menus
You can create your own custom menus in FoxPro Mac. The menu dialog box
(see fig. 19.22) enables you to construct your own menu from scratch or just
add items to FoxPro Mac's standard men us. For each menu bar item, you can
add menu items. For each item, you can add addi tional items, thus constructing a cascading menu. At the end, you must attach a snippet of code to a
menu option. FoxPro Mac executes this snippet of code whenever the user

A report grou ped
by com pany, with
a sum mary field fo r
the invoice totals.
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selects the menu item. You can use the expression builder to set up a condition that grays out (disables) a menu item when a formula is true. This
enables your applicatio n to determine when it is appropriate for a menu option to be selectable. You can set a keyboard shortcut fo r a menu option , set
up a message to be displayed in the status bar when the user selects the menu
option, and give the bar its own number (overriding the strange coding
scheme that FoxPro Mac uses). You can add separator bars in the menu as
well. A Try It button shows you how your menu will look, complete with
cascading items. However, the menu is not functional-you can' t select an
item to see if it works.

Fig. 19.22
The Menu dialog
box.
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Building a Project
FoxPro Mac provides a tool called a Project to bind all the pieces of your application together. These pieces include queries, screens, databases, reports, and
menus. Yo u can either create all the pieces beforehand and add them to a
Project, o r create th e Pro ject first and create all the pieces from within th e
Project dialog box (see fig. 19.23).
Fig. 19.23
The Project dialog
box.
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Editing items from the Project dia log box is very simple-highlight the item
yo u wa nt and click the Edit button. FoxPro Mac opens the appropriate editor
so that you can work on that item. You can add items to the Project in the
sam e way. Oddly, you must be careful to exclude certain files from a Project.
This ra ther stran ge process involves add ing the file (fo r example, a table) to
the Project, and then excluding it. An excluded file stil l shows up in the
Project, but it has special properties. For example, unli ke included files, you
can modify the conten ts of an excluded fi le after you build the Project into

FoxPro for Mac
an Application (see below). This is usually necessary fo r database tables,
because most database applications involve entering new data into tables.
Thus, most tables must be excluded from a Project.
Once you have gathered all the tables you need (both included and excluded)
into a Project, you can have FoxPro Mac generate an application. The contents of the Project are used to create an application file that you ca n run
from the Program menu. The process of generating an application doesn't
take very long, but if you make any changes to component files in the Project
(for example, change a report), you must regenerate the application. This
delay in your ability to test your application will probably increase the number of errors in your final application.

Programming FoxPro Mac
FoxPro Mac uses one of the most popular programming languages of all time:
xBase. As mentioned, you can attach xBase code snippets to fields, graphics,
and buttons. Microsoft has extended xBase con siderably to handle graphic
objects. It has a huge number of commands available. Even so, xBase is starting to show its age. It doesn't handle event-driven control very well, and the
editor, while adequate, doesn't provide any hint that you can have made an
error until you actually try to run the code. Another problem is that almost
everything requires that you write code. For exam ple, even a simple set of
buttons to navigate through records requires that you write a program!
Almost any other database provides simple functio ns such as record navigation without having to program.

Getting the Most Out of FoxPro Mac: Hot Tips
• If you want to use a complex SQL statement in a program to retrieve
data, you can have FoxPro Mac write the SQL statement fo r you. Open
the RQBE window and set up the query, setting all the options and
table joins that you need. Click the See SQL button to open the SQL
window. Use the mouse to highlight all the text in the SQL box. Use
Edit Copy to place the SQL statement o n the clipboard. Return to the
program editor and paste the SQL text into your program.
• You can attach a set of radio buttons or a list to either a character or
numeri c database field. However, what gets stored in the database varies
depending on the field type. If the database field is a character field, the
actual text of the radio button prompt or the list item is stored in the
database. If the database field is numeric, FoxPro Mac stores the number
of the radio button prompt or the list item in the database.
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• FoxPro Mac does not include a repeating panel to display the m any
records that correspond to the one record for tables that joined in a
o ne-to-many relationship. To add a Browse window to a screen, you
must use the following steps:
1 . Create a parent screen that will encom pass the GET screen (one
table) and the Browse window.
2. In the setup code for the parent screen, define a window with the
attributes you want the Browse window to have, but don't ACTIVATE th e window. For example:

DEFINE Window browse;
FROM 13.85, 3.00;
TO 22.85, 90.00;
FONT "MS Sans Serif", 8;
NO FLOAT;
NUCLEASE;
NONE;
IN WINDOW main
Main is the name of the parent window as specified in the Screen
Layout d ialog box fo r the parent screen. To o btain the FROM and
TO coordinates, draw a rectangle in the parent window where you
want the Browse window to be and note the dimensions as displayed in the status bar.
3. Include a BROWSE command in the setup code. For example:
BROWSE WINDOW wbrowse in WINDOW wmain NO WAIT SAVE
4. Create a separate screen for the GET (one table) fields.
5 . In the setup code for the GET screen, include the following
command:

#WCLAUSES in WINDOW wmain
6. Generate a screen set that includes both th e parent screen and the
GET screen.

Conclusions and Recommendations
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Summary
FoxPro Mac has a lot going for it: a robust screen builder and report writer,
and an excellent query engine. On the other hand, you must compile screens
before you can test them, and build Pro jects to compile in to Applications
before you can try your efforts. You must also plan on writing code for many
operations, including some simple ones. Still, if you need a relational database application that is fast, well-documented, and has the ability to run
virtually unmodified in Wi ndows and DOS, FoxPro Mac is a good choice.

Conclusions and Recommendations
The two databases looked at here probably couldn't be m o re different. For
people needing a q uick and easy solution that doesn't req uire complex relationships between table, Filemaker Pro is an excellent choice. You can do
application development with Filemaker Pro, but you are limited by the lack
of any kind of a programming language. However, the macro facility is quite
powerful.
FoxPro is a good choice if you need the full power of an applicationdevelopment environmen t. You do pay th e price in complexity (programming is necessary for most tasks) and in compiling screens, reports, and so on
into an application.
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Integrated Software
Pulls It All fogether
by Peter Durso

Integrated software packages are bundles of software that combine word processing and spreadsheet modules with any combination of grap hics, communications, and database modules into a single purchase.
Early integrated software packages were not very integrated. In fact, for quite
some time, integrated software packages more closely resembled the current
crop of Office offerings from Microsoft and WordPerfect in that they were
separate packages. You wanted to put a graphic into a report and then incorporate spreadsheet results? More often than not, you had to get o ut the tape
and scissors and head for the copying machine to get your "integrated"
report.
Integrated software has come a long way, but the integration is more complete in some cases than in others. Not all integrated software is created
eq ual, as you will see.
This chapter examines three integrated packages, and how they compare to
each other regarding ease of integration of their multiple functions:
• ClarisWorks (Ciaris)
• WordPerfect Works (WordPerfect)
• MS-Works (Microsoft)
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Using ClarisWorks
With ClarisWorks you can work with text, graphics, and spreadsheet informatio n in a truly seam less environment.
Claris, an Apple company, is the publisher of the MacDraw II and MacD raw
Pro prod ucts. It is also the publisher of MacPain t and MacWrite. Both the
MacPaint and MacWrite programs were originally standard issue with the
purchase of a Macintosh. The word processing, painting, and drawing tools
that are provided in ClarisWorks will look very familiar to anyone that
has used these packages. The tools genera lly are very powerful and wellintegrated.

System Requirements
Cla risWorks will work on any Macintosh from a Mac Plus on up with system
software version 6.0.5 or later. System 6 requires 1MB of system RAM. If you
are using System 7, you need 2MB of system RAM. System 7.0 or System 7.0.1
requires System 7 Tune-Up, Version 1.1.1. System Tune-Up is available fro m
Apple Computer, Inc.
ClarisWorks only requi res 600K of hard disk space, and you can vary system
RAM requirements depending on your Macintosh configuratio n.
If you are usin g System 6.0.5 or higher with MultiFinder, o r if you are using
System 7, and you have enough RAM, you can increase the allocated memory
for ClarisWorks to as much as 2,048K.
ClarisWorks wi ll benefit fro m this extra allocation if you expect to work with
multiple documents simultaneously, with documents that contain many
graphics objects, in the paint environment, or o n very large com pound
documents.
If you are using System 7 and you have only 2MB of memory, or if you are
using a PowerBook, you m ay reduce your ClarisWorks memory alloca tion to
as low as 768K.

Features and Capabilities
Any system that tries to do everything at once will have some deficiencies.
The most glaring ones here are that you cannot apply paragraph styles in the
word processor, and you cannot include graphics in the database.
Wi th th ese deficiencies noted, ClarisWorks provides power and accessibility
when used in ho me or educational settings. You can easily run a small business with this package.

Using ClarisWorks
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When you first open ClarisWorks, MS-Works, and WordPerfect Works, you
are presented with a screen that lets you open a particular segment (sometimes called a "mod ule") of the program (see fig. 20. 1). ClarisWorks gives you
the choice of either Word Processing, Drawing, Painting, Spreadsheet, Database, or Communicatio ns.
D:52 PM

'•

of•

New Document

® Word Processi ng 0 Spreadsheet
Drawing
0 Database
Pointing
0 Co mmunl collnns

0
0

Stationery !None..,..,

Trash

When you open ClarisWorks in Word Processing, Spreadsheet, Draw, or Paint
modes, you have access to the tools from the other three modules, as shown
in figure 20.2.
Figure 20.3 shows that the Communications and Database mo dules are separate, with their own set of tools, and without access to the tools of the other
modules.

Compound Documents
Compound documents, such as the one shown in figure 20.4, are an Pxample
of an advantage that a fully integrated environment gives you over conventional Publish and Subscribe or Co py and Paste methods. That advantage is
simplicity.

Fig. 20.1
When you open
ClarisWorks, a
screen, similar to
those that open
the other packages
discussed in this
chapter, appears.
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Fig. 20.2
Wh en you open
ClarisWorks in
Word Processing,
Spreadsheet, Draw,
or Paint modes,
you have access to
the tools from the
other three
modules.

-

. ... 1 111

f•-• ,..,

~ ,.,

u

..... .. -

.. ''" ..., ....... ........ . .... . . .
~..

...UI..f

ii UI :6"'"~

. .tll'"l l.llllt z::.r=::;;-

Using ClarisWorks

545

Fig. 20.3
The Communications and Database
modules are
separate, wi th thei r
own set of tools,
and without access
to the tools of the
other modules.
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Fig. 20.4
ClarisWorks makes
compound
docum ents a snap!
All the elements of
this document
were created
within o11e
ClarisWorks
document.
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The document shown in figure 20.4 was created by ClarisWorks and saved in
only one document. When a similar document is created in WordPerfect
Works, it takes a minimum of two documents and the process creates some
"editions" in a special folder reserved for this purpose in the system folder.
This is a result of WordPerfect using Publish and Subscribe for its integration.
In MS-Works, it took two documents and some copy-and-paste actions.

Spreadsheets with Charts
The Spreadsheet and Chart functions of ClarisWorks are smooth . You can
customize the look of th e charts, text, headings, and number fo rmats just like
in a freestanding spreadsheet program (see fig. 20.5).
The chart displaying the success of the fictitio us annual picnic in figure 20.4
is a spreadsheet that was created by selecting the Spreadsheet tool, dragging a
box to create a spreadsheet area, and then entering the data to crunch the
numbers. It was also very easy to manipulate the position of the chart in
relation to the hands of the cartoon figure so th at the chart looks as if it's
being carried by him, and to paint the ragged circle around the final total.

Database Capabilities
f-igure 20.6 displays the kind of results you can ach ieve with the ClarisWorks
Database module.
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Spreadsheets can
be customized ancl
enhanced easily in
ClarisWorks.
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Fig. 20.6
A nice touch that
is unique to a
ClarisWorks
database is its
capability to define
multiple choice
fields.

Unfortunately, because t here are n o picture fields, you ca nnot crea te, say, a
real estate database with t he hom e that is for sale shown with each address
record .
Avery label te mplates are provided, wh ich can be very conven ien t. You can
even use DBF-form at files. The ability to use DBF-format files allows you to
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use an industry standard file format for sharing database files with others. As
long as the database program used by your colleagues supports the DBF-files,
you can use ClarisWorks to create output files that their programs can use, or
you can use ClarisWorks to read fil es that they have created on their system.

Communications
If you need a full-fledged communications program, you should probably
look elsewhere. The biggest shortcoming of ClarisWorks in this area is that
you have to set those pesky items in the line settings each time you dial out.
The ba ud rate, stop bits, and so on should be saved for each entry in the
phone book. They are not.
No ne of the packages discussed in this chapter substitute for a complete communications program. Because on-line services such as America Online and
Prodigy supply their own communications front-end programs, this aspect of
the integrated package will probably be used the least anyway.
You can automate your required responses and cause the program to wait for
specified respon ses from the host system by using ClarisWorks Macros.

Getting the Most from ClarisWorks: Hot Tips
• ClarisWorks has a simple and Super Undo command. It is in the File
menu and is called Revert.
You can experiment with a document. Change the text format, stretch
a graphic, change colors and if you don't like the results, select File
Revert and your document goes back to the last saved version.
• If you've visually aligned two ob jects and they aren't perfectly aligned
when you print your document, don't yell at the laser printer. Open
your document. Turn off Autogrid under Options. Then click on the
larger of the two mountain range pictures next to the number 100 at
the bottom left of the ClarisWorks screen. They are called the zoom
controls. Click until you change that 100 to 1,600 or 3,200. Your drawing is now huge. With some practice, you will find the offending misaligned two edges of your drawing. Select one of the objects and use the
arrow keys to nudge the edges into perfect alignment.
• lf you receive a document from someone that you cannot open successfully in another application, try opening it with ClarisWorks.
ClarisWorks has a significant number of translation modules that can
open or save to and from many non-ClarisWorks formats.

Summary
• In the ClarisWorks Spreadsheet, if you Show Shortcuts, th e palette presents you with an array of different chart types to choose from as soon
as you cre:te your spreadsheet. With one click o n the chart type you
desire, you eliminate the need to go through the menus to define each
aspect of your chart before you even see it.
• When you are using ClarisWorks Shortcuts, palettes can be put out of
the way and still be handy if you collapse them instead of closing them .
This way, you o nly need to click on the collapsed window to regain the
full view of the palette, without poking through the Edit menu.
Here are some items in th e Preferences menu:

• Smart Quotes (Text Preferences) Gives you a chance to have curly quotation marks and apostrophes. They can really dress up invitations, formal product announcements, resumes, just about an ything. This will
get rid of those annoying straight quotes and apostrophes that look
very machine-like and unprofessional.
• Show Invisibles (Text Preferences) Shows you all th e usually invisible special characters in your d ocument. These codes do not print even if you
choose Show Invisibles. Seeing the invisible character codes embedded
in your documents can help you understand why som e of th e formatting habits you bring over from typewriters (such as spacing between
columns instead of using tabs) simply are not reliable in a word processor.
• Date Format (Text Preferences) When you use the Insert Date feature
under the Edit menu, the format is determined from one of the five
fo rmats represented here.
• Mouse Preferences (Graphics Preferences) Here you tell ClarisWorks that
lines you draw will be constrai ned to exact mu ltiples of n degrees,
where n is the number that you type in the Shift Constraint box.
• Show Names (Palettes Preferences) This puts the names from the description field of the Edit Sho rtcuts box on the Shortcuts palette instead of
the buttons.

Summary
The level of integratio n fo r ClarisWorks has always been high . In its current
incarnation (Version 2.1), an individual might never have to go beyond the
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features provided by this package. The most expensive package described
here, ClarisWorks ($299 list) is widely available at steep discoun ts and is
1
bundled with some Mac configuratio ns.

Using WordPerfect Works
WordPerfect Works accomplishes its integration by implementing Publish
and Subscribe. For example this can put a spreadsheet applet into a WP
document, complete with its own set of tools.
This works but it is no t as seamless as it could be. It simply takes too lo ng, fo r
example, to open a spreadsheet embedded in a word processing document
when you have to double-click the spreadsheet and wait for a spreadsheet
applet to activate so that you can work on it.

System Requirements
WordPerfect Works works on any Macintosh from a Mac Plus on up with
system software version 6.0.5 or later. System 6 requires 1MB of system RAM.
2MB of system RAM is required if System 7 is in use. RAM usage can be
brought down to 900K if you are tight on memory.

Features and Capabilities
When you first open WordPerfect Works, you have the choice of either Word
Processing, Drawing, Painting, Spreadsh eet, Database, or Communicatio ns.
Figure 20.7 shows the WordPerfect Works opening screen.
Fig. 20.7
When you first
open WordPerfect
Works, you are
presen ted a screen
similar to those
th at open the
other packages
discussed in t his
chapter.

New WordPerfec t Works Do cument

When you open WordPerfect Works in Word Processing, Spreadsheet, Draw,
or Paint modules, you use Publish and Subscribe to share portions of o ne
document with any of the others. Figure 20.8 shows the opening screens of
the various modules.
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Compound Documents
Using Publish and Subscribe, you ca n achieve the resul ts shown in figure
20.9.
The main advantage of using Publish and Subscribe is that the person that
creates the spread sheet can subscribe to a graphic that is published by a
graphic artist and on a server to which both users have access. Any changes
made to the graphic are available to the spreadsheet according to t he update
schedule specified by each party.
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Fig. 20.8
These are the
opening screens
of the various
Word Perfect
modules. To share
data between
documents, you
must use Publish
and Subscribe.
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Fig. 20.9
A document
similar to the one
in figures 20.4 and
20.14. This
document was
created in
WordPerfect
Works with
Publish and
Subscribe.
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Spreadsheets with Charts
Figure 20.10 shows the same concept when applied to a spreadsheet and its
chart. The chart is created in a Draw document. Agai n, any updates made to
the numbers or changes made to the chart can be made readily available to
those that subscribe across a network.

Fig. 20.10
Publish and
Subscribe at work
again, this time
with a chart of the
spreadsheet.
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Database Capabilities
Figure 20.11 shows what can be accomp lished with the database module. As
with ClarisWorks, there is no provisio n for picture fields fo r th is database.
Fig. 20.11
The database
layout of
WordPerfect
Works is functional.
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Communications
This phone book stores the connection settings along with each telephone
n umber-a real help if you dial onto your favorite service very often. The
interface is quite good, too.
Buttons on the too lbar allow easy access to the common commands, and the
status line shows you th e date and time. WordPerfect Works also shows you
the terminal emulation, file transfer protocol, and dial-up speed.
You can automate procedures that allow you to log onto remote systems,
complete with specified wait times before sending text strings, expected
responses from the host, and your password.

Getting the Most from WordPerfect Works: Hot Tips
• When you type a date into a spreadsheet cell, WordPerfect Works recognizes it as a date, converts it into a serial nu mber, and fo rmats it as a
date.
•

If you type @ into a WordPerfect Works database field or spreadsheet

field, you will get the current date. If you type# in to a database or
spreadsheet time field you will get the current time.
• Be very awa re of the extra Editions files that you produce as you use
Publish and Subscribe to integrate documents. In producing the examples for th is chapter and experimenting along the way I m anaged to
put nine documents in a folder called WPWorks-Editio ns, in my system
folder. If you personally produce many d ocumen ts you wi ll also be
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experimenting, failing, and stopping in midstream for any of a dozen
good reasons. This will propagate duplicate and stillborn Editions. Now
m ultiply this potential fo r accumulating extra Editions files times the
dozens o r hundreds of people that can group author docum ents over a
network.

Summary
The telecommunications package of WordPerfect Works is the most fullfeatured of the three products investiga ted in this ch apter. This package is
also the o nly one discussed that allows you to apply useful paragraph styles
as do full-blown word processors.

Using Microsoft Works
Microsoft Works is a loosely integrated collection of functional software programs. To share information between the word processor and the spreadsheet
module, for example, you have to use cut and paste to do it.

System Requirements
Microsoft Works will work on any Macintosh from a Mac Plus on up with
system software version 6.0.5 or later. System 6 requires 1MB of system RAM.
2MB of system RAM is required if System 7 is in use.

Features and Capabilities
When you first open Microsoft Works as seen in figure 20.12, you are presented a screen similar to those that open the other packages discussed in
th is chapter.
Fig. 20.12
When you first
open WordPerfect
Works, you have
the choice of
either Word
Processi ng,
Drawing, Spreadsheet, Database, or
Communications.
There is no Paint
module in
Microsoft Works.
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When you open Microsoft Works in Word processing, Spreadsheet, or Draw
modes you use copy and paste to share portions of one document with any of
the others. Charts appear in their associated spreadsheet documents, rather
than in a separate draw document, as in WordPerfect Works. Figure 20.13
shows the o pening screens of the va rious mod ules.

IV

Fig. 20.13
These are the
opening screens
of the various
WordPerfect
modules. To share
data between
documents, you
must use Publish
and Subscribe.
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fol lowing are some of the features added to Microsoft Works 3.0:
• Headers and Footers with automatic date, ti me, and page n umbers
• Business, education, personal, and communications stationery documents to help you get started
• An improved mail merge feature to make it easier to create form letters
• Charts that appear with their spreadsheets and can be manipula ted
there

Compound Documents
Using cut and paste, you can achieve the results shown in fi gure 20. 14.
Fig. 20. 14
M icrosoft Works
will let you
produce this
document, sim ilar
to Figures 20.4 and
20.9.
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Spreadsheets with Charts
Fig 20.15 shows the resu lts of creating a chart from within the spreadsheet
program. You can easily add graphic elements and comments. In this example, it's the arrow with the What Happened Here ? ! printed above it.

Database Capabilities
Figure 20.16 shows what can be accomplished with the da tabase module. As
with ClarisWorks and WordPerfect Works, there is no provision for picture
fields fo r th is database.
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Fig. 20.15
You can add
em phasis to your
graphs made from
Spreadsheets, as in
the "What

Happened
Here?! " shown
here.
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Communications
This module is user-friendly and easy to use. The tools to designate a capture
to folder and to open a connection are righ t on the tool palette, but there is
no phone book feature.

Fig. 20.16
Microsoft Works
lets you dress up a
database file with
cut and paste.
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As with the other communication packages described in this chapter, you can
automate your logon sequences.

Getting the Most from Microsoft Works: Hot Tips
• Use Print One from the File menu to quickl y print the current document with the current printer settings.
• You can change the color of the text in one cell without affecting the
rest of the spreadsheet. Highlight the cell you wan t to change, select
Format character from the Format menu, then choose the color you
want under Style, and click OK.
• Use the Microsoft Works status bar at the bottom of the communications window to track the time and cost of a communications session.
You get a detailed picture of your current connection and previous
connection costs in the Show Info dialog box of the Connection menu.
• Each Database Document in Microsoft Works can have up to 16 reports.
• When you choose the Show Stationery box from New Spreadsheet, only
Microsoft Works 3.0 stationery will be previewed . Other stationery
documents, such as those created under the Finder with Macintosh
System 7 or from earlier versions of Microsoft Works, will not be previewed.
• Instead of using a filter to display part of a database, use the Match
Records command from the Data menu to have Microsoft Works display a part of the database that you specify.
•

If you have a color monitor and you want to see how a Microsoft Works

Chart will look when printed in black and white, change the color setting to Black and White in the Monitors dialog box from the
Macintosh's Contro l Panel. Microsoft Works will display the chart with
the various patterns that will be printed out on a black-and-white
printer.
• When you are setting print margins fo r a document, you don't have to
type "in" fo r inches or "em" for centimeters because Microsoft Works
handles such de tails. However, if you do type "em" and the unit of
measure is inches, Works will do the conversion.
• You may wa nt to print a database report directly from the Finder; that
is, print the document by selecting its icon and then select print from
the Finder's File menu without starting Microsoft Works first.

Conclusions and Recommendations
In this case, make sure that report view is displayed when you save the
Database document fo r the last time before printing.
• To check spelling in only a part of a Microsoft Works document, highlight the part of the document that you wa nt to check (even a single
word). When Microsoft Wo rks finishes checking the selection, you can
choose to continue to check the entire document by clicking the Continue Check button.

Summary
The method of integration provided by Microsoft Works is barely more than
the minimum kind of integration provided by the operating system. However, it is less con fusing than the proliferation of editions caused by the Publish and Subscribe fun ctions in WordPerfect Works.

Conclusions and Recommendations
The separate packages that are sold today in "Office" suites are more completely integrated than the earliest integrated packages ever were. This is
largely due to the standard data handli ng methodology imposed by Windows
and the Macintosh interfaces, both of wh ich have raised user expectations in
this regard.
ClarisWorks is the most advanced package discussed in this chapter regarding
seamless in terplay between modules.
WordPerfect has some level of interplay because it integrates System 7 Publish and Subscribe. WordPerfect Works was originally published by Beagle
Works, a company that is no longer with us. Beagle Works had been around
since the days of the Apple lie computer. (Word Perfect Works still saves its
documents with the document type of Beagle Works.)
MS-Works is the least in tegrated of this trio, not even supporting Publish and
Subscribe. It also has the weakest word processing module.
Separate full-fledged word processing, spreadsheet, flat file management,
draw, paint, and communica tions software could easily cost $1,000 o r more,
so you need to balance in tegration aga inst your other needs.
Admittedly, all of these packages offer a big bang for your software buck. The
main selling point for the integrated package these days is that it gives you a
lot of functionality for a very reasonable price (read cheap).
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Desktop Publishing
by Gene Steinberg

The word processing software discussed in Chapter 17 has taken on many of
the features of desktop publishing software. They offer page layout, basic
drawing tools, the ability to flow text around an irregular shape and th e capability of importing text and pictures in a variety of file formats. One of the
programs described, MacWrite Pro, even has settings for automatic kerning
and hyphenation and justification, quite similar to the programs that we're
going to describe in this chapter. Microsoft has also added support for
kerning pairs in their latest version of Word.
In addition to basic publishing capabilities, high-end word processing software can handle such chores as mail merge and outli ning with aplomb. There
are macro capabilities, highly sophisti cated search and replace capabili ties,
and elaborate table creation tools that have few equals in the publishi ng
software arena.
For many basic desktop publishing chores, you might just find that o ne of
these programs will be more than up to the task. But when it comes to handling sophisticated page layouts, color separations and trapping, and support
of sophisticated typographic features, you'll want to consider the programs
we're going to describe in this chapter.
In this chapter, you learn the following:
• The real differences between word processing and publishing software.
• The m ajor features of the four major desktop publishing programs.
• Excl usive, hands-o n ti.ps and tricks that you won't find in your desktop
publishing software manuals.
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What Is Out There?
Before 1985, typesetting required expensive computers and hardware and was
the province of a printer o r specialty pre-press establishment. You could pay
anywhere fro m ten thousand to well over a million dollars for these tools of
the trade . .Typographers required special skills far beyond those associated
with normal typing.
Desktop publishing had its beginnings in 1985, with two very important
developments. One was the introduction of th e origina l Apple LaserW riter,
a printer that used the PostScript page descriptio n language to provide sharp
reproduction of printed pages. The o ther event was the arrival of programs
like Aldus PageMaker and Ready,Set,Go, both of which are profiled later in
this chapter. Together they created a revolution in publishing that has affected every nook and cranny of the industry.
Mac publishing software is a highly competitive market, with programs competing on the basis of features and the best perfo rm ance. The software we're
about to describe here have suggested retail prices from $395 up to $995, but
all offer a mixture of high-end publishing featu res such as color separations
and sophisticated kern ing and hyphenation and justification settings. We'll
be discussing not o nly Aldus PageMaker, but its arch rival in publish ing software, QuarkX Press. We'll also be profiling another pio neer in the publishing
software sweepstakes, Ready,Set,Go, and a very specialized product,
FrameMaker, which was origi nally created to produce technical documentation on workstations.

Using Aldus PageMaker 5.0
Aldus Corporation li tera ll y began in Paul Brainerd's garage workshop in 1984,
and the n ew company's first software product, PageMaker 1.0 for Macintosh,
shipped in july 1985. Over the years, the program grew in size and flexibility,
and the latest version is a sophisticated publishing tool used by design studios and magazi nes ali ke. PageMaker uses the metaphor of a mechanical
board, very m uch reminiscent of the way mechanical artists used to assemble
pages in the days of traditional typesett ing. You use your mouse and keyboard to move elements around a virtual pasteboard that appears on your
Mac's screen.

System Requirements
Aldus PageMaker 5.0 shares code with its Windows counterpart, and the addition of new features has taken its toll. Installed, the program can take up to
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15MB o n your hard drive. It req uires a Macintosh II or better, running System 6.0.7 or later, with 5MB to 8MB RAM, minimum. Large documents, filled
with graphics, require even more RAM to run efficiently. Expect to need
another 24MB of RAM and additio nal couple of megabytes of disk storage to
install t he native Power Macintosh version.
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Using Page Setup
To begin c,pnstructing your PageMa ker publication, you select New from th e
File menu, or press :l:C-N, which displays the Page setup window shown in figure 21.1.
Page se tup
Page:
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Start page ":
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There are defau lt settings for common page sizes, such as Letter or Legal, but
you can enter a custom page dimension in the box, in inches, picas, or whatever measu rement system you've established in the program's preferences
settings (available from the Preferences command in the File menu). If you're
using automatic page numbering, you ca n select the starting page number,
and the number of pages in your d ocument. You' ll wan t to specify your page
margins now, but these ca n be changed later on, should you decide to modify
your document formatting.

A Tour of PageMaker's Pasteboard
Once you've opened up your default document, you'll see a virtual page on
your Mac's screen that, if viewed at 100%, matches in dimension the size
you've specified , as shown in figure 21.2. If you don't have a large monitor,
the page will be scaled to fit the size of your screen, plus the borders of your
pasteboard. If you select Facing Pages in your Page setup box, all pages beyond page 1 will appear on your screen as a two-page spread. (The St yles palette and Control palette that are shown are not displayed unless you select
them from the Windows menu.)

Fig. 21.1

basic setup of
your document is
established in

The

PageMaker's Page

setup box.
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Fig. 21.2
A blank page, like
a blackboa rd,
ready for you to
create your
publication.

The pasteboard, to the right and left of your document pages, can be used as
a holding area, just as mechanical artists used to do in the days of traditional
typesetting. You can place text and picture elements there, and move them
on to your page as you continue to modify the layou t of your publication.
Basic formatting can be do ne th rough men us, dia log boxes, and keyboard
sho rtcuts, but you can do it more qu ickly with PageMaker's selection of floa ting palettes, which we'll discuss next.

Using PageMaker's Toolbox
The basic fu nctions of creating your PageMaker publication are controlled
with the toolbox. The features are similar to other Mac programs, and at least
some of the tools are probably familiar to you. But let's examine the toolbox
palette, listed in table 21.1, from left to right.

Table 21.1

PageMaker's Toolbox

Tool

Use

L1

The Pointer Tool. You can use this tool to select picture and
text objects, and to resize or move them.
The Line Tool. You can use this tool to draw a straight line.
Holding down Shift while the line is being drawn will
constrain the line to an exact 45 degree angle.
The Constrained Line Tool. You can use this tool to create
lines at exact angles. It doesn't do any more than the
regular Line Tool, but you don't have to bother holding
Shift as your line is drawn.
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The Text Tool. You can use this tool to create text.

The Rotating Tool. You can use this tool to rotate text and
pictures. The process is a bit imprecise, though, and you
will fare better if you use the Control Palette instead. We'll
get to that shortly.
The Rectangle Tool. You can use this tool to create a
rectangular box. Once it's selected, you click the page
and drag to the dimensions of your box. If you hold Shift,
you get a square.
The Ellipse Tool. You can use this tool to create an ellipse.
You select the tool, click the page, and drag. The Shift key
will constrain the ellipse to a circle.
The Cropping Tool. You can use this tool to crop your
graphic, so only a part of it appears in your publication .

Using Pag e Maker's Style Sheets
To speed formatting of your document, you'll want to take advantage of
PageMaker's flexible style sheets. Styles can be selected from a floating palette, shown in figure 21.4, which is displayed (or hidden) by selecting Style
Palette from the Wi ndow menu o r by pressing ~ - Y (see fig. 21.3). A selectio n
of standard styles are provided with the program, which you can alter or add
to as you prefer.
:Gill Slijles
0
Dody leHl
Caption
llonglng In den
lleadllne
Subhead I
Subhead 2

Fig. 21 .3
PageMaker's Styles
pal ette.

~l!i

To mod ify a style, simply hold ~ and click the style na me listed in the palette. This action will bring up the window in which you can edit the selected
style. To create a new style, press ~-3. You can define a new style or edit an
existing style in a window li ke the one shown in figure 21.4.

566

Chapter 21-Desktop Publishing

Fig. 21 .4
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You can modify all paragraph formatting attributes of an existing style, or
create new ones, through a simple procession of dialog boxes. To edit a style
sheet, click the style's name, then the Edit button. Oth erwise, click the New
button which lets you create a style based on an existing one, o r to fo rmat a
new one from scratch. Once a style is changed, all paragraphs in your publicatio n that carry that style tag will be changed, too. Local fo rmatting,
though, such as words set in italic or bold for emphasis, will be left untouched.

Using PageMaker' s Control Palette
The programmers at Aldus and Quark are in hot competition with their software o n a feature-for-feature basis. When QuarkXPress introd uced a floating
measurement palette to control basic text and picture fo rmatting,
PageMaker's programmers tried to do them one better with their own Control
Palette, shown in figu re 21.5. At first glance, it looks sim ilar to Quark's, but if
you look closer, you' ll find some new wrinkles, especially when it comes to
paragraph formatting.
Fig. 21.5
PageMaker's
Control Palette in
its text formatting
guise.

Through a selection of icons and pop-up menus, you can control most of
your basic text formatting. The white boxes o n the palette represent fo rmats
you can change simply by clicking in the box and typing the name of your
new typeface, size, leading o r character scaling. Clicking on the down arrow
to the right of the white boxes will produce a pop-up m enu of options, such
as the font selectio ns shown in figure 21.6.
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Fig. 21.6
You can select
fonts from a
convenient po pup menu on
PageMaker's
Control Palette.
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Beneath your type selections are a set of icons for type styles, such as bold,
italic, underline and so forth. To the right of these styles, you can select line
spacing, type size and ho rizontal scaling, tracking and kerning, and whether
the type will fall above or below the baseline. We've saved the little paragraph label, at the bottom left, for last. Click it, and PageMaker's Control
Palette dons a new identity, as shown in figure 21.7.
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Style sheet list box
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The Paragraph view of the Control palette enables you to change the paragraph attributes of your text. At the ri ght of the paragraph style sheet list box
is a series of boxes showing paragraph spacing and indents. Below the list of
style sheets are icons to set text flush left, flush right, centered, and justified.
If you click the paragraph icon, now highlighted (or the character view icon,
which is dimmed), the standard Control Palette will return.

Fig. 21.7
Another way to
select style s heets
in PageMaker.

The Control Palette lives one more life, and the metamorphosis is accomplished simply by selecting a graphic or text object. This action brings up a
display that allows you to move and scale your graphic or text object (see
fig. 21.8). The Apply button in the palette changes appearance depending
on the object selected.

Fig. 21.8
The Cont rol Palette
is also used to
ad just the pictures
in your PageMaker
publication.
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Setting Columns in PageMaker
If your document has a single column, you're ready now to add text and
pictures to your document. But if you want to create a publication with two
or more columns, there's one additional step to take and that is to choose
Column guides from the Layout menu, which opens the window shown in
figure 21.9. Enter the number of columns you want to create in this window,
along with the space between columns.
Fig. 21.9

Column guides

Dividing your text
into multiple
columns.

Number of columns:

IL:J

Spec a bot ween column1:

~ pleas

You can establish a separate format for your left and right hand pages, for a
more decorative layout. Once you bring text into your document, it will fall
within the guides you've just created.

•

Using Master Pages in PageMaker
If you have recurring elements from page to page, such as headers, footers or
page numbers, or a special logo, you'll want to place them on a master page,
so they'll automatically appear in all the pages you create for your publication. Setting up a master page involves selecting the icons labeled L-R at the
lower left of your PageMaker document window.
The master pages look identical to a regular blank page on your screen. Whatever items you place there will show up on the corresponding right or left
hand page. You can also create automatic page numbers, by clicking on the
location of the page where the numbers are to appear, and typing ~ -Option
P. The code LM or RM will appear on the Master Page at the point where the
page numbers will be displayed.When you return to your regular document
page, you'll see the correct page numbers. Your document will begin with
whatever page number you entered in the Page setup box which was discussed earlier, but you can change that setting at any time.
Note
Master page items that appear on your regular document pages cannot be edited,
but you can cover individual items up with a box containing a white fill to prevent
them from being printed. If you want to prevent all master items from printing, make
sure Display Master Items in the Layout menu is unchecked.
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Creating Text
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Most PageMaker users create text in a word processing program and import
the text into PageMaker. It's no t that you cannot enter text directly o n your
layout page, but if your typing speed ever exceeds 30 words a minute, you'll
find th at direct text entry isn't this program's fo rte. Yo u are better off using
your word processor. PageMaker will even import style tags fro m Microsoft
Word (descri bed in Chapter 17), which is useful if that's your word processor
of choice.
Another option is to use PageMaker's own built-in wo rd processing tool, the
Story Editor, which is shown in figure 21.10. The Sto ry Editor will display
your text in a generic typeface, but you get full spell checking and search
capabilities. And text entry is quite speedy; it'll keep up with the fastest typist. The text you create here will appear at your insertio n point in your
PageMaker publication .
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PageMaker's Advanced Features
Creating simple documents is easy in PageMaker, and its mo re sophisticated
features are readily accessible. We' ll describe som e of them here:
• Table of Contents. When you establish your style sheets, you can also
indicate whether the style is to be included in the Table of Contents.
When you generate your table of contents after your document has
been completed, you'll be able to have it automatically incorporate the

Fig. 21 .10
Use PageMaker's
Story Editor to
enter text in your
document.
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correct material. The contents can reflect your current document, or
you can generate a table of contents for an entire book, consisting of a
number of documents.
• Tndex. You can select portions of your text and have them included in

an index. Once the index is complete, it can be generated for a single
document o r a series of documents that would comprise a book.
• Color Separations. You can generate both process and spot color separa-

tions in PageMaker. You can select colors from li braries such as
Dainippon, Focoltone, Pan to ne, Toyo, and TrueMatch.
• Aldus Additions. Out of the box, PageMaker comes with over 20 Addi-

tions, which are advanced scripting routines that provide additional
capabilities to the program, such as creating drop caps, or reordering
the pages in printer's spreads form, to ease your printer's page assembly
burden . New additions are available as an option, including o ne that
will add automatic trapping capability to the program.

Getting The Most Out Of Aldus PageMaker:
Hints and Tips
• Combine multiple stories into a single story. If you have multiple stories (separate text blocks) that you'd like to combine into a single
threaded story, move all the text blocks to a common area (a single
page or the pasteboard), select them all with the Pointer tool, cut (or
copy), then select the Text tool, create an insertion point and paste. The
copied text blocks will be pasted in a single sto ry, in order from bottom
to top.
• Use templates to specify default settings. Create a blank PageMaker
publication, save as a Template, and check "Save preview." When you
want to create a new file, simply open this template. If you use
QuicKeys or another macro utility, you can even redefine "New" to
actually open this template, and even open page setup as if it were a
new publication.
• Templates are a grea t way in general to save even simple settings, not
just for a full blown document template.
• PageMaker doesn 't give an option to not un derline spaces, but it's easy
enough to use the Story Editor's "Find and Change" to rem ove underlines from any space. Sim ply type a space and in the "Find" field,
choose Underline from the attributes optio ns, and type a space band in
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"Change" with no underli ne option (or the text set to Normal). You can
even create a special style if you have some instances where you may
want some spaces underlined but others not-just use the appropriate
style where desired and include the style in the search criteria (but
don 't change the style when you find and change.)
• Occasio nally a user will need to freeze page numbers, or have a publication with two sets of page numbers o n each page (for techn ical documents, or periodicals that reference both the current issue and the
yearly volume). This can be done relatively easily using the " Build
booklet" Additio n. This add ition has an option to "Preserve page numbering." Simply run this additio n with one set of page numbers set o n
the master page (for example, you set the starting page number to
"1000"), choose a layout of "None." When the addition is finished, it
will have copied the master page number markers to the local pages,
and froze n the existing page numbers. Then change the numbering
sequence in Page setup to the second set of numbers (such as "1"), and
add a new page number marker on the master pages.
• A quick and easy way to export just a few elements on a page without
using the entire page as a bou nding box is to use the "PSGrouplt" Addition. This Additio n works by exporting the selected elements as an EPS,
then placing it back in, thus creating a group. The EPS file that th is
Addition creates can be placed into any other application that imports
EPS files, and has a bounding box limited to the selected elements. The
EPS file should be saved in the directory that the o riginal publication
is in.
• Aldus FreeHand users are used to deselecting elements by pressing Tab
rather than clicking on an empty area of the page. You can accomplish
a simila r action in PageMaker by using the pointer tool toggle (~ -s pace
bar). This command allows you to switch back and forth between the
tool you've selected and the Poin ter tool.

Using FrameMaker 4
Frame Technologies FrameMaker had its origins in 1986 as a technical document creatio n program fo r Sun wo rkstations running Un ix. It migrated to
personal com puters in 1989, when the first 68030 Macintosh models afforded
eno ugh power to hand le FrameMaker's sophisticated publishing features.
That same yea r the program also became the o ne and only desktop publishing program to support the NeXt computer.
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The latest versions of FrameMaker feature four-color separations, and free
rotation of text and graphic objects. They also incorporate sophisticated
cross-referencing tools, flexible table formatting, and the ability to create side
heads, to the left or right of your text margins. A QuickAccess bar offers easy
access to many of its sophisticated features. If you're used to a highend word
processing program, such as Microsoft Word or WordPerfect, getting up to
speed with FrameMaker is not a difficult task, but the more sophisticated
features are apt to take a wh ile to master.

System Requirements
Like its UNIX and Windows counterparts, FrameMaker exacts a high toll in
hard drive and RAM space. It requires a 68020 Mac or faster, with 58MB of
installed RAM, running System 6.0.7 o r later, but System 7 is recommended.
Expect to fill roughly 15MB of hard disk space fully loaded. The Power
Macintosh version of FrameMaker requires 16MB of RAM, and at least 18MB
of hard disk space.

Creating a New Document
FrameMaker comes with a selection of templates that you can use in building
your own document. They cover the basic categories of document creation,
from a simple business card to a long technical publication. When you type
the standard keystroke for creating a new docum ent, ~ - N, you have four
choices, shown at the bottom of the window in figu re 21. 11.
Fig. 21.11
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When you click the Explore Standard Tem plates butto n, you' ll bring up a
graphical display of the templates that are supplied with the progra m. Just
click the name of the template to learn mo re abo ut it. The Show Sample option, shown at the botto m of the window in figure 21.1 2, will actually open a
documen t window showing the template fu ll size on your screen. If you wan t
to examine a hard copy before m odi fying your template, you can print it th e
same as an y o th er document.

Fig. 21 . 12
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The Create button, at the bottom of the window shown in figure 21.12
above, will open a new documen t window containing the very same forma tting attributes of your template. You can then create your text and il lustrations, and they'll m atch the characteristics of the o riginal. O r you can modify
the template o r create a new one.

Using FrameMaker' s QuickAccess Bar
Your new document page in FrameMaker fo llows after the ones you create in
your favorite word processor, at least visually. We' ll explo re the tremendous
power of this program in a moment, and you'll begin to see some of the differences. But fo r writing a simple documen t, a letter o r a memo, you can use
the QuickAccess Bar, shown in figure 21.13, to handle basic character and
page fo rmatting.
Like most features in FrameMaker, you will find immense power beneath the
surface when you begin to explore. An example is that QuickAccess bar. At
the very least, clicking on an icon activates the pictured function, such as a
text attri bute, or saving and printing a document.

Fra meMaker a llows
you to preview a
template before
you decide
whether to use
it or not.
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Plain

Italic

Previous page of Quick Access

Increase Size 1 pt.

Undo

Lowercase

Copy

Flip Quick
Access bar

Footnote

Fig. 21.13
FrameMaker's
Qu ickAccess bar
looks on the
surface much like
what you'd find in
a p rogram like
Microsoft Word.

Insert table

Paste
Next page of Quick Access Ba r

Decrease Size 1 pt.

- ,..,,,.,.,,, ,e

But if you click one of those small up and down arrows at the center of the
QuickAccess bar, it undergoes a decided metamorphosis. There are four separate bars, each providing fu nctio ns fo r a specific FrameMaker feature. The one
we've shown so fa r hand les your word processing chores. If you click the
down arrow o nce, as shown in figure 21.14, you'll see a num ber of icons that
reflect the creatio n of graphics, such as you're likely to find in an illustration
program.

Group

Bring to Front

Previous page of Quick Access bar

Distribute

Undo

Smooth

Copy

Flip up/ down

Print
Flip Quick
Access bar

Fig. 21.14
The Q uickAccess
bar in one of its
four identities.

Gravity

Paste
Next page of Quick Access Bar

Send to back
Ungroup
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The third posi tion, when you click the down arrow, d isplays another set of
graphics too ls, which you use to ed it your graphics. The fi na l Quid•Access ba r
for mat provides tools for table creation . FrameMaker's h ighly soph isticated
table editor is discussed shortly.

IV

Using FrameMaker' s Paragraph Designer
r:rameMaker excels at creating long, complex documents. In t his way, it's a
modern-day equivalent of the very expensive book typesetting computers of
years ago. After you've decided the size page you wish to use, whether it's
portrait or landscape, and the page d imensions, you' ll want to create paragraph and character styles to speed documen t creatio n. Every fo rmatting
elemen t of you r docu ment ca n be established in advance, saved as a templa te, and even exported to other documents to ensure a consistent look and
feel to your publicatio ns.
FrameMaker's unique Paragrap h Designer is shown in figure 21.1 5. You ca n
access t he Pa ragraph Designer by choosing Paragraphs fro m the f o rmat menu
and Designer fro m the sub-menu . Since FrameMaker excels in its repos itory
o f keyboard shortcuts, you ca n get there just by typing ):e-M.
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The Paragraph Designer lets you ad just six basic properties of your paragraph
text, simply by selecting the item on the p ull-down menu. These include:
•

Basic. This window is used to establish paragraph spacing, inden ts, and

line spacing.
• Defnult {o11t. This window sets your character attributes, such as size,
style, color and w hether to turn on au to matic ke rn ing. The Character
Designer, covered in t he following sectio n, can be used to change t he
style fo r individ ual characters.

Fig. 2 1.15
just the fi rst part
of FrameMaker's
Paragraph
Designer wi ndow.
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FrameMaker's regular font menu shows only the name of the font family, not
the individual styles. This is unlike most other Mac programs and is sometimes
confusing till you get used to it. Individual styles in a font family are selected
by choosing Style from the Format menu, or as part of the Default font properties in the Paragraph Designer.

•

Pngitwtioll. This window establishes whether a paragraph will have a

no rmal style, w hether it should begin where it falls or at a specific locatio n on the page, and whether the paragraph wi ll be used as a running
head or a side- head. The side head is FrameMaker's unique contribution
to desktop publishing. It allows a headline of text to extend beyond the
left o r right margin of a column of text. Figu re 21. 16 shows a side head.
Fig. 21.16
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Numbering. This window allows you to set an automatic numbering

format fo r paragrap hs. If a paragra ph is moved out of sequence, the
numbers will be changed to reflect th e new location.
•

Advanced. This is your tool for setting special typographic formatting.
There are adjustments for hyphenatio n and word spacing, and an adjustment fo r rules above o r below the paragraph .

•

Table cell. When used togeth er with fram eMaker's sophisticated table

editor, you can format each cell separately. You can set th e amount of
space between the border of the cell and the text and whether it will be
top, center, or bottom aligned within the cell.
The Paragraph Designer can be used to change the format of a single selected
area of text, or all text having the same style name. Once you've created your
paragraph fo rmats, you can export them to other documents.
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Your completed paragraph styles are saved in what is called a Catalog, and
you can click the paragraph icon at the top right of your application window
to bring up a floating palette of styles, as shown in figure 21. 17. To change
the style of a selected paragraph, just click the style's name in the catalog
palette.
• Catalo

Fig. 21.17
frameMaker's
Paragraph Catalog
Palette.
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Using FrameMaker' s Character Designer
When you apply a new style to a paragraph, normally all the text in that
paragraph will take on the characteristics of the format. But you can also
create a separate set of styles for individual characters, so you can easil y select
italic or bold for emphasis, once you've created the right format.
The Character Designer, shown in figure 21. 18, consists of a single window
that you use to make your basic paragraph settings. Once you've set your
character settings, you can apply them from a palette that's accessed by clicking the icon at th e upper right of your document window.
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Using FrameMaker' s Spelling Checker and Thesaurus
Once your text has been written, you'll find the program has a capable spelling checker and thesaurus to check your text. If you're just looking for the
correct word to apply to a particular situation, you highlight the word you
want to change, and bring up the Thesaurus from the Edit menu, or press
~ -Shift-T, as was done in figure 21.19.

Fig. 21.18
frameMaker's
Character Designer
changes the fo rmat
of individual
characters without
affecting paragraph formatting.
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Fig. 21.19
Finding the
right word in
FrameMaker.
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The next step is to spell check your document, by selecting Spelling Checker
in the File menu or just typing :1:(-L. While spell checking is in progress, as
shown in figure 21.20, you'll have the option to correct misspellings, ignore
flagged words, or add new words to the program's custom dictionary.
Fig. 21.20
FrameMaker tries
to catch your
spelli ng erro rs.
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Using Illustrations in FrameMaker
When you want to add an illustration to your FrameMaker document, you
can import or place a picture from your favorite illustration software, or create one from scratch .
Before I try my own hand at drawing a picture, I' ll import one from one of
my favorite illustration programs. First select Import File from the File menu,
and choose File from the sub-menu. You have two options when you place a
picture in your FrameMaker document, as shown in figure 21.21.
Normally you'd import by reference, as you do in other publishing software.
The document carries a low-resolution PICT representation of your picture,
and a link is established to the original graphic. When you print your document, the information contained in that graphic is downloaded to your
printer, too.
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The second option, Copy into Document, actually incorporates your graphic
file into your FrameMaker document. This has the advantage of freeing you
from worrying about the original graphic, and you don't have to bring that
file with you if you take your file to a service bureau for high resolution output. But you still have to keep the original on hand to reimport in case you
want to change it. And the side-effect is to m ake you r FrameMaker file much,
much larger.
Most popular graphic formats, such as EPS, PICT and TIFF, are supported by
FrameMaker. You'll see a small preview of your picture before it's imported.
Just select the file you want to bring in and click the Import button. If the
picture is a PICT or TIFF file, you'll bring up a Scaling window, as shown in
figure 21.22, which allows you to scale the picture before it finally shows up
in your document.
-
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Fig. 21.22
FrameMaker's
Graphic Scaling
wi ndow.
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FrameMaker is not intended to replace such sophisticated PostScript drawing
tools as Adobe Jllustrator or Aldus FreeHand, which is discussed in Chapter
23, "Drawing and Painting." But fo r simple drawings, FrameMaker is suffi.
cient. To create an illustratio n in your document, choose Tools from the
Graphics menu or press )::C-3, or select the triangle icon from the upper right
of your document window. Either way, you'll bring up a familiar set of drawing tools, as shown in figure 21.23.
Fig. 21.23
FrameMaker's set
of drawing tools.

After you design the basic shape of your drawing, you can use the pen and fill
patterns offered by the program to enhance your drawing. You can choose
fro m a selection of black and white or color patterns.

Using FrameMaker's Table Tools
Just about any table you can imagine can be created quickly with
FrameMaker's table creation tools. It's an area in which this program excels
over all o ther publishing software, and most word processing programs as
well. You can control every element of your table, from the basic shape, to
the formatting of text and graphics and the positioning of that text inside the
table.
Tables can also be copied from one place to another inside a document o r
fro m o ne document to another. For now, we'll just create a simple table and
give you an idea of how easily it's done. To begin, choose Insert Table from
the Table menu, which opens the window shown in figure 21.24.
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quick work in
FrameMaker.
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Your table consists o f columns and rows, and a single colum n of a single row
in th e table is considered a cell . Once you've specified h ow many colum ns
a nd rows your table wi ll have, you click the Insert button, which will place
the n ew tab le at you r c ursor's insertion point in your docum ent, as sh own in
figu re 21.25.

:....................:.:: :.:::::· . ~bl~: f D::::.:: .·::..::: .... :::::::··.:·:

Fig. 21.25

Building the
outlines of your
new table.

Before you begin to e nte r your text, you can resize and modify your table to
your hea rt's content, till it meets your expectatio ns. When you click the
table, you can drag the selection handles at the right o r left of th e table to
increase its width. You can use both the Paragraph a nd Character Designer
windows, described a bove, to modify formatting. Tex t and graphics ca n be
separately aligned in each cell. Your topmost row, fo r example, ca n have
centered headlines, and your body copy in the rows below ca n be set flush
left o r rotated. We've c reated a sa mple table, shown in figure 21.26, to give
you a ge ne ral idea of how it sh apes up.
There is o ne more FrameMaker Designer to discuss-th e Table Desig ner. You
will find it in the Table Menu, and it allows you to customize your tables still
furthe r. The first pull-down menu, showing Basic cell properties, as shown in
figure 21.27, allows you to set cell spacing, margins, a nd th e position ing of
th e table.
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Fig. 21.26
Each cell in a table
can receive its own
special formatting.

Fig. 21.27
Using FrameMaker's
handy Table
Designer to customize spacing and
table positioning.
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To give your table a fancy look, you'll wan t to choose the third selection in

the Properties pull-down menu in the Table Designer. It controls shading.
You can add a fill to the headlines, for example, and leave the body copy
alone, as shown in figure 21.28, or apply a fill to the entire table.
Fig. 21 .28
Shading headlines
to give your table
a bit of sparkle.
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As with the Paragraph and Character Designer, you can apply your changes

to a single table or all tables in your document that have the same format
name.
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FrameMaker's Advanced Features

IV

Just describing FrameMaker's features can take a book in itself. The steps
we've described are relatively easy to master, and they allow you to create a
wide variety of documents, from a basic form letter to a school textbook or
technical manual. Here are som e of FrameMaker's power user features that,
despite their sophistication, are not all that difficult to learn once you've
mastered the basics.
• You can automatically generate an index and/or table of conten ts, by
applying styles or tags to portions of text. Once your document is completed, you can use FrameMaker's Generate/Book feature, found in the
File m enu, to build the index and table of contents from a single document or a group of documents.
• FrameMaker's Equation palette allows you to easily build all manner of
equations. The program will check your equation syntax as you type
your equation, and display a question m ark wh ere an additio nal figure
or argument needs to be inserted. Each symbol of your equatio n can be
selected from the palette, shown in figure 21.29. Just click the kind of
element you want, and it will appea r at the insertion point in your
document.

• FrameMaker uses hypertext cross-references that allow you to click a
portio n of your document, and immediately be taken to another part of
the document that contains related material. Fo rmatting the crossreferences are done with styles or tags, same as a table of contents or
index.
• FrameMaker provides docu ment comparison tools that allow d ifferent
versions of a single document to be examined for updates. This feature
is useful when creating a publication in a workgroup environment,
where separate copies of the same document may be revised on different computers, even in an office that uses Macs, Windows computers,
and Unix workstations.

Fig. 21.29
A choice palette
of ready-to-use
symbols to help
you easily create
the most complex
equations for your
document.
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Getting the Most Out of
FrameMaker: Hot Tips
• Use FrameMaker's powerful search feature to locate text in every elemen t of your docum en t, incl ud ing style tags and headers and footers.
• When you need a quick answer to a problem whi le creating a
Frame\llaker document, press ';f.-/, wh ich wi ll change the cu rsor into a
q uestion mark, and click t he command you wa n t to know more about
to bring up an inform ative Help window.
• By clicking on a head and then applying a new fo rmat with the Paragraph Designer, you can apply the new fo rmat, say a side head or a
runni ng head, to just t hat head line or all headlines in t hat document
that have the sa me attrib u tes.
• You can import and export formats, including master page setups, between docu ments.
• You can click t he too lbar to select any of fou r d ifferent QuickAccess
views, which include text formatting, graphic creation, graph ic editing,
and table editing.
• If your FrameMaker document needs to be exported to the Windows or
UN IX en vironments, your documents are bi nary compatible, so they
ca n be o pened in an y o f these platforms. If you select Windows compatibility in your program p references, the program will warn you if the
fi le name exceeds the DOS/Windows na mi ng conven tion.
• Character and pa ragraph fo rmats, documen t setu p, tables, color definitions and o th er d ocument characteristics ca n be sto red in a master tem plate, which ca n be used as a for mat library. Any of these attributes can
be separately and seamlessly imported in to a new document,
• You ca n use FrameMaker's cond itio nal text featu re to offer several variatio ns of a single document. To use this fea ture, you go to Special menu,
select Cond itio nal Text, and use t he Edit optio n . Then you highligh t
the material that will be considered conditio nal, th en apply that condition to a specific portion of t he d ocum en t, whether text, tables or
graphics.
• Use FrameMaker's status line d isplay at t he bottom of your document
window to check for matting and other characteristics of your document.

Using QuarkXPress 3.5
• Almost every ma jor feature in FrameMaker has a keyboard shortcut, and
sometimes several sho rtcuts. They're all spelled out in the Quick Reference guide that ships with the program.
• In the Power Macintosh version of FrameMaker, you have a special
command that allows you to take a FrameMaker equation and have it
run o n Apple's Graph ing Calculator. The resulting graphic image can
then be copied into your FrameMaker document.

Using QuarkXPress 3.5
Quark, Inc. was founded in 1981 as a developer of software for the Apple ll
and the Apple Ill platforms. Typeface, an Apple lii typesetting program released in 1982, is considered a forer unner of QuarkXPress, which debuted in
1987. QuarkXPress offers high end document creation features such as color
separations, trapping, multiple color models, an d advanced hyphenation and
kerning tools. Despite its soph istication, the learning curve is nowhere near
as steep as it used to be. Anyone reasonably skilled on a Macintosh shoul d be
able to pick up this program in short order.

System Requirements
Qua rkX Press will work on any Mac runn ing System 6.0.5 or later, with 4MB
or more of installed RAM. Fully configu red, the program uses around 6MB o f
disk space. The Power Macintosh version adds about 1MB to application size,
and an addi tional 2MB to system memory requirements.

Getting Started in QuarkXPress
Before covering some of the features of QuarkXPress, I want to give you an
idea of how the program operates. Once you get the hang of it, you'll find
QuarkXPress is as easy to lea rn as any of the other publishing programs covered in this chapter. QuarkXPress uses a frame metaphor. All of your text is
contained in text boxes, which you define before creating or importing text.
All of your pictures are in picture boxes. These are the building blocks for
your documents.
Aldus PageMaker uses a single pasteboard for the entire document.
QuarkXPress establishes a separate pasteboard area for each page or sp read.
This has t he advantage of giving you more room to stuff text and picture
elem ents, but it so metimes m ean s that un used elements aren't seen once you
switch to ano ther page, and may be forgotte n or ignored (a nd besides they
increase the size of your document).
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To create a blank QuarkXPress document, select New from the File menu
(and choose Document from the sub-menu), or press ~-N, which displays
the Page setup window shown in figure 21.30. (The Page Sets box shown at
the upper right of the window only appears if you are using a QuarkXTension
called Kitchen Sink, described later in this chapter.) The measurements
shown may differ depending on the size of the last document you created.

Fig. 21.30
Create the basic
layout of your
QuarkXPress
document.
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You can establish settings for page size, page margins, the number of columns
and the space between columns. That little item at the upper right corner of
the window, Page Sets, is part of a neat little add-on to QuarkXPress, Kitchen
Sink, which we'll discuss in more detail a bit later on.

A Tour of QuarkXPress's Pasteboard
Your blank QuarkXPress document contains a text box, with the margins and
columns you've just established, as shown in figure 21.31. If you don't have a
large monitor, the page will be scaled to fit the size of your screen, aligned to
the left. If you chose Facing Pages in your document setup box, all pages past
page 1 will appear on your screen as a two-up spread.
Fig. 21.31
Your new
QuarkXPress
document, ready
for you to add text
and graphics.

Using QuarkXPress 3.5
At this point, you can continue to format your document and create style
sheets, or you can click the textbox, and begin typing away. QuarkXPress has
a default text style, called Normal, that is in effect on every new text box you
create. As we'll explain later on, you can change this default style whenever
you wish.

Using QuarkXPress's Tool Palette
QuarkXPress has several floating palettes, and like other Macintosh software,
basic function s are activated with a click of the Tool Palette. Some of these
Tool icons are a little different from other programs and deserve further explanation.

Table 21 .2
Tool

•

QuarkXPress's Tool Palette
Use
The Item Tool. This tool is used to move, group, ungroup,
and cut, copy, and paste text and picture boxes and rules.
The Content Tool. This is your default tool, when you click a
text or picture box. You can enter and edit text, and
modify and scale pictures.
The Rotation Tool. This tool is used to freely rotate text and
picture boxes. This tool is about as precise as the one in
PageMaker, so you are better off specifying rotation
manually, usi ng the famous QuarkXPress Measurement
Palette, which we' ll d iscuss shortly.
The loom Tool. This tool is used to enlarge or reduce the
view scale in your document window.
The Text Box Tool. This tool is used to create your text box.

Rectangular Picture Box Tool. This tool is used to create your
picture box. Holding down Shift constrains the rectangle to
a square.
Rounded-comer Rectangle Picture Box Tool. This tool is used

to create a rectangular picture box with rounded corners.
Holding down Shift constrains the rectang le to a square.
Oval Picture Box Tool. This tool is used to create an oval

picture box. Holding down Shift constrains the oval to a
circle.
Polygon Picture Box Tool. You use this tool to create a
variably shaped polygon picture box.

(continues)
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Table 21 .2
Tool

Continued
Use
Orthogonal Line Tool. Not as obscure as it sounds. This tool
is used to create a vertical or horizontal rule.
Line Tool. This tool is used to create rules at an angle.
Holding Shift constrains the line to 45-degree angles,
producing results that can be the same as the tool above
(so long as lines are constrained to horizontal or vertical
positions).
Linking Tool. This tool is used to flow text from one text box
to another by linking them. The default setting in
QuarkXPress generally allows text to flow automatically
from one text box to another.
Unlinking Tool. This tool is used to break the text flow
between text boxes.

Using QuarkXPress' Style Sheets
Formatting style sheets in QuarkXPress is similar to PageMaker. You can create and edit paragraph styles by selecting Style Sheets menu in the Edit menu.
After a style is created, it appears in the floating Style Sheets Palette, shown in
figure 2 1.32. This palette can be displayed or hidden through the View menu.
As explained in the preceding section, the Normal style is your default document text setting, which you are free to change to your taste.
Fig. 21.32
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If you want to change a style, simply hold~ and click the style's name
shown in the palette, which will bring up the window we've illustrated in
figure 21.33.

Every element of your paragraph, including whether to include rules above
and below it, can be established as a style sheet. Like Microsoft Word, you
have a Next Style pop-up menu, which allows you to automatically activate
another style, when you press the Return key. This is useful for setting subheads, as the Return key will switch you to the next style, most often for the
body text. Local text changes, such as using italic or bold for emphasis, don't
change when you switch styles, unless you hold the Option key. That choice
removes all local changes to th e style sheets.

Using QuarkXPress' Measurement Palette

Fig. 21 .33
QuarkXPress's
easy-to-use style
sheet edito r.
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Using QuarkXPress' Measurement
Palette
The programmers at Quark had the right idea here. It has proven popular
with users of the program, and h as been imitated elsewhere, such as in Aldus
PageMaker. QuarkXPress' Measurement Palette, shown in figure 21.34, is a
simple tool that you can use to easily modify the attributes of a text or picture box.
Rotation

Font

Point size

The Measurement Palette consists of two parts, and the look changes depending on the sort of element you've selected. If you've selected a text box, for
example, the displays on the left half of the palette are used to control the
location of a textbox, whether it's rotated or not, and how ma ny colum ns it
has. The display at the right applies to the content of the box. It allows you
to change typeface, size, line spacing, styles, such as bold, italic, or underlined, or whether the text is set flush left, right, centered, or justified. A righ t
arrow indicates a pop-up menu. So if you click the area to the left of the
name of the typeface you're using, you'll see a reduced-sized font menu, as
shown in figure 21.35.

Fig. 21.34
QuarkXPress'
Measurement
Palette allows you
to easily change
settings in tex t and
picture boxes.
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Fig. 21.35
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If you've selected a picture box, the Measurement Palette will take on a differ-

ent identity, as shown in figure 21.36. The selections at the left are similar to
the ones shown when a text box is selected, and can be used for adjusting the
position and rotation of your picture box.
Rotate image inside
picture box

Rotate picture
box

Fig. 21.36
The Measurement
Palette changes its
look when a
picture box is
selected.

Adjust position of
picture box

Scale picture

At the right of the Measurement Palette are settings for adjusting and scaling
your graphic inside the picture box. You can rotate this picture separate from
the picture box itself, which provides additional control over the look of your
document.

Document Layout Palette
The Document Layout Palette in QuarkXPress is a convenient way to navigate
from page to page, as shown in figure 21.37. You can hide/display this palette
by selecting the Hide (Show) Document Layout command in the View menu.
Once the palette is displayed, just double-click the icon bearing the number
of the page you want to switch to. You can also reorder the positioning of the
page by selecting its icon and dragging it to another position in the layout.
The vertical rule separates left and right hand pages.
Fig. 21.37
Page navigation
and order
switching made
simple with
QuarkXPress'
Document Layout
Palette.

Using QuarkXPress' Measurement Palette
In addition to going to another page or moving them about in your layout,
you can delete a page (which will bring up a confirming dialog) or apply a
master page to it.

Using Master Pages in QuarkXPress
QuarkXPress's master pages are eno rmously flexible. You can create up to 127
master pages for each document, and unlike FrameMaker or PageMaker, you
can edit the elements from your master page in your regular document pages.
Usi ng the Document Layout Palette described in the preceding section, you
can apply any master page to any selected page in your document. This is a
useful tool if you decide you want to change the master pages that apply to
individual pages.
With so many master pages available, you can customize each one with a
differen t set of recurring text, numbers, or illustrations. To create or modify a
master page you can double click it in the Document Layout Palette, or
choose Display Master-from the Page menu. Except for a few wrinkles, the
master page, shown in figure 21.38, looks very much like your regular document page.
Fig. 21.38
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That little wrinkle I referred to is that little "link" ico n at the upper left of
your document window. Normally, automatic linking between th e text boxes
on adjacent pages is automatic. But you can use this feature to unlink your
m aster page, in case you don 't want your text to automatically flow to another page.
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Creat ing Text in QuarkXPress
QuarkXPress has a decent wo rd processing engine, so you can easily enter
text in your document witho ut the need to import it fro m a word processing
document. You can spell check your document, and find and change text
and fo rmatting.
But if your layout is complex, with type snaking around graphics, and co nsists of a number of columns, you might find that the go ing gets a bit slo w,
especiall y if yo ur Mac offers less than Quadra level perfo rmance. So don 't be
prepared to toss that word processor just yet. Li ke PageMaker, QuarkXPress
will import style sheets generated in Microsoft Word.

Advanced QuarkXPress Features
QuarkX Press has been the program of cho ice fo r a number of newspaper and
magazine publishers, so it goes witho ut saying that there are a wealth of sophisticated to ols to create and format your docume nt. Fo llowing are a few of
QuarkXPress's high-end features:

• Automatic Trapping. When you are printing colo r separations, you need
to deal with such issues as trapping. Trapping is a mean s of compensating for m isalignmen t of colors tha t occurs when you are printing a
multi-color document. QuarkXPress allows you to customi ze trap info rmatio n in your document, for better printing results.

• Color Separations. QuarkXPress can create spo t and process color separations. Such colo r li braries as DIC, Focoltone, PANTONE, Toyo, and
Trumatch are supported with on-screen representatio ns.

• Vertical justifica tion. Bo th li ne spacing in a pa ragraph and between pa ragraphs can be adjusted automatically, so your text fills an enti re text
block.

• Reshaping Picture or Text Boxes. Not o nl y can your text box be a rectangle
o r a square, but you can also reshape your text box (or a picture box),
with th e o ptio ns shown in figure 2139.
Fig. 2 1.39
You can reshape
you r text box to
p rov ide specia l
graph ic effects in
Q uark XPress.
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0
0
0
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QuarkXTensions
A QuarkXPress XTension is, in its own way, very much like the Extensions
you use to enhance the functions of the Mac operating system . O nly in this
case, the enhancements are provided to QuarkXPress, and give it capabilities
that aren 't included in the core program. We'll cover two popular XTensions
here. There are dozens, and they're all available through a mail order dealer,
XChange, whom you can call at 800-788-7557.
VIsion Contents

This XTensio n, from Visio ns Edge, as shown in figure 21.40, allows you to
automatically generate a table of contents in your QuarkXPress document.
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Vision Co ntents will auto matically recognize heads and subheads in a docum ent, or among a group of docum ents, and allow you to quickly build an
accurate table of contents, fully fo rmatted and ready to print.
Kitchen Sink

A few words cannot do justice to this XTension, from programmer Paul
Schmitt's a lowly apprentice productions (or a lap fo r short). You can customize
your d ocument settings in a number of ways, such as automatically opening
your file o n the last page you were workin g o n when the document was
closed, o r build ing a library of default document page setups. The Co-Pilot
feature, shown in figure 21.41, allows you to click an iconic representation of
your document or spread, and immediately go to that positio n in the actual
d ocument itself.

Fig. 21.40
One of the many
QuarkXPress
XTensions to
enhance the
program's featu reset.
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Fig. 21.41
You can do just
about everything
with alap's
Kitchen Sink
XTension for
QuarkXPress.

Another feature, Command Pad, opens a floating palette with icons representing commonly-used functions when a specific XPress tool is selected. You
can change views up to 1200% of the original size, and add flash and flourish
to your document windows with the XTension's customizing options.

Getting The Most Out Of QuarkXPress: Hints and
Tips
Note
Some of the tips below, which are the favorites of some of Quark's own technical
support people, require version 3.3 or later.

• To automatically indent copy at a given point in a paragraph, say after
a bullet or a number, press ~ - \, which is the QuarkX Press Indent Here
command . All copy in a paragraph will now be aligned at the point
where the indent is established.
• If you have a crash when opening a specific page in an XPress document that contains pictures, hold ~ when opening the QuarkXPress
document (in version 3.3) to automatically reimport all grap hics. This
will help in situations where bad screen PICTs are ca using crashes.
• The free Thing-a-ma-Bob XTension from Quark contains a feature t hat
wil l create true typographic piece fractions from a selected set of numbers.
• To quickly change an automatic page number, select a page in the
Documen t Layout palette and press the page wi ndow in the lower lefthand corner to bring up the section window.

Using Ready,Set,Go 6
• Click once on the number below the page icon in the Document Layout
Palette to view that page. This is cool, because you don't have to
double-click a page to go to it and you can navigate between pages
while keeping a separate page or page range selected.
• If you're encountering a Postscript error when printing, try printing in

Rough mode, in the Print dialog box. This will suppress all the graphic
images in the document and print only QuarkXPress elements and text.
If the document prints, you know the error is related to an imported
graphic.
• The Get Text dialog now has sticky buttons. Once Include Style Sheets
is pressed, it stays pressed.
• QuarkXPress 3.3 allows you to shade a grayscale TIFF through the Shade
item in the Style Menu. In previous versions of the program, you were
able to do this only under Other Contrast functions.
• In traditional typesetting, dot leaders, such as those used on an order
form, are generally done with wordspace between the leader character.
QuarkX.Press allows you to establish two character leaders, using any
two characters, in the Tab setup box.
• To scale a picture to automatically fill a picture box, press ;):(-OptionShift-F. This command will retain the picture's proportions; as a result,
the graphic may not precisely fill the picture box, if the proportion s are
different. ;):C-Shift-F will change the proportions of th e graphic object, as
needed, to fill the picture box.

Using Ready,Set,Go 6
Manhattan Graphics was a traditional typesetting and printing company that
was established in New York City in the early 1970s. Work on Ready,Set,Go
started in 1984, when the first Macs shipped, and version 1.0 of Ready,Set,Go
first appeared in january 1985, months ahead of Aldus PageMaker, thus making it one of the first desktop publishing programs to be introduced for the
Macintosh, but it's had a long and somewhat checkered history, as we'll explain. Version 3.0, which appeared in November 1986, was the first publishing program to include automatic hyphenation, something that's taken for
granted in publishing and word processing software today.
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Manhattan Graphics transferred marketing rights to Letraset in 1987, but
continued to develop the program. A high-end version, DesignStudio, appeared early in 1990. The new version featured an extensible architecture that
supported modules known as Annexes, which are similar to a QuarkXPress
XTension, automatic vertical justification, four-color separations and other
publishing tools that later showed up in other desktop publishing software.
The original release of DesignStudio was less than a success in the marketplace, in part because of the name change and price increase, according to its
publisher. Finally, the rights to the program reverted to its developer, Manhattan Graphics, who lowered the price to $395 and restored the original
name. They have continued to develop Ready,Set,Go and improve its range
of highend publishing features.

System Requirements
In addition to its slim price tag, Ready,Set,Go has modest RAM and storage
requirements. It will work on any Macintosh computer with 2MB of RAM
running System 6 or later, and requires 4MB RAM for System 7.0 or later. The
installed program consumes less than 4MB space on your hard drive, including the full stock of Claris XTend translators.

Getting Started in Ready,Set,Go
If you are familiar with QuarkXPress, you will find some of the features of
Ready,Set,Go are not dissimilar. Like XPress, Ready,Set,Go places text in a text
box, and pictures in a picture box. These elements form the cornerstone of
your document.
You'll probably find familiar aspects in other areas of Ready,Set,Go. The Tool
Bar seems to have elements of both XPress and PageMaker in it, but it has its
own individual feel. Ready,Set,Go's pasteboard, like PageMaker's, consists of a
single workspace that applies to all pages in your document.

A Tour of Ready,Set,Go's Pasteboard
When you first launch Ready,Set,Go, it creates a default, untitled document,
with a series of floating palettes surrounding it, as shown in figu re 21.42.
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The n umber icons on the floating palette at the top of your screen represent
page numbers and, at the left, master pages. All of these palettes may be
moved around your screen, in whatever location you choose.
Your Ready,Set,Go document page is blank. In order for you to enter text o r
graphics, you first have to create a frame, using one of the tools that are provided. We'll review those tools next.

Using Ready,Set,Go's Tool Bar
Ready,Set,Go's Tool Bar has its own unique touches, though everyth ing is
marked reasonably clearly as to fun ction, as listed in Table 21.3. The tools are
covered as they appear, from left to right, row by row.

Table 21 .3 Ready,Set,Go's Tool Bar
Tool

Use
Object Pointer Tool. This tool is used to select objects and
to move objects around your document page.
Rotation Tool. This tool is used to freely rotate selected
text and picture objects. As you rotate the object, you' ll
see the angle of rotation displayed at the bottom left of
you r document window. If you want exact precision, you
might make these settings numerically in the text and
picture block setup windows.

(continues)
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Table 21.3 Continued
Tool

Use

II

Hand Too/. When you click this tool, the pointer changes to

a hand and you can move your document page dynamically across your Mac's screen.
Zoom Too/. This tool is used to enlarge o r reduce the view
scale in your document window.
Text Block Tool. This tool is used to create text blocks.

/-beam Pointer Tool. After your text block has been
created, you click this tool and then on your text block to
enter or edit text.
Linking Tool. This tool is used to direct teKt flow by linking
o ne text block to another. Text flow can be also established automatically for newly created pages.
Rectangular Tool. This d rawing tool is used to create a

rectangular box. You can constrain it to a square by
hold ing Shift.
Picture Block Tool. This tool is used to create a picture

block to hold your document's graphics.
Cropping Tool. This tool is used to crop graphics.

Line Tool.This tool is used to create lines constrained to 90
degree angles.
Diagonal Une Tool. This tool is used to create lines at an
angle. If you hold Shift, the lines will be constrained to 45
degree angles.
Rounded Box Tool. This tool is used to create a box with

rounded corners. Holding down Shift constrains it to a
square with rounded corners.
Oval Tool. This tool is used to create an ellipse, or, w hen
you hold Shift, a circle.
Polygon Tool. This tool is used to create a polygon, an
object containing more than three angles.
Polygon Editing Tool. This tool is used to add or delete

points, in order to customize the shape of the polygon.

Using Ready,Set,Go's Style Sheets
Ready,Set,Go has a sophisticated style sheet editor that works on both the
paragraph and character level. To create a style sheet, choose Styles from the
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Document menu, or type ):(-H. Then select New from the window, which
opens a dialog box like the one shown in figure 21.43. You can establish all
the major formatting of your paragraph, from typeface, style, leading and
alignment, to kerning, tracking and whether o r not to hyphenate, in the
Style Specifications Box.
Stqle Spetlncatlons
Nnmo:INew Style

I

Font: 0 New Century Sc ... ,--Typo styles
0 Pinln
0 Outline
ODold
0 Shadow
O ltnllc
0 Duerstrlko
Lending:
0 Underline
Alignment: I center )
Tab s ...
(
Auto Kern: ~
Indents
...
(
nuto Trnck: ILeuel 1)
Size:

~

Fig. 21.43
Ready,Set,Go's
Style Specifications
box.
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Color...
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As with other publishing software, you can highlight a block of text, and
have the format appear in your Style Specifications box. If you want to use
the style sheets from another document, you can easily import those styles to
your new document. Your finished styles appear in a Style palette, as shown
in figure 21.44, which actually doesn' t show up on your screen (except for its
title bar) until a style has been created. You can display this palette by selecting the Document menu, choosing Palettes, and h ighligh ting Show Styles.
Fig. 21.44
Ready,Set,Go's
Style pa lette.

Using Ready,Set,Go's Floating Palettes
Ready,Set,Go doesn't have a Measurement Palette or a Control Palette quite
like those found in its two higher-cost competitors. Instead, it offers two
separate palettes that provide many of the same functions. The palette shown
in figure 21.45 shows text attributes.
The Typography Palette displays your basic text formatting, such as typeface,
size, style, leading and alignment (such as flush left, flush right, centered or
justified}. Other text formatting is done from the Format m enu o r from the
Style palette.
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Typeface

Style

Fig. 21.45

Ready,Set,Go's
Typography
palette.

Alignment
The Specifications pale tte, shown in figure 21.46, is used to change t h e size
and position of a text o r picture block.
To change the size and position, just click the appropriate specification in the
pale tte, and enter the chan ges you want to m ake.

Fig. 21.46

lt.cf'H r. 90'9

pku

'W't!WI ·

16.D7

~~~

Ad justing the size
and position of a
text or picture
block.

Oown : 8 .10

pieu:

C>.pth:

1:5 00

plcu

Using Ready,Set,Go's Text Blocks
Ready,Set,G o's text blocks offer an extraordinary degree of flexibility in addition to basic size and positio n settings. You can bring up the Text Block
Specifications box by double-clicking on a text block with the Object Pointer
tool selected, or press :l=C-M, as we've done in figure 21.47.

Fig. 21.47

just a glimmer of
what lies beneath
the surface in
Ready,Set,Go.
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In addition to setting size a nd position, you can set the degree of rotation
and where the text will align on the page. The graphi cal pull-down menu
labeled Alignmen t le ts you have text alig n automa tically at th e top of the
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page, at the center, or at the bottom. Additio nal settings allow for two va rieties of vertical justification, to spread either individual lines or the space between paragraphs, to fi ll a text block. The Text Shape option changes the
shape of the text block from a rectangle to a variety of shapes, from ellipses to
polygons.

IV

Sep Options controls Ready,Set,Go's sophisticated auto matic colo r trapping
tools. Drop Caps creates autom atic drop caps at the top of your tex t block,
and offers you the choice of typeface, color, and separate trapping o ptions.
There are additio nal settings for ruled borders (Pen Screen) and fi lls (Fill
Screen).
Ready,Set,Go's picture box offers an equally flexible range of settings, along
with the abi lity to have overlapping text run around a graphic.

Using Master Pages in Ready,Set,Go
Your Ready,Set,Go document can be fo rmatted with up to 54 separate master
pages, 27 left, 27 right. Each master page can contain text and picture blocks
that will appear automatically on the page to which they apply. Like
FrameMaker and PageMaker, the items you place on a master page can not be
edited on a document page.

Creating Text in Ready,Set,Go
Ready,Set,Go uses Claris XTend translators to import text in many popular
word processing formats. These same translators can be sh ared with oth er
programs that support XTend technology, offering you a lo t of flexibility. But
you don 't have to go to another program for you r text. Ready,Set,Go has its
own word processing tools that are good enough for many users. You can
find and replace text, using format and style. And there's a decent spell
checker at hand as well, as shown in figure 21.48.
Spelllnq Suggestions
Interned

( Cancel ]

Internee
Interment

Interes t
IWntemed

i

:::::JI

I[Reploce

3

Fig. 21.48
Ready,Set,Go
fi nds your spelling
erro rs before your
readers do.
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The only disconcerting aspect of Ready,Set,Go's word processing capabilities
is its means of handling justified text. As you type characters, they seem to fly
across the page, which sometimes becomes distracting. Experienced users of
the program will set text in flush left mode, than switch to justified mode
when they're finishing typing.

Advanced Ready, Set,Go Features
As you've seen so far, Ready,Set,Go offers much of the power and sophisticated document creating abilities of programs costing twice as much. Here's
some additional features that make this program attractive for many users.
• Ready,Set,Go can create spot and process color separations, and supports RGB, TIFF, RIFF, and EPSF files. The Pantone color library is supported.
• You can import QuickTime movies and include them as part of your
document. Just double-click the movie icon and use the player controls
to view your movie.
• Like Aldus PageMaker, and QuarkXPress, Ready,Set,Go has an extensible
architecture. The software ships with several Annexes, as shown in
figure 21.49. The format is open for third-party programmers to provide
additional modules.
Fig. 21.49
Ready,Set,Go's
Annexes provide
room for additional features for
this publishing
program.
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Getting The Most Out Of Ready,Set,Go: Hints and
Tips
• When copying a text or picture object from one page to another, the
object will appear in the exact same position as on the original page.
• If you hold the Option-Shift-C key, the selected text and picture objects
will automatically center in the middle of the page.
• If you have a text of a certain size and press the j::C- \ keys, the text will
automatically be scaled to fit within the text box. This feat ure works in
graphics as well. You can also select the Scale to Fit function fro m the
Text menu for text, and the Scale Graphic to Block command fro m the
Graphics menu for graphics.

Sum ma ry
• If you press 'lt.-1 while a text block is selected, it will scale the textbox to
the size of the text. The same results occur with a picture box.
• If you highlight some text, and hold the 'lt.-[, the formatting for that
text, such as fonts, size, leading and kerning, will be copied. You can
transfer the text styling to another text area by selecting that text and
typing )t.-] .
• In Ready,Set,Go, you can establish text glossaries, similar to the feature
used in Microsoft Word. Yo u highlight text, select Glossaries, then Text
from the Document menu, click Define and name the Glossary. From
now o n, whenever you press )t.-G, click the Glossary name and click,
the text in the selected Glossary will be inserted at the cursor. You can
also use the Edit Paste Glossary command if you don't want to bring up
the Glossary dia log box. A similar feature is available for graphics.
Graphic objects stored in the Glossary will be placed in the same location as they were when they were originally stored.
• To assign a master or default page to a particular page, click and hold
the page icon in the page palette at the top of your document window,
and you will bring up a Grid menu showing your available master
pages. Simply highlight the master page you want, and it will be applied automatically to that page. You will see the name of the current
page and its associated master page in the title bar of the document
window.
• For foreign language composition, you can set hyphenation and language on a style sheet. You can also apply hyphenatio n and spelling
dictionaries to single paragraphs. (Foreign language dictionaries are an
optional extra.)

Summary
Choosing a publishing software package is a m atter of personal taste. We've
covered the h ighlights of the major programs here, and I hope you'll use it as
a guide in deciding which program to buy. If you are already a user of an
existing publishing softwa re product, I hope my capsule descriptions will
help you explore other options that might be available. Having more than
o ne program at hand is very common amo ng desktop publishing professionals these days.
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Conclusions and Recommendations
If your document creatio n aspirations are modest, the word processing software described in Chapter 17 may provide all the power you need. But if you r
needs demand mo re sop histicatio n, here are some things for you to consider.
• Aldus PageMaker is a full-featured, flexible publishi ng tool that has
been a top seller in bo th its Mac and Wi ndows versio ns. Graphic artists
who have a backgroun d in tradi tio nal layout and design take easily to
this program. The addition of sophisti cated ty pographic tools and color
se para tion ca pability make it more than ca pable of handli ng any job
you have.
• Frame Tech no logy's FrameMaker is a very specialized program, pa rt
word processor, part deskto p publishing, part drawing program. Its
elaborate equation edito r, indexing, table of contents tools and crossreferencing ca pability make it ideal fo r large, structured docu ments,
such as manuals and textbooks. Its basic features are readily accessible,
but when you want to do some of its fancier tricks, you might find it
takes a little while to become adept at them . But the program is no
m o re difficult to lea rn than any of the word processing software discussed in Chapter 17.
• QuarkXPress is a highly sophisticated publi shing tool that has fo und a
ho me in ma ny advertising agencies, magazines, and newspapers. It
takes a back seat to no o ther program in offering fast performance,
precisio n colo r and typographic features, and the growing library of
XTensio n add-ons provide a way fo r you to custom ize the program to
your taste.
• Read y,Set,Go from Ma nhattan Graphics is the senior member of the
deskto p publishing software lineup. It was there ahead of all of the
o ther prog rams we've discussed. It offers some unique document creation features, colo r separation capability, and fast, slick performance
that belies its low pri ce. It is the only program among this group that
pro mises to provide direct suppo rt for Apple's QuickDraw GX tech no logy in a fu ture version. Where cost is a factor, this may be just the program fo r you.

From Here...

From Here ...
This chapter described fo ur of the most popular Macintosh desktop publishing programs, each offering a different twist to the task of creati ng you r docum ents.
• Chapter 8, "All about Fonts," provides valuable information about fonts
and how to use them in you r documents.
• If you're deciding whether to buy a deskto p publishing program, read
Chapter 16, "Word Processing."
• Chapters 37 and 38 discuss the steps you need to take to troub leshoot
common problems with your Mac and how you can solve them before
they becom e serio us.
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Drawing and Painting
by Cyndie Klopfenstein

In the world of electronic art, you can render art on the computer screen in
two basic ways. Vector-based is used to refer to a drawing program such as
Adobe Illustrator, Aldus Freehand, or Deneba Canvas. It is a type of drawing
made up of contiguo us li nes. Usuall y, vector-based programs have tools such
as Bezier curves, scissors, and blend, as well as object-drawing tools such as
circles, squares, and so o n. Selected objects have hand les, or nodes, for editing their size, shape, and content. Objects ca n have a fill and a stroke (ou tline), and you can choose options such as overprinting for trapping purposes.
Pixel-based applications create art from dots. A pixel is either o n or off. If you

zoom in very tightly to art created in a pixel-based program, you would see
that it is made up of millions of square pixels- sort of a close-up view of the
screen doo r, with some of the holes o f the screen filled in. Those pixels that
are turned on create a solid area. Color pixel-based art is made up of different
colored p ixels, but still ei ther on or off. Examples of pixel-based programs are
Claris BrushStrokes and Fractal Design Painter. Adobe Photoshop is anoth er
very popular example.
In this chapter, you learn the major differences between vector- and pixelbased applications, and you also learn about the following:
• Tracing scans in illustration programs
• The drawing tools and how they work
• Bezier curves and the types of tools that create them
• Color creatio n and selection
• Lassoing objects in pixel-based programs
• Plug-Ins and what they add to a program
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• What kinds of applications work best for photo editing
• Adding and deleting text in pixel-based documents
This chapter tours these programs in a logical progression. It starts with the
three most popular vector-based programs on the market-Adobe Illustrator,
Aldus Freehand, and Deneba Ca nvas. Fro m there you explore the pixel-based
program s, where you work primarily with photos and bitmap images. The
chapter starts with the simpler of the two, BrushStrokes from Claris, and then
tours Fractal Design's Painter.

Adobe Illustrator
This high-end, versatile member of the vector-based programs has super texthandling features, works great o n little Macs o n up to the Power Macs, and
handles color creation, blends, and separations like no oth er. It has a following easily divided into two groups: those artists that use it primarily for ill ustrating scanned logos and those who use it fo r custom-design creation. You'll
find that the tools are easy and intuitive, and you'll soon be able to make
your way around the menus and toolbox without help, using the documentatio n only for the occasional challenge.

Using the Drawing Tools
The five d rawing tools (Pen, Brush, Freehand, Oval, and Rectangle) are the
most frequently used tools in Illustrator. Of these, the Be.zier curve tool is the
one you'll find yourself tu rning to with a certain degree of regularity. With
the Bezier pen tool you can d raw perfectly straight lines, any degree of angled
line, and all sorts of curves (see fig. 22. 1). By closing the path (that's what a
line is called-a path), you end up with a shape that can be filled with color.
The outli ne of the shape, called the stroke, can also contain color. Open
paths and closed paths (paths that have joined ends) can have fills, but open
paths often fill in an unexpected manner.
To d raw a straight path, click, hold down the Shift key, and click again . You
can continue the path, either curved or straight (add the Shift key), around to
form a shape and end it by choosing ano ther tool, ):(-clicking in an open area
of the document page, clicking the beginning ha ndle of the path, or by clicking the end of another path (th ereby joining the two paths). Paths, or portions of paths, drawn with the Shift key pressed are constrained to the nearest
15-degree angle.
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To d raw a curved path, click, choose a new position, click and drag. Drag in
the direction opposite of where you want to go with the curve. The illustrations in figure 22.2 show how the Bezier curves work. Each time you click
with this tool, a handle is created. Handles can be deleted and added with the
pop-up menu attached to the Scissors tool.
Fig. 22.2
Drawing curves
takes some getting
used to if this is
your first experience with the
Bezicr pen tool.

The next two tools, the Brush and Freehand tool, are used similarly. Using
either of these is more like drawing with a pencil. To draw, click the tool and
click in the document area. Hold the mouse button down while you move
the mo use and th e line appears. Both of these line ty pes are very sensitive to
each li ttle bump you make with the mo use, but by setting the tolerance in
the Preferences dia log box to a higher number, yo u wi ll make the line somewhat more forgiving. The difference between these two tools is that the Brush
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tool em ulates a paintbrush, while the Freehand pen emulates a pencil or pen.
With the Brush, you can d ictate a stroke width (double-click the tool), and
calligraphic pen style, or a brush tip. To colo r the Brush line, choose a Fill
color in the Paint Style dialog box. The Freehand tool draws lines more li ke
those created with the Bezier pen tool. They are single lines that are colored
by choosing a Stroke color in the Paint palette.
Tip
If you choose the
Ova l or Rectangle
tool and then
Optio n-Cl ick on
the document
area, you can
type specific
height and width
values in the
fields of the
resulting dialog
box.

Fig. 22.3
Using the Open
d ialog box, you
can access an
illustratio n or a
template.

Th e Oval and Rectangle too ls in the Toolbox enable you to draw squares,
rectangles, circles, and ovals very quickly and easily. Just as you did with the
Bezier pen tool, you constrain a shape with the shift key. Hold the shift key
down while drawing a rectangle and it is constrained to a perfect square-an
oval to a perfect circle.

Tracing a Scan
With the Bezier pen tool, you can easily trace a scanned image. Scans that are
to be traced must be saved as a PICT image. PICT is a file fo rmat for graphics-a language, if you will. Adobe Illustrato r can o pen a PICT image as a
template fo r tracing o r it can be placed in the document. For tracing, use the
Open command in the File menu. When you choose Open, a dialog box
appears, allowing you to choose the Template or Illustration you want to
open (see fig. 22.3).
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Locate the PICT image you want to trace and click Open. The scanned image
appears in the exact center of the page as a gray, bitm ap image. Use the Bezier
or Freehand pen tools to draw the image just as you would trace an image
under a piece of paper. The higher resolutio n your scan is, the larger, and
more full of detail the template is. A scan resolution of 300, to 500 is quite
suffi cient. You can hide the Template (the scan) by choosing Hide Tem plate
from the View menu. You may wan t to do this if you have parts of the image
traced and want to get a good look at it without th e template confusing the
view.
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Choosing a View
Views besides Hide/Show Template are also available. Each view has its benefits. In the Artwork view, the illustration is shown much like a wireframe
representation. No colo r appears and all objects on all layers can be seen. In
the Preview mode, colo rs show and opaque objects hide objects that are below them . In either view, the Hide and Show commands of the view menu
can tempo rarily remove o bjects fro m view. This is especially helpful if you
need to edit an object that lies below or very close to another ob ject. Simply
select the object and choose Hide from the View men u, the selected o bject is
removed from view, and you gain full access to the object below. Use the
Show command of the View menu to make all hidden objects visible.

Tip
Use the Arran ge
menu's Lock
command to
Lock an object
so that it is not
inadvertently
selected but
remains in View.

Filling and Stroking Objects and Paths
As you complete paths and o bjects with the d rawi ng tools, they can be fi lled
o r stroked using the Paint Style dialog box shown in figure 22.4 (;):(-!). A fill
is the color that resides inside a path or object, the stroke is the color of the
outline. If you draw an open path (one that does not have the end and beginn ing meet), the fill may be unexpected. Figu re 22.4 sh ows some examples of
the way Illustrator fill s o pen paths. Closed paths are mo re predictable. The
inside of the path is filled with th e Fill color and the outli nes of the Path are
colo red by your selectio n in the Stroke field of the Pain t Style d ialog box (see
fig. 22.5).
Fig. 22.4
In the Paint Style
d ialog box, you
can choose a fill
color, pattern, or
gradient, and a
stroke color,
pattern, and
width.
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Fig. 22.5
Open and closed
paths fill differently. Closed
paths fill the
enti re area of
the enclosure.
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To apply a color, follow these steps:
1. Select an object or objects, and click the Fill or Stroke icon in the upper

left corner of the Paint Style dialog box. An underline appears below the
active swatch.
2. Pick a color from the color swatches directly below the Fill and Stroke

icons, create a process color (click the process color swatch in the row of
swatches to the right), or choose a Pantone color (click the custom
color swatch, also at the right).
3 . The next swatch is for selecting a pattern (or so that you can create

patterns of your own). Apply these to the fill or stroke of an object. If
you have the Fill swatch selected, you can also ch oose from a preset list
of gradient fills or create a custom gradient fill by clicking the Gradient
swatch and double-clicking one of the gradient names to prompt the
Grad ient palette (see fig. 22.6).
Fig. 22.6
Crea te custom
Gradients and
Patterns in the
appropriate
pal ettes.
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In the Stroke Weight field, type a value for the width of the outline. The
values are measured in points, and you can use numbers to the tenth of a
point. If you have the Stroke swatch selected, you can choose a dashed or
solid line style. At the bottom of the Paint Style dialog box, in the fields to
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the right of the Solid and Dashed buttons, typ e values (m easured in po ints)
for the length of the dash and th e ga p. For an even dashed line, numbers
should repeat themselves. Figure 22.7 sho ws examples of values that create
the dashed line below it. You can also control the end caps of lines. You h ave
three o ptio ns: Butt cap, Round cap, and Projecting cap. Figure 22.6 shows
exa mples of the three types of ca ps.
Fig. 22.7
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In the j o ins sectio n of the Paint Styles d ialog box, you dictate the type of
corner you want to make. Your optio ns are Sharp, Round, or Bevel. Each of
these options is further affected by the Miter limit amoun t. The larger the
number you enter in the Mi ter field, the mo re drawn out the corners are.
Figure 22.9 shows examples of joins and miter amo unts.

Fig. 22.8
Choose one of the
th ree end cap
options to dictate
how you wan t the
ends of lines to
appear.
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Fig. 22.9
In the Paint Style
dialog box, you
can also change
the joins and
miters of a line.

Tip
If you click the
down arrow in the
upper right corner
of the Pai n t Style
dialog box, you
can expand o r
collapse the size of
the dialog box for
access to only
those areas of the
dialog box with
which you currently are working.

Adding Type to Your Document
Use the Type tool in the toolbox for adding text characters into the document. Text can be floating on the page, constrained inside a shape (Area
Type), or free-form along a path o r object (Path Type). To access each of these
tools, click and hold down the mouse button on the Type tool to make a
selection (see fig. 22.1 0).

Fig. 22.10
The three type
tools each are used
for d ifferent kinds
of text. Text on a
page, Area Type,
and Path Type.

.

In order to create Area Type, draw an object first (for instance, an ova l or a
rectangle) and then click the object with the Area Type tool. When you begin
typing, the text wi ll fi ll the shape. To type along a path, draw a line with the
Bezier or Freehand Pen tool, choose the Path tool, and click the path. Begin
typing, and the text will fo llow the path. Use one of the selection tools (the
top two arrows of the toolbox) to select the 1-beam cursor of the type, and
you can move the starting point to another position o n the path. You can see
these resu lts in figu re 22.11.

Adobe Illustrator
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Fig. 22.11
Position the !-beam
along a path to
choose the
placem ent of
the characters.

Path Type can also be appHed to a shape. Use this method when you want to
place type in a curve, li ke in figure 22.12. Use the Selection tool to move the
I-beam of the starting point.
Fig. 22.12
In the Artwork
view, you can see
the type applied to
a circle using the
Path Type tool. The
circle has no stroke
or fill and will not
print.

Using the Character Palette

After the characters are typed, select them by dragging through them with
the Type tool, and choose the Character palette from the Type menu ()::1;-T),
shown in figure 22.13. This palette, like Paint Style, can be expanded and
collapsed using the switch icon in the bottom right corner (middle, if the
dialog box is already expanded). Use the arrows beside the fields to scroll to
a font, size, or leading choice, or type the desired selection in the field. For
Baseline Shift, Leading, and Tracking, you cannot scroll. You must type the
value. Press the Return or Enter key, or click the document area to accept the
choices applied to the selected text.
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Making Text Into Graphic Objects

Because Illustrator is a drawing program, one of the best features is its capability to edit the shape of individual text characters. To do this, you must first
select with the Selection tool the text and choose Create Outlines from the

Tip
Choose centered
alignment, and
click the top center of the ci rcle to
make the text flow
evenly down both
sides of the circle.
The !-beam is
placed at the
point where you
click (refer to
fig. 22.12).
Fig. 22.13
The Character
pa lette allows you
to make text
attribute changes.
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Type men u. This makes each letter a graphic object with hand les that can be
edited like all other object hand les in Ill ustrator. The drawback is that the
text is no lo nger text. The fo nt ca nn ot be changed, and it ca nnot be hyp henated automatically. Other attributes, such as leading, are no longer optio ns.
In figure 22.14, you see text characters that have not been converted to
curves on top, and those below after Create Outlines. This view is the Artwork view.
Fig. 22.14
Use the Create
Outl ines option
to change text
characters into
ed itable objects.

The Transformation Tools
The next four tools on the Toolbox are the transformation tools: Ro tate,
Scale, Reflect, and Shear. These tools are used o n objects (or text) and apply
the att ribute for which they' re named. Each of these options can be applied
to the original or applied to a copy. For example, if you select an object and
Option-click with the Reflect tool (where you click the documen t is the point
from wh ich the transformation takes place), you prompt a dialog box where
then you choose Vertical or Horizontal and click the Copy button (see fig.
22. 15). This action makes a d u plicate of the object and fli ps it horizontally or
verticall y, whichever you choose in the dialog box.
Fig. 22.1 5
Use the Copy
button in the
dialog box to
apply the effect to
a duplicate of the
selected object.
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Plug-in Filters
New to Illustrator is the use of filters, or add-o n featu res. Illustrator is shipped
with several sample fil ters such as Ob jects, Pathfinder, and Select. Each of
these filters compliments the capabilities of Illustrator. The Select filter allows
you to select all of the objects in your documen t that have the same fill color
or same stroke colo r. You can also select all stray points which are hand les
left behind when an ob ject was not entirely deleted. Other applications call
these fil ters Pl ug-Ins, XTensions, Extensions, and Add-Ons.

Adobe Illustrator

Note
To make a global color change, click an object that has the fill or outline color you
w ant. Choose Select from the Filters menu, and then choose Sam e Fill Color or
Stroke Color. All objects matching that Fill or Stroke color are selected, and you can
choose a new color in the Paint Style dialog box.

Making Graphs
Illustrator has a fairl y comprehensive gra ph feature. Wi th this feature, you
can quickly create graphs of all sorts. The indicato rs on the graph can be
custom-drawn objects. Use the Graph too l in the Toolbox to begin the g raph.
When you click the document, the Graph Data dialog box appears. Type the
values for the graph in the dialog box. Use th e Graph menu to choose the
type of graph (pie, bar, and so on), columns, ax is, and mo re.

Getting the Most from Illustrator: Hot Tips
•

Reduci11g PostScript Ba11ding. Postscript banding often occurs in large
areas of tints o r gradated screens. To reduce t he occurren ce of banding,
use a Step number divisible evenly into the resolution. For instance, if
you' re outputting to film at 2540 dpi, try an lpi o r screen ruling of 254
or 127 rather than th e traditional 133, 150, 200, or 300.

•

Drawing parallel angled lines. By using the Constrain Angle Preferences
setting in Illustrator, you can set t he angle to which all objects are
drawn . For instance, if you are drawing several 30° lines, set t he Constrain Angle to 30° and draw straight lines with the Pen tool while ho lding down the Shift key. All li nes are then constrained to the 30°. To
return to regular d rawing m od e, reset the Const ra in angle to 0°.

• Applying line weights. To set a mini-default fo r fill and stroke colors and

patterns witho ut resetting the choices in the Paint di alog box, click on
the object containing the fill and stroke that you want to duplicate. Use
the keyboard equiva lent to invoke the Paint dialog box (I collapse the
palette and move it as fa r to the right of the active work area as possible); th en p ress Return or Enter. Now, still using the pen tool, draw
th e new object. The fill and stroke attributes of t he first object are applied to new objects until you change the settings in the Paint dialog
box or until you repeat the steps above fo r choosing mini-defaults.
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• Printing difficult PostScript. When creating art for importation to another
program, such as a logo imported into a QuarkXPress document, always
create the logo in a new Illustrator document by itself. A very common
mistake is to create many different versions of the logo on the same
document page and then import the graphic, moving it around in the
page layout program until only the desired logo shows. With PostScript,
the entire page is rasterized, even though only a small image showsthis creates longer imaging times that you might be charged by the
minute for.
• Printing separations. Illustrator does not print separations in its native
format. Images must be imported into a page layout program that supports separations or into Adobe Separator which ships with Illustrator.
When using a page layout program to generate separations, be sure that
each of the colors that you want is listed in the color palette of the page
layout program or the separation plate for that color will not print.
Separator is particularly adept, especially when you want to print only
specific plates of the document, specify registration marks, and need to
choose an lpi amount that reduces the occurrence of banding.
• Eliminating Stray Points. When deleting guidelines, remember to always
press the Delete key twice. Pressing it once removes the line, but leaves
the anchor points in place. These anchor points are positioned at the
opposite far reaches of the document edge and are considered part of
your image. When importing the image, the stray anchor points are
used to determine the image size. The preview of the page layout program may warn you of this. Be wary of any preview that looks exceedingly small. The Plug-In Select, Stray Points also allows you to delete
any anchor points missed. Choose this option and then press Delete to
remove all stray points inadvertently left behind.
• Repeating Objects to Fonn Circles. To form circular borders with a selected
object, draw a circle iry the size of the desired border. Draw, copy, or
type an object at a point along the circle. If you want to repeat the object around the circle 20 times, divide 360° by 20. Select the object and
choose the rotation tool. Option-Click on the center point of the circle,
and use the resulting number (18 in our example) in the Degree field of
the Rotate dialog box.
• Joining paths. To join two separate open paths and meld the anchor
points, try moving one of the anchor points completely away from the
other path, releasing the line and then moving the anchor point back.
Because of the resolution of the monitor, it sometimes seems impossible

Aldus Freehand
to perfectly align two lines, especiall y in Preview mode. By dragging
one line away and then back, you allow the line you' re moving to snap
to the first line. After you've placed the two lines together, choose Join
();(-]) from the Arrange menu.

Summary
Adobe Illustrator is one of the most widely usetl illustration programs fo r the
Macintosh o r Windows environments. It's easy to see why. It has superior
text-, line-, and color-handling capabilities and the new filter technology
adds extra kick to some of the hardest parts about illustrating. You'll find th at
whether you are a designer making marker comps or a production person
drawing corporate logos, lllustrato r has the tools you need to get th e jo b
done quickly and easily.

Aldus .Freehand
FreeHand 4.0 has made great strides in intuitiveness and a comfortable, easy
user in terface. The newest version relies much more heavily on palette than
did its predecessors. The palette, a floating wi ndow, can be accessed and left
in the document area for repeated use. A central palette, called the Inspector,
allows you to view many different objects and their applied attributes from a
single, handy location. Like Illustrator, this vector-based program is for contiguous line d raw ings. Although you can place halftone TIFF, PICT, and EPS
images, you cannot edit them from within FreeHand. That's a job for a pixelbased painting program (see the fo llowing section) . The Place feature is primarily for the traci ng of scans or to view photos when you wish to design
around them.
The biggest change yet just might be the man uals. Both the Macintosh and
the Wi ndows version of FreeHand are shipped with exactly the same documentation, sort of a unisex handbook. But this documentation is unlike any
other. A great deal of planning went into the layout and design of this
manual, and you'll fi nd information extremely easy to fi nd and the steps a
breeze to follow. The only shortcom ings of the man ua ls are in the depth of
the information. If you're new to FreeHand you' ll have no trouble working
through the process, but if you're an old pro, th e manual won't help you to
stretch your creative drive in uncharted ter ritories. This is not a drawback
uniqu e to FreeHand-most manuals don't h elp you with the advanced
techniques.
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Using the Drawing Tools
As with most illustration programs-and most programs in general, for that
matter-the Toolbox is the focal point. In FreeHand, the Toolbox and the
Inspector pa lette are both focal points. The tools of the Toolbox are somewhat common. You have the Selection tool, the Text tool, several drawing
tools (Rectangle, Polygon, Ellipse, Line, Freehand, Pen, and Bezigon), a Cutti ng tool, and a few different types of transformation tools. In figure 22.16,
the tools are titled.
Pointer

Rectangle

Fig. 22.16
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The Toolbox of
FreeHand offers
several different
drawing tools,
a text tool, a
selection tool,
and a number of
Ellipse
transfom1ation
Freehand
tools.
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Paths are closed or open and are drawn with on e or more of the drawing
tools mentioned previously. Figure 22. 17 shows examples of both a closed
and open path. Paths have handles for editing the line. The more handles
you h ave, the more complex the line is. Handles translate directly into print
time. The more handles a document has, the longer it takes to print. Handles
are not the only cause of extended print time, however.

Aldus Freehand
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Fig. 22.17
On the left is an
exa mple of an
open path. It can
con tain a fill, but
the fill cannot be
seen and will not
print until the
path is closed.

To draw lines or shapes in FreeHand, you have only two options: draw by
dragging or draw by placing points. For example, to draw a rectangle, select
the Rectangle tool, click a starting point, hold the mouse button down and
drag. The object is shown by a temporary bounding box so that you can see
the size and shape before you release the mouse button to accept the object
you've drawn. If you release the mouse button, and don't like the shape,
Delete the move, Undo (J:t-Z) the move, or click, hold the mouse button
down, and drag on one of the handles with the selection tool to edit the
shape. The Pen tool and Bezigon tool both make lines by clicking to place
points (handles). If you click a point, hold the mouse button down, and then
drag the line will become curved, just like the Bezier curves of Illustrator.
All handles are editable. Some objects, such as ellipses and rectangles, must
be ungrouped before they can be edited . Handles that are part of a curve
segment also have handles for editing the curve. You can click the handles
at the intersection of the curve to display them. If you click a corner handle,
you can make it a curve by clicking and dragging the handle. A curve appears
on-screen following the handle in the direction you are dragging. If you click
it again and drag in the opposite direction, the line preceding the handle
becomes curved.

Working with Views

Viewing artwork in FreeHand offers you two options: Keyline mode and Preview mode. As you can see in figure 22.18, each view has its advantages. The
primary advantage for the Keyline mode is the speed with which the screen
redraws. In Keyline, you are viewing the illustration as though it were a
wireframe representation of your work. Colors are not displayed, and all parts
of objects are visible-even those covered by other objects in Preview mode
are visible. Viewing with the Preview mode enables you to see all colors and
objects that are not covered by other objects. Layers affect both of these
views.
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Fig. 22.18
In the Kcyline
mode, the artwork
appears as a
wireframe.

Working with Layers

Using Layers, you can choose to make some items visible (in either view), and
other items hidden. To do this, you simply place items you want to h ide on a
layer by themselves and click the ch eck mark next to the layer name in the
Layers palette (see fig. 22.19). All items on a hidden layer are removed fro m
view. To display them, click in the area of the vacated check mark and a new
check mark appears. All items on that layer are again visible.
Fig. 22.19
In the Layers
palette, you can
duplicate layers,
remove layers,
move objects
between layers,
and select layers as
non printing or
nonviewing.
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Layers can also be used to make drawing easier in complex illustrations. If
you are creating an illustration that is very busy and made up of several components, you might find it easier to work with the com ponents if you divide
them into li ke groups and put all of those items on a single layer. For example, you could have a text layer, a scann ed image layer, a traci ng layer, a
grid layer, and maybe a placed art layer. By shuffling the layers and hiding
some, you can then easily work on tracing the scan, correcting typing errors,
or repositioning placed art without the cluttered view of all layers at once.

Adding Color

You add color to drawn objects by using the Color list, Color mixer, and
Tints palettes shown in figure 22.20. Each of these palettes interacts with the
oth er two palettes and enables you to create custom colors, define Pantone

Aldus Freehand
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or other standard colors, and create tints of the colors you add to the
document. After a color is created (in the Color mixer palette), or a tint defined (Tints palette), you can drag and drop it on the Color list palette. The
Color list is where you select a color to add to an object. The two icons in the
upper left of the palette are for selecting either the Fill or a Line. The line
might also be the outline color of an object. Click the object to which you
want to apply color, choose the correct icon (Fill or Li ne), and click the color
name in the list at the bottom of the Color Jist palette. This applies color to
all selected objects or li nes.

IV

Fig. 22.20
FreeHand has th ree
major palettes for
choosing, mixing,
and applying
colors.

Using Text

Even though FreeHand is an illustration package, its text-hand ling and page
layout fea tures are better than som e of the desktop publishing software. Text
is added to a document in a box called a text block. This text block can be
made up of one colum n or several columns, can contain tabular text o r paragraph text, and can be linked to other text blocks.
All type is added to the document by using the Text tool from the toolbox.
Click the document area to add text and a tab ruler along with a box for inserting the text appear (see fig. 22.21). Type characters as you normally would
and use the tab ruler fo r defining tab stops and indents. Like other handles
in FreeHand, the handles of a text block are editable. Just click and drag to
change the size of the text block. The small box at the bottom right corner of
the text block is to indicate an overflow of text or whether the block is li nked
to another block.
Text can also be bound to a path o r to fill a shape. Type the text, and with
the Selection, tool select both the text and the path and choose Bind to Path
fro m the Type menu. For text in a shape, use the Flow inside Path command,
also in the Type m en u.
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Fig. 22.21

Click the document area to
activate a text
block.

lfhis IS an acb.ve text box. To
~reate one, click the Text tool
n the tool box and click the
~ocument area.!

0

Tracing a Scan
Although FreeHand certainly has the tools for custom art, it also has
strengths in tracing art. You may use custom art for several reasons. You may
want to re-create a customer logo, incorporate existing drawings into your
electronic file, or to use the scan as a guidel ine for some other part of your
illustration. In any case, placed images in FreeHand are not limited to just a
view for tracing witho ut printing as they are in Illustrator. You can move the
scan ned image to a layer that doesn't print, you can ch ange the color so that
it is light enough to see lines drawn over the top of it, and you can view the
image in Keyline mode. Placed images also reside o utside the actual FreeHand
fil e so that th ey don't increase your file size substan tially.

Summary
FreeHand 4.0 has made great strides in merging the desktop publishi ng and
illustrating worlds. It has also become one of the friendliest programs to new
users. By understanding the palette interface, even the most inexperienced of
users can make their way around the options of FreeHand. In addition, the
manuals are superb. Text ha ndling, page layout, and illustration have all
come together in FreeHand. This product wou ld be a much less expensive
start than purchasing a word processing, desktop publishing, and illustration
package separately.

Aldus Freehand

Getting the Most from Freehand: Hot Tips
• Simplifying PostScript Graphics. Always keep your drawn art that is
imported into other page layout programs as simple as possible, never
more than a single graphic per page. A PostScript imagesetter rasterizes
the entire document area, not just the area you've cropped to.
• Smoothing Traced Images. Tracing a scanned image is a great way to add
difficult pieces to your art without all the time it would take to draw
from scratch. Use the Simplify command in the Arrange menu to remove dots. This also works great on pieces that you've d rawn and that
are too complex for an imagesetter to output.
• Reducing PostScript Banding. To create a graduated fill with a dark or light
point in the center that fades to the outside, draw one side and graduate the fill in the direction you want. Then, using the clo ne tool, m ake
a clone that joins at the center. Use the Artwork view so you can accurately align the object and its clone if the seam between the two objects
shows.
• Choosing a Resolution. Select your printer resolutio n before you begin
working on the document. This number is used to calculate the number
of steps to a blend. A chosen resolution lower or higher than th e actual
output will result in PostScript banding in tints and grad uated screen s.
• Delete, don't hide objects. Though it is often recommended, do not use
white boxes to cover up unwanted portions of your artwork. Another
object adds to the complexity of your document and will show if you
place your artwork on a colored or tinted backgroun d. Use the knife
tool to cut away the part o r create a mask. When using a mask, make
sure that you use an object with o nly the necessary items. Do n' t mask
out items that wo n't show, delete them.
• Faster Preview. The more complex your illustration is, th e longer it will
take to draw, this applies to al l computer graphics. Keep your illustrations simple, and, whenever possible, work in Artwork view, which
draws faster because it doesn't render th e fills and patterns.
• Proof Printing. Put all like ob jects o n a single layer, especially text, so
that you can print only that layer for proofreadin g.
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Deneba Canvas
Another of the vector-based programs, Canvas, has been arou nd fo r some
time. Its market share is not nearly that of Ad obe Ill ustrator or FreeHand, but
it is a very similar program. The tools for wo rking in Canvas resem ble those
discussed in the first two sections of this chapter. In fact, other than a few
minor name discrepan cies, they are duplicates in function and form. Canvas
is in the same general price range as Illustrator and FreeHand but is less common, which may mean some diffi culty outputting fil es to a service bureau,
should you need to.
Canvas's focus-and therefore strength- lies in technical illustrati ons. Many
of the tools and options are geared toward home planning, illustratio ns requ iring callouts, and dimension labeling. Figure 22.22 shows an exam ple of
this type of illust ration. This particular example was created in Canvas, and
most of the items you see were automatic functions or optio ns of the toolbox
o r menus.
Fig. 22.22
The strengths of
Canvas lie in
technical illustrations such as this
one.
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Using the Primary Tools
The Tool Box is where you find the power of illustration programs, and Canvas is no different. The Canvas Tool Box contains too ls fo r selecting, erasing,
typing, li nes, objects, and transfo rmations- all too ls discussed in previous
sections (see fig. 22.23). Painting tools such as Lasso, Spray Can, and Paint
Bucket are also included, and this is the first time we've discussed these in
this chapter. This is the ty pe of tool that's typical to a pixel-based program ,
but rarely fo und in a vector-based program .
Drawing with the basic tools is basically the same universally. Click the tool
icon (Line tool, Oval tool, Arc tool, and so on) in th e Tool Box, click in the
document area, hold the mouse button down, and d rag. If you' re d rawing
Bezier curves, yo u click, move the mouse, click and drag in the direction
opposite where you wan t the curve to go. In figure 22.24, some of th e diffe rent drawing tools and their meth ods are illustrated.

Deneba Canvas
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Fig. 22.23
The Tool Box
is loaded with
tools t hat are a
combi nation of
drawing and
painting tools.
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same.
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Fig. 22.24
Continued
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Objects that you have drawn in Canvas are editable, but they must be entered
into the Edit mode. Adding an object to the Edit mode is as simple as doublecl icking it with the Arrow tool (selection tool). The Polygon and Bezier Curve
tools can be set to automatically en ter the Edit mode in the Preferences of
Canvas. Another way to automatically enter the Edit mode is to select the
Arrow tool immedia tely after placi ng the last handle (anchor point) of an
ob ject you have drawn . While you are in the Edit mode, the Arrow too l
changes to a gray arrow to remind you of its status. When the Arrow is positioned over an ed it point (handle) it changes to a cross ha ir. Click and d rag
ha ndles to edit their positio n. After you finish editing your object, exi t the
Edit mode by double-clicking outside the obj ect, by pressing Return, o r by
pressing Enter. You can select several handles to edit at o ne time by ho lding
t he Shift key to select the consecutive points.
In the lower half of the Too l Box, you'll find the pattern s, background, foreground, and other attributes butto ns. Again, this is a combi nation of drawing
and painting tools. Bu t they work the same way: click the tool with the
mouse, click the document area, and hold down the mouse bu tton to disperse paint (such as with the Spray Can), click insid e an object to fill (Pai nt
Bucket), or click a color to change th e line color.

Fig. 22.24
Continued
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Tool Manager is an external application that a llows you to choose the tools
that you want available to you during a drawing sessio n in Canvas. The best
part of this feature, and surely the reason for its inception, is the capability to
free up as much mem ory for more complex files by not running every feature
under the sun-sort of like a Plug-In, Filter, or XTension, but with definable
interface. Tools in the Tool Box use a down-facing arrow indicator in th e
bottom right corner to let you know that the tool has Tool Manager options.
Figure 22.25 shows this indicato r. You have seen the right-faci ng indicator
before, in Illustrator. It pro mpts a fa miliar drop-down or pop-up list (whichever terminology you prefer) from which you can make o th er too l choices.
After you develop a list of tools in th e Tool Manager with which you're comfortable, you can choose to save it as a Tool Set for instan t recall in to other
illustrations you begin.
Fig. 22.25
These double
down-facing
arrows in the
bottom right
corner tell you
tha t other tools
a re available if
you have chosen
them in the
Tool Manager.
Double down-facing arrows

Another feature that Canvas shares with some paint programs is tear-off
menus (see fig. 22.26). You wi ll find that the differences between a tear-off
menu and a palette are minimal. Palettes are generally accessed through a
me nu and remain floating above your artwork where ever you place it. Some
can be collapsed and expanded to furth er hide th em but leave them accessible. Tear-off menus usually cannot be collapsed, but they can be moved or
closed. Both are used in the same manner: select an o bject and click the
selectio n in the palette to apply.
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Changing Views
Aside from scrolling around in your document, Canvas provides a few ways
to change the view size but not ways to view in wireframe or artwork mode.
You are always in the Preview mode in Canvas, and you always see the colors
and patterns applied. This can be a m ajor drain o n memo ry because o bjects
must be rendered fully. To change view size, the sim plest way is to use the
Zoom In/Zoom Out palette icon located at the very botto m of the Tool Box
(see fig. 22.27). just slide the Arrow tool over to the enlargemen t o r reduction
size you need and release the mouse butto n; the view size changes.

Adding Color to Objects
Color is added to Canvas objects using the RGB Color dialog box found in
the Edit menu under Managers. (Ma nagers are tools controlled by the Tool
Manager and are only ava ilable if you have chosen them to be in the Tool
Manager.) RGB colo rs are great for displaying you r work o n the monito r but
aren't very useful if you intend to have your artwork printed. For that, you
have the Color Info Manager which allows you to choose between RGB, HSV,
CMY, CMYK, and Pan tone color opti o ns. If you click th e Pan tone button,
you will not see a palette of colo rs fro m which to choose-only a di alog box
for entering the Pantone number of choice. In figure 22.28, both the RGB
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Fig. 22.26
Tear-off menus
give you immcdia te access to
hidden options,
and they stay in
the document area
until you close
them.
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Color and Color Info Manager dia log boxes are shown. Also under Managers
(located in the Edit menu) is the Gradient Fill manager. As with lllustrator
and FreeHand, you can create a blend of one color to another and apply it to
objects.
Fig. 22.27
Use the Zoom In/
Zoom Out palette
for changing view
size.
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Fig. 22.28
Colo r is accessed
using one of these
dialog boxes: RGB
Color or Color
Info Manager.
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You can only have o ne color palette open in the document at a time. In the
RGB Color Manager, you open a palette by clicking the Get Colors button
and choosing fro m the list of Color Tables in the Colo r Tables folder. The
color palette that you have chosen appea rs in all of the color o ptions in Ca nvas.
To apply color to an object, select it and choose Colo r Info Ma nager. Mix
your color by typing in values or using the sliders. Click Pan tone to define a
color of this module. Click OK and th e object's colo r is changed.
The Pantone Color Window (Windows menu) allows you to view the list of
colo rs and pick a colo r fro m it. You can create custom color sets from which
to choose colors and add, delete, edit, cut, copy, paste, duplicate, and remove
colors from these sets.

Working with Type in the Document
In the Text menu you can select a size, font, justification method, leading,
kerning, and style for your text. If you choose the Text tool from the Tool
Box and hold the mouse button down, you will get the options. Make your
choice from either the menu or the Tool Box and click in the docu ment area
to begin typing. Also in the Text menu is the Type Specifications d ialog box.
You can choose Type from the Tex t menu to see the dialog box shown in
figure 22.29. This d ialog box provides th e sim plest way to m ake multiple
attribute changes to Text. It also sets up the default for all text that is typed
into the docu ment. The Type Specifications dial og box is an external tool
that is accessed by choosing it in the ToolPicker d ialog box.
T pe Spetlll tn tlo ns

Fig. 22.29
Choices in the
Type Specifications
dialog box become
the default for type
in that document.
Change the
defaul ts by coming
back here, or
override them
using the Text
menu.
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You can type paragraph text or caption text in a Canvas document. The two
are differentiated by whether or no t you need margins. Paragraph text allows
you to set margins such as when you're using Canvas for page layout and
want to define columns. To do this, click and drag the Text tool (from the
Tool Box) to define the size of the column. Other text tools are available only
if you have enabled Text Utilities in the Canvas Tools Folder by using the
Tool Picker.

Getting the Most from Canvas: Hot Tips
• Using the Cal/outs. Use Canvas to open Illustrator 88 o r 1.1 documents
so that you can utilize the features of the automatic measured callouts.
Save any Illustrator file (up to 5.0) in a 1.1 or 88 format so that Canvas
can import it.
• Using Tear-Off palettes. When using the same type of arrowhead, for
example, use the tear-off palettes to keep access handy.
• Switching from RGB. Canvas defaults to RGB colors. Make sure that you
are working in the correct color system before you begin choosing colors. Remember that it is unlikely that your mo nitor is displaying the
color accurately, so choose from either a CMYK color swatch book or
Pantone fan, and compile your colo rs accordingly.
• Printing Layers. Place like objects on the same layer so that you can print
specific layers quickly for proofing. This is especially true of text. Being
able to proofread only the text without waiting for a complex document to print is a considerable timesaver.
• Text from Word Processors. Rather than typing extensive text in Canvas,
type it in a word processor that doesn 't take extra time to draw the
objects you've created. Once complete, use Publish and Subscribe to
update and track the text. ror company disclaimers that must appear on
all marketing material but that are updated yearly, this can be a priceless tip.
• Choosing Points for a Blend. When blending objects, use the Point-toPoint option. This will give you added control over how the ob jects
rotate when blended. Without Point-to-Point the objects will align
points-upper-left anchor to upper-left ancho r, and so on.
• Speeding the Preview. Since Canvas does not have a wireframe or artwork
view, illustrations can take a long time to draw. To speed things up,
complete the illustration before add ing patterns, colors, and so on.

Claris BrushStrokes

Summary
Many of the tools of Canvas are from the drawing-type programs and some
from the painting programs-this makes Canvas a good investment if you
find yourself stuck between these two worlds of electronic file creation. Its
price is comparable to Ill ustrator o r FreeHand, but neither of these programs
offers the painting tools as Canvas does.
On the other hand, because Canvas has such a small user base, many of the
service bureaus are not accustomed to outputting this kind of file. This ca n be
bad news if you've spent a great deal of time on ly to learn that the job can 't
be printed.
The documentation on Canvas is very glitzy but organized in a manner that
may require that you look in severa l areas to discern how to perform a certain
function. Canvas's tools are geared particulary well toward creating techn ical
ill ustrations, and therein lies the strength.

Claris BrushStrokes
This program is a scaled-down version of the big boys, such as Adobe
Photoshop or Aldus Photo Styler. But its size is probably the most becoming
feature. Not everyone needs the power (or the expense) of a program like
Photoshop.
BrushStrokes is also a great program to have in addition to one of the more
complex programs. Even if you have the budget to own a more expensive
program, with expense generally comes size, and with size comes memory
requirements. (See table 22.1, later in this chapter.)
Many painting-type pro jects are sim ple and don't require the use of a fullblown program. This is the niche for BrushStrokes. Pixel editing scanned
images is an ideal use for BrushStrokes. You certainly don't need a $450
program to do this.
None of this is to say that BrushStrokes is li m iting. It's not. It has features
that enable you to create the look of fine art paintings, bitmap images, and
full-color, pixel-based drawings.

The Tool Palette and Tear-Off Menus
Still focusing on the tool palette, BrushStrokes introduces tools such as
Spraycan, Eyedropper, and Paintbucket, which are fairly common to paint
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programs. Even tho ugh you can find these tools in some ill ustration packages, they seem to fit best here in pixel-based programs. The Tool palette is
displayed in figure 22.30.
Freehand tool
Selection Rectangle Polygon Selectio n tool
Text
Eraser Grabber

Fig. 22.30
ln BrushStrokes,
tools such as the
Spraycan and
Eraser are used for

S

Rounded Rectang le

Text and Object tools are found here as they would be in an illustration
prog ram, but they work differently. After an object or text is added to the
drawing, it beco mes a grouping of pixels. In fact, all objects in this type of
program are made u p of pixels. You cannot click objects to de lete them o r
edit their handles as you can in the vecto r-based programs.
In BrushStrokes, parts of a pain ting are selected with a different kind of
selectio n tool: the lasso. The Rectangle, Freehand, and Po lygon are all lasso
selecti on too ls. The Oval lasso is one of the Plug-Ins that shipped with
BrushStrokes. To use any of these selectio n too ls, just choose the tool fro m
the Tool palette, click and d rag to encompass the pa rt of your painting that
you want to edit, as shown in figure 22.31.
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Fig_ 22.31
Use one of the
selection tools to
encompass an area
for editing.
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The Magic Wand Plug-In is also a selection tool, but it is not a lasso tool.
To select all objects of the same colo r, choose the Magic Wand and click on
t l u~ w lur you wan t to choose. All pixels in your document that are the same
color as the color you clicked are selected and ready for editing.
Each of the pain ting, object, and eraser tools works with basic Macin tosh
mouse skills. You click and drag to stretch out an object, click and hold down
to disperse paint, or click and drag to erase part of a painting. When you
erase, you're actually painting over the top with whatever color is chosen as
the background color. (More about colo rs later in this section.)
The lower portion of the Tool palette is for selecting colors (see fig. 22.32) .
A foreground color is the color you pain t with. It is the colo r that is dispersed
when you use any of the painting tools. A backgrou nd colo r is the color you
erase with. It is the colo r that is used to cover selected parts of your painting
when you use the Eraser tool. The Line color is the color that the Line tool
puts down. You can use the color drop-down, tear-off menus by clicking the
button and choosing a new color fro m the pop-up color palette. If you continue to hold the mouse button down and drag away, the palette will tear off
and remain wherever you release the mouse button. Toggle between the colo r
wheel and color palette by clicking the Mode button at the top of the tea r-off
men u. Whatever color you choose wi ll be displayed as the color of th e button
on the Tool palette-be it a Foreground, Line, or Background color.

IV

638

Chapter 22-Drawing and Painting

Fig. 22.32
Use the Color popup pa lette to select
a Background,
Foreground, or
Line color.
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Another method fo r choosing a color is to use the Eyedropper tool. If you
already have a painting in your document area, you can copy a color used in
that painting to the foreground color for use by other painting tools. Click
the Eyed ropper tool in the Tool palette and then click the color you want to
copy. It is placed in the Foreground color button.

Working with Views
To zoom in or out on a portion of your drawing, select it with one of the
selection tools and then use the field in the lower left corner of the document
window to type in a value for enlargement or reduction. You ca n also use the
Minus button to reduce the view or the Plus button to enlarge the view.
Unlike Illustrator or Freehand, BrushStrokes does not have a wireframe or
artwork view.

Typing Text into a Graphic
Using the Text tool from the Tool palette, you can add type to your pain ting.
You can add text in two ways, but once you release the box that contains the
text, the characters become part of the image, called a bitmap. Click the Text
tool, click the document area where you want the tex t to be, and drag out a
box the approxima te size that you want the text to occupy. In the second
method, you only click in the document area and BrushStrokes draws a box
of a predefined size. From the Text menu, you select a size, font, style, and
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the type of align me nt. Choose a Foreground color (the colo r that the letters
are painted with) a nd th en type the text. When you a re finish ed typing, if
you d o n 't like the positio n o r your box isn't big enough, you ca n use th e
h and les to ed it the box o r click inside the box a nd drag it to a diffe re nt positio n. If you click outside the box, the text is added to the graph ic, as was
don e in figure 22.33. To remove text, you m ust pain t over it with o n e o f the
painting tools, c hoosing a Foreground color to match the su rrounding a rea.
Opllono TeHI

Mask

Windo w s

Un tille d - I

Working with Non-Native Graphics ·
In BrushStrokes, you ca n open graphics th at were sca nned o r c rea ted in other
environments o r progra ms. They ca n be a TIF F, PICT, Mac Paint, o r PixelPaint
forma t. After they have been opened into BrushStro kes they can be saved as a
PICT, TI FF, or Sta rtup Screen. You might wa n t to scan an image to use a part
of your painting, o r open an existing graphic and edit it by adding text or
colored objects.

Adding and Using Plug-In Modules
Plug-In mod ules are mi n i-a pplica tions that you can add on to BrushStrokes.
Some Plug-Ins are ve ry small a nd only perform one function as with th e oval
selectio n tool d iscussed earlier. Other Plug-Ins are mo re com plex and some
even work with o the r pain t programs. Plug-Ins n eed to be stored in th e

Fig. 22.33
Text placed in
the image area
becomes a bitmap.
It is no longer
editable as text.
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BrushStrokes folder o r in a fo lder just inside BrushStrokes, in the System
folder, or in the Preferences folder inside the System 7 folder. After they're
installed properly, they become a part of the program and work seamlessly.

Getting the Most from BrushStrokes: Hot Tips
•

Adding color. Instead of trying to create a color to match a specific color,

pick up a sampling of the color with the eyedropper and then edit the
positioning of the marker on the color wheel slightly. This will give you
a color very close to the original color.
•

Making Selections. Although the polygon tool allow you to make an

irregularly shaped selection, selecting objects that contain a single color
or similar colors are easier to define by using the Magic Wand Plug-In.
Set the tolerance to pick up the colors you need.
•

Hiding Mistakes. Unli ke illustration programs, a paint program does not

layer or accumulate objects. Therefore, using the paint brush loaded
with the foreground color is an effective way to delete objects.
•

Working witll Text Characters. Because text becomes part of the painted
image as soon as you release the selection, type the text into a new
document, color it, move the letters, and edit until you are satisfied
wi th the results. Then select the text and choose copy, and paste the
text into your image, making sure to postion it before you release the
selection.

•

Choosing a resolution. For optimum printing q uality, the resolution you

create your image at should follow the same rules as resolutions for
halftones. A form ula for determ ining the correct amou nt is simple:
Screen frequency (lpi) X 1.5 = Image Resolution (dpi).
If you intend to reduce or enlarge the painting as you output the file,
factor that number in also. For instance, if you have painted a 4 x 5"
image and you intend to enlarge it 200% (you will use an 8 x 10"), the
formula looks like th is.
Screen frequency (!pi) x 1.5 = x
x x 8" 4 = Image Resolutio n (dpi).
Enter the resolution amount in the Resolution field of the Document
Setup dialog box. Your image may not display properly at resolutions
other than 72 dpi.
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Summary
BrushStrokes is a smaller paint program, but it still can turn o ut professional
pixel-based art and edit TifF, Paint, and PICT format files. The text-hand ling
capabilities are limited but sufficient. Its low cost makes it a good backup
system or stand-alo ne product if you' re o nly occasio nally doing this kind of
wo rk.

Fractal Design Painter
Painter is a fairl y new contender in the paint program ring. But this newcomer is by n o mea ns a mino r player. It has extrem e ideas about how an
electro nic file should be created by a fine artist and fo llows th rough with
those ideas by putting action into their claims. This program not o nly has
superior photo-editing ca pabilities and color separatio n handling, but also
has superior custo m art creati on tools. The palettes of Painter are many and
extensive. Most have tea r-off menus so that whatever you' re working on is
handy. For those fin e artists who say that their style can't be duplicated by a
co mputer, they haven' t tried Painter.
Yo u know Painter is d ifferent as soon as it arrives. Its authen tic pn in t-cnn
packaging and the small-sized m anuals are m aybe just a li ttle too cute. But
getting past th e fluff and into the meat of the program, you're not surprised
that the company uses such gimmicks to pro mote this highly adva nced and
finely tuned product. The best part of the m anuals is the Com pa n ion. It picks
up right where th e regular documentation leaves off. All software manuals
can be expected to teach you the basics about running the program, but the
Companion teaches you about pilo ting the rocket after you learn to fly the
glider. In sho rt, Pa inter is a unique and adept program, especially for fine
artists, photo editors, and illustrators; it is easy to use with great documentation support.

Using the Primary Tools
The tools of Painter are almost all found in palettes. Yo u have Brushes,
friskets, Paper, Colo r, and Expressio n palettes to work from in add ition to the
Tool Box and menus. To understand Pai nter, imagine yourself as an artistsay, Van Gogh. Look around your work area, and what do you see? Pens,
pencils, charcoal, chalk, oil paints, water colors, and mediums of all sortscanvas, paper, glass, and so o n. These are the tools of Painter, but this is the
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twentieth century and you do own a Macintosh. So now what do you have?
All of the tools of Van Gogh placed in easy-to-use palettes and the seemingly
limitless options tha t are a part of the electronic world.
The primary tools of Painter are the brushes and color palettes. With these
two palettes you can select from a wide range of painting tools and shades of
color with which to paint. Painter palettes are similar to palettes in other
Macintosh programs (see fig. 22.34). Open the palette fro m the menu, use the
scroll bar to find the tool of choice, and click the tool. Most of the palettes
can be zoo med open to show mo re optio ns by cl icking the zoom box in the
upper right corner of the pa lette window. After you have clicked on a tool in
the palette, that tool (or its function) is ready to be applied to the open document. The document m ight be an im ported scanned photo, art from a PhotoCO, art created in Fractal Design's Sketcher, or perhaps a piece that you have
created entirely in Painter. Regard less of the o rigination, the tools work the
same. Apply the tool by pressing and holding the mouse button, or with a
stylus from a digitizing pen and pad.
Fig. 22.34
Palettes arc the
primary tools of
Painter. Use the
zoom box to show
more opt ions.
Click the zoom
box again to
collapse the
palette to the
original size.

As you choose a tool from the Brush Palette, the dialog box area below the
scrollable tool list changes. The va riants of the selected tool are fo und in the
Variant pop-up menu. Variants arc the options fo r that tool and are selected
by clicking and dragging the mouse to the desired variant. Other options
besides Variants might also be available depending o n the brush type you
have chosen.

Fractal Design Painter

643

The Brush Size Palette, shown in figure 22.35, works in conjunction with the
Brush Palette by enabling you to edit the size of the brush, the numbers of
bristles, and the angle with which the brush paints.
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Fig. 22.35
Use the Brush Size
Pa lette to edit the
bmsh size, angle,
bristles, and so on.
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The Paper Palette is for selecting a background texture. In figure 22.36, you
can see a sampling of the paper types ava ilable as they appear in the Paper
Palette. O nly some of the brushes are affected by the type of paper to which
they are applied. You can combine brush types and paper types to add more
feel to your paintings. To determine if your brush type is affected by the paper
type, check to see whether the word Grainy appears in the Method pop-up
menu. If so, that tool will be affected by the paper it is used on.

Medium Fine
0 lnuert Grein
s.c..~

( library ...

I
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0 Rend om Grein Bru sh Strokes

In the Color Palette (sec fig. 22.37), you can choose the color of the applied
paint. You can use any color of the spectrum with an y of the brushes, but the
preset color palette is a sampling of colo rs that are normally associated with
the brush that you have chosen in the Brush Palette.

Fig. 22.36
Use the scroll bar
to find a paper
type that suits
your painting. Not
all brush types are
affected by the
type of paper to
wh ich they are
applied.
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Fig. 22.37
The Color Palette
enables you to
define the color
that the brush
applies. You can
use a ny co lor with
any brush, not
just those in the
predefined
swatches.

Besides being able to edit the brush size, you can also define the intensity
(or buildup) with which the color is applied. Options for buildup include the
following: Soft, Grainy Soft, Grainy Hard, Grainy Edge Flat, Soft Paper, and
mo re. With the Brush Behavior Palette, you can define the Saturation, Spacing, and Wet Fringe from sliders that control that type of setting and other
attributes.

Working with the Toolbox Contents
The Toolhox of Pain ter plays a minor role next to the Brush and Colo rs palette (see fig. 22.38). It does not hold the same importance that the Toolbox of
each of the applications we have already discussed. It has a zoom box like the
o ther palettes of Painter, and clicking it shows and hides the Frisket tools. It
also includes the Zoom tool (for enlarging and reducing your artwork on
screen), the Grabber tool (for positioning the artwork in the active window),
the Brush tool (for selecting a Brush fro m the Brush palette), the Eyedropper
tool (for picking up a colo r selection from inside you r painting), and so on.
The Frisket tools that only sh ow when you have zoomed the palette are for
masking parts of your painting.

Using the Editing, Retouching, and Special Effects
There are q uite a few other attributes that you can add to a painting. These
include the following: Add Lighting, Color Overlay, Adjust Dye Concentration, Apply Surface Texture, and Apply Screen. Each of these o ptio ns can be
applied to art that you have created or to a scan that you have opened inside
Painter. A number of typical transformation tools are also available, such as
Rotate, Distort, Scale, and Flip Vertical/ Horizontal. Photo editing tools are
also numerous: you'll find tools such as Soften, Sh arpen, Focus, Brightness/
Contrast, Equalize, and Posterize. All of these combined-or individuallymake for an extremely adept photo editing and retouching program.
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Fig. 22.38
The Toolbox is no t
used to the extent
that it is in other
drawing and
pain ting programs.

Frisket tools
Paint bucket
Selection
Eyedropper

Special effects are also possible here. You are given the tools for Highpass,
Motion Blur, Blob, Marbling, and Glass Distortion. These options are easy
to use and most come with their own window or dialog box (as d o the
transformation and attr ibute tools) for applying or ad justing that fea ture
of th e painting.
Like other pixel-based and vector-based program s discussed in th is chapter,
Plus-Ins ca n be used with Painter. After they are installed, you access them
from the Effects menu.

Cloning
The Cloning feature o f Painter enables you to perform photo retouching
without affecting th e original scan or graphic. It also enables you to trace
over originals and transform photos into pencil sketches, oil paintings, Van
Goghs, o r Seurats. After you make a clone of your artwork by using the File
menu, you're ready to begin editing the painting, tracing, or painting or
drawing on top of the image.

Working with Friskets
In the world of traditional fi ne art, a frisket is used to cover up portions o f a
painting to keep from getting paint on that part that is covered. It might also
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be used by an airbrush artist to define an area for editing. Either way, friskets
are used similarly in Painter. Use them for defining areas that you wan t to
add colo r to or to cover areas where you don't wa nt to accidentally add color.
The Toolbox has four additional tools fo r creating friskets th at a re available
o n ly when you use the zoom button to expand th e Tool box to its full size.
Th ere is also a Frisket Palette that turns Friskets on and off, smoothes them,
and controls the feathering amount, amon g other options. Friskets can contain a colo r and can be transparent or o paque. Use the Magic Wand (a selection tool from the Toolbox) to select all pixels of a like colo r and then make
them a frisket. This would allow you to ch an ge t he color of all the p ixels
insid e o r all the pixels outside the frisket selection.

Getting the Most from Painter: Hot Tips
• Choosing a resolution . (This tip also appea red in Claris BrushStrokes, but
is important h e re, as well.) For optimum printing quality, the resolution
you create your image at should follow the same rules as resolutions fo r
h al ftones. A fo rmula for de termining the correct a mou nt is simple:

Screen frequency (lpi) x 1.5 = Image Resolution (dpi).
If you intend to reduce o r enlarge the painting as you outpu t the file,
facto r that number in also. For instance, if you have painted a 4 x 5"
image and you intend to enlarge it 20091o (you will use an 8 x 10"), the
fo rmula looks like this.
Screen frequ ency (!pi) x 1.5 = x
x x 8" + 4 = Image Resolutio n (dpi).
Enter the resolution amount in the Resolution field of the New Picture
Size dialog box. The tota l docum ent size, based on this resolution and
the width a nd height you have chosen, is displayed below this field.
•

Extending Painter. Wh en working with several objects, use Fractal
Design's Painte r X2. This ex tensio n allows you to create a scrolling
portfol io of thumbnail v iews of painted objects. These objects are
dragged to the image area and placed floa ting above the layer below.
Each item is a frisket that can be feathered to any degree.

• Adding Brushes. In addition to the palette of brushes already available in
Painter, o ther libraries of brush styles ca n be added as a Plug-In. Highend users will find the expanded collection can be customized to fit
t h eir artistic style.

Conclusions and Recommendations

• Straightening your Lines. Though you generally don't paint perfectly
straight lines with a brush, it is an option in Painter. Choose Brush
Stroke, Draw Straight Lines. If you'd like to draw lines and make them
into guide lines or grids, choose Options, Grid Overlay.

Summary
Painter is probably one of the most unique programs to hit the market in
some time. It is specifically geared toward the fine artist making the transition to electronic art, a switch that can be nearly seamless but will open up a
whole new world of possibilities. For the first time, traditional fine artists can
have m ultiple medias and paper textures in the same creation. It stands separate from the other products in this chapter because of its very specific purpose and unique features.

Conclusions and Recommendations
The five programs discussed in this chapter are all produced with the artist in
mind. The type of artist you are, or what your style is for a particu lar job, will
h elp you to decide which of the products are best fo r you. Illustrations that
do not require a great number of technical callouts are handled equally well
by Illustrator or FreeHand. For those of you who draw objects to scale and
n eed the ability to very quickly add measured callouts or add dimension to
objects, you'll find Canvas quite adept at this type of art.
Brush Strokes and Painter are vastly different, though both are pixel-based
and both are for editing or creating painting-type art. A beginner might be
very at home with a small, easy-to-use application like BrushStrokes, but an
experienced artist will feel limited. Painter, on the other hand, offers the fine
artist many texture, paper, and brush options that feel more like working
traditionally.
Other factors, such as price, hard disk space, and so on, may also have a bearing on the program you choose. In table 22.1, further comparisons between
the programs are shown.
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Table 22.1

Application Comparisons

Application

Vector/
Pixel
Based

Approximate
Retail
(Street) Price

Hard
Disk

RAM
Requirements

Illustrator

Vector

$389.95

4.5 MB

5 MB rec.

FreeHand

Vector

$389.95

3.5 MB

8MB rec.

Canvas

Vector

$251.90

6.2 MB

2MB

Brush Strokes

Pixel

$45.95

2MB

4M B

Painter

Pixel

$264.95

5.3 MB

2.5 MB

Chapter 23

Digital Pt;}otography and
Desktop Video---.
by Rob Sonner

The Digita l revolutio n is here and won't be leaving anytime soon. This chapter deals with Digital Photography and Desktop Video. This field was largely
made possible by the folks at Apple Computer and wou ld not have existed in
the same way without Adobe Systems, Inc.
Digital Photography and Desktop Video are perhaps two of the most underestimated and powerful capabilities and the best-kept secret about the Apple
Macintosh computer. Every day, people scan pho tographs, digitize their movies, and touch up and print their works of art without ever having to leave
their desk-desktop, that is.
Working on the desktop means never having to look or move away from
your Macintosh. All you r work efforts and the tools necessary to complete
these efforts are self-conta ined in you r computer.
This chapter takes a brief look into five programs:
• Adobe Photoshop 2.5.1
• Adobe Aud ition 1.0/Adobe Premiere 2.1 LE
• QuickTime 1.6.1 and 1.6.2

Adobe Photoshop
Adobe Photoshop has stormed the marketplace since its inception in 1989
and has literally spawned thousands of digital photography labs in people's
homes and offices. Professional pho tographers and artists using Adobe
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Photoshop for just a few months wonder how they ever managed without it.
They can hard ly see themselves returning to the traditional darkroom mixing
chemicals. Newcomers are immersed in a new world with the power of millions in their hands for only a few hundred dollars.
Adobe Photoshop allows you as the computer user to create, edit, manipulate
and take charge of working with all forms of color images. You can create
Photo composites with ease and retouch images that have been tarnished
over time. Adobe Photoshop has something to offer for every individual,
whether that person is an artist, photographer, or casual user.
Finding your way around the program is easy in version 2.5.1, where many
complicated tasks have been streamlined down to one or two steps and are
available in floa ting palettes. In Photoshop, mi xing chemicals and preparing
separations for the print house are never more than a mouse click away.
Along with Photoshop's extensive bag of tools, revolutionary third-party
plug-ins for Photoshop such as Kai's Power Tools (designed by Photoshop
wizard Kai Krause and published by HSC Software, Inc.) and Paint Alchemy
(published by Xaos Tools, Inc.) have made designing an easy task in
Photoshop, giving you the power and glory to illustrate creations beyond
your wildest dreams with simplicity and ease.
It's preferable to have a color Macintosh system and 24-bit color, although
you'll be okay with an 8-bit configuration . Photoshop runs on all black-andwhite Macintosh es, provided adequate memory is available. Also, there is an
Indexed Color feature that will optimize any 24-bit color document for optimal viewing of 24-bit images on an 8-bit system.

What Is the Difference between 24-Bit Color and
8-Bit Color?
On a Macintosh, 24-bit color is represented on-screen by 16.7 million different colors referred to as three-channel or RGB images. The channels are Red,
Green, and Blue, which account for all the colors in the spectrum. Although
the eye cannot see all these shades and hues, the colors can be simulated onscreen in a way the human eye can understand. To achieve 24-bit color on
your Macintosh, you must have a 24-bit video card such as ones made by
Super Mac (Thunder 24) and Radius (Precision Color) or enough Video RAM
(VRAM) installed on the motherboard.
When referring to 8-bit color, you're dealing with 256 colors optimized
for your screen viewing. An 8-bit color image is a single channel image

Adobe Photoshop
contai ning a max imu m of 256 colors and uses a reference loo kup table to
preview your image on screen dithering the 16. 7 m illio n colors down to the
most common 256 in a matter of seconds.

M emory /System Requirements
Photoshop is an easy-to-learn program that is fun fo r the beginner and has
the power to take seasoned professionals to new places and quali ty levels of
work output. After all, in th is business, time and work are mo ney.
You m ust know what you need to effectively run Pho toshop. A sta ndard
Macintosh with 8MB of RAM is the bare minim um required. The mo re RAM
your system has, the better off you will be. Don 't worry- you don't have to
drive down to your local computer store and buy all the m emory you can
squeeze into your Macintosh . Sit down and see what your optio ns are.
Sometimes, not as much RAM is n eeded as you might expect. Photoshop has
its own built-in Virtual Memory that utilizes yo ur hard disk as extra RAM.
The latest version, 2.5.1, can use up to two hard drives as scratch disks,
whereas version 2.0 and 2.01 were li mited to just one. These scratch disks
temporarily hold the essential data needed for the active docum ents in
Photoshop by storing the informa tio n in free space on the designated drive
when RAM is insufficient.
One cautio n about using Virtual Memory: as Ph otosho p physically has to
write the infor mation to disk, speed and performance slow dramatically.
If you find yourself waiting long periods between operations in Photoshop,
this may be the time to upgrade your RAM.
The RAM allocated to Photoshop m ay be changed while the program is not
runn ing by select ing the Photoshop icon in the Finder and pressing ~-I to
display the Get Info dialog box. In the next example, you can see that I h ave
increased memory to 20000K. Based o n your system's configuratio n, this
actual nu mber will ch ange slightly.
When at all possible, give Photoshop as much memo ry as allowed by your
system configuration (see fig. 23.1). I always leave a small buffe r equivalent to
approximately 2MB of RAM to allow fo r system heap expansion . Also, th is is
very h elpful for switching to another program, such as the Chooser, to select
a printer or a file server o r to browse thro ugh folders in the network without
having to q ui t Photoshop.
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Photoshop stores three copies of every document you are working o n in
m emory, be it virtual or real memory (RAM). Naturally, the more RAM you
have, the better off you wi ll be performance-wise and speed-wise. The first
copy of your document in memory is the actual working copy you see onscreen. The second copy is an exact clone for reference pu rposes only to expedite some of the more time-consuming procedures such as channel and composite operatio ns as well as screen refreshes, or what l refer to as a cache copy.
The third and most importan t copy of your document in memory is your
Undo copy. With this copy, you can use the Undo com mand (:J:t-Z) to restore
your document to its previous state before your last move. Photoshop currently cannot do mu ltiple Undos because of the mass of memo ry required to
accomplish the task. The File menu, however, conta ins a Revert option that
will take you back to the previously saved version of your document should
something go horribly wrong necessitating such an action.
When you launch Photoshop for the first ti me, you will be running with the
program's default settings. At this po int, I high ly recommend a visit to the
Preferences, where you'll find the necessary settings to ensure the program's
smooth operation. The Preferences settings are found in the File menu of
Photoshop and have a fur ther submenu. Consult your manua l for specifics
on these settings. The main preference that interests us at this time is the
Scratch Disks p reference, which is necessary o n ly if you utilize a second d rive
as a scratch d isk (see fig. 23.2).
In the Units preferences, in the File menu > Preferences submenu, yo u can set
the defau lt unit of measure. My defau lt unit of measure is usually the pixel,
but based on your personal preference, you can set this however you wa nt.
Other options include inches, centimeters, picas, and points in the Units
Preferences dialog box (see fig. 23.3).
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Adobe recommends that your System settings for Memory Cache (in the
Memory Control Panel) are set to 32K and that the System's Virtual Memory
is turned off (see fig. 23.4). Photoshop greatly appreciates having th is domain
reserved for its internal memory manager. The maladies that can arise when
using System virtual memory with Photoshop's virtual memory can prove
destructive.
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Fig. 23.4
The Memory
Control pa nel.
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Using a Scanner
Many scanners are compatible with Photoshop, ranging from low-priced
flatbed scanners all the way to high-resolution Leaf scanners for slides and
transparencies. The one thing they have in common is the standard Acquire
plug-in configuration for Photoshop, and they usually ship with a standalone scanning program proprietary to the particular scanner you choose. A
considerable amount of documentation is written about different scannersfrom magazine article reviews to university journal documentation. A visit to
your local library can open th is information to you. Before buying your scanner, make sure that the o ne you get is truly the right one for you.
If you own Photoshop and want to take Digital Photography seriously, you
shouldn' t be without the services of a scanner. You don't need to own a scanner because many service bureaus sell scanning services and most large cities
have several outfits that lease on-site scanning services. In the long run, however, you'll find that owning your own scanner will be much more costeffective.
When scanning directly into Photoshop, you can set your docum ent size,
resolution, and Image mode (including line art) before you scan. This alleviates the time-consuming task of repeated file conversions. As soon as you
scan, you can immediately manipulate your image. Photoshop allows you to
save images in more than 15 file formats, which provides compatibility with
a host of other programs and platforms like IBM-compatible PCs and Scitex.
The native Photoshop 2.5 format saves files more quickly than other file
formats and clears the memory buffer for prolonged and better Photoshop
performance.

Getting Started with Photoshop
Like all Macintosh programs, Photoshop has standard pull-down menus with
all the normal, recognizable fea tures, as well as some that will not be as familiar. This chapter covers some of the essential o nes to get you started and o n
you r way in Photoshop in no time at al l.
The New command at the top of the File menu opens a dialog box in which
you can define your initial docum ent size. In the diagram, the document size
is 512 pixels by 5 12 pixels with a resolution of 72 dots per inch (dpi) in the
RGB Mode (see fig. 23.5).
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Now that you have a clean white canvas, there are many places you can go.
You can place an image into your new document from your hard drive by
using the Place command, acquire a document by scanning an image by
using the Acquire comma nd, open an existing image from your hard d ri ve, or
create a new image using Photosho p's tools and filters. The Acquire submenu
is where scanner Acqu ire plug-in modules show up in your Photoshop. You'll
know whether you have these beca use many-if not all- popular scanners,
such as the o nes man ufactured by Microtek and UMAX, ship with an Adobe
Photoshop Acquire plug-in module, as well as with a stand-alone application
program for scanning (see fig. 23.6).
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Changing Image Size
When you import an image in to Photoshop, you can customize its physical
size and resolu tio n freely and at will. Downsizing your image can be done to
m aintain proportion so as not to lose touch with the aspect ratios. This is
frequently used when finalizing a project in Photoshop, but should always
be taken into consideratio n ahead of time before you even begin working.
Ask yourself what you want or your customer wants.

Fig. 23.6
Example of an
Acquire plug-in for
the Microtek
scanner.
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More often than not, consulting with your printer or service bureau gives
you th e most insight as to what you need to determine when making such
decisio ns. The key is to consult and final ize the details before you start the
project. This way you'll always have an understanding with your client and
between you and the printer-which is very important.
You should know a few things about res izing your image. You can downs ize
an image with no trouble and no degradation. In the General Photoshop
preferences, make sure that Bicubic Interpolation is selected in General Preferences. Each new pixel that Photoshop creates in the upscaled resul t is ave raged from the values of the immediate surround ing pixels. Upsizing your
bitmap image is more difficult because in theory you cannot create what is
not already there. This is your best bet if you do need to increase the overall
size and resolution of your image.
Tip
An ytime you
upsize an image
in Photoshop,
be sure to run
the Unsharp
Mask Plug-In
filter located
in the Filter >
Sharpen menu.

The other option is to use Nearest 1\eighbor, which takes th e nearest corresponding pixels and assigns these values to the newly created pixels in the
upscaled image. The result of using the Nea rest Neighbo r is a faste r, although
less precise, alternative. The look of your image will be rather choppy and
will have a noticeably exaggerated pixelated effect as well. If your original
source image is intentionally pixelated or is aliased text (such as Macintosh
screen shots and fonts) and you want to keep these qua li ties, Nea rest
Neigh bor is an excellent cho ice. Otherwise, it's best to stay wi th Bicubic
In terpolation.
Remember, just as when yo u create a new document, when you resize a
documen t, you can m ake your changes based on the different Units settings
available in Photoshop. You can even res ize based on image size percentage
(see fig. 25.7).

Fig. 23.7
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t he Image menu.
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Changing Canvas Size

IV

The Canvas size command in the Image menu refers to the overall big picture
of the image you are working with in Photosho p. If you were to downsize the
Canvas, you'd cut off parts of your image. Photoshop warns you before th is
happens. The chief purpose of Canvas size is to increase your workspace
around an image.
This is not without its loophole consequences-the larger your Canvas is, the
more memory your image requires to manipulate and store. Never work with
a larger Canvas than necessary. This becomes very apparent the more you
work in Photoshop, because image size is geometrically progressive and
expansive.

Exporting Files from Photoshop
Below Acquire in the File menu is t he Export menu (see fig. 23.8). There you
will find a series of export m odules fo r custom file definition s such as fo r
Adobe Illustrato r, Amiga, Image Writer Color, and Film Strips. Consul t your
Adobe Photosho p manual fo r mo re in formation on th ese and oth er Ex po rt
file types.
Fig. 23.8
Photoshop's
Export submenu.
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Using Photoshop's Toolbox
In Photoshop's vast array of powers, you can use selection tools to define
specific areas to edit. This gives you the ability to paste an entire image (or
portion thereof) inside o r behi nd an isolated po rtion of an image. To create
selections, Pho toshop's Toolbox contains fo ur tools speci fically reserved fo r
making selections. The Toolbox can usually be found in the upper left corner
of your screen .
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At the to p of the Toolbox are the Rectangle and Ellipse Marq uee selectio n
tools, represented by dashed lines (see fig. 23.9). W hen you're using one of
these tools, your selection will be represented on-screen by what appear to be
marching ants-dashed bli nking dotted lines that march around your selectio n. You can constrain the movement of these tools to perfect circles and
sq uares by double-clicking the Marquee tool and selecting the Constrained
Aspect Rati o optio n in th e dialog box that appea rs.
The Lasso tool is where you truly have control to make freeform arbitrary
selections. You ca n also make multiple selectio ns with any of the tools by
ho lding down the Shift key d uring th e selectio n process. Ho lding down the
~ key enables you to subtract areas fro m your selection. Also, to lock certain
preferences into a parti cular tool, double-click the tool's icon in th e toolbox.
This actio n displays a dia log box with the tool's preferences, such as feathering and constraining propo rtions, as well as a fixed pixel ratio size.
The last remaining selectio n tool is the Magic Wan d. Magically, this tool's
icon looks like a miniature wan d, and when you click the mouse around o r
on a particular colo r value in your document, the Magic Wan d sea rches the
imm ediate area fo r similar colors and outlines them wi th the now fa mi liar
marching ants.
Elliptical M arquee

Fig. 23.9
Double-clicking
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The Cropping tool is one of the most helpful tools in Photoshop. You can
crop images in a couple of short steps with total control. Select the tool from
the Toolbox and drag the marquee over the area you want to crop in on. At
this point, you can adjust the crop area by grabbing the handles at any of the
four corners and making your necessary adjustments. When you double-click
the Cropping tool icon in the Toolbox, you get a dialog box that allows you
to set the specific dimensions of your crop and even the resolution you want
after the crop. Also, setting dimensions allows you to maintain a certain aspect ratio. Figure 23.10 shows the Toolbar.
Fig. 23.10
The Toolbar.
Cropping
Grabber Paint
Bucket
Line
Eraser
Airbrush
Rubber Stamp
Blur/Sharpen

Text
Magnifying Glass
Gradient
Eyedropper
Pencil
Paintbrush
Smudge
Dodge/ Burn

When performing this operation, you need to take your interpolation setting
into consideration; once again, Bicubic is you r best choice. If for some reason
you're cropping in and scaling up to the resolution you desire fo r the cropped
area-this is a must-make sure that you are in the Bicubic Interpolation
mode for the same reason discussed a few pages back: you need to use sample
image data from a broader range of pixels for more accurate image detail.
When you have marked the area to crop, move the mouse into the center of
the selected crop image. The mo use icon turns into scissors. Click the mouse,
and your crop is complete. Clicking o utside the selected area cancels the crop,
leaving your image untouched.
You can insert text into your Photoshop image by selecting the Text tool.
With the Text tool selected, click the mouse. A dialog box where you can
enter your text appears on-screen. Enter the text you want to insert, set your
Font, and click OK.
As long as the text remains highlighted with the marquee, you can reposition
the text. Once the selection is dropped, you can no longer move the text by
itself.
The Grabber tool allows you to move around your document by literally
grabbing the document. This allows you to move through your image area
without having to use the scroll bars. Th is is especially helpful in the Full
Screen modes, when the menu bars are hidden.

Tip
Make sure that the
Anti-Aiiased box is
checked in the
Text Edit dialog
box for best result s
with PostScript
fon ts. Th is ensures
that your type is
smooth instead o f
the aliased "stairstepped" effects of
bitmap fo nts.

Tip
You can access t he
Grabber tool on
the fly as you're
using an y other
tool by pressing
and holding t he
space ba r; to
ret urn to the
selected tool,
release the space
bar.
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The Magnifying Glass tool is most handy for zooming in and out on your
image. The keyboard shortcut when using any other tool is ~ -space bar.
Pressing ~ -Option-space bar activates the De-magnifying Glass for zooming
out on your image.
The Paint Bucket tool enables you to fill areas with the foreground color.
The Blend/Gradient tool allows you to make gradients by blending theselected Foreground and Background colors in your image. Double-clicking the
Toolbox icon opens a dialog box where you can set particular preferences of
your gradient (see fig. 23. 11). Options enable you to create Linear or Radial
gradients with control of the midpoint skew on the color blend. You can also
do a full spectrum in a Clockwise or a Counterclockwise direction.

Fig. 23.11
The Gradient tool
preferences.
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The Line tool enables you to paint straight lines on your image in the selected Foreground color. Holding down the Shift key constrains the lines to
45-degree-angle multiples.
Tip
In either the Pai nt
Brush or Pencil
tool, holding
down the Option
key changes the
tool to the
Eyedropper so you
can select a Foreground color.

The Eyedropper tool enables you to select your Foreground and Background
colors from an image without having to call up the Color Picker. Normal
selection of the tool enables you to choose the Foreground color; holding
down the Option key assigns a new Background color. The Eyedropper Options dialog box is shown in figure 23.12.
The Eraser tool erases areas of your image to the selected background color
based 1:1 on the icon to image ratio. Wh at you see is what you get. Doubleclicking the Eraser tool in the Toolbox erases your entire image. By holding
down the Option key whil e eras ing, your image loads your last saved version,
enabling you, magically, to selectively revert parts of your image.
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Fig. 23.12
The Eyedropper
tool allows you to
pick a single color
or an average over
several pixels.

E edropper Options

.,
3 by 3 Rueroge
S by S nueroye

Tip

Note
Feathering a selection is a task you'll become very familia r with quickly. A feathered
selection allows for the selected area, when modified, to have a smooth, meticulous
look as well as a consistent smooth edge. In the real world, a feat hered edge equates
into a smooth, soft, tapered look. If you fa il to use feathered selections when necessary, the result is very apparent with sometimes jagged and raw blotchy edges, Any
selection can be feathered by selecting "Feather" from the Select pull-down menu
and entering a pixel radius number.
Also, by double-clicking the selection tools in the Toolbox, you can enter a feather
radius value as well.

The Pencil tool enables you to draw straight or freeform lines. Holding the
Shift key w hile you apply the Pencil constrains the movem e nt h orizonta lly or

Try using th e
magic eraser with
feathered Lasso
tool selections.
This Eraser tool
erases to your
selected background color
(as chosen in the
Color Picker),
leaving you with a
soft tapered look
rather than a hard
pixelated edge.

vertica lly. Figure 23. 13 shows the Pencil Options dialog box.
Pencil Opllons
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The Airbru sh tool works in much the same was as the traditional a irbrush.

It spreads a li ght layer of the selected Fo reg round colo r on your image. If you
have a pressure-sensitive tablet attach ed to your Maci ntosh , you can vary the
press ure of th e Airbrus h tool. Fif:,rure 23.14 sh ows the Airbrush Opt ions dia log
box.
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Fig. 23.13
Pencil tool
preferen ces.
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Fig. 23.14
Preference dialog
box fo r the
Airbrush tool.

Airbrush Options
- r ode-ou t - - - - ,
Ols ton ce:

CJ

0 ru lronspmen1
0 lo Dockground
ls tylus Pressure:,~
Uor y: D Color
OP•eume

l

The Paintbrush tool enables you to paint your image by using any o f the
brushes in the Brush Palette. You can create your own custom brushes an d
the apply mode in w hich you will do you r painting. The apply modes are
found in the Brush Palette. The most common apply mode is the Normal
apply, which is just what you would see if you applied opaque paint to a
ca nvas. Other apply modes allow you to only pai n t areas that are darker than
your paintbru sh color (Lighten mode) or paint areas that are lighter than
your paintbrush color (Darken only). Try each of the apply modes to get a
feel for what they can do. The brushes work in the same way as many o f the
tools. Consult the Plwtoshop User Guide for specific and d etailed information
perta ini ng to brush selection, manip ul ation, and creation . Figure 23.15 shows
the Paintbrush Options d ial og box.
Fig. 23.15
Paintbrush tool
preferences.
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The Rubber Stamp tool allows you to sample and clone different portions of
yo u r image from one locatio n to another while preserving the nature of the
orientation point. When selecting the tool, hold down the Option key and
select the originating point of the area from which you want to clone. Upon
releasing the Option key, move th e cursor to the destinatio n area. You ca n
clone across differen t images, and yo u can set your Brush size from the Brush
Palette as well as its characteristics. The Im pressio nistic effects of the Rubber
Stamp are amazing, and the From Saved option will allow you to Rubber
Stamp back in portions o f your image from th e previously saved version.
Figu re 23.16 shows the Rubber Stamp Options di alog box.
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Rubber Stomp Options
-'Clone (ollgned)
Clone (non - oligned)
Pottern (aligned)
Pattern (non-ollgned)
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Fig. 23.16
The many options
available in the
Rubber Stamp tool.

from Snapshot
From Soocd
lmpressloni\t

The Smudge tool enables you to smudge precise areas of your image, like
digital finger painting. The Smudge tool is pressure-sensitive when used
with a tablet such as a Wacom tablet. Figure 23.17 shows the Smudge Tool
Options dialog box.
Smud e Tool Options

[8l Finger Pointing
Stylus Pressure

Uory:

0
0

Size
Pro <Sure

Fig. 23.17
Options of the
Smudge tool allow
you to digitally
finger paint.

When selected, the Blu r/Sharpen tool sharpens or blurs the areas of the image
over which the tool passes. To toggle between Blur/Sharpen, you just Optionclick the tool in the Toolbox. This also works while in the document; the
icon reflects which tool is currently active. This tool is also pressure-sensitive
when a drawing tablet is attached to the Macintosh. Double-clicking the tool
displays a dialog box with all these options at the end of the paragraph (see
fig. 23. 18).
Blur/S harpen Options

The newest tool to come to Photoshop is the Dodge and Burn tool. While
this is a practical technique in the darkroom, Photoshop brings this tool out
into the light for you to use right from your desktop (see fig. 23. 19). Optionclicking on the icon toggles between the two. While working in the document, the Option key has the same tool-toggling effect.

Fig. 23.18
Toggling the Blur
and Sharpen tool.
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Fig. 23.19
The Dodge and
Burn tools.

Choosing Your Foreground and Background Colors
At the bottom of the Toolbox is the Photoshop Color Picker. The two large
squares each show the currently selected Foreground and Background colors.
The left square represents the Foreground, and the right represents Background color. On-screen, the left square appears to be sitting slightly in front
of the one on the right.
If you click either the Foreground or the Background square, the Photoshop
Color Picker appears on-screen, allowing you to choose your color visually
with a complex full spectrum palette (see fig. 23.20). You can precisely dial in
your desired color by using any of the numeral entry charts for RGB, CMYK,
HSB, or LAB.
Fig. 23.20
Photoshop's Color
Picker.

Color Picker
Selec t foreground color.
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Clicking th e Custo m button opens th e Custom Pantone color picker (see fig.
23.21). You can either scroll fo r the entire list, or if you know th e name of the
eq uivalent Pantone Matching number, you can enter it in the Find #: box
and scroll right to it. It's as simple as can be. Choosing the exact Pantone
color in a CMYK Photosho p image is highly reliable fo r color accuracy.
You will also no tice in the bottom of the Toolbox above and below Color
Picker squares that there are little arrows and little Black/White squares.
Clicking the squares resets the color picker to Black and White, and the
double arrow toggles and switches the Foreground and Background Colors.
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Working with Selections in Photoshop
After defining a selection in your document, you can save the selection to be
recalled at any time. It's as simple as choosing Save Selection from the Select
menu. When you save add itional selections, the Save selection becomes a
hierarchical menu, at which time you can choose to either save a selection
over one that is already in existence or to create a new Alpha Chan nel. Saving
selections does n ot come without its toll in memory usage. Every time a selection is saved adding an Alpha Channel, an additional Channel is added to
your document, increasing your file size, but it does not affect finished look.
Alpha Channels can be edited or deleted by using the Show Channels palette
found in the Windows pull-down menu and then selecting Delete with the
desired channel highlighted. Alpha Channels are very common in video for
superimposing text or objects into a defined area leaving the underlying
image area untouched.
The way this applies to Photoshop is by storing selection data in an Alpha
Channel you can access what is otherwise transparent to you and the actual
working image. The amount of Alpha Channel use va ries from one user to
another; typically, expert Photoshoppers will use 10-12 Alpha Channels to
store their transpa rent selection data.
To merge an image into another image, you can copy and paste. Initially,
when you paste one image on top of another, it becomes a floating selection.
This means you can grab it, move it, and otherwise tweak it in any way,
shape, or form that you want-even delete it. After the selection is dropped,
however, you can no longer edit it as a floating selection. Images can be
pasted over another image or into com plex selections. The possibilities are
endless.

Fig. 23.21
Photos hop's
Pantone Color
Picker.
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One exercise you should try once you feel comfo rtable in Photoshop is
to copy and paste images onto one another and head straight into the
Composite Controls command on the Edit menu. The art of com positing in
Photoshop is tru ly magical and effortless. I recommend consulting your
Photoslwp User Guide for details o n what comprises the Composite Controls,
as these will truly give you some spectacular and unbeatable resul ts o n your
finished images.

Using Third-Party Plug-In Packages
Along with the spectacular composite and pasting controls of Photoshop,
you should immediately become fa miliar with the image calculation features
of Photoshop. German-bo rn artist and Photoshop commando Kai Krause
has made himself a devout following with insider tips he authored abou t
Photoshop's calculatio n modes. Originally these tips were written in
Microsoft Word format and uploaded to the computer network America
Online where he gained international recognition. Now they are available
virtually anywhere a computer and modem exist via the Internet. You can
obtain the tips not only o n America Online and CompuServe, but also
through Anonymous ITP by accessing the host ftp.netcom.com and going
to the pub/hsc/Ka is_Power_Tips/mac_tips directory.
Kal's Power Tools

These tips not only ga rnered Kai much respect worldwide but inspired him to
publish software to complem ent Photoshop. In order to get the most out of
Photoshop with a minim um amount of effort, every Photoshop user should
own a copy of Kai's Power Tools (see fig. 23 .22). KPT 2.0 is a set of 33 plug-in
filters for Pho toshop where you, the Photoshop user, can explore an endless
combination of seamless tiled textures and multiple gradients, as well as a
Fractal Explorer that infinitely loops and makes looking for the perfect
iteration easy and intuitive.
Other third-party plug-in packages worth checking o ut include Paint Alchemy and Terrazo fro m Xaos Tools, Inc., Andromeda Series filters, and the
three volumes of Aldus Gallery Effects.
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Fig. 23.22
Kai 's Power Tools
Fractal Explorer
User Interface.

Shareware Plug-In Packages
Photoshop is a unique program in that it can virtually be expanded in many
different ways with the addition of third-party plug-ins, whether it is a new
file fo rmat th at will be supported or m o re fi lters. An excellent sou rce of third
party Shareware Photoshop filters is America Online, offering a small package
of filters called Chris' Filters (written by a college student by the name of
Chris Cox) and another by a group w ho call themselves Alien Skin and their
new Black Box Filters, which include effects like the Drop Shad ow plug-in.
Demonstrations of Andromeda filters are also available.

You have just had a quick overview of Photoshop, giving you th e needed
insight to get yourself started. What you have here is the nuts and bolts
approach to Photoshop; there is more to tell which is more than can ever
be written in any book, and more than has ever been written in any book.
Photoshop is very much a self-learning program which o nly you can contro l
based o n the need to learn and the desire to learn. Experiment. Work. Play.
Photoshop.

Getting the Most from Photoshop: Hot Tips
•

If you' re using a Power Macintos h with Photoshop 2.5. 1, make sure that
you obtain a copy of the Power Macintosh Photoshop Plug-ln. It is
available free from Adobe Systems and available on m any onli ne services such as Am erica Online and CompuServe as well as the Internet.
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•

When viewing a selection in Photoshop characterized by the marching
ants on your screen, hide the selection's edges for the best possible
preview with the keyboard shortcut ):(-H.

•

You can quickly snap to the Magnifying Glass tool from any other tool
in Pho tos hop by holding down the )::( and the space bar together; the
cu rsor will turn into a magnifying glass with a+ on it. With the magnifying tool selected, clicking the mouse to enla rge the image or dragging
a marquee rectangle selection tool to define an area you want to zoom
in to are q uick ways to isolate an area of an image you want to view.
When you press the Option key on the keyboard in addition to :}::( and
the space bar, th e magnifying glass turns into a de-magnifying glass and
wil l have a distinguishable minus sign (-)as the cursor and has the
exact opposite of the magnifying glass. Pressing :}:(-Option- zoo111s
you r Photoshop document to the smallest possible size 1:1 6 of the 1:1
size, and pressing ):(-Option+ quick zooms to the 1:1 size ratio. In
Photoshop 2.5.1 LE, )::(- reduces the view to the next lowest ratio {that
is, 2:1 becomes 1:1), and )::(+ magnifies the view to the next highest
ratio (1:1 becomes 2: 1, 2:1 becomes 3:1, and so on).

•

The Hand tool can be activa ted at any time from anywhere by holding
down the space bar on the keyboard and click-dragging your image
rather than using the scroll bars.

•

In a Photoshop document in norma l view, a number in the format of a
1:1 ratio appears in the window's title bar. This number represents the
ratio of pixels to the screen based on 72 pixels to the inch. When the
ratio is 1:1, it mea ns you are viewing you r image at a 1:1 ra tio at 72 DPI
and not necessarily at the true resolution of your document. If you' re
working in a 300DPI docu ment, the 1:1 screen ratio will undoubtedly
appear to be zoomed in and cropped up. There is no need to worry. Just
work the logistics of th e algorithm into the picture and th e numbers
wi ll pan out.

•

Engaging the Caps Lock key changes most of the cursors for Photoshop's tools into a cross hair. This is extremely helpful when you need
to see exactly where you are trying to crop o r wh ich pixel you want to
select for the Rubber Stamp tool.

•

A copy of the Sharewa re CDEV Window Shade is one of the most va luable add itions that is not directly a part of Photoshop that you can add
to your list of accessories. Ava ilable from America Online, this Control

Adobe Photoshop
Panel acts as a roll-up Window Shade for all windows on your
Macintosh, incl uding those in Pho toshop.
• The Show Info floating palette located in the Window menu in
Photoshop is a very small and ind iscreet tool (when shown). It constantly displays all the pixel information of your image as the cursor
passes over it. It does not use an y additional memory and works all by
its lonesome. It provides the location of your cursor with X/Y coordinates as well as the RGB and CMYK values in your image.
• The New Window also found in the Windo w menu will create an active
clone of your working image giving you a second view of your document at a di ffe rent magnification. Any changes m ade in one window
always reflect themselves in the actual image wi ndow. Each window
can be set to different magnificatio ns so you can work with two distinct
views simultaneously
• The Variations feature is very handy for color correcting scanned images quickly. You access this feature under Image> Adjust > Va riations.
Photoshop displays several images that allow you to change the color in
the shadows, midto nes, highlights, and saturation . By comparing your
original image to the variations on-screen, gettin g accurate color is as
easy as point and click.

Summary
Adobe Photoshop is considered by many to be perha ps the most useful software tool designed for the Macin tosh for both the editing of color scanned
images and photographs alike. It was, and still is, one of a kind in terms of
similar applications.
One of the main useful features built into Photoshop is its ability to accept
and use plug-ins designed by third-party develo pers such as HSC Software
(Ka i's Power Tools) and Xaos Tools (Paint Alchemy). In fact, many paint and
drawing programs have followed suit and reconfigured their overall structure
to follow suit and also allow the use of third-party pl ug-ins.
Naturally, there are many paint programs developed and sold for the
Macintosh over the yea rs. Perhaps the closest match is Pain ter from Fractal
Designs and more recently Pixel Paint Pro from Pixel Resources, Inc.; but still,
no thing is q uite like Photoshop.
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Adobe Audition
The Adobe Audition 1.0 software package brings together two of the hottest
digital imaging programs in a special full y functional Limited Edition:
Photoshop 2.5.1 and Premiere 2.1.
The Limited Edition version of Photoshop and the unabridged full shipping
version of Photoshop are nearly the same in many ways. The top end of
Photoshop LE is restricted by its high-end o utput limitations and cannot
work in four color CMYK mode-making output of color separations nil.
Photoshop LE is intended for those who are not planning to do color
separations and high-end imaging.
All in all, Audition is an excellent beginning kit if one is unsure whether the
full feature versions of the software (Photoshop and Premiere) are the right
choices. Whether Audition is initially purchased for a trial run or received as
part of a software/hardware bundle, the new user can get a fairly good feel for
what each program can and cannot do. Upgrading fro m the Audition package
to the full-blown reta il versions is very affordable direct from Adobe Systems
and many third-party resellers.

System Requirements
Adobe Audition can be operated on any QuickTime compatible Macintosh
with a 68020 microprocessor or greater, although Adobe recommends a
68030 processor for smoothest operation . It is also recommended you have a
CD-ROM drive, a color monitor, and video card with at least an 8-bit colo r
depth (256 colors or gray scale). Your work will look much better for color
accuracy because the image color will not break up if you have a 24-bit Video
Display Card installed in your system.
Effectively, this means you must have a Macintosh II or newer model in order
to ru n Premiere and Photoshop and a minim um of 4 megabytes of RAM installed in your machine. The more m em ory you have to run the program, the
better off you will be in the long and short run of operations.
The Adobe Audition programs are primarily System 7 applications, which
means for optimum program performance your System should be loaded
with System 7. Both programs wi ll run on System 6.0.7 or newer versions,
but need 32-bit QuickDraw (version 1.2 or newer) installed o n the older
Macintosh models in order for the programs to run. Newer Macintoshes have
32-bit QuickDraw built into the System, and QuickDraw is available on the
CD-ROM that is shipped with the software.
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Adobe Premiere 2.1 LE
In Adobe Premiere, you ca n make your debut as the Director and the Prod ucer as well as the Editor of your own mov ie. Th e funn y thing is, whe n all is
said and done, your budget n eed not be millio ns of dollars and you won 't
have piles of film strips litterin g the floor.
Adobe Prem ie re LE allows you to put your ideas from your desktop into
motio n without having to leave your seat. C reating high-quali ty, full-color
QuickTime MooVs with stereo sound has never been so easy. As you may
expect, Premiere 2.1 LE does require version 1.5 of the QuickTime extension
to be installed in your system to run.
Adobe Pre mie re is the award-winning QuickTime movie creation and editing
application for the Maci ntos h. Released initia lly immediately following the
advent of QuickTime in 1991, the program has grown by leaps a nd bounds
along with th e QuickTime movie-making m ovement, meeting the advanced
n eeds of the d esktop Videograph er as well as add ressing the wants of the
casual QuickTi me movie make r.

Getting Started with Premiere
Inside Premie re is a very elegant a nd easy-to- use interface. Everyth ing is on
the desktop and easily within reach of you r mouse. Premiere's design has
re mained consistent since its beginning. With the current release, version 4.0,
th e nuts and bolts essentials are sti ll there along with t he addition of increased performance, power, and flexibility. It is safe to say that Adobe Premiere is the industry sta ndard for commercia l QuickTime Movie making.
In Premiere, your desktop can be configu red a ny way you want with the
Co nstruc tion Window (the ph ysica l big p icture of your project) along with
the Pro ject Window. It is very easy to be up a nd running in little or no time
at all (see fig. 23.23).
When se tting up you r movie, you can pull images from many places a nd
d ifferent programs. Some 3-0 ani mation packages, such as lnfini-0, will save
a nimatio n in what is called PICS fo rmat (diffe re nt from PICT). PICS a re a
st ring of PICT files that a re stored in a similar fash ion to th e Scrapbook format. Freq uently I make my movies from individua l PICT files and store all
the images in a commo n folde r to avoid confusion la te r in the prod ucti on
process. Generally you wa nt to work with smaller image fil es in the 300 x 200
pixel size range. Sometim es the re wi ll be severa l different scen es wh ic h will
have their own set of ch a racteristics and thus maybe several working fo lders.
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Fig. 23.23
The Premiere
Interface.

Note
Label your folders with appropriate names, such as Premiere Project Scene 1, Premiere Project Scene 2, and so on, to keep track of scenes and their images. Remember that you're the Director and the Producer; if you're disorganized in the way you
manage your files, your production could also be disorganized.

When inserting images into your movie, they first go into the project window where you can complete much of your outline work in the movie towards the final project. The default duration of an imported frame is one
second when it is imported in to Premiere. Very often, you will find yourself
reducing this number to a couple of frames per image or even one frame per
image. It depends o n your seq uence of images that you w ill be assembling
into an animation/QuickTime movie. Experiment with what's right for your
particular project. Of course, a different set of logistics takes precedence if you
are actually capturing video. In order to capture video d irectly to your Desktop, you will need to purchase the complete Adobe Premiere package.
In the Import window, which is accessed via the r ile menu, you can either
Impo rt an individual file (be it PICTs or Sounds) o n an individual basis or
Import a whole folder with the click of your mouse or a series of individual
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images. This will depend u pon your particular situation of course. If you
select Multiple it will allow yo u to strategically select some files and not
others by either double-clicking on the files you want (or highlighting and
selecting the Open button).

IV

Clicking Folder enables you to select a Folder of Images containing both images and sound data files. This feature is particul arly helpful when you are
working with a large number of images. You do n't have to sit by your computer and attend your mouse as you click and navigate through every single
image. This is a timesaving feature unlike no other-it has saved me many
hours of production time.

The Project versus the Movie
When you' re workin g on a project in Premiere, your saved work in Premiere
is called a Project and your final project a Movie. The Project window where
the thumbnails of your working images appear is your content manager (see
fig. 23.24). This vertically oriented window can be rather large. The scroll bars
can become long based on the number of actual images in your movie
project. This is limited to your monitor size and will not extend beyond its
li mits. Naming your images before importing them in an alpha-numeric format will make for easier work and understanding once you get going on your
movie project. An example of this would be 8001, 8002, B003, and so on.
Fig. 23.24
Premiere's Project
W i ndow.
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While traversing through Premiere and setting up you r project, you should
note that before you get to your layout phase, it may be necessary to edit
your film cli p's frame duration. The default setting is 00:00:01:00, which
translates into one second. If each and every frame of your movie is o ne
second, it will run very slowly (longer than you'd probably care), and
undoubtedly it will have a very choppy feel.

Special Effects and Superimposing
As seen in figure 23.25, the Pro ject Window contains two boxes: a wh ite box
with two buttons and a m id-level gray box labeled Duration (which is also
access ible for the selected image by selecting "Duration" from the Cli p
menu). The white box with labels RGB and Alpha contains the types o f images being used in your project. For most movies you will wan t the RGB butto n selected because that is what you will be working with. As wi th standard
video editing, Alpha Channels in Premiere are for superimposing text over an
image. An example might be fi lm credits rolling at the beginning o r end of
the film or the addition of clouds to a scene. More specifics on this feat ure
can be found in the Adobe Premiere User Guide on using Alpha Chan nels and
o ther related special effects.
Fig. 23.25
The closeup view
of a still in

Prem iere.
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Ea rly versio ns of QuickTim e would o n ly play back on th e Macintosh 15
frames per second at a 160 x 120 pixel frame size. However, th is has
increased over the past three yea rs with each succeed ing versio n. The
cu rrent QuickTime 2.0 effectively al lows for fu ll-speed, full-frame, full-screen
640 x 480, 30 frame-per-second (fps) playback, whi ch is eq uivalent to t hat of
a motion picture.

Adobe Audition
Of course, you can easily run one image for ten seconds in your project/
movie by dialing in the duration to ten seconds.
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The fun only begins by moving you r images into the Constructio n Window.
This is a drag-and-d rop operation that may take some practice before you
get the hang of it. Try it a few times. This way you can see what happens.
You will soon assume complete control over your video editing bay.
You can drag a whole series of film clips from the Project Window to the
Construction Window by Shift-clicking the frames you want to select, which
may be several hu ndred or a thousand, or maybe just one or two. It depends
on what size or type of project you're working on (see fig. 23.26).
Fig . 2 3.26

Premiere's
Construction
Window.

You can have two different film tracks in any given movie at any given time.
This is particu larly useful for editing between several different clips in a given
project. This is also useful for setting up transitions (Special Effects) between
d ifferent clips. Putting these Special Effects into your movie is as easy as a
click and drag of the mouse.
The scenario that works best is a series of snapshots-like your family
vaca tion to the desert Sand Dunes. You define those as series A. You also
have anoth er part of your family vacation that you wa nt to include in your
project; you define this trip to the red sunset with the beautiful sunset over
the island as series B. You can run a Special Effect to smooth o ut the transition between Series A and Series B, and also depict where the first film clip
drops off and the second clip comes into the movie. Figure 23.27 shows the
Special Effects palette.
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Fig. 23.27
Special Effects
palette.
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Nothing is worse than an abrupt change between scenes. This is where the
transition comes into play. You drag any of the 42 effects from the Special
Effects floating palette into the FX strip as the transition between film strip A
and film strip B. You can include up to three separate sound tracks in your
movie project. The individual sound clips need to be imported and moved
into your Constructio n Wi ndow in the same fashion that the images are
impo rted and assembled into place.
To add Special Effects to your movie prod uction is made very easy in Premiere. It is a drag-and-drop procedure. In the "FIX" channel in the Construction Window, you simply drag your desired effect into place and move it into
its designated location. The length of th e transitio n/Special Effect can be
adjusted by dragging the width, and some of the Special Effects can be customized as to direction and A/B video clip effect entrance and exit.

Assembling Film Clips in the Construction Window
At an y ti me, you can move the starting points and ending points of your

d ifferent project segments, which is determined by you-the d irector/editor
of the movie project. The beginning and ending scenes in the Construction
Window are very easy to visually sync u p as far as starting and end ing poin ts
of video and soun d clips alike. The first clip will start at the left of the
Construction W indow in track A and move right X number of frames. Where
tha t first clip ends, the second begins in track B. Be sure and read in depth
about the sound file form ats supported in Premiere 2. 1 LE; most are supported. The accompanying filters and special effects fit in to the big picture.
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This sectio n provides only a quick overview, but consulting the user guide is
never a bad idea; in fini te wisdom ca n be gained from d oing this.
Note that the yellow band at the top of the Constructio n Window is your
effective work area. The red arrow at either side of t he band is for adjusting
the width (length) of your work area. Drag the arrows to ad just your
workspace.

Putting the Finishing Touches on Your Project
When you finish setting up your pro ject, the next step is to actually create
your movie. All you need to d o is compile your movie fo r viewing. In the
Project menu, select Make> Movie ( ~ -K) (see fig. 23.28). In the presen t d ialog box, you need to give your m ovie a fil e name and, before saving, click the
Options button, which will allow you to depict your final file size, comp ression format, and Frames Per Second (FPS) (see fig. 23.29). Many restrictions
here depend on the capabilities o f which Q uickTime version you' re running
in your System. The new QuickTime 2.0 will support larger video image sizes
as well as faster and sm oother playback, generally suppo rting full screen
640 x 480 QuickTime movies at 15 FPS o n virtually all Macin tos h m od els.
QuickTime 1.6.1 ca n only handle, at best, 320 x 240 images at 12 FPS tops.
Fig. 23.28
Making your
movie.

You are presented with a standard dialog box as to where you want to save
your movie.
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Be sure to click the Options button before you proceed to OK (see fig. 23.30).

Fig. 23.30
Premiere's Project
Output Options.
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The Project Output Options dialog box is where you can set up the specifications of your final movie. You can tell Premiere to compile the images only
for your work area or for the entire project, create a QuickTime movie, or
create a QuickTime composite. (See the Premiere User Guide fo r more information.)
In Premier 2.1 LE, you can only save your movies with thousands of colors,
whereas in the full release version, you can save your movies in true heroic
fashion with 24-bit color.
The Quality slider bar located in the Options dialog box gives you the option
of how much compression versus image quality you wa nt in the fina l product. As with all QuickTime prior to 2.0, there are several different types of
QuickTime compression, including Photo JPEG, Cinepak, and Video (as well
as an option of none) from which you can choose. Also, be sure to select your
movie output size. The output size greatly affects the viewing size of the
movie. What you set here is what you'll see when you play it back.
When your movie is finished compiling, a window with the finished product
appears on-screen so that you can see the results of your work (see fig. 23.31}.
Now that we've discussed the making of a QuickTime movie in Premiere 2.1
LE, it is up to you whether you want to jump on the bandwagon and create
one yourself. The information provided in this chapter on both Photoshop
and Premiere should be more than enough to get you started .
Also, if you decide to upgrade to the full version of Premiere, you will gain
even more added flexibility and ability by being able to perform image grabs
from videotapes played on your VCR or other similar media. While this
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requires a little more time and experi ence with Premiere, it is something that
is very easy-and loads of fun-on ce you get the hang of it.
Fig. 23.31
The fi nal m ovie in
Premiere.

• A film clip in the <;:onstruction Window and in the Project Wi ndow is
only a reference to the o riginal file o n your hard drive. It is important
NOT to delete any of the original clips until you are positive you are
done working with the movie's construction and have finished making
your movie.
• When making a movie, you may find it helpful to first make your
movie o nce in a smaller size as sort of a means to go by. This takes less
time and less disk space and is an excellent way to see what you're
working with. This is often the next step after using Premiere's built-in
Preview option before the final completed project. Using Preview often
leaves out complex transitions and effects in your movie and will not
display accurately.
• When applying a filter ( ~ -F bring up the filter list) to a clip, it will affect the whole clip. You can use the razor tool to spli t the clip. If you
are importing individual clips into your Project, applying a filter will
once again apply only to one clip at a time.
• Making your own 3-D movies in Premiere is easy. Simply apply th e
Color Offset filter. Offsetting the red channel to the left causes the image to drop back while offsetting th e red channel to the right creates
the 3-D effect that your image is moving towards you. In o rder to view
this 3-D effect, you will need a pair of 3-D glasses.
• Premiere uses many filters that are Photoshop plug-in compatible. If
there are any third-party Photoshop filters that you would like to use in
Premiere, you may want to check with the software develo per to ensure
proper compatibility; all you need to do is place them in your Premiere
Plug-Ins folder.
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• The adjustable do uble-sided yellow arrow is what defines your work
area. The yellow arrow at either end also acts as a handle. You can adjust the size of your wo rk area accordingly by adjusting the placement
of these arrows. While in Make Movie, you can specify whether you
want to make a movie out of th e Entire Pro ject o r simply the Work Area
you have defined.

Summary
Wo rking in Adobe Premiere, yo u, as an ordinary Macintosh computer user,
can easil y seat yourself in the Director's chair at little expense. Although you
canno t create huge full-scale pro ductio ns, you are well on your way to
making your own Hollywood.
If you have a scanner, I suggest that a good starting point is to ta ke some
scans of famil y pho tos and assemble them into a movie fo r playback on your
computer. Apply different effects, use your Macintosh's built-in soun d recording board (if equipped), and record your voice narrating your movie scenes.
The full version of Premiere has th e ca pability to output to videotape for
ho me viewing in your VCR or similar viewing device.
There are so many uses for Premiere, and I know this is just o ne example.
This is ho w I started. To this day, I' m very pro ud with my first QuickTime
MooV, as it was a very satisfying experience after all the work and effort.
I will leave it up to you to decide where you want to go from here. There
are so many possibilities.
Apple QuickTime is a software extensio n that gives your Macintosh the capability to play and create deskto p video and sound. Without QuickTime, yo ur
Macintosh is o nly a no isy, idle machine. This is okay for people who do n't
expect more, but I'm absolutely positive you will wa nt as much as QuickTime
can offe r.
QuickTime has revolutio nized Macintosh and desktop video in the '90s.
Witho ut it, the Macintosh would no t be the Macintosh as it's known .
QuickTime resides in your computer as an Extensio n (INIT) in your System
Folder's Exten sions Fo lder and will load itself at startup. QuickTime is recognized by its distinctive look: the icon with th e big Q.
QuickTime is an inconspicuo us piece of software created by Apple. Most of
the time, it just sits transparently in your System. Man y tasks taken fo r
g ranted cann ot be accomplished without the aid and presence of QuickTime.
The Q uickTime Extensio n ships with every Apple Macintosh and Power
Macintosh . QuickTim e is a staple of the Apple way of computing and is no
lo nger the unknown entity that it was the fi rst yea r o r so if its existence.
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Apple has been steadily expanding and building upon the power of
QuickTi me, and it has been adopted as an industry standard . Even many
Microsoft Windows programs fo r IBM and compatible PCs can recog nize and
use QuickTime/JPEG compression.
QuickTime is rather small in physical file size (Version 1.6.1 is 837 kil obytes)
and uses only about 20K of memory when not in use. It is a very smart extension memory-wise, as opposed to other system Extensions and Control Panels
that sometimes use large chunks of RAM continuously.

Using QuickTime for Compression
The m ost common form of QuickTime compression is JPEG (prono unced
"jay-peg") compression. JPEG stands for j oint Photographic Experts Group
(named after the group that wrote the standard), and is a proprietary graphic
file compression format excl usive to raw JPEG/JFIF and JPEG Pict files. It is
especially effective at compressing and archiving large color graphic files.
JPEG compression is very fast. With the speed of today's Macintosh computers, you can barely ascertain the elapsed time difference saving/exporting a
JPEG compressed image vs. saving an image without compression. Compression ratios 1/ lSth to 1/20th of the original file size can be achieved.
JPEG compression is not altogether foolproof-it is what is called lossy compression. The amount of loss/degradation of your image is adj ustable and can
be controlled. In addition, several compression formats are ava ilab le: Video,
Photo - JPEG, Cinepak, and Animatio n as of version 1.6.1.
The way QuickTime works is based on algorithms and mathematical permutations of your images. The graphic's pixel information in the graphic is analyzed by the Qui ckTime extension. For example, each RGB (Red, Green, and
Blue) image is referred to as a multi-channeled image, as interpreted by your
computer and your graph ics programs. It is displayed to you r monitor in the
exact same way color images are viewed from a television screen: one color
and pixel at a time in rapid succession.
What QuickTime/jPEG compression does is look fo r each of the Red, Green,
and Blue layers. In the case where there is a large area of solid color, it takes
the solid colo r values of each color and applies an algorithmic code value fo r
each of the three color layers. The more solid an area, the more compression
can be achieved. JPEG compression gets tough when an image has a particularly large amo unt of detail, where it takes mo re code to break down the im age in to formu las representing the pixels rather than storing all the colo r
information. The more deta il there is in an image, less overall compression
will be achieved.
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When decompressing or opening a ]PEG compressed image, QuickTime goes
on a search and interpolates the code it originally created. For example, the
areas with more detail are compressed less. Image areas with less detail are
largely ignored by QuickTime because the human eye will not see the apparent loss in detail. Where QuickTime sees more detail, it pays more careful
attention to its work and takes greater care when compressing.

Using QuickTime MooVs
QuickTirhe is very useful in production environments, but the program is
also a fun source of entertainment.' Ma ny CD-ROM games for the Macintosh
require QuickTime to play back animation movies (spelled MooV). A wide
variety of QuickTime MooVs is available from many sources-CO-ROMS,
such as those shipped with Adobe Premiere and Adobe Audition. There are
also full-length titles available in QuickTime format such as Ludwig Van
Beethoven: Symphony #9, The Voyager Company, and the Beatles' "A Hard
Days Night."
QuickTime serves a number of useful purposes beyond digital entertainment.
For example, many manufacturing industries use QuickTime MooVs as an
interactive learning device for employees as well as for staging on-screen
product demonstrations. NASA uses QuickTime/]PEG compression technology for beaming satellite photographs from faraway locations like Jupiter
back to Earth for viewing by conventional means.
Included on all Macintosh computers when shipped is the QuickTime
MoviePlayer (and sometimes Simple Player). Both are QuickTime Movie applications and can also be found on all the QuickTime installer disks Apple
ships. This disk also ships with PictCompressor, which specifically deals with
still JPEG/QuickTime compressed PICT files.
On the Power Macintosh, the MoviePiayer and the Simple Player have been
made obsolete in lieu of the new and improved SimpleText. Much the same
as TeachText, SimpleText not only can read text files and open PICT files, but
also play sounds and run QuickTime Movies.

Getting the Most from QuickTime
The following hints and tips will help you get the most out of QuickTime:
• QuickTime is not just for movies! You can use QuickTime compression
in applications like Adobe Photoshop to compress PICT format images
up to 1/20th of their original size. When saving an image in Photoshop
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as a PICT, Photoshop will prompt you with an additional choice of
QuickTime compression (only if QuickTime is installed), complete with
a slider control to set the amount of compression .
• If you are making movies for the first time, you may be surprised to
discover the amount of hard disk space required to make and store
them. If you have an interest in making more extensive projects than
just a couple minutes, it is advisable to check out large hard drive and
external storage systems such as Digital Audio Tape (DAT).
• When choosing hard drives to use for QuickTime and AV purposes,
notice the drives on the market labeled specifically for AV use. These
drives have faster access times and are designed for high performance.
• Sometimes a QuickTime movie will appear to look more like an animated flip-book (or rapid slide show) than a movie. This can be caused
if a movie is run on a slower machine, or if there are a lot of frames-persecond in the movie. With quicker and better algorithms for compression/decompression, QuickTime 2.0 relegates this problem as a thing pf
the past. Full-screen video is now possible at 15 frames-per-second on
the Macintosh LC47S.
• Although QuickTime 2.0 will allow lower-end machines to create and
use video, keep in mind that you get what you pay for when purchasing
machines. Bigger is better in the case of creating movies-especially if 3D rendering is involved, where a coprocessor is a must in the 68000
series of Macintosh .
• QuickTime 2.0 is music for Macintosh users' ears. QuickTime now supports MIDI and 16-bit audio with compression rates that can reduce a
300MB CO-quality digital recording of Beethoven's Sth Symphony to fit
on an 800K floppy disk.
• QuickTime 2.0 supports MIDI, 4-to-1 compression of 16-bit audio
tracks, and text tracks, as well as the enhanced speed performance
gains.
Other features of QuickTime 2.0 we can all rejoice about are improved crossplatform compatibility with Windows and DOS-compatible PC machines.
QuickTime 2.0 for Windows is expected to ship later this yea r.

683

684

Chapter 23-Digital Photography and Desktop Video

Summary
What you can look fo rward to with QuickTime 2.0 is larger smoother playback of QuickTime movies. In version 1.6.1 a 320 x 240 pixel movie played
back at 12 fps was considered amazing and high tech. With QuickTime 2.0
you can now do the same thing with full-screen 640 x 480 pixel movies at up
to 15 fps. The smaller format 320 x 240 movies can now play back at 30 fps
with no evident System slowdown and include support for time-code-based
professional-level video editing capabilities at up to 60 fps wi th h igh-end data
throughout at up to 3MB per second, as well as MPEG recognition and support.

Conclusions and Recommendations
While QuickTime is typically Freeware from Apple Computer, lnc. and is
shipped with all current versions of System software, it has also been made
readily available in the past from o nline services such as America Online and
Com puServe as well as the Internet. Version 2.0 will not be made available
electronically, however. Nothing other than your ordinary Maci ntosh computer is required to run Qui ckTime. It is possible with current versions of
QuickTime (version 1.5 or newer) that it can be run under System 6 with
limited advantages. It is preferable that if you are in fact using an older
Macintosh (such as a Mac llci or older), you upgrade to System 7 when using
QuickTime.

Chapter 24

Using CD-ROM Elrives

and Soft
by David Busch

When the Macintosh was first introduced, the idea of m ore than 600M of
software on a single disc that costs less than a dollar to produce and which
could be sold fo r $5 .00 to $50.00 was on ly an impossible dream. After all, the
first Macs could access only 400K of programs or data before it was necessary
to spit out a disc and insert a new one.
Today, multimedia discs that combine sound, high-resolution images,
QuickTime video clips, or even full-m otion movies are within the reach of
any Macintosh owner. You can add CD-ROM technology to the long list of
innovations that received their first strong support from Apple Computer
and the Macintosh community.
While the "new" CD-ROM explosio n is shaking the foundations of both the
Macintosh and PC worlds, th e deto nation's fuse extends back to the late
1980s. Apple primed the canno n by offe ring som e of the fi rst affordable CDROM dri ves, the AppleCD SC, alo ng with pio neering discs like Apple Develo per Gro up's Developer Helper (also kn own as "Phil and Dave's Excellent
CD"). This early entry was no speed demo n: data access times were in the
500-600 ms range in an age when a fast hard disc could find any sector in 28
ms or less.
Thanks to the easy expandability offered by the Mac's built-in SCSI in terface,
since 1988 it's been easy for any Macintosh owner to buy and connect up a
CD-ROM drive. The growing installed base of drives has in turn sparked the
development of multimedia CD-ROM discs that use the features of the
Macintosh. Of course, as in many "Which comes first, the chicken or the
egg?" situatio ns, even after ch icken s were plentiful, the market was
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remarkably barren of eggs. That's changing now with the daily introduction
of new and exciting CD-ROM software offerings.
This chapter provides the following:
• A quick introduction to CD-ROM technology
• An explanation of the hardware requirements
• An overview of the best software on the market

CD-ROM Technology
You probably don't care to know the technology behind the CD-ROM, so I'll
boil it all down to a single sentence: CO-ROMs are circular, 4.75-inch writeonce, read-many times (WORM) discs in which digital info rmation is represented very compactly by tiny holes that can be read with lasers attached to
high-resolution sensors. That's enough techno-babble.

Where Did CD-ROM Technology Come From?
CD-ROMs have been around in one form or another for nearly a decade, and
other formats of optical disc (which is what a CD-ROM actually is) have been
sold since the first laser discs became available in 1974.
Capable of storing up to 680M of information on a single disc, CD-ROMs
were at first almost exclusively devoted to distributing large databases of
information. Telephone directories, massive computer reports, census data,
huge operations manuals, scientific bibliographies, and other text-oriented
material were efficiently stored on these laser discs.
The advantage of using CD-ROMs for data distribution was obvious-the
discs could be mass-duplicated with the same manufacturing techniques used
for the higher-volume CD audio disc, and read by anyone equipped with a
CD-ROM player, which was a modified version of consumer audio CD players. Information providers could distribute massive amounts of information,
which could be read by anyone with a $500-$800 CD player. The cost to the
originator of the disc could be a few dollars per disc, or more, depending on
the quantity ordered and, if l)ecessary, could be recouped by charging those
who used the information $150 to $2000 for the privilege of accessing the
data.
Still, the market for CD-ROMs was limited. Discs filled with scientific or business data were of interest only to scientists or business people. An $800 CDROM player could be easily justified by a business or educational institution,
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even in quantities, and the value of the information made $150 discs a
bargain. However, consumers were not interested in buying $200 dictionaries, $99 full-text reproductions of books they could purchase for $19.95 in
hard cover form, or other similar software, even when th e price of drives
dropped to the $400 level and below.

Why CD-ROMs Will Become Standard Equipment
Shrewd ind ustry analysts predict that CD-ROM drives wi ll become a no noptional, standard part of eve ry Macintosh sold sometime in 1995. Only the
need for a few low-cost entries in Apple's war for market share with t he PC
world have kept this change from ha ppening sooner. The following sections
cover the key reasons why we're now seeing a growth of CD-ROM drives.

Stunning Simplicity
Most of all, t he CD-ROM m akes an overpoweringly attractive add-on by virtue of its simplicity. Once you've successfully installed a CD-ROM drive in
your computer (and many Mac systems, including all AV Macintosh and
Power Macintosh configuratio ns, now com e with these d rives already installed), all you need to do to enjoy a CD is pop the disc in the drive and
follow th e included installation instructions.
There's no need to swap multiple flopp y discs in and ou t. Frequently, CDROM software runs d irectly off the CD-ROM, with only a few files stored
permanen tly on your computer to speed operations a little. And, often, the
exact same CD-ROM ca n be used with both Macintosh as well as IBM PC and
compatible systems, so you may not even need to know w hat kind of computer you own to buy the righ t disc!

Enhanced Applications with Sound and Motion
Applicatio ns provided on CD-ROM can be enh anced with sound, graphics,
and multimedia features that are d ifficult to integrate into floppy-disk-based
offerings wi thout commandeering massive chun ks of precious hard d isk
space. Computer m ultimedia-sound plus graphics-equa ls computers that
can do eve rything that videotape players or sound/slide o r film strip proj ectors could do-a nd much more, thanks to computer interactivity. There is
now a vast new market for software that takes adva ntage of the sound capabilities of Macintoshes an d the storage facilities of th e CD-ROM .
CD-ROM Technology Makes a Lot of Sense for Vendors
Software has tradi tion ally been delivered on floppy disk. Large applications
m ay requ ire four to ten disks, or mo re, depending on whether t he vendor
uses the o lder 800K fo rmat for compatibili ty with earlier Macs, or takes a
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chance and releases a product on 1.44M diskettes. The disks are easily damaged, can be accidentally erased, and must be duplicated by the end-user to
provide back-up copies as a safety measure.
One compact disc can replace hundreds of floppies (at much lower cost),
they're difficult to damage, and expensive to pirate. Vendors can load up the
disk with tons of free ex tras, such as clip art or fonts, which cost them virtually nothing but have a high perceived va lue in the customer's eyes. You get
more and the vendor pays less. Everybody wins.
Lower-Cost CD-ROM Drives and Interfaces

CO-ROMs cou ld have become a success even if drives rema ined at the $400$500 price point we saw before 1994. Given the advantages of CD-ROM software, a $500 player was a bargain. But prices didn't stop their plunge at $400.
The drop has been as dramatic as the rise in disk sales.
At the beginning of 1994, I purchased a state-of-the-art external CD-ROM
drive for my Quadra 650 for $289.00. Today, you can see advertisements in
mail order catalogs for equivalent units for $199, including one listed at $139
(or $79 if you purchase it with a $99 Grolier Multimedia Encyclopedia). CDROM drives today cost what floppy disk drives cost last year. I could predict
that prices will stabilize at the $12S-$ 199 1evel, and still be proved perilously
pessimistic before the next update of this book is due.
Lower-Cost CD-ROM Discs

The plummeting cost of the discs themselves also is driving the CD-ROM
revolution. The price-performance ratio is becoming more attractive in two
ways: you're getting much, much better discs at a much , much lower cost.
CD-ROM encyclopedias were originally developed as a lower-cost alternative
to a hardbound encyclo pedia, with some fancy retrieval options thrown in.
You might pay $500 or more for a set of encyclopedia books that strain your
bookshelf, and force you to page through several volumes and a dozen articles to find all the information you need on a topic (The phrase "See also:"
was the original version of hypertext!).
Today, if you want that text encyclopedia on CD-ROM, you can probably
pick one up for $25 or so. They have been largely supplanted by $395 multimedia encyclopedias (which never really sold for much more than $149 and
which now have $89-$99 street prices-or less) with the same text you got
before, supplemented by hou rs of video cli ps, tons of sound bites, thousands
of still photographs, animation, and other things. The product you get today
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is hundreds of times better than the one you purchased a year or two ago,
and costs much less.

CD-ROM Standards
We must delve back into CD-ROM technology for a moment to explain the
different standards you should understand when purchasing a disc. But don't
worry, we' re only going to get one toe wet. I'm going to tell you what the
standards are, but nothing at all of how they work.
All CO-ROMs are not alike. The digita l data on them can be written using one
of several different standards. These have names like Red Book, Yellow Book,
Green Book, and Orange Book, after the color-coded covers of the manuals
overseen by the Dutch manufactu rer, Philips N.V., which developed the technology and serves as a guardian and clearinghouse for many of the standards
applied to these discs. I'll refer to the common names of each of these standards, because odds are slim that you'll ever have the need or desire to actually peruse a Red, Yellow, Green, or Orange book itself.
•

CO-Audio. This standard defines the familiar audio COs that you've

probably been enjoying on your home CD player for years. Digital audio data is stored in bits and bytes just like computer programs, and
then read and converted to music through a device called a digital-toanalog converter (DAC) in your audio system.
Compu ter CD-ROM drives can also read audio COs. You may need a
special driver program to start the audio CD playing and to change
from track to track. To hear the sound, you can plug a set of headphones into the headphone jack on your CD-ROM d rive, and connect
its output to your amplifier or speakers.
• IS0-9660/Higll Sierra. This International Standards Organizatio n (ISO)

standard defines a type of data structure that can be read by DOS/ Windows, Macintosh, or Com modore Amiga computers, when those platforms are equipped with appropriate driver software. Many CO-ROMs
are furnished in this fo rmat and include both Mac and PC access
software, which can, in turn, read the same data files, or a special set
created for each type of com puter, on a so-called llybrirl disc. Since COROMs have so much storage space, it's often possible to develop IS09660 discs that provide virtually the sam e functions and features on
both types of computers.
•

CD-ROM Interactive. This CD-ROM format, often called CD-I, is most

often used in stand-alone players that are connected to a television set
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a n d keyboard/keypad. You won't use CD-I discs in your computer C DROM drive.

• CD-ROM XA. This CD-ROM format is an extension of the IS0-9660
sta n dard, add ing support for d iscs that are erasable and updatable. All
other types of discs have t heir data written to them at one time, in a socalled single session. Most of the discs you use in your CD-ROM drive
were actually pressed, like waffles coming out of a waffle iron, exactly as
audio C Ds are produced.
However, we now have a n ew kind of disc that can be written to by a
laser/m agnet ic device (generall y costing $3000 and up, and used only
by companies rath er than individuals). Since these discs can be written
to more than once (a nd some types ca n be e ra sed and rewritten), they
are called m ul ti-session d iscs. Kodak Photo CDs, which incorporate
p h otographs scan ned by your photofinisher, arc a type of multi-session
disc. Others are written as pa rt of a database updating process.
Nearly all CD-ROM drives now sold are XA compatible. The only XAformat discs you are like ly to encounter will be Photo CDs you create
from your own photos with the h elp of your finisher, o r Photo CDs
compiled by others for sale as h igh-resolution clip art.
The CD-ROM formats discussed in the previous section are all wellestablished, and you probably don't have to worry about any new ones being
in trod uced for t he n ext few years (alt h ough Kodak continues to enha nce its
Photo CD format) .
What you can expect are CO-ROMs that take advantage of new software and
hardware technologies buil t into your computer system. These include:
•

Video. QuickTime for t h e Macintosh and other video technologies will
see extensive application in CD-ROMS during 1995 and beyond. Each
technology makes it possible to display small video images on your
screen, bringing CDs to vivid life. Since none of these technologies are
pervasive as yet, the CD-ROMs which require them will include runti me vers ions a n d install the m on you r hard disk as requi red. Additiona l
video technologies have been announced that will bring full -screen,
more realistic video to CD-ROMs during the co ming years.

• New Operating Syste111S. In the Macintosh world, System 7.5 and
QuickDraw GX (which h as yet to d raw broad support from ven dors)

CD-ROM Technology
will offer software developers some new tools fo r bringing you faster,
more realistic on-screen graphics.
•

Faster Hardware. The Power Macintosh 6100, 7100, and 8100 models

have all proved to be from four to ten times faster than equivalent
Quadra models when running native software, and 1995 will be the
year when all ma jor applications-including those that depend on CDRON(-convert to that mode. Apple's "fat binary" format lets a single
application run in an optimized mode on either Power Macs or 680x0based Macintoshes, so those who choose to remain with our older systems will still be able to run the same applications (albeit at lower
speeds!).
These faster Mac systems, coupled with triple- and quadruple-speed CD-ROM
drives should make CD-ROM software even more practical and popular in the
coming yea rs. We may be in the middle of a revolution, but the changes are
only beginning.

CD-ROM and Multimedia
Most CD-ROM software are multimedia discs, which, in the broadest terms,
means they contain something more than just text. To qualify as "multi"
media, a CD-ROM may have pictures, video, sound, animation, plain text,
linked text (hypertext), and other features in various combinations. Any
Macintosh equipped with the cheapest CD-ROM drive can view text; to access multimedia features, you'll n eed something more in the way of hardware.
The term multimedia predates desktop computer technology by many years.
Educational tools using filmstrip or slide pro jectors linked to synchronized
cassette recorder sound tracks have been classroom workhorses for decades.
Business conferences and seminars are spiced up by motion picture or slideshow/sound extravaganzas that often feature dozens of projectors, massive
screens, and thundering speakers. You' ll even find this brand of multimedia
at amusement parks.
Desktop multimedia was initially a way to harness the power of the personal
computer to manage all the sound and visual elements of th ese presentations
in a new way. However, the sheer size of image and sound files used restricted
desktop presentations to relatively simple productions, such as those generated by Microsoft PowerPoint or Aldus Persuasion.
CD-ROMs, which can easily store 70 minutes or more of music, or up to
680M of image files, freed developers from most storage constraints. For the
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first time it became possible to produce multimedia programs that could be
stored o n a11d nm from a single, compact d isc.

The Macintosh and CD-ROM Technology
Part of the reason the Macintosh has had a head start in CD technology is the
Mac, manufactured and marketed by a single company, has always been

fairly well-standardized. Until the last few yea rs, when the Macintosh line
grew into separate Performa, LC, Quadra, PowerBook, DuoDock, and
PowerMacintosh li nes (have I forgotten a couple?), there wasn' t th e bewildering variety of Mac models we have today to confuse the issue. A Mac was
basically a Mac.
For exa mple, every Macintosh sold in the last six or seven years has a built-in
SCSI (small com puter systems interface) port, so anyone who wants to use a
CD-ROM d rive could buy a SCSI model and plug it in, and then d rag a few
ex tensions to the System folder so t he Mac could recognize the new d rive.
Then, restart the Mac, and you are in business.
All Macs since the very first one introduced in 1984 have had a graphical
interface and quality sound built in, too. Basic Mac sound is m uch superior to
the tinny speaker most IBM PC users find in thei r stock machines. The 256color displays required to view mul timedia CO-ROMs are the on ly feature
needed for mul timedia that is actually optional. So, a "standard" colo r
Macintosh is pretty much CO-ROM-ready, and man y of these machines are
being sold with a CD-ROM drive built in .

Macintosh Multimedia Hardware
Requirements
As you can see, external drives are very easy to add to a Macintosh system
(C D-ROM drives are even available as battery-powered units for PowcrBooks)
but they may also be mounted interna lly in some models. Your drive supplier
ca n sell you a replacement face plate, if required, to accommodate the internal drive. Some Macs with a built-in CD-ROM drive can even start up from a
CD, if it's one made especially for that Mac (that is, it has compatible system
software and appropriate enabler). That's a slow option, of course, but a valuable one if you someday find your start-up hard disk has died.
You'll need to add a few extensions to you r System folder to make your Mac
recognize your CD-ROM d rive, provide audio CD capabilities, and use all
your software. The High Sierra Access, IS0-9660 Access, and Audio CD Access

Macintosh Multimedia Hardware Requirements
extensio ns should be furnished with your drive. You'll also need Foreign File
Access to be able to recognize files on PC-oriented CO-ROMs. Other multimedia-oriented extensions will be installed by software requiring them: you
may need to update you r QuickTime or Sound Manager extensio ns to use the
latest CD-ROMs, fo r exam ple.
CD-ROM d rives come with a Con t ro l Panel that could be used to enable or
disable the supplied caching softwa re with any drive on your system- not
just with t he CD-ROM d rive. You may also wa nt accessories li ke Voyager's
CD Aud io Toolkit, wh ich lets you access audio CDs from within HyperCard
stacks.

Sound Considerations
CD-ROM software often has sou nd, and all Macs have good-q uality sound
built in, wh ich can be m ade better by plugging external spea kers in to the jack
on t he back o f the unit. That may be all you need fo r multimedia use. You
can, however, pu rchase add-on sou nd ca rds for NuBus-equipped Macs if you
need mo re sophisticated sound capabili ties. Most of us don't need that much
quality unless we're doing high-end audio production.
Later Macs also have sou nd record ing capabilities built in, and some are even
furnished with a micropho ne. I purchased a cheap microphone fo r my
Quadra, and get good eno ugh quali ty. Some models, such as th e lamented AV
Macs and the new PowerMaci ntoshes in AV d ress, record CO-quality sound
with no additional hardware, using th e Sound co ntrol panel.

Do I Need an Internal or External CD-ROM drive?
As noted above, Macintosh owners can pu rchase CD-ROM d rives as internal
units mou nted in the same case as their CPU, video card, and disk drives, or
as an external unit that is co nnected to the mai n computer wit h a cable.
Whi ch is best for you? There are adva ntages to each type of drive:
• Internal drives are less expensive. You're not paying fo r a case o r power
su pply with an internal drive-just the bare drive itself and an inexpensive ribbon cable to co nn ect it to t he interface. An ex ternal d rive will
cost $60-$100 more.
• Interna l drives are "cleaner." That is, you don't have extra power, data,
and audio cables trailing around. Everything is inside yo ur computer.
• In ternal drives don't take up any add itional desktop space.
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• Internal drives move with your computer-and don't move without it.
Having an internal drive means you have one less thing to unplug and
move when you relocate your system, which can be quite often for
those who cart their computers around to perform demos. It also means
it's more difficult for an unethical person to run off with your CD-ROM
drive without taking the whole com puter. A compact drive may fit
inside a briefcase, but an entire system won't.
• External drives are easier to install. Just plug and play.
• External drives don't use up a precious drive bay in your computer,
which may be important if you have a Mac with limited internal space.
• External drives can be used with more than one computer, if each has
its own interface. Just unplug the drive, plug into the n ew system, and
then restart or reboot. A single CD-ROM drive can be used with multiple computers in a pinch-or regularly if you must save money.

Double-, Triple-, Quad-Speed Drives, Changers, and
Towers
Your choices of CD-ROM drives has grown significantly in the past year.
Nobody should really consider a single-speed drive. But can you safely purchase a double-speed unit with the triple- and quad-speed drives coming on
the market? And what about these multi-CO units you see advertised?
For most people, a double-speed drive will be the prudent choice through
1995, unless the prices on the faster units drop sharply. I paid $169 for the
last double-speed drive I purchased: would it have been worthwhile to spend
twice as much for a triple-speed unit?
No. In fact, it might have made more sense to buy two double-speed drives
for the price of one triple-speed unit, and thereby have twice as many discs
online at one time. If I used both discs equally, I could probably make up for
the slower transfer rate by the time I'd save not swapping CD-ROM discs
constantly.
If you really want to use more than on e disc freq uently, investigate the sixdisc changers from Pioneer and others. These units still have only one CDROM reader inside, but can switch internally from one disc to another very
quickly. Each phantom drive is addressed by a different drive letter, so you
can access multiple discs quickly and easily. Since the $1000 changers are
often quad-speed units, once the disc you wa nt is mounted, access is that
much faster.
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There are also CD-ROM "towers" containing four to eight or mo re CD-ROM
drives. Each drive is accessed by a d ifferen t drive letter, so you can quickly
run o ut of alphabet if you have several con nected to your computer. They are
m ost often required by network users and electronic bulletin board system s
(BBSs) that must make diffe rent CO-ROMs available to multiple users, sim ultaneously.
CD-ROM drives mo unted in individ ual computers can also be shared over a
network. If each Mac on the net has its own CD-ROM drive, it's like having
three or four CD-ROM drives in one computer.

Caddies or No Caddies?
The first CD-ROM drive fo r the Macintosh used caddies. Today, you can purchase drives th at do n' t use them . Are they inconvenient? Not necessarily:
they may provide more convenience. If your CD-ROM drive uses caddies,
you'll want to buy a separate caddy fo r each CD you use frequently, o r perhaps all the COs you own if you don' t have a large collection . Then, you'll
find it mo re convenient to use these COs; instead of o pen ing the jewel box,
sliding open a drawer, dro pping in the d isc, closing th e door (and using the
reverse process to unmoun t the disc), you just grab the caddy you want, and
:slip it in the drive. I love caddies. People with child ren or clumsy coworkers
love caddies; they protect the d isc fro m fumble-fingers. In truth, CD-ROM
caddies are o nly inconvenient for those who have zillio ns of CO-ROMs and
not eno ugh cadd ies; people who pay $9.95 each fo r cadd ies instead of $3.50
or less (some stores sell them fo r full price, wh ile others sell the exact same
caddies at a heavy discou nt), or those who must share CO-ROMs amo ng different types of drives.
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If you looked at the software best-seller lists, you'd think that th e o nly CO-

ROMs ava ilable for purchase are ga mes and encyclo pedias. However, those
two categories are o nly the tip of the iceberg. There's a large market for games
because Macintosh users are constantly looking fo r new thrills, and an o ld
gam e must be replaced with a new one at frequent intervals. CD-ROM games
for the Mac sell by the truckloads.
At the o pposite end of the turn over spectrum are multimedia en cyclopedias
and reference works. Each Mac owner probably needs o nly one of these per
type, but vendors are still able to sell these fo r $75 and up-much more than
th e average price of most CO-ROMs. Moreover, every ho me and business user
can benefit from an encycloped ia, so the ma rket is vast.
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In reality, there are nine other major categories of discs available for the Mac,
each importa n t in its own way. The following sections will look at each of
them in turn, with a desc ription of a few of the key CDs available. But first,
let me list the key types of discs for your review:
• Business
• Reference
• Education
• Children's Movies/Multimedia
• Games
• Music
• General Interest
• Graphics
• Shareware
• Applications
There is a 12th category of CD-RO~ software, the so-called "adult" CD-ROM
(although I imagine it is purchased al most exclusively by men). While these
sell extremely well, l won't bother to describe the leading entries in the category. In one sense, t hey don't really qua lify as computer software, since the
fact that the material is avai lable on CD-ROM is only an incidental facto r in
its appeal.
Instead, we'll look at the true computer-oriented offerings in more detail.

Business
Business CO-ROMs are those you can use in you r work, apa rt fro m those
containing specific applications. These are often business reference works,
packed with data that can be used for marketing. Others can improve your
business skills, or help you operate your computer more efficiently.
Some typical entries in this category include:
• Wilson Learning Interactive Series. These discs use exercises,
simulations, videos, and self tests to help you meet business challenges.
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Titles in the series include Connect for Success, Decide for Sure, Relate
wi th Ease, and Keep Your Cool. More than just self-improvement discs,
the Wilson series helps you move up the ladder more efficiently.

• Great Business jokes. Here's a quirky entry, but one worth looking
at. This disc presents more than 175 business jokes in QuickTime movies that use professional stand-up comics. You've never h ea rd of any of
these comedians, but, better yet, you haven't hea rd all the jokes either!
We found some clever new nuggets sprinkled in among a few golden
oldies. Business people can spice up their speeches with gems like, "Our
CFO is so cheap, he sends his voice-mail postage due!" Or, "Oh, the
product isn't delayed .. it just doesn't match the description on the packaging yet." Figure 24.1 shows the product in action.
Fig. 24.1
The comics aren't
nationally-known,
but neither are the
gags on Great
Business jokes.

• PhoneDisc USA. Why let you r fingers do the walking when your computer does the job much better? The Residential, Business, and Reverse
directories aren't cheap, but is that Information o perator so helpful
when you're looking for Fred Q. Schwartzmiller, Inc.-somewhere o n
the West Coast? Or if all you need are some addresses, and don't even
care about the phone numbers? PhoneDisc USA is fast. It doesn't wai t
for you to finish typing in a name; as you key in the first few letters, the
program races ahead to Jist the first name meeting the parameters entered so far. The disc is updated quarterly, and you' ll want to keep current to avoid too many wrong numbers, but PhoneDisc is a valuable
add ition to any business library.

Reference
Reference works are what CO-ROMs are all about; one compact disc containing everything you need to know, with all the facts, figu res, maps, and o ther
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data, for a specific area of knowledge. Encyclopedias are very popular, especially since Microsoft raised the ante by porting its popular Encarta offering
over to the Macintosh.
Amidst all the multimedia offerings, yo u'll sti ll find a few text-heavy works.
The reference category is a little more forgiving of m ul timedia weakness than
others, because all we really need are the facts. Some top discs to look for in
this category include:
• Microsoft Bookshelf. If you can only find room for one reference
CD-ROM among your collectio n of games or personal interest discs, this
is the one you should have. The seven printed volumes converted to
CD-ROM format for this disc include: The American Heritage Dictionary, Second College Edition, Bartlett's Familiar Quotations, Fifteenth
Edition, The Concise Colu mbia Dictionary of Quotations has 6,000
additio nal quotes of more recent derivation; The Concise Columbia
Encyclopedia, Second Edition, covers 15,000 topics with text, images,
and an imation; the Hammond Atlas has low-detail, but still useful maps
of continents, countries, and US. States, accompanied by flag images,
audio clips of natio na l anthems, and pronunciations of key geographic
names; Roget's II Electronic Thesaurus contains brief synonyms and
antonym lists for a collection of key terms; The Wo rld Almanac and
Book of Facts includes statistics, facts, zip codes, and trivia.
• Microsoft Encarta. If Microsoft Encarta is any indicator of the byproducts we can expect fro m Bill Gates' quest for Total World Domination, Chai rman Bill can dominate my world anytime. Simply put,
Encarta is nothing like any encyclopedia you've ever worked withelectroni c or o therwise-starting with its name. Everything about
Encarta seem s specifically included to dazzle you, from the moment
you open th e slick packaging and view the lush fu ll-color manuals to
that first moment when the impressive splash ex plodes on your screen.
Sure, it's manipulative, but Encarta makes you love being toyed with.
Encarta includes eight hours of audio (itself pretty impressive on a CDROM that could ho ld o nly 75 minutes of d igital audio). In addition to
the pervasive narration, there's 200 natural animal and bird sounds,
words and phrases in 60 foreign languages, and 1500 pro nunciations of
geograph ic place names alo ne.
• Grolier's Multimedia Encyclopedia. This disc contains the complete text of Grolier's 21-volume Academic American Encyclopedia,
comprising nearly 33,000 articles. You'll also find 8000 new o r updated
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articles which reflect the latest developments in the world of politics,
entertainment, and other areas. The program has eleven key sections,
which each let you access the available database of information in different ways. You'll find a title list if you care to search through article
titles in alphabetical order (much like a conventional encyclopedia).
There's a word search function, too, which rapidly scans through the
built-in index to locate all articles that meet criteria you type in. Because of the thoroughness of ils articles, this encyclopedia is a top
choice for older students.

Education
I've lumped into the Education category a vast range of discs that cover every
subject taught in primary and secondary school, as well as college. These
range from language study courses like Applied Optical's Language Discovery
to Queue's Origins of the Constitution . Nearly every discipline is wellrepresented on the Macintosh, because of the popularity of this platform in
schools.
• Let's Visit France. On the surface, Let's Visit France (and companion
COs that cover Mexico, South America, and Spain) bears a stri ki ng resemblance to one of those film strips you sat through in French II while
your teacher sneaked off to the lounge for a quick break. A pleasant
voice provides interesting commentary as a parade of postcard-perfect
still color photos marches across the screen. Dig a little deeper, and
you' ll find that this disc has significant advantages over either videotapes or film strips. Let's Visit France can be used by a single student or
a group, without the need for a teacher to supervise operation of a VCR
or film-strip projector. The student can select English or French narration, add helpful on-screen subtitles, and stop the show at any time to
review a scene, jump to another part of the presentation, or get additional information from the index. (See fig. 24.2.)
• San Diego Zoo Presents: The Animals. What a great disc! SanDiego Zoo's The Animals is still as fresh and interesting as the latest multimedia extravaganza on the market. A Jive-action tour through the exhibits of one of the world's premier zoos, this disc has everything you'd
expect from a first-rate CD-ROM: stunning video clips on an amazing
range of topics, thousands of photographs and pages of info rmation on
animals and their habitats, and hours of audio narration . The core of
this disc centers around the animal "exhibits," which can be accessed
from a graphical main menu that resembles a three-dimensional map of
the zoo itself. Your mouse can wander up and down paths leading to
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habitat types (tropical rain forest, savanna, grasslands, mounta ins, etc.)
o r oth er zoo centers of in terest (research center, library, nursery, tours,
stories, or kid's area). Click on that portion of the main map, and you're
insta ntl y transported to a new area to explore.

Fig. 24.2
Let's Visit France
offers a tour or the

country in both
French and

English.

• Shakespeare on Disc. If you think of Shakespeare as some dead guy
they tried to fo rce you to read in 11th grade li terature class, you'll proba bly want to skip t his review. We're n o t passing judgment here; th e old
Bard is tough going for some, and reading thi ngs you like (instead of
Shakespeare) is infin itely better than not reading at all. But, if you love
great literature, el ra ma, or history, you' ll be interested in Sh akespeare:
The Com plete Works of William Shakespeare, wh et her or not you happen to be a serious student of Stratford-On-Avon's most famous dramatist. You can get all this in paperback at about the same price, of course.
W hat makes the CD-ROM version of Shakespeare so valuable is the
remarkable access you have to his words, using the DiscPassage character-based interface. You can search by p hrase, subj ect, or ti tle to find a
specific passage you're interested in. Or, you ca n browse thro ugh all the
works at leisure using the same parameters, looking for something in teresting that you might not have known was the re.
• Sleeping Beauty. One of a series of d iscs from Ebook, Inc., Sleeping
Bea u ty is a combination o f text, imagery, a li ttle a nimation, and sound
that ca rries the fai ry ta le genre into a new realm. That feeling of
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listening to a fam iliar story, told by a pleasant-voiced narrator, never
quite loses its appea l. There's a little childhood left in the o ldest person
and this CD catches and holds the attention. The Sleeping Beauty disc
lets you page through the text with mouse clicks. Icons on the pages
invoke sound files, o r audibly read the whole page. Pastel illustrations,
some an imated to a small degree, by Judith K. jones, who also retold
and narrated the text, appear on certain pages, greatly enhancing the
experience. The table of contents permits viewing the pictures or hearing the sound fi les independent of reading the text.
• Scary Poems f or Rotten Kids. This disc is a compilation of 14 poems sure to be appreciated by subteenagers who are engrossed with
gross things; always macabre, sometimes funny, spiced with a good
dose of ick, but never downbeat enough to induce n ightmares. Kids can
have the book read to them, or they can use the mouse to click on individual words, phrases, and objects in the illustrations. The poems are
engaging enough that children don' t seem to miss th e eye-catching
animation and underlying effects interactive books provide. Our test
children rolled on the floor throughout "Acid Rain," in which thena rrator describes a rain "that came down in heavy drops; it washed away
my shoes and socks; it washed the ha ir off from my head, it took my
ears, and then I turned red." Children under seven probably won't understa nd the "fake" horror in these poems, and while the excellent
illustrations aren't grisly, they are comic-book explicit, so you' ll wa n t to
steer preschoolers away from th is disc.

Movies/Multimedia
Television didn't really kill off motion pictures, as everyone predicted in the
ea rly 50s. And phonograp h records (or, aud io CDs today) d id n 't kill off radio
programming. Instead, TV created vast new markets for movie productions,
while giving us something to escape from when we did venture back to theaters. And radio and the recording industry complement each other nicely,
encouraging consumers to en joy both.
Today, ma n y ki nds of media happily co-exist. jurassic Park raked in $900
million in revenues at the box office worldwide is on its way to becoming the
most profitable movie ever. Yet, it's expected to reap another $1 billion after
its October 4, 1994 release o n home video. Can you imagine what a CD-ROM
based on th is hit would collect?
Movies are as much a part of our lives today as music has been for centuries.
Obviously, we love to watch fil ms and videos, and welcomed the change
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fro m small h o me screens with their fuzzy pictures in the 50s, to the large
"home theater" television sets of today. So, would you really be interested in
taking a step back to watch a film like it's a W onderful Life on your computer
monitor? Or, could you watch the Beatles' classic A Hard Day's Night in a tiny
window taking up only a couple inches of a Macintosh's screen ? The answer
is, yes-if something more were provided.
That's what CD-ROM technology gives you movie buffs: the capability to
combine full-motion video with immediate access to scripts, biographies, cast
lists, and other goodies. You get that with Voyager's version of A Hard Day's
Night. You get a great deal more with other movie-oriented discs, like
Microsoft Cinemania '94 o r Movie Select. These discs combine video clips with
m usic, movie reviews, trivia, and other bonuses that tell you everything you
want to know about a particular movie, star, director, o r studio.

• Microsoft Cinemania '94. This disc is a movie buff's dream! It combines reviews, biographies, filmographies, and summaries covering
thousands of movies, actors, directors, and producers with priceless film
clips. Included are Leonard Maltin's capsule reviews (a sentence or two)
of more than 19,000 movies from his Movie and Video Guide 1994;
more than 1200 insightful and detailed reviews from the always-superb
Roger Ebert, excerpted from his Video Companion 1994; brief reviews of
2500 films from Pauline Kael's 5001 Nights at the Movies; and Baseline's
detailed reviews of classic and recent films from The Motion Picture
Guide. There are also 4000 cast lists and biographies extracted from
Baseline's Encyclo pedia of Film and Ephraim Katz's Film Encyclopedia.
• The Honeymooners' Funniest Moments. jackie Gleason's Honeymooners skits (eventually expanded to half-hour "telefilms") are most
fondly remembered of all early television. Some 48 classic scenes fro m
70 "lost" episodes are brought to life o n this great CD-ROM, available in
a combined PC/Macintosh format. Also packed into the 400+ megabyte
disk are text articles o n The Honeymooners' series that include a comprehensive history of the show and helpful comments about the scenes,
along with the title and original air date of each clip. The CD-ROM
format gives you the power to review favorite clips over and over again,
for pure enjoyment or study (watch Gleason's eyes bug out when he
notices the burglar in his apartment-it's a classic "take"). The format
also m akes it possible to group like-scenes together so you can compare
and contrast comedy techniques without spending hours rewinding
and advancing videotapes. This disc is shown in figure 24.3
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Fig. 24.3
These arc some of
The Honeymooners' funniest
mom ents.

Games
Games arc the bigges t mon eymakers in the CD-ROM industry, so you'll find a
lot of effort put into developing flash y prod ucts that make the best usc of the
Macintosh 's sound and graphics capabilities. The list of top-sellers changes
almost weekly, but some leading con tenders at the time t his book was written
incl ude:

• Battle Chess. Battle Ch ess is o ne of many chess p rog rams on the market for Macintoshes. Why is it unique? The ma in d istinction that Battle
Ch ess has over its competitors is its graphic d epiction of anima ted comba t wh e n one piece captures a no th er. Why is this importa nt? For the
most part, it isn' t. Battle Ch ess has very slick animation, and by virtue
of the large amount of space o n the CD-ROM, a la rge am ount o f di gitized aud io . At one lime, such displays of ani mation virtuosity were of
themselves a reason to select a product. But an imation fo r its own sake
isn't enough anymore. The ga me of chess h as been played for hundreds
o f yea rs without an ima tio n , or com p uters for that mat ter. Wh ere a nimation might be used effectively is in interactive tuto ri als. Battle C hess
does have a tuto ri al, but the use of animatio n h ere too is less effective
then it might h ave been.
• Who Killed Sam Rupert"! Who killed Sam Rupert? With eight su spects, but only six (compressed) h ours to fi nd th e c ulprit, using only a
collection of interviews, an enterprising assista nt, a nd some fa irly
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nebulous clues, you wi ll probably exhaust the majority of the allo tted
time figuring out the answer to that question. Who Killed Sam Rupert is
an interactive, multimedia murder mystery in which you have the opportunity to act as detective in solving the murder of Sam Rupert, a
restau rant owner known for his famous wi nes. This game gives you the
opportunity to collect clues, observe live-action video questio ning of
suspects by your assistant (Lucy Fairwell), eval uate forensics results,
perform follow-up questioning of suspects, even check alibis, and eventuall y request a warrant fo r the arrest of your prime suspect.

• Lunicus. You've repaired an ancient alien device, and find it contains
videotapes of the Jurassic Era. Unfortunately, the device's owners have
been alerted and are coming back to reclaim their property. The Un ited
Nations' Moonbase Lunicus is the only hope for Earth's salvation ... and
you're in charge of the rescue!

Music
Music COs were once fairly rare, but are now becoming more numerous.
You' ll find a mixture of discs ranging from classical music (wit h in-depth
discussions of various pieces) to more pop-oriented CDs. The best on the
market include:

• Xplora 1 . Peter Gabriel's Secret World. The noted pop star is your
host as he takes you backstage at a concert, behind the scenes at the
Grammy Awards, and into the studio with him to mix a Top 10 single.
You get 140 minutes of video and audio and 100 full-colo r photographic images.
• A Hard Day's Night. Is this a music CD, a long-form music vid eo, or
just a movie? The Beatles' first fil m has been brought to the Macin tosh
on CD as all three, in a disc that was voted by MacUser magazine as the
#1 CD-ROM of all time! You can view the entire film in interactive
form, and see th e original script and two other short fi lms by t he director, Richard Lester. Also included is the movie's o riginal trailer.
• The Residents Freak Show. This disc by the San Francisco art music
group has spectacular an imatio n, encompassing both music, interactive
story-telling, and d igital art in o ne stun ning package.

General Interest
The General Interest category includes everything and anything, from looks
at o ur national parks, to discs devoted to U.S. and foreign travel. You'll find

An Overview of CD-ROM Software
CDs on parenting, and others that collect info rmation o n Yoga or wines of
the world. Amo ng the best:

• Mayo Clinic Family Health Book. Now you can take advantage of
Mayo Clinic wisdom in your own ho me through the comprehensive
family health guide on this CD-ROM. Within its hundred s of pages of
hypertext-linked information you'll find clues that alert you to medical
emergencies that should be attended to by a professio nal, comforting
descriptions o f treatmen ts and their follow-up, and a rich vein of basic
medical and healt h lore. Navigating t he easy-to-use Macintosh interface, you'll find more than SO video clips and animati ons th at shed
ligh t on complex health topics with well-narrated mini-presentatio ns.
The 400-plus fu ll-color still illustratio ns can be accessed almost instantly by clicking on ico ns embedded in the text. Over an hour of
audio narration adds extended verbal ca ptions to the photos, charts,
and drawings.
• Total Baseball. If your home (or mind) is full of baseball memorabilia, this package will be a we lcome add itio n to the clutter. Supplemented by more t han 600 photographs and 20 sound clips, Total Baseball contains enough articles and statistics, (some 2300 pages worth) to
satisfy even t he most die-hard baseball fa natic, and m ay help bring
order to your interest in this all-American pastime. The d rop-down
menus and search methods, although a bit cumbersome, open the door
to articles which are exceptio nally well-written , detailed, and fluid .
While perusing Total Baseball, the reader finds topical informatio n
sorted under a host of categories such as The History, Tile 100 Greatest
Players, Streaks and Feats, Tragedies and Shortened Careers, Scandals and
Controversies, and many more. Those looking to take advantage of a
CD-ROM for its sound features wi ll enjoy t he sound cli ps, twenty in all,
which include bites from Goose Goslin's 1935 World Series winning
hit, Don Larson's 1956 World Series perfect game, and Hank Aaron's
1974 71Sth home run.
• Kathy Smith's Fat Burning System. This is a hea lth and fitness
CD-ROM that lets you create your own tailored workout and d iet plan,
with information on nutri tion and exercise. It's billed as a "10-Week
Fat-Burning System."

Graphics
Graphics COs for the Macintosh are heavily concentrated in clip art for desktop publishing. You'll find EPS, PICT, and TIFF files available from a number
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of sources at reasonable prices. Don't forget to check out shareware discs,
which may have public domain images scanned from government publications, old books, or other sources. Some top-selling discs in this category
include:
• Pixar 128. This disc includes 128 different photographic quality textures in 512 x 512 pixel format, and can be used by Pixar Typestry,
Adobe Photoshop, or other graphics applications.
• Click Art from T /Maker Click Art. This clip-art pioneer offers a
wide variety of disks for the Macintosh, including Animals and Nature
(150 images), Artistry and Borders (375 varieties), and Sports and Games
(180 action-packed pictures).
• Metro Imagebase. You'll find 2000 high-quality images, covering
everything from business to borders on this disc, equally divided between 1000 EPS and 1000 TIFF images.
• Architectural Photofile. Available from Loggia, this disc has
bridges, churches, housing, industry, transit, and more.

Shareware
Shareware discs have to be among the best bargains of any CO-ROMs you can
buy. Most have from hundreds to thousands of ready-to-run applications,
fonts, utilities, clip art, and other files . Many are public domain or freeware,
while others are shareware you can try out for a specified period of time. If
you continue using the product after you've evaluated it, you should send a
small registration fee to the author, usually $5.00 to $30.00. Among the
standout discs we've seen:
• Shareware Breakthrough. Quantum Axcess produces some of the
best shareware discs on the market. They don't just throw shareware at
you and leave you hanging. The disc is furnished with a snazzy shell
that lets you browse through the offerings, read about the files in the
categories that most interest you, and then launch and run programs
for a test drive. This disc is shown in figure 24.4
• Wayzata's Best of Macintosh Shareware. This disc has a huge
number of fonts, graphics applications, games, personal productivity
programs, business software, and other programs that you can try before you buy.
• PowerTools for the Macintosh. This disc has Desk Accessories,
Education programs, graphics programs, £NITs, CDEVs, sounds, and a
variety of utilities.

An Overview of CD-ROM Software
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Fig. 24.4
Shareware
Breakthrough has
a great assortment
of try-before-youbuy software.

Applications
If I wanted to bet money on a growth market for the future, I'd sock everything I had into the prospects for CD-ROMs containing enhanced versions of
applications that had only been available on floppy disk before. Only a few
key products are available on CD-ROM at this time, but by early 1995 you
can expect the market leaders in virtually every category to go this route.
Adobe Photoshop and other Adobe products have led the way. It doesn't
make a lot of sense to review the applications you can get now on CD-ROM,
since they should be evaluated on the basis of how well they perform as applications, not how good they are as CO-ROMs. Look for Microsoft Office,
Quicken, Adobe's entire product line, and other key programs to go to CDROM soon . Other highlights:

• Strata Studio Pro. This high-end ($ 1500) 3D modeling and animation program is already furnished with a great CD-ROM that includes a
library of shapes you can use in your own projects.
• Adobe Photoshop. The CD-ROM edition of this leading image-editing software includes 5 Kai's Power Tools filters, SO high-resolution
stock photos, a Type on Call CD-ROM, Adobe Technical Notes, Expert
Tips, 150 digital images from Digital Art & Photography Show, and tryout versions of Adobe Dimensions, Adobe lllustrator, and Adobe Premiere software.
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Hot Tips for Getting the Most from
Your CD-ROM
• Make sure you've installed all the appropriate extensions to get the
most from your CD-ROM d rive: the Foreign File Access, High Sierra File
Access, ISO 9660 Access, and Audio CD Access extensions that came
with your CD-ROM drive probably were installed with the drive. If not,
find a copy and drag th~m to your System Folder.
•

Desktop publishers can save precious hard disk space by using cli p art
CD-ROMs. More than 600M of image files can be stored on a single
disc.

•

Look for "hybrid" CD-ROM d iscs that can be used o n both Macintosh
and IBM PC platforms. If your organi zation has both types of systems,
you can often get double-duty by using the same disc with Macs and
PCs both.

• Macintoshes are quite a bit mo re multimedia- and CD-ROM-friendly
than PCs. The drives can cost less and are easier to install, since you
don' t need a separate interface card.
• If you're installing an external drive, you don't even need to open the
Macintosh up. Indeed, all you may do is plug in the power cable, unplug a daisy-chain cable going from an external hard disk to any other
ex ternal devices in that particular SCSI chain, and plug it into the new
CD-ROM drive instead . Then connect the CD-ROM drive to the other
external device {hard d isk, scanner, etc.) with a second daisy-chain
cable, and make sure each has a d iffe rent SCSI ID from the other devices. (All can be set externally.) Then power up the Mac, drag a few
files from the supplied installation disk to your System file, and restart.
Presto! There is your CD-ROM drive.
• CD-ROMs are difficult to damage, but you should still treat them with
caution . Handle only by the edges, and avoid getting fingerprints on
the shiny su rface (opposite the label or printed side). If you do need to
clean a CD-ROM, always wipe with a soft cloth in a radial direction
(center to outside, for example), rather than in the same direction as
the disc's rotation: you'll red uce the chances of creating scratches along
one of the data " tracks."

Conclusions and Recommendations
• A PC equipped with a SCSI interface card that has an external port
can easily share an externa l CD-ROM drive with a Macin tosh. Simply
unplug the drive from th e Mac's daisy chain of devices, and connect to
the SCSI port of th e PC. The PC must have the necessary software required to recognize the CD-ROM drive, of course.
• If you have a small collection of CO-ROMs, you may want to purchase a
protective caddy for each. However, man y users just buy one caddy for
each of their frequently used discs, and purchase a few extras that are
shared by all their other discs.
• Don 't forget that caddies make a great way to "baby-proof" your Mac. I
keep all the d iscs that my four- and six-year-old children use frequently
in caddies. They've learned which end to insert in the d rive fi rst, so I
don't have to worry that they'll damage an expensive d isc with rough
handling-the d isc never leaves the caddy.
• If you have a CD-ROM drive, you also have a po tential ga teway to lowcost permanen t storage of large quantities of information: it's n ow relatively inexpensive to have custom CO-ROMs made especially for you. If
your business generates a large database of information that doesn't
change, but wh ich you'd like to have ava ilable (such as o ld accounting
records), many CD-ROM service bureaus can create a "custom" singlecopy CD-ROM for $100-$200. If you'd like to distribute copies of the
same data to multiple users in your oq;anization, you ca n get 100 duplicates fo r as little as $1500.

Conclusions and Recommendations
CD-ROM technology will bring you more powerfu l software, better gra phics,
entertainment, vital information, and improved educatio n, as costs for both
the drives and d iscs come down to a ridiculously low price. CO-ROMs will
not o nly become standard in the nea r future, they will become tile stan da rd,
by which every other Macintosh peripheral and program will be judged. The
key poin ts to keep in mind from th is chapter are:
CD-ROM drives are li kely to become standa rd equipment on the Maci ntosh
in the near futu re because of their simplicity, the enhanced applicatio ns they
make possible, and th e lower cost of distributing large volumes of software
and data files.

709

710

Chapter 24-Using CD-ROM Drives and Software
Macs now can be fitted with external o r internal CD-ROM d rives. External
units are easy to install-you just plug them into th e SCSI port of your Mac,
or, if you already have an external SCSI device, fit the CD-ROM dri ve into the
"daisy-chain" of devices. Internal drives are often furnished preinstalJed in
new computers, but can be added later. It's often best to have your computer
sto re handle the installatio n. Internal drives are less expensive and take up
Jess desk space, but are otherwise identical to the external versio ns.
A vari ety of CD-ROM formats are on the market. Some are intended o nly for
use with IBM-PCs, but there are also "hybrid" discs that can be used equally
well with a Macintosh o r a PC. Some special fo rmats, like Kodak Pho toCD,
have o ther features. PhotoCDs, for example, can sto re ro ughly 100 of your
own snapshots on a special disc provided by your pho tofin isher. Virtually all
CD-ROM drives sold today are "XA" compatible-mea ning they can handle
Pho toeD discs and some other newer formats.
One of the most exciting aspects of CD-ROM techno logy are the new multimedia applicatio ns, which combine still photos, video, sophisticated sound,
and other co mputerized features to give you a rich, involving, and interactive
experience. You'll find entire movies on CD-ROM, as well as encyclopedias
th at show you moving images, music, and sound effects alo ng with their tex t
articles.
The key software categories available fo r Macintosh CO-ROMs incl ude Business, Reference, Education, Children's Movies/Multimedia, Games, Music,
General Interest, Graphics, Shareware, and Applicati o ns. These can help you
in your work, schooling, hobbies-or just when you want to have a good
time.

Chapter 25

Utilities
by Carman Minarik

Utility software is a general term used to describe software packages which do

not fit neatly into a software category such as word processing or spreadsheets.
Various types of utility software are used for such functions as protecting
your Macintosh from viruses, recovering lost or damaged files, preventing
images from burning into the monitor screen, and compressing files to conserve disk space.
In this chapter, you learn about the following:
• Utilities that enhance your operating system
• File management utilities
• Utilities for graphic files
• File compression utilities
• Utility collections

System Enhancements
Many utilities are used to enhance or extend the functionality of the
Macintosh operating system. This type of utility is used to extend your
Macintosh's control over fonts, provide information regarding your hardware
and its operation, and so on.
The following sections provide information on several system enhancement
utilities.
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Suitcase
Suitcase, from Fifth Generation Systems, is a font management utility. It
allows you to group fonts into sets, and open or close font sets at any time.
Suitcase also allows you to use more fonts than the Macin tosh operating
system normally allows. J' or more information about fon ts, see Chapter 8,
"All About Fonts."
Under System 7.1, fo nts are stored in the Fonts folder in the System folder.
Any fonts stored in this folder are automatically loaded at startup time. Up to
128 fo nts or suitcases (groups of fonts), can be present in the Fonts folder.
This system works fine for relatively small numbers of fo nts or fon t suitcases.
Two problems become evident, however, as the n umber of installed fon ts
increases.
Note
Under operating system versions prior to System 7.1, fonts are stored in the system
file.

First, all the fonts and font suitcases present in the Fonts folder will automatically load at startup time. If the number of fonts is very large, this process can
take a considerable amoun t of time.
A second problem manifests itself when you are working with software. All
the fo nts in the Fonts folder are displayed on every font list or font menu in
every software application you use. This can be unwieldy, especially if you are
using many fonts. Even though you may use particular fon ts only rarely, they
will appear on all the fo nt lists all the ti me.
The Suitcase utility program addresses these problems by allowing you to
group fonts and font suitcases into sets. You then decide which sets are to be
opened at startup time. You can also open font sets at any time during use of
you r Macintosh, and close them again when you are finished with them. In
this way, fonts are available on the fo nt lists an d menus any time you need
them, but are not in the way when you don't.
Suitcase is an Extension, and as such must be located in the Extensions folder
inside the System folder to operate. When Sui tcase is installed and functioning, you will notice the Sui tcase choice available on the Apple menu.
When you select the Apple menu option Suitcase, the screen shown in figu re
25.1 appears.
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Th is screen allows you to complete the following tasks:
• Crea te, delete, o r rename fo nt sets
• Ad d fonts or font suitcases to sets
• Remove fonts or font suitcases from sets
• Open fo n t sets for use
• Close fon t sets to remove fonts from use
Note
Fo nts can be opened by the Macintosh operating system or by Suitcase, but they
should not be opened by both. That is, a fo nt present in the Fonts folder inside the
System folde r sho uld not be included in a Suitcase font set.

Suitcase provides add itional utilities fo r worki ng with desk accessories, FKey
and sound files, managing font conflicts, and compressing font and sound
files that are seldom used.

Adobe Type Manager
Adobe Type Ma nager (ATM) is a font utility that performs two basic functions. First, ATM allows non-Postscri pt prin ters to print Type 1 Postscript
fo nts. Second, ATM allows the Macintosh to d isplay accu rate Postscript fo nts
o n the mo nitor screen . For more info rmation about fo n ts, see Ch apter 8, "All
About Fonts."
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Fig. 25.1
This screen is used
to ereate font sets,
add fonts to sets,
and open sets fo r
use.
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Adobe Type Manager in effect makes the advantages of TrueType fon t technology available for Postscript fonts. Because a huge library of high quality
Type 1 Postscript fonts exists, this can be a tremendous advantage to you as
a Macintosh user.
ATM is made up of two parts: a Control Panel and a hardware driver. The
Control Panel is named -ATM, and must reside in the Control Panels folder
inside the System folder.
One specific hardware driver exists for Macintosh computers using the
Motorola 68000 processing chip, and another hardware driver exists fo r all
other Macintosh computers. Table 25 .1 describes the use of these drivers.

Table 25.1

ATM Hardware Drivers

Macintosh

Driver

Plus, SE, Classic

- ATM 68000

All others

-ATM 68020/030/040

The appropriate driver for your Macintosh should be located in the System
folder.
Once ATM is properly installed, it can be accessed like any other Control
Panel. Follow these steps:
1 . Open the Apple menu and choose Control Panels.
2. Choose -ATM from the resulting window, and the screen shown in

figure 25.2 opens.
Fig. 25.2
The Adobe Type
Manager screen
allows activation
or deactivation of
ATM.
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In addition to turning ATM on and off, this screen can be used to set the size
of the font cache. The larger the font cache, the faster ATM will be able to
image fonts on-screen.

Toner Tuner
Toner Tuner, from Working Software, Inc., is a print utility which allows you
to set the darkness level of printing on any inkjet or laser printer. This can
create substantial savings in ink or toner cartridge expenses over time. This is
especially true if you print many rough drafts of your documents, where the
print quali ty is not critical. For more information on printing, see Chapter
10, "The Printing Chapter."
The Toner Tuner extension adds new controls in the print dialog box for all
software applications. Figure 25.3 shows the print dialog from Canvas with
Toner Tuner installed.
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The controls added by Toner Tuner allow you to choose the percentage of
normal darkness to use when printing. The lower the percentage, the lighter
the print will be, and the less ink or toner will be used.

PopChar
PopChar, ava ilable free through most shareware distribution channels, is a
Control Panel utility which can display the entire character set for any selected fo nt. Most Macintosh fo nts contain many characters beyond the standard letters and nu mbers. These characters are normally accessed by pressing
a key combination . For example, to place a registered trademark symbol into
your document, you would press Option-R (in most fonts). PopChar eliminates the need to remember the key combinations by producing a table of
available characters from which to choose.
When PopChar is installed, a small icon is added o n the m enu bar. This icon
will be available fro m wi thin any software application. Point at the PopChar
icon and hold the mouse button to o pen the screen shown in figure 25.4.

Fig. 25.3
Toner Tu ner adds
an option bar to
the Print dialog in
all software
applications.
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Fig. 25.4
Use this pop-up
screen to choose
the characters you
want to use in
your document.
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Select the desired character from this screen, and it will be placed in your
document at the inserti on point locatio n.

SCSI Probe
SCSIProbe, available through shareware channels, allows you to view information about and activate any SCSI devices installed on your Macintosh.
SCSI stands for Sm all Computer System In terface, and is pronounced scuzzy.
It is a high-speed data transfer connection available on all Macintosh com-

puters. Up to seven devices can be attached in a SCSI chai n. That is, one SCSI
device can be attach ed to the Macintosh, a second SCSI device can be attached to the first, and so on. Typical SCSI devices include hard disk drives,
CD-ROM drives, tape backup drives, and scanners.
Part of a Macintosh computer's initial startup sequence includes checking the
SCSI port for any attached SCSI devices. If a device is not attach ed or is not
powered on at startup time, the Macintosh will n o t be aware of the device's
existence. Normally, the Macintosh does not check the SCSI port aga in until
th e n ext system startup.
The SCSIPro be utility is a Control Panel, and can be launched from the Control Panels folder. SCSIProbe will recheck the SCSI port fo r attached devices,
and display a screen similar to the o ne illustrated in figure 25.5.
Fig. 25.5
Use SCSIProbe to
identify and
mount SCSI
devices.
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This screen shows the device type, manufacturer, model number, and versio n
number fo r each installed SCSI device.
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If a device appears in the SCSIProbe list that is not currently available on
your Macintosh desktop, click the Mount button. SCSIProbe will mount the
device.

IV

SuperCiock!
SuperCiock! is a shareware Control Panel utility that places the current time
on the Menu Bar in all applications. SuperClock! also provides extensive user
control over the appeara nce and functionality of the clock.
Once installed, SuperClock! is accessed fro m the Control Panels folder. A
window will appear providing options for clock, timer, and alarm controls.
When you click the Clock option, a screen like the one in figure 25.6 appears.
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Fig. 25.6
Use this screen
to control the
func tion and
appearance of
SuperCiock!.
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Use this screen to choose the font and size for the clock information, whether
the seconds will be visible, and so on.
Figure 25.7 illustrates the function of SuperClock!, showing the Microsoft
Word Menu Bar with SuperClock! installed.
SuperClock! is included with System 7.5.
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TechTool
TechTool, from MicroMat Computer Systems, is a utility application which
performs the following three basic functions:
• TechTool provides in-depth system info rmation, including your
Macintosh 's date of manufacture and total hours of operatio n.

Fig. 25.7
SuperCiock! places
the current time in
t he Menu Bar.
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• TechTool resets the Parameter RAM of your Macintosh. The Parameter
RAM contains information such as the alert sound settings, desktop
patterns and colors, Macintosh name and network number, and so on.
Corrupted Parameter RAM settings can cause many problems which can
be corrected by resetting the Parameter RAM. This process is often refer red to as zapping the PRAM.
• TechTool thorough ly rebuilds the Desktop file on your Macintosh. The
Desktop file is an invisible file which contains icon and location information for the files on a disk. Damaged Desktop files can cause serious
problems, so the Desktop file should be rebuilt occasionally.
Note
Rebuilding the Desktop file and zapping the PRAM can both be accomplished
through key combinations built into the Macintosh operating system. Tech Tool,
however, will do a more thorough job than the operating system.

When TechTool is launched, the screen shown in figure 25.8 opens.
The ~y~tem information i~ immediately available. Click the appropriate buttons to zap the PRAM or rebuild the Desktop file.
Fig. 25.8
The Tech Tool
window displays
system information.

MacErrors
MacErrors, available free through shareware channels, is a database of common Macintosh error numbers. Whenever the Macintosh operating system
cannot complete a requested task, an error message is displayed in an alert
box. This error message often contains an error number. MacErrors will provide a corresponding description for each error number.
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Launch MacErrors, and the window shown in figure 25.9 opens.
Enter an error number in the Error box, and the corresponding error code
and description is displayed.
:u:JI:

MacErrors [

~
~

Fig. 25.9
Use the MacErrors
window to see
descriptions of
Macintosh errors.

Now Utilities
Now Utilities, from Now Software, Inc., is a collection of seven utilities designed to enhance the operation of your Macintosh. Now Utilities contains
the following components:
allows you to control the loading of Extensions, Control Panels, and startup items. It automatically disables Extensions that
crash, and helps keep conflicting Extensions separate. Startup Manager
allows you to choose which Extensions and Control Panels will load at
startup time.

•

Startup Manager

•

Super Boomerang is

•

NowMenus

•

WYSIWYG Menus causes fonts on a font menu in any application to be
displayed in their own typefaces.

•

NowSave automatically

•

Now Scrapbook

•

Now Profile provides

an enhancement added to the directory dialog box in
all applications. It keeps track of the most recently used files and folders
and makes them available as a list within the Open dialogs, and also on
the Apple menu.
allows the Apple menu to cascade for up to five levels of
submenus. NowMenus also allows you to change the order of appearance of Apple menu items, and allows you to change the menu font.

saves your work in any application at specified
intervals. You can set it up to save based on elapsed time, number of
keystrokes, or number of mouse clicks.

allows you to create catalogs of graphics, text, sounds,
and QuickTime movies. Items in these catalogs can be easily retrieved
into your documents.

a detailed report on your Macintosh system configuration. This can be extremely helpful when you are trying to isolate
a problem with your system performance.
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NowMenus is built into System 7.5.

File Management
The Macintosh Finder provides an easy-to-use, intuitive interface for managing your files. It may not provide every capability you might wish for however, and some processes may not work exactly th e way you want them to.
That's where file management utilities come in. For more information about
file management, see Chapter 7, "Organizing Your Files, Folders, and Disks."
File management utilities allow you to do things such as recover lost or damaged fi les, optimize you r disk performance, open files more easily, and copy
files more quickly. The following sectio ns describe some of the commonly
used file management utilities.

Norton Utilities
Norton Utilities, fro m Symantec Corporation , is perhaps the most wellknown file and disk recovery software ava ilable. With Norton Utilities, you
will be able to repair floppy clisks and hard disks, and retrieve data which
otherwise would be lost.
When you launch Norton Utilities, the screen shown in figure 25.10 appears.
Fig. 25.10

The Nort on Utilities

The main Norton
Utilities screen
provides access to
the major Norton
Utilities functions.
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This screen provides access to the ma jo r Norton Utilities fu nctions:

• Norton Disk Doctor. This function diagnoses and repairs most disk problems. Descri ptive screens appear, providing information on the nature
of each identified problem and advice on h ow to proceed.
• Unerase. This fea ture allows you to recover files that have been moved
to the Trash, even after the trash has been em ptied.
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Volume Recover. This option allows recovery of files from disks that cannot be repaired with Norton Disk Doctor.

• Speed Disk. This is a disk optimization program which will speed disk

access by defragmenting files on the disk.
• Norton Backup. This option allows you to backup the contents of your

hard disk to floppy disks.
Norton Utilities also provides additional capabilities, such as th e following:
• Password protection for your files
• The ability to divide large hard disks into separate partitions
• File deletion which cannot be recovered (for confidential information)
• A disk access indicator for your monitor
• Fast floppy disk duplication

MacTools
MacTools, from Central Point Software, provides file and disk recovery, as
well as other utility functions. Like Norton Utilities, the central purpose of
MacTools is recovery of lost data. Figure 25.11 illustrates th e MacTools screen
as the software analyzes and repairs a disk.

Disk Structure
Disk Conten ts
Ulrus/ Malntenance
Fragmentation

0

"""
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In addition to disk repair, MacTools provides the following utility functions:
• Recovery of deleted files
• Virus protection
• Hard disk backup to floppy disks

Fig. 25.11
The MacTools
screen displays
information
regarding the disk
being checked.
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• Fast floppy disk duplication
• Disk access indicator for your monitor
• File defragmentation
• File repair capability for Microsoft Word and Microsoft Excel
documents

Disk First Aid
Disk First Aid is a disk repair utility included with the Macintosh operating
system. It lacks the sophistication of Norton Utilities or MacTools but can be
very effective for repairing damaged disks.

Macintosh users who are experienced in disk and file recovery recommend
that for maximum protection against lost data you should have all three of
these utilities (Disk First Aid, MacTools, and Norton Utilities) available. Each
of these applications has strengths and weaknesses, and problems that one
package cannot begin to diagnose may be easily repaired by one of the other
two.
Disk First Aid is included with System 7.5.

Mr. File
Mr. File, from Softways, is a file management utility which provides the capability to copy, move, find, rename, and delete files in the background. This
allows you to use your Macintosh for other functions without waiting for
these file management tasks to be completed.
Mr. File takes the form of a Desk Accessory under System 6, and an Apple
Menu Item under System 7. The utility is therefore always available on the
Apple menu. Choose the Apple menu option Mr. File, and the window
shown in figure 25. 12 opens.
This window displays many of Mr. File's central capabilities, such as the
following:
• Copy files and folders
• Find files and folders
• Move files and folders
• Erase files and folders

System Enhancements
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Fig. 25.12
The Mr. File folder
window allows
you to view, copy,
rename, move,
and erase files in
the background.

These tasks are all completed in the background. That is, you will retain control of your Macintosh and can work on other jobs while these tasks are being
completed.
Mr. File allows you to have as many task windows open at one time as you
need. You can, for example, copy three folders, rename two others, and erase
five files all at the same time, using separate windows.
Mr. File also provides the following additiona l capabilities:
• Create lists of items, even from llifferent folders, to view or launch
• Launch applications from folder or list windows
• Format or erase disks more quickly than the Finder
• View file details such as file type and creator

DART
DART (Data Archive/Retrieval Tool) is available from Apple Computer. Its
purpose is to archive floppy disk images. Archiving of floppy disk images
with DART h as the following two primary benefits:
• The disk image is compressed so that the disk information can be stored
in less space.
• The disk can be duplicated more quickly and more accurately than by
using the Finder's disk copy routine.
When the DART application is launched, the screen shown in figure 25.13
opens.
If you are creating a disk archive, the source will be a floppy disk and the
destination will be a DART file. The floppy disk will be copied to the DART
file and compressed, significantly reducing the disk space required.
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Fig. 25.13
Use the DART
screen to choose
a source and a
destination for the
copy procedure.
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If you are creating a floppy disk copy, the source will be a DART file and the
destination will be a floppy disk. The file will be decompressed and copied to
the floppy disk. The information will also be verified as it is copied, using a
more stringent verification process than that employed by the Finder. You
also have options to forma t the floppy disks as they are being copied onto,
and to make multiple floppy disk copies from the DART file.

Graphics
Graphics utilities allow you to manipulate picture and video files on your
Macintosh. Such utilities might be used to play QuickTime movies, ca pture
screen images as graphic files, or set a complex pattern or picture as your
desktop background.

VisuaiCiips
VisualClips, from Sound Source Unlimited, is a QuickTime playback utility
packaged with a collection of high quality QuickTime movies. The utility is
called VideoBeep and takes the form of a Control Panel.
VideoBeep allows you to assign QuickTime movies for playback when specified system events occur. For example, you can assign one movie to play
when the Trash is emptied, and a different movie to play when a disk is inserted.
Choosing the VideoBeep Control Panel will open the wi ndow shown in
figure 25.14.
In addition to assigning the movie for each system event, this screen provides
controls for the location of the video window and the sound volume setting.
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Fig. 2 5.14
Use the Video Beep
screen to assign
Qu ickTime movies
to system events.
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When VideoBeep is set up, you will be treated to entertaining video clips as
you work with your Macintosh. Whenever a particular system event occurs,
the associated QuickTime movie will play automatically.

Capture
Capture is a screen-capture utility manufactured by Mainstay. It allows you to
save parts of the currently visible screen or the entire screen as a graphic file.
This graphic file can then be printed, or opened an d manipulated in a program such as Canvas or Illustrator.
Capture is a Control Panel, and as such must be located in the Control Panels
folder in the System folder. Opening the Capture Control Panel will produce
a window as shown in figure 25.15.

Cop t ure:

Formot:
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All Scr eens

PICT file
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...-1
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This screen allows you to do the following:
• Select a key combination to perform a screen capture
• Select a folder to store the graphic files in
• Choose to capture all screens, the main screen, or a part of the screen
you select

Fig. 25.1 5
The Capture
window allows
you to choose
what will be
captured, the file
format it will be
captured in, and so
on.
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• Choose to save the resulting graphic file to the clipboard, as a PICT file,
as a TIFF file, or as a MacPaint file
• Auto matically reduce the screen image
• Delay the capture for a specified period of time
With Capture installed, you need only press the designated key combination
to capture the screen image to the clipboard o r a file.
If you choose to capture a selection, your mouse pointer changes shape when
the key combination is pressed. You can then drag around the portion of the
screen you want to capture.

Desktop Textures
The Desktop Textures utility, available as shareware, allows you to choose
from a va riety of interesting desktop background patterns. These patterns
will be much more complex than those which can be created through use of
the General Controls Control Panel. For more information, see Chapter 12,
"Creating and Modifying Icons."
When the Texture Installer application is launched, the window shown in
figure 25. 16 appears.
Fig 25.16
Usc the Texture
Installer window
to view and install
textures.

This window is used to select the desired desktop pattern fro m the collectio n
of textures.
The Desktop Textures package also comes with an application called Texture
Randomizer which can be placed in the Startup Items folder. This program
will automatically choose a rando m texture each time the Macintosh is
started up.

Compression
File compression utilities reduce the amount of disk space required to store
files. This is possible because most computer files contain significant amounts

Compression
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of repeated information. That is, in order to be usable, many computer files
are actually larger than they need to be. Compression utilities remove the
repeated information in a fil e, and store the file much more efficiently.

Note
Compressed files are not usable in their compressed form. They must be decompressed before use. Therefore, if you plan to use compression utilities as a means to
move large files from one Macintosh to another, be sure that the compression utility
is available on both computers.

DiskDoubler
DiskDoubler is a file compression utility from Fifth Generation Systems. It
will compress files or folders, reducing their size to as little as SOo/o of original.
The DiskDoubler application can compress and expand items using the
screen shown in figure 25. 17.
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(compress ...] ( EHpond ... )
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Quit

As items are being compressed or expanded, compression statistics are displayed on this screen.
DiskDoubler is also available as a desk accessory or Apple Menu item, so it
can be accessed at any time regardless of the software currently in use.
DiskDoubler will automatically expand any compressed file which is opened,
either from the Finder o r from within an applicatio n . When the file is closed,
DiskDoubler will automatically compress the file again.

Auto Doubler
AutoDoubler is also from Fifth Generation Systems and uses the same type of
file compression system as DiskDoubler. AutoDoubler, however, does not
compress individually selected files or folders. Instead, AutoDoubler automatically compresses all the files on your disk.

Fig. 25.17
Use this screen
to select files
or folders
to compress
or expand.

728

Chapter 25-Utilities
The file compression takes place in the background, so any time your
Macintosh is not processing information, AutoDoubler automatically begins
compressing files. Any fi le that is o pened, either from the Finder or within
any application, will automatically be decompressed.
AutoDoubler is a Control Panel, and must be located in the Control Panels
folder inside the System folder. You can select files and folders to exclude
from automatic compression so that items such as your system fi les and frequently used applicatio ns wi ll always remain uncompressed.

TimesTwo
TimesTwo, from Golden Triangle Computers, is not technically a file compression utility. It is actually a disk driver that replaces the driver supplied by
Apple. The TimesTwo driver is designed to arrange information on the disk in
such a way that repeated information within a file is automatically compressed.
Because TimesTwo is a device-level driver, the chances of incompatibilities
with software and system extensions, an occasional problem with compression utilities, is greatly reduced.
TimesTwo will roughly double the usable size of your hard disk. The disk will
actually report larger amounts of remaining disk space in the Finder windows. Files on the disk wi ll show their actual sizes in the Finder.
As with all file compression techniques, increased disk storage capacity is
achieved at the expense of speed. Disks using TimesTwo will provide slower
access times than identical disks not set up with TimesTwo.

Screen Savers
The purpose of a screen saver utility is to red uce the chance that an image
wi ll be "burned into" your monitor screen if your Macintosh is left running
unattended for extended periods. Screen saver utilities achieve this purpose
by placing moving images on the screen, thus preventing a static image from
burning in. For more informatio n, see Chapter 12, "Creati ng and Modifying
Icons."

After Dark
After Dark from Berkeley Systems is probably the best known of the screen
saver utilities. The After Dark package consists of two parts: the After Dark
Control Panel and the After Dark Files folder. The Control Panel is installed
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in the Control Panels folder inside the System folder, and the After Dark Files
folder is installed in the System folder.

IV

When the After Dark Control Panel is opened, the window shown in figure
25.18 appears.
Fig. 25.18

Use the After Dark
Control Panel to
select the image
for use as a screen
saver.

This screen is used to choose the desired image for the screen saver, and to
set such options as the volume for any associated sound files which will be
played as part of the screen saver.
Once After Dark is installed, the screen saver image will be activated automatically when the system has been idle for the specified period of time.
After Dark provides controls for length of idle time, starting the screen saver
immediately, and preventing the screen saver from starting. You can even
add password protection for your Macintosh as part of After Dark's functionality.
Many screen saver images are available for use with After Dark, including Star
Trek, Marvel Comics, and Walt Disney collections.

Virus Protection
Computer software code created for the sole purpose of disrupting the functionality of your Macintosh is called a virus. Viruses range from relatively
harmless amusements to incredibly destructive programs which cause permanent data loss.
Viruses are created by individuals and hidden in the programming code of
other software. As the legitimate files are copied from one computer to another, the virus is spread as well. Most viruses are designed to automatically
copy themselves onto any computer they come in contact with.
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Virus protection software is designed to identify virus programs, and protect
your Macintosh from them .

Symantec AntiVirus
Symantec AntiVirus for Macintosh (SAM) is manufactured by Symantec Corporation. It is one of the most comprehensive virus prevention, detection,
and removal utilities available for your Macintosh.
SAM is made up of two components: SAM Intercept and SAM Virus Clin ic.
SAM Intercept is a Control Panel, and works in th e background to prevent a
virus from infecting your Macintosh. It scans automatically for known viruses, and monitors your system for suspicious activity that might indicate
the presence of a virus. SAM Virus Clinic is an application which thoroughly
inspects your files and disks for evidence of virus activity, and provides the
capability to remove many viruses once they are discovered.
SAM provides an extraordinary level of control over the virus protection process. The screen illustrated in figure 25.19 shows some of SAM's options.
Fig. 25.19
The SAM Intercept
scan controls
provide many
options relating
to the virus scan
process.
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SAM Intercept provides options for automatically scanning flo ppy disks for
viruses when they are inserted, scanning the system and desktop files automatically when the Macintosh is started or shut down, and automatically
scanning system activity for any suspicious actions.
SAM Virus Clinic provides extensive capabilities for identifying files or disks
infected with any of the known viruses. When a virus is identified, SAM is
usually able to remove the virus and its effects from the infected file or disk.

From Here...

Disinfectant
Disinfectant is a virus prevention utility distributed free of change by Northwestern University. This utility is available through most shareware channels.
Disinfectant operates as an applicatio n for scanning and repairing disks and
files, and also as an extension for automatically moni toring your system for
virus activity.
Disinfectant differs fro m most commercial vi rus protection packages in that it
does not scan for viruses at specific times such as when a floppy d isk is inserted. Instead, it monitors d isk and fi le activity fo r the ind icatio ns of a virus
attack. When such indications occur, Disinfectant o perates to preven t the
virus from becoming active. As a result of this approach, Disinfectant ra rely
causes any problems such as conflicts with software or system extensio ns.

From Here ...
In this chapter, you explo red some of the many utility packages ava ilable for
your Macintosh. You reviewed both commercial software and free programs
that can add functionality and enjoyment to your Macintosh experience.
• For more information on Extensions and Control Panels, see Chapter 5,
"Understanding the Desktop and Finder."
• See Chapter 8, "All About Fonts," for more information on fo n ts and
font use.
• For more information on printing with your Macintosh, see Chapter 10,
"The Printing Chapter."
• See Chapter 11, "Changing the Look of Your Desktop," for add itional
information on customizing the look of your desktop.

731

Chapter 26

Personal and Business
Mana gem eAt~---.\
by Mark Bilbo

Computers and business have gone hand in hand fo r many yea rs now. One
of the fi rst applications of the com puter was in managing com pany fina nces.
Before the invention of the personal com puter, however, only large corpo rations could afford to purchase, use, and maintain computers. Today, even the
smallest one-person business not o nly can afford but needs a computer.
At first, the Macintosh was not widely accepted as a business machi ne. Today,
however, an enormous vari ety of powerful business software is ava ilable for
the Macintosh- fro m ho me finance applications to full business accounting
and management software.
Alo ng with the standard, mo re fa miliar categories of personal finance, business finance, income tax, and project planning, a new category has arisen
and "heated up" in recen t times. This new category is called Personal Information Management. Softwa re included in this category ranges from programs
that enable you to create calendars and schedules with reminders (by using
Time and Schedule M mwgers) to high powered, computerized versio ns of the
old Rolodex (by using Contact M anagers).
Many packages are o n the market that can help you manage your personal or
business affairs. This chapter highl ights some of the more popular software in
the following categories:
• Personal f-inance Ma nagem ent
• Business Manage ment
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• Income Tax Planning and Filing
• Project Planning
• Personal Information Management

Personal Finance
One of the early successes of the Macintosh was personal finance management software. Although not the first such package, the Dollars and Sense
program by Monogram software was one of the early attempts to bring
double-entry accounting down to a personal level and enable average
Macintosh owners to keep track of their finances.
Although Dollars and Sense faded in the late '80s (more because of poor management by the owner rather than the quality of the softwa re), the vacuum
was quickly filled by Quicken, which has now become the dominant personal
finance program not only on the Macintosh but in the DOS and Windows
world as well.
Quicken is not without competition. Andrew Tobias's Managing Your Money
is also a popular personal finance program.
Other more specialized programs also exist that can help you plan your investments, manage your mortgage, and handle you r estate.

Quicken
Quicken first appeared as a small check-writing program. The program's biggest asset was its ease of use and simplicity. Over the yea rs, Quicken's steadily
increasing power lead to its current dominance in the personal and small
business finance category. Intuit, Quicken's publisher, has consistently
brought more power to the program while maintaining the ease of use that
has characterized Quicken.
At Quicken's heart is the orginaJ check-writing function. This function is one
of the features that makes Quicken familiar and easy to use. Figure 26.1
shows a check written with Quicken.
Checks written in Quicken look pretty much just like the checks in your
checkbook-you don't have to learn a whole new way of doing things.
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Fig. 26.1
Writing a check
with Quicken.
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What is different between handwritten checks and using Quicken to record
checks is the use of categories. In Quicken, categories are the dividing up of
your expenses and income sources in ways that enable you to track where
your mo ney is going.
For example, a check to the light company belongs in the category
Utilities:Gas & Electric. The amount of each check you write to the light company is added up so that at any time you can see how much m oney you are
spending on the electricity in your home (see fig. 26.2).
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Not o nly does Quicken provide predefined sets of categories, but you can
m odify these sets and even create your own categories to suit your personal
needs.

Fig. 26.2
Categorizing a
utility payment.
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Quicken also enables you to set up classes to further subdivide your paym ents
in useful ways. Small business users, for example, might have classes to track
employee sales or pro ject specific expenses.
Quicken goes beyond simply managing your checking account. You can also
track credit card, cash, liability, portfolio, and money market accounts (see
fig. 26.3).

Fig. 26.3
Creating an
account to
track your Visa
card.
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Each account-including your checking account-has a register into which
you enter transactions that reflect your purchases and payments (see
fig. 26.4).
Fig. 26.4
A charge for
gasoline is entered
in the Visa
register.
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Quicken tracks each account's balance, recording your transactio ns and its
effect o n your finances. In the case of credit card accounts, you even see the
remaining balance on the card to help you avoid charging over your limit.
Quicken enables you to enter budgets fo r each income and expense account
(see fig. 26.5).
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Fig. 26.5
Creating a
Quicken budget.
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One of the powerful fea tu res of a personal finance program in general and
Quicken in specific is budgeting. Quicken enables you to track your finances
aga inst the budget you enter with graphs and reports to watch your budget
progress (see fig. 26.6).
Bu~

Fig. 26.6
Checking the
monthly budget.
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Tip
For faster transaction entry,
take advantage
of Quicken's
Memorize feature.

Quicken offers a wide variety of reports and graphs. Business reports such as
payroll, accounts receivable and payable, balance sheet, and others are offered in addition to the personal finance reports such as net worth, budget,
tax schedule, and so o n.
Quicken works with programs such as MaclnTax for tax reporting and planning. Use the Tax Schedule Personal Finance report to export tax info rmation
in a format that can be read by tax reporting software. Using Quicken together with a tax reporting program saves you a great deal of time when April
15th comes around. For more info rmation on tax software, see "Income Tax
Planning and Filing" later in this chapter.
Quicken also interfaces with CheckFree, the electronic bill payment service.
CheckFree is an independent company that handles payment requests, transmits Electronic Funds Transfers (EFTs), or mails laser printed checks to your
payees. With this service (which costs about $10 per month plus transaction
charges), you can almost eliminate printed and handwritten checks.
Intuit also offers the Quicken Visa card with electronic statements downloaded over modem or sent to you on disk. Reconciling your Quicken Visa
can then be done quickly through the program.
At about $49, Quicken is a bargain. And if you shop around, you can many
times find Quicken bundled with other software packages, such as MaclnTax,
and save even more money. The program's ease of use combined with the
power it offers has made Quicken the leading personal and small business
finance manager. You can't go wrong with this one.

Managing Your Money
Tip
After you set up
graphs and
reports in a
manner that is
useful to you,
you can use the
Memorize
feature to store
the customized
report for later
access.

Andrew Tobias' Managing Your Money (MYM), published by Meca, is also a
popular personal finance manager, altho ugh the program is often more difficult to use than Quicken .
Like Quicken, MYM imitates the checkbook in appearance and in the methods you employ to enter transactions (see fig. 26.7).
Like Quicken, MYM tracks the amounts of transactio ns. Instead of using categories, however, MYM records everything in accounts.
Although MYM offers registers for accounts, you cannot directly enter transactio ns into the registers. You also cannot edit transacti ons while in the register, which you can do with Quicken. When you double-click a transaction in
the register, however, the Write Checks screen appears in edit mode (refer to
fig. 26.7).
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Fig. 26.7
Entering a check
with Mananging
Your Money.
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MYM simplifies some tasks by enabling you to set up a transaction as recurring. You can even add a reminder to alert you when a transaction is due to
occur (see fig. 26.8).
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Fig. 26.8
Adding a recurring
transaction.
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You can record a transaction as recurring in the Write Checks screen by clicking the Save As Recurring button. Later, you can invoke recurring transactions singly or in groups (see fig. 26.9).
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Fig. 26.9
Selecting a group
of transactions to
enter at once.
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MYM enables you to set budgets for each account. Instead of displaying all
the accounts at once, MYM requires you to set a budget in a separate window
fo r each account (see fig. 26.1 0).

•

Fig. 26.10
Setting a Clothing
account budget.
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Your budgets can be compared against your actual spending through the
Analyze Budgets vs. Actuals report provided by MYM (see fig. 26. 11).
Fig. 26.11
Comparing actual
expenditures
versus a budget.
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MYM provides a large num ber of reports, including tax forms filled out based
o n your MYM accoun ts, transaction reports, and planning reports (such as
amortization schedules, budget reports, and so on). Many of the reports also
can be graphed (see fig. 26. 12).
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Fig. 26.12
Graphing the
assets that
contribute to your
net worth .

A fea ture of MYM worth noting is the tax planning p rovided in the program .
When you create your accounts, you ca n link the accoun ts to the appropriate
lines in the tax forms. When you enter tran sactions throughout the year, you
ca n check on your progress (see fig. 26. 13).
Fig. 26.13
The 1040 fo rm in
MYM can help you
plan your income
taxes.
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MYM can display the 1040 fo rm, sc hedules A through F, and SE complete
with the am ounts from your transactions.

IV

742

Chapter 26-Personal and Business Management
Overall, Managing Your Money can be a difficult program to use. Before
Quicken's recent upgrade, MYM had some features that gave the program
something of an edge in power and might have made putting up with the
program's obstinate behavior and dozens of cluttered screens worth putting
up with.
MYM also seems to attempt to do too much in one program. For example,
reminders are provided to alert you to appointments you need to keep. There
doesn't seem to be much reason to include such a feature in a finance management program. A number of schedule-keeping programs are available, as
described later in this chapter.
Quicken is by far the easier program to use and has as much power as MYM,
especially now that Quicken 4.0 has added portfolio management. Your best
bet now would be to go with the winner.

Will Maker
Creating a will used to mean a trip to the lawyer's office and attendant fees.
In recent years, however, more people have begun to create their own wills,
often using paralegal assistance or books.
Now your Macintosh can help and save you a great deal of time and money.
WillMaker 5 by Nolo Press uses an interview format, asking you the necessary
questions and stepping you through the process of creating a will. State specific laws are addressed, and you can update your will at any time.
Included in the latest release are living will and final arrangements modules.
For about S40, WillMaker 5 is far less expensive than a trip to the attorney's
office.
Related to will-making and home finance, Nolo's Living Trust program,
which sells for about $45, can help you set up a living trust that avoids probate costs and delays (good in every state except Louisiana).
Nolo Press also has Personal RecordKeeper that can help you organize your
finances and your estate by tracking important legal, personal, and financial
records. The $30 program tracks your credit card numbers, household inventory, securities, and other important information. Exporting to Quicken is
supported to help you track your net worth.

Wealth Builder
For more serious investment planning, the investment and planning modules
of Quicken and Managing Your Money may not be sufficient. WealthBuilder,

Business Finance and Management
a program devoted solely to applying a widely accepted investment plan to
your personal finances, can help in this area.
This $60 program ca n even connect by modem to obtai n q uotes on securities,
obtain m arket b riefs, price h istory information, and more, although this service requires an additional monthly fee.
WealthBuilder does more than simply track your investmen ts; it also helps
you to strategize and plan. If your investments arc significant enough to
require that you spend time overseeing them and making plans, you may
want to consider bringing in your Macintosh to help.

Market Analyzer Plus
If you play the stock ma rket, you may want to consider software direct from
Dow ] ones. Market Ana lyzer Plus interfaces on-line with the Dow ]ones

News/Retri eval service to access up to fifteen years of price and volume history. You are able to chart the information and apply several statistical
ana lyses.
The p rogram is not cheap, costing about $225 but the serious investor will
wa n t to consider this p roduct ca refully.

Business Finance and Management
The Macintosh had an uphill climb being accepted in the business world. For
some years, the Mac was considered a novelty or a "niche" machine-useful
in a limited way in o nly certain areas. In time, however, solid business software began to appear. Combined with the ease of use of the Macintosh user
interface, the Mac is now often regarded as an ideal business computer. The
expenses of training are far less on the Mac t han in t he DOS and Windows
world. And labor is far more expensive than any computer or software.
So many business o riented packages are avai lable today that the Mac user has
almost an embarrassment of riches. Accounting packages, business forms
programs, sales forecasting software, asset management, and a grea t many
other business related packages are available. This section surveys the available softwa re.

Accounting
Accounting is a task well-suited for turning over to a computer. Keeping track
of a company's finances is an important task and computers are less prone to
math errors than human beings.
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Additionally, the quick reporting of an accounting package can reduce headaches greatly by providing fast, up-to-date information on a company's financial position.
MYOB
Mind Your Own Business is a name that initially might be difficult to take
seriously, but MYOB has become the top Macintosh accounting programprimarily due to its ease of use. At the same time, MYOB has full general ledger, checkbook management, A/Rand A/P, and a wealth of reports.

Recent upgrades have added CD-ROM on-line help (obviously you will need a
CD-ROM drive to take advantage of this feature), an easier startup procedure,
recurring transactions for frequently produced invoices, and other featu res to
help the small business user take full advantage of the program.
Best! Ware sells the package for about $100 list, but you can find MYOB for
about $60 if you shop around. A version that includes a payroll module sells
for about $50 more.
Home and small business users will want to consider this package to manage
their business finances.

Peachtree Accounting
Small business users may be interested in the Peachtree offerings. Peachtree
Accounting has won awards and been praised for being easy to learn and easy
to use.
The program offers unlimited (actually limited only by your available hard
disk space) numbers of accounts, customers, transactions, employees, and so
on instead of setting limits that could cause trouble when your business
grows.
The standard accounting modules are offered, including general ledger, A/R
and A/P, job costing, inventory, purchase orders, budgeting, and more. You
can also create custom business forms.
The around $120 package is compatible with System 7 features such as Publish and Subscribe, core Apple events, and Balloon help.
Peachtree also offers Insight Accounting, which formerly was a series of separate programs sold as the Insight Expert Accounting System. Peachtree integrates the programs into a single package and enables the user to install them
separately or as an integrated system.

Business Finance and Management
Insight offers reports that are meant to aid you with more expert advice to
interpret and analyze your data and to spot problems and trends in advance.
The program sells for about $300.
MacP&L

Start Accounting offers a full, serious accounting pack.age for larger businesses. MacP&L, which sells for around $190, has over 100 standard reports
and has more accounting modules than just about any other package. Check
writing, A/Rand A/P, inventory, payroll, project revenue, general ledger,
expense tracking, invoicing, and more are fully integrated. MacP&L is fully
System 7 savvy and works with AppleScript.
A multiuser version is offered that works over AppleTalk. The $380 package
allows three users with more user optional capacity available by upgrade.
Multlledger and CheckMark Payroll

CheckMark offers an accounting system for larger businesses. MultiLedger
handles AIR, A/P, G/L, inventory, and other necessary accounting functions.
The single user version sells for about $230 and a five user multi-user version
is about $400.
MultiLedger also has payroll capabilities with CheckMark Payroll, which can
handle accrued vacation, sick leave, retirement savings plans, government
forms, and other important payroll issues. Tax tables can be changed within
the program or updates can be ordered. The $170 program can be used alone
or in conjunction with MultiLedger or MYOB.
Tlmesllps Ill

Freelance professionals need a way to track their time and process billing for
clients. Timeslips III offers a TS Timer desk accessory that accumulates the
information as you work. Then TS Report will generate invoices and reports
to aid you in your billing and record keeping. The $200 program is offered by
Timeslips Corp.
Timeslips II can be extended with TAL Timeslips Accounting link to generate
customized income reports and link to accounting software. Accounting Link
sells for about $60.
ShopKeeper Plus

For the retail store owner, ShopKeeper offers the ShopKeeper Plus package
geared towards the management of a retail store. This package is something a
video store owner or convenience store owner might consider.
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The $320 package handles five different types of customer records and th e
same number of different inventory models. Bar code, order entry, cash
drawer control, customer billi ng and vendor ordering (including automatic
ordering), trade-ins, refunds, discounts (by item or customer), promotionals,
and other retail features are provided.
ShopKeeper Plus also in terfaces with different Macintosh gen eral ledger accounting packages to make managing your store's finances easier.

The Palo Alto Software Business Tools
Palo Alto offers some unique tools that the business owner may want to consider. The Toolkits use interview techniques and organized methodologies to
aid you in creating business and marketing plans, make sales and marketing
forecasts, busi ness budgets, and employee handbooks. All of the packages sell
for about $75 with the exception of the Employee Handbook Toolkit which
runs about $10 less.
•

Business Plan Toolkit uses the interview technique to guide you through
financial and business charts, cash flow, profit and loss, and other important business consideration s. The software can help teach business
planning. It would be worthwhile to home or small business users who
are just entering the business world.

•

Marketing Plan Toolkit helps you plan marketing strategy, including
gathering information, focusing on your market, developing tactics,
projecting forecasts, and creating budgets. The program then helps you
analyze results.

•

Business Budgeting Toolkit is geared for the manager who needs to create
and plan budgets, including accounting for tactics, strategies, tracking,
follow through, and other approaches to keep your department or business on track financially.

•

Employee Handbook Toolkit is meant to help th ose who need to create

comprehensive employee handbooks. Rather than start from scratch
and re-invent the wheel, you can use this document on disk to create a
full employee handbook q uickly.

Informed Foundation
If your business is large enough to need fo rms, you will appreciate having a
form system such as Informed Foundation by Shana Corporatio n. This $245
package is aimed at large companies with networks who can benefit from
transferring their paper forms to the Macintosh.

Income Tax Planni ng and Filing
The package enables users to fill out, sign, distribute, route, create, edit, and
format forms. Time taken to fill out forms can be reduced by automatic calculations and error checking. Links can be established to databases and accounting packages. Digital signatures can be attached with PowerTalk.

GraceLAN Asset Manager
A business with computer assets to manage and a network with many
Macintoshes may consider Tech Works' GraceLAN Asset Manager program
(about $500). The asset tracking database is aimed primarily at the individual
responsible for maintaining and tracking computer hardware, software, and
controling maintenance schedules.
Full information about hardware and software can be stored, including user,
location, serial numbers, purchase and warranty information, and so on. The
program will perform software version audits over a network to enable the
network manager to keep users current. One interesting feature is Asset
Manager's capability to import electronic versions of vendor catalogs to update information on available products.

Income Tax Planning and Filing
April 15th is a date few people find pleasant. However, there are some steps
you can take to at least make tax day less stressful. The first step is to maintain financial records with a personal finance package such as Quicken (see
Personal Finance Mangement earlier in this chapter). With a personal finance
manager, you can accumulate tax information throughout the year leaving
you with only the task of reporting the information when tax time comes
around.
With income tax software, you can further simplify the process by having the
software link your financial information to the appropriate forms and even
laser print the forms ready to sign. The home business user-having to fill
out a number of complicated IRS forms- will certainly want to consider automating this process.

MaclnTax 1040 and MaclnTax State
The leading tax software package is MaclnTax by ChipSoft. MaclnTax 1040 is
updated each year to reflect changes in the tax code. MacinTax 1040 imports
information from personal finance programs such as Quicken and fills the tax
forms out for you. If you plan ahead and create your Quicken categories with
tax day in mind, you will have to do very little editing.
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MaclnTax 1040 performs those complex IRS calculations for you. It helps you
avoid math errors (which are easy to make with those convoluted tax fo rm
instructions) and can flag errors and potential problems. The $40 package can
save you much more than the price by helping you avoid hiring someone to
do you r taxes.
ChipSoft also offers th e $25 MaclnTax state, supporting 20 states with income taxes. The program takes information from your federal tax fo rms and
fills out your state forms for you.
To save even more money, watch for MaclnTax/Quicken bundles. At the time
of this writing, the two programs together were being offered fo r about $50
from va rious sources.

MaclnTax Tax Planner and Tax Savings Guide
ChipSoft offers two helpful packages to aid you in preparing fo r tax time. The
Tax Savings Guide offers tips and suggestions on how you can lower your tax
bill. The MaclnTax Planner is a software package that enables you to create
"what if" scenarios to check o n th e effectiveness of different strategies to
lower your tax bill. The Savings Guide sells for about $15 and the Planner for
about $20.

Project Planning
Businesses of all sizes need to plan their projects carefully, creating schedules,
maintaining goals, and tracking progress. Software is available for the
Macintosh to aid you in your planning endeavors.
The available software ranges from the large Microsoft Project, wh ich can
manage large projects even over networks, to unique tools such as Inspiration
and ldeafisher, which help you "brainstorm."

Microsoft Project*
The $450 Microsoft Project is aimed at th e medium to larger businesses. With
this program, you accumulate all of a project's information and then present
it in formats such as PERT, GANTT, or spreadsheet. You can employ an
outliner to simplify (or collapse) an outlined form so that you see the overall
picture.
Microsoft Project offers useful features common to Microsoft programs such
as a custom izable toolbar to give you one-click access to frequently used

Project Planning
commands. The program is networkable and can even share files with the
Windows version of the program.

MacProject Pro
Claris Corporation is known for creating useful but easy-to-use software.
MacProject Pro, which sells fo r about $400, continues this tradition. Schedules, budgets, personnel, resources, and other project-related information can
be entered and managed easily. The program spots schedule and resource
conflicts. MacProject Pro includes scripting to automate common tasks and
one click access to frequently used commands through a floating palette.
Data can be shared with the Windows version, and you can create lin ks to
programs such as the Filemaker Pro database and the Claris Resolve spreadsheet program. (Claris is also known for doing an excellent job in integrating
its application software.)

ManagePro
For the manager, Avantos offers Man agePro. The $250 package is aimed at
aiding the manager organize, set goals, work with people, delegate, and track
progress. Three tool sets are offered: Goal, People, and Action .
Information is entered through a spreadsheet like interface, ManagePro creates to do lists, goal lists, status boards, time lines, calendars, and reports.
The program has been well-received-the Windows version has even won
awards.

Inspiration*
Inspiration is an interesting offering from Inspiration Software. The $170
program helps you bra instorm by enabling you to create flow charts, write
outlines, develop the flow of a process, lay out a project, and much mo re.
Inspiration displays your work in both graphical and outline form.
With Inspiration, you can brainstorm to develop your project and then use
the presentation tools to create a presentation to present your work.

Idea fisher*
IdeaFisher is one of the more unique offerings in the planning software
arena. The $100 tool features a large database with associative connections
and problem solving questions. The program is rather large, taking up some
7MB of disk space.
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IdeaFisher is meant to help you speculate and consider ideas by making suggestions and associations. ldeaFisher can be used to generate ideas for articles,
proposals, advertising, marketing, products, even names. Of course, you do
the thinking, but ldeaFisher makes suggestions and associations you might
not have come up with on your own or ones that might suggest new lines of
creativity.
You can also create your own idea library and add questions to the database.
IdeaFisher Systems also offers the Business and Grant Proposals Module. This
$70 module is an add-on that works with IdeaFisher to help you deal with
proposals both for business and grants. Questions are presented to hel p you
think of angles you may not have considered, assist critical thinking about
the proposal, even help you avoid cliche terms and choose more effective
wording.

TopDown Flowchart
Flowcharting is a common need in business to plan and layout a process.
TopDown Flowchart by Kaetron Software Corporation is intended to help
you create flowcharts quickly and easily. It includes 110 predefined symbols.
You can also create your own symbols. Connecting lines are automatically
made as you add symbols and intelligently reroute when you rearrange or
resize symbols. Symbols automatically resize to fit the text you enter in them.
You can also double-click to create nested levels in the flowchart. The package sells for about $200, and a multi-user pack is available.

FlowChart and OrgChart Express
Kaetron offers a small, simpler flowcharting program called FlowChart Express for about $100. This package is intended for the user who needs to
create basic flowcharts quickly.
For the person in charge of a company's organization charts, OrgChart Express for $120 can help by enabling the creation of orgcharts in a matter of
minutes. The program enables quick and easy shuffling around of people and
positions and offers automatic aligning. Database information can be imported to create orgcharts automatically and many formatting and styling
features are offered to enhance the orgchart's appearance.

Personal Information Management
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The Personal Information Management (PJM) category has arisen only recently. Essentially, the category is a collection of personal management tools
and could be considered the electronic version of the well-known Day Timer.
Two broad subcategories within the PIM category are time and schedule managers-calendars and appointment reminders, and contact managers. These
programs maintain your mailing and phone lists, replacing the old Rolodex.

Time and Schedule Managers
Having the Macintosh keep your schedule is a perfect job for a computer.
Computers rarely "forget" (they usually "forget" only when the hard drive
goes belly up) and if you work at your Mac everyday, having the computer
pop up and remind you of appointments automatically is an ideal computer
function.
Now Up-To-Date

My personal favorite in the time-management area is Now Software's Now
Up-To-Date. The $70 program centers on a calendar that has features consistent with the Macintosh interface-double-click on a day in the calendar, and
that day's schedule window appears (see fig. 26.14).
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Now Up-To-Date supports seven event types, including appointment, to-do,
holiday, and banner. Events can be categorized. You can also customize the
categories and create category sets. Priorities can be set and customized.
Schedule recurring events easily with daily, monthly, weekly, and o ther combinations of occurrences, including a customizable recurrance.
Four different calendar views are offered, including year, month, week, and
multiday (see fig. 26.15).

Fig. 26.15
Viewing the
week's schedule.
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Now Up-To-Date is very much a Macintosh program. It allows you to doubleclick days, drag events around the calendar, and change m eeting times by
dragging. You use the Mac actions you expect to encounter.
The Reminder extension is included to in terface with your calendar and provide a menu clock and reminders in the menu bar or in dialogs.
Up-To-Date works over networks for businesses that need to share schedules.
You can set Up-To-Date to automatically access servers and update to and
from the server to keep everybody posted about your schedule, view their
schedules, and set meetings with times broadcasted to other users.
First Things First Proactive
I've always liked the First Things First (FTF) approach of the floating calendar
icon that hovers over your desktop and puts your schedule only a doubleclick away.

Personal Information Management
This $100 Visionary Software package has been upgraded to do more than
just act as a calendar program. It includes outlining capabilities, multiple
calendar views, and reminders. Networking is supported fo r offices that need
everyone to be aware of each other's schedules.
With FfF, you can create plans by outlining and then drag them to the calendar to quickly set your schedule. Documents and applications can be
launched from the calendar or through the pop-up reminders.
In Control

In Control by Attain is an $85 package that takes the outline approach to
organizing your schedule. You respond to questions about when and what
needs to be done to outline your tasks. You can then prioritize, sort, and
categorize project tasks. Then the integrated calendar helps you keep track of
when tasks need to be done.
Reminders are offered to alert you to approaching appointments and deadlines, and scripting is included for automating In Control functions. You can
also link to other software or print to popular paper organizers.
DateBook Pro

Aldus offers DateBook Pro, a time-management program for about $50 that
combines a calendar, schedule, to-do listing, and alarms. You can view your
schedule in various ways, including the standard year, month, week, day
formats, but also in text, time bar, and Gantt chart formats.
With DateBook Pro, you can customize calendars by using icons and banners.
You can print wall charts and schedules. Printing in Daytimer as well as other
popular organizer formats is supported.
lnfoDepot

InfoDepot by Chena Software is a unique product in the PIM arena. Information is collected in a custom table. You then can view the information in
various ways. You add scheduling with the built-in calendar or time lin e, and
use date- and time-calculation for mulas to compute sch edule dates. Searching
and sorting are provided to help you sift through information , and custom
layouts enable you to focus on specific information. Connections to other
documents can be created, and AppleScript is supported for automating tasks.
The $200 package is more powerful than the average scheduling/organizi ng
PIM but incorporates similar features. Overall, the program is more a powerfu l database-like package that also aids you in creating your schedule as you
organize your project information.
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Contact Managers
"It's not what you know but who you know" is an oft repeated cliche which
is not strictly true. However, who you know is a critical issue in business.
Managing your contacts, keeping mailing lists, and maintaining address
books has become more difficult in a rapidly changing business world. Recently, the category of Contact Managers has arisen as more programs are
produced to aid you in this area of business life.
Contact managers can come to your aid by maintaining databases of contacts
(names, phone numbers, addresses, and similar information), enabli ng you to
quickly find the right person to call.
Now Contact

Now Software recently entered the contact manager category with Now Contact. The $70 package offers Now's ease of use applied to contact management. Names, numbers, and addresses can be easily entered and then accessed quickly in a variety of customizable for mats.
Now Contact offers a built-in word processor to enable you to quickly create
form letters, labels, an d envelopes. QuickContact enables you to access your
contacts while in other programs.
Touchbase Pro

Aldus offers Touchbase Pro for about $50. The Touchbase Pro database enables you to maintain lists of contacts with multiple notes, alternate phone
numbers, custom text, and check boxes. Pop-up menus speed data entry.
Searching and sorting helps you locate specific contacts quickly. You can use
the built-in letter processor to create form letters and envelopes or export to
your word processor.
ACT!

The bestselling contact manager is from Symantec for about $170. ACT! not
only enables you to create a database of contacts but to manage schedules, do
mail merge for form letters and envelopes, and create custom reports. ACT!
has fully customizeable fields and a history log.
Although ACT! is powerful, the program's price is steep. Admittedly, the combined power of managing schedules and contacts makes this program a worthy contender for the executive (or executive secretary). The average user may
want to consider a less expensive package, however.

From Here...

Conclusions and Recommendations
A great number of packages are available in these categories, and it seems that
everyday new ones are released. Recommendations are not easily made. Personal experience suggests that you consider the following programs, however.
In the Personal Finance category, Quicken is the most widely used package
and for good reason. The program is easy to set up and use, and will quickly
have you managing your personal or even small business finances with
greater ease. Quicken is rapidly becoming one of those can't-live-without packages.
In business accounting, MYOB has a similar ease of use reputation. And ease
of use is a top priority to my mind when choosing a program that will be
used to manage your finances. A program that is difficult to use can create
headaches as errors are introduced and corrected with difficulty.
MaclnTax has been around the longest in the tax software category. You
would do well with this one. Combined with a good personal finance program (such as Quicken), MaclnTax can help alleviate many headaches at tax
time.
Claris Corporation is one of my favorite Macintosh software companies. They
have a reputation of creating easy to use, Mac-like software. MacProject Pro is
a good choice in the project planning category.
In the area of Personal Information Management, I prefer Now Software's
programs. Now Up-To-Date and Now Contact are well-written programs that
have many helpful features. You won't go wrong with Now Software.

From Here ...
From here, consider the following chapters for information regarding other
business-related software:
• Chapter 16 discusses word processing packages. Many contact managers
enable you to export names and addresses to create mailing lists. The
mail merge feature of word processors can help you create and print the
form letters.
• Chapter 17 discusses presentation graph ics. If you are going to be doing
scheduling, planning, and financial management, you are probably also
going to be presenting you r work to others. This chapter shows you
software geared towards creating presentations.

755

756

Chapter 26-Personal and Business Management
• Chapter 18 covers sp readsheets. A business user will also want a good
spreadsheet program to create custo m form ulas and layouts to work
with th e info rmation accumulated by fi nance management prog rams.
This chapter shows you what is ava ilable.

Chapter 27

Games and Edwcation
by Dave Busch

Among its many distinctions, the Macintosh was the first computer sold with
a game built into its system software. Puzzle, the simple sliding-numbers
game installed as a Desk Accessory on the early 1984-edition Macintoshes, is
still present in System 7.1 in modified form (see fig. 27 .1). That's your first
clue that games, education, and Macs were made for each other.
Indeed, the first Mac manual's inviting full-color photos of bicycle-riding
college students toting Macs around campus in overgrown camera bags set a
tone for the platform that Apple has ironically been fighting to overcome
ever since. Today, the Macintosh may mean business, but it's been at home
with games and educational software (the distinction is often a fine line) for
more than a decade.
Fig. 27.1
Puzzle is a Desk
Accessory game
that has been
furnished with
every Macintosh
sold si nce 1984.

It's easy to see why the Mac was especially friendly to games and education
software-many of its innovations are essential for these kinds of programs.
The key types of business applications-word processors, spreadsheets, and
databases-can function perfectly well (although on a rudimentary level)
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without graphics, sound, or color (a nd actually did fo r a decade in the PC
world!). A mouse, buttons, and dialog boxes are useful luxuries when you're
developing a spreadsheet but hardly a necessity. But try to imagine a game or
educational program without these features!
Without the Macintosh and later systems that copied its features, we'd still be
playing boring old text-based Adventure games or learning Spanish from
screen after screen of multiple choice quizzes. For many people, the programs
in this category are just as impo rtant as word processors are in the business
community.
After all, ga mes and education software perform key roles in our lives. Everyone likes to take a break from the tedium of work now and then, and a wellwritten game can be more relaxing, and challenging, than the best television
show or a potboiler novel. As lo ng as you m ix computer games with other
types of entertainment (sports, movies, ho bbies, and so on), a session with
The 7th Guest can be fun, healthful, and an excellent way to stretch your
mind a bit.
Educational programs, on the other hand, are designed to exercise your mental muscles. Many, such as Hyperglot's L eam To Speak Spanish (shown in fig.
27.2) are pure teaching/ training programs. The student runs through d rills,
memorization exercises, practice sessions, and a series of tests unti l the material is mastered. Other educational software combines gam e elements, such as
W here in the World Is Carmen Sandiego? This kind of software may be designed
for child ren as young as three, who can learn colors and shapes, to adults
who want to master a foreign language.

Fig. 27.2
Leam To Speak
Spanisll is a pure

teaching/train ing

program.

What Is Out There
This chapter looks at some of the leading games and educational software,
and explains how well it fulfills your need for fun, entertainment, and learning. There are quite a few programs worthy of mention, so the discussions are
a little less detailed in terms of "how to" than in some of the other chapters
in this book. I'll still describe system requirements where appropriate and
give you a feeling for how the program works. Software packages reviewed in
this chapter include the following:
•

Just Grandma and Me and Putt-Putt Goes To The Moon

•

KidPix, Four Footed Friends, and Busytown

•

Leam to Speak Spanish

•

Black American History: Slavery to Civil Rights

•

Where in the World is Carmen Sandiego?

•

Oregon Trail and Treasure MathStonn

•

SimCity 2000 and The 7th Guest

•

Lemmings, Railroad Tycoon, and Populous

What Is Out There
There is a great deal of overlap among the programs profiled in this chapter,
but in general, Macintosh game and educational software fall into one of
three categories:
•

Children's Software. I've listed this as a separate category, because these

programs, aimed at the very young, often have very low-key educational goals. Some programs, such as KidPix, provide young Mac users
with a fun time and, perhaps, a little practice using the mouse and
menus. Others, such as Just Grandma and Me, can be used on two levels.
Smaller children can have an entertaining story read to them and then
"play" on each page by clicking various objects. Older kids can use the
interactive features to learn to read and expand their vocabularies.
A typical program in this category, Just Grandma and Me, is shown in
figure 27.3.
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Fig. 27.3
just Grandma and

Me is a typical
children's software
program, with lots
of hm and a little
learning mixed in.

•

Education. Educational programs vary greatly in format, depending on

whether they are aimed at older or younger students. Primary and
middle school students also soak up knowledge like a sponge, but they
spend more time learning if the lessons are cloaked in arcade-style
clothing. So educational software aimed at younger audiences has a
high game content.
On the other hand, Programs such as Learn To Speak Spanish, or Barron 's
Complete Book Notes are clearly designed for older students, with nary a

game in sight. Instead, these programs mimic secondary or college
classroom texts in format, with computerized or multimedia enhancements that take adva ntage of the Macintosh's power.
•

Games. Many excellent programs have no pretensions of teaching you

anything useful, although a few (simulations such as SirnCity 2000 or
SimEarth) may satisfy your curiosity about how things work. Others,

such as The 7th Guest or Hei/Cab, exercise your ability to solve problems.
Still other pure ga mes purport to be nothing more than arcade-style
shoot-em-ups, in the manner of Stellar 7. These programs are aimed at
Mac owners of all ages, from about six through adult. We'll look at an
interesting clutch of games in this category shortly.
Many of the programs mentioned in this chapter are available in two versions: one is sold in floppy disk form and installed on your hard disk. A second, enhanced version is available on CD-ROM, with added features such as
video or sound. The CD-ROM versio n, which is often only a few dollars more

Children's Software
than the d isk-based edition, may be installed to your hard disk or run directly
from the CD. Busytown, SimCity 2000 and Oregon Trail are examples of
children's, game, and educational programs available on both disk and CDROM.

Children's Software
Five of the most popular programs in this category are KidPix, ava ilable in
floppy disk format; Just Grandma and Me, Putt-Putt Goes To The Moon, and Four
Footed Friends, which are sold in CD-ROM packages, and Busytown, which is
available both on disk and CD-ROM. We'll look at just Grandma and Me, and
Putt-Putt in some detail, and then take brief looks at the other three programs.

Just Grandma and Me
This entry in Broderbund's Living Book series is a perfect example of what a
child's CD-ROM sh ould contain. Children can have the book read to them,
o r they can "play" inside the pages, activa ting a series of fancifu l scenarios
just by clicking various o bjects they see. There's enough fun and whimsy to
please any kid from age 3 to 8, a liberal sprinkling of options designed to
keep interest high after repeated sessions and solid educational content that
en courages young students to think of learning as a treat rather than a chore.
The same is true of other Living Books from Broderbund, which include
best-sellers such as Arthur's Teacher Trouble (filled with spelling-bee fun), The
Tortoise and the Hare, and New Kid on the Block. Most of the material in this
section apply to the other programs in the line.
System Requirements
Just Grandma and Me is furnished on a single compact disc, so you' ll need a
CD-ROM drive connected to your Mac to use it. It requires 2.SMB of RAM
and a 256-color video display. For best performance, turn off virtual memory,
disable any screen savers you've installed, and close any other open programs
you may have running. Apple's Launcher or At Ease interfaces can cause
problems with this program's sound routines, so they should be disabled.
Drag them out of your Startup items folder and then restart your Mac. If you
have a Macintosh LC and are still using System 6.0x, you may notice occasio nal sound dropouts.
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Overview of Just Grandma and Me
Just Grandma and M e is a lively adaptation of Mercer Mayer's popular line of

books about "Little Critter," a cute young mammal of indeterminate species
(we vote for groundhog). Young Cri tter takes a bus to the beach for a day of
fun with Grandma and the other animals on holiday. Sand-filled hot dogs,
going snorkeling (but not too deep!), and uncooperative beach umbrellas are
all part of the low-key adventures the two enjoy.
Youngsters can choose to have the book read to them . Just Grandma and Me
comes to life as Critter reads the story. The characters actually move around
the page through life-like animation and react to the story with giggles or
short responses. The effect is more like watching a cartoon than reading a
book. All the while, a pert background tune sets the light-hearted mood for
the story. Mercer Mayer's stories and illustrations have already become
children's classics, so on this level alone, Just Grandma and Me is an excellent
disc.
Choosing a Mode

While Read to Me mode may be the best introduction to the disc, most kids
will soon be chomping at the bit to review the book in its interactive mode.
The child turns pages manually and clicks a special icon with the mouse to
have the text on that page read aloud. Beginning readers can click individual
words to have them read individually.
You can select the mode you want by clicking the appropriate button in the
main screen, shown in figure 27.4. Notice that you can also choose from
English, Japanese, or Spanish narration. Those studying one of those languages can use Just Grandma and Me as a tool to practice foreign language
conversation, too. Once you've heard the story a few times in English, the
Spanish version, for example, almost translates itself in your mind.
A special options menu offers a scrolling preview of each page; the child can
choose a page and jump directly to it. One tip: don't neglect to read the credits, hidden inside this option menu. You'll be treated to a five-minute minicartoon featuring an inept witch and a hot five-piece jazz combo.
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Fig. 27.4

Ju~~ GRANDitJA AND A1 E
;:

The main screen
lets you choose
reading or playing
mode and an
appropriate
language for the
narration.

LETME
PLAY

Playing Inside Pages
No child will be able to resist exploring the individual objects on each of the
12 pages in this book-disc. Delightful animated sequences are triggered by
clicking almost any person or item o n the page. In the opening scene, shown
in figure 27.5, Grandma and Critter walk to the curb and wait for their bus. If
you click the fro nt door of the h ome they just leh, a doorbell chimes. Click
one of the windows and the phone rings, Gra ndma's answering machine
picks up and reports that she is no t home. If you "open" the mailbox by the
street, a mysterious hand reaches out of it and slams the door shut.
Fig. 27.5
Delightful
animated sequences, such as
the arrival of this
bus, are triggered
by clicking objects
shown on each
page.
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There are lots of surprises on each page. For example, something different
happens each time you go back to that mailbox. One time you may find a cat
sleeping inside, or you may be pelted by a cascade of tumbling golf balls.
The silliness includes some visual and audio puns aimed at more astute kids.
Click an ordinary rock by the roadside, and you're treated to a few bars of
string-bending "rock" music. Children can easily spend hours "playing" inside the story.
In interactive mode, you may take as long as you like on each page, clicking a
right-arrow icon to advance to the next or a left-arrow icon to go back to the
previous page. The child may click the page number button at the bottom of
each page to return to the main menu at any time.
Summary
just Grandma and Me is another of those discs that set the standard fo r all the

other "talking storybook" CO-ROMs that follow. The story is charming, the
length just right for short attention spans, and the animation of Mayer's
artwork first-rate. Even the background music is catchy and varied enough to
soothe parents annoyed by purple dinosaur sing-alongs.
just Grandma and Me is recommended for households with preschoolers who

like to "play" with computers, even though they can' t yet read. This disc
might be their head start toward early reading. Beginning readers will also
enjoy the book, exploring the simple words and phrases by reading fo r themselves, repeating the words after Critter says them aloud, or by clicking words
they are unsure of to hear the correct pronunciation.
Finally, older students will find the book an enjoyable way to practice their
conversational and comprehension skills in English, Spanish, or j apanese.

Putt-Putt Goes To The Moon
Children aged three and up are entranced by Putt-Putt, the little purple convertible with a rea l child's voice but the appetites and inclinations of a humanized automobile. The adven tures of Putt-Putt, who likes motor oil on his
Tire-O's cereal, form the basis of this easy-but involving- preschoolers'
ga me.
The story unfolds one bright morning as Putt-Putt visits a Fireworks Factory
owned by his friend Mr. Firebird, shown in figure 27 .6. The child can use the
mouse to click various items in the factory with a puffy, over-sized arrow
cursor. Clicking the window pane opens the window, allowing a butterfly to
flutter in . Soon, Putt-Putt's puppy (which he adopted in his previous adventure, Putt-Putt joins tile Parade) leaps at the butterfly but instead, presses a
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forbidden lever that launches Putt-Putt on a skyrocket to the Moon. To return
home, Putt-Putt has to find missing rocket parts and 10 Moon Crysta ls,
through va rious adventures o n Luna.

IV
Fig. 27.6
Putt-Putt's
adventure starts

out in Mr.
Firebird's fireworks

factory.

System Requirements

Putt-Putt Goes To The Moon is available in both floppy d isk and CD-ROM versions. Both req uire a Macintos h LC II I o r later system with 256-color video
display and 2M of RAM. The version that comes on floppy d isks requires 13M
of free hard disk space for program files. The CD-ROM version can run d irectly from t he CD, saving hard d isk space.
Running Putt-Putt Goes To The Moon

Putt-Putt can run using one of several different screen sizes on your Mac,
depend ing on the speed of your system. "Small" and "medium" are best fo r
slow systems, t hose with small moni tors, o r wit h o nly 256K of video
memory. The "large" and "smoothi ng" modes use as much of you r screen as
possible, but ca n reduce the speed at wh ich the program run s if you don' t
have a fast Quad ra, LC Ill, Performa, or Power Macin tosh m odel. Sometimes,
turning off !NITs and Extensions can speed up t he animation of the program
a little.
On the Moon, Putt-Putt soon lands in trouble, as a bridge collapses, throwing
him into a puddle of moon goo (see fig. 27.7). When t he child clicks o n the
horn button on Putt-Putt's dashboard, Rover, a lonely lunar terrain vehicle,
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comes to, the rescue. Abandoned by one of the Apollo moon missions, Rover,
like Putt-Putt, just wants to go home. Together, they perform good deeds for
the Moon People while assembling the pieces of the rocket needed to return
to Earth.

Fig. 27.7
Putt-Putt lands in
hot water soon
after he arrives on
the Moon.

Even the youngest child will be able to complete the story-adventu re by randomly moving Putt-Putt from scene to scene and clicking various objects
found in each. As he moves around the Moon, Putt-Putt encounters a host of
other characters, who help him along with advice, refreshments, and the odd
jobs he needs to earn his rocket pieces.
Putt-Putt's "user interface" was obviously designed for curious preschoolers
who have mastered the mouse or a joystick. No keyboard commands at all
are required (except ):(-Q to exit). Parents can access the remaining keyboard
commands to t~rn sound on/off ():C-M and )::C-0 for music and dialog, respectively), pause or resta rt the game (space bar or :l=(-P), or change the sound
volume (square bracket keys). Games in progress can be saved to disk and
resumed later.
Although a child can perform the various deeds required to assemble the
rocket in a different order each time, the game doesn 't vary much from play
to play. Those with young children will know that this is a definite plus! The
same preschoolers who want to hear a story repeated over and over love to
work their way through Putt-Putt's universe again and again, seeking out
familiar situations they find entertaining.
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Adults may find the repetitive music and sound effects in Putt-Putt Goes To
The Moon annoying, but kids are oblivious as they play along.

IV

Summary
It's tough finding programs that young children can enjoy, and Putt-Putt Goes
To The Moon is one of the best available. The graphics are more cartoon-like
than photorealistic, but that's exactly what kids want and expect. The educational content is minor but sufficient, considering the 3- to 7-year-old audience for this program.

Brief Looks: KidPix, Four Footed Friends,
and Busytown
One classic and two new entries show the direction children's software is
taking. KidPix provides drawing tools that even the youngest child can enjoy,
while Four Footed Friends and Busytown demonstrate the lively animation
possible from CO-ROM-based programs. Here's a brief look at each of these
three offerings:
Kid Pix
KidPix, shown in figure 27.8, is a classic children's painting program that

takes the pioneering MacPaint toolbox to new-and if you can imagine iteasier-to-use levels. The chief enhancements-beyond full color, of courseare whimsical tools that perform fun functions on the child's drawing with
minimal effort.
Fig. 27.8
Kidf>ix provides
many new and
whimsical tools for
yo ung artists.
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For example, there's a rubber stamp tool that stamps little pictures (there are
more than 100 to choose from) such as dogs, palm trees, dinosaurs, clowns,
and major household appliances. A Mixer tool adds special effects, such as
spots, stripes, or flower patterns, to the d rawing. To move parts of a drawing,
the kid just clicks a moving va n icon and selects the portion to relocate with
the mouse. The skidd ing noise sound effects during the move are priceless.
Indeed, all the sounds in this program have been selected to add appeal.
Pouring paint from the paint bucket evokes distinct gurgling sounds. Clicking
the Undo icon summons a hilarious "Oh no! " Tool sounds can be turned off,
or the child can record his or her own sounds o n Macs equipped with a microphone.
KidPix will run on nearly any Mac, but you' ll get the most benefit from it

with systems equipped with a color monitor. Even very young children who
are not ready for even simple games can learn to use the Mac with
Broderbund's KidPix. If your kid can hold and click the mouse button, the
youngster will enjoy this program.
Four-Footed Friends

The animation alo ne is worth the price for this T/Maker entry for children.
The 3-D modeling is incredibly realistic, with more in common with Roger
Rabbit than Bugs Bunny. One look at the interface, an animated
lnteractivator, will show you what I'm talking about (see fig. 27.9). The Next
Page arrow button doesn't sit there idly waiting for you to click it- it jumps,
twirls, and twists to catch th e child's attention ! This program makes the best
use of QuickTime we've seen in a children's program.
As with other animated storybooks, you can listen to the story (told with a
delightful English accent), click phrases to h ear them repeated, or select individual objects in the illustration to bring them to life. Mrs. Cow's blouse
changes from red to a flowered pattern, and an ever-growing pile of hay is
produced on her dinner plate when you click it a few times. Other fourfooted friends include General Rhinoceros, Kangaroo, Nanny Goat, and Madame Elephant. Each is accompanied by a silly poem that will m ake kids grin
(see fig. 27.10).
Your guides include Pablo, who lets you color your own pictures, Wendy the
bookworm, who helps kids learn to read and spell, and Albert, the number
worm, who provides facts and figures. You can access a Storybook Library,
complete with Card Catalog previews to choose a page.
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Fig. 27.9
The
lnteractivator's
lively interface
features four
bookworm friends
and some rather
lively buttons.

SaidMrs. Cow: "When I say' Moo,'
I do not mean to frighten you;
But that is quite the only way
I have, toask you for morehay."

Richard Scarry's Busytown
Busytown is certa inly an apt name fo r t his program! Busytown will keep c hildren from 3 to 7 occupied for hours on end t h rough 12 diffe re n t en e rgetic
activities that let kids exp eriment with objects, m anipulate real machines,

Fig. 27.10
Clicking Mrs.
Cow's plate adds
the hay she is
requesti ng.
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and even practice working behind the counter of a fast food restaurant. Our
four-yea r-old tester cried when we told her it was ti me to stop playing
Busytown.

This Paramount program is available in both floppy disk and CD-ROM formats. If you have a CD-ROM drive, the disc version is worth the extra money.
It is spiced with lively songs and includes an extra playground, Busy Tunes,
that lets the chi ld choose from a selection of songs. CD-ROM users can run
the program from the disc, but those with the floppy version will need about
12M of free hard disk space to hold the progra m files.
We received this Paramount disc shortly before author Scarry died, so the loss
was even more acute when we looked at what his imagination had wrought.
Busytown is populated by creatures such as Bananas Gorilla, who needs to
wind his way through a maze to a bunch of bananas without losing any fru it
to a horde of photographers. At Bruno's Deli, the child can help Huckle the
Cat piece together complex food orders using an animated machine, choosing from cheese, hot chocolate, soda, and other delicacies.
Other playgrounds ask kids to help build a house, deliver items from a warehouse to various locations in Busytown, serve as an aide to Dr. Diane as she
bandages hapless Norbert the Elephant, build and furnish Captain Salty's
ship before it sets sail, or put out fires. Many of the activities have overt educational goals, such as the seesaw that can be balanced only by putting equal
number totals on either side. Others, such as the Busy Tunes jukebox, are just
fun.
The program is furnished with a study guide that helps parents choose activities for developing kids: language/prereading, math, problem solving, social,
emotional, physica l, motor development, art, or music skills. But, don 't get
too high minded when you turn your kids loose with this program: they're
likely to insist o n playing in Busytown at their own pace.

Other Winners
You'll find a wealth of o ther great children's programs available fo r the
Macintosh that I couldn't describe in any detail. These include:
• All the Broderbund "Living Books," from Arthur's Teacher Trouble to New
Kid on the Block.

• Discis "Kids Can Read" series, especially Scmy Poems For Rotten Kids.
• Humongous' Fatty Bear series (e.g., Fatty Bear's Birthday Surprise), wh ich
are interactive stories in the Putt-Putt vein.
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• Stickybear's Early Learning series.
• Sierra Online's wonderful Alphabet Blocks, with the adorable Bananas
and jack.
• Any of The Learning Company's excellent Reader Rabbit programs
(Ready for Letters, and others).

Education
Ever since Minnesota Educational Classroom Consortium (MECC) and others
began distributing programs such as Speedway Math for the pre-Mac Apple II
line ages ago, teaching games have been popular in schools and homes. These
programs have certain things in common: visual and auditory "rewards" for
successfu lly completing a level or lesson, ways to keep score (measu re
progress), and a strong game element. Competition (against the computer or
other students) may or may not be a major component.
Today, you'll still find MECC programs among the best sellers-the venerable
Oregon Trail has gained new life with a CD-ROM edition that features video
and sound. But other companies have developed innovative teaching tools
that use the power of the Mac to educate in new ways. In this section, we'll
look at Learn To Speak Spanish, Black American History, and Where in tile World
is Carmen Sandiego? in detai l, and then review several other important Mac
educationa l programs, including Oregon Trail itself.

Learn To Speak Spanish
Hyperglot's Learn To Speak Spanish provides almost everything you need to
learn this language except a stern teacher to rap your knuckles when you get
something wrong. In that sense, it makes a perfect complement to a formal
language program, rather than a complete stand-alone system. Hyperglot
offers other CO-ROMs for French, German, Italian, Chinese, japanese, Russian, and English.
System Requirements
You'll need a 256-color Macintosh such as the Mac LC III or Performa 450 or
higher (a 68030/25 MHz machine o r faster), 4M of RAM, and System 7. This
is a CO-ROM-only product, so you must have a CD drive installed in your
Mac. An external microphone or MacRecorder is required if you want to
record you r own voice to compare with the nati ve speakers in the program.
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Using Learn To Speak Spanish
Lea rning a fo reign language thoro ughly involves eq ual parts of studying
vocabulary, memorizi ng grammar rules, and practicing conversation.
Hyperglot's Learn To Speak Spanish provides a smattering of all three. There's a
fun-to-use vocabulary mod ule that will help you build an impressive Spanish
vocabu lary in no time.
The conversational portio n of the program lets you listen and learn from selfpaced sessio ns with native (Latin American) Spa nish spea kers. You can even
practice pronunciatio n by recording your own voice through your Mac, and
comparing the results with the correct pronunciation.
Your study begins fro m the main screen (shown earlier in this chapter in fig.
27.2), which shows the first 15 of the 30 available lessons/chapters. These all
center around the conversational situations that occur during the typica l
business o r pleasure trip to a Spanish-speaking country. You can choose from
Arriva l, Changing Money, Getting a Tax i, Arriving at the Hotel, and other
traditional scenes.
Each chapter starts with an introd uctio n screen and a short video clip, actually shot in Mexico City. You can move from scene to scene by clicking naviga tional arrows at the top of the screen, o r you can click the title bar to bring
up a toolbar of butto ns that lead to chapter sections such as vocabulary drill,
communications skills, or a word jumble game.
The Vocabulary screen, shown in figure 27.11, lets you listen and learn new
vocabulary words, and practice record ing them in your own voice. You learn
words by selecting one of the chapter's new words from a scrolling list. A
defi n itio n of the word appears in a wi ndow, and vocabulary notes about the
word appea r in another. For exam ple, if you select ti ene (he/she has), you'll
see that it is a fo rm of the word tener and that you' ll learn to conjuga te that
verb in Chapter 6.
If you click the Hear in Context wi ndow, a sho rt video clip taken from that
chapter's movie will play with a native speaker using the word in context.
You may repeat th e clip as many times as you want, which will probably be
necessa ry: unlike Spanish students and, sometimes, their teachers, actual
speakers of the language tend to slide words together and otherwise make
them sound different in full sentences than w hen you pronounce them
alone.
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Fig . 27.11

The Vocabulary
screen shows you a
word, its defin ition, and a
conversation that
uses it in context.

At the bottom of the vocabulary window is a recorder pane. If your Mac or
PC has a microphone attached, you can click t he Record button. The word
will be pro no un ced and then record ing starts. You ca n record the word you rself. Click Play, and bo th your versio n and the ac tual p ron unciation will be
played back, as many times as you wish.

Other Modules
The Vocabulary Drill module lets you practice your new vocabulary, either in
Spanish-to-English or English-to-Spanish mode. You ca n record your own
pronunciation here, too.
The Sto ry Screen lets you see and hear the native spea ker using eve ryday
Spanish at normal speeds. You can p ractice saying longe r Span ish sentences,
and deciphering it as it's actually spoken. You may watch the chapter's fu ll
movie clip or work through it sentence by sen tence.
There's also an Action Screen that provides a continuation of the story, with
several native speakers engaging in a dialogue. This more advanced mode will
really give your comprehension a workout.
The Listening Skills screen repeats sections of t he chapter's movie bu t with
blanks which you must fill in with the correct word. This tests how we ll
you've mastered the vocabulary of t he chapter. The Commun ications Skills
screen, shown in figure 27 .12, requires you to type in length y responses.
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Fig. 27.12
If you've mastered
Spanish, you can
type your responses in this
dialog box.

Exercise screens test your grammar skills, asking you to change articles fro m
singular to plural o r provide the correct verb tense. If you get stumped, you
can click the Show Answers or Show Gramma r buttons fo r help.
Other games and exercises are available. Drag and Match asks you to do
things such as drag an indefinite article to the nuu n it agrees with, while
Word jumble gives you five jumbled sentences to unscramble. The Help
screen appears when you click the Question Mark icon (see fig. 27.13).
Fig. 27.13
Help is available
with the Questjon
Mark icon.

The text and workbook are good and oriented, li ke the CD-ROM, to conversational Spanish as it is used ~n travel settings. It can give you all the gram mar
you need to get by if you work through its exercises religiously.
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Summary
Learn To Speak Spanish is aimed at an older audience-high school to adult

beginners. It has everything you need to learn sim ple Spanish conversations
except a stern teacher. You can practice conversation, build your vocabulary,
sharpen knowledge of grammar rules, and learn while listening to native
speakers discussing travel topics in everyday situations.

Black American History: Slavery to Civil Rights
This program provides a taste of another type of educational program that is
increasingly common: audiovisual presentations that might have been given
in classrooms using VCRs five yea rs ago or with filmstrip projectors and
audiotaped narration 15 years ago. Today, the same type of material can be
presented much more effectively on CD-ROM, using the power of the
Macintosh to add cross-indexing and a measure of interactivity.
Black American History is available from Queue, which also offers similar pro-

grams on other topics, such as Let 's Visit France.
System Requirements
Any Macintosh with a color monitor and CD-ROM drive will be fine for this
program. You'll need System 6.0.7 or higher, or any version of System 7, and
2M of free random access memory (RAM).
Exploring Black American History
Black American History is more than a CD-ROM presentation on the history of

African-Americans: it's a complete course of study that can be used in middle
schools, junior high, and high schools. In addition to a variety of illustrated,
narrated programs covering everything from the Colonial Period to Protest
Movements, there are tests that measure student comprehension, a teacher's
guide, answer key, and historical documents for further study.
Actual voices of leading figures involved in the events, including the Reverend Dr. Martin Luther King, Jr., bring this aspect of our history to vivid life.
Dramatic presentations representing more than 75 African-American personalities, from Sojourner Truth and Harriet Tubman to Thurgood Marshall and
Ralph Bunche add strength and reality to the program.
Your course starts from a main menu screen, shown in figure 27.14, with
nine choices, such as The Abolitionists, Reconstruction, The Harlem Renaissance, and The Depression. Clicking one of these sections leads to a ISminute narrated presentation, illustrated with historical photos, drawi ngs,
and charts.
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Fig. 27.14

Black American
History's Main
Menu offers nine
topic choices.

While viewing a sectio n, the student can access an index at the click of a
magni fying glass icon to view related topics or page thro ugh faster than the
normal d isplay by clicking left and right arrow bu tto ns. Text d isplay can
accompany th e spo ken narration, or sound ca n be turned off if a silent mo de
is des ired in the classroom .
At the end of each sectio n, the student can be quizzed with multiple choice
questio ns to see how well t he material was understood (see fig. 27 .15). Scores
can be p rin ted o r stored to your hard disk. The program is clever enough to
sto re scores in a miscellaneous sectio n if the student enters an invalid name
or ID number by mistake. Most teachers will prefer to sort o ut stray scores
later rather than have t he studen t denied the oppo rtunity to take the test
thro ugh an error.
A password-protected Class Manager program provided o n the d isc h elps the
teacher view scores, edit names, and delete records. Up to 100 n ames ca n be
included in each class file.
The narrated texts include impo rtant written materials accompanied by
speech and sound effects on topics such as The Quest fo r Freedom , Su p reme
Court Cases, and Black Vo ices.
Under the latter sectio n, fo r example, you ca n hear speeches by j ames
Baldwin, Martin Luther King, La ngsto n Hughes, and o thers. The Quest fo r
Freedom has narrations on Africa n-American b usiness leaders, achievers in
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literature, arts, and sports, and pieces on their roles as patriots, soldiers, scientists, and inventors.

IV
Fig. 27.15
Multiple choice
questions test
student retention
of the material.

Supreme Court Cases cover four key court decisions that have had profound
effects on ou r history, including Brown vs. tile Topeka Board of Education, and
th e historic Dred Scott decision. An image from one of the presentations is
shown in figure 27.16.
Fig. 27.16
Historic photos
accompany the
narration in Black
American History.
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Summary
Although the programs on this disc are basic slide-show audiovisual material,.
enhanced by additional spoken word segments, it's convenient to have all
this information on a single CD instead of a dozen audiotapes, film strips,
videotapes, or other media. Black American History is a CD-ROM that belongs
in every classroom where history is studied, examined, and cherished.

Where in the World Is Carmen Sandiego?
Today, Where in the World Is Carmen Sandiego? is perhaps the classic

ed utainment program for the Mac. It's not enough that students must answer
challenging geography-based questions, they must use their knowledge to
find the evil criminal mastermind, Carmen Sandiego. Aimed at ages 6 to 12,
there are also versions of this program that deal with USA geography and
historical events.
System Requirements
Carmen Sandiego is available on floppy disk in a black-and-white format and

will run on just about any Macintosh from an ancient Mac 512E or Mac Plus
up through Mac SE, SE/30; or Mac II systems. The new Deluxe Editions on
CD-ROM require a color Macintosh and CD-ROM drive and have new soundeffects, movie-like music tracks, and more vivid animations.
Running with Carmen Sandiego
You can explore 30 of the world's great cities in tracking down Carmen and
nine cohorts, all members of Villains International League of Evil (VILE).
Using a portable videophone that provides direct personal communications
and news flashes, the player picks up clues by flying around the world to
interview witnesses and suspects. You can review evidence, dossiers on suspects, and information about particular countries. A World Almanac is packaged with the game to let you look up more key facts on your own.
Once you've signed in, you' ll be issued a videophone and Dataminder,
shown in figure 27.17, and receive a briefing on your next case. You can
review the case file and then click the Travel button to fly to your first
destination.
Once there, a yellow note pad displays your options for seeking clues. Some
clues help you find the culprit's next destination, while others can be used to
identify the gang member.
Each stop includes snapshots of the country and city being visited, with various tidbits of information cleverly worked into the plot. For example, a tour
guide may recall that the suspect asked about Spanish exploration and
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produce a snapshot of a Cerro Silver Mine. With those clues in hand, you're
off to investigate New World m ining activities in Lima, Peru (see fig. 27. 18).
All during the game, a digital clock ticks off the remaining seconds allowed
fo r your q uest.
Fig. 27.17
The videophone
and Dataminder
are your key tools
fo r finding
Carmen Sandiego
and cohorts.

Fig. 27.18
It's off to Lima,
Peru, for another
round of interviews in the quest
for Carmen
Sandiego.
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Once enough evidence has been collected, the gumshoe can issue a warrant
for the arrest of a suspect. To get a valid wa rrant, you must gather all the
evidence identifying that particular crook. Once Carmen's gang has been
rounded up, you may snare Carmen herself if you're lucky, and gain a conviction in court. The ob ject of this game is to obtain warrants for as many of the
crooks as possible or track them to th eir hideouts before time runs out.

Summary
This ed ucational game pits a student's knowledge of world geography against
fleeing master criminals as the youngster attempts to track down Carmen
Sandiego and her gang. The video and animation in Carmen Sandiego are
first-rate, and the problems challenging. It's no wonder that this game has
spawned a top-rated television show and other spin-offs. The books supplied
with the various versio ns of the game are themselves valuable study aids. This
classic deserves its ranking on the best-seller lists.

Brief Looks at Oregon Trail and Treasure MathStorm
Two more types of ed ucational programs are represented by Oregon Trail, a
simulation, and Treasure MathStorm, a game which includes many wellthought-out math lessons. Both are typical of a large group of teaching software available on disk and CD-ROM for the Macintosh .
Oregon Trail

Now you can face the same perils as the pio neers, includi ng disease, snakebites, and starvation! Your party sets out from Independence, Missouri in its
quest for Oregon's Willamette valley. Choose your supplies wisely, plan the
most efficient routes, and be prepared to buy or barter what you may need
along the way.
This MECC program, shown in figure 27.19, runs on a Mac Plus or later in its
floppy disk version, req uiring only 1M of RAM (4M with System 7). The new
CD-ROM version has enhanced video and sound.
As you start the game, you can choose an occupation (see fig. 27.20) and
then select your supplies from Matt's General sto re (see fig. 27.21). You'll
want to buy enough oxen, clothing, bullets, spare wheels and axles, and food
to last for your journey. On ly $1,600 is available for purchases, but luckily,
money went a lot farther in those days!
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Fig. 27.19
Setti ng out on the
O regon Trail.

Fig. 27.20
Choose your
occupation from
among those
listed.

I

Name: David

®Honker
0Biacksmllh
Otorpenler
O Doctor
O rcrmer
OMerchonl
0 Soddlemaker
0 Teocher
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The othe• people ·1n your wa11on:

Joey
Mary
Beth

Zeke
OK

Fig. 27.21
Matt's General
store is your last
stop before
departing on the
trail.
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You can also select the month you start in (planning for good weather),
choosing other options along the way from a menu of activities (see fig.
27.22). A map is available to check progress, along with a helpful guidebook
of tips and lore. You may check your health status or ratio ns, and choose to
trade, ta lk, rest, o r hun t. The pace of your journey can be set from steady to
grueling (if you're up to it).

Fig. 27.22
This screen helps
you track your
progress along the
Oregon Trail.

Oregon Trail has remained popular for a decade because of its thrilling simulation of the conditions of pioneer days. Though greatly enhanced with graphics and sound, its text and simple graphics heritage show th rough. Most studen ts will enjoy learning about the Oregon Trail from the game, but it can
get repetitious with freq uent playing. This is one lesson that is best learned
and then left behind. The journey is well worth the effort, however.
Treasure MathStorm
Treasure MathStorm, from The Learning Company (those Reader Rabbit folks),
is an alpine adventure game that h elps kids 5-9 learn m ath, mo ney changing
skills, while honing problem-solving capabilities. It's typical of the learning
intensive programs that take a more serio us approach to educational games.
Kids find these programs a lot of fun, but they'll have to sharpen the ir math
skills to a fine edge to get through the challenging exercises.

This program requires a color-equipped Macintosh with 2M of RAM, and
System 6.0. 7 or later, or System 7 and 3M of RAM. A hard disk is also required
to store the program .files.
Each of the activities independently adjust to the abilities of the child, presenting more difficult problems as the youngster masters concepts, so the
game always remains challenging and fun. Along the way, they'll pursue
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elves, solve problems, set the clock in the Time Igloo (shown in fig. 27.23),
balance the scale in the Gold Room, and count the crystals in the Crystal
Cave.

IV
Fig. 27.23
Children learn
how to tell time in
the Time Igloo.

The child takes the role of SuperSeeker, trying to rescue Treasure Mountain
from the icy clutches of the Master of Mischief, who has cast an evil spell. To
find him and release the mountain, the child m ust capture his elf-henchmen
by solving their ma th problems.
Various modules of the program drill the student in a selection of math skills.
For example, the child can enter the Store to purch ase nets for snaring elves
(see fig. 27.24). There, a friendly shopkeeper teaches the child how to make
change.
Fig. 27.24
Learning to make
change is only one
of the activities
chi ldren can spend
time on in the
Store.

The you ngster can earn more tools in the Time Igloo, where an elf shows the
child how to set a clock and tell time. Other adventures teach the child to
recognize number patterns, understand inequalities, and solve problems in
h is or her head.
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You are probably fam iliar with Reader Rabbit, but may not be familiar with
this program, o r others from The Learning Company, such as Treasure Cove.
All feature sprightly music, exciting animation, and challenging problems for
kids to solve as they learn.

Other Winners
Addi tional educational programs that you' ll want to know about include:
•

Word Munchers, from MECC, a dressed-up version of an Apple II classic
that lives on in classrooms all over the country.

• Mario Teaches Typing, from MacPiay, in which your Donkey Kong hero
(does anybody remember Donkey Kong?) introduces you to the computer and typewriter keyboard (does anybody remember typewriters?).

Games
Pure ga mes for the Macintosh fa ll into several neat categories. There are simulations that model real-world situations and give you th e opportun ity to fool
around in them. SimCity 2000, Railroad Tycoon, and Populous are among the
best-known of these ga mes. Another group of best-sellers are th e "virtual
rea lity" best-sellers, typified by The 7th Guest (and its sequel, The Xlth Hour),
Hei/Cab, and Myst. These games all provide realistic 3-D settings that you can
wander around in, hopefully solving the puzzles or challenges built into the
mini-un iverses.
A third type of game attempts to duplicate various popular arcade stylega mes, ranging from martial arts fighting games to jet-fighter/spaceshi p
shoot-em-ups and "gentler" games such as Lemmings.
The final main category consists of games that duplicate common board or
card games, but with computerized enhancements. Here, you'll find Battle
Clless, poker and casino games, and role-playing games such as Lord of the
Rings.

SimCity 2000
Interested in being your own city planner, with the power to subdivide land,
create residential, commercial, or industrial areas, and then supply police or
fire protection? Welcome to SimCity 2000 (see fig. 27.25)!
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Fig. 27.25
Welcome to
SimCity 2000's

enhanced 3-D
graphics!

The original Maxis SimCity was one of the most addicting Macintosh games
ever, and lau nched a whole genre of simulation games, ranging from Civilization to Maxis' own SimAnt, SimFarm, and SimEartl1. There are even several
third-party books written on how to play the game. Now, the game has been
taken into the thi rd dimensio n with SimCity 2000. We're happy to report that
this new CD version from Interplay is mo re fun and entertaining than the
floppy-disk-based original.
System Requirements
SimCity 2000 is intended for the Macin tosh Color Classic, or any member of

the Mac II, LC, Centris, Performa, Quadra, or PowerBook families w ith an
internal or external color display capable of showing 256 colors. You'll need
2.SM of free RAM, and 3M of hard disk space. System 7 or above is req uired.
It's a CD-ROM game and req uires a CD-ROM drive.
Playing SlmCity 2000
Build your ow n city from scratch, o r work with one of the supplied scenarios
to meddl e in the affairs of a real-life city such as Buenos Aires or Tokyo. Your
town will be populated to capacity with simulated citizens-Sim s-who build
houses, churches, stores, and factori es, pay taxes, and can di e off o r move
away if you muck things up too badly. But do a good job and your city will
grow and prosper.
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Your tool ki t is the floating palette at the left side of the screen, shown in
figure 27.26. just click an icon to turn the cursor into a lean, mean building
machine that can run electric lines, bulldoze trees or burnt-out tracts, create
new residential, commercial, or industrial districts, or perhaps build an airport or nuclear power plant. As the city develops, it is shown in the main
window.

Fig. 27.26
Your tool palette
and city are shown
in this window.

You'll need to create residential zones, which will grow and prosper based on
the amount of pollution (don 't put them too near industrial zones!), traffic
density, population density, access to roads, and available parks and utilities.
Commercial zones should be n earby, too, providing your Sims with places to
work and shop. Industrial zones are for heavy manufacturing. You'll need
police and fire departments, stadiums, seaports, powerplants, and airports to
keep your city thriving. But these amenities are expensive. Your city must
grow large enough to support them.
Various pull-down menus let you control the speed of the ga me, activate or
deactivate disasters, open or close informational windows, and view the
scuttlebutt in the daily newspapers. A selection of windows provides graphs
that track important growth and economic factors over time or show the
distribution of resources.
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Managing a city is tougher than it looks. If you raise taxes too high, building
will be stifled. Fail to allocate sufficient funds to police or fire protection, and
crime, arson, and even unchecked grassfires can wreak havoc. Creating a
successful SimCity requires a delicate balance of planned growth, attractive
amenities, and shrewd taxation to cash in on voter pleasure with their working and living environment. It also helps to have a lot of time to waste making haste slowly. (I once let a SimCity scenario run 24 hours a day for three
months on an old Mac Plus, fine-tuning m y way to the multi-zillion dollar
megamegalopolis level.)
Once a year, you'll receive a budget report, similar to the one shown in figure
27.27, detailing how you did. You can make corrections then or let your current plan run a little longer to see if things improve (if trends are bad, they
usually don't, without deliberate effort).
Fig. 27.27
Your yearly budget
report gives the
good news-and
bad-for your Sim

city.

As you work with the program, you'll find a few ways to cheat or at least
reduce your overhead to acceptable levels. For example, any property abutted
by at least one section of road or railway m ay be considered "connected" to
the transit system, even though the road or track doesn't go anywhere. Or
you may discover that not building an airport is an admirable way to keep
your fire department costs in check since plane crashes are the most frequent
cause of fires in SimCity.
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The 3-D graphics in this new version are welcome enough, but the animations and music, along with many of the voice-over effects, get old real fast.
Luckily, you can disable any and all of th ese from the Options menu. You
can set the program to take you automatically to the site of any disaster or
major event (saving you the trouble of hunting for it) and choose to try out
you r readiness by unleashing a disaster of yo ur choice fro m a tempting list
that includes fire, flood, air crash, tornado, earthquake, m onster (your typical
Tokyo-eating Godzilla clone), and nuclear meltdown. These can be disabled
entirely th rough another option if you'd rather have a few years of peace and
quiet.
Summary
The original city simulator has grown up, giving you an attractive 3-D view
on things that was lacking fro m the old aerial-view, floppy-disk-based version. You can use your political and economic acumen to create and manage
a thriving city or end up getting ridden o ut of town on a rail. Everything is
under your control in SimCity 2000.

The 7th Guest
Before there was Myst, we had The 7th Guest, which bro ke new ground in the
interactive virtual reality game field for its vivid, realistic 3-D graphics, great
sound, tough puzzles, and slick interface. It was o ne of the first CD-ROM
games to spawn a spin-off book of hints and ti ps. Once you've played this
ga me, you' ll find its imitators pale more quickly than the ghosts that haunt
the center stage.
System Requirements
You' ll need a CD-ROM drive and a color-capable Macintosh with a 256-color
display to play The 7th Guest. At least a 68030-based machine (or a fas ter
68040 or Power Macintosh) is recommended to view the animations
smoothly. The game runs in 4M of RAM o r mo re.
You and that extra guest
You play the game in the role of the mysterious Ego, whose viewpoint is used
to view the three-dimensional, virtual-reali ty setting of the eerie Stauf mansion. Use the mouse to move through the various rooms, following cues from
a floating skeleton hand that wafts about the screen to guide you.

Many of the rooms and settings contain puzzles to be solved. Each is preceded by a playlet acted o ut by the ghostly apparitions of six of the last guests
to stay at the mansion. Then, you'll be faced with the puzzle itself and a

Chapter 34

Data Exchange
by Carman Minarik

In many organizations, Macintoshes and IBM-compa tible PC's must coexist
and exchange information. Home Macintosh users also may need to exchange data wi th PC users. In this chapter you explore th e various methods
o f transferring files between the Macintosh and PC computing platforms.
Tn this chapter, you learn the following:
• The difference between file transfer and fi le translation
• How to transfer files using floppy disks, networks, or other cabling
• How to use Apple Fi le Exchange to transfer files
• How software utilities can make the file transfer process easier
• How to use cross-platform compatible applications
• How to translate files using MacLin k Plus
• Differences between Macintosh and PC file types
• How PC emulation can allow you to run PC software on your
Macintosh

General Concepts
The two q uestions t hat you must ask you rself when transferring files between
your Macintosh and a PC are How do I move the file from one computer to the
other? and How do I use tile file on tile other computer? While each of these questio ns raises unique issues, they are rarely addressed independently.
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The first step toward exchanging information between a Macintosh and a PC
is to physically transfer the file from one machine to the other. While both
Macintosh computers and PCs use similar media (hard disks, floppy disks,
CD-ROM, and so on) to store information, the manner in which data is
arranged on the media is drastically different on each platform.
After the fi le has been moved to the computer where it is needed, the issue
becomes how the file can be made usable. Picture an American tourist in
Germany. The American is physically in Germany, but unless he can speak
German, he may not be able to communicate. The same problem exists for
files moving from one platform to another. just because a fi le is physically
located on a particular computer does not mean that any software on that
computer can open the file.

File Transfer
File transfer is the process of moving a file from one machine to the other.
You can transfer a file using floppy disks, network systems, or direct cable
connections between computers.
Disk Transfer
The most common method of transferring files from one platform to another
is to use a floppy disk. Both PCs and Macintosh computers can use a 3.5-inch
floppy disk, but the formats are different. If you place a Macintosh forma tted
floppy disk in PC, it can't be read. Similarly, a Macintosh without special
software will want to format any PC-formatted disk placed in its drive.

To alleviate this problem, Macintosh computers with high-density drives can
read and write PC-formatted diskettes. High-density drives are able to use
1.44MB disks, and have been standard on all Macintosh models since theSE/
30 was introduced. In order for the Macintosh operating system to recognize
a PC-formatted disk, however, software such as Apple File Exchange or
Macintosh PC Exchange must be loaded.
Apple File Exchange
Even though the Macintosh high-density drive is physically able to read PC
disks, special software is needed to actually transfer files. The Macintosh
comes with an application called Apple File Exchange, which is a software
program designed to transfer files between the Macintosh and a PC-formatted
floppy disk. Some Macintosh models also ship with Macintosh PC Exchange,
which will be discussed in detail later in this chapter.

General Concepts
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Tip

_

Apple File

Apple File Exchange m ust be launched before the PC flo ppy disk is inserted in
the fl oppy d rive. Otherwise, the Macintosh will treat the disk like any other non-

Exchange is not
cop ied to the hard

Macintosh formatted disk, and promp t you to initialize it. This situatio n is alleviated if
PC Exchange is loaded.

disk auto m atica lly
as part o f th e
system installation
process. You may
need to manually

Caution

-

Launch Apple File Exchange by d ouble-clicking its icon . Apple File Exchange can
often be found in t he Utilities folder on the hard d isk.

copy th e appl ication fro m the
Tidbits system
in sta llation disk to
the hard disk.

Wh en launched, Apple File Exchange shows a transfer window similar to that
shown in figure 34.1.
Fig. 34.1
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Initially, the left side of this window displays the contents of the Macintosh's
hard drive. When a PC disk is placed in the floppy d rive, the contents of that
d isk are displayed in the right side of the window.
Use the fo llowing guideli nes w hile wo rking with Apple File Exchange:
• A fi le can be selected in either window by clicking the desired file.
• Hold d own the Shift key while clicking files to select a conti n uous
range of files.
• Ho ld ):C while clicking files to select d isconti n uous files.
• The arrows on the Translate button confirm the d irectio n of the
transfer.
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• Click the Translate button to transfer the files.
You can use the standard Macintosh file dialog controls in the Apple File
Exchange window to choose other disks, folders, and so on. Be sure you have
selected the appropriate folder in which to transfer files.
Commercial Utilities
Apple File Exchange can be used effectively to transfer files from one platform to another. The software is somewhat cumbersome, however, in that
you must remember to run the application before you place a PC-formatted
disk in the floppy drive. Commercial utility programs exist which allow
PC disks to be mounted on the Macintosh desktop in the same way that
Macintosh disks are mounted.

The most popular of these utilities are DOS Mounter from Dayna Corporation, Access PC, and Macintosh PC Exchange from Apple. All of these packages allow the Macintosh to mount, format, and copy information to and
from PC disks as well as Macintosh disks.
Each of these utilities operate in much the same manner. The software is in
the form of a Control Panel which automatically launches at system startup
time. The Control Panel extends your operating system's ability to recognize
and use floppy disks to include PC-formatted disks as well as Macintosh disks.
In addition, the Special menu option Erase Disk allows you to choose
whether to format the disk as a Macintosh disk or as a PC disk. Both high
density and low density disks are supported. Figure 34.2 shows a PC-fo rmatted disk as it would appear on a Macintosh with Apple's Macintosh PC Exchange software installed.
Fig. 34.2
PC Exchange
allows the PC disk
to b e used exactly
like a Macintosh
disk.

Caution
When using floppy disks to transfer files between PCs and Macintosh computers, be
sure the disks are formatted properly. High-density (those with an HD stamped on
them, and two square corner holes rather than one) PC d isks must be fo rmatted
1.44MB and standard PC disks must be formatted 720K. If a standard disk is formatted 1.44MB, the Macintosh will not be able to read the d isk.
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Network Transfer
Files can also be transferred from one platform to another using network
wiring. If the Macintosh computers and PCs are connected to a compatible
network (AppleTalk, Novell, Tops, and so on) files can usually be transferred
either peer-to-peer or via a file server. For more information on networking,
see Chapter 33, "Networking."
Commercial software such as Farallon's PhoneNET PC allows PC users to
connect to Macintosh file servers and transfer files much in the same manner
as a Macintosh user would. Products such as Novell's NetWare for Macintosh
allow Macintosh users to connect with Novell file servers.

Cable/Modem Transfer
Other common methods of transferring files include direct cable connection
or connection over phone lines using modems. For more information on
transferring files, see Chapter 29, "Getting Online."
Utilities such as MacLinkPlus/PC allow direct connection of Macintosh com puters and PCs via a special cable and software. Modems can be connected to
both Macintosh and IBM-compatible computers allowing files to be transmitted over standard telephone lines. Software communicating via modem varies
greatly, but nearly every communication software package includes standard
file transfer options.

File Translation
In order for a file that has been transferred from one platform to another to
be displayed or modified, the file must be in a format compatible with software o n the destination computer. The file format determines how an application stores information . Each application uses its own method of encoding
the information it creates. File translation is th e method used to get a file into
a format another application can use. If no file translation is available, files
created on other platforms may be unusable.
Two basic m ethods exist for translating files. The first involves use of software
applications with file translators built-in. Microsoft Excel, for example, contains file translation capabilities for 18 different file types.
The second method involves use of translation software such as MacLink
Plus from Data Viz. This type of software provides translation where no
application-based translators exist.
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Application-Based Translators
Many current applications automatically translate files created in differen t
applications or applications on different platforms. For example, Microsoft
Excel for Macintosh can automatically read files created in earlier versions of
Excel, files created in Excel for Windows, files created with Lotus 1-2-3 for
DOS, and many others.
Microsoft Excel also automatically creates files which are compatible across
platforms. For example, a file created in Microsoft Excel for Windows can be
read by Microsoft Excel for the Macintosh without any translation. A file
created with Microsoft Excel 4.0 for the Macintosh can be used by Lotus 1-2-3
for MS-DOS just by saving th e file in the proper format using Excel's built-in
Save Options as shown in figure 34.3.
Fig. 34.3
The applicationbased translators
supplied with
Microsoft Excel
are listed here.
Many software
packages
provide similar
capabilities.
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As another example, opening a WordPerfect 5.1 for MS-DOS file in Microsoft
Word 5.0 for the Macintosh can be accomplished using Word's buil t-in
translators.
Many software packages allow translation of different file types. Some packages go one step further, and actually use the same fi le for mats for their
Macintosh and PC versio ns. This is the ideal situation, since no translation of
any kind is needed to use files created with these packages across platforms.
The fo llowing list shows som e of the ma jo r software that uses identical file
formats for both Macintosh and PC:
• Microsoft Excel 4.0
• FileMaker Pro 2.0
• PowerPoint 3.0
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• PageMaker 5.0
• FoxPro 2.5 (Mac) and 2.6 (PC)
• Microsoft Project 3.0
• QuarkXPress

Translator Utility Software
In addition to the translatio n capabilities built-in to software such as
Microsoft Word and Excel, commercial software is available to hand le more
complex or less common translations. The most popular of these packages is
MacLinkPlus from Data Viz. MacLink Plus can translate word processing,
spreadsheet, and graphics files between dozens of applications.
Launch MacLink Plus by double-clicking its icon, and th e screen shown in
figu re 34.4 opens.
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This screen allows you to choose among MacLink Plus's modes of operation.
Each operating mode is described on the screen. Choose Desktop Translations
to open the screen illustrated in figure 34.5.
This screen is used to select the files you-want to translate. When selecting
files, keep the following points in mind:
• You can use the standard Macintosh fi le d ialog controls o n this screen
to ch oose other disks, folders, and so on.
• A file can be selected in either window by clicking the desired file.
• Hold down the Shift key while clicking files to select multiple files.

Fig. 34 .4
Use this screen to
choose a basic
operating mode.
For standard file
translation,
choose Desktop
Translations.
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Fig. 34.5

Use this screen to
select the files to
translate.
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From th is screen, follow these ste ps to a utoma ti ca lly tra nslate files:
1. Select the files to be tra nsla ted.
2 . When you have selected th e files you wa nt to translate, click the
Continue button. A new screen appears, sh owi ng t he progress of
the tra n slati o n.

By d efa ul t, MacLi n k Plus provid es a u tomatic tran slator selection based on the
type of fi le being translated. Au tomatic translator selection works well for
man y fi les, but in some cases you may n eed to set t he translators manually.
From the Prefere nces me nu, select Man ual Operati on, a nd activate the check
box in the resulting d ialog box.
Wh e n Ma nual Ope ra tion is activated, a new screen, as illustrated in figure 34.6, a ppea rs after t he file selectio n screen in the tra nslation process.
Fig. 34.6
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This screen indicates the file type of the selected files, and allows you to select
the translator you want from the displayed list. Select the desired translator
and click the Continue button. The screen shown in figure 34.7 opens.
Fig. 34.7
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When the translation is completed, a new file in the selected fo rmat will be
created in the chosen desti nation.

File Name Differences between
Platforms
When transferring a file between Macintosh and PC platforms, you should
keep in mind how to name the file. The Macintosh allows long file names
and use of most characters, while PCs have more stringent naming ru les.
Table 34.1 lists the naming differences on Macintosh and PC systems.

Table 34.1

File Name Conventions

File System

Number of Characters

Illegal Characters

MS-DOS (PC)

8 maximum with an
optional 3-character
extension

angle brackets <>
asterisk*
comma,
colon:
equal sign=
(continues)
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Table 34.1

Continued

File System

Number of Characters

Illegal Characters
pipe I
null
plus sign +
quotation m arks ""
question mark ?
slashes/\
square brackets [ )
space

Macintosh

31 m aximum

colon:
null

Not only do PCs and Macintoshes requ ire different nam ing conventions,
they also recognize files in different ways. PCs rely on the three-character
extension in a file name to determine which application was used to create
the file. Macintosh applications check the file's type and creator information,
which is stored within the file itself. Table 34.2 shows commonly used file
type eq uivalents between Macintosh and PC platforms.

Table 34.2 File Types
File Type

PC Extension

Macintosh Type/Creator

ASCII Text File

.TXT

TEXT/ ttxt or
TEXT/MSWD

Canvas

.CVS

drw2/ DAD2

FileMaker Pro

.FM

FMPR/FMPR

Lotus 1-2-3 Worksheet

.WKS

LWKS/ L123

Microsoft Excel Worksheet

.XLS

XLS4/ XCEL

Microsoft Excel Chart

.XLC

XLC3/ XCEL

Microsoft Excel Workbook

.XLW

XLW4/ XCEL

Microsoft Excel Macro Sheet

.XLM

XLM3/ XCEL

Microsoft Wo rd

.DOC

WDBN/MSWD

PageMaker

.PM4

ALT4/ ALD4

Text File Differences between Platforms

File Type

PC Extension

Macintosh Type/Creator

QuarkXPress

.QXD

XDOC/XPRS

GIF Graphic File

.GIF

GIFt/ Bozo

TIFF File

.TIF

TIFF/BBIM
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Text File Differences between
Platforms
Even if no translation software is available, som e files can be used on a different platform if they are converted or saved in some generic format first. Most
word processing, spreadsheet, and database applications allow files to be
saved in a text-o nly format. In this format only the base character info rmation is saved and all formatting such as font, size, bold, italic, and so on, will
be lost.

ASCII Files
ASCII (A merican Standard Code for Info rmatio n Interchange) is the name
given to a set of codes that defines the base set of text and numbers that can
be used on a computer system. Most computer systems adhere to the standard set of ASCII codes as shown in table 34.3.

Table 34.3

ASCII Codes

Code

Character

Code

Character

9

(Tab)

10

(Line Feed)

12

(Form Feed)

13

(Carriage Return)

27

(Escape)

32

(Space)

VI

34

33
35

#

36

$

37

o/o

38

&.

39

40

41

42
(continues)
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Table 34.3

Continued

Code

Character

Code

43

+

44
46

45
47

Character

I

49

48

0

50

2

51

3

52

4

53

5

54

6

55

7

56

8

57

9

58

59

60

<

61

62

>

63

?

64

@

65

A

66

B

67

c

68

D

69

E

70

71

G

72

73

H

74

75

K

76

L

77

M

78

N

79

0

80

p

81

Q

82

R

83

s

84

T

85

u

86

v

87

w

88

X

89

y

90

z

91

92

\

93

94

"
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Code

Character

95

Code

Character

96

97

a

98

b

99

c

100

d

101

e

102

103

9

104

105

h

106

107

k

108

109

m

110

n

111

0

11 2

p

113

q

114

115

116

117

u

118

v

11 9

w

120

X

121

y

122

z

123

124

125

126

127
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(Delete)

Note
The standard ASCII character set includes only codes 0-127. Some computers, including most PCs, also use an extended ASCII character set (codes 128-255) that includes
other machine-specific characters.

Text Files
Files that contain o nly characters and numbers conforming to s tandard ASCII
codes are usually referred to as text fi les. Almost every application allows
saving or exporting o f data in text file format. However, n ot all text files are
exactly the same.
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When a Macintosh application creates a text file, the end of each line is
marked with a single carriage return character. When a text file is created by a
PC application, the end of each line is marked with a carriage return character and a line-feed character. When text files are transferred from a Macintosh
to a PC, they're missing this line-feed character. When text files are transferred from a PC to a Macintosh, they contain extra line-feed characters.
Transfer utilities such as Apple File Exchange provide options to change the
line-feed characters as shown in figure 34.8.

Fig. 34.8
This screen allows
you to select
options to
enhance text file
translation.
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From the translation menu (Mac to DOS, Mac to Mac, etc), choose Text
Translation to access this screen. Other Apple File Exchange options available
on this screen include replacing special characters and replacing tab characters with spaces.

Format Differences between
Platforms
Some file format differences exist that cannot be resolved easily, even with
t ranslation software. Certain types of files may not have exact counterparts
on other platforms, and some features or capabilities of a particular application may have no equivalent in another application.

Graphics
Text and basic formatting will nearly always translate properly. The next
sections discuss some limitations on the translation process which may prevent perfect translation of information beyond the basics.

Fonts
Font formatting controls the appearance of text. The term font comes from
the printing industry, and refers to a specific typeface with a specific size and
type style. Helvetica 12 Point Bold is a description of a font. For more in fo rmation about fonts, see Chapter 8, "All about Fonts."
If you create a file using a certain font on one platform and then transfer that
file to another platform, the document will look different un less an equivalent font is available.
Note
Fonts on a Macintosh are stored as part of the operating system so that they are
available to any Macintosh application. Fonts on a PC are stored as part of the individual applications. The Microsoft Windows operating environment allows font handling on a PC similar to that on a Macintosh. Windows also supports TrueType font
technology, like a Macintosh. It is therefore much more likely that you will find
equivalent fonts for your transferred documents if you are moving files between
Macintosh and Windows applications than if you are moving files between Macintosh
and MS-DOS applications.

Graphics
Graphic files are difficult to translate from one platform to another. Some
graphic file formats, such as EPS (Encapsulated PostScript) and TIFF (Tagged
Image File Format), do exist on bo th the Macintosh and PC platfo rms. Even
when using these file for mats, however, the image will usually not translate
perfectly. For example, Macintosh EPS files contain both the printer information for the graphic image and a screen representation of the image. EPS fil es
on a PC do not contain a screen component. An EPS file transferred from a
PC to a Macintosh might print properl y, but may no t be visible on the
screen.
A related problem occurs when graphic images are con tained within other
documents. An example is a logo contained in a word processing document.
When you convert documents from one platform to the other, any graphic
images in the file are usually lost.
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Sounds
There is no common format for sound files o n Macintosh and PC systems, so
sound information is usually lost when translating a fi le which contains
sound.

Emulation
You may find that your needs go beyond file translation, and that you must
actually run PC software on your Macintosh. Emulation is the name given to
the process of running software from one platform on another platform. Your
Macintosh can be made to emulate a PC.
The most popular em ulation solution is a software application called SoftPC
from Insignia Solutions. When the SoftPC applicatio n is launched, MS-DOS
opens in a window on the Macintosh where you can run PC software.
Another approach to PC emulation o n a Macintosh involves use of hardware.
A company called Orange Micro offers the OrangePC card, which contains an
Intel 486 processor and plugs into any Macintosh with a NuBus slot. Apple's
Macintosh Quadra 610 computer took a similar approach, including the Intel
486 processor as part of the package. Unfortunately, the Quadra 610 has been
discontinued.
When comparing hardware and software solu tio ns, keep the followi ng points
in mind:
• SoftPC is less costly than a hardware solution.
• SoftPC is not as fast as a hardware solution. This is particul arly important if Windows-based software must be used.
• Hardware solutions do not support Macintosh CD-ROM drives or
Macintosh printers. Soft-PC allows you to use your Mac printer and
CD-ROM fo r PC applications.

From Here...

From Here ...
In this chapter, you learned the basics for transferring and translating fi les
between the Macintosh and PC platforms. You have seen several methods of
transferring files, and have looked at many issues impacting the translatio n
of files between platforms.
• For m ore information on opening and saving files, see chapters 5 and 7.
• To learn more about networking, see Chapter 33.
• See the software descriptions in Chapters 16 through 28 for more
information o n individual software applications.
• See Chapter 8 fo r a detailed discussio n of fonts.
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Chapter 35

On The Roaa
by Gene Steinberg

Chapters 29 through 32 discussed the ways you can get in to uch with the
entire world by using your Macintosh and your modem. When you take your
work on the road, you can remain in to uch by using these same tools.
Most desktop Macs, except perhaps the original compact models (such as the
Plus and Classic), are not really suited fo r work on the road. Apple therefo re
created the PowerBook line. It all started back in 1989 with an unga inly product known as the Mac Portable, which, despite its girth (it weighed 16
pounds), had some unique features for a portable computer, some of which
have become mainstays of Apple's PowerBook line, such as an ul tra sharp
(and expensive) active m atrix screen. The o riginal PowerBook 100, in fact, is
considered in many ways a miniature ve rsion of the original Po rtable.
In this chapter you learn the following:
• The latest portable computers ava ilable from Apple
• The accessories you need when you take your Mac o n the road
• How to send e-m ail and fax and print documents while you're o n the
road
• How to hook up your notebook Mac to a mo nito r or projecto r fo r giving presentatio ns

PowerBooks and Duos
Gone are the days when a Macintosh of any sort was priced higher than its
PC-based coun terparts and you had to resort to that other platform when you
needed portabili ty. Apple learned its lessons well after its first fo ray into the

VI

996

Chapter 35- 0n The Road
production of no tebook computers, best exemplified when the PowerBook
made its debut in 199 1. Now you' ll find a wide array of po rtable o ptio ns in
the Apple line from which to choose. The following sections cover the basics
of this product line. Because Apple is always adding new products to its arsenal, you can expect continuing changes in the mon ths to come.

PowerBook 1 xx Series
The Po werBook 1x;" Series no tebook models are based o n th e ori ginal
PowerBook design first introduced in Octo ber of 199 1. They sport commo n
features, such as an integrated trackball and palm rest. They contain slo ts fo r
RAM ex pansion and the installatio n of an internal modem. Li ke deskto p
Macs, they have AppleTalk and modem ports. They also include a special 30pin SCSI jack that requires a specially designed plug.
PowerBook 1458

This model fo rms the bo ttom of Apple's PowerBook line. It has a 25Mhz
68030 CPU, which puts it on nearly equal footing with such desktop Macs as
th e llci in terms of perfor mance, except for math related work. Th is m odel
lacks an FPU, but you can look to third-party suppliers such as Digital Eclipse
to provide this sort of upgrade path. The 145B has a 10-inch passive matri x
screen with a 640x400 pixel black-and-white display (s maller th an your standard 13/14-inch desktop monito r). It weighs in at approximately 6.8 pounds
and can accept up to 8MB RAM.
PowerBook 165

The PowerBook 165 is quite sim ilar to the 145 8, but offers upgraded performance in several areas. It uses a 33Mhz 68030 CPU, aga in without an FPU.
Unless you are doing math-intensive work, such as spreadsheet calculations
and 3-D rendering, you probably won't notice the difference. Th e 10-inch
600x400 pixel passive ma trix screen supports 16 levels of gray. This model is
especially suited fo r presentatio ns or as a substitute for a desktop Mac- you
can connect a regular mon ito r (up to 16-inch) to its external mo nitor port. A
dual d isplay mode gives you the o ptio n of showing o ne image on the interna l
screen and an other on your external mon itor. You ca n install an internal
modem or expand RAM up to a total (with mo therboard RAM) of 14MB. The
165 also weighs in at 6.8 pounds.

PowerBook 500 Series
This model line represents the first majo r change in Apple's popular all-ino ne PowerBook design. On the surface, the PowerBook 500 series are
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comparable to the older models in terms of size and weight. At a cursory
glance, they may even look similar. But eve ry aspect of these new models has
been improved. They all sport 68LC040 CPUs and have promised upgrade
paths to PowerPC. You get 16-bit CO-quality audio, same as the Power Macintosh line, and twin speakers are provided.
Gone is Apple's trackball, and in its place is the Apple Trackpad, a new solidstate pointing device, sometimes known as Midas (see fig. 35.1). Instead of
moving a trackball, your finger does the wa lking instead, literally. When your
finger moves across the trackpad, tw in layers of electrodes beneath the surface of the pad sense the movement of your fingers and move the cursor
accord ingly. A special Contro l Panel adjusts the speed of cursor movement.
In Apple's original announcement o n the new products, they boasted that
users learned how to navigate on-screen with the new trackpad in five minutes flat!
Fig. 35.1
This diagram shows
the complex
checkerboard
assembly of
electrodes that
senses fin ger
m ovement across
the Apple trackpad.

Top Layer
(with second layer exposed)

Bottom layer

Many standard features from desktop models are included in these models.
Networking is improved with a built-in Ethernet port. Instead of pushing a
button at the back of th e unit to turn it on, you can power up the 500 Series
PowerBooks with the keyboa rd. The keyboa rd also adds functio n keys to the
mix, something that used to require the addition of an aux iliary keyboard or
an Extension that remapped function keys. CO-like 16-bit sound is su pported, and twin spea kers provide stereo reproduction.
Like PC notebooks, PCMCIA expansio n is offered using an optional module.
There's also a PDS slo t for t hi rd-party expa nsion possibilities. The batteries
use an onboard processor to provide an accurate status report on battery life.
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The new models also include a package of handy uti li ties known as the
PowerBook Mobility Bundle th at are designed to help with your on-the-road
com puting tasks. They also monitor the computer's day-to-day status. These
utilities are described in more detail later in this chapter.
..
No~

·

Because the 68040 CPU has an internal dual-clock architecture, similar in some resp ects to a 48 6DX2, Ap ple revised its speed designation. The PowerBook 540cs CPU,
for example, is described as having a 680LC040 running at 66/33 Mhz.

PowerBook 520
The entry level product in the n ew PowerBook line is faster than any of the
original PowerBook products. The 520 sports a 50/25Mhz 68LC040 CPU, and
a passive matrix screen offering 16 shades of gray. It includes a 160MB hard
drive, 4MB of RAM, standard, an d a single battery with an advertised lifespan
of 1.5 to 3 hours under normal use between charges. The unit tips the scales
at 6.3 lbs.

PowerBook 520c
This model is virtually iden tical in con figuration to the 520. The main difference is a dual-scan passive matrix color screen offering 256 colors. This unit
weighs in at 6.4 lbs.

PowerBook 540
This model adds to the mix a 68LC040 CPU running at 66/33Mhz, equivalent
in performance to high-end Macintosh Quadra models, except for the lack of
integrated floating point unit. It offers an active matrix screen sporting 64
shades of gray. This model ships with two batteries and offers 4MB RAM and
a 240MB hard drive in its base configuration. It weighs 7.1 lbs. Most of the
increased weight can be accounted for by the fact that it has two batteries.

PowerBook 540c
The top of the new all-in-one PowerBook line offers an active matrix dual
resolution color screen. Standard display is 256 colors, with the option of
thousands of colors in 640x 400 mode. Resolu tion switching can be done on
the fly without having to reboot. Other specs are pretty much the same as the
540. This un it weighs 7.3 pounds.

PowerBooks and Duos
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PowerBook Duos
Apple's Duo li ne is designed to offer the best of both worlds- desktop and
portable computing. The basic un it is smaller than the regular PowerBooks,
less than an inch and a half thick, and weighs in at less than 5 pounds. It is
designed to mate with a docking device, known as the Duo Dock, wh ich adds
built-in Ethernet and NuBus card expansion, essentially converting the computer into a desktop model. Like the original PowerBooks, all Duo models
include a built-in trackball and palm rest. You need the Duo Dock fo r floppy
drive support.

PowerBook Duo 230
This model is a carryover from the original line. It comes with a 9-inch 16
color grayscale passive matrix screen and a 33Mhz 68030 CPU, and weighs a
litt le over 4 pounds. Battery life is advertised as 2 to 4.5 hours. It comes standard with 4MB RAM and an 80MB hard drive, with an option for 120MB, and
you can expand RAM up to 24MB.

PowerBook Duo 280
The newest PowerBook Duos are based on the older 270 and 270c. They sport
a 68LC040 CPU run ning at 66/33 Mhz (to quote Apple's new dual-speed
scheme once again). This model and the top-of-the line 280c will have
PowerPC upgrade paths. The 280 weighs in at just 4.2 lbs, and has a 9-inch
active matrix 16 color grayscale screen, wi th a resolution of 640x400 pixels.
The lone disk storage option is a 240MB ha rd drive. The supplied NiMH battery has an advertised life of two to fo ur hours.

PowerBook Duo 280c
This model is essentially identical to the Duo 280, but it offers an 8.4-inch
active matrix color screen, with 256 color resolution at 640x480 pixels, and
an option of 16-bit color (thousands of colors) at 640x400 resolution.
On board hard drive capacity expands to 320MB. This model weighs 4.8 lbs.

PowerBook Duo Dock II
This device provides the desktop capability fo r the Duos. You mate the Duo
into this unit, essentially sliding it on, and you get a floppy drive, built-in
Ethern et and space for NuBus expansion .
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Useful Accessories
Tip
Always travel with
a set of system
backup disks, hard
disk diagnostic
disks, and floppy
backups for your
most important
software packages
so that you can
quickly get up and
running in the
event of a disk
crash.

Before leaving on a trip, you'll probably want to get some useful accessories
that are bound to make your PowerBook work more effectively on the road .
The following sections concentrate strictly on items that you can easily pack
in an overnight bag. A visit to your favorite dealer will reveal many more
treasures from which to choose.

Portable Fixed Hard Drive
PowerBook drives usually have limited capacity and are expensive to replace.
If you're doing a large presentation or heavy-duty graphic work req uiring lots
of storage space, youll want to consider products such as the APS Technologies Companion II or the Liberty portable drives, both of which offer the
extra storage capacity you may need in small, convenient cases. The APS
product includes their DaTerm digital active terminatio n circuit, which helps
reduce fiddling around with SCSI connections during a trip.

Portable Removable Hard Drive
If you need to transfer files to different locations, a removable drive is a plus.
The new 3-1/2 SyQuest cartridges, available in both 105MB and 270MB varieties, weigh just three ounces and are especially suitable for travel. APS Technologies offers removable mechanisms in its Companion II line. The PLl
Infinity Turbo models also offer a good mixture of portability and convenience.

Powerbook Carrying Cases
So many shapes and sizes are now available that you are bound to find one
that meets your needs. Some products combine an overnight bag with a compartment for your PowerBook and some accessories. Other cases are hardly
larger than the computer. Our suggestion is that you get o ne with straps to
hold your Mac securely, with a sufficient amount of cushioning to protect it.
There should be a pouch or two that are large enough to contain phone and
SCSI cables, disks, and whatever accessories you need on your trip.

SCSI Disk Adapter
This cable allows PowerBooks and Duos (with the exception of the 140, 145,
14Sb, or 170) to be used as a hard drive on your desktop Mac.

SCSI System Cable
The PowerBook doesn't accept a standard SCSI cable, but this special cable
enables you to attach an external hard drive or another SCSI device to your
Power Book.

Useful Accessories
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The PowerBook SCSI Disk Adapter cable and the SCSI System Cable are frequently
confused with one another, even by some dealers. The Apple version of the former,
the product that turns your PowerBook into a SCSI disk, is dark gray and about 9-1 / 2
inches in length. The cable used to connect another hard drive to your PowerBook is
a lighter gray and about 18 inches in length. The difference is in the 30-pin connection jack that hooks to your Powerbook. The SCSI system cable has one pin missing,
which you can see at the upper left when the plug is facing you.

SCSI Terminator
You can buy a standard SCSI terminator for anywhere from $10 to $20, but
you might want to consider the $99 APS Technologies SCSI Sentry, an active
terminator that uses digital circuitry to maintain proper current and impedance across the SCSI chain, and reduce problems that sometimes affect a SCSI
setup.

Extra Battery and Recharger
If you need to do a long work session o n the road, or if you're using one of
the original all-in-one PowerBooks with a short battery life, a second battery
and a separate recharger will keep you running when power is low.

To get the maxi-

Modular Telephone Cord

PowerBook, turn

Tip
mum battery life
from your

You can buy a modular telephone cord at your supermarket, if your modem
wasn't shipped with one (although they usually are). j ust get a simple cable
with the standard Rj-11 modular jacks at each end.

off AppleTal k, File
Sharing, and, if
you have enough
RAM, set up a RAM
disk in your

Digital Phone Switch
One of the manufacturers of PowerBook modems, Global Village, offers such
a product, which provides an interface between a PBX digital phone system
and your PowerBook's modem.

PowerBook Management Software
Programs such as CPU from Con nectix, PB Tools from lnline Software, and
Power To Go from Claris provide tools to monitor power use and to allow
you to quickly change settings to maximize battery life. The PowerBook Mobility Bundle shipped with the new 500 Series models also p rovides a set of
useful utilities to get the maximum amount of working time between
charges.

Memory Control
panel.
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Note
Although Apple suggests caution when running your PowerBook through the x-ray
devices at an airport security check-in, the chances are slight that you would be at
risk of damage to your data. If in doubt, insist on a manual inspection, and have your
PowerBook left in the Sleep mode, rather than shut off, so that its startup routine can
be quickly observed by the airport security personnel.

Portable Printer
While your traveling bag is apt to get crowded with all the accessories you
can buy, if you intend to create many documents, you might want to bring
along a portable printer, too. Apple, GCC, Hewlett-Packard, and other manufacturers offer lines of small printers that you can use to process your mission-critical documents during a trip. Don't expect any of these models to be
speed demons compared to your desktop printer, but they more than make
up for their slower performance in terms of convenience.

TV / VCR Interface
If you expect to use your PowerBook to generate a slide show or other presentation, you'll want to bring an interface unit, such as the Lapis LoTV Po rtable
at hand. These products allow you to hook up many PowerBook models directly to a TV or VCR.

Pow erBook M obility Bundle
Apple's new PowerBook an d Duo line is bundled with a set of software designed to make it easier to stay in to uch while on th e road and to work with
the data you create when you return to your home or office. Following is a
brief sum mary of what it incl udes:

• Apple Remote Access. Chapter 29, "Getting Online," discussed this program i n detail. The most attractive feature to the traveler, aside from
the easy connectivity to your Mac's deskt.op, is its DialAssist utility. This
program, shown in figure 35.2, enables you to customize telephone
settings to make it easier to dial out from wherever you happen to be
traveling.
Settings for your area code and country make dialing those complex
international country codes less of a chore. You can establish a prefix to
get an outside dialing line or to reach your preferred long distance carrier. There's even a special suffix setting where you can enter your credit
card or calling card number (the numbers themselves appear only as
bullets on the Mac's screen).

Useful Accessories
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Fig. 35.2
DialAssist utility
stores custom
telephone dialing
sequences.

LOtiO otshtiCt Aco.-ss •

, .... ,
[

'""'"''I ,.,.

Country...

[ Long Dlstoncc ...

I(
I[

·I

PrefiH .. .
Suffht .. .

Caution
Be careful when storing passwords o r calling card numbers in your communications software. Someone who gets access to you r computer may also be
able to place calls with your phone credit card, even though the number
can't be read.

•

PowerTalk (bundled with top-of-the-line PowerBook models). Apple's
system-level electronic mail system, PowerTalk, enables you to create an
in box and an out box on you r desktop, where you can send and receive communications. You can establish special settings, depending on
where you are located, so that when you log onto your network after
returning to the office, you can automatically send your communications.

•

eWorld. You get a special sign-up offer for Apple's eWorld online service

and a software disk. Apple's new online service is described in Chapter
31, "Using eWorld."
•

PC Exchange. This utility, which is also included with many desktop

Macs, allows you to mount MS-DOS disks o n your Mac's desktop, and
to perform simple data conversions.
•

Easy Open Translators. The ability to tran sfer files from one format to

another, or from one computer platform to another is detailed in Chapter 34, "Data Exchange."
•

Apple File Assistant. When you return to your home o r offi ce, you can

use this handy utility to synch ronize the files you've created on the
road with the ones on your desktop Mac.
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• Power Management. Apple's unique Control Strip, shown in figure 35.3,
provides a comprehensive look at the status of various systems on your
PowerBook, ranging from the remaining battery life to whether
AppleTalk and File Sharing is on or off.
Hard disk
Fig. 35.3

Apples Control
Strip provides an
on-screen display
and control panel
for various system
functions .

Sizing tab

Close Be

In addition to monitoring these functions, you can use the Control Strip to
change settings, or even customize it to show only the status information you
select.

Using On The Road
Even though you may be traveling, there are times when you need to fax or
print a document, but you have neith er a telephone nor a printer handy.
Through a nifty program from Connectix, called On The Road, you can continue printing and faxing, just as if you actually had a modem or printer
attached to your computer.
When you are back at your office or home, as soon as you reattach your Macintosh to your network or phone line, On The Road automatically configures the Mac to your location (somewhat in the way PowerTalk does). The
program displays an icon indicating your location, as shown in figure 35.4.
Fig. 35.4

Connectix On The
Road is accessible
by a Finder level
pull-down menu.
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The settings On The Road uses to determine your location are set in the
program 's preferences, as shown in figure 35.5. In situations where you may
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be connecting to different networks with printer setups that differ on ly
slightly, you may prefer to have the program put up a dialog box requesting
your exact location.
Fig. 35.5
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On The Road is quite flexible in the way you can set it up. While you're o n
your trip, you can print and fax normally. When you are reconnected to your
network, the program will sense the network change and begin to feed your
printed documents to the selected printer. You can even redirect the job, if
that printer is busy, which is something that even Apple's own PrintMonitor
cannot do. When you are hooked up to a telephone line, you can have On
The Road fax your documents for you, too.

Sending Faxes
Most hotels offer fax service, but at a cost of a dollar or more a page, it's usually much m ore convenient and less expensive to use your own fax modem
and your Macintosh to send your documents. Chapter 29, "Getting Online,"
described how to use a modem, telecommunications software, and fax software. just about every modem you can buy nowadays offers some form of
faxing capability.
All PowerBooks have a provision for internal modems, and wide ch oice is
available, with many models selling for less than $200. If you have a
PowerBook Duo, however, you'll only be able to select from Apple's Express
Modem, or products from Global Village. A similar situation exists with the
new PowerBook 500 Series. Global Village provides a version of their 19,200
bps PowerPort Mercury fo r North America, and Apple provides a versio n of its
Express Modem elsewhere around ,the world.
A PowerBook modem is a marvel of engineering ingenuity, bei ng about as big
as a standard business card as well as extremely thin. Altho ugh installation is

Tip
One neat way to
prin t your documents without a
prin ter is to fax the
documents to your
hotel or to someone else with a fax
machine instead.
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a fairly simple process on a regu lar 100 Series PowerBook, it becomes more
daunting on a Duo or the new 500 Series models, and dealer installation is
recommended.
If your PowerBook doesn't have an internal modem, of course, you can always pack a desktop model with you. They fit into the side compartment of
many PowerBook carrying cases.

Caution
Digital PBX telephone systems may not work with a standard modem, and may
damage the modem's delicate circuitry. If you intend to use a modem at your hotel,
be sure to check with management about the type of system they offer, and ask
whether their phones are equipped with a data line. The data line is generally a
standard RJ-11 modular telephone jack to which you can attach your modem.

Sending E-mail and Files
Tip
You'll find access
to your favorite
online service
more convenient
if you record the
access numbers
for the cities to
which you're
traveling beforehand .

Tip
Hotels often
add big surcharges for
long distance
calls. If you
have to dial
another city to
reach your
online service,
you may be
better off using
a credit card.

Armed with your PowerBook and a modem, staying in touch on the road isn't
much more difficu lt than remaining in contact from your home or office. The
major online services, such as America Online, eWorld, and CompuServe offer,
as well as show in the coming pages, easy ways to locate conn ection numbers
in most U.S. cities. If you're traveli ng abroad, you should check with the online
service as to how to log on. This chapter focuses on connections in the U.S.
Using an online service, you can send and receive m ail from your business
associates and fri ends, and you can also transfer important files. That way,
you can continue to do your wo rk, say, from th e comfort of your hotel room
(if you're not o ut sightseeing), and easily send it to the proper recipient.

Note
If you need to send a huge file of several megabytes or more, you may find that
online charges and telephone bills cost you more than simply packing up the disks
and send ing them to the recipient by overnight carrier. If you are not facing a serious
deadline, this may be an option to consider.

•
Using America Online On The Road
The newest versions of America Onli ne software, beginning with 2.1, offer a
Locality feature that enables you to create custom calling setups for telephoning from home, the office, or while traveli ng. If you have an earlier version of
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the software, upgrade to this new version because it offers 9600 bps access
(with a connection number that supports that speed).
Before you create a new locali ty profile, get a list of local phone num bers. To
do that, simply log onto America Online and type the keyword Access. That
keyword will take you to the free area shown in figu re 35.6. This department
allows you to search America Online's huge database of connection numbers
throughout the U.S. and Canada.
Fig. 35.6
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The quickest way to find the numbers you want is to click on the Search
Access Number's listing in the directory, shown in figure 35.6. You'll see a
search screen like the one shown in figure 35.7. Enter the area code of the
city you're visiting in the field . If you want to concentrate on 9600 bps numbers alone, just enter the words and 9600 after the area code.
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Fig. 35.7
America Online's
speedy search
mechanism tries to
find the local
connection
numbers you
want.

ra

To see the list of numbers, just double-click the listing in the directory window. If suitable numbers aren' t found, try a neighboring area code and see
what it produces for you. Save the entire list, in case you have difficulty connecting with the first number you select.
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After you obtain a list of numbers, create a new Locality profile for the cities
you intend to visit. Simply select New from the File menu of your AOL software and choose Locality from the sub menu. You'll see a window like the
one shown in figu re 35.8.
Fig. 35.8
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If yo u are uncertain how to select a profil e for your modem, simply review
your Setu p box, which is reached from the mai n window of your AO L software. Copy the settings from Connection Port, Modem Type, and other
options from there. If yo ur portable Mac has a different m ake and model
modem, you' ll wa nt to see whether a profile is available for that model or
be guided by the manufactu rer's instructions. If sui table instructions aren't
available, try Hayes Basic or Hayes Error Correcting, which are offered in
the pull-down menu unde r Modem Type.

Note
America Online has a free support library for mo dem profiles. just enter the Online
Sup port area (Keyword: Help), and click the Modem Help icon, which is at the right
of the Online Suppo rt forum window.

At the top of the Locali ty window is the space to enter the number for your

first con nection attempt. I suggest you choose an alternate number (even if
it's in a different city) for your second connection attempt to ensure that you
can log on in case the local number is busy.
Note
There is actually a second way to get a local access number from America Online,
using the methods described in the sectio n o n eWorld later in this chapter. The
descriptions provided in that section apply in almost identical fash ion to AOL.
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Using CompuServe On The Road
Because CompuServe's access number search m echanism doesn't sport a
fancy icon for CompuServe Info rmatio n Manager, l just used my regular
telecommunicatio ns software to get a list of connection numbers. Log onto
the service in the normal way, as described in Chapter 30, "Using America
Online and CompuServe." Type the Go words GO PHONES to display the
directory shown in figure 35.9.
CompuSerue

Fig. 35.9
CompuServe's
convenient phone
number search
mechanism.
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After you enter the area code of the city fo r which you seek a telephone number, a list of the avai lable phone numbers appears. You'll have the option of
choosing a standard 2400 bps connection number or one supporting the
newer 9600 bps and 14,400 bps offered by CompuServe, as shown in figure
35.10.
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Whether you're using a regular telecommunications program o r CompuServe
Information Manager or CompuServe Navigator, you can save the terminal
window showing the phone numbers for which you searched. That way you
can review them later when you are on the road.

Fig. 35.10
High-speed
connection
numbers merit a
special listing on
CompuServe.
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Using eWorld On The Road
Apple's new online service uses more of an automated phone number search
process than CompuServe. In order to change your access number, you
launch the eWorld program and then click the Local Setup pop-up menu,
which produces a Get Local# choice, shown in figure 35.11. (The method I'm
about to describe can actually be employed in essentially the same way to
locate a new access number on America Online using, of course, your AOL
software.)
Fig. 35.11
The first step in
using eWorld's
phone number
search routine.

Connect t o eWorld

eWorld
eWorld name:
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l:

I
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Click the Connect button to access eWorld's 800 telephone search service,
and when the opening screen appears (see fig. 35.12), enter the area code fo r
which you seek telephone numbers.
Fig. 35.12
Finding local
connection
numbers eWorld
style.

tntu..Y.our nrs;n code

To connect to eWorld, you u::e a
'1ocalaccess" phone number.

Areacode:

~

To find a Ust oflot111l aetMs pho ne

numbers in your e. rea, type your e.rea
rode In th e box at the righ t. then d i ck

Continue.

If local access numbers are available, they'll appear in the next screen, shown
in figure 35.13. You just click the ones you want to add. If a local number is
not ava ilable, you can choose an alternate area code to try.

Going Wireless
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Fig. 35.13
eWorld suggested
connection
numbers in the
ci ty you selected.

D Use Selected f'ok.mber II

After the numbers are added, you are logged off and the standard Locality
window appears, with your selected numbers already entered for you. The
next step is simple. Click the Save Setup window, which opens a Save As
dialog box. Enter the name of your new Locality profile. To make it easier to
find later on, you can name the connection settings after the city to which
you're traveling. Once saved, the name of the new Locality settings shows up
as on the Local Setup pop-up menu.

Using MCI Mail
Unlike the regular online services, MCI Mail concentrates on one specific
function: serving as your electronic post office. You can send and receive email, or have your letters delivered by the post office or sent as a fax. You pay
an annual fee and receive an 800 telephone access number. Receiving mail
doesn't cost you extra, but you h ave to pay for each message you send. The
pricing schedule depends on the size of the message and whether a copy is
being sent by snail mail or fax. You can get additional information on MCI
Mail by calling (800)444-6245.

VI

Going Wireless
You sometimes may travel to places where no teleph one line is handy, but
you still need to be able to stay in touch. Cellular telephones are a ubiquitous
site on the American landscape these days, but as described in Chapter 29,
"Getting Online," they present unique problems in maintaining stable connections.

Wireless Modems
One solution to this dilemma is the arrival of devices that incorporate a cellular telephone and a modem. Manufacturers such as Motorola are introducing

Tip
If your travel plans
change, use such
services as America
On line and
CompuServe and
their Easy Sabre
feature to make car
rental, hotel, and
plane reservations.
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these units that, although presenting the utmost in convenience while traveling, are apt to exact a higher price than a separate phone and modem.

Connecting to a Cellular Telephone
As explained in Chapter 29, cellular telephone connections aren' t nearly as
stable as your regular home telephone. As you travel from place to place, the
signal from your telephone is passed off from o ne cellular center to another.
The quality of the signal can vary as you pass around buildings and hilltops.
To cope with this occurrence, Microcom has an MNP-10 error correction
protocol that's supported by some modems. The manual for your modem
should indicate whether this scheme is supported.
A modem that doesn't have MNP-10 will most likely work, but it will work at
reduced efficiency. You also need an interface to hook up directly with many
cellular telephones. Global Village has a variation, a product called PowerPort
Coupler, a base to which you can attach the headset of your cellular phone (or
even a pay phone). The other end hooks into your PowerBook. This acoustic
coupler promises reliable transmissions at up to 9600 bps.

Giving Presentations
...

See "What is
Out There,"

p.403

...

See "Adobe
Photosho p,"

p.649

<II See "Adobe

Audition,"

p.670
<II See

"QuickTime,"

p.670

Giving a presen tation used to mea n lugging around a slide projector and tray
or a VCR from place to place. Armed wi th a PowerBook, the right presentation software, and some video pro jection devices, you can now give highly
professional slide shows and other demonstrations wherever you travel.
Chapter 17, "Presentation Graphics," reviewed several of the most popular
software packages for generating charts and slides. These include Claris Impact, DeltaGraph Professio nal, Microsoft PowerPoint, and Gold Disk Astound.
In addition, you can generate attractive charts with Adobe Illustrator. A growing number of Mac programs support Apple's QuickTime technology, which
allows you to easily create audio and video multimedia presentations. Chapter 23, "Digital Photography and Desktop Video," describes the magic you
can produce with programs such as Adobe PhotoShop, Apple's PhotoFlash,
and Video Director.
Note
Since complex digital video presentations may consume a great deal of disk space,
you may find it convenient to carry a portable hard drive in your travels.

Giving Presentations
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Using a Large Screen TV
One convenient way to play your presentations from your notebook Macintosh is with a large screen TV. Although it's not something you want to carry
around on a trip, some large audito riums are equipped with a mo nitor of this
sort. Models such as Mitsubishi's line of 37-inch mo nitors cost many thousands of d ollars, but provide extraordinarily clear images, mo re crisp than
most normal TVs with comparably sized screens.
This sort of installation isn't quite plug and play, however. Your Mac deals
with RGB signals, and a TV speaks NTSC (or PAL and SEC for internatio nal
setups). This setup therefore will generally require an adapter in terface of
some sort.

Using an Overhead Projector
A less costly alternative to a monitor-and one more suited to a larger auditorium-is an LCD projectio n panel. Th ese devices are designed to fit on top of
an overhead pro jector, just like a slide. The panel acts as an externa l monitor,
and you can project exactly what you see on you r Mac's screen. Pro jectio n
panels that are small enough to fit conveniently into a briefcase or a shoulder
bag are available.
Although far less expensive than a large screen TV, LCD projectio n panels
aren't necessarily cheap, especially the ones that offer full color output. An
LCD projection panel can cost more than a top-line PowerBook, so if you
only need this sort of accessory occasionally, you might find a dealer who
will rent a unit fo r you.
Some products actually combine the projection panel and a pro jector into a
single unit, complete with a carrying case for travel. If you plan o n giving
presentations at locations where local projection equipmen t isn't available,
this may be an alternative to consider.

Presentations On The Cheap
You can use o ne more method to show a Mac-created presentation. j ust visit
a local service bureau that has a film recorder. They'll be able to take your
document files an d transfer them to slides. This back-to-basics approach also
shows that the o ld fashioned slide projector is not quite o bsolete yet.

VI
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Amplifying The Sound Portion of Your Presentation
Your Mac's internal speakers may be suitable for a small gathering in a small
room, but they don't provide nearly enough volume for a larger setup. But
your Macintosh is capable of offering very high quality sound, especially th e
newest PowerBooks with 16-bit audio output, wh ich is equ ivalent to a audio
compact disk.
A number of powered loudspeakers are now available for audio and video use,
such as the popular AppleDesign Speakers, which will fit neatly into an overnight bag. You can mount them beside a large screen moni tor. For a larger
auditorium, you may want to acqu ire a standard public address amplifier and
speaker system.
Note
When you buy a set of powered speakers for your Macintosh, spend a little time
listening to them before you take them home. As with the loudspeakers you buy for
your stereo system, the sound varies tremendously from model to model, and they
may sound different when moved from one environment to another. Listen carefully
for clear, undistorted reproduction of both music and speech, especially at roomfilling volume levels.

From Here ...
This chapter provided helpful hints and explained how to use your Mac most
effectively to stay in touch o n the road. It also provided a list of the accessories you might want to buy before you take your trip.
• Chapter 29, "Getting Online," tells you the ins and o uts of buying and
setting up your modem and getting connected.
• Chapter 30, "Using America Online and CompuServe," talks about two
of the most popular online services.
• Chapter 31, "Using eWorld," describes Apple's new consumer-orien ted
online service.
• Chapters 3 7 and 38 describe the steps you need to take to trou bleshoot
common p roblems with you r Mac and explain how you ca n solve them
before they become serious.

Chapter 36

Setting Up the Perfect
Home Offi ae
by Mark Bilbo

The office used to be a place in a city center to which people drove each day.
The home and the office were usuall y separate places, sometimes distant from
one anoth er. Today, increasing numbers of people are finding it convenient
not just to bring work home fro m the office but to bring the office home.
Many people have moved their offices completely home.
As desktop com puter power has grown and in formation "highways" have
become more common, many options for home businesses have opened up.
Many people set up businesses for telecommuting, contracting their services,
or worki ng freelance.
This chapter helps you efficiently set up you r home office by covering the
following considerations:
• Creating a safe and comfortable work environ ment
• Protecting your Macintosh from damage by power surges, dust, and
theft
• Purchasing helpful accessories for the home office
• Examining hardwa re choices that are both affordable and well-suited to
the h ome office
• Exami n ing software choices to increase prod uctivity and enable you to
work more easily with your main office

VI
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Products mentioned in this chapter are widely available through your dealer,
computer superstore, o r favorite mail-order com pany unless o therwise specified as "direct" (meaning available only directly from the manufacturer).
Competing products are also available through the same sources. You may
wan t to use the recommendatio ns in this chapter as basic guidelines to enable you to do comparison shopping.

Creating a Work Environment
Setting up a home office involves more than putting your Macintosh on a
desk in the den. Whether you are planning to work only a few hours a week
or fu ll-time, you will need to create a work environment that is both safe and
comfortable.
This section talks about concerns often overlooked when a home office is set
up: choosin g a safe location to place the Macin tosh, protecting you r investment by safeguarding the computer, choosing and adjusting furniture to
avoid back and neck pains, and other considerations.

Choosing a Safe Location
After spending a few thousand dollars on a computer, you don 't want to
endanger your investment. You also should think carefully about issues such
as lighti ng, noise, and space when locating your Macintosh.
Although computer eq uipment is more durable than you might suspect,
computers are senstive to some elements. When choosing a location for your
home office, think about the followi ng potential problems:

• Direct sunligllt. just as long-term exposure to direct sunlight can heat up
your car, your Macintosh can reach damaging temperatures if sunlight
fa lls o n the case for extended periods of time. Locate the Macintosh
away from windows, or be sure to close curtains or blinds to avoid this
problem.

• Temperature extremes. Both high heat and extreme cold are damaging,
but extreme heat is more likely to damage your computer. Normal
room temperature (or slightly cooler) is best for computer equipment.
As a rule of thumb, if you are comfortable, your Mac will be comfortable.

Creating a Work Environ ment

1017

Caution
Don't forget to think about what happens when you leave your home office or
even your home on long trips. The room may be perfectly comfortable during
the hours you work, but what about when you are gone? Temperatures below
50 degrees or above about 120 degrees can damage the Macintosh as well as
your floppy disks.

• Moisture. You certainly would avoid placing your Macintosh in water,
but you should also consider humidity. Condensation can be destructive to your Macintosh. Avoid damp rooms.

Caution

Tip
_

Keep food and drink away from the computer. One coffee or soft drink spill
can cause expensive damage. Avoid placing the Macintosh in areas of the
house where the family commonly carries food and drink.

• Dust and srnoke. Dust is an enem y of computers. Dust can get into hard
and floppy drive mechanisms and block the exhaus t vent s o f the
Macintosh. Dust can also coat the electronics inside the Macintosh and
cause the components to ove rheat. Avoid dusty rooms. Smokers should
be awa re of the risk t h ey take exposing the Macintosh to tobacco
smoke. Avoid ing smoking in the home office is the best solution . The
second best solution is to locate the Macintosh in a well-ventilated
room.
•

Believe it or not, you should vaccuum your computer. Suncom Technologies offers a cleaning kit that includes a vacuum suitable fo r removing dust from you r Maci ntosh, as well as other useful clea ning item s fo r
your floppy disk drive, monitor screen, and mouse, for o nly about $30.

•

For the truly cheap (such as myself), you can get away with using a n
ordinary h ome vacu um to clean your Mac. With the Macintosh off,
I use the attach m ents meant for upholstery to clear the exh aust vents
and clea n the Macintosh of dust. Don't laugh-it works. Just be gentle,
and don't jam anything into the Macintosh's insides.

One way to avoid
dangerous spills is
to use travel mugs
with lids. Also,
avoid placing the
mug on the same
desk with your
Macintosh.
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•

Vibration. Excessive vibration can cause hard drive failure. Wash ing
machine spin cycles can shake floors and walls, especially in older
homes. You may need to avoid placing the Macintosh too close to utility rooms.

•

Poor grounding. The Macintosh, as with all computer equipment, needs

to be pl ugged into a three-pronged outlet with a good ground. Avoid
the use of two- to three-prong adapters. In older homes, you may want
to have the wiring checked even if you have th ree-prong outlets because sometimes the groun d is not actually connected.
You may have other considerations depending on where you live and the
particular conditions of your home. Users on the West Coast, for example,
must consider earthquakes and avoid placing the Macin tosh beneath shelves
because the items on the shelves (or the shelves themselves) may fa ll. Carefu lly consider the location for your home office. Anticipating hazardous
conditions is better than having to correct the pro blem later.

Choosing a Comfortable Lo cation
Tip
Floor lamps that
illuminate the
ceiling and indirectly light the
room are available.
Halogen lamps of
this type are often
inexpensive and
come with dimmers.
Tip
Glare screens or
filters over your
Macintosh monitor screen reduce
the problem of
reflected tight.
These items range
from about $30
to $75.

You will most certainly avoid areas that are obviously uncomfortable when
locating your Macintosh, but a few considerations may not be immediately
obvious, such as lighting, noise, and space.
•

Lighting . Indirect lighting is best and should fully illuminate the work

area. Avoid placing your desk in a location where your monitor screen
will reflect sunlight or lamplight. A glare can cause eyestrain that leads
to headaches and tension.
•

Noise. Choose a qu iet location, especially if you will be working in

your home office fu ll-time. Using a room right next to the den or
fami ly room, for example, could limit your ability to work without
distractions.

• Space. Ample space is often a problem for setting up a home office.
Ideally, your home office should be in a separate room for several reasons. One important reason is ho me office tax deductions, which are
easier to make when you have a clearly defined home office area (check
with your tax professional on home office deductions; IRS rules are
known for changing frequently).
An important consideration is whether the room has a door that locks. If you
have children, you are already aware of the reasons to have a door that locks.

Creating a Work Environment
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Finding your eight-month-old niece chewing on a disk might be cute, but the
disk rarely survives. Also, closing doors reduces noise.
You should try to have sufficient space to enable you to gather all the items
you need to work in a single, easily accessible location. If your Macintosh is
upstairs and your reference books are downstairs, for example, you may
spend much of your work time running up and down stairs trying to find an
article.
People may have once thought that comfort had no place in the office, but
today the understanding that comfortable people are more productive people
is growing. Good, indirect lighting, a low noise level, and perhaps a nice view
out a window can contribute to a productive environment for your home
office-more than you may think.

Protecting Your Macintosh
Four threats to your Macintosh exist, but you can take inexpensive action to
prevent or reduce them. These threats are dust, power surges, static electricity, and theft.
Dust
You may have located your Macintosh in a room that has little dust, but dust
is always in the air. Dust covers are inexpensive-running from $10 to $20and can protect your Macintosh from harmful dust buildup. You can purchase dust covers at your local Apple dealer or through mail order.
Caution
Dust covers are meant to protect your computer while the computer is turned off.
leaving dust covers on a computer while it is running can cause heat buildup by
blocking the ventilation of the computer's casing. If you use your computer for long
periods, you might also want to let it cool before placing the dust cover on.

Two notable products in the dust cover category are the ThinSkin and the
HardTop keyboard covers by Basic Needs. The ThinSkin keyboard cover remains on your keyboard at all times and prevents dust, liquids, and food
particles from falling into your keyboard. (Yes, I know I said don't eat and
drink around the computer, but the author is a hypocrite and knows others
are going to have the cookie-crumbs-in-the-keyboard problem, too.) The
ThinSkin's worth the $16 or so-that's one tenth the price of a new
keyboard.

Tip
Air filtration
devices can reduce
the amount of
smoke in a room.
They cost around
$60 to $100,
which is much
cheaper than a
Macintosh repair.

VI
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The HardTop keyboard cover is mo re durable-made of the same material as
football helmets- and is impact res istant. The HardTop costs from about $15
to $17.
Power surges
The greatest enemy of the Macintosh o r any electronic equipment is the
power surge. Normal voltage levels in the U.S. are around 110-120 volts, but
infrequent, sho rt surges (or spikes) of as much as ten times the normal voltage
level can occur fo r va ri ous reasons.

Power-surge protectors block these sudden, brief increases of voltage, which
can literally burn holes in the computer's in ternal board. While 1,000 volt
spikes are rare, smaller but still damaging surges are not uncommon.
No Mac intosh owner sho uld be witho ut a power-surge protector. Power-surge
damage to computer eq uipment is painfully expensive and much more costly
than a good protector.
When you choose a power-surge protector, consider these qualities:

• EMl/RFl filters. Avoiding technical discussions, EMl and RFI are 00ise"
in power lines that can degrade the electro nic compo nents in your
Macintosh. A good power-surge protector includes these filters.
11

• Rapid respo11se time. Respo nse time represents how quickly the powersurge protector acts and is expressed in nanoseconds (billio nths of a
second). The lower th e number is, the faster the protector acts to prevent damage to your Macintosh .
• Failure indication. Audible alarms are now included in many protectors
to indicate that the protection circuitry has ceased to fu nction.
• Modem/fax protection. If you have a modem o r fax modem, you will
wan t to have protection from power surges o n the phone lines, too.
Modem /fax protection is included with many models of surge
protectors.
Caution
Be aware that there are power strips that provide extra outlets but offer no protection
for your Macintosh. M ake certain to purchase a power-su rge protector.
Nothing can protect your Macintosh from direct lightning strikes on power lines. Do
not assume that a power-surge protector will guard you and your Macintosh during
thunderstorms. Your only safe course of action during a thunderstorm is to shut
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down and unplug the Macintosh. If you have a modem, you should disconnect the
modem from the phone line.
A case in point: My stepfather left his computer plugged in, though turned off,
during a thunderstorm. A lightning strike on the power line fused the power-surge
protector, and then proceeded to burn a one-inch hole in his computer's main
board.

Many people have home offices to avoid living in the city. Some even move
to more rural areas. Unfortunately, rural areas are more prone to another
power problem: brownouts. Brownouts are when the power level falls. You
will notice that the lights in the house go dim either briefly or for noticeable
periods of time.

Tip
Ask your power
company about
lightning arrestors
on your power
lines if you live in

These kinds of power fluctuations can damage your Macintosh and can cause
you to lose data. You may want to consider an Uninterruptable Power Supply
(UPS). These devices use batt~ries to deliver emergency electricity during
brownouts and power failures long enough to enable you to safely save your
data and shut down your Macintosh.

an area of frequent
thunderstorm s.

A UPS is an expensive piece of equipment and, so, should be considered only
if you experience frequent power problems that the power company cannot
(or will not) address, and if data loss would be severely damaging to your
home business work. Kensington offers four UPS "Power Backer" models
ranging from $280 to as much as $660. The more expensive models can deliver more power over longer periods.
Static electricity
Static electricity is merely an annoyance to a human being, but those sharp
little jolts can be death to disks and com puter components. If you live in a
dry climate or find yourself being popped when you touch doorknobs, your
data and even your Macintosh could be in jeopardy.

Inexpensive antistatic sprays are available through dealers, ma il order, and
even many ordinary office supply stores. Use the sprays liberally and frequently on carpeting around your computer, the area in which you walk
when working, and even the upholstery of your desk chair.
If you live in an area where static electricity buildup is a frequent occurrence,
you may also want to consider purchasing an antistatic pad to place beneath
your desk chair, especially if you have a rolling chair.

VI
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Theft
Your Macintosh is an investment that you should protect the best you can.
You should consider protecting your Macintosh from theft.

You may consider insuring your Macintosh. Because homeowner policies
often do not cover equipment used in business pursuits, you may need additional insurance. Some companies specialize in insuring computers even
against occurrences such as power surges. You can find several advertisements
for computer insurance in the back of major computer publications such as
MacUser magazine. Be certain to consult with your insurance agent about
such policies.
Another option is to secure your Macintosh. Kensington offers an Apple Security System for about $35 that enables you to chain the Macintosh to your
desk. (Of course, you need a sturdy desk.)

Selecting Furniture
Furniture issues relate to ergonomics, which essentially means having a work
environment that is healthy. Many have become aware of problems caused
by poorly designed office environments, but few are aware of some simple
steps that can he taken to reduce or avoid the problems.
Desk and Chair Considerations
Your office desk and chair should, if at all possible, be ch osen together. Desks
are generally constructed to have uniform heights, so the chair should be
adjustable; you should be able to raise and lower the office chair so that you
can work comfortably and sit with a straight back.

The desk should have ample space to enable you to arrange your Macintosh
and work tools, and still have a decent workspace. You should be able to
arrange your work items so that you avoid excess bending and stretching.
Look for a chair that offers good back support. Sitting for long periods with
poor posture can result in painful back problems. The ideal chair height
places your elbows at about a ninety degree angle when you are typing. Having a chair with an adjustable height enables you to achieve this position.
Monitor Considerations
The ideal monitor position places the monitor about 18 inches fro m your
eyes, which is normal focusing distance. Your eyes then do n ot have to constantly work to focus on the monitor screen.
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The monitor height should place the screen so that you are looking straight
ahead. Stands for monitors and for Macintoshes with built-in monitors are
available at many Apple dealers and office supply stores. Be certain to purchase a sturdy one. Avoid the temptation of the cheap plastic stands.
Keyboard Considerations
Keyboards have been at the center of a storm of controversy because of the
appearance of repetitive stress disorders such as carpal tunnel syndrome. The
problem lies with the stresses of repetitive motions of the fingers, hands, and
wrists.

While no absolute agreement exists on how to avoid the problem entirely,
you can take some steps to reduce the threat of this expensive (and painful)
problem.
Many companies now offer wrist savers, which are padded rests used with
keyboards and mice. These devices enable your wrists to be at rest rather than
strained to maintain proper typing or mouse-maneuvering positions.
LB Innovators offers several of these items with price ranges from about $15
to $25. The WristSaver supports your wrists and reduces strain during typing.
Tht! WristSaver MousePad is a mouse pad that includes a wrist rest. A combination package including both wrist rests is available.
Some of the most innovative products aimed at reducing the problem of
carpal tunnel syndrome come from Apple Computer. The new Apple Adjustable Keyboard looks odd with its split design, but this keyboard enables you
to adjust the angle of the two halves of the keyboard so that your wrists are at
natural angles instead of bent to fit a straight keyboard. The keyboard currently sells for about $150 through mail order and includes wrist rests.
One possibility for avoiding strain is one I have used. The old QWERTY
design of the keyboard came out of an odd solution to the problem of keys
jamming on the original typewriters. Frequently used keys were deliberately
spaced widely. The result is that your hands and fingers do more "traveling"
as you type. While my evidence is anecdotal (that is, pure personal experience as opposed to some scientific study), I can say that I come away from
long typing sessions feeling much less "strained" when using the Dvorak
arrangement than when I used QWERTY.
The Dvorak keyboard has been around for decades but has never gained wide
acceptance because of the huge number of typewriters that would have to be
replaced (being mechanical, they would have to be replaced with Dvorak
typewriters rather than simply reconfigured, as computer keyboards can).
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Fortunately, com pu ters ca n easily be switched to a Dvorak keyboard configuration and back aga in.
The Dvo rak keyboard arrangement places the most frequen tly used letters on
the home keys. This arrangement enables you to spend approximately 70
percent of your typing o n the home keys as opposed to about SO to 55 percent, reducing th e amo unt of movement you r hands have to do. I switched
four years ago and fou nd that the Dvorak arrangement reduced the amount
of "reaching" necessary when typing.
If you are interested in switching to the Dvo rak arrangement, be aware that a
period of ad justment and retraining is needed. Also, you need a Dvorak keyboard layout to install in your System file.
Nisus Software at (619) 481-1477 sells MacQWERTY for $45 direct. The product contains two Dvorak keyboard layo uts, a customization program, and
keytop stickers. For retraining you rself, consider Mavis Beacon Teaches Typing from Software Toolworks at about $50, available through dealers and mail
o rder.
After MacQWERTY is insta lled on the Macintosh, you switch between the
standard QWERTY arrangement and the Dvorak arrangement through the
Keyboard contro l panel (see fig. 36.1).

Fig. 36.1
Choosing a
Dvorak keyboard
arrangement.
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I am sold on the Dvorak keyboa rd arra ngement, but you should keep in mind
the fo llowing considerations that will affect your decision about switching:

• Dvorak is not widespread. If you move between offices o r companies, you
may need to do as I do and carry th e Dvorak keyboard software around
with you. (Dvorak keyboard software for the IBM exists, and shareware
versions are ava ilable on many online services.)

• Retraini11g takes some time (lllr/ effort. So don't make the switch during a
busy time o r you' ll be down to hunting and pecking.

Creating a Work Environment

• Typewriters can't be converted. If you have to use a typewriter (although
nobody should have to by now), you'll be hunting and pecking when
you make the changeover.
Overall, if you spend the bulk of your time working at your own computer
(home, office, or both), or if you work almost exclusively with computers
(Macintosh or IB\4 PC), the barriers to switching are fa r fewer than ever. And
the Dvorak keyboard is far easier to type on once you make the switch.
Mouse Considerations

Heavy users of the mouse often find their wrists and hands bothering them.
You wouldn't think moving a small device around in a small space could
have such an effect, but over time, even small motions can cause pain.
One of the LB Innovator's WristSaver MousePads might give just the support
you need, but you should also be aware that other possible solutions exist.
Apple offers an ergonom ically designed mouse for about $80. The Apple
Desktop Bus Mouse II is more comfortable to use. Mouse Systems offers one
of my personal favorites in the mouse category: the optical mouse. Optical
mice use a special mouse pad and have no moving parts, using instead reflected light to detect motion. I find that optical mice are easier to move; they
glide more smoothly than the standard roller ball type mouse. They're also
easier to keep clean. The Mouse Systems Little Mouse is ergonomically designed to be easier on the hand and wrist, and costs in th e neighbo rhood of
$70.
Some find that the solution to a mouse problem is not to have a mouse at all.
Some people prefe r the trackball, which looks som ething like an upside-down
mouse. The ball is on top, and you move it by using your fingers. Trackballs
take a bit of adjusting to at first, but many people find that trackballs reduce
the amount of movement the wrist must make and prefer them to mice.
Mouse Systems offers the A3 Trackball for about $70. This device has built-in
wrist support and is designed to fit the hand.
One of the most popular trackballs is the Kensington Turbo Mouse, which is
so widespread now that you can even obtain optional, decorative balls to
replace the supplied ones. The Turbo Mouse costs around $ 110 and comes
with software to enable you not only to adjust the sensitivity of the trackball
but to customize the buttons and create hot spots (a reas that have special
meaning and invoke specific actions) on-screen by using special functions.
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The TrackMan by Logitech is a relatively new entry. The TrackMan reminds
m e of a seashell, but the design makes sense. Your palm rests on the case, and
you move the ball with your thumb. The buttons are right at your fingertips.
The TrackMan costs about $139 list, but you should be able to find lower
prices by mail order. The only drawback to the TrackMan is that no left-hand
version is available.
Which mouse is best and whether a mo use or trackball is best are high ly
subjective. If you have a dealer nearby, you might want to go for a test drive
before making up yo ur mind.

Odds and Ends
You sho uld consider some issues that don 't fall into any particular category.
Obviously, you'll need supplies such as d iskettes, printer ribbons o r toner,
paper, and the like.
A good disk storage box provides a helpful way to protect your floppies from
dust. Attractive, oak sto rage boxes are available, as well as stackable "lazy
susan" storage systems. An ordinary, inexpensive plastic disk storage box does
the job just fin e, however.
If you need to carry disks aroun d, consider purchasing a disk wa llette. Softside wallettes are available from ABCOM for price ranges of about $10 to $16.
One interesting portable carrier from MediaMate sells for only $10. The FlexPack holds 10 disks, expanding and collapsing accordian style to sit o n a desk
o r to be carried.

CD holders, such as the Sony CD Holder for about $15, can protect your COROMs. Of course, your local department sto res also carry CD cases th at work
fine. (Audio and computer COs are physically identical.)
MediaMate also offers the WorkPac which, fo r about $30, gives you a compact mouse pad, a five-disk carrier, a disk/CO storage box, a copy clip to hold
documents to the side of your monitor while you work with them, and a
three-pronged outlet surge protector in o ne package.
PowerBook users who have to plug in at remote sites should also check out
MediaMate's Power Tamer- a small, inexpensive surge protector.
just fo r the heck of it, PowerBook users can purchase Magn aStone balls fo r
the built-in trackball. Stone Age Technologies offers an assortment of interesting looking replacement balls for around $20 each. They are available for all
PowerBook and PowerBook Duo models.

Choosing Hardware

A good PowerBook carrying case is a must for the h ome office user who transports his or her PowerBook between home and office o r remote sites. There
are sim ply to o many carrying-case o ptions around to even begin d iscussing
them in detail, but a few companies are wo rth mentioning by name.
Targus has long been known fo r making carrying cases fo r lapto p computers
and provides a wide array of cases with va rious options. You can find a quality carrying case to fit almost an y budget. Ma ny types are available, ranging
from inexpensive cases fo r your Po wer Book to leather carry-on luggage with
room fo r your PowerBook, cellular pho ne, and a change of clo thes. Ta rgus
case prices run from as low as $35 to as high as $250.
Kensington has been a Macintosh standard fo r some yea rs now. You won't go
wrong with o ne of the NoteBook Traveler cases, which runs from about $50
up to $115. The 1/0 Design Ultim ate brand is also worth co nsidering, especially if you wan t style. The prices run fro m the low $50s to $150 and are
very attractive; especially the PowerBook Attache at the high end of the price
range.

Choosing Hardware
Setting up a home office may req uire some hardware purchases. First, of
course, you need a Macintosh. But these days, so m any models are available
that choosing a Macintosh can be a confusing task. Also, many Macintosh
models have sepa rate mo n itors, so you need to choose o ne to go with the
com puter.
A prin ter is a necessity, but you probably don 't want to spend an arm and a
leg. Printer prices have beco me much mo re reaso nable in recent years. You
can find many good printers-even laser printers-for reaso nable prices.
Some other hardwa re choices are worth ex ploring. One you should defini tely
consider is a fas t fax modem. No home office can reall y survi ve without o ne
today.

Getting the Be st Deals
Times were that mail order had th e best dea ls. This can often be true today,
and you will want to compare prices. However, recen t Apple pricing structures have closed the ga p between dealer, compu ter sto re, and mai l-order
prices on Macintosh computers. Even Apple's direct prices are reasonable
now.
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Pick up a copy of MacUser, MacWorld, or Mac Home f oumal to locate mailo rder houses. Many mail-order ads list prices to enable you to com pare with
you r loca l hardware source. Do some sho pping around not only on price but
some other considerations.
Mail order is many times less expensive, but having a local dealer to take your
Macintosh back should a pro blem arise is often worth the price difference.
You should spend some time finding out just how helpful the dealer is before
spending extra money, however. Take some time, ask questions, sit down
with th e Macintosh o r other eq uipment, and try it out.
Before spending any extra money, make sure that the dealer will be there
after the sale. Check to see how warranty repairs are handled. Does the dealer
have a technician on site, or does the dealer send the Macintosh off fo r repairs? If the machine has to be shipped, doing it yourse lf will take about the
same amount of time.
Does th e dealer offer technical support, or will the dealer be calli ng Apple
with your q uestio ns? Now that Apple offers technical support (as do many
mail-order compa nies), buying from a dealer doesn't offer much of an advantage un less the dealer has knowledgeable people ava ilable to you on locatio n.
If yo u are in need of training, ask whether the dea ler offers training o r knows
of training in your area. Be awa re that many ho me training courses arc available through mail-o rder sources, however, and that the booksto res are fi lled
with books on using the Maci ntosh.
Overall, if you are paying extra to go through a dealer, make certa in that you
are purchasi ng more than just the equipmen t. Mail order is still a viable alternative because many companies now offer technical support by phone and
have fast turnaround on repairs. You should ask about these issues when
considering a mail-order company as well.
Keep in mind that rock-botto m prices come most often from sources (mail
order o r o therwise) that offer little after-sale suppo rt. If you know exactly
what you wan t and need, you can get the best prices. If you need some help,
however, your best value is to spend some extra money for after-sale support.
One suggestion about hard ware: subscribe to MacUser and th e Mac Home
Joumal. MacUser is well-known for its thorough evaluations of hardware, and
Mac Hom e Joumal is oriented toward ho me and home-office users.

Choosing Hardware

1029

Ideal Home Macint oshes
The ideal h om e-office Macintoshes in the "if you can at all affo rd it, do it"
category are the Po wer Macintoshes using the PowerPC. This new line of
Macintoshes will rapidly make everything else pretty m uch obsolete. If yo u
are just starting out, your best bet is to buy the most advanced techno logy
possible in order to avoid bei ng left behi nd in the years to come.
The only d rawback to the PowerPC models is that most current Mac intosh
software ru ns o nly in an emulatio n mode that does not take full adva ntage
of the new processor's speed and power. Software upgrades are following
quickly, however. You should check fo r PowerPC "native" labels o n your
software purchases or verify that a PowerPC upgrade is com ing.
The Power Macintosh comes in three models. Which you choose depends on
your budget and need fo r power. The 6100/60 is the least expensive, runni ng
about $1,800 in the 8MB memory, 160MB hard drive configuration. Fo r
about $500, yo u can obtain a buil t-in CD-ROM and a 250MB hard drive. A
versio n with SoftWindows- the software that enables yo ur Power Macintosh
to do a decent emulation of a 486SX and run DOS softwa re-is ava ilable.
The two faster, mo re expensive models-the 7100/66 and 8100/80-offer
more speed, m ore expandability, and larger hard drive o ptions (the 8100/80
has a l ,OOOMB hard d isk configuration ava ilable).
The 6100/ 60 strikes me as a good, solid home-office co mputer at a reasonable
price. The Power Macintosh is definitely the future of the Macintosh and
again, when you are first starting o ut, your best option is to pu rchase the
most current tech no logy possible.
This is not to say that the o ther Macintos h models are in danger of d isappearing overnigh t. Far too many no n-Power Macintoshes are out there, and companies will find it profitable to support th em fo r years to come.
For the bud get conscio us, the Perfo rma series of Macintoshes makes excellent
home office/home computer cho ices. Which Performa you cl.oose will depend mainly o n the options you want, such as a built-in CD-ROM, hard d rive
size, memory size, and so on. Performas are widely ava ilable now in electronics stores such as Circuit City and can even be found at Sears. Perfor mas have
the advantages of being ail-in-one packages that incl ude a mo nito r, a keyboard, an d software. Several models even come with modems. Apple offers
support and service for th e Performas.
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Home office users who travel will want to take a look at the PowerBook Duos.
The 230 and 255 are reasonably priced at about $1,530 and $2,260. The biggest difference between them is hard drive size, which is 120MB and 200M B
respectively. The advantage of the Duos is the Duo Dock docking station,
which sells in the area of $1,000 or so depend ing o n optio ns. With the Duo
Dock, the PowerBook Duos double as desktop computers as well as laptops.
You can also obtain less expensive docks with fewer options from Apple and
other companies.

Monitors
Because so many monitors are on the market today and new models are being introduced almost every other day, it seem s, giving specific recom mendations is almost a lost cause. Some general suggestions can be made to give
you some guidelines, however.
Unless you know exactly which mo nitor you want, you should probably
avoid mail order. The best way to determine which monitor is for you is to
see the monitor-perhaps even sit and work in front of the monito r fo r a
while.
A 13- or 14-inch diagonal mo nitor is best for general use. When you start
moving into larger monitors, you start needing more video memory in your
Macintosh. Unless you work with full-page ads o r two-page ill ustrations,
don't be talked into a large mon itor.

Printers
A printer is an essential these days. In recent yea rs, printers have come down
in price and improved in quality. You have a wide selectio n from which to
choose, but a few stand o ut.
For inexpensive printing, the Apple StyleWriter II can hardl y be beat. The
price is about $350. The printer is slow, but the print quali ty is good. You
won't want to try to print a novel on the StyleWriter II, but for light printing,
the printer is a good choice. Consumables run about $22 to $25 per 500
pages.
That said, you should be aware that GCC offers a laser printer that doesn't
cost much more than the StyleWriter II. The PLP II lists at $660 but can be
fou nd at just below $500. The prin ter is slow in laser printer terms (about
four pages per minute maximum) but runs about twice as fast as the
StyleWriter II. Consumables run about $35 per 2,500 pages for to ner and
about $300 per 15,000 pages for the drum. For more information on printers,
see Chapter 10, "The Printing Chapter."
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Stepping up in quality and speed, the Apple LaserWriter Select 360 offers
twice the resolution, a 10-page-per minute engine, and high-quality images
for about $1,500. Toner cartridges run about $90 per 4,000 pages.
Overall, Apple and GCC printers remain my top picks. Both companies offer
a wide variety of laser printers beyond the two mentioned here, and you
cannot go wrong with a printer choice from one of them.

CD-ROM Drives
No question here-if you want CD-ROM capability, get a NEC. NEC has long
produced some of the best CD-ROM drives around; the 3X models are some
of the fastest yet. Speed is critical in using CD-ROMs, and the triple speed 3Xs
are a jump ahead of the current double-speed standard. Not every CD takes
advantage of the triple speed, but new titles that utilize the speed are becoming available. The 3Xs will play current CDs. These drives cost around $430 to
$560. You can find less expensive CD-ROM players, but few things are worse
than a slow CD-ROM.
One player to avoid is the Apple PowerCD. Although this player is inexpensive and has features that sound good (such as the capability to connect to
the TV to show Kodak PhotoCDs and play audio CDs), the drive is a single
speed drive, and you'll find yourself going for coffee (maybe running errands)
waiting for images to appear. All CD-ROM drives play audio CDs, but this
capability is rather a non-feature because none (including the PowerCD) are
as portable as a Sony Discman.

Modems and Fax Modems
Modem terminology is too confusing to even bother with these days. You are
assaulted with MNPs and V dots this and thats and something called a his.
The bottom line for a home office user is get the following:
• 14,400 bps. Faster modems are available, but the faster speeds are not
widely supported. The 14,400 speed is becoming more widespread and
should become more or less the standard fairly soon. The 14,400 modems can also operate at 2,400 and 9,600, which are common speeds.
Avoid modems advertised with higher speeds. The standards for higher
speeas-at the time of this wri ting-have not even become fu lly official, despite the fact that modems using the speeds are already available.
Unless you are certain you can connect to another modem with the
same higher speed standard, you will spend the extra money but not
get the faster speed.
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• Look for MNP2-S data compression features and V.42 error correction.
(V.32 exists and costs less, but you cannot have enough error correction .) V.42bis data compression is nice, too.
Yo u don't have to understand all of these tech ie labels. V.32 and V.42 are
basically just error correction featu res that help overcome the noise on phone
lines, and V.42 is mo re recent than the V.32. The bison the end of either
specifies a data compression scheme that can speed up your modem transmissio n- provided the modem to which you are connected has the same data
compression capability. If both 14,400 modems have V.42/V.42bis, fo r example, they can communicate at effective speeds of 57,600 bps which, in
technical terms, mea ns th ey can blaze.
• Look for Group Ill fax in fax modems and check to see whether the
modem is send-onl y or send-and-receive. Group lli is pretty much the
only standard you' ll find in fax modems, but it never hurts to check.
Be aware that some models of fax modems send faxes but do not
receive them.
• Beware of speed claims in fax modems. It's not un common for the fax
bps rate to be higher than the data bps rate. A fax modem may send
and receive faxes at 9,600 bps but onl y send and receive data at 2,400
bps. Ads will often still refer to the modem as a 9,600 bps modem,
however, so you have to read the sm al le r print.
With all this information in mind, o ne suggestion is the Zoom Fax Modem
PKT 14.4, which sells for about $200. Zoom modems are usually among the
least expensive in their class, and I've found their products to be reliable.
Hayes has been the premier modem com pany for years and set the standard
for modems. Hayes was also known for being the most costly. However, the
Accura line is actually reasonably priced. The Accura 144+Faxl44 sells for
abou t $240.

Choosing Software
Much of this book is devoted to Macintosh software and evaluatioHs of the
same. Instead of dup licating that effort here, this chapter is concerned with
some recommendations for h ome-office users. It also mention s some software
that som etimes fall s between the cracks, no t fitting well into any category
o ther than useful.
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Purchasing Software
In the past, software was sold "as is" w ith no warranty. This absurd state of
affairs has ch anged con siderably as competition has heated up, and moneyback gua ra n tees are n ow w idespread .
When you are considering a software pu rch ase, c h eck the warra n ty. Can you
return t he software if you find it to be defective o r incompatible w it h your
system ? What if it sim ply does not live up to its promises? Even if the manufactu re r does not offer a return policy, m any t imes the dealer o r mail-o rder
com pan y w ill.
Ma il o rder is a n excellen t sou rce fo r software for the home o ffice. Two companies I have dealt with come immed iately to mind: MacWareh o use a nd
MacCon nection. Both com pa nies stock virtua lly every Macintosh software
product o n t h e m arket, and both h ave been con sistently h elpful, frien d ly,
and quick. Overnig ht delivery is even available fo r a nominal ch a rge.
MacWa reh o use is fo und at the fo ll owing add ress:
MacWa reho use
PO Box 3013
1720 Oak St.
Lakewood, NJ 08701-3013
O rders: 1-800-255-6227
Fax o rders: 1-908-905-9279
Customer Service: 1-800-925-6227
O rders taken 24 hrs, 7 days a week.
MacConnection can be contacted at the following address:
MacConnection
14 Mill St.
Marlow, NH 03456
Orders: 1-800-800-2222
Fax: 1-603-446-7791
Demo Downloads: 1-603-446-0100
Orders taken from 8 a.m . Monday to 5 p.m. Sunday Easte rn .
Both companies offer upgrad es to m an y products, simplifying your upgrad e
ordering. And MacWareh o use recen tly becam e an Apple autho rized printer
an d scan ne r resellcr.
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Worthwhile Words
Chapter 16, "Word Processing," covers word processors in greater depth than
in this chapter, but you sho uld consider a couple of points when choosing a
home-office word processing program. One of the biggest issues is compatibility with the office or offices with which you deal.
If you are bringing home work from an office that uses WordPerfect (Mac or

DOS), for example, it would make sense to have WordPerfect on your homeoffice Macintosh.
What if you do not dea l with a specific office, however? The question then
becomes how to deal with many different formats. Translation software is
available to help you in this case (see "Working with Other Formats" later in
this chapter).
Once you get past the issue of dealing with different formats and other word
processors and computers, choosing a word processor for your home office
becomes a matter of which is best suited for your kind of work. Chapter 17
can help you with this decision.
If you work with text more than anything, however, one of the best word
processors to have is Nisus. Nisus is by far the most text-oriented of the
Macintosh word processors and has at least one feature I've not found anywhere else: GREP (Global Regular Expression Parser).

GREP came out of the UNIX operating system and is an extremely powerful
(although potentially arcane) text manipulation system. GREP works with
something called regular expressions (which is where theRE in the GREP
com es from). Regu lar expressions are patterns using special symbols to stand
for types of characters. For example, :d stands for any digit from 0 to 9. You
could search for ZIP codes starting with 7 by typing 7:d:d:d:d. Or, if you do
something like what I often do and transpose letters in certain words like
from and form, you can use a search pattern something like this:
f\ (\[or]\) \ (\ [ro] \)m to find form and from but nothing else. You can even set
up the search and replace to transpose the letters wh en you click the Replace
button (see fig. 36.2).
Looks complicated d oesn't it? Well, that's because GREP is complicated.
Fortunately, Nisus has the PowerSearch option that simplifies things
considerably (see fig. 36.3).
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Fig. 36.3
PowerSearch
makes GREP
easier to use.
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PowerSearch enables you to choose GREP elements from m enus in the Find/
Replace dia log box. The full G REP is available as PowerSea rch+.
I' m not going to try to tell you that learning GREP is easy, bu t GREP is outrageously powerful fo r text work. Even if you have to sit with a manual for a
wh ile and knock a regular expression around until it works, you can sti ll
create a powerful find and replace that can save you immense amounts of
time later. Combined with macros (which Nisus has), you ca n perform
amazing text fo rmatting and editing procedures.
Nisus also works with the Data Viz translators, so even if you have to d eal
with o ther word processors on other computers (even PCs), you can perform
translations back and forth.
The more well-known word processors, such as Microsoft Word and
WordPerfect, are large, powerful packages but have become more oriented
towa rd d esktop publishing. If you're like me and work mostly with words,
Nisus is a worthy cho ice because it is more text oriented.
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If you need to combine tex t with layout and design (say, to create and format
manuals), you'l l probably need Microsoft Word. But if you just want to write,
give Nisus a look.

Quick Financials
..,. See " Personal
Finance,"
p.734

Fig. 36.4
Quicken's set of
business reports.

If your home office is going to be you r place of employment, you'll need a
financial management package. The top program-and for good reason-is
Quicken. Quicken is just perfect for use in a home-office setting. Quicken
combines both personal financial management and planning with basic
business-related features such as a decent collection of business reports
(see fig. 36.4).
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Quicken is not a full accounting package, but is just the right size for homeoffice use. The program can do basic accounts payable and receivable, print
your checks, and even hand le basic payroll. Quicken also easily interfaces
with Chi pSoft tax programs such as MacinTax to help you with the insa ne
self-employed-tax-filing headache.

Working with Other Formats
Home-office users often have to deal with computers other than the
Macintosh as well as file for mats other than the ones used by the software
they have. The m ai n suggestion I have here is to run-do not walk- to get
MacLink Plus/Translators Pro by DataViz.
Included with this extremely useful translation software is Apple's PC Exchange, which enables your Macintosh SuperDrive to work with DOSformatted disks, and even format the d isks in DOS format (see fig. 36.5).
Version 7.5 of the software has over 1,000 translation combination s, but you
do n't have to spend time choosing your way through all of these. MacLink
does the work for you, recognizing file formats and popping up with only a
couple of cho ices if there is a q uestion.
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Fig. 36.5
Fo rmatting a disk
for DOS.

The best part is that Data Viz's translators also work with m any other vendo r
products. I regularly use them to save word processing files in DOS fo rmats
(see fig. 36.6) .
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The convenience is worth the approximate $100 price of th e package when
you can format a d isk for DOS, and then use the Save as command to save
your fi les onto the d isk, and hand the disk to DOS users or calmly pop their
disks into your Mac's drive and open their files.
Even if your word processor or other software program doesn't interface wi th
the Data Viz translators, MacLink Plus translatio n soft ware can do the processing for you.
If you deal with really oddball forma ts, get Can Opener 2 by Abbot Systems

for about $60. With this program, you can crack open just about any file any
time.
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File compression can make dealing with the DOS world a pain. Here's an
inexpensive suggestio n: Ziplt. Ziplt is sold by Tommy Brown-the author of
the program-and is o nly $10. You can order Ziplt at the following address
(Ziplt is not available through dealers or mail order):
Tommy Brown
110-45 Queens Blvd. Apt. 716
Forest Hills, NY 11375
A more advan ced (and more pricey) option is Stuffit Deluxe for about $70.
Stuffit Deluxe can handle both zip and arc compressions (see fig. 36.7) .
Fig. 36.7
Preparing to
decom press an
IBM PC arc file.
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Stuffit Deluxe is also a must-have program for the program 's compression and
archiving capabilities (see "Handling Crowded Hard Drives" later in this
chapter).

Enhancing Your System
Several system enhancement packages are ava ilable, but only o ne falls into
my can't-live-without category. Now Utilities by Now Software co ntain s
seven items, two of which are absolute necessities.
Super Boomerang used to be shareware but migrated in to the commerial sp here
with the Now Utilities package. Super Boomerang enhances your Open and
Save d ialogs in extremely useful ways. For starters, folders and files are automatically added to menus in your dialogs for easy access (see fig. 36.8).
Yo ur most recently opened folders and files are added to the menus as you
work. Yo u may add a folder or file to the menus as permanent (meaning they
stay until you remove them) by pressing the space bar while the mouse
pointer is on the folder or file name in the menu. Key com mands can be
added to the folder and file choices. Super Boomerang keeps track of where
you were last. When you open a dialog later, you find the same files you last
saw. You even have a Find command in the Open and Save dialogs.
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Fig. 36.8
The Folder menu
in the Open dialog
gives quick access
to folders on your
hard disk.
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Included in Now Utilities is Now Menus, which works with Super Boomerang. File menu Open commands become hierarchical menus with the last
files you opened in the current application listed for quick access to files.
Your Apple menu (in System 7) becomes a fully customizable menu with
heirarchical submenus and optional key command shortcuts (see fig. 36.9).

Ul

Fig. 36.9
The Apple menu
with Now Menus
installed.
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Now Menus also enables you to have other menus, one in each corner of
your monitor, and pop-up menus keyed to key combinations. If you have a
large monitor, you can set up a key combination that causes the Mac menu
bar to appear as a pop-up menu anywhere you click the mouse button while
holding down the keys.
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Now Utilities also h as an enhanced scrapbook; a control panel that will
automatically save your work after a specified amount of time, number of
keystrokes, or number of mouse clicks; a control panel to change your font
m enus to display the font names in their own font so that you can see how
the font actually looks before choosing it; and a Startup Manager that enables
you to control system extensions, control panels, and even create sets of
applications and documents that you can start when you switch on your
Macintosh. Or you can create worksets to open gro ups of applications and
documents when you double-click o n the workset.
Now Utilities sells for about $85 and is we ll worth the price.

Keeping on Schedule
Now Software also sells a calendar program that is worth considering. Now
Up-To-Date can keep your schedule and pop up to remind you of approaching appointments (see fig. 36.10).
Fig. 36.10
Entering a meeting
appointment.
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Now Up-To-Date enables you to schedu le appointments, enter "to dos," put
banners on you r calendar, set reminders of upcoming events to display in the
menu bar or appear in a dialog, and more. The Reminder control panel included with Now Up-To-Date will put the time and date in your menu bar
and flash rem inders at you so that you don't miss your appointments.
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Protecting Your Dat a
If you are working at hom e, you want to do the best yo u can to protect your
hard drive's da ta. You need to consider three things: viruses, backu ps, and
what to do after th ings go wrong.
Warding Off VIruses

I've used Symantic Anti-Virus for some time now and, even with constantly
exchanging disks, communicating with bulleti n boards, and logging o n to
on-line services, l haven't had a problem with a vi rus. SAM auto matically
scans your d rives o r System Folder at startup or shu t down, scans floppy disks
when you insert them (an option you'll want to use), o r do full scans when
requested (see fig. 36.11).
SAM Ulrus Clinic-

Fig. 36.11
SAM search ing for
virus infections.

One of the things I li ke best about SAM is th at Symantec provides a bulleti n
board you can log o nto to obtain updates fo r the virus defin itio ns-free. Registered users also receive no tificatio n of new viruses and how to configure
SAM to detect them . The program is about $65 but well worth th e price.
Keeping Backups

You definitely need backups of you r data. The only questio n that remains fo r
the home-office user is how to accom plish the backup.
I never use backup softwa re; l rely o n m aki ng my o wn floppy backups of
documents with which I work. This system req ui res the user to track which
files have been backed up, but I find it easier to use and less time-consum ing.
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Mainly, I find this approach less time-consu ming because in day-to-day work,
only a few files on your hard disk actually change. Popping a fl oppy in and
copying the changed files is quick and painless. You also do not have to purchase any software. Of course, if you forget to back up a critical file, you may
end up kicking yourself. Backup software takes more time, but will keep track
of which files have or have not been backed up.
To simplify things, get DiskFit Pro from Dantz Developmen t for about $75.
The program is easy to use, creates Finder readable backups {that is, you can
pop any backup disk into your floppy drive and read the contents witho ut
using the backup software), and even has a reminder control panel (see
fig. 36.12).
Fig. 36.12
The easy-to-use
Diskfit Pro backup
program.
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Damage Repair

You've guarded against viruses and kept backups, but no matter how m uch
safer you are now, something is bound to go wrong som e time. You should
consider two products that can help when your hard d rive goes south.
Norton Utilities fo r the Macintosh by Symantec has pulled me out of problems more than once. The $95 program can repa ir problem s o n your hard
disk before they develop into major disasters, or can help you recover trashed
or damaged files or disks after disaster strikes (see fig. 36.13) .
The Norton Utilities package also includes a disk optimizer, an encryption
program (to scramble files and hide the contents fro m prying eyes), a backup
program, and some other interesting software items. I've only found t he encryption program and the disk doctor usefu l, however (the optimizer is nice
but doesn' t work with compressed hard disks).
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Fig. 36.13
THI NORTO N DI SK DOCTOR

Norton Uti lities

checki ng a hard
d isk.

I'm also coming to rely more on the competing product MacTools. Norton
Utilities has not been upgraded in a long ti me and may end up being left
behind. MacTools provides q uick recovery of files accidentally trashed (a life
saver wh en you empty the Trash and get this "uh oh " feeling in the pit of
your stomach), saves the formatting info rmatio n of your hard disk and other
important data in case of a crash, and incl udes other useful items such as disk
optimization, backup, backgrou nd disk checking, and more. MacTools 3.0 is
selling for about $85.

Handling Crowded Hard Drives
A ru le of thumb with computers is that data expands to fill all available hard
disk space. It never fa ils that when you first bring your Macintosh home, you
are quite sure you' ll never fill up all that nice, clean d isk space.
It isn't much later, however, that you start wondering just how small one of
these "byte" things must be when you fi ll up 80 or 120 million of them li ke a
crowded closet.
You can take two steps to dea l with bulging and overloaded hard disks:
archiving and data compression.
Archiving Data
No question here-the top archival program is Stuffit Deluxe by Aladdi n
Systems for about $85. No Mac user should be without this o ne. Stuffit can
compress your files into "sit" archive files, achieving an average compression
of about SO% (see fig. 36.1 4).
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Fig. 36.14
A Stuffit archive
averaging 54o/o
reductio n in space
required.
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Stuffit ca n also unpack zip and arc files from the DOS world as well as several
of the other Macintosh com pression formats.
Not only will Stuffit help you red uce the space needed to store infrequently
used data files, but the progra m is inval uable if you need to transmit files
over modem, reducing the transmission time by as much as one ha lf on
average.
Compressing Data
Stuffit Deluxe also comes with Stuffit SpaceSaver, whi ch will automatically
com press and d ecompress data on your ha rd disk. Special folders that wi ll
compress files dropped into them can be set up. You ca n create Stu ffit arch ives by merely changing the name of a folder. Options can be set to automatically comp ress files that have not bee n worked with a certain amount of
time and a great num ber o f compression o ptions ca n be set.
Stuffit SpaceSaver is a file level compression system meaning that the software compresses fi les o n your hard disk as opposed to the driver level compression systems that compress th e enti re disk. SpaceSaver is one of the best
file compression systems o n the market, but it does have o ne drawback: the
software can slow your Macintosh noticeably. O n newer, faster machines
(mine's a bit o ld now), this is not going to happen as much, but if you have
an o lder Mac, you may end u p pulling your hair o ut as SpaceSaver decides to
start compressing fil es (at times I wou ld have killed fo r a Cancel button).
Beca use you should get Stuffit Deluxe and SpaceSaver is included, t ry it ou t.
You may find SpaceSaver to be the perfect answe r to a crowd ed hard disk.
And SpaceSaver has and is receiving excellent reviews.
Driver level compressio n is a bit more risky, but I still prefer it. And only o ne
real cho ice exists in this category: Stacker for Macintosh. Stacker has been
around in the DOS wo rld fo r ages, and I was glad to see the p roduct come to
the Macintosh world.

Choosing Software

1045

Driver level compression does techie voodoo to your hard drive's driver software. That can be risky. But I have to poi nt o ut that I've been using the very
first release of Stacker for over a year now without a problem (pretty amazing
fo r a first release) .
Installing Stacker is a bit more complica ted than, say, Stuffit SpaceSaver. You
need to back up your hard d isk and then run an installer program that converts you r data into the new format. The installatio n is a bit time-consuming,
but you o nly have to do it once. After installation, your hard disk comes up
about twice as big. My o ld 40MB interna l, fo r example, now thinks it's an
80MB drive.
Now you don't get exactly twice as much space, and tests show that Stacker
does slow you r Macintosh some. But I still have over 70MB of data stored on
a 40MB drive (with some room to spare) and haven't noticed m uch of a difference in speed. Applications do seem to take a tad longer to start up, but
nothing to complain about.
Home-office users are almost always strapped for cash and hard drives aren't
cheap. To almost double your hard disk space, $65 is a bargain.

Preventing Screen Burn
I'll tell you a secret. Screen burn hasn' t been a problem with personal computers for years. But it's gotten to be too much fun to prevent it, so why stop
now?
Screen bum happens when the same high-contrast images stay on your moni-

tor screen fo r hours-li ke those ghostly letters you see o n older ATM machines. The mo nito r's phosphor (in English: the stuff that makes the screen
glow) becomes weaker over time, and if one image stays on-screen for lo ng
periods of time, that image can become imprinted o n-screen.
Thing is, it's been years since computers sat around with text-only disp lays
burning their phosphor with Log on : prompts. And anybody that can remember screen-burned computer screens is dating themselves as an o ldtimer.
To save some bucks, turn the brightness control o n your monitor down if you
leave your computer for any length of time. Of course, that's not nearly as
fun as the fo llowing, um, safety necessities:
•

' 11 Bill. Bloom County fans will su rely find a definite need to protect their Macintosh screen with images of Opus, Bill the Cat, Rosebud
the Basselope, and others. After seeing this o ne, I've decided screen
burn is a horrifically urgent problem that needs immediate attentio n for
$30. I' m sure Delrina, the manufacturer, will agree.

Opus

VI
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•

UnderWare. just remember when your spouse asks about folders walking

off your desktop, dragons melting your Trash icon, flying saucers, and
more, to look very serious and talk about the great lengths you've undergone to prevent phosphor damage to your monitor. Hopefully the
rubber chicken won' t be on-screen during the discussion. UnderWare is
$30 fro m Bitjugglers.
• Star Trek: Tl1e Screen Saver. Since when do Star Trek fans need an excuse?

$34 from Berkeley Systems, which also has the now-famous After Dark
for about $30. You have not lived until toasters have flown across your
screen.

Kid Proofing
I love this one. If you have kids, you'llli ke it as well. You know the kids are
going to want to use the computer, but you don't wa nt them getting into
your office files, right?
Kid Desk, $25 fro m EdMark, hides your data and applications from young
mousers but enables them to have o ne-click access to games and educational
software (see fig. 36.15).
Fig. 36.15
One desktop setup
in KidDesk.

From Here...
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You can use Apple's At Ease software to accomplish basically the same thing,
but it's not nearly as nice for kids. KidDesk also enables you to set up different application and document sets fo r kids. And they have their own appointment calendar (junio r Day Timer trainees, l guess), calculator, and other
desk accessory-like options.
School teachers will want to take a look at this one because of the feature of
setting time limits on computer use.

From Here ...
From here you m ay want to consider part IV of the book and the chapters on
software. Chapters 16 through 28 cover different categories of software and
discuss the leading products in each to help you make purchase decisions.
• Chapter 29, "Getting Online," explains how to connect to bulletin
boards and on-line services as well as remote office sites. If you are going to be telecommuting, consider this chapter as well as Chapter 30,
"Using America Online and CompuServe," because you can communicate remotely through th ese services (especially CompuServe).
• Chapters 33, 34, and 35 in this part of the book can also help. Networking, data exchange, and being on the road are all issues related to the
hom e office when the home office must connect with other sites remotely (even while on the road).
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Chapter 37

Troubleshoo

VII

g

by Gene Steinberg

Like any personal computer, your Macintosh will crash on occasion-sometimes when you're involved in finishing a mission-critical document. If you
follow a few simple steps, however, you'll be able to get your computer up
and running again. And if you take a few simple precautions, you'll even be
able to prevent many of these problems from occurring in the future.
In this chapter, you learn the following:
• How to solve common Macintosh problems
• How to fi nd the causes of !nit (Extension) conflicts
• The best way to reinstall your system software
• How to diagnose problems with floppy disks and your hard drive
• How to solve printing problems

Why Is My Computer Crashing?
A computer always decides to crash when least expected. You may be working late on a special project that needs to be on the boss's desk (or on your
desk, if you're the boss) first th ing in the morning. In just a few minutes, you
are ready to print your document, and then your computer locks up.
Or you've arrived at work late again, and you need to turn out an annual
report by lunch time. Yo u start your Mac, and it freezes at the Welcome to
Macintosh screen.
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Your Mac can crash for many reasons. Hardware-related problems sometimes
occur, but a Mac is a pretty reliable piece of equipment, and most Macintosh
peripherals are designed and ma nufactured to give yea rs of trouble-free service. You'll find that hardware problems are seldom responsible for a crash.
Later in this chapter, you get some hi nts on looking for hardware-related
troubles.
By far the biggest factor causing erratic Mac behavior is a software conflict of
some sort. Every time Apple revises its system software- and despite thousands of hours of testing-some programs will require revision. This is especiall y true of programs that change Finder capabilities, such as adding fas t
copy capabilities, providing the ability to compress a file by pulling down a
menu fro m the Finder's menu bar, o r opening and closing font resources
on-the-fly.
Older software versions may not be compatible with System 7 features such
as file sharing or 32-bit addressing, o r may not work with one of the newer
68040 o r PowerPC models. The best advice is to contact the publisher (or the
program 's author if it's shareware or freeware) about getting an update.
Where the cost of an update may be too daunting for you, sometimes the
publisher can give you a workaround so that you can continue to use the
software.

Tip
Before you install
new software, check
the publisher's
ReadMe fi le or
special inserts in the
software package fo r
in formation about
compatibility with
other software and
possible special
insta llation requirements.

Inits or System Extensions are especially prone to conflicts. Each of these
utilities will patch a specific resource in your system software to provide some
enhanced capability, such as interactive spell checking, or screen saving capability. Two Extensions that do the same th ing (such as Norton's Directory
Assistance II and Now's SuperBoomerang, o r Alsoft's Master]uggler or
Symantec's Suitcase) often collide and cause a crash or other erratic behavior.
Your choice in this case is decide which of the programs to use.
Installi ng these utilities o n a Macintosh is simple-usually you just drag them
to your System Folder and restart. But it's a good idea to trea t the Mac's System Folder with respect. Too many system enhancements will not provide
entertainment; they'll provide untold hours of aggravation. The process of
configuring your Mac should be fun, but you should also choose the software
you use carefully.
The following sections describe the steps you need to take to diagnose common Macintosh problems, and to reinstall your system software, should the
need arise. You'll want to keep th is chapter on hand, maybe with a bookmark, in case you need to refer to it later o n.

Apple's Emergency First Aid Disk
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But first you need to make sure you have an em ergency startup disk ready.
You' ll n eed th is on hand for the day your Mac fa ils to start properl y.

VII

Apple's Emergency First Aid Disk
If you are a user of System 7, you're lucky. App le has made an emergency d isk
for you. It's called Disk Tools (the d isk is labeled "Utilities" o n Macintosh
Perfo rma m odels), and it comes with you r System 7 installatio n d isks (see
fig. 37.1). Disk Tools co ntai n s a copy of Apple's Disk First Aid and HD SC
Setup. In case your Mac won't start, you can use th is disk to boot yo ur Mac
and test for ro utine disk d irectory or SCSI d river problems.
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Th roughout th is chapter, I'm going to refer to the term SCSI, wh ich is short
fo r Small Compu ter System Interface. It's a specification that defines how a
com puter and its peripherals, such as CD-ROM d rives, hard drives, tape
d rives, o r scanners, communicate with each other. All Macs fro m the Plus on
su pport SCSI, w hich allows you to easily hook up seven devices to your Mac.
One of these devices is usually your Mac's hard drive. Som e h igh-end Macs
even allow you to in stall several drives inside the co mputer.
If you' re using o ne of the commercial hard disk repair programs, such as
MacTools or No rton Utilities, you will receive a set of emergency disks that
you can use to start you r Mac in the event of tro uble. Or you'll receive instructions o n how to make such a disk.

If you are using System 6, your System Startup o r System Tools d isks contain
minimal System Folders that will boot your Mac. Yo u should make a backup
of these disks and maybe remove som e of the extra utilities you don't need
(aside from System and Finder, of course) and install copies of Apple's disk
repair an d for matting program .

Fig. 37.1
Apple's Disk Tools
floppy disk
contains the basic
tools you need to
check and update
you r Mac's hard
d rive.
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When you back up a boot floppy, use Apple's Disk Copy, shown in figure

37.2, or a

commercial program that can make a track-by-track copy of a floppy, such as
MacTools FastCopy or Norton's Flopper utility. These programs will correctly copy
boot blocks to the new floppy so that these floppies will boot your Mac properly. A
straight Finder copy is not always successful in transferring all this data. Apple's Disk
Copy is available from online services such as America Online or CompuServe, or
from a local Mac user's group.

Fig. 37.2
Apple's handy and
free disk copying
program.

D1sk Copy 3.5" Fl oppy Dtok Dupltcotor. v4.2

DUll Copy o.tn O..~tt '" M.cintosh floppy dult fonNtJ,
Applt ]1800K ProOOS~ Mid 1t1t 11\d 2t1J NS-DOS dUb

It 'W'Ill not , hovtYff', ~lie.~ It CC>p¥-prottottd du'-•
(tlld: tM moult to contii'IUt')

Startup Conflicts
The following sections describe typica l Macintosh problems and their solutions. You' ll find a common thread in all o f these descriptio n s. The cause is
generally related to an Extension conflict, a problem with your System softwa re, or a problem with a SCSI device attached to your Mac (such as a hard
dri ve or scanner). Even if your specific problem isn' t discussed in these sections, the solutions described may apply in your situation .

Disk Icon with a Blinking "?"
Wh en you boot you r Macintosh, it looks for a di sk that has a working System
Folder, with a System and Finder in it. If all you see on your Mac's screen is a
disk icon with a blinking question mark in it, as shown in figure 37 .3, il may
mean any of the fo llowing:
• You don't have a Syste m Folder installed on any of your drives.
• You r System a nd/or Finder is damaged.
• You r boot d ri ve (or any drives th at have a System Folder) are not being
recognized for some reason (see the section, "Hard Disk Problems," later
in th is ch apter).
• You have a SCSI-related conflict.
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Fig. 37.3
A blinking
question mark
inside a fl oppy
disk icon at
startup often
indicates damaged
or missing System
software.

Try the following steps to get you r Mac running aga in:
1. Restart and place your System 7 Disk Too ls disk in your floppy drive. If
you are using System 6, try the System Tools or System Startup disk.

2. If your Mac boots normally, check your hard drives for the presence of
a System Folder, and make sure that a System and a Finder is inside that
folder.
3. Even if you have a System Folder that looks o kay, reinstall your System

software. Follow the instructions in the sectio n, "Why a Clean System
Installation?" later in this chapter.
4. If your hard drive(s) won't mount, run Disk First Aid o r o ne of th e commercial hard d rive repair/d iagnostic progra ms, such as MacTools or
Norton Utilities.
5 . If you have an y external SCSI devices attached to you r Mac (such as a
hard drive or scanner), power down, d isconnect the SCSI cable at the
rear of your Mac, and turn it on again.

Disk Icon with a Stationary (Nonblinking) " ?"
When you boot your Macintosh, SCSI device drivers are loaded into memory.
If there's a SCSI-related conflict of some sort, your Mac may not start properly. The quickest way to d iagnose th is problem is to power down, disconnect
the SCSI cable from your Mac's SCSI po rt, and restart.
If your computer still won' t work properly, please follow the steps described
in the preceding section.

Disk Icon with an "X"
This problem has a fairl y simple solution. The d isplay usually follows an
attempt to start with a floppy disk that cannot boot your Mac. Normally, the
disk is ejected, and after several seconds, your Mac will boot from whatever

Tip
If a visual sea rch
doesn't reveal a
System Folder, use
the Finder's Search
function ():C-F or
select Find fro m
the File m enu).
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startup d isk has been selected. If you then see a blinking o r solid q uestion
mark ins ide that disk icon, please read the two preceding sections for further
suggestions.

Sad Mac Icon
When your Mac boots, fo r th e first time, or d uring a restart, it does a brief set
of self-diagnostic tests to make sure all com po nents are wo rking properly.
Then th e SCSI device dri vers are loaded in to memo ry. If someth ing sho uld go
wrong during this testing process, you may see a Sad Mac ico n on yo ur
screen, as shown in figure 3 7.4.
Fig. 37.4
A Sad Mac o ften
indica tes SCS I o r
system-related
troubles.

On early Macs, models released before th eSE, o ne row of numbers and letters
is displayed below the Sad Mac. On theSE and later models, two letters are
d isplayed. These codes may change from model to model and may m ea n
different things in different installatio ns. fo llowing are the most common
causes and solution s for a Sad Mac:
• Your new RAM was installed incorrectly. Po wer down and make sure
the SIMMs are firm ly seated in their slots (but do not fo rce them into
position), and orien ted in the pro per direction .
• A RAM SIMM has gone bad. If your Mac has mo re than a single bank of
RAM, remove the RAM in one bank as a test. If it sti ll doesn't work,
reinstall and try the other bank.
• Your keyboard or mo use has a pro blem . Power down, remove and reseat
the devices' cables, and try agai n . Or try ano ther mo use o r keyboard.
• A NuBus o r PDS expansio n card has gone bad. To check for th is, power
down, remove the expansion card, and power up again.
• Yo u have a SCSI-related conflict, or one of your drives has a bad o r
corrupted d river on it. To check fo r th is problem, follow these steps:
1. Power down your Mac and its peripherals, disco nnect the SCSI cable,
and try to boot your Mac.

Startup Conflicts
2. If the problem is still present, try restarting with your System 7 Disk
Tools disk or the corresponding System 6 startup floppy.
3. If you still cannot start your computer, restart with a floppy disk, but
h old down the ):(-Option-Shift-Delete keys (all at the same time), to
prevent use of you r internal drive as a startup device.
4. If the Sad Mac icon remains sad, turn off power, open the Mac's case
and carefully discon nect the power and SCSI cables attached to the
internal drive. (If your Mac is under wa rranty, contact your dealer or
Apple for help.)
5. Restart the Mac with a floppy startup disk. If it runs okay with the
internal d rive disconnected, contact your dealer about repair or replacement of the drive.

If all else fails, call your dealer o r contact Apple Customer Assistance
at (800) SOS-APPL. Be sure to write down the full set of numbers
displayed beneath the Sad Mac icon- these numbers may help the
servi ce techn ician to diagnose your problem.

Mac Intones a Series of Chimes Rather Than the
Normal Startup Sound
As mentioned ea rli er in th is chapter, w hen you start your Mac, it undergoes a
series of self-tests to make sure all systems ate "go" for a startup. These tests
begin at the point you power up. If the sound you hear is something other
than the normal startup chord (what some Mac users call the chimes of doom )
it may mean:
• Your new m emo ry upgrade was not installed correctly.
• A RAM SIMM has gone bad.
• A NuBus or PDS expansio n slo t is not working correctly.
• There has been a hardware failure.
To check for these problems, follow these steps:
1. Power down and remove and carefully reseat your RAM upgrade. If the
update was performed by a dealer or private consultant, contact that
party immediately for assistance.
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Caution
According to Apple's latest service policy, they won't void your warranty if you
install an upgrade card, DRAM, VRAM, or internal modem inside your Mac, as
long as you don't damage the computer. If the computer is damaged as a
result of an upgrade performed by someone other than an Apple service
provider, they won't fix it under your product warranty. This new service
policy does not cover compact Macintosh models, such as the Plus, SE, or
Classic, because of the high voltage risk posed by the presence of your
computer's picture tube when you open the case. Therefore, opening the
compact Mac's case could void your product wa rranty (although most all of
these products are long out of warranty by now).

2. Power down and re move any newly-i nstalled RAM or NuBus expansion
cards. Power up again and see whether everything works okay.
3. If the expansio n ca rd is needed for video, just reseat th e card for now,
and try again.
4. If your monitor will work with your Mac's internal video circuitry (if
ava ilable), try u si ng your Mac with out its video ca rd as a test.
5. Power d own a n d re move the SCSI cable from your Mac's SCSI port.

6. lf none of these steps wo rk, call Apple Customer Assistance at (800)
SOS-APPL or your dea ler.

Mac Freezes or Bombs After the Happy Mac Icon
At this step in the sta rtup process, your Mac is loading system softwa re in to
RAM. If you c rash at this point, it may mea n o ne of the following:
•

You r System and/or Finder is damaged.

• You h ave a SCSI co nflict.
•

You have a h ard drive directory problem, preventing System software
from loading.

To get you r Mac running again, try the fo llowing steps:
1. Under System 7, restart with t h e Shift key held down. You will see the
Welcome to Macintosh startup screen with the words Extensions off
beneath it (if you aren't usi ng a custom startup screen), as sh own in
figure 37.5.
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Fig. 37.5
Welcome to Macintosh
EHtension s off.

2. If your Mac starts normally, follow the instructions in "Diagnosing
Extension Conflicts," later in this chapter.

3. If your Mac still fa ils to boot normally, restart and place your System 7
Disk Tools disk in your floppy drive. If you are using System 6, try the
System Tools o r System Startup disk.
4 . If the Mac starts up without an y problem, reinstall your System soft-

ware, following the instructio ns in the section, "Why a Clean System
Installation ?," later in this chapter.
S. If your Mac still fails to boot, power down your Mac and all attached

peripherals and disconnect the SCSI cable fro m your Mac's SCSI port.
6. If disconnecting SCSI devices resto res your Mac's normal o peratio n,

power down, and reinstall each SCSI device, one at a time, until the
problem returns. Be sure you check fo r proper cable, term ination , and
SCSI address settings.
Note
A terminator is a device that contains a resistor that, in effect, completes an electrical
circuit. An improperly terminated SCSI chain may fail to boot, not read or w rite data
properly, or even crash a hard drive.

Caution
Never attach or remove SCSI cables, o r change SCSI address numbers or the position
of termination blocks or adjustments while the power on your Mac and attached
devices is turned on. Doing so could damage your Mac's SCSI chip, as well as your
SCSI peripherals.

If you don't have a
custom startup
screen, you'll see a
visua l ind ication
that you've
disabled System
Exten sions under
System 7.
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Mac Freezes or Bombs after One of Your
Extensions Loads
As your Mac continues to boot, each of your startup programs, called System
Extensio ns (or Ini ts under System 6), will load, one at a time. If your Mac
freezes or produces a bomb message while Extensio ns are loading into
memory, it may mean one of the following:
• The Extension whose icon just appea red o n-screen or the one following
that icon is conflicting wi th other software.
• The Extensio n whose icon just appea red o n-screen o r the one following
that ico n is damaged.
• Your System and/o r r:inder is damaged.
• You have a SCSI conflict.
To get your Mac runn ing again, try the following steps:
1. Remove or disable the Extension that loaded just before your Mac
crashed-and the o ne that was to load next.
2 . If now your Mac starts okay, remove o r disable all Extensions but these
two and try aga in.
3. If your Mac crashes agai n, consult the directions provided by the publish er or author of the conflicting programs about possible conflicts o r
workarounds-or call the publisher for assistance.
4. If you still cannot get your Mac to start properly (under System 7), restart with the Shift key held down. You will see the Wel come to
Macintosh startup screen with the words Extensions off beneath it (if
you aren't using a custom startup screen).
5. If your Mac starts normally, follow the instructions in ''Diagnosing
Extension Conflicts," later in th is chapter.
6 . If your Mac still fai ls to boo t normally, restart and place your System 7

Disk Tools disk in your floppy dri ve. If you are using System 6, try the
System Tools or System Startup di sk.
7 . If the Mac starts up witho ut any problem, reinsta ll your System soft-

wa re, following the instructio ns in "Why a Clean System Installation ?"
later in this chapter.
8. If your Mac still fails to boot, powe r down your Mac and all attached
periphera ls and disconnect the SCSI cable from your Mac's SCSI port.
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9 . If disconnecting SCSI devices restores your Mac's normal operation,

power down, and reinstall each SCSI device, one at a time, until the
problem returns. Be sure you check for proper cable, termination, and
SCSI address settings.

Mac Freezes or Bombs at the Desktop
After all of your Extensions load, the first startup program, the Finder, is
launched. If your Mac crashes at this stage, it may mean one of the following:
• You have an Extension conflict.
• Your System and/or Finder is damaged.
• The desktop fi les used to maintain file icons and application/document
links are damaged.
• You have a SCSI conflict.
• You have a hard drive directory problem, preventing System software
from loading.
To get you r Mac running again, try the following steps:
1. Under System 7, restart while holding the Shift key. You will see the
Welcome to Macintosh startup screen with the words Extensions off
beneath it (if you aren't using a custom startup screen).

2. If your Mac starts normally, follow the instructions in "Diagnosing
Extension Conflicts," later in this chapter.
3. If your Mac still fails to boot normally, restart and place your System 7
Disk Tools disk in your floppy drive. If you are using System 6, try the
System Tools or System Startup disk.
If the Mac starts up without any problem from the flopp y disk, reinstall
your System software. Follow the instructions in "Why a Clean System
Installation?" later in this chapter.
4. If your Mac still fails to get past the Desktop, rebuild the desktop by

following these steps:
• Restart with Extensions off and hold down the ~-Option keys
after startup, and before the Desktop pattern appears.
• When a window appears asking whether you want to rebuild the
Desktop, press OK.
• You will see that message appear for each hard disk volume you
have.
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Note
If you have a large number of fonts installed, it will take much longer for the
desktop to rebuild because the icon for each font file has to be read and
loaded into the Finder's desktop files.
If your desktop won't rebuild successfully, check with your local Mac user's
group or an online service such as America Online, CompuServe, or eWorld for
a copy of DeskTop Reset from Symantec or TechTool from MicroMat. Either of
these programs will delete the desktop files, forcing a more thorough desktop
rebuild. Finder enhancement programs such as PrairieSoft's DiskTop can also
delete your Mac's desktop files.

5. If your Mac still fails to boot, power down your Mac and all attached
peripherals and disconnect the SCSI cable from your Mac's SCSI port.

6. If d isconnecting SCSI devices restores your Mac's normal operation,
power down, and reinstall each SCSI device, one at a time, while carefully watching cable, termination, and SCSI address settings.

System Problems
There is probably nothing more disturbing than to have an application sudden ly q ui t during a work session on your Mac, or to see a bomb message of
some sort. Although it's relatively easy to use, your Mac works by a complex
relationship of many systems, ranging from your screen, to your keyboard,
mouse, and CPU. Data is funneled back and forth in a constant stream, and if
some of the messages do not get through, your Mac will fail to work correctly.
Ma ny of the problems that generate a startup crash can also cause your Mac
to fail while you're actually do ing work on it. The following sections discuss
many of the problems and common sol utions.

The Application Has Unexpectedly Quit
This sort of message can happen right after you first launch an application or
at some point d uring the work sessio n. Often you'll see an error message of
some sort, such as a "Type 1 " (bu s) error, "Type 2" (addre ss ) error, o r Type
3 (illegal instruction) error. Sometimes the messages don't really describe
the problem. When you experience this sort of problem, it may mean:
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• The application you're using is not compatible with your Maci ntosh o r
o perating system. This m ay be especially true when you use very old
software under System 7, or o n a Centris, Quadra, o r Power Macintosh
model.
• Because applications load information about your ins talled font library
when they launch, when an application unexpectedly q uits sho rtly
after it's launched, it may indica te tha t you have a damaged font suitcase.
• The applicatio n doesn't h ave eno ugh memory to run.
• The application is in con flict with one of your System Extensions.
• The application may be da maged and should be reinstalled.
• The System and/or Finder is da maged.

Caution
If an application quits, be sure to restart your Mac right away. If you continue
to work with another program or relaunch the application that quit, you will
most likely experience a system crash in short order because your Mac is now
running in an unstable state.

The followi ng steps will help you get your Mac runn ing again:
1. Make sure the program is compatible wi th your computer and operating system. If in doubt, contact the author or publisher.
If an upgrade isn't available, you may be able to get the program to run
within some li m itations, say, wi th System ?'s 32-bit addressing fea ture
turned off, an 040 Mac's Cache Switch, or the Power Macintosh's Modern Memory Manager feat ure, in the Memory Control Panel, disabled .

2. Strip your library of installed fonts to o nly the basic system fon ts, such
as Chicago, Geneva, Monaco, or New York, and see if the program
launches correctly.
3. If you use a program li ke Masterjuggler or Suitcase to run you r fo n t
library, close all fonts opened through these programs.

Tip
A quick way to
isolate a bad font
suitcase is to
double-cl ick on
the suitcase file
(under System 7).
A bad font suitcase
wi ll be reported as
damaged.
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Note
If you are using the Font and Sound Valet utility fro m the Suitcase package
(from Symantec) to compress your fonts, try expanding them before use.
System 7.1 and later may be incompatible with older versions of this u tility.

4 . Give the applicatio n more memory to run. Highlight the applica tion

icon and select Get Info from the Finder desktop. Then increase t he
memory allocated to the program by SOOK or more, and t ry aga in (see
fig. 37.6).
Fig. 37.6
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If you have
en ough free RAM,
giving a little mo re
memory to an
applicatio n is easy.

~
ICind :

Word Info

,..iet'01oft 't/rwd
Microsoft "iOf'd 6 0
¥J~ Ho• Uon

. ...

progr.w'fl

Sl.u : 3 6MB ondt$k (3,776,038 ~ h·s
)

Vht n : Stwstup Ont : Appltc.• tions
Mkr~>son 'l'ord 6 O;
Crt•t•d : Thu, Apr 14, 19!:1<4 , II ~ N1
HodiOd : Ti'lu, Apr 14 , 1994 , I '08PH
Vusion : Ytrrion 6.0
~"9ht C> 1983· 199-4 Mttr~n

COMtMnts :

I
O tec~r:d

I

~Htmo-.
Rt,u;rtmtn~
]
~Jttd st:.t ·
3000
K

I . . .""""'..,. l:sooo
~•
I
Pn ftn"td si:t ·

K

5. Restart with Extensions off (Shift key held down at startup fo r System 7
users). If the problem is due to an Extensio n conflict, it w ill q uickly go
away.
6 . Reinstall the application.

Caution
-

Be sure new software installations are do ne with Extensions off. Application
installers are especially sensitive to the presence of virus software and other
startup programs.

7. Reinstall your System software. Follow t he instructions in " Wh y a Clean

System Installation?" later in this chapter.

You Get a System Bomb
So metimes the application doesn't qu it at all o r you aren' t using any parti cular program, but a bomb message appears on-screen. Rega rdless o f whet her
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the bomb message describes the error, it indicates some breakdown in the
complex chain of communication in wh ich your Mac is engaged every moment that it's on.

VII

The steps described in the preceding section apply equally to a System bomb
message, but I would li ke to add a few more pieces of advice:
1. If the bomb message has a Restart button at the lower right side (see
fig. 37.7), click the Restart button. Sometimes (but not often) your Mac
will restart.
Fig. 37.7
Sorry, a s ys tem error occurred.

[ Resta r t

I [ Resume I

10=02

2. If you can successfully resta rt your Mac this way, hold down the Shift
key upon restart to disable Extensions. Then follow the instructions
presented in the preceding section.

The Mac Freezes without a Bomb Message
Regardless of whether you see a system bomb message, the causes of a freeze
are usually the sa me. Somewhere along the line, the delicate chain of communication among your Mac's systems has broken down. Follow the steps
o utlined in th e preceding section to diagnose and fi x the problem.
Note

.

.

·

A force quit, ;):(;-Option-Esc, will sometimes get your Mac running again. Because
your Mac will be running in an unstable state, however, restart immediately after
saving your work.

Cannot Change the Name of a Folder or Disk
The process of changing an icon's name sho uld be simple. You click the
icon's text, and, after waiting a second or two (for System 7 users), the icon is
highlighted and surrounded by a black rectangle. Under th e following circumstances, you can't rename the icon:

When the
complex chain o f
actions and
reactions of your
Mac breaks down,
it may crash.
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• The disk or file is being shared through File Sharing, or another network
software setup. To change the icon's name, turn off sharing.
• The file is locked. You can unlock the file by highlighting the file icon,
selecting Get Info from Finder's File menu, and unchecking the
"Locked" checkbox at the lower left of the Get Info window.
• There is disk directory damage. To diagnose or repair this problem, run
Apple's Disk First Aid or one of the commercial hard drive repair/diagnostic programs, such as MacTools or Norton Utilities.
• A shared disk has been used on a System 6 Mac. If this is the case,
Apple's Disk First Aid version 7.2 or later, or a free Apple utility, Rename Rescue (available from the major online services) can restore the
renaming capability.

Tip
To delete a
locked file,
hold down the
Option key
while selecting
Empty Trash
from the
Finder's Special
menu.

Tip
One fast way to
remove a damaged
file that won't
delete is to create a
new fo lder with
the same name as
the damaged file-

Cannot Delete a File
This is an all-too-common problem. You are finished using a file, or you
never needed it in the first place, and you toss it into the trash can. Then you
try to delete the file, and you get a message that it's locked or busy. The following list examines the possible causes for both these symptoms:
• The file is itself an application that's opened. Quit the application to
delete it.
• The file is an Extension that's presently in use (some can be deleted,
others cannot). You need to restart with Extensions off to delete the
file.
• The program used to create the file is still open, even though the document window is closed. You must also qu it the application. (This will
happen with Microsoft Word and other programs.)

and delete that

• The file is really locked. To unlock the file, select the file icon, choose
Get Info from the Finder's File menu, and uncheck the Locked box at
the bottom left of the Get Info window, as shown in figure 37.8.

one too. That
should allow you
to remove both
files.

• The file is damaged. Run Disk First Aid or one of the commercial hard
disk diagnosis/ repair programs, such as MacTools or Norton, and determine whether the damage can be fixed.
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Cannot Delete a Font
This is an error that first reared its head under System 7.1. You try to delete a
fo nt suitcase from your Fonts folder (inside the System Folder), and when you
drag the font to the trash, you get a -39 error.
If this happens, follow these steps:
1. Drag the Fonts folder outside of the System Folder and leave it on the

Desktop.
2 . Restart your Mac while holding down the Shift key (to disable Exten-

sions). A new empty Fonts folder will be created inside your System
Folder, but don't worry about that for now.
3. Drag the font suitcase you wan t to delete to the trash. You should be
able to empty the trash now.
4 . Just in case the original Fon ts folder was subject to directory damage of

some sort, open it, drag all of th e fonts inside it to the closed System
Folder icon.
5. All the fonts will be moved to the new Fon ts folder.

6. Delete the old Fonts folder, and restart normally.

Files Have Lost Their Icons
The information about your file icons is stored in two invisible da tabase files
under System 7, called the desktop files. System 6 users have all this information in one file. A system crash, software conflict, or the process of restoring a
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Fig. 37.8
Here's how to
unlock a file so
you can remove it.
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hard drive after reformatting may result in a damaged or incomplete desktop
file. Your icon s become generic document icons, and your document files
lose their relationship with the creator programs. If this happens, follow
these steps:
1 . Rebuild the desktop file. Hold down the

~-Option

keys after you restart

your Mac, before the desktop pattern appears.
2. Shortly after your Mac's desktop pattern appears, a message appears

asking whether you want to rebuild the desktop. Press OK for each hard
drive volume you want to update (see fig. 37.9).
Fig. 37.9

Rre you • ure you wont to rebuild the

The first step to
rebuilding the
desktop.

desktop file on th e disk. .. Cross-Count ry

#5"1 Comment. In Info window• will be
lost.

Caution
If you're using an id le-time file compression program such as AutoDoubler,
More Disk Space, Now Compress, or Stufflt SpaceSaver, make sure that the
compression Extension is running when you rebuild the deskto p. Otherwise,
files won't have the correct icons.

3. If the file icons don't change to their normal status, try rebuilding a

second time, even a third time.
4. If the process still won't work, try Symantec's Desktop Reset or

MicroMat's TechTool. These programs are free, available from local user
groups or the major online services. These programs allow you to delete
the old desktop files, which results in the desktop being re-created
rather than updated (as is done normally).

The Application Cannot Be Found
Your document files have a special relationship with the application that was
used to create those documen ts. If the application is installed on your Mac
(on any hard drive that's mounted), just double-clicking on the document
will launch the program and then open the document. As described in the
preceding section, the Finder maintains this information.

System Problems
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At one time or another, all of us casually double-click on a document only to
receive a message similar to the one pictured in figure. 37.10.
The document " RS6 Feotures.MW" could
not be opened, betouse the application

progrom Ihot creoled II could not be
found.

If this happens, it may mean any of the following:
• You do not have the program that created the document.
Note
If the file you cannot open was created in a popular word processor format,
such as MacWrite or Microsoft Word, you may be able to open it by using the
Open dialog box from another word processor (or even just by dragging the
document icon to the application icon of your word processor under System
7). Sometimes you can open a file in a program that reads straight text, but
formatting information, such as type styles, tables, and complex layouts, may
be lost.

• The desktop file is damaged. Follow the directions in the previous section for rebuilding the desktop.

Settings Made in the Views Control Panel
Won't Stick
Under System 7, the Views Control Panel is used to set your default font for
directory listings (the standard is 9-point Geneva); settings in this control
panel also determine whether small-, medium-, or large-sized icons appear on
your desktop, and whether to show hard drive capacity, and other adjustments (see fig. 37 .11). Sometimes the settings you make revert to default
every time you restart. If this happens to you, follow these steps:

Fig. 37-10
If your desktop
needs to be
rebuilt, or you
don't have the
right program,
you'll see this
message when you
double-click on a
document.
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Fig. 37.11
The Views Control
Panel helps you
customize the way
your Mac's desktop
will look.
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1. Go to the Preferences Folder inside your System 7 System Folder.
2. Select the Finder Preferences file, and drag it to the Trash (you cannot

delete it until the next restart, because the file is always open).
3. Restart your Mac. Open the Views Control Panel and change the settings to your p reference.
4. Trash your old Finder Preferences file, which clearly has become cor-

rupted somehow.

Mac Freezes After Installing System 7
Apple offers System 7 upgrade kits with a one-button installation capability.
Most times it works, but sometimes it doesn't, and crashes occur when you
boot under your new operating system or frequently while you are at work on
your Mac. If this happens to you, consider the following possibilities:
• You're using a hardware expansion card, such as a video display
adapter, that needs a ROM upgrade to work with System 7.
• You need to update your hard drive to support System 7's new file system. This step replaces the SCSI driver with a new one.
• You are running Extensions that aren't compatible with System 7.
• You don't have enough RAM installed to run System 7. Apple recommends 2MB, minimum, but you should consider 4MB at the very least
to allow you to use at least some of your favorite Extensions and to run
any of the popular Macintosh applications.
• You need to do a "clean" system software installation. For fu ll details
on how to do this, follow the instructions in "Why a Clean System
Installation ?" later in this chapter.

System Problems

The Dat e on Your Mac Reverts to 1904 or 1956
Default system settings, such as th e date and time, mouse tracking speed,
network settings, screen depth, sound level, startup disk, and other ad justm ents are stored in a small memory bank called PRAM (parameter RAM). Th is
little chunk of memory is powered by a small li thium battery inside your
Mac. Som etimes the settings you make just don't stick, or you restart your
Mac and it reverts to system defaults. When this happens, you should follow
these steps:
1. Zap the PRAM. Th is clears the PRAM of corrupted data and often fixes
the problem.
2 . To zap the PRAM under System 7, hold down the ~-Option-P-R keys at
startup, wait until two or three startup tones sound and then release the
keys.
3. To zap the PRAM under System 6, hold down the ~-Option-Shift keys
and select Control Panels from the Apple menu. When you are asked
whether you want to zap the PRAM, okay the dialog box.
4. Before getting back to work, recheck all of your standard Control Panel
settings. You will find that sound levels may be too low, mouse tracking
speeds too slow, and that your selected monitor settings (such as black
and white or color) have changed.
5. If zapping the PRAM doesn't cure your problem, contact your dealer
about testing your Mac's internal battery for possible replacement.
I

Note
The process of installing a memory or modem upgrade on a PowerBook or a new
expansion board on a modular Mac may automatically zap the PRAM. Don't be
alarmed if this happens; it's usually quite normal.
Sometimes you can cure a corrupted PRAM problem by actually removing the Mac's
battery for approximately 10 minutes and then reinstalling it. The battery is generally
on the main logic board. If your Mac is still under warranty, let your dealer do it for
you.
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Hard Disk Problems
Like system software, a hard drive is used and abused every moment you are
running your Mac-with the possible exception of a PowerBook (if your drive
is in the Sleep mode). The hard drive is also the one arena of Macintosh use
that is not always quite plug and play.
Many hard disk problems may manifest themselves as possible Extension
conflicts or corrupted system software, which makes them a little harder to
diagnose.
Tip
If your Mac won't
boot after adding a
n ew SCSI peripheral, power down
all of your equipm ent, and disconnect th e SCSI
cable. Then restart-the problem
could be due to a
SCSI conflict, bad
cables, or termination.

Here are a few typical problems that you're likely to encounter at o ne time or
another with your Mac and its complex SCSI chain.

Hard Disk Icon Does Not Show Up On the Desktop
When you first boot your Mac, a hard drive's SCSI driver is loaded into RAM.
When your desktop pattern appears, all your hard disk icons should be displayed shortly thereafter. If a hard disk icon is missing, it may mean any of
the following:
Note
Although you cannot see your SCSI driver, it is, like a printer driver, a communications tool. It allows your Macintosh to send commands to your hard drive about
reading and writing data. If it becomes corrupted for some reason, you will experience system crashes, the failure of your hard drive icon to mount, or possible disk
directory damage.

• The hard drive is not properly connected to the SCSI chain.
• SCSI device is not properly terminated.
• The hard drive is damaged.
• The hard drive wasn 't turned on until after you booted your Mac.
• You have a SCSI-related conflict.
•

If it's a removable hard drive, you need to install a special mounting

Extensio n for its ico n to appear on your Mac's desktop.
• The disk is not properly formatted.

Hard Disk Problems
Here are a few steps to help you get your hard drive to work properly again:
1. Use Apple's Disk First Aid or o ne o f th e commercial hard drive diagnostic/repair utilities, and see whether they can store or fix your drive .

..

2. Update (not reformat) the drive using Apple's HD SC Setup from your
System 7 Disk Tools d isk (fo r Apple's own drives) o r the d isk fo rmatting
utility you prefer.
3. Power down your Macintosh, then turn on your SCSI d evices first, and
wait for 10-20 seconds for them to spin up. Then restart your Mac.
4 . If that doesn' t work, power d own your Mac once again, and an y attached SCSI accessories, and check cables, terminatio n, and SCSI ID
settings.

Caution
External drives generally have push buttons, knobs, or dip switches to change
SCSI ID numbers, and the num bers them selves are usually displayed clearly (if
not, check the m anual that came w ith the drive) . It's also very easy to accidentally push an ID selector button w hile moving a drive, so examine the drive
carefully before powering it on. With internal drives, ID numbers are set w ith
jumpers inserted at the bottom of the drive on its controller board. You may
want a dealer to assist you in changing this setting. A convenient w ay to
examine SCSI ID numbers that are not readily visible is to use the freeware
SCSI Probe utility which is available on all the major online services and from
many user group BBS. Some hard drive formatters also come with utilities that
allow you to check for SCSI JD numbers. None of these programs, how ever,
will show when two drives occupy the same ID number.

5. Reinstall your SCS I devices, o ne at a time, adjustin g SCSI setups as

needed.
6. If the problem is isolated to a single device, try using t hat d evice with a
new set o f cables, wit h and wi th out term ination.
7. C heck the manufacturer's instructions o r look over the rear panel o f

your drive case fo r such things as switchable termination, or whether or
not the device is desig ned to be installed in a particular spo t o n your
SCSI chain (some devices wo rk best when installed last).
8 . If you are using a remova ble device, check the manufacturer's manuals
for instructio ns abo ut the installation of special mo un ting Inits o r using
a special fo rmatting program .
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9. Don't be afraid to experiment a little on your SCSI chain. As lo ng as you
make sure everything is properly connected when you power o n, and
that no two devices occupy the same add ress number, you can remove
termination o r even add a second termination block (on a long SCSI
chain) if necessary to get it to work.
Note
The Macintosh llfx requires a special black-colored terminator block to handle its
ultra-fast SCSI chain. Although this terminator might also function on Macintosh
Quadra models, it doesn't work reliably on a Power Macintosh.

There Are Duplicate Hard Disk Icons on the Desktop
This is one ailment we've no t encountered, but it's possible to happen under
some rare circumstances. Following are some possibilities:
• Two of your hard drive volumes have the same icon and disk name. As
long as the drives occupy different ID numbers, o r are on different partitions of the same drive, they'll both show up on your desktop. Just
rename one of the d rives to ensure less confusion.
• The SCSI device driver is damaged. just update the drive or reformat the
drive to fix this problem.

The Disk Cannot Be Opened
This is another infrequent situation. Your disk icons show up on the desktop,
but you are unable to open the disk directory without a crash or an error
message of some sort. Sho uld this happen to you, it may mean one of the
following:
• The hard drive is damaged.
• The hard drive SCSI driver is corrupted .
To diagnose o r repair these problems, follo w the steps o utlined in the previous sectio n.

Drive Freezes While Reading or Writing Data
Your Mac starts normally, all the disk drives are moun ting on the desktop,
but as soon as you copy a large fi le to a disk, the drive freezes. If the drive has
an activity light, the light remains lit. If th is should happen to you, it may
indicate one of th e following:

Hard Disk Problems
• Your SCSI chain is not properly terminated.
• You are using worn or low-grad e SCSI cables.
• The SCSI driver is corrupted.
• There is an Ex tension conflict.
• System and/or Finder are corrupted.
Although the last three issues are worth exploring if all else fails, your most
likely solutio n to the problem is one of the first two. Someti mes the usual
SCSI setups, terminating the first and last device o n the chain, don' t work.
On a lo ng SCSI chain, you may need a second terminator in the middle of
the chain or at the very end. Using poor quality cables, especially o n a
Cent ris, Quadra or Power Macintosh model, can result in poor current transfer, which would produce a problem of this sort.

Apple's HD SC Setup Cannot Find Your Hard Drive
There are two really nice things about Apple's hom e-brewed d isk formatting
utility-it's free, and it comes with the System disks that ship with every new
Macintosh. If your Mac has an Apple hard drive, it was formatted with this
program right from th e factory. HD SC Setup does have some major lim itations:
• It won't format a drive that doesn 't have Apple's custom controller
chip.
• You ca nnot create more than a single Macintosh partition wit h it.
So if you try to fo rmat or update a drive, and HD SC Setup can not locate the
d rive on your Mac's SCSI chain, consider these possibilities:
• You're using a non-Apple drive. Your o nly solutio n is to use a
non-Apple formatting program. You can get one from the drive's
manufacturer, your dealer, or one of the mail-ord er houses that sells
Mac software.
• The drive isn't hooked up properly. Check the standard SCSI issues,
cables, termination, and SCST address number.
• The drive is damaged. Check the drive with Disk First Aid o r hard disk
repair/recovery programs such as MacTools or Norto n Utilities.
If the above suggestions don 't help, contact your dealer or Apple Custo mer
Assistance at (800) SOS-APPL for advice.
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Recovering Damaged Files
There are three words that you should always keep in m ind when working on
an important document o n your Mac-backup, backup, backup. High-end
publishing and word processing software can often be configured to make an
automatic backup copy as a hedge in case something goes wrong with the
original file. If your software doesn't have this capability, use you r program's
Save As feature to make another copy with a different name, and have that
add itional copy written to a different drive (a floppy disk if necessary) for
add itional protectio n.
Following are situations where you may have a file go bad:
• Your Mac crashes while a file is being saved.
• There is directory damage o n your hard drive, preventing files from
being wri tten properly to disk.
• There are bad blocks o n t he drive, secto rs that will not accept data
properly.
• You have an Extension conflict.
• You have a SCSI-related conflict.
Here are some steps to take to protect your files:
1. Backup all of your missio n-critica l data regularly, once a day at t he very
minimu m.

2. Important files should receive backups several times during a work
sessio n.
3. Check you r hard d ri ve at least once a week wi th Disk First Aid or
MacTools o r Norton Utili ties.
4. Use your hard d isk formatting program to "verify" the drive every three
months. Some disk formatters wi ll automatically map out or "hide" bad
blocks during such a test.
5 . Backup and reformat you r drive at least once a year.

6. When adding new SCSI peripherals to your Mac's SCSI chain, check the
new device all by itself for proper operation.
7. For a hard d rive o r removable device, check its capability to read and

wri te large files without error messages. Recheck the drive after all of
your SCSI devices are running in their normal order.

Hard Disk Problems
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If you have a file come up damaged despite taking the right precautions,

Tip

there are no guarantees, but sometimes you can recover all or part of a file.
Follow these steps:

Can Opener from
Abbott Systems
(available at many
software resellers)
is another program
that can often
recover parts of a
corrupted file.

1. Restart with Extensions off (Shift key held down at startup under Sys-

tem 7) and try open ing the file again.
2 . Use a text editor or a word processor that can read text, such as

Microsoft Word or WordPerfect, to extract the text from your document, as shown in figure 37.12.
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Fig. 37.12
The standard
Open dialog box
for WordPerfect
can be used to
select and open
files created in
many fo rmats
other than the
program's own.
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3. Try MacTools CP FileFix, which is designed to repair damaged Microsoft

Excel or Word files, but will sometimes repair other damaged files as
well (see fig. 3 7.13).
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Fig. 37.13
CP FileFix, part of
the MacTools
package from
Central Point
Software, is able to
recover some
damaged fi les.
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Recovering Deleted Files from the Hard Disk
Tip
File recovery
tools work best
when they are
installed before
you lose your
file, because
they write
"invisible" files
to your drive to
track deleted
data.

This is the error everyone dreads. You are in a rush to complete a job, and
you trash (then delete) the wrong file. System 7 has made it more difficult to
accidentally remove a file, because you have to manually select th e Empty
Trash button (though some programs will do this automatically for you).
Here are the steps to help you recover your files:
1. As soon as-you realize the file was mistakenly deleted, do not write any

more files to that drive.
2. Run a program like MacTools' CP Undelete or Norton Disk Doctor to

recover the files.
3. Check the file immediately after recovery for damaged or missing data.
4. If the recovered file will not open in the program in which it was cre-

ated, use a word processor or text editing program to try to retrieve the
text portion of the file.

Floppy Disk Problems
Second only to a hard drive, floppy disk mechanisms on a Mac get really
heavy workouts. We pop our disks in and out with abandon, and depend on
the disks to always work properly.
Floppy disks are kept in shirt pockets, back pockets, in purses, car trunks,
glove com partments, shoe boxes, file cabinets, anywhere with a few extra
inches to spare (we haven't looked inside the refrigerators of any of our
computer-using fri ends yet). They get little respect, but if something goes
wrong, the words of aggravation and annoyance know no bounds.

Cannot Eject a Floppy Disk
You are finished using a floppy disk, and you dismount the icon, by trashing
it or hitting the :Fe-Y (Put Away) keys under System 7. The floppy icon disappears, but the disk remains inserted in the drive. Or you pop in a disk, and it
doesn't show up on a desktop.
If this ha ppens to you, follow these steps:
I

1. Restart your Mac, and hold down the mouse button as your Mac boots.

When you hold down the mouse button, it will signal the drive to e ject
the flopp y disk.

Floppy Disk Problems

1079

2. If the disk doesn't eject, take a paper clip, bend one end of the clip's
wire into a straight line and push that wire into the small hole below
and to the right of the floppy disk drive opening. That will usually result in the disk being ejected.
After the floppy disk is removed, inspect the disk for surface damage. If the
disk appears undamaged, try it again in the drive, or try another disk. If the
drive refuses to eject the disk, try the following:
1. Clean the floppy drive with 3-M floppy disk cleaner.

2. If the drive still won't eject the disk without our brute force technique,
reinstall your system software, using the instructions provided in "Why
a Clean System Installation?" later in this chapter.
3. If a new system installation won't fix your problem, contact your dealer

to have the floppy drive inspected.

Cannot Initialize a Floppy Disk
You insert a new, unformatted floppy disk into the drive, and nothing happens. Or you have a disk mounted that you want to reformat, and after selecting Erase from the Finder's Special Menu, you get a message that the disk
is locked (see fig. 37.14).

The disk 11 0lsney Disk: 2" could not be
erosed, bet nuse th e disk I s locked .

Look at these problems separately. If the disk is inserted correctly in the drive
and won't mount an icon on the desktop, follow these steps:
1. Restart, but hold down the mouse button. The disk sho uld eject automatically during the restart process.
2. If the disk is not e jected, straighten the end of a paper clip and push it

into the small hold below and to the right of the floppy drive's opening.
3. If the disk cannot be ejected by these techniques, contact your dealer
fo r assistance.

Tip
It's normal
practice for Apple
dealers to replace
a bad drive. But
some repair shops,
many of which
advertise in the
Macintosh magazines, may offer to
rebuild the drive

and save you
money.
Fig. 37.14

Sometimes the
message that the
floppy disk is
locked just isn't so.
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Note
The newest Macintosh models, produced since the summer of 1993 (and all
PowerBooks), use a floppy drive that lacks the automatic inject feature, in which the
disk is pulled into the drive mechanism after being inserted most of the way. With
the newer mechanism, you need to gently but firmly place the disk into the drive.

For the floppy disk that can't be fo rmatted, try following these steps:
1. Eject the disk and examine the write/no-write tab from the rear of the

disk (it's at the upper left).
2. Make sure that the little tab is moved all the way down into the write
position. Sometimes you have to move the tab up and down a couple of
times for it to work.
3. Reinsert the disk.
4. If the flop py still shows up as locked, discard the disk (unless you need
the files on it).
Note

.

Some software is shipped on disks that lack the little write/no-write tabs; they can
only be erased if you place tape over the little opening. Because the tape may get
caught in the drive mechanism, if you no longer need the disk, you should probably
just discard it.

Reverifying a Floppy Disk
Here's the problem: You reformat a floppy disk, and somewhere during the
verifying disk stage under System 7, the message changes to reverifying, and
the process continues for additional minutes. What's going on here?
System 7 has added a fea ture to preserve flopp y disks with damaged blocks
(sections of the disk that cannot be read from or written to reliably). The
Finder will mark these bad portions of the disk so that data won' t be written
to them, very much as a hard disk formatter will lock out bad blocks on a
hard drive.

Floppy Disk Problems
Caution

-

If you get a reverifying message when you format a floppy, unless you absolutely
need the disk, you are better off discarding it. After part of the disk is damaged, the
rest of the disk is apt to go bad too.

Floppy Disk Is Unreadable
You put in a floppy disk you know has files on it, and your Mac puts up a
message asking if you want to initialize the disk. Here are some of the reasons
why this m ight happen:
• The floppy drive is dirty.
• The floppy disk is damaged.
• You are trying to read a 1.4MB (high-density) disk on an 800K floppy
drive.
• You are using a super drive (FDHD drive) to read a high-density disk
formatted as an 800K disk.
Following are some things you might try to salvage the disk:
1. Use 3-M floppy drive cleaner to clean your floppy drive.

2. Examine the disk itself for possible signs of damage.
3. Check to make sure the metal shutter at the bottom of the disk slides
back and forth smoothly. Sometimes moving it back and forth will free
a stuck shutter.
4 . If your high-density drive is trying to read a 1.4MB disk formatted on

an BOOK drive, take a small piece of tape and cover the small hole on
the disk at the upper left, when observed from the front of the disk (not
the one with the write/no-wri te tab on it).
Note
This little hole opposite the write/no-write tab is used by the high density
floppy mechanism to identify the disk as a 1.4MB floppy. Covering the hole
will fool the drive into accepting it as an BOOK floppy.
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Note
Some of the older modular Macintosh models, such as the cx/ci/Quadra 700, are
veritable dust magnets. Over time, more and more dust is drawn into the drive by
the cooling fan on the power supply, which is located behind the drive. The usual
solution is to have a dealer or your friendly Mac guru clean out the interior of the
computer with a miniature vacuum cleaner or with a can of compressed air.

Floppy Disk Is Damaged
As expla ined at the start of this section, floppy disks get no respect from m ost
of us. So when you insert a disk that you know has data on it, and you get a
message asking if you want to initia lize the disk, it may come as a sh ock, but
it happens more often than it should.
Following are some o f the reasons why this m ig ht h appen:
• The floppy disk media is damaged.
• The floppy drive is dirty o r n eed s re pair.
• You are trying to read a high-density (1.4MB) disk on an 800K floppy
drive.

Tip
Even if you get
the high-density
disk fo rmatted in
BOOK format to
work on your
Mac's super drive,
it's best to copy
the data to a
correctly formatted floppy disk as
soon as possible.

•

You are tryi ng to read a high-density disk in a Mac's super drive that
was formatted o n an 800K drive.

Th ere's little hope to recover your data if the disk is seriously damaged, bu t
following a re some things you might want to try:

1. Examine the floppy disk a nd m ake sure that the w rite/no-write tab is
firmly at the top o r bottom position.
2 . Examine the metal shutter at the bottom of the disk a nd make s ure it
moves freely and snaps back in position when you let go of it.
3. Use a drive diagnostic/ recovery tool like MacTools or Norto n Utilities to
try to repair the d isk or recover your files.

If a ll or most of the disks you insert in your Mac's floppy drive ca nnot be
read, try this:
1. Clean the d rive with 3-M floppy d rive clea ner.

Printing Problems
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2. If you have an older Mac, clean the inside with a portable vacuum

VII

cleaner, or a can of compressed air (but be careful not to blow the dirt
back into the drive mechanism).
3. If all else fails, contact your dealer to repair or replace the drive.

Printing Problems
The fo llowing sections detail common printing-related ailments and describe
a few ways to solve the problems should you encounter them.
Most times, selecting Print from the File menu or pressing the )::(-P keyboard
combination and okaying the Print dialog box is enough to get your document printed in a satisfactory manner. But sometimes, no matter how hard
you try, you just cannot get your document printed.

..,.. See "How the
Printing Process
Works," p. 203
..,.. See "QuickDraw
GX," p. 230

Jagged Printing
As you saw in Chapter 8, "All about Fonts," the Mac's font handling can be
confusing. You have PostScript fonts, both Type 1 and Type 3, TrueType
fonts and bitmap fonts. Both PostScript and TrueType fo nts are scalable,
meaning they should print in any size you select at the maximum resolution
of your printer.
But jagged printing is an all too common problem. Following are a few techniques to help you find a solution:
• If you're using PostScript fonts, make sure that both screen and printer

fonts are installed correctly by following these steps:
1. Under System 7, you should copy the fonts to the closed System

Folder icon, and the Finder will figure out where they go; just as
shown in figure 37. ~5.
ronts need to be stored In the ront s folder
In order to be auallabl e to th e Macintosh.
Put these f onts Into th e Fonts fold er?
[ Cancel )

CE:J

2. Under System 6, you need to install screen fonts with Font/DA

Mover and copy printer fo nts directly to the System Folder.

Fig. 37.15
System 7's Finder
knows just where
your fonts belong.
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Note
Font resource managers such as MasterJuggler, from Alsoft, and Suitcase, from
Symantec, enable you to install your fonts in locations other than the System Folder
and still have them work normally. The manuals that come w ith these two products
provide the information you need on setting up your font library this way. Review
Chapter 8 for further tips and tricks on organizing your font library.

Caution

-

If you are using TrueType fonts, under System 6, you must install the TrueType lnit,
which rasterizes or processes the fonts for printing. This Init is only supported for
System 6.0.7 and 6.0.8, but users of 6.0.5 have also been able to get it to work.

Note
If you are using PostScript fonts with a QuickDraw printer, such as Apple's StyleWriter
or Hewlett-Packard's DeskWriter, you need Adobe Type Manager to process the fonts
correctly for printing.

PostScript Errors
Here's th e problem: You've just tried to print a document, but you are confronted with a screen message that a PostScript error has been generated. You
try printing again, and you get the same message. These messages may signify
any of the following:
• Your printer doesn't have enough memory to process th e document.
• You are using the wrong printing software.
• Your printing software is damaged and needs to be replaced.
• You have an Extension conflict.
• Your System software has been damaged and needs to be replaced.
By far the most common problem is that the document is too big or too complex to be processed. If you're using a PostScript printer, turn it off then turn
it back on again. This will flush data from the printer's memory bank, and
sometimes allow it to process a document more effectively.

Printing Problems
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If t hat doesn 't work, t ry to find o ut the specific prin ter error by fo llowing
these steps:

VII

1. If you're using background printing and Apple's PrintMonito r program,
pull down Syste m 7's applica tio n menu (at t he upper right of the menu
ba r) after printing begins and select PrintMon ito r.
2. Keep PrintMonitor o n your screen a nd wa tch the status messages describing the printing process. (If there is an error, the cause of the e rror
w ill flash o n the screen brie fly.)
3. If the error uses the wo rds VMerror, it m ea ns the printer doesn ' t have
en o ugh me mory to process the document.
4. Try opening the Chooser from the App le m enu and turning off backg round printing.

5 . If the VMerror message persists, try simplifying the document by using
fewer fonts.
6. If your d ocume nt still won 't print, select Unlimited Downloada ble
Fonts in the Options section of yo ur Page Setup b o x.

Caution
Using the Unlimited Downloadable Fonts option slows down printing because
fonts are first downloaded and then flushed from RAM to make way for additional fonts. If you select this option, be sure that the Wider Print Area option
is not selected.

7. Conside r getting a me mo ry upgrade fo r your printe r- if o ne is available.

Note
Some laser printers cannot handle the full width of a legal-sized page without
a memory upgrade. Check your printer's manual for details.

If the error contains the word limitcheck, it m ea ns t h e d ocument contains
graph ic images that contain too many paths to process. In th is case, follow
these ste ps:
1. Go to th e d rawing program in w h ich th e documen t was p roduced a nd
look fo r a feature called split patl1s o r split complex paths.

,
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Tip
Some programs,
such as Adobe
Illustrator, will
make a permanent
change to your
document if you
choose split paths
as an option. Make
this setting only
on a copy of your
illustration.

2. Remove objects or elements from your illustration file tha t are n ot being reproduced in your final document.
If you still cannot print your document:

1 . Try running with Extensions off (Shift key held down at startup under
System 7).

2. If your document prints okay with Extensions off, check the section on
"Diagnosing Extension Conflicts" later in this chapter.
3. If disabling Extensions fail s to resolve your problem, reinstall first you r
printing software, then your System software. See the section, "Why a
Clean System Installation?" later in this chapter.

PrintMonitor Quits or Crashes
Apple's print spooling application has but one advantage over every other
softwa re solution on the market-it's free. But it has its share of problems.
Sometimes, for no apparent reason, the PrintMonitor application will q uit
while pri nting is in progress. Following are some of the reasons why it happens:
\

• You are the victim of a bug in System 7.0 and System 7.0.1.
• PrintMo nito r doesn't have eno ugh memory to process your documents.
• You have an Extension conflict.
• Your printing software is corrupted and needs to be reinstalled .
• Your System software is corrupted and needs to be reinstalled.
Let's describe that first problem, involving System 7.0 and 7.0.1. It involves a
bug that will cause PrintMonitor to fail if you quit the application from
which you' re printing while the printing process is still underway.
Here are the usual solutions to your problem:
1. Leave the application open until printing is complete.

2. Get a copy of the System 7 Tune-Up from your Apple dealer, Apple
Customer Assistance, or one of the o nline services. It fixes the
PrintMonitor bug. (This problem does no t exist in System 7.1 o r later.)
3. Reinstall your printing software.

Printing Problems
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If the previous solutio ns fail to resolve your problem try the following:
1. Restart with Extensions off (Shift key held down at startup) and try to
print you r document again.
2. If printing proceeds normally with Extensions off, read the sectio n,
"Diagnosing Extension Conflicts" later in this chapter.

3. If printing problems persist, reinstall your printing software and then, if
necessary, your System softwa re. See "Why a Clean System Installation?" later in this chapter.

Not Enough Memory to Print
Actually, two problem s are invo lved here. The first occurs when you truly do
not have enough memory to print your document, and you get a message
asking whether you want to turn off background printing, or that printing
will resume when sufficient memory is ava ilable (see fig. 37. 16).

There is not enough memory to print now.
PrintMonitor will attempt to print again
when more memory is ouolloble. Closing
windows or quitting application programs
can make more memory auailable.

n

OK

D

The second problem happen s when you see a window asking you to bring
PrintMonitor to the fro n t. You see a dialog box with two buttons, one of
which allows you to adjust PrintMonitor memory size. Some programs generate print files that require more memory to print than others. This is true of
QuarkXPress, for exam ple.
If you get this type of message, follow these steps:
1. Press OK.
2. If the message repeats itself, okay the memory adjustment again.
3. If the memory adjustment req uest won't go away, ca ncel printing and
locate your PrintMonitor application. It's in the Extensio ns folder under
System 7 (loose in the System Folder under System 6).

Fig. 37.16
When there's not
enough memory
to print your
document,
PrintMon itor will
rema in idle until
more memory is
available.
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4. Highlight the PrintMonito r icon and select Get Info from the Finder's
File menu.
5 . Increase the RAM allocation for PrintMonitor by approximately lOOK
(see fig. 37.17).

Fig. 37.17
Increasing
PrintMonitor's
RAM allocation
will often fix
annoyi ng printing
problems.
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Diagnosing Extension Conflicts
The most frequent cause of a system crash, an application quitting, o r the
failure of your Mac to boot prOJ?erly is a conflicting System Extension (or an
Init for System 6 users). It can happen to most anyone, especially if you've
added a number of startup programs to your Mac's System raider.
You can simply remove Extensions from the System Folder on a trial-anderro r basis until thi ngs begin to work correctly again, but an lnit manager
program can simplify the process. There is even an !nit manager that will
help to automate the conflict solving process.

How Does an lnit Manager Work?
.,.. See "Hard Disk
Repair and
Optimization,"
p. 111 7

An Ex tension Manager is an Extension that controls which programs load
when you boot your computer and which do not. Some of these utilities will
also flag an Ex tension that crashes your Mac upon startup and offer to disable
the offending program before continuing with the startup process.
These programs allow you to systematically disable your startup programs
and change Init loading o rder. Some will even enable you to create startup
sets so that you can run two Extensions that may normally conflict wi th each
other in separate session s, especially if both are needed to perform a needed
function-such as an Extension that controls your scanner, or mounts a removable disk.

Diagnosing Extension Conflicts
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The No-Frills Method of Checking lnit Conflicts

VII

Whether or not you have an lnit manager, and I recommend that you get
one, such as the freeware Extensions Manager from Apple (shown in
fig. 37.18), the following is a way to determine whether an I nit conflict is
causing crashes and startup problems:
Fig. 37.18

' l'.lfC EHtenslons Mana er

I Sets

.... 1

~~~
[ More ...

I

[ Options...

I

1. If your Mac produces a bomb message o r crashes before or after a certain Init loads (you can determine this by which icon has appeared o n
your screen when the crash happens), remove or disable that Init.

2. Restart your Mac.
3. If the problem goes away, try running it in a different loading order.
This can be done by changing the startup order in your Jnit manager
program, or just by renaming the Init.
4. If you add a hard word space to the Init's name (O ption-Space), it'll
load toward the beginning of the lineup.
5. If you add the letter z or a tilde (-) to the name of the Init, it'll load
towards the end. See figure 37.19 for an example.

Note
Under System 7, you can place a Control Panel program in the Extensions
fo lder to move it ahead of the pack. To make an Extension load later, put it in
the Control Panels folder, or leave it loose in the System Folder. Any startup
program (other than files like System Enablers, wh ich load when your Mac
boots) placed loose in the System Folder gets last priority in loading.

Apple's free
Extensions
Manager program
allows you to turn
Ex tensions on and
off simply by
clicking on their
name in the Jist
window.
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Fig. 37.19
Renaming an
Extension is as
simple as selecting
the icon, and
adding a character
such as a tilde to
the name.
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Tip
To quickly diagnose an !n it conflict, disable all
your !nits, or,
under System 7,
restart with Extensions off, by holding down the Shift
key.

6. If you can 't isolate the offending lnit this way, disable everything, or

restart with Extensions off and remove all !nits from the System Folder.
7. Add three or four Exten sions to your System Folder at a time, restarting
each time. Try to duplicate the steps necessary to trigger the crash if a
simple restart won 't do it.

Following these steps, you should be able to isolate the source of your conflict quickly. After you've decided that a specific Extension is causing a crash,
contact the software publ isher or author (if it's shareware o r freeware) and see
whether they are aware of your problem. Tell them the steps you took to
duplicate the crash or odd system performance. Quite often an update is
already available that will address the problem.

Reinstalling System Software
Your Mac's system software is the single most used and abused software you
use. Every minute your computer is running, resources from your System
Folder are in use by the vario us progra ms you run. And don 't forget that the
Finder itself is an application.

Reinstalling System Software
All it takes is a single crash to corrupt a system resource, and this can come
back to haunt you later on when your Mac hangs at the Welcome to Macintosh
startup screen, or crashes for unexplained reasons, even if all of your !nits are
disabled.
Even if your Mac behaves in a flaky manner occasionally, it is a good idea to
reinstall system software on occasion, as a precaution against troubles showing up later.

Why a Clean System Installation?
The most effective way to reinstall system software is a clean installation. The
standard system installation will replace your system support files, such as
the Finder, Extensions, and Control Panels, but the system file itself is merely
updated. In most cases, it may not make much of a difference, but if the system gets rea lly corrupted due to a crash or software conflict, the net result is
that the problems you might be having will just continue without letup.
But the simple technique outlined here builds a brand new System Folder for
you. You won't lose any of your treasured startup programs, or even any of
the special settings you've made, but you will be taking an important step
toward removing the source of many of the problems you might be having
with your Mac.

Preparing for a System Installation
Your System 7 kit or any Macintosh manufactured since the middle of 1991
includes a disk labeled Disk Tools (or "Utilities" on Performa models), described previously in this chapter. This disk contains a basic startup System
Folder plus two useful tools. One of these tools is Disk First Aid the other is
Apple's HD SC Setup, a no-frills hard disk formatting program. If you are still
using System 6, you' ll probably find these two programs on one of your Utilities disks.
Follow these steps:
1. Start or restart your Macintosh and immediately insert the Disk Tools

disk into the floppy drive.
2. After the startup process is complete, the icon for the Disk Tools floppy
drive should appear at the upper right corner of your screen. The icons
for your installed hard drives should appear below it.
3. If your computer e jects the Disk Tools disk-and you have a newer
Macintosh-make sure the disk comes direct from your computer's
installation kit.
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Caution

-

The latest Macs use a System Enabler, an Extension that allows the system
software to recognize the new hardware. These models will absolutely not
boot unless the correct System Enabler is installed.

4. If the startup process is successful, look for the Disk First Aid icon,_and
double-click the program (see fig. 37.20).
Fig. 37.20
Disk First Aid can
seek out and repair
minor disk
directory problem s.
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Note ·
A system software installation involves moving a number of files, rewriting
boot blocks to your startup disk, and installing new files. If there is even slight
directory damage, the installation process may be unsuccessful. Disk First Aid
will take a few minutes to analyze your hard drive and make minor repairs.

5. If Disk First Aid reports that the drive has damage that cannot be repaired, you have two choices. The first is to backup you r data and reformat the drive. The second choice is to run one of t he commercial hard
drive utilities, such as MacTools or Norton Utilities, and see if they fare
better in fixing the hard drive.

Caution
Do not install system software before checking your hard drive for possible
directory damage. If the hard drive repair utilities cannot fix the problem, back
up your data and reformat. Even if your drive works okay now, a system software installation may not be successful, or your drive may crash at some time
in the future, resulting in the loss of your valuable data.

Reinstalling System Software
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6. If you have an Apple hard drive, you should update the SCSI driver
using HD SC Setup, shown in figure 37.21. Updating simply replaces
the SCSI driver, it doesn't involve initializing or reformatting the drive,
and it should not affect your data in any way.

App l e liD SC Setup
[ Initialize
( Update

I
I

( Partition

I

[

Tes t

I

((

Quit

J

~

[_t;;;j

VII

Fig. 37.21
HD SC Setup can
be used to update,
initialize, or verify
your Apple hard
drive.

u7 .3

SCSI Deulce: D

The uolume ncme Is Starshlp
Dne

7. To update the drive, simply click in the Update button. The process
takes just a few seconds to complete.
8. If J-ID SC Setup cannot locate a drive to update, it means the hard drives
you're using are not Apple's. You will want to update the drive using
the formatting program supplied wi th the drive instead.
9. After the preliminaries are out of the way, go to the System Folder on

your startup disk, open the folder, and locate the Finder icon.
10. Create a new folder labeled Old Finder, and place the Finder icon in
that new folder (see fig. 37.22).

IB
1 il•m

~~

Old Finder
164.5 MB in disk

9 1 .6MB availabl•

,Q

Q
Find•r

¢1

~
1¢ Ill

11 . Rename your System Folder. You can call it anything you want, but for

the sake of this discussion, I'll call it Storage.

Fig. 37.22
Burying your
Finder in a new
folder keeps the
system in staller
from recognizing
your old System
Folder.
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Installing Your New System Software
With the preliminaries out of the way, it's time to get to the main course.
You now want to check your hard drive fo r the presence of a second System
Folder.
1. Restart your Macintosh. Within a few seconds, the Disk Tools d isk

should be ejected fro m the floppy drive.

Note
You will see a picture of a disk with a flashing question mark on-screen-don't
be alarmed.

2. If you r Maci ntosh starts up normally from your hard drive, it means
there is indeed a second System Folder there, and that could truly be
the source of your troubles.
3. If there is a second System Folder, follow th e steps described previously
to disable it-removing the Finder and renaming the folder. Or trash it
entirely (after making sure that you don't want to keep anything inside
it).

Caution
Having more than one System Folder on a single drive is an invitation to w eird
startup problems, crashes, and other unexplained behavior.

4. Select your first installatio n disk. On the newest Macintosh and Power
Maci ntosh models, it is labeled Instal!MeFirst. On older Macs, it is
called Install, Install 1, System Tools, o r System Startup.

Note
New Macintosh and Power Macintosh computers with internal CD-ROMs
usually are supplied with all system software on a CD. Before removing your
old Finder, be sure your Mac will successfully boot w ith the CD-ROM. After
starting your Mac with the CD, you w ill see an icon labeled Install System
Software (see fig. 37.23). Double-click that icon to begin the installation
process.

Reinstalling System Software
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Fig. 37.23
System software
and other
programs on a
CD-ROM.
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5. Restart and place the first system installation disk in the floppy drive.
6 . The Welcome to Macintosh message should appear on-screen in a few

seconds.
7. If you are installing System 7, the Installer application is opened automatically. If you are installing System 6, you must select the Installer
icon from the floppy disk directory and double-click it. You will see a
window much like th e one shown in figure 37.24.

¢

Welcome to the Apple Installer

[1J Your Macintosh needs certain software to start up.
The Installer places this software on your disk
in the System Folder.

(Q]
~sttmfoldtr

• Easy Install" chooses the software Apple recommends and
creates a disk which can be used to swt up your Macintosh.

(•customize· If you are sure you wan: to override those
recommendations.)

00
8. For most purposes, choosing the Easy Install option will allow the in-

staller to build a System Folder with the resources necessary to run your
Macintosh.

Fig. 37.24
Apple's system
installer program,
ready to do its
stuff.
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Note
A list of what will be installed will appear in the installer program's main window. The Customize option will allow you to select special featu res, such as
networking software, QuickTime, CD-ROM Setup or other special features that
may be needed by your Mac (see fig. 37.25). If in d oubt, check your
computer's manual, or go for the Easy Install. You can always install additional
features, by themselves, later on without having to replace the system again.

Fig. 37.25

Click the Items you wont to selec t;
Shift-click to select mul tiple Items.

You can use the
Easy Install or opt
to Customize your
system installation, as you prefer.
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System 7.5 Note
Apple's new system software version will provide many new ways to customize
your system installation. You'll even be able to choose which utilities are
placed in the Apple Menu Items, Extensions and Control Panels folder (see
fig. 37.26).

Fig. 37.26
Apple's System 7. 5
installer brings
new features to a
custom system
installation.
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9. If you're doing a floppy system installation, assemble the disks you
need. The Installer w ill ask for t hem as necessary.
10. When the installation is complete, quit the Installer applicatio n .

Note
On a System 7 floppy d isk installation, you will see a darkened screen, and a
small window in its center giving you the option to Restart or Shut Down.

11. C hoose the Restart option. Your Mac will restart, and the disk inside the

floppy drive will be ejected.

What Do I Do Next?
If th e system installation is successful, your Mac will start normally, and
you'll be at the Finder desktop in just a sho rt time. Before resto ring anything
fro m the Storage folder, your original System Folder, take some time to work
with your Mac to make sure everything is running correctly.

Note
If you receive a message that your system installation has been interru pted for any
reason, you may have a bad set of system disks o r a SCSI· related conflict. To be sure,
power down your Mac and its accessories, remove the SCSI cable from the rear of
your Mac (if one is plugged in there), and then power up your Mac and attempt the
system installation again.

Note
If you have just upgraded from System 6 to System 7, the desktop files of all of your
mounted hard drives will be rebuilt automatically. This is a normal process. The files
used to manage the desktop under System 7 are d ifferen t from earlier system
versions.

If your Mac now runs normally, follow these steps:

1. Return to your Storage fo lder, and drag special applicatio n folder icons,
such as the Aldus or Claris fo lders, to the new System Fold er (see
fig. 37.27).
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Fig . 37.27
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You may also find a plethora of loose files. in the System Folder that are labeled
data, preferences, o r settings. These are likely application configuration fi les
that you will need to retain special settings in certain programs.

2. If you are using System 7-any version-most of your no n-Apple

startup programs will be in the Extensions and Control Panels fo lder.
Don't restore files that are already duplicated in your new System
Folder.
3. Select just a few of your origina l Extensions and drag the files to your

n ew System Folder icon, as shown in figu re 37.28.
Fig. 37.28
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4. Restart your compu ter and run a few programs, copy some files to and

from a floppy disk or another hard drive, and make sure that everything
is working okay.
5. If your Mac performs in a satisfacto ry manner, continue to add your
Ex tensio ns to your new System Folder, a few at a time, followed by a
restart.
6 . If a problem returns, you may have isolated a potential software con-

flict.

Reinstalling System Software
7. If your Mac runs norma lly, continue the install/restart process un ti l all
Extensions and Control Panels are restored.
8. Go to the Preferences folder in side your Storage fo lder, and move all
preference files and app licati on-specific folders, except those that are
duplicated, to your new System Folder. That will restore all application
and Extension settings.
9. If the problems return after reinstalling all of your o ld files to the new

System Folder, reread the preceding sectio n o n locating Init conflicts.

SCSI Voodoo
Even though each ma nufacturer of a SCSI product may be following Apple's
specificatio ns, the combination of a n umber of devices from d ifferent m anufacturers m ay produce unexpected resu lts. Th e newest Macintosh models,
especially the Quadras and Power Macintosh lines, have very fast SCSI contro llers and can transfer da ta at extremely rapid rates. These models are also
sensitive to the presence of poor cables and terminatio n. It is worth spending
extra money to buy the h ighest q uality cables; do n't buy thi n, bargainbasement products, because you will only pay fo r it later in add itional aggravation in getting your Mac to work correctly.
It is also a good idea to buy all of your cables from one manufacturer, to ensure th ey are all of un ifor m quality and meet the same specifications. A slight
m ismatch in electrical specifica tions among cables can be respo nsible fo r
SCSI chain d isorders. If you have a long SCSI chain with severa l devices, you
might want to consider buyi ng a d igi tal active term inator, such as the APS
SCSI Sentry, from APS Techno logies. This device m on itors the cond ition of
the SCSI chain and helps mai n ta in correct termi nation voltage.
Caution

-

The maximum allowable length of a SCSI chain is a little over 19 feet. When you
figure the total leng th of all your SCSI cables, you should add several feet to cover
the internal SCSI cables in the Mac, plus the internal cables inside each of your SCSI
peripherals. Use the shortest cables you can buy. If cable leng th exceeds the maxi·
mum, some devices may not mount, you may experience erratic performance or
unexplained system crashes. If you need to install additional SCSI devices, you might
consider a SCSI accelerator, which supports many Macintosh models that have
NuBus expansion slots. These accelerators will provide a second SCSI bus to your
Mac, allowing you to hook up additional drives and other peripherals.
Never turn your Mac on or off with a loose SCSI cable. Do not remove or attach SCSI
cables whi le your Mac or peripheral devices are powered on. At the very least, you
run the risk of crashing a hard drive. At worst, you may also damage your Mac's SCSI
controller chip, w hich will require logic board replacement or repair.
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Hardware Problems
There are truly times when all the software conflict testing won't help, because the problem lies with your Mac hardware. Most often a hardware problem is clear. You try to boot your Mac, and it won't produce a startup sound.
Or your start your Mac and you hear a procession of chimes-the chimes of
doom. Testing for hardware troubles may require a dealer's service technician,
but following are a few tips as to what you can do yourself before you bring
your computer or its accessories in for repair:
1. If you've just installed a new hardware product inside your computer,

such as a NuBus or PDS expansion card, remove it and then carefully
reseat the card in the expansion slot.
Before you roam around the inside of your Mac, make sure that you've
followed the manufacturer's instructions about grounding yourself to
the Mac's chassis while it's plugged in or using the static wrist pad that
is sometimes included.
2. Start your Mac.
3. If you've installed a memory upgrade, either DRAM or VRAM, remove

and reseat the memory module.

Caution
Make sure that the memory module is seated firmly at both ends, but do not
force it. There is the risk that you will break the module or the Mac's RAM
bank.

4. Restart your Mac.
If the added hardware is correctly installed and your Mac still won't
boot without warning chimes, or with no startup sound at all, remove
the hardware and try again.
S. If your Mac now works correctly, contact the dealer or the

manufacturer's support people about your problem.
6. If you haven't installed any new ha rdware, and your Mac or accessories
are under warranty, contact the dealer or the manufacturer for service.

From Here...

Caution

-

Even if you are exp erienced at handling the inside of your computer, an attempt to repair the problem yourself m ay void the wa rranty.
Never open your Mac's case or remove or reconnect SCSI cables while your
Mac and SCSI peripherals are turned on. Either step can risk serious damage
(or an electrical shock if you touch the w rong part inside your computer).

7. If the problems you experience are intermi ttent, it is still a good idea to
have a service technician examine your computer eq ui pment. An infrequent problem is apt to become more frequent over time, and a mino r
problem left untouched could blossom into a major and expensive
affair later o n.
In Chapter 38, "Preventive Maintenance," we describe software that is designed to diagnose po tential software and hardware troubles. While such
software products will som etimes only give you a series of benchma rk tests,
those test results may alert you to potential troubles.

From Here ...
Now that you've learned a few tricks to get you out of trouble should problems arise, it's time to do some preventive m aintenance.
• Chapter 38, "Preventive Maintenance," provides some helpful hints to
help you reduce the likelihood of having problems with your Mac.
• You'll also want to read Part II, "System 7 Essentials," Chapters 4
through 10, for more valuable information on setting up and using
your Macintosh.
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Chapter 38

Preventive Maintenance
by Colin Bay

As you read in this chapter and the preceding chapter about all the things
that could go wrong with your Macintosh, you may start to feel paranoid or
lose confidence that the computer is going to keep working. It's important to
keep these things in perspective. Possibly, you could skip this entire chapter,
never do any preventive maintenance to your Macintosh, and have years of
use with no problems, no broken components, no lost fi les, and no electrical
failures.
But things do go wrong sometimes, even wi th a well-made computer. The
main point is that by building a few good habits and being aware of potential
problems, you can increase your chances of long, trouble-free use of your
Macintosh. You don't have to spend all day on prevention to protect yourself
from the most common hazards.
If you don't read any further, remember these two things-save often as you
work and back up your data regularly. These are the two most important
preventive measures you can take.
In this chapter, you learn the following:
• How to reduce workplace hazards
• How to develop good working habits for prevention
• How to keep the various components of the Macintosh system clean
• Become familiar with utility maintenance software
• How to set up a schedule of periodic m aintenance tasks
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Your Macintosh's Environment
Just as you need protection from the elements, your Macintosh needs to be
protected from the environmental hazards around it. Liquids, temperature
extremes, and irregularities in electrical power can all take their toll. But
they're all preven table if you follow some basic guidelines.

Liquids
A little thirst can be a dangerous thing: keyboards don't often fail, but when
they do, spilled liquid is the most common cause. To fill your floppy drive
with water o r to get coffee inside your monitor, you would have to do something unusual. But because the keyboard lies flat and is the part of the computer that's closest to you, it's vulnerabl e as you sit in your chair sipping a
drink.
If you ever use your Macintosh outside-not an unusua l occurrence, if you
own a PowerBook-make sure that you keep it protected from rain, water
fights, and lawn sprinklers. Liquid from any source can short-circuit your
keyboard or other parts of you Macintosh. Sometimes d ryi ng out is all a keyboard needs to function again, but the damage can be worse.

Power Problems
Like a stereo, a Macintosh is a sensitive piece of electronic equipment, full of
chips, transistors, resistors, and capacitors-all of which expect a normal
range of electrical power. If they don't get the power, they can fa il temporarily, or in severe cases, a component can burn out and need to be replaced.
Though people speak of "power su rges" collectively as the main electrical
danger to a com puter, there are actually several kinds of electrical irregularities that, if not countered with basic preventive measures, can damage your
Macintosh.
Spikes and Surges
A spike is a sudden, extreme rise in the intensity of your incoming power line,
so fas t that it is usually measured in nanoseconds. A surge is not as fast o r
extreme, more like a gradual wave of increased power, but can also cause
damage. Because the electronic components of the Macintosh are guaranteed
to work only within certain levels of power, a spike or surge can overheat a
component such as a chip or "jump" between electrical channels in the same
way the electricity in a spark plug jumps the gap. A lightning strike is an
extreme exam ple of a spike.

Your Macintosh's Environment
Your best protection against spikes and surges is a good surge protector. Som e
models are a single added connector between your power plug and the wall
outlet; most, however, include a power strip wit h 46 added outlets, convenient for pl ugging in a mon itor or external drive in addition to the
Macin tosh. Remember, however, that overloading the circuit by pl ugging in
to ma n y th ings at once defeats the purpose of the surge protector-keeping
your Macintosh running.
Lightning

If ligh ti ng hi ts you r house or a nearby power li ne, you' ll wish you had a good
su rge protector. However, even then the power can be so strong that it can
ju mp between electrically isolated components of the surge protector. If you
wan t to t ruly protect your Macintosh du ring a ligh tning storm, the su rest
method is this: unpl ug it from the wall completely. That way, t here's no
conducting path from you r house's electrical system to the Macintosh.
Power Failure

Even the best of public utilities sometimes has power outages, whether from
lightning strikes, snowstorms, or collisions with uti lity poles. Very brief losses
of power may not affect your Macintosh at all because it contains a residual
amount of power for a fraction of a second. However, if the power goes off
and stays off, you're out of luck if you haven't saved lately. Saving your work
regul arly is t he best defense aga inst power fail ures and ma n y other p ro blems.
If your business depend s on you r Macintosh never going down unexpectedly,
it's worth investi ng several hu ndred dollars in a UPS (uninterruptible power
su pply). A UPS contains constantly charged batteries that ca n keep your
Macintosh running for some length of time (often 30 minutes o r more) in
the event of a power failure. This can give you enough time to save data, quit
applications, and shut down your Macintosh safely. UPS units generally also
give power all the time, filtering out spikes, surges, and voltage drops.
Static Electricity

No matter how clean the power source that goes into the back of your
Macintosh, you can always add to it with static. If you find yourself making
sparks when you touch the doorknob, or shake hands, you may have a static
prone combination of carpet and shoes. You can buy an anti-static pad to
absorb the extra ch arge.
Static rea lly com es into play when you open u p you r Macintosh to add
memory, insert or remove a card, or just look around. The sim plest way to
discharge the static is to touch t he metal shielded box containi ng the power
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supply before you to uch anything else. You can easily tell where the power
supply is because the power cord at the back of the Macintosh goes into the
power supply.

Magnetic Fields
Hard disks are usuall y pretty well shielded from stray magnetism, but floppy
disks are no t. Because the surface of floppy disks (inside the hard plastic case)
is a form of m agnetic media, it can be erased or damaged by being too close
to a magnetic field. Common sources of magnetic fields are electric motors
and strong power supplies.
In fact, your Macintosh contains such a power supply, so it's best not to leave
floppy disks laying against the back part of the compu ter. Wherever the
power cord goes into the back of the Macintosh is where the power supply
sits.
Holding a floppy disk to a refrigerator with a magnet is an obvious invitation
to data loss, but other magnetic sources are less obvious. Some travelers have
reported floppy disk problems from passing through airport X-ray machines.
This is most likely caused by the electric motor m oving the conveyer belt
rather than by the X-rays. If you have valuable data on floppy disks, and the
disks go thro ugh airport security more than a couple of times, it's worth passing them th rough by hand.

Dust and Smoke
Som e parts of your Macintosh can deal with dust and smoke m uch better
then others. None of them are in much danger of dust unless it's extreme.
Smoke will deposit a film on your monitor and can have a cumulative effect
o n the read and write heads (analogous to the heads o n a VCR or cassette
player) of fl oppy and hard disk drives, so it's best no t to use the Macintosh
in a consisten tly smo ky area over the long term.
Dust can cause two kinds of problems: mechanical and thermal. The
mech anical pro blem is d ust collecting o n drive heads, decreasing their sensitivity and accuracy. The thermal problem can happen inside the CPU. If
excessive amounts of dust collect on the chips and o ther parts inside the case,
it can have an insulating effect and cause some com ponents to heat up more
than they sho uld.
Once again, however, you do n't need to be a fanati cal duster or buy an expensive air fil tratio n system fo r your office or den. just keep the room relatively clean and check inside your Macintosh once or twice a year to see if dust
has built up.

Good Work Habits
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Temperature
Your Macintosh is comfortabl e in a wider temperature range than you are,
but you should avoid extremes on the hot side. Acceptable temperature
ranges, which are similar fo r most Macintoshes, are listed in the technical
specifications in your Macintosh documentatio n .
For example, the Power Macintosh 6100 can be used at temperatures from
50° F to 104° F. Because storage is less demandi ng than use, this Macin tosh
can be safely stored at an even wider range of temperatures, trom -40° to
11 6.6° F. Notice that you're more likely to reach the upper extreme th an the
lower o ne. Although you're unlikely to leave th e computer outside in a blizzard, it could reach very high temperatures if you leave it in your car in direct
sunlight on a hot day. To be on the safe side, don't leave your Macintosh in a
place that would make you uncomfortably hot.
Regardless of the temperature in the room where you work, don't block the
ventilation openings o n the Macintosh. The circuitry and machinery, because
so much power is running through it, can create a significant amount of
heat, which needs to dissipate. If you block the vents, heat may build up
mo re than it should and damage electrical components or gradually shorten
the useful life of your Macintosh.

Good Work Habits
If people saved their work and backed up th eir disks religiously, most of the
data loss in the perso nal computer world would be taken care of. If you only
skim th is chapter, remember these two things: Save often! Back up regularly!
The o ther tips are helpful, too, but these first two are paramount.

Save Early and Often
Al most every lo ng-term computer user, Macintosh or otherwise, has a story
about wo rking o n an impo rtant project for three hours witho ut saving, then
losing it all in an accident: you nudge the power cord, the program crashes,
the electricity fails, you r son steps o n the power strip and turns it off. If you
save your work every five or 10 minutes, then that's the most work you' re
likely to lose if one of these mishaps happens to you.
The exception is when you've m ade a major change (say, deleting 80 rows of
a spreadsheet), and you aren't sure you want the change to be fina l. In that
case, you can save the changed work under a new name, letting you change
your mind later witho ut losing any data.

VII
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Back Up Your Files
Worse thi ngs than a power failure can happen: a destructive vi rus, accidental
deletion of a file, a hard disk fa ilure. The first question you'll get from technical suppo rt o r your network adm inistrator is, "Do you have a recent backup?"
All computers and hard disks will fail eventually, if you use them long
enough-years and years, in some cases. But when something does fail, you
should have important data backed up. A common scheme, explai ned o n
most backup software documentation, is to back up all of your data once a
week and then make daily backups of the files that changed that day.
If you don't have a tape drive (in the case of office network) or a shared file
server, you can back up to floppy disks. Most backup software can compress
data so that it doesn't need as many disks, but even so, you could end up
with a lot of floppy disks.
If you have too much data for floppy disks, you can back up just you r documents, which decreases the size of the backup. This requires, however, that
you keep the original installation disks for your system software and application programs-but you should be doing that anyway. Because the installation disks can also fail, get in the habit of making a flopp y backup set of the
installation disks before you install a new software package. A one-time
backup is enough for applications because those files ra rely change.

Delete Unused Applications and Documents
Unused files can clutter up your hard disk unnecessarily. Copy o ld documents to floppy disks in case you need them later. In the case of application
files, make sure that you have them on the original disks.
Especially good candidates for deletion are o utdated application versions. For
some applications, you may want to keep th e old version around for a little
wh ile for com patibility, but this usually isn't necessary. For example, a new
version of a word processor will usually save a file in the old fo rmat as well as
let you open files created by the old version . If you leave old versions of applications o n your hard disk after installing the new one, you could
double-cl ick a document and open the wrong version of the software.

Keep the System Folder Lean
There are hundreds of programs you can buy that modify the system to do
neat things, but try to avoid the tem ptation of overdoing it. These system
extensions and control panels, in excess, use up extra memory and increase
the chances of a conflict with each other.

Good Work Habits
The sa me thin g goes fo r fonts: each font you have installed in your system
uses up a li ttle memory. You can keep rarely-used fon ts in another folder and
install them only when you're actually going to use them.

Use the Shut Down Command
You can save yourself potential trouble and keep your Macintosh hard d isk
healthy by always choosing the Shut Down command from the Special menu
when you're ready to power down. Why not just turn off the power? When
you choose Shut Down, the system cleans itself up in preparation fo r tu rning
off, gives you a chance to save any documents you forgot to save, quits any
o pen applications, and saves any adjustments you may have made to the
Finder desktop (moving a folder, for example). If you turn off your Macin tosh
in the middle of things, you lose all these safeguards.

Keep Only One System Folder
If you copy a large group of files fro m ano ther d isk, perhaps a network installation folde r or Apple system disks, you could end up with m ultiple copies of
the system folder on your own hard disk. Look through your folders sometime to make certain there isn't an extra system folder buried somewhere on
the disk. A system folder-even if it has a different name-contains at least
the System and Finder files.
If you have more than one system folder o n your disk, when the Macintosh
starts up o r applica tio ns try to access system files, there could be some confusion about which system folde r is supposed to be the active one.

Don't Move Devices with the Power On
Once again, you might do this all the time with no problems, but you would
be pushing your luck. If you move parts of your computer system with the
power o n, you risk pulling out a power cord, jarring a hard drive by dropping
it, o r damaging sensitive com ponents of a prin ter. You should also avo id
pluggi ng o r unplugging th ings such as the keyboa rd, mo nitor, mouse, o r
external drive while the Macintosh 's power is turned on .
If you have a printer, external drive, monitor, keyboa rd, mouse, and perhaps
another device attached to your Macintosh, you can get quite a collectio n of
cables. Arrange them so that they're o ut of the way as much as possible. If a
power cable is hanging by the side of your desk where someone might bump
it and pull it out, you're tempting fa te.
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Turn SCSI Devices On and Off in Order
SCSI devices include external hard drives, CD-ROM drives, scanners, tape
drives, and anything else that is connected to one of these devices. If the
Macintosh is turned on before these devices, it may not recognize them when
the system starts up.
The order is reversed when you shut down: choose the Shut Down command
and turn off the Macintosh; then turn off the other SCSI devices. If the
Macintosh is still on and you turn off a device such as an external hard d rive
containing your system software, it's the same as cutting the power before
choosing the Shut Down command. Because the Macintosh itself is a SCSI
device, and the most important o ne, it's best not to disrupt the SCSI chain
wh ile the Macintosh is on.

Give Your Monitor a Rest
Have you ever noticed how automated teller machines at banks often have
the words burned into the screen from sitting there for so long? The same
thing can happen to your Macintosh monitor if you leave it on for many
hours with no change in the picture. If you leave your Macintosh on for
weeks at a time without using it, a shadow of the image o n the screen will
gradually begin to become a permanent m ark. That's why screen saver programs were developed.
The truth is, black-and-white monitors are more likely than color mo nitors to
have burned-in images, but most screen savers are used on color Macintoshes.
A cheaper m ethod is to simply turn down the brightness dial o n your monitor when it's going to be left on unused for a long time, but this method isn't
nearl y as entertaining as a screen saver. Besides, some screen savers offer extra
features such as password protection. This gives you a convenient method of
keeping unauthorized people from walking by your office and using your
Macintosh or seeing your confidential files.

Keep Your Software Current
Keeping up with the latest versions of software can actually be a fo rm of preventive maintenance. Due to the complexity of software and the variety of
configurations it must run on, it's virtually impossible to write a program
that does everything you want it to, in the right way, in every situation. Although the most severe bugs are found and taken care of befo re the software
is commercially distributed, little glitches may remain. That's why updates
can be helpful. If you have anti-virus software, as you should, it becomes
particularly important to find out if new Macintosh viruses have been
discovered.

Keep Things Clean
Software companies periodically release updates to system software and applications. Usually, they add new fea tures and capabilities, but som etimes
they'll release a new version with only minor changes that improve compatibility with a certain Macintosh model, other software, or new devices such as
CD-ROM drives. If you fall into the category of people who could be helped,
it's good to know about software updates.
When to Buy Updates

This is not to say that you need to buy every new version that comes out for
every software package you own . If the current version of an applicatio n
fulfills all of your needs, there's no need to buy the new one. However, if the
new version offers features that would make your life easier and allow you to
produce better work, the update is probably worth the cost.
Where to Learn About Updat es

How do you find out about updates? A first step is to mail in the registration
card that comes with every Macintosh computer or application program.
Most developers will send you information about upcoming changes so you'll
know when a new version is available. Occasion ally, they'll send a free update.
If you use your Macintosh a lot, it's also a good idea to subscribe to a
monthly Macintosh magazine such as MacUser or Macworld. They will generally have news of the latest versions of software, potential problems, and
reviews of new software. If subscribing seems like overkill, you can still pick
up some useful information by buying one or two issues a year and seeing
what's new.

Many manufacturers of anti-virus software maintain a bulletin board or a
ho tli ne number you can call to find out if there are new viruses. When a new
virus is found, they generally issue an update or a small piece of extra code
that allows your software to identify the new virus.

Keep Things Clean
You don 't need to be a compulsive cleaner. Your computing will be more
comfortable and reliable, though, if you give a few items a quick once-over
from time to time.

Keyboard
Other than liquids, which you should keep away from the keyboard, the
keyboard can collect lint, dust, and crumbs between the keys, as well as grime
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and other deposits on the surface of the keys. For example, if you've ever
peeled an orange at your desk, you probably sprayed some juice or rind
particles on your keyboard.
To clean the keyboard, follow these steps:
1. Shut down your Macintosh and turn the power off.
2. Use a barely damp cloth to clean the surface of the keys, avoiding

strong or sideways pressure, which could pop off one of the key ca ps.
3. Gently turn the keyboard upside down to free crumbs or dust that has

fallen between the keys.

Mouse
The mouse contains a roller ball that spends all day going back and fo rth
along your desk or mouse pad. You might be surprised at how much dust,
lint, and dirt it can pick up after a year or two of use in a dirty room. If you
notice the mouse pointer jumping when you move it or failing to roll
smoothly, it's probably because of dirt inside. Fortunately, it's easy to clean.
Follow these steps to clea n your mouse:
1. Shut down your Macintosh and turn the power off.
2. Turn the mouse upside-down to expose the roller ball, and release the

round, plastic piece surrounding the ball.
For a new mouse, turn the ring counterclockwise to release the ball. For
an older mouse, locate the grooved edges of the ring. Press down and
toward the top of the ball to release it.
3. Roll the ball into one hand to prevent it from falling and getting dirtier.

4. Wipe the ball clean with a soft, dry cloth that doesn't shed lint.
5 . Blow to remove dust or lint inside the mouse.
6. Moisten a cotton swab with some isopropyl or rubbing alcohol (not so

much that it drips) and clean the rollers inside the mouse.
7. Replace the ball and reattach the back mouse cover.
If you own a trackball or another pointing device, it could probably use
cleaning as well. Consult your documentation for details on cleaning these
devices.

Keep Things Clean

Monitor
Because you may be spending h ours a day staring at your monitor, it's worth
keeping it clean. Dust accumulates quickly because of the static of the monitor screen, and it's hard to keep from to uching the screen sometimes when
you point at it.
You can use a lint-free cloth and some standard window cleaner to wipe the
screen clear. Be sure to use only a small amount of cleaner, so the excess liquid doesn't drip down inside the mo nito r case or into the Macintosh. Better
yet, spray the cleaner o n your cloth rather than directly o n the screen. If you
want to spend more money for the convenience, you can buy individua lly
packaged lens-cleaning or monitor-cleaning cloths.

Floppy Disk Drives
In the early days of the Macintosh, everything ran from flo ppy disks and
hard disks were seen as an expensive lu xury. Now virtually every Macintosh
has a hard disk, but you still need to keep your floppy disk drive in good
worki ng shape. Don't look down on it-you still n eed it for installing software, transferring info rmation to other computers, and perhaps backing up
your data.
Covering the Floppy Opening

Some of the newer Macintosh models have a built-in hinged cover that protects the floppy drive opening from d ust particles. For the other floppy drives,
you needn't worry too much about dust unless the room where you use your
Macintosh is unusuall y dusty. If so, you can cover the floppy drive opening,
when no t in use, with a yellow sticky note.
Replacing Old Floppy Disks

One other important preventive measure for floppy drives can also protect
your data: get rid of old floppy disks. If a floppy disk is several yea rs old and
has been used regularly, the media surface can get worn out. When this happens, the disk can have errors that leave a file unreadable. It can also have
bits of magnetic material flake loose and stick to the read or write head in the
floppy d rive.
So if you're saving, opening, o r copying a file on a floppy disk and a dialog
box says there's been an error reading or writing a file, don' t delay. Immediately copy the files to another disk and throw away the bad floppy disk. just
throw it away without a second thought-the 50ft you might save by keeping
an old disk isn't nearly worth the lost data you put in jeopardy by keeping
the disk.
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Logic Board
The logic board is the large board at the base of the Macintosh's insides. It
contains the main processor, memory, and other key functions. Most of the
time, the best thing to do to keep your Macintosh's logic board clean is to
just leave it alone. If you break a connection by dusting it too vigorously,
you'll wish you could have your dusty, functioning logic board back again.
A small amount of dust won't hurt it.
If the logic board is thick with dust when you open up the Macintosh case,
you can simply blow to clean off the dust. just make sure you don' t blow the
dust into a sensitive part of the computer, such as the floppy disk drive.

For most Macintosh models, you can open the case by lifting the two tabs at
the rear of the computer. See the documentation fo r your specific model to
see how to open it. For compact Macintoshes such as the Plus, SE, or Classic
models, it's best not to open the case at all. The built-in monitor, like all
monitors, can harbor high-voltage charges for some time after the com puter
is turned off. For these models, leave the inside workings for a qualified technician. Besides, opening compact models can void your warranty.

CD-ROM Drives
CD-ROM drives are pretty durable, but they rely on the accurate alignment of
the laser beam that reads information from the compact disc. The key preventive measure for a CD-ROM drive is thus to treat it gently when moving it.
Your CD-ROM may or may not use a disc caddy. If it does, the inside of the
drive is relatively protected from dust and dirt, but you should keep the
caddy clean. If your CD-ROM is caddyless- that is, you can place a disc directly on the tray without using a special case-don 't leave the disc tray out,
where it can collect dust.
You should also keep your discs clean by handling them only on the edges.
Especially avoid dirt or fingerprints on the underside of the disc, which is
where the drive reads the data.
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The prudent Macintosh user will own one each of at least four types of utility
software. Some software packages include a collection of programs that cover
most or all of these categories.
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Backup
The first rule of backu p is this: if you do n't want to lose your data, back it up.
It sounds obvio us, but many com puter users don' t bother to back up even
their most important fi les. If you back u p da ily, a day's work is the most you
could lose in a d isaster. If you back up o nly weekly or monthly, you could
spend a lo ng time catching up in case of a d isk failure. A good backup strategy, used regularly, can give yo u peace of mind and save you if something
goes wrong.
If you've done a lot of customizing to yo ur system or no longer have original
program disks, include the system fo lder or program files in you r backup.
This is usually im practical, however, if you use floppy disks fo r your backup.
The simplest and cheapest form of backup invo lves the mouse: you drag your
essential files to a floppy disk to copy them . Then you repeat with other
flopp y disks until you have backup co pies of all of your important data. This
approach soon runs into li mitations, though. W hat happens if you have a file
bigger than a floppy d isk's capacity of 1.44MB? What abo ut if you have hundreds of fi les and can't spend all day figuring out which fi les can fit best on
w hich disks? What if your data would fi ll u p 200 floppy d isks?
That's wh y you need a backup utility. A good backu p application lets you
select what folders and files you need to back up, compresses the data so it
takes u p less space, supports high-vo lume storage devices such as tape d rives,
and keeps track of all the details of which files were backed up w hen. Then if
you m istakenly overwrite a file o r your hard disk goes bad, you still have your
da ta.
Backup Types
Backups of your da ta come in three types: fu ll, differential, and incremen tal.
The ma jo r backup applications su ppo rt all three backup types, each has a
specific use depending o n your needs.

A full backup makes copies of every file. If you make a full backu p every day,
all you ever need to resto re lost da ta is o ne set of backup disks (or tapes, if
you have a tape d rive). The disadvantage is that performing a fu ll backup
takes the lo ngest time of the three backup types.
A differential backup makes copies of files that changed since the last full
backup. A common scheme might be to do a full backup o n Friday and
d ifferential backups o n the o ther weekdays. To restore data, you need just
two backup sets, the fu ll backup and the d ifferential backup fro m th e day
before the data was lost. The downside of this backup type is that each day's

~

See "Compression," p. 726
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differential backup is at least as big or bigger than the previous day's, so you
use more disks or tapes.
An incremental backup makes copies of files that changed since the last
backup o f any kind. A common scheme here is to do a full backup on Friday
and incremental backups o n the weekdays. This scheme uses fewer disks or
tapes than differential backups or daily full backups because there is no duplication of files: if you already have a backup of a fil e in its current state, it
doesn't get backed up in the incremental backup. The disadvantage is that
you may have to assemble several sets of backups (one full set and as many as
four incremental sets) to re-create your whole disk in case of disaster.
You can use a backup method that best fits your needs. For example, if you
need to be ready to restore files fast and don't care how many backup disks or
tapes you need, a differential strategy may be best. If you're willing to go
through a few more steps in return for faster backup times and less money
spent on backup media, the incremental route is probably best. Make sure the
backup package you buy supports that method.

Backup Applications
Dantz Retrospect is one of the most popular backup applications available. It
supports a wide variety of tape drives as well as backups to other media such
as floppy disks and removable hard drive cartridges. Retrospect also allows
you to back up only certain files based o n criteria such as how old the file is,
whether it's an applicatio n or document, and so on. You can store all of these
specifications in a script and reuse them later, freeing you from setting up
each backup from scratch (see fig. 38.1).
Fig. 38.1
The Retrospect
backup application.
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Dantz is also the developer of DiskFit, a backup application directed at
the single user with less demanding backup needs. DiskFit specializes in
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Fi11der-{omwt backups. Ra ther t han combine ma n y fi les into one a rchive that
ca n be o pen ed on ly by th e backup application, a Finder-form at backup leaves
each file in its original fo rm so you do n 't n eed th e backup applica tio n to
copy t h e file back to the ha rd disk. The d isadvan tage of this backup format
is th at it doesn 't suppo rt password p rotectio n o r space-saving compression.
Fifth Gen erati on Fastback was o nce a sta nda rd in Macintosh backup bu t has
since been passed up in popu la rity by Re trospect. Because Fifth Gen e ra tio n
h as been acquired by Symantec Corp., th e product's futu re is uncertain .
No netheless, Symantec is su re to supports its users by o ffe ring an altern ative
if it is discon ti n ued .
Redux, fro m lnline, is a typical Macintosh backup applica tio n . Like several
competitors, Redux all ows you to set up unatte nded backups. For exa m ple,
you ca n leave work at 5 :00 Friday afternoon a nd h ave your backup sta rt a t
6:00 after you' re gone. Redux also allows auto ma tic fo rma tting o f flo ppy
d isks to reduce the steps you have to go through fo r a ma nual backup.
Among t he utili ty collections, Central Point MacTools a nd Norto n Utilities
fo r t he Macintosh (n ow both owned by Syma ntec) include backup a pplicatio n s. MacTools Backup ca n make hill, diffe re ntial, or incremental backups
with or w ith o ut compression and in Finder forma t if you wish . It supports a
small list o f tape drives as well as n etwork drives, ca n scan fil es fo r v iruses
befo re backing up, a nd allows scheduling for unattended backups. Norton
Backup includes many o f the fea tures o f Retrospect and othe r backup applications but on a smaller scale. Norto n Backup is on e o f the fas te r products in
pe rfo rming backups to floppy disks.

Hard Disk Repair and Optimization
A Maci ntosh utility that repairs hard d isks could save your data some day. If a
h a rd d isk fails mecha nically-for exam p le, if the motor sim pl y di es o r o n e of
t h e ro ta ting disks inside cracks-there is very little you ca n do. However,
m ost ha rd disk p roblems ha ppen a t th e software level, not th e h ardware level.
Ha rd d isk repair is listed as a preventive measure beca use m a ny di sk pro blems
can be nipped in the bud by di sk repa ir application s, before yo u notice that
a nything is wro ng. And you ca n speed u p your h a rd di sk's pe rfo rma nce by
removing file fragmenta tio n with a d isk op timization ap p licatio n.

The Macintosh's File System
Th e file system is responsible fo r keeping track of wh e re your files a re o n a
d isk, alloca ting them extra space when you add info rmatio n to t hem by saving, reading them whe n a pplicatio n s n eed access to data, a n d d eleting th em
whe n you pu t th em in th e Trash .

VII
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In the early days, the Macintosh used what is called MFS (Macintosh File
System), a relatively simple fi le system that let you group files in folde rs in
the Finder while internally storing them so tha t every file on a d isk was in the
same folder. This worked fine for 400K floppy disks, but as hard disks started
getting more common, a file system that could offer higher performance and
greater capacity became necessary.
The current Macintosh file system, called the Hierarchical File System (HFS),
has an intricate structure. It involves a tree of index and leaf nodes that catalog up to many thousands of files and fo lders on a d isk for the most efficient
access. Occasionally things can go wrong in the record-keeping. Most often
this can happen after a system error or power fail ure, when files aren't
cleaned up and closed in the normal way. That's w hen a hard disk repair
application can become important. Some hard disk repair applications can
also find other problems, such as mu ltiple copies of the system fo lder, invalid
file dates, and corruption of the desktop database, which keeps track of wh ich
icons and documents are associated wi th a particular application.
Disk Fragmentation

Because files are created, changed, and deleted at d ifferent times and in no
particular order, a disk necessarily contains fragmented files. For efficient use
of space, a new or saved file may fill up a previously free chunk of space on a
disk, use a little more space later, and perhaps put the rest of its contents near
the end of a the disk's storage area. The blocks of space used are thus
discontiguous, or fragmented .
Normally, fragmentation is no problem because the fi le system keeps track of
the location of each fragment in a file. However, the more fragments a file
has, th e longer it takes the d isk to read the file because the disk head must
jump from place to place on the disk. High fragmentation also sligh tl y decreases your chances of recovering lost data with a data recovery tool. That's
where hard disk optimization applications are useful.
Hard disk optimization applications can copy parts of files to and from free
areas on your disk so that every file is in one piece, unfragmented. They can
organize the files on your disk so that all the unused space is together, which
helps to decrease future fragmentation. Finally, most hard disk optimizers
even let you decide which folders or types of files should be stored at the
beginning of a disk. If the files that rarely change are together at the beginning, then they are less likely to cause fragmentation around them.
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Hard Disk Repair and Optimization Applications
There are collection s of utilities on the market that offer who le suites of d ata
protection and data recovery applications, including hard disk repair and
optimization. There are also stand-alone disk optimization applicatio ns and a
free hard disk repair application that comes with your Macintosh. However,
in the case of disk repair, you get what you pay for.

VII

MacTools, from Central Point (now owned by Syman tec), includes a repair
utility, DiskFi x, that fixes software problems on hard disks. In addition to
problems in a d isk's actual file system, Diskfix can find viruses, warn you
when you have a certain number of files that haven't been backed up, fix
problems in the desktop database, and assess the overall level o f fragmentation o n your d isk. You can sched ul e DiskFix to run automatically at interva ls
you specify.
MacTools also includes Optimizer, a hard d isk defragmentation application.
Optimizer displays a color map of the contents o f your disk, identifying
which areas contain fragmented and unfragmented applications and documents. You can use the map to click any area of the disk and see the file it
contains. Before you optimize your disk, you can see a list of fragmented files
that shows how man y pieces each file is split into on the disk.
The main competitor with MacTools is Norton Utilities fo r the Macintosh
(NVM). Because they are now owned by the same company, Symantec, the
technology from the two products may soon be pooled. NUM is the better
known of the two utility collections, but it (as of this printing) hasn't been
updated for a couple of yea rs. The Disk Doctor applicatio n doesn't detect
quite as man y kinds of problems as DiskFix, but it generally works somewhat
faster (see fig. 38.2).

TU MOAtOH DISK OOCTOA

Ofeqrmlno .. Dete f 1lu ..

Fig. 38.2
The Norton Disk
Doctor hard disk
repair application.
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Also in the NUM package is Speed Disk, a h ard di sk optimiza tion application.
Speed Disk provides t he sam e basic disk defragme ntation functions as its
compe titors (see fig. 38.3).

Fig. 38.3
The Norto n
Speed Disk
defragm en tation
applica tion.

The granddaddy of Macintosh disk optimi za tion applications is ALSoft's Disk
Express, which has been available in some fo rm since t he mid-1980s. Disk
Express has the advantage of lo ng experience in disk d efragm entation tech nology. However, this p roduct is at a d isadvantage in price because the utility
collections offer several data recovery tools for a slightl y grea ter pri ce.
For h a rd disk repair, your minimum defense is Disk First Aid, a sma ll utility
included by Apple with the Macintosh system software. Disk First Aid fixes
only a few of t h e proble ms that the o the r hard disk repair applica tions can
deal with handily. However, if you d o n 't have a n other uti lity, run Disk First
Aid periodicall y. It can repa ir your disk in certain situatio ns a nd is better than
n othing.
One kind of di sk repair you can easil y do witho ut usin g a program at all:
rebuild ing the desktop database. The d esktop database is a pai r o f invisible
files that keep track of which ico ns go with wh ich files and w hic h docume nts
shou ld launch which a pplicatio ns. Double-clicking a d ocum en t a nd h aving
its associated application open is made possible by the desktop da tabase. This
deskto p database can become corru pted, resulting in gen eric b la nk page icons
or documents that won 't launch an application that you know is o n your disk.
To reb4 ild the desktop by yourself, follow these steps:
1. Turn o n you r Macintosh .
2. Ho ld down the Option a nd Comma nd ():() keys until a d ialog box asks
wheU1er you want to rebuild the desktop.

3. C lick OK.
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One side effect of rebuilding the desktop is deleting any comments you have
added to the Get Info window for a fi le. You can see o r add comments by
selecting the file and choosing Get Info from the File menu in the Finder. If
you don't want to keep track of shortcut key combinations, a shareware program called Desktop Reset can rebuild the desktop. Desktop Reset is available
from on-line services and from other distributors of public domain software.

Virus Protection
Happily, the communi ty of Macintosh users has been neglected by writers of
computer viruses, compared to the world of DOS-based PCs, where viruses
and their variants number in the thousands. But that fact is small consolation
if your data is lost or your system becomes unstable because of a virus. If you
ever download a file from a BBS (bulleti n board service), get a shareware
floppy disk from a friend, or use your disks in an unprotected campus computer center, your system could get a virus. Any sharing of files with an infected disk can transfer a virus.
Anti-virus sofh\'are has three main functions: background checking, disk
scanning, and repairing. Each is important for a complete line of defense
against viruses.
Background Checking

Most Macintosh viruses take effect when you run an application or load a
system extension or control panel. The virus may make changes to the system file, modify routines in memory, or attach itself to other files on your
disk. Some viruses deliberately attack your data, trying to garble files or erase
your disk.
When this happens, vi ruses leave telltale traces, usually a recognizable chunk
of computer code in the fil~ they attach themselves to. This code identifies
them like a signature. When anti-virus software is loaded as a system extension, it can wait in the background, checking each program before you run it
to see if it contains any known virus signatures. If so, the anti-virus software
can stop the program from running.
Background checking can also stop even unknown viruses by watching for
suspicious behavior, as well. For example, if a program goes around the standard fi le system's m ethods of deleting files, or if it tries to reformat a hard
disk, the background checker can warn you before it happens. Background
checking can also block a floppy disk from being made available to the system until it is scanned for viruses.

<Ill

See "Virus
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p. 729
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Disk Scanning
It's smart to periodically scan your disk for viruses even if your anti-virus
program has background checking turned on. You could have viruses that are
lying in wait but haven' t been activated yet. The scanning portion of the
software goes th ro ugh the files on your disk looking for recognizable virus
signatures.

Anti-virus softwa re may also create a checksum, a mathematical encapsulation
of the unique characteristics of a file. If an app lication has changed-because
being infiltrated by a virus changes the application file-comparing the current checksum with a previously recorded o ne.
Repairing
Sometimes all you can do if a file is infected by a virus is to delete it. However, som e viruses can be cleaned, or removed fro m the infected file, witho ut
permanent damage. In some cases, anti-virus applications can reconstruct the
original state of the file o r system component without the virus.
Anti-VIrus Applications
The best-known Macintosh anti-virus product is SAM (Symantec Anti-Virus
for Macintosh). SAM has been through several generations of revisions and is
widely used in corporations where Maci ntoshes are a standard. It offers a
variety of security features that can make sure, fo r example, that floppy disks
are always scanned for viruses (see fig. 38.4).
Fig. 38.4
The Symantec
Anti-Virus fo r
Macintosh
application.
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A runn er-up in market share is Virex, which has also been in the Macintosh
anti-virus business for years and offers many of the same fea tures as SAM.
One major selling point of Virex, besides general protection from viruses, is
its speed in scanning your disks (see fig. 38.5).
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Cen tral Poin t MacTools includes Central Point Anti-Virus, which also offers
t he typical background checking, d isk scanning, and repair capabilities. The
Anti-Virus module is so metimes sold on its own as well. Several other
MacTools modules, such as DiskFix and Backup, incorporate the same antivirus tech nology.
The best-priced an ti-virus application is Disinfectant, w rit ten by John
Norstad. It's free. Disin fectant is ava ilable fro m o n-line services and from
other distributors of public dom ain software.
Anti-virus researchers are very good about pooling their info rmation for the
good of the Macintosh co mmunity when m~w viruses are found. Usually
updated virus signatures or new versions of anti-virus soft ware are available
wit hin just a few weeks of a new virus's initial discovery, even if the virus was
initially fou nd as far away as Europe.

Diagnostics
Diagnostic software, tho ugh perhaps not strictly essential, ca n be a helpful
add itio n to your library of utility software. These packages are designed to
id entify potential problem s befo re they happen, like a perio dic physical exam
fo r your Macintosh . Most diagn ostic applications concentrate o n Macintosh
hardware, eit her specific o r general, and o thers o ffe r li m ited software features
as wel l.
Micro mat's MacEKG is a general hardware diagnostic tool t hat reports the
characteristics of the various componen ts of your Macintosh: memo ry, video,
SCSI devices such as hard disks, and o ther areas. You can use MacEKG to do
bench ma rk testi ng o f com ponents to see how they compare with other
Macintoshes o r peri pheral devices.
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Fig. 38.5
The Virex antiviru s application .
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The FWB Hard Disk Toolkit, a SCSI disk utili ty, can be purchased in one of
two options, Professional or Personal. The Personal package contains a less
technically-oriented subset of the Professional package. The Hard Disk Toolkit
focuses o n hard disks, though it can display limited information on other
SCSI devices such as CD-ROM d rives or scanners. You can use this utility to
refo rmat hard disks with multiple partitions, protect a disk with a password,
run benchmarks to check your disk's speed, and update your disk's drivers
(the hidden software that lets the disk communicate with the Macintosh
system) (see fig. 38.6).

Fig. 38.6

The Hard Disk
Toolkit SCSI utili ty
application.
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Help!, an application from Technosys, concentrates more on the software
configuration side of d iagnostics. You can use Help! to identify memory problems and scan your system folder to catch inco mpatibilities between system
additions such as extensions and control panels. Help! also increases potential storage space by checking th e contents of your disk for duplicate files.

Maintenance Schedule
If you took care of all of the preventive maintenance items in this chapter
every time you turned on the Macintosh, you'd never find time to do any
work or play any games. That's not the purpose of this chapter. Fortunately,
most of these preventive tasks need to be done only occasionally. A small
investment of time can bring a big d ividend in reliability.
Following are maintenance items grouped by suggested frequency. For details
o n each item, see the corresponding paragraphs earlier in this chapter.

Many Times a Day
• Save th e document you're working on. Save, save, save.

Maintenance Schedule

Daily
• Choose Shut Down from the Special menu in the Finder before turning
off the power to the Macintosh.
• Back up important documents that have changed since you last backed
them up.
• Perform a virus scan on any new software you get from an on-line service, BBS (bulletin board system), or a friend. Viruses don't develop by
themselves; they have to come from someone else.

Weekly
• Do a full backu p of your data.
• Clean your monitor screen. Fingerprints and dust can accumulate
quickly.
• Scan your entire hard disk for viruses. It sh ould take o nly a few minutes
to scan.

Monthly
• Optimize your hard disk with a hard-disk defragmentation application.
• Run Disk First Aid or, if you have one, a hard disk analysis application.
•

If you're short o n disk space, weed out useless information. Copy un-

used applications, documents, or system extensions to floppy disks, in
case you need them later, and then delete the fi les from your hard disk.
• Read a Macintosh magazine, if you subscribe, to watch for software
updates and useful new products.
• Clean the inside of your mouse or trackball.
• Clean your keyboard if it's dirty.
• Check the time by opening the Date & Time control panel. If the clock
loses time rapidly, you may need to have the computer's internal battery replaced by your dealer. Normally, the battery should last for years.

Yearly
• Open your Macintosh case and check for excessive dust.
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• Rebuild your desktop. You may want to do this more often if copying
files begins to take longer, file icons turn to the generic blank page icon,
or there's an increasingly long delay between when you double-click a
document and its associated application starts up.

From Here ...
For other information about solving problems that can happen while you use
the Macintosh, you can refer to the following chapter:
• Chapter 37, "Troubleshooting," goes through a list of symptoms and
explains what causes each sym ptom and how you can fix the problem.
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Appendix A

System 7.5 Shor

You can use keyboard commands to work quickly in the Finder. Selected
shortcuts are listed by category in this appendix. Other keyboard commands
are listed in the menus.

Working with Icons
To open an icon

Double-click the icon

To copy an icon into another
folder (instead of moving it)

Option-drag the icon

To clean up selected icons

Shift-Clean Up

To clean up and sort icons

Option-Clean Up

To edit the name of the selected icon

Return or Enter

To cancel moving or copying
an icon as you're dragging it

Drag the icon to the menu bar

To select an icon by name

Begin typing the name

To select the next icon alphabetically

Tab

To select the previous icon
alphabetically

Shift-Tab

To select an icon to the left
or right (in icon views only)

Left arrow or right arrow

To select an icon above or
below (in any view)

Up arrow or down arrow

To select more than one icon

Shift-click the icons or drag to enclose the icons

To select no icon (making
the desktop active)

:!:1:-Shift-up arrow or
click the desktop pattern
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Working with Windows
To close all disk and folder windows

Option-Close or Option-click any window's
close box

To move a window without
making it active

~ -drag

To open a pop-up menu of the
folders and disk that contain this
folder

~ -press

To close a window after opening
one of its icons

Option-Open or Option-double-click the icon

To zoom a window to the
full size of the screen it's on

Option-click the zoom box

the window

the window title

Working with List Views
To change how items are listed

Click a column heading

To expand the contents of the
selected folder

~-right

To collapse the contents of the
selected folder

~-left

To move an item to the top
level in the window

Drag the icon to top of window
(below title bar)

To expand all the contents
of the selected folder

~-Op t ion-rig h t arrow or
Option-click the triangle

To collapse all the contents
of the selected folder

~ -O ption-left arrow or
Option-click the triangle

To expand or collapse the contents
of every folder in the window

Choose Select All, then expand
or collapse the contents

arrow

arrow

Restarting the Computer

Using Directory Dialog Boxes
To cancel

~ -period

To move up one level

~-up

To move to the desktop level

~- D

To select an item by name

Begin typing the name

To select the next or previous item

Up arrow or down arrow

To display, instead of open,
the original of an alias

Option-open the alias

To open the selected item

Return or enter or

To eject the selected disk

~ -E

To create a new folder (in Save dialog
boxes only)

~ -N

To make the directory or the
name box active (in Save
dialog boxes only)

Tab

or Escape

arrow or click the disk icon

~ -0

or

~ -down

arrow

Restarting the Computer
~ -Option

To rebuild the Desktop file

Hold down

while computer starts up

To turn off all system
extensions when starting up

Hold down Shift w hile computer starts up

To eject floppy disk (to avoid using
it as the startup disk)

Hold down mouse or trackball button w hile
computer starts up

To bypass internal hard disk
when starting up

Hold down ~-Shift-Option-Delete while
computer starts up

To reset the Chooser and control
panel settings (stored in parameter
RAM)

Hold down ;J:t-Option-P-R while computer
starts up
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Miscellaneous Options
To make the desktop active

~ -Shift-up

To skip the warning message
and to delete locked files
in the Trash

Option-Empty Trash

To reverse the current
setting of "Always snap to
grid" (in the Views control
panel) w hile moving an icon

~ -drag

To erase a disk automatically
wh en you insert it

Hold down ~ -O ption-Ta b
while inserting the disk

To take a snapshot of
the screen

~-Shift-3

To hide a program's windows
w hen you switch to another
prog ram

Option-make another program active (by choosing
it from the Application menu or by clicking one
of its windows)

To select an item in a
list in the Chooser

Begin typing the name

To make the next list active
in the Chooser

Tab

To make the previous list
active in the Chooser

Shift-Tab

arrow or click the desktop pattern

the icon

To choose Guest when connecting
to another computer
To choose Registered User
w hen connecting to another
computer
To set the language to
English (if WordScript is installed)

~ - left

To set the language to
the system script

~ -right

To set the language to the
next script in the
Keyboard menu

~ -space

To set the language to the
next language in the current script

~ - Option-space

arrow

arrow

bar

bar

Appendix B

Special Characters

The following tables show examples of special characters that can be easily
accessed on the Mac by pressing either Option or Option-Shift in combination with the keys listed across the top of the table. The fon ts shown here
represent just a few of the many fonts available for the Mac. The fon ts you
have to choose from depend on what software is installed on your system.
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Glossary

32-bit addressing. The method the Macintosh uses to access RAM above 8
megabytes.
A/UX. A form of UNIX available for the Macintosh. See also UNIX.

Accelerator board. An option card that, when installed in the Macintosh,
enables the computer to operate and manipulate data at a faster rate.
Acoustic modem. A modem with two cups that fit around a telephone's
handset; converts a computer's signals into sound and back again. See also
modem.

Active window. The top or fro nt window o n the Desktop. It has a highlighted title bar.
ADB. See Apple Desktop Bus.

Adobe Type Manager (ATM). An outline fo nt utility that allows postscript
fo nt scaling on the screen and on no n-postscript printers.
Adobe Type Manager GX (ATM GX). Adobe Type Manager for
QuickDraw GX . See also QuickDmw GX.
Alarm Clock. A desk accessory that displays the current date and time. The
alarm can be set to alert you at a specified time.
Alert box. Contains a warning when you ask the Macintosh to do something
that can cause loss of data or when o ther errors occur. See also dialog box.
Alias. An ico n that represents an o riginal fil e folder or disk.
Apple Desktop Bus (ADB). The connectors on the back of the Macintosh
that allow connection of the keyboard, mouse, joysticks, graphics tablets,
touch screens, track balls, and so on.
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Apple HD SC Setup. A system utility file packaged with the Macintosh that
initializes and sets up an Apple hard disk.
Apple menu. The far left menu at the top of the Macintosh screen.
Apple menu items. Items ava ilable on the Apple menu of the Desktop fo r
immediate use. In System 7, these applications, folders, and files are placed in
the Apple Menu Items folde r.
AppleScript. Apples scripti ng system that allows you to automate tasks.
AppleShare. An o perating system designed to enable a Macintosh to become a server to other Macs o n the same network.
AppleTalk. A communications network used to connect Macs and share
peripheral devices such as prin ters. AppleTalk is the communication protocol
by which data is transferred. Also called LocalTalk.
Application. A program th at enables the user to create, enter, and design
information. Examples are word processors, spreadsheets, and paint programs.
Application menu. A menu on the right end of the m enu bar that allows
you to switch between active applications. It also allows you to hide applications, including th e Finder.
Application template. A file developed to guide the creation or design of
documents. See also ternplnte.
Arrow keys. The fo ur keys that move the insertion point left, right, up, and
down in a word processor file and that ch ange the active cell in a spreadsheet.
ASCII (American Standard Code for Information Interchange).
A standard com puter text format in w hich each cha racter is represented by
seven bits. See also text file.
Assembler. A program that translates symbolic codes, o r assembly lauguage,
to machine language. See also compiler.
Asynchronous communication. A means of transmitting data between
computers. A special signal indicates when each character starts and stops.
ATM. See Adobe Type Manager.

Auto answer. The capability of a modem to answer an incoming call and to
establish communications without human assistance.

Glossary
Autocall. The capability of a computer-controlled modem to place a telephone call.
Autotrace. A fea ture in drawing and page layout applications that enables
the user to trace around shapes and lines of an image.
Background execution. A program that can continue operating without
user comm ands and witho ut interrupti ng a procedure operating in th e foreground. See also MultiFinder and multitasking .
Ba llo on Help. Context-sensitive help available through System 7 and m any
System 7 applications.
Baseline. The horizontal line that defines the bo tto m of each character,
excluding the descenders, in a font fam ily.
BASIC (Beginner's All-Purpose Symbolic Instruction Code).
A common progra mming language that is easy to learn but relatively inflexible.
Ba ud rate. A measure of the speed at which a modem modulates signals.
Bits per second is a more meaningful measure of modem speed. See Bits per
second.

BBS. See bulletin board system.
Beta test . The fi rst test of a new product o utside the labo ratory. This test is
the final step before a full market release. Because many product bugs are
fo und in th e beta test release, producers do not consider the beta versio n to
be a final version.
Bezier curves. Ma thematically generated line that can display non-uniform
curves; used to create PostScript fo nts.
Binary. A numbering system based on a series of o nes (1s) and zeros (Os)
used to en code text and numerical informa tion .
Bit (binary digit). The smallest unit of computer informatio n. A 1 or a 0
code electronically represents o n o r off, respectively.
Bit-mapped f ont. A fo nt composed of dots. Used primarily fo r screen representatio n of fo nts.
Bit-mapped image. An image consisting of dots, in which one dot represents o ne o r mo re bits of the image (depending o n whether colo r or o ther
attributes are used). A Mac Plus uses one bit per dot.
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Bits per second (bps) . A measure of the number of useful bits of data transferred over a communications line.
Bomb. An abnormal termination of a program. A bomb occurs ~hen a program unexpectedly halts due to a bug or encounters data conditions it canno t
hand le. See also bug.
Boot. To start a computer by loading the operating system (System fi le and
Finder) into memory. The operating system software tells the Macintosh how
to load other programs.
Bridge. A device that enables you to connect networks so that members on
one network can communicate with members on another network. See also

gateway.
Buffer. A section of memory that temporarily holds information from 1/0
(input/output) communications, including data transfer through a modem or
reading and writing to your disk. The buffer holds information when the
computer is sending informatio n faster than the device can receive it.
Bug. A problem in a software program. Initially named after a moth that
caused the failure of an ea rly computer (1945) at Harvard University. Today, a
bug usually refers to an inappropriate or inaccurate line o f programming code
that causes the program to halt execution or respond incorrectly. See also
bomb.
Bulletin board system (BBS). A telecommunications facility used to sha re
information with others through the use of a modem and specialized commun ications software.
Bundled software. Software included with your Macintosh, such as the
System Tools disk, Utilities disk, and HyperCard. Such a package deal includes
hardware and software.
Bus. A path through which information is shared between one part of a computer and another.
Button. A location on the screen where the user can click to initiate a command for the Macintosh to take some predefined action.
Byte. A collection of eight bits. A byte can store a single character of
information.
Cache. See RAM cache.
Calculator. A desk accessory that looks and acts like a four-function
calculator.

Glossary
Cancel button. A button in dialog boxes that the user can click to cancel a
command.
Caps Lock key. A key located on the lower left corner of the Macintosh
standard keyboard that, when pressed, causes alphabetic characters to be
displayed in uppercase format but does not affect numeric keys o r symbols.
Carrier detect. A modem function that detects whether another modem is
sending a carrier signal. If the carrier signal is not detected, you r modem
generally disconnects itself and hangs up.
Cathode-ray tube (CRT). The screen used in computers in which light
produced by a cathode strikes a phosphor coating on the screen.
CDEV. An acronym for Control panel DEVice. A program that adds functionality to a Mac and is controlled by a Control Panel.
CD-ROM (Compact Disc-Read-Only Memory). A disc that can store as
much as 600 megabytes of da ta. A CD-ROM uses the same technology as
audio CDs, but is used to provide a computer access to large quantities of
information.
Central processing unit (CPU). The computer's m ain informatio n processing unit. In a Macintosh, the CPU is a single silicon chip called the microprocessor. See also microprocessor.
Chip. A tiny piece of silicon with an integrated electronic circuit photoen graved on its surface.
Chooser. A desk accessory that enables the user to choose the printer on
which the document is to be printed. For the Chooser to function, the printer
resou rce files must be installed in the current System file. In a networking
environment, the Chooser can be used to connect and disconnect the
Macintosh from the network and choose from among devices connected to
the network.
CISC. An acronym fo r Complex Instruction Set Computer. A microprocessor
that includes a large number of instructions, m any of which take several steps
to perform. CISC processors are not as fast as the alternative design, ca lled
RISC. See also RJSC.
Click. To place the mouse pointer (arrow) on an item on-screen, and quickly
press and release the mouse butto n .
Clip art. Artwork, bought on disk, that can consist of bit-mapped graphics,
object graphics, or encapsulated PostScript files.
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Clipboard. A tem porary storage location that holds cut and copied
information.
Clock speed. The actual operating speed of the computer's microprocessor.
Close. A command that closes a window or document.
Close box. A small box located at the top left of some wi ndows. Clicking the
Close box causes the window to close.
CMYK. The four colors-cyan, magenta, yellow, and black-used in the color

separation process that can be combined to form any other color.
Cold boot. Using the power switch to turn on your Macintosh.
Color separations. A process used in offset printing in which separate
plates are used to print different colors of ink on a page producing multiple
colo rs. As the name implies, each colo r has its own plate. When all color
plates are placed atop each o ther, the final product is produced.
Command. A m enu option that causes an action. A command tells the
Macintosh what to do next.
Command key. A key that, when pressed in combination with other keys,
performs a command o r action. The command key has a picture of an Apple
and a "cloverleaf" on it.
Commercial software. Software that is copyrighted and sold for profit.
Commercial software canno t be copied and distributed to others without the
approval of the software publisher.
Compiler. A program that translates source code to machine language. See
also assembler.
Computer-aided design (CAD). Applications that take advantage of a
computer's power to design architectural, mechanical, electrical, civil, schem atic, IC, and various o ther types of drawings. Usi ng the two- and threedimensional capabilities of the application, the user can develop highly complex structures. Commonly referred to as computer-aided drafting and design
(CADD).
Condensed type. A typeface in which the space between the characters is
less than the normal spacing of the typeface. See also font and kerning.
Continuous tone image. An image that contains gradient tones from
black to white. In a scanned image, the tones are converted from continuous
to halftone images. See also scanner and optical character recognition.
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Control (Ctrl) key. A key located on the left side of the standard keyboard,
whose functio n varies depending upon the application being used.
Control panel. A desk accessory in System 6 that's used to personalize such
features as the pattern o n the Desktop, the speed of the mouse movement,
and the volume of the wa rning beep.
Control Panels folder. A folder in System 7 that resides in the System
Folder and contains control panels. Replaces the Control Panel desk accessory
of System 6.
Coprocessor. See Matll Coprocessor.
Copy. A command used to make an exact replica of text, an entire document, or a graphic. The Copy command is located in the Edit menu. Using
Copy does not modify or delete the original.
Copy protection. A method of preventing unauthorized duplication of
software. See also write-protect tab.
Current startup disk. The startup disk whose System files the Macintosh is
using.
Cursor. The blinking vertical bar that indicates where keyed text will appear.
Also called insertion point.
Cut. A command that removes selected information from a document and
temporarily places it in the Clipboard.
Cylinder. Th e total number of disk tracks that can be written or read fo r a
specific disk-head positio n . On a double-sided floppy disk, a cylinder is two
tracks; on a hard disk, it consists of four or mo re tracks. See also track.
DA. See desk accessory.

Data. The informatio n processed with a computer application or program .
Also called information.
Datai_Jase. A collection of related info rmation that is organized for storage
and retrieval. A database may contain names, addresses, and phone numbers,
for example.
Data fork. Th e portion of a Macintosh disk file containing the user's data.
Default. The settings that hardware o r software have when first installed.
Defragment. To increase the amount of usable space on a hard disk by rewriting files so that they are stored on contiguous sectors or parts of the hard disk.
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Delete key. A key that you press to remove informatio n from a document.
Using this key is the same as using the Cut command except that the information is not placed on the Clipboard; it is deleted permanently. See also cut.
Delimiter. A special character used by applications and communications
software to indicate the end of a line or to separate one field from another or
one record from another.
Desk accessory (DA). A small application (located in the System file) that is
accessible from the Apple menu. Exa mples are the Alarm Clock, Chooser, and
Control Panel. Other more complex desk accessories are mini-spreadsheets, a
thesaurus, and a bibliography maker.
Desktop. The wo rk area of the Macintosh. The screen, disk icons, Trash can,
and m enu bar that you see when you start your Mac.
Desktop file. A file created on all Macintosh disks by the Finder. It is hidden from the user and contains information the Finder uses to locate files,
folders, and icons.
Desktop publishing. An integrated package of certain applicatio ns that
enables the user to design the layout of pages, determine the size and location of graphics, modify and locate text, and produce a document. Desktop
publishing programs integrate page layout, text entry, graphics design, and
printing into one overall application.
Dialog. A message from the Macintosh requesting further action or inform ation from the user. In most instances, the user can respond by typing a response or clicking a button . When accompanied by a beep, the user is being
warned that som ething may happen that the user has not anticipated. See
also alert box.
Digitizer pad. A peripheral device that is similar to the mouse but enables
the user to choose drawing tools, menu commands, and other functio ns, as
well as to d raw sha pes without using the applications interface.
Dimmed command. A menu command that appears gray o n-screen and
cannot be used while dimmed. Usually anoth er command must be completed
or a selection made before the dimmed command can be accessed.
Dimmed icon. Represents a document, folder, or application on a disk that
has been e jected. The image still resides on the Desktop, but the contents of
the folder or disk cannot be opened .
Direct-connect modem. A modem that connects directly from the computer into the telephone line o utlet and bypasses the telephone handset.
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Directory window. The window that lists the contents of a disk. Using the
View menu, the user can alter the appearance of the directory and have the
contents displayed in small icons, large icons, and words.
Disk. A device that uses magnetic medium to store information. Disks can be
floppy or h ard. The Macintosh uses 3.5-inch, h ard-case floppy disks.
Disk drive. Holds th e disk and retrieves information stored o n the disk. The
user must insert a floppy disk into the floppy disk drive. A hard disk drive has
a built-in disk permanently installed.
Disk drive port. A port o n the Macintosh designed to be connected to an
external floppy disk drive. See also port.
Disk server. A disk drive, generally on a network, that is ava ilable to all
users.
Document. A generic term describing whatever the user creates, using an
application on the Macintosh. A document can be a letter, article, picture,
table, o r spreadsheet, among o thers. A document contains the information
the user has entered and saved.
DOS (Disk Operating System). A shortened name for PC-DOS and
MS-DOS, which are the complete names of the operating system fo r IBM and
IBM-compatible computers. DOS is a set of instructions. See also operating

system.
Dot-matrix printer. A printer that forms characters and graphics from pins
impacting the paper through an ink ribbon. The ImageWriter printers are
do t-matrix printers.
Dots per inch (dpi). A measure of screen and printer resolution by the
number of dots per linear inch. The higher the number of dots, the better the
resolution. The ImageWriter II operates at 144 dpi, and the LaserWriter operates at 300 dpi. See also resolution.
Double-click. An action used to open applications, documents, or folders.
Double-clicking is performed by clicking the mouse button twice in rapid
succession .
Download. A procedure in which a user transfers data from a remote
computer's database to the user's computer and stores the data on a hard disk
or floppy.
Downloadable font. A font that is downloaded (sent from your Macintosh
to your printer) .
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dpi. See dots per incll.
Drag. A mouse technique used to select text and move objects on the screen.
To select text, place the pointer at the beginning of the text you want to
select, hold down the mouse button, move the pointer to the end of the
selection, and release the button. To move an object, point to the object,
hold down the mouse button, move the pointer to the location you want the
object to appear, and release the mouse button.
Drag and Drop. An editing technique that allows you to copy or move text
by dragging a selection with the mouse. See also drag.
Driver. Software that tells the Macintosh how to operate an external device
such as a printer. A driver is located in the System Folder or Extension Folder.
Duplex. A communications protocol that allows for two-way communication. A half-duplex communication transmission can go only one direction at
a time. In full-duplex commun ication, transmission occurs in both directions
simultaneously.
Edit menu. A menu that contains the copying and cutting fea tures and the
Undo command.
Electronic mail. See e-mail.
e-mail. A messaging system that enables the user to send and receive messages to people in and outside the user's computer network. Outside messages
are gen erally sent using telephone lines. A message can be as simple as a
quick note or as complex as multiple documents and files.
Em dash. A dash the width of the capital letter M.
Em space. A space that is the width of the letter M of a specified typeface
and type size. See also en space, font, keming, and leading.
Emulation. A feature that enables one device to imitate another.
Encryption. To substitute characters to hide the origi nal meaning of a
document from those people who do not have the enciphering program.
En dash. A dash the width of the capital letter N, usually half the width of
an em space.
En space. A space that is the width of the letter N ina specified typeface and
type size, usually half the width of an em space. See also em space.
Enter key. A key that confirms an entry. Similar to the Return key.
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EPS (encapsulated PostScript). A file format that uses PostScript language to sto re an image.
Ethernet. A standard for local area network hardware.
Expansion card. An interna l card that enables additional features to be
added to the computer's processing capability, telecommunicatio ns capability, and so on.
Expansion slot. A location inside the Macintosh that allows the installation
of an o ption card to perform additional functions. See also option card.
Extension. A system program that extends the capabilities of System 7's
fea tures. See also INIT.
Fax/modem. A modem with fax capabilities. See modem.
File. Info rmation stored o n disk. Documents and applications are examples
of files.
File format. The set of instructions used to store information.
File server. A node o n a network that has a disk drive, software, and processor that is available to all users. File-server software controls access to individual files, and multiuser software enables sever11I users to access the same
file simultaneously.
File synchronization. A method that enables people who wo rk with the
same fi le o n two different systems to syn chron ize the files to ensure that they
are working on the most recent versio n.
Fill. To paint an enclosed area with black, white, color, or shading.
Finder. A file and memo ry management utility that keeps the Desktop organized, thus enabling users to find and open files or folders. The Finder must
always be in the System Folder fo r your Macintosh to operate properly (with
the exceptio n of HyperCard).
Fkey. A utility program similar to a desk accessory that runs when the user
presses one of the number keys along the top of the keyboard in combinatio n
with ~ and Shift. Fkeys sho uld not be confused with the Functio n keys at the
top of extended keyboards.
Floppy disk. A removable secondary storage medium that uses a magnetically sensitive, flexible disk enclosed in a plastic envelope or case.
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Folder. Ho lds related information in o ne location like the folders in an office
file cabinet. A folder can contain files, other folde rs, graphics documents, or
other informatio n.
Font. A collection of letters, punctuation marks, numbers, and symbols that
appear in the same typeface, style, and size. The Macintosh comes with a
number of typefaces, such as Monaco, Chicago, and Geneva. See also bitmapped image, outline font, and PostScript.
Font/ DA Mover. A System 6 utili ty that moves fonts and DAs from o ne
System to another or from a floppy disk to a System.
Font substitution. A Macintosh activity that substitutes one font for another when the font required by a particular application is not available.
Footer. Text that is automatically printed at the bo ttom of each page.
See also header.
Fragmentation. A situation in which various parts of a file are stored on
more than o ne sector of a hard disk.
Freeware. Software shared without costs to the user, with the intention that
the software be shared by others and d istributed throughout a large network
of users. See also public domain software and shareware.

ftp. An acronym for file transfer protocol. On the Internet, an ftp server
provides files for transfer.
Function key. A key that can be programmed to perform a particular
fun ction.
Gateway. In a com puter network, the hardware and software used to connect two different types of computer networks. See also bridge.
Get Info. A command o n the File men u that provides the following info rmation o n the file: locked or un locked, creation date, mod ification dates,
size, and user-entered notes.
Gigabyte (G). Around one billion bytes (1,073,741,824 bytes) or 1,024
megabytes.
Gopher. An Internet service that allows you to locate files and information
on the Internet.
Grayscale. A degree of screening ranging from white (0% screen) to black
(100% screen) applied to images created with various graphics and drawing
app licatio ns.
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Grouping. A fea ture of drawing and page layout applicatio ns in which two
or more objects are combined so that they are trea ted as one object.
GUI (graphical user interface). The way the Mac and the Mac user interact with each o ther. The GUl takes full advantage of graphics by using icons
and the mouse.
Hard disk drive. A disk drive contained inside or residing outside the
Macintosh. The drive contains permanen tly installed disks that hold much
mo re information than a flo ppy disk does and retrieves information faster.
Hardware. The physical parts of the Macintosh : the screen, keyboard,
mouse, disk drives, casing, cables, and all the electronic mechanisms and
boards inside the Macintosh. Hardware also includes other pi eces of computer eq uipment, such as printers and modems.
Hanging indent. A word processing fo rmat in which the first line of a paragraph is flush with the left margin and all subsequent lines in the paragraph
are indented.
Hayes-compatible modem. A modem that sets modes and features with
the AT command set that was d evelo ped by Hayes Microcomputer Products.
Header. Text that is automatically printed at the top of each page. See also
footer.
Hierarchical database. A database that o rganizes info rmation in tree-like
structures.
Hierarchical File System (HFS). A system that enables the user to o rgani ze info rmatio n with folders. The user can orga ni ze applicati ons, documents, and other folders withi n fo lders to create levels in a hierarchy. See also
Macintosll File System.
Highlight. Usua lly means to select something so that it appea rs different
from the surrounding information. When a piece of information is highlighted, the user can initiate a command to modify th at info rm ati on, fo r
example, you highlight a word w hen you are read y to make it bold .
High-profile SIMM. An in-line m emory module that, when installed, is not
flush with the motherboard.
HyperCard. An object-oriented appl ication, developed by Bill Atkinson,
that the user can modify. Us ing a scripting language called HyperTalk, you
program HyperCard to create applications called stacks, which consist of
cards that have buttons, icons, and fields that ca n perform other fun ctions or
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can be linked to o ther stacks o r ca rds. You can use HyperCard (which is idea l
fo r sharing information in an ap proach that is visually appealing and understandable) to access many diffe rent types of info rmatio n. See also HyperTnlk.

HyperTalk. The programming language used to program HyperCa rd stacks
and to create user-defined functio ns. HyperTalk is an "En gl ish-li ke" scripting
language. HyperTa lk uses scripts to reference in fo rma tion and to build the
command structure within the stack. See also HyperCard.
Hypertext. The retrieva l o f text and ideas thro ugho ut various documen ts
an d files without rega rd to order.
1-beam. The shape t he mo use pointer takes when the user is en tering info rmatio n or editing text. The pointer resembles the uppercase letter I .
Icon. A graphic representati on of a file, folder, disk, o r command. A file is
generall y represented as a sheet o f paper, for exa mple, and a folder looks like
a ma nila folder.
ImageWriter. The first d o t-matrix printer d esign ed specifically for use wi th
the Macintosh.
ImageWriter font. A bit-mapped fo nt designed to be printed using the
lmageWriter.
Impact printer. A p rinter that fo rms characters b y stri king an in ked ribbon
aga inst paper. See also dot-mntrLY printer.
Incremental backup. O ne o f two types of backups in which only those
files changed since the last backup are backed up.
Information service. A service accessed through telecommunications software th at enables users to access financial, n ews, and entertainment da tabases. See also bulletin board system and on-line services.
INIT. A utili ty file (called extension in System 7) located in the System Folder.
After you place an !NIT fi le in the System Folder and restart the Maci n tosh,
the INIT file becomes acti ve. See also extension.
Initialize. To prepa re a disk to be used by the Macintosh . Generally, when
you in itialize a disk, t he Macintosh structures the disk into sectors and tracks.
After a disk has been initialized, the Macintosh can use it to save informat ion
to and retrieve info rmatio n fro m. Also called fo rmatting a d isk.
Inkjet printer. A prin ter that forms characters by spraying tiny streams of
ink onto paper.

Glossary
Input device. A device (such as a mouse, keyboard, trackball, or graphics
tablet) that inputs information into your Macintosh.
Insertion point. See cursor.
Installer. A separate application used to install software on your hard disk.
Integrated software. A software package containing spreadsheet, database,
word processor, and telecommunications applications in which the component programs freely exchange data.
Interface. An electronic link between different computer devices, such as
the computer and a mo use. The point where two elements meet. The connectin g point between the Macintosh and the lmageWriter II, for example, is
an interface. An interface may exist between two pieces of hardware, two
pieces of software, o r a piece of hardware and a piece of software.
Internal modem. A modem installed into a computer slot. A modem that
is built directly into the computer.
Internet. A collection of com puter networks that make up the info rmatio n
superhighway.
Invisible file. A file that does not appear on the Desktop and that cannot
be copied, erased, or moved.
Kerning. In word processors, page layout software, and adva nced drawing
applications, the process of adjusting the spacing between letters. Typically
used to reduce the space between pairs of letters. Kerning is an automatic
feature with QuickDraw GX.
Kilobits per second (Kbps). A measure of da ta transfer speed, in tho usands of bits per second.
Kilobyte (KB). 1,024 bytes. A common measure of file size. A typical
double-spaced page is l.SKB.
LAN. See local area network.

Landscape. A page orientation in which the printer prints the image horizon tally. The page to p is the longest side of the paper.
Laser font. An easily scaled font defined by math ematical formulas.
Laser printer. A printer that forms characters and graphics by moving a
laser beam across a photoconductive d rum. The printer then projects the
image onto paper. Macintosh laser printers are called LaserWriters. See also

toner.
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LaserWriters. Apple's line of laser printers.
Launch. The act of double-clicking an application to start it.
Leading. The amount of vertical spacing, in points, between baselines of
type.
Lisa. The first computer to use th e Mac interface, including the mouse and
icons. The Lisa was unsuccessful due to its high cost.
Local area network (LAN). Computers linked with cables and software.
The computers can share files and external devices such as printers and disk
drives. Many offices are li nked together with LANs to improve communication and efficiency.
LocalTaJk. The hardware portion of Apple's LAN system used to connect
Macs to LaserWriters and other Macs.
Logic board. The board inside the Macintosh responsible for o rganizing
and executing instructions.
Lookup field. A database field that the database management system uses
to find information contained in a table.
Low-profile SIMM. An in-line memory module flush with the motherboard
when installed.
MacBinary. A format that enables Macintosh files to be stored on non-Mac
machines without any loss of data.
Macintosh File System (MFS) . A method of organizing files and folders
where folders cannot be nested within folders. Followed by the Hierarchical
File System (HFS). See also Hierarchical File System.
Macintosh User Group. An association of Macintosh enthusiasts of various
levels of proficiency who meet to discuss issues relating to the Mac. User
groups are located throughout the country. Many have a newsletter, which
provides m embers with updated information and tips.
Macro. A small program of stored commands that, when retrieved, replays
the commands to perform a task. It can be activated to do repetitive tasks
simply by typing a letter or number that represents the macro program. Usually created with a macro application, altho ugh macro creation is available
within some applications.
MacTCP. Apples version of TCP/IP, which allows Macintoshes to communicate with other mainframe and other hosts. See also TCP/ IP.
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Mainframe. A large-capacity computer shared by many users. Its central
processing unit (CPU) generally is housed in an air-conditioned room, and
the terminals are located at various sites.
Marquee. The dotted line drawn around text or graphics by using the mouse
pointer.
Math Coprocessor. A component that assists the main processor with
floating-point math operations, such as those used in complex spreadsheets
and graphics.
Megabyte (MB). A unit of measure representing 1,048,576 bytes (or
1,024KB) of storage capacity on a disk or in RAM. Hard disks are typically
measured in terms of the amount of storage capacity. A 20MB hard disk indicates that the storage capacity of this disk drive is 20MB and holds approximately 20,480KB of information.
Memory. The primary internal location within the computer where internal
instructions are stored. The location in the Macintosh's central processing
unit that holds information. Some of this memory is used by applications as
necessary to do complex calculations or sort data (RAM). Other memory is
permanently used by the Macintosh and is not accessible to the user (ROM).
See also random-access memory (RAM) and read-only memory (ROM).
Menu. A list of commands available to the user. You can open a menu by
clicking the menu's name at the top of the screen. The user holds down the
mouse button, moves t he mouse pointer down the list of menu commands,
and then releases the mouse button on the command needed.
Menu bar. The top line on-screen. It horizontally lists the menus available
to the Macintosh user. See also menu.
MFS (Macintosh File System). The original filing system used by the
Macintosh in which files and folders remain at the same organizational level.
See also Macintosh File System.
Microcomputer. A small, relatively inexpensive computer developed primarily for use by one person. Also referred to as a personal computer or home
computer. A Macintosh is a microcomputer.
Microfloppy disk. A 3.5-inch flexible disk contained within a semi-rigid
plastic casing. See also floppy disk.
Microprocessor. A small silicon chip containing a large number of electronic components. The microprocessor chip can operate on large amounts of
information when used with other computer components.
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Minifloppy disk. A 5.25-inch flexible disk contained in a flexible plastic
casing, used in many microcomputers. See also microfloppy disk.
Modem (modulator/demodulator). A peripheral device that enables
computers to communicate by telephone lines.
Monitor. The screen associated with a computer. The light-blue Macintosh
Plus and SE monitors are located directly above the disk drives, all contained
in one cabinet. The Macintosh II has a separate monitor, which is not enclosed with the CPU or disk drives. Monitors can be color or monochrome.
Motherboard. The main board (also called the logic board) in the Macintosh
that contains the central processing chips, RAM, and expansion slots.
Mouse. A hand-held device used to navigate on the Macintosh screen. The
mouse can be used to access the menus and select information. When you
move the mouse, the pointer moves on-screen in the corresponding direction.
MultiFinder. A component of the Macintosh's System software that enables
the user to load into memory multiple applications and switch among them.
MultiFinder also allows for concurrent tasks to take place at seemingly the
same time, which is known as multitasking.
Multimedia. Information presented in visual, auditory, and text formats.
Multitasking. A computer capability in which two or more programs are
loaded into memory simultaneously. The CPU attends to all programs at once
by switching back and forth between them-a process known as time slicing.
See also MultiFinder.
Nanosecond. One billionth of a second.
Nesting. The placement of files within folders.
Network. A computer communication pathway using hardware and software that links multiple computers and peripheral devices so that each computer or device shares information. See Node and Local area network.
Node. A device on a network (such as a computer, a hard disk, or a printer)
that can send and receive information. See also network.
NuBus. A high-speed information pathway for the Mac II family of
computers.
Null modem. A cable connecting two computers. Used for communication
purposes rather than a modem.
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Object-oriented programming (OOP). A programming language in
which program elements are conceptualized as objects that can pass messages
to each other.
On-line help. A file contained within an application that can provide the
user with help as the application continues.
On-line services. Various databases available to users who have a modem
and telecommunications software. They offer access to business, education,
travel, and entertainment databases (among others). Two popular on-line
services are CompuServe and America Online, which are offered to members
who pay a membership fee and a monthly access-time fee. In most instances,
members can download information, files, and applications of interest. See
also bulletin board system.
Open. The act of accessing a document for changing or viewing.
Open architecture. A computer design that enables third parties to design
components and other improvements for use with the System.
Operating system. The System Software, which controls the functioning of
the Macintosh and the direction of information flow among computer components. See also System Software.
Optical character recognition. A technology by which printed characters
are optically scanned and translated into codes that the computer can process. The device that has this capability is known as an optical character
reader (OCR) or scanner. See also scanner.
Optical disc. A disc on wh ich music or data is recorded in the form of small
pits. The data or music is retrieved with a laser beam.
Option card. Generally, a specialized piece of electronic circuits, installed
by your Apple dealer, that enhances the performance of your Macintosh. An
example is the installation of an accelerator card. See also expansion slot.
Option key. A Macintosh key used with other keys to perform particular
operations.
Outline font. A PostScript font formed of outlines, which are then fi lled in.
A printer font used to describe font characteristics for laser printers. Outline
fonts generally have greater resolution than bit-mapped (screen) fonts. See
also bit-mapped image, font, and PostScript.
Pack/unpack. To compress data for the purpose of storage or transmission.
Unpacking is decompressing a file and returning it to its normal state.
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Page description language (PDL). A language used to describe printer
output.
Page preview. A feature of many Macintosh applications that gives the user
a view of the printed page before actually printing the document.
Pantone Matching System. A standard system for choosing colors based
upon ink mixes. A color wheel generally provides the necessary information
for choosing colors for color applications and monitors.
Parallel port. A connection to a computer through which eight or more
bits are transmitted simultaneously in one direction. See also disk drive port.
Parameter RAM. Memory devoted to certain System settings such as the
time, date, and the alarm clock.
Parity bit. An extra bit appended to a character whose value is used to
check for errors in the transmission of data.
Partition. A physically separate section on a hard disk that can be used with
the same or a different operating system.
Paste. A command that retrieves from the Clipboard a copied or cut piece of
data and places the data at the insertion point in a document.
Path. The hierarchical path to a folder, application, or document file that
reflects the organ ization of a particular group of information.
PDD. See Portable Digital Document.
PDS. An acronym for Processor Direct Slot, an expansion slot fo und in some
Macintosh models.
Peer-to-Peer. A network arrangement where computers on the network
access each others disks and printers, rather than those of a dedicated network server.
Peripheral device. A unit of computer hardware such as a printer, modem,
or external hard disk drive. Peripheral devices usually are connected to the
Macintosh with cables.
Personal computer (PC). A generic term used to describe a computer designed for use at home or in a small-business setting. In general, a Macintosh
is not referred to as a PC. The term has come to mean any IBM computer or
IBM-compatible computer.
PhoneNET. A system that allows computers to be networked using standard
phone plugs.
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Phosphor. A chemical material used to coat the inside of cathode ray tubes
(CRTs) on which electrons are targeted to produce images.
Pica. A unit of measure equal to 12 points, or approximately one-sixth of an
inch.
PICT. An object-oriented graphic format used by m any Macintosh graphics
programs.
Pixel (picture element). A single dot or picture element on the Macintosh
display.
Point. A unit of measure used to indicate size of line o r type. An inch
consists of 72 points.
Pointer. An icon, usually arrow-shaped, that reflects the movement of the
mouse.
Pop-up menu. A menu located somewhere other than the menu bar.
Port. A connection socket on the back of the Macintosh that enables the
user to connect a printer cable, hard disk drive, modem, keyboard, or m ouse
to the Macintosh.
Portable Digital Document. A technology in QuickDraw GX that allows
a document to be printed to a fil e in a format that can later be printed on
another computer, whether or not the computer has the software used to
create the document. See also QuickDraw GX.
Portrait mode. A page orientatio n in which the top of the printed image is
along the short side of the paper.
PostScript. A page description programming language written by Adobe,
Inc. to prepare an image for printing on a laser printer. PostScript fon ts are
used with PostScript-compatible printers. These fo nts are widely recognized
as the standard in near-typeset quality printing.
PostScript interpreter. A program built into PostScript-compatible printers that converts PostScript commands into the print image. See also
PostScript.

Power Macintosh. Apples new line of computers that use the PowerPC
processor.
PowerBooks. Apple's line of notebook computers.
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PowerPC. The RISC processor that is found in the Power Macintosh. The
processor was developed jointly by Apple, IBM, and Motorola. See also RISC
and Power Macintosh.
PowerTalk. A feature that allows communications, such as electronic mail,
to take place from within an application.
Printer buffer. Additional memory storage that enables the computer to
send data for printing at a faster rate than the printer can accept.
Printer driver. The software containi ng the instructions that enable the
computer to communicate with the prin ter.
Printer font. A font designed for printing and not just for display.
Printer port. A serial port designed for the connection of a printer or
modem to the computer. See also serial port.
Printer server. On a network, a printer available to all network users.
Printer spooling. The process by which documents to be printed are stored
in a memory outside the computer's RAM, enabling computer processing to
continue while the printer is working.
PrintMonitor. The program that allows printing to take place in the background.
Program. A set of instructions, usually in the form of a programming language, that tells a computer what to do.
Programmer's switch. A switch on the side of many Macintosh computers
that enables you to reboot the computer and access the Macintosh's debugging utility.
Programming language. A language used to write programs for the
Macintosh. Many languages are available, including Object Pascal, C++, BASIC, FORTRAN, and SmallTalk/V. The code, words, and symbols used to send
commands and instructions to the computer.
Proportional spacing. In typesetting or printing, the characteristic in
which wider letters take up more space than narrower letters.
Protocol. In computer telecommunications, the set of commands, rules, and
procedures determining how information travels between computers. See also
handshake.
Public domain software. Software that can be copied without copyright
infringement. See also shareware and freeware.
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Publish and Subscribe. A technology that allows Macintosh programs to
share data.
Pull-down menu. A menu that appears only when accessed by the user. At
all other times, only th e menu titles are visible.
QuickDraw. Part of the Macintosh 's ROM that facilitates th e generati o n of
images for the screen and for some printers.
QuickDraw GX. The next gen eratio n of Apples imaging technology.
QuickDraw GX which makes many fancy font tricks available at the system
level.
QuickTime. Apples animation and d igital video technology.
Radio button. A round button, found in dialog boxes, that you click to
choose a particular option .
RAM. See also random-access memory.

RAM cache. A portio n of the RAM m emo ry that can be designated to hold
data that is used repeatedl y by an application.
RAM disk. A program that sets aside part of the Macintosh 's memo ry and

program s the computer to recognize th is mem ory as a disk drive.
Random-access memory (RAM). The part of the Macintosh 's memory
that allows temporary storage of data. Because RAM is o nly tem porary, any
inform ation left in RAM is lost when the computer is tu rned off.
Readme file. A file often included on applicatio ns that updates th e user as
to any changes made in the accompanying documentation.
Read-only memory (ROM). Th e part of the Macintosh's memory that
permanently stores System informa tion and contains the info rm ation needed
to start up. Also called finnware.
Reboot. The act of restarting the computer.
Record. A set of related fields in a database. A record con tains informa ti on
unique to an individual o r object.
Relational database . A database in which any field or record of one file
can be tied to any other fi eld or record by using a common key field .
Removable media. Typically a cartridge conta ining magnetic media such
as a disk or tape that can be removed from the computer's sto rage device.
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ResEdit. A utility application capable of editing the resources of other applications. ResEdit enables you to customize such applications as the Finder, to
change menu commands, or to modify the appearance of icons.
Resolution. The number of dots per inch (dpi) displayed on a screen or a
printed document. See also dots per inch.
Restart. To reset a computer to its startup state without turning off the
power. The Macintosh has two procedures for restart: a menu command and
the programmer's switch. Also referred to as a warm boot.
Return key. The key, located to the right side of the main keyboard, that
instructs the Macintosh to move the cursor to the next line. Similar to the
Enter key.
RISC. An acronym for Reduced Instruction Set Computer. A microprocessor

that has fewe r instructions tha n a CISC processor. The instructions are simpler and as a result, the processor operates faster than a CISC processor. See
also C/SC.
ROM. See read-only memory.

Root directory. The first level of organization of the top level created when
the disk is formatted.
Run. The act of executing a program or an application.
Sans Serif Font. A kind of typeface without the small cross strokes across
the ends of the main strokes of each character. See also serif font.
Save. A command instructing the Macintosh to store information on disk.
Save As. A command instructing the Macintosh to save the current document using a different name or file format or on a different disk drive.
Scanner. A device used to capture graphics and text for use in Mac applications. See also optical character recognition.
Scrapbook. A desk accessory used to store pictures and text. The Scrapbook,
located in the System Folder, can be accessed in the Apple menu. In contrast
to the Clipboard, the Scrapbook permanently stores information.
Screen dump. A picture of the screen sent to a fi le or to a printer for
printing.
Screen font. A font used for display and for printing on QuickDraw
printers.
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Screen saver. A utility, usually in the form of a desk accessory, FKey, exten·
sion, or control panel, that prevents image "burn in" by automatically filling
the screen with a form of animation during a period of user inactivity.
Script. A series of commands written in the HyperTalk programming language for HyperCard.
Scroll. A method of moving within a document. Using the scroll bars located on the right and bottom of the screen, the user can move forward,
backward, left, and right to see other portions of the document. Scroll arrows,
located in the scroll bars, move the document one line or column at a time in
the direction desired. The user can scroll continuously through a document
by clicking the arrow and holding the mouse button.
SCSI. An acronym for Small Computer Systems Interface. SCSI (pronounced
scuzzy) is a standard interface for connecting hardware peripherals.
SCSI port. A port located on the back of the Macintosh th!l.t enables the user
to connect a SCSI cable from a peripheral device to the Macintosh.
SCSI terminator. A device placed at the end of a chain of SCSI devices that
ensures proper operation of the SCSI interface.
Sector. On a disk, the smallest continuous physical space for saving data.
Multiple sectors define a track. See also track and cylinder.
Security system. A password-protection software utility that enables the
user to protect files or disks from unwanted intruders. Most security utilities
enable the user to set a password and to encrypt files.
Select. An operation used to indicate where the next action should take
place. To select an object, the user double-clicks the icon or word or drags the
mouse across the object.
Serial interface. A form of data transmission in which the bits of each
character are transmitted sequentially one by one over a single channel or
wire. The most common serial interface is the RS-232 cable and connector.
Serial port. A connector on the back of the Macintosh that enables the user
to connect serial devices using a serial interface. See also printer port.
Serif font. A kind of typeface that has small cross strokes across the ends of
the main strokes of each character. See also sans serif font.
Server. On a network, any device or computer that all users can share.
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Shareware. Copyrighted computer programs that users can try on a trial
basis. If you like the software, you are expected to pay a fee to the program's
author. See also public domain software and freeware.
Shutdown. The process of saving all work, closing all folders and files, ejecting all disks, and turning off the power of the computer.
Signal-to-noise ratio (SIN). The ratio of the level of a received electric
signal to the level of the interfering noise.

SIMM. An in-line memory module that plugs into the motherboard or the
logic board.
Size box. A box located in the lower right corner of the active window that
contains two overlapping smaller boxes. Clicking and dragging in the smaller
of the two boxes enables the user to decrease the size of the active window.
Clicking and dragging in the larger box increases the size of the active window.
Slot. A location on an internal board where additional cards can fit.
Small Computer System Interface (SCSI). A standard interface that
enables the user to connect a peripheral device to the Macintosh.
Software. A generic term for computer programs. Software tells the computer hardware how to perform its work. Software can be categorized into
many areas, including systems software, utility software, and applications
software.
Spooler. A printer software utility that enables the user to send multiple
documents to the printer and continue working while the printer receives
each spooled document for printing.
Spooling. Th e act of storing data in a buffer until it is needed.
Spreadsheet. A program using a rectangular grid of rows and columns. The
intersection of a row and a column is a cell. The spreadsheet can manipulate
values, and th e user can specify interrelationships among the values. The
program can calculate results using fo rm ulas and macros. Advan ced spreadsheets integrate graphics, charts, buttons, macros, and functions.
Stack. A HyperCard document or application. A group of related cards. Each
card is a record and each record (card) has a number of fields.
Startup disk. A disk that contains the System files the Macintosh needs
to get started. A startup disk m ust contain the System file and Finder and
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generally contains printer resources and desk accessories. The start-up disk is
the first disk inserted into a floppy disk system. In a hard disk system , the
startup disk is contained on the hard disk and automatically boots when the
power switch is turned on. See also boot.
Startup screen. The open ing screen containing words and graphics that
appears when booting th e Macintosh. Many utilities enable the user to customize the startup screen.
String. A specified sequence of characters (a word, phrase, or number).
Style. A variation of a fo nt that can be displayed in boldface, ital ic, shadow,
outline, underline, and strikethrough styles, to name a few.
Style sheet. A set of predefined format and text commands that can easily
and quickly be inco rporated into a new document.
StyleWriter's. Apple's line of inexpensive in kjet printers.
Suitcase. The icon that represents a set of fonts or desk accessories.
SuperDrive. Apple's high-density flopp y disk drive that can read 400K,
BOOK, and 1.44 megabyte Macintosh disks as well as 720K and 1.44 megabyte
DOS formatted disks.
Surge suppressor. A device that filters th e power going to you r computer
to protect your computer fro m surges and spikes in th e power lines.
SYLK (Symbolic Link). A file format developed by Microsoft for spreadsheets and databases. Used for transferring data between inco mpatible applications.
System 6. A version of the Macintos h operating system that can run on
older Macintos h systems with limited memory and older processors. Many of
the features of System 7 are not ava ilable to computers using System 6.
System 7. Apple's latest version of the Macintosh operating system.
System file. A file that contains information th e Maci ntosh uses to operate
and start u p. System files cannot be opened in the usual m anner but can be
modified. The Macintosh cannot operate without a System file.
System Folder. The folder that contains the importan t System and Finder
files necessa ry to boot up and run the Macintosh.
System heap. The area of memory set aside for storing system information
about fi les and resources.
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System software. The files, extensions, control panels, utilities, desk accessories, fonts, and resources located in the System Folder as provided by Apple.
This software is all the Macintosh needs to run properly. See also operating

systern.
System Tools disk. Software disks packaged with the Macintosh that provide the user with va rious 'tools to facilitate using the Macintosh.
Tab-delimited file. A data file in which tabs separate individual records or
data elements. See also delimiter.
TCP/IP. An acronym fo r Transmissio n Control Protocol I Internet Protoco l.
A standard for communications between networked computers. See also

MacTCP.
Tear-off menu. A feature of some Macintosh applications that en ables the
user to pull down a m enu and to keep the menu visible while working. The
menu also can be moved to a mo re convenient location within the active
window.
Telecommunications. Sh aring information over phone lines through the
use of a modem and telecommunicatio ns.
Template. A document created for repeated use. By using the Save As command, the user can save each use of the template with a uniq ue name and
still maintai n the original template for future use.
Terminal emulation. To m ake a computer act like a terminal for use with
a modem and host com puter such as a mai nframe. Terminal em ulation softwa re enables the user to customize the Macintosh to recognize and use the
contro l codes required to access the host's data.
Text file. A computer file that contai ns sequences of bits that represent
characters. Also known as an ASCII fi le. See also ASCII.
TIFF (Tagged Image File Format). A scanned image-saving format. See
also optical character recognition.
Title bar. The multilined bar at the top of the active window tha t displays
the title of the document or window.
Token-ring network. A network in which information is passed from one
node through another in a ring-like shape.
Toner. A black powder used in laser prin ters and photocopiers that serves as
ink in the printing of characters and images. See also Laser printer.
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Tool Box. A collection of drawing and painting tools found in many applications such as HyperCard, MacDraw, and MacPaint.
Track. A location on magnetic media that stores data. Tracks are concentric
circles on the surface of a disk made up of sectors. One or more tracks make
up a cylinder of disk space. See also cylinder and sector.
Trackball. A pointing device that essentially is an inverted mouse, in which
the ball is located o n to p of the device. The user moves th e ball rather than
the device, which remains stationary. A pointed arrow on-screen reflects the
ball's movement just as though a mouse is being used. See also 11101/Se.
Tractor-feed printer. A printer that advances paper through the use of
pins that fit into pre-formed holes on th e edges of the computer paper.
Trash can. A sto rage location on the Desktop used to discard documents,
folders, and applications.
Typeface. The basic font family design, such as Times or Monaco. See also
font.
Type size. The height in points of the characters in a font. See also fo nt.
UNIX. An operating system developed by Bell Laboratories for minicomputers. UNIX, rega rded as a powerful, general-purpose operating system, enables
several programs to run simultaneously. It can easily be transferred from one
computer type to another.

Upload. A procedure in which a user transfers information from his or her
computer to a remo te computer.
Usenet. Newsgroups o n the Internet that serve as forums for the d iscussion
of thousands of topics.
User group. A group of people who have an in terest in a particular computer or a particular type of application such as desktop publishing.
Utilities disk. A disk packaged with the Macintosh that contains utilities
used to maintain your computer system. Examples of utility programs contained on this disk are the Font/DA Mover and the Installer.
Video card. A circuit board containing the video controller and related
components that connects into a computer to control the video display. See
also video controller circuit.
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Video controller circuit. A circuit that modifies digital information to
create the signal necessary for display on a computer screen. See also cathoderay tube (CRT).
Video RAM. A section of RAM devoted to screen information. In the
Macintosh, the video RAM stores a bit-mapped image of the screen display.
See also random-a ccess memory (RAM).
Virtual memory. The use of the available space on a hard disk to increase
the RAM available for application use.
Virus. A series of computer program lines designed to alter the normal functioning of a computer by destroying data, corrupting system files, locking
users out of the computer, or flashing messages on-screen at predetermined
times. In many cases, the user may be unaware that a virus exists in the system until it is too late to protect the existing data. A virus is generally passed
from disk to disk and from computer to computer through disk sharing or
telecommunication file transfers.
Virus-protection software. A utility software program designed to check
existing files and applications for the presence of a virus. Some protection
software identifies the strain of virus and tries to eradicate it. Other software
just informs the user that a virus exists.
Visual interface. The system of representing files, folders, and commands
in symbols, such as icons, that easily can be recognized.
Volatile memory. Memory that loses its contents when the power is
removed.
WAIS. An acronym for Wide Area Information Service. WAlS is an Internet
search mechanism that helps you locate text documents on Internet that are
indexed for WAIS.
Warm boot. The act of selecting the Restart command on the Special menu
so that the computer boots witho ut turning the power off and o n .
Window. The area on the Desktop that displays information. To view a
document, the user uses a window. Windows can be opened or closed, moved
around on the Desktop, resized, and scrolled through.
Word processor. An application that enables the user to enter characters to
create documents, including letters, newsletters, and graphics. Examples include MacWrite II, Microsoft Word, and WordPerfect. Word processors are
becoming mo re advanced with features such as macro support, page layout
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capabilities, file import/export, mail-merge features, footnoting, and spellchecking features.

Word wrap. In word processing, a text-entry feature in which typed text
automatically adva nces to the n ext line at the end of a line.
Wristwatch cursor. Appears on-screen when the Macintosh is busy perfo rming some activity. During the time that the wristwatch is on the screen,
the user can not access additional commands. The wristwatch's hands turn,
indicating that the Macintosh is working.
Write-protect tab. A small tab or box built into a 3.5-inch disk casing to
prevent accidental erasure or overwriting of disk contents. See also copy pro-

tection.
WYSIWYG. An acronym for What You See Is What You Get. (Pronounced
wizzy-wig.) The term refers to a program that shows documents on the screen
the way they will look when printed. Typical Macintosh programs are
WYSIWYG programs.

Zone. An AppleTalk network in a series of interconnected networks joined by
bridges.
Zoom box. A box located on the right side of the title bar that the user clicks
to expand the active window to its maximum size. By clicking the zoom box
again, the user can return the window to its previous size.
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1-2-3, 492-508
3-D spreadsheets, 506-508
databases, 504-505
drawing, 503
formatting
numbers, 499
text, 499-501
formulas, 496
graphing data, 501-503
macros, 506
system requirements, 492
worksheets, 493-498
clearing, 495-496
copying, 495-496
cutting, 495-496
drag and drop, 496
editing, 495, 497
entering data, 493-494
fills, 494-495
formul as, 496
functions, 496-497
pasting, 495-496
series, 494-495
Status window, 498
3-D spreadsheets, 506-508
3.5 floppy disk drives,
15-27
The 7th Guest (game),
788-790
8-bit color (Photoshop),
650-651
24-bit color (Photoshop),
650-651
32-bit addressing, 1137
601 chip (PowerPCs), 38

A/UX (UNIX), 1137
accelerator board, 113 7
access privileges
networks, 959-960
denying, 961-963
disks, 950-95 1
fi les, 948-950
fo lders, 965-966
other computers, 951-956
remote, 840-841, 960-96 I
shared d isks, 952-953
accessing Internet
(Netcom), 913-923
accounting software,
744-747
acoustic modem, 1137
ACT! (Contact Manager
software), 754
active window, 1137
Actors (Astound), 440-441
adapters (MIDI), 312-313
ADB (AJJple Desktop Bus),
1137
adding sounds, 282-283
Address Book
eWorld, 905
shareware, 8 12
addresses
America Online, 852-853
Internet, 913-914
Adobe Illustrator, 608-619
Bezier pen tool, 610
Character palette, 6 15-616
colors, 611 -613
drawing tools, 608-61 0

filters, 6 16-6 17
graphs, 617
objects
filling, 611-613
stroking, 611 -613
paths
filling, 6 11 -613
stroking, 6 11-613
scanned images, 610
text
adding, 61-l-616
graphic objects, 6 15-6 16
transformation tools, 616
Adobe Systems (PostScript
fonts), 148-149
Adobe Type Manager
(fonts), 152, 157-158
After Dark (screen saver),
262-264, 728-729
AIFF (sound file format),
285
alarm dock, 1137
Aldus Additions
(PageMaker), 570
Aldus PageMaker
(software), 16-17
a lert boxes, 1137
alias files (Finder), 129-133
creating, 13 1
sto ring, 131-1 33
aliases, 953-954, 1137
Ali gn dialog box, 422
aligning objects
(DeltaGraph Pro), 3, 422
Alpha Channels
(Photoshop), 665-666
America Online, 850-857
Computing & Software, 862
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America Online

Consu111er Reports magazine,
861
e-mail, 866-867
entertainment, 859-860
help, 866
installing, 850-853
Internet, 921-924
Learning & Reference,
865-867
Lifestyles & Interests,
864-865
ma iling address. 852-853
modems, 852
News & Finance, 858-859
Newsstand, 864
People Connection, 863
Power books, 1006- 1008
Rotunda, 862
shortcuts, 867-868
Stock Market Quotes, 859
Ti111e magazine, 858
Travel & Shopping, 860-86 1
Zen and tl1e Art of lite lntemet
(book), 922
Apple
lm ageWriter, 209-210
interfaces, 42-4-1
LaserWriter Utility, 214-218
library (eWorld), 895
Qu ickDraw, 208
QuickDraw GX, 205-206
QuickTime, 11 59
warranty, 1058
A1Jple File Exchange,
978-980
Apple Guide (System 7.5),
56-57
Apple HD SC Setup, 1138
Apple menu, 1138
Control Panel, 256
System 7.5, 133
Apple menu commands
Chooser, 225, 943
Control Panels, 98, 714-715,
944
Find File, 13-1
Mr. File, 722-723
Recent Document~ . 137
Scrapbook, 175
Suitcase, 712
Apple Remote Access
(software), 840
AIJpleScript, 113M
applications, 347
editing, 350
Finder, 354-356

formalli ng, 350-352
language, 348
recording, 347-354
System 7.5, 57, 139-141
writing, 3S2-3S3
AppleScript Formatting
command (Edit menu),
350
AppleShare, 1138
AppleTalk, 1138
AppleTalk (network), 18,
943-944, 1138
Application menu
commands, 96, 1138
application templates, 1138
applications, 1138
Assembler, 11 38
backups, I I 16-111 7
CD-ROM, 707
compiler, 11 42
deleting, 1108
hard drive repa irs,
111 9-1121
insta ller, li S I
launching, 1152
missing, 1068-1069
networks, linking, 966-968
openi ng, 137-138
recordable, 347
running, 1160
scriptable, 34 7
transferring data, 170-183
translating files, 982-983
troubleshooting, 1062-1064,
1068-1069
AppliWindows (freeware),
797
Arrange menu commands,
625
Archie (Internet), 925-927
architecture (open), 1155
archiving data, 1043-1044
ARPANET (Advanced
Research Projects
Agency), 912
Arrange menu commands,
436
Arrow keys, 1138
Arts and Leisure Pavilion
(eWorld), 897-898
ASCII (American Standard
Code for Information
Interchange), 987-989,
1138
Assembler, 1138

A.'itound, 436-450
interactions, 443-444
Outline View, 446-447
Slide Sorter View, 447
slides, 437-443
Actors, 440-44 I
adding graphics, 438
adding text, 438
charts, 439-440
cl ip art, 440
color gradien t tool, 442
custom izi ng, 437-438
fill patterns, 443
libraries, 443
QuickTime movies, 441
sound, 442
spell checker, 447-448
system requirements, 437
Timeline, 445-446
transitions, 444-445
asynchronous
communication
(modems), 1138
At Ease 2.0 (Performa),
100-107
assigning programs, 103-104
menus, 107
password, 102
saving, 104-105
shutting down, 105- 106
sounds, lOS
sta rting, 101-102
switching programs, 107
users, 102-10S
ATM (Adobe Type
Manager), 713-715, 1137
ATM GX (Adobe Type
Manager GX), 1137
Attach Sounds (File menu),
105
attaching files (e-mail)
America Online, 867
eWorld, 905-910
Attention key setting
(speech recognition),
329-330
audio
At Ease 2.0 (Performa), 105
notes, 281
PlainTalk, 321-322
Powerbooks, 1014
speech recognition, 322-332
1TS (text-to-speech),
333-334
see also sound

CD-Audio
Audition, 670-684
Premiere, 671, 678-680
QuickTime, 681-684
system requi rements, 670
auto answer (modems),
1138
Autocall (modems), 1139
AutoCorrect (Word 6.0),
374
AutoDoubler (compression
utilities), 727-728
Autofill (Excel), 464-465
AutoFormat
Excel, 483-493
Word 6.0, 37 1
AutoFormat command
(Format menu), 371, 483
AutoFormat dialog box,
483
Automatic Courier
command (e-mail menu),
909
Automatic Trapping
(QuarkXPress), 592-594
automatically connecting
to networks, 954-956
Autotrace, 1139

B
backbone (networks),
972-975
background execution,
1139
see also multitasking
background printing, 204
backups
applications, 1116-1117
Drag.n Back (shareware),
817-818
files, 1108
home office, 1041-1042
incremental, 1150
Performa, 96-98
System Folder, 97
types, 111 5- 111 6
utilities, 111 5- 1117
Balloon Help, 1139
Finder, 81-8S
menu commands, 342
System 7.1, 82
baseline (fonts), 1139
BASIC (Beginner's
All-Purpose Symbolic
Instruction Code), 1139

batteries (Powerbooks),
1001
baud rate (modems),
835-848, 1139
BBS (Bulletin Board
System), 841-846, 1140
files
downloading, 842-848
transfer protocols,
843-844
uploading, 842-848
hosting, 846-847
log off, 844-846
Beatnik (shareware), 808
beta test (bugs), 1139
Bezier curves, 1139
Bez ier pen tool, 610
binary numbers, 1139
Bind to Path command
(Type menu), 623
bit-mapped fonts, 147-148,
1139
bit-mapped images, 1139
bits (binary digit), 1139,
1156
Black American History:
Slavery to Civil Rights
(educational software),
775-778
Blend command (Object
menu), 449
Bold command (Style
menu), 349
bombing, 1140
booting, 1140
cold, 1142
wa rm, 1166
borders (cells), 480-481
bps (bits per second), 825,
1140
bridges (networks),
973-975, 1140
Browse command
(Messages menu), 878
Browse mode (FoxPro Mac),
527-539
BrushStrokes, 635-641
drawing tools, 635-638
imported graphics, 639
plug-in modules, 639-640
tea r-off menus, 635-638
text, 638-639
views, 638-641
buffers (memory), 1140
bugs, 1140
beta test, 1139
DeltaGraph Pro 3, 424-42S
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bullctcd lists
(WordPerfect), 395
Bullets a nd Numbering
command (Format menu),
3 79
Bullets and Numbering
dialog box, 379
bundled software, 1140
buses, 1140
business
freeware, 812-816
shareware, 812-816
software, 696-697, 743-747
Business & Finance Plaza
(eWorld), 900
Busytown (children's
software), 769-771
Button Bar (WordPerfect),
391
buttons, 1140, 1159
bytes, 1140

c
cables, 981, 1000-1001
CAD (computer-aided
des ign), 1142
caddies (CD-ROM drives),
695
calculated fields (FileMakcr
Pro), 515
calculator, 1140
calendars, 1040
cancel button, 1141
Canvas, 626-635
colors, 63 1-633
drawi ng tools, 626-630
tear-off menus, 630
text, 633-634
views, 631
canvas (Photoshop), 657
Canvas size command
(Image menu), 657
caps lock key, 1141
Capture (graphics utilities),
725-726
cards (option), 1155
carrier detect (modems),
1141
ca ses (Powerbooks), 1000,
1027
cathode-ray tubes (CRT),
1141, 1157
CD-Audio, 689
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CD-ROM

CD- ROM (Compa ct
Disc-Read-Only Memory),
114 1
applications, 707
care, 709-710
drives, 688-689, 693, 103 1
caddies, 695
cleaning, 1114
speeds, 694-695
towers, 694-695
graphics, 705-706
handling, 709
hardware, 693
hardware speed, 691 -692
in teractive, 689
IS0-9660/High Sierra, 689
Macintosh, 692
multimedia, 691-692
operating systems, 690-693
shareware, 706
software, 695-707
busi ness, 696-697
educational, 699-701
exercise, 705
games, 703-704
health, 704-705
movies, 701-702
music, 704
Reference, 69 7-699
sports, 705
System 7.5, 66
system requiremen ts,
692-695
video, 690-693
CD-ROM XA, 690
CDEV (control panel
DEVice), 1141
COs (compact discs)
digital audio, 3 11 -3 20
WORM (Write Once Read
Many), 285-286
cells
borders, 480-481
formatting, 480-48 1
patterns, 480-481
Cells comm and (Format
menu), 479
cellular t eleph ones, 1012
Center Page command
(Layout men u ), 381-400
Ch a n n el Messages (M ID I),
291-29 2
Ch a r a cter Designer
(FrameMaker), 577
Ch aracter palette (Adobe
Illu strator), 61 5-616

charts
Astound, slides, 439-440
ClarisWorks, 546
DeltaG ra ph Pro 3, 41 5-41 9
custom izing, 418-419
presen tations, 419-422
Excel, 483-485
Microsoft Works, 556
Persuasion, slides, 453-454
PowerPoint, 430-432
CheckMark P a yroll
(accounting software),
745
child proofing home office,
1046-1047
children's soft w a re,
759-760
Busytown, 769-77 1
Four Footed Friends, 768
just Grandma and Me,
761-764
KidPix, 767-770
Putt-Putt Goes to the Moo n,
764-767
chips, 1141
CISC (Complex Instruction
Set Com puters), 30
DSP (Digital Signal
Processor), 322
microprocessors, 11 53
Pentiu m, 30-31
PowerPCs, 38
RISC (Reduced Instruction
Set Computers), 30-31
Choose Object•; command
(Insert menu), 378
Chooser, 1141
Chooser command (Apple
menu), 225, 943
Chooser dialog box, 225
CISC (Complex Instruction
Set Computer), 30-31,
1141
ClarisWorks, 542-549
charts, 546
communications, 548
databases, 546-548
documen ts, 543-546
spreadsheets, 546
system requirements, 542
ClarisWorks command
(Sets menu), 344
Clean Up comma nd (Special
menu), 127
clea ning
CD-ROM drives, 11 14
floppy drives, 1113

keyboard, 11 11 - 111 4
logic board, 1114
monitors, 111 3
mouse, 111 2
system softwa re, 1091
cleaning up f iles (Finde r),
127-128
Clear command (Ed i t
menu), 270, 4 69
clea ring worksheets (1-2-3),
495-496
ClickChange (software),
265-266
clicking mouse, 77-86, 1141
clip a rt, 1141
Astound, slides, 440
icons, 268-269
Persuasion, slides, 454
Clip menu commands, 6 74
Clipboard, 1 71-175, 1142
copying icons, 269-270
formatting, 172-174
moov format, 172
Nisus Wri ter, 383-384
pasting, 1156
PICT fo rmat, 172
RTF (Rich-Text Format),
173-1 74
snd format, 172
styl format, 172
TEXT format, 172
clock, 717, 1137
clock speed, 1142
clone printers, 211-212
Cloning (Painter), 645
Close box (Finder), 76, 1142
close command, 1142
Close Window command
(File menu), 324
closing windows, 1130
CMYK (cyan, magenta,
yellow, black), 1142
cold booting, 114 2
Color Info Mana ger dialog
box es, 632
Color Model menu
commands, 425
color sep a ra tions, 1142
PageMaker, 570
QuarkX Press, 592-594
Color Set m enu commands,
425
Color System command
(Show menu), 458
colors
8-bit color (Photoshop),
650-651

commands
24-bit color (Photoshop),
650-651
Adobe Illustrator, 6 11-613
Astound gradien t tool, 442
Canvas, 631 -633
CMYK (cyan, magenta,
yellow, black), 1142
Control Panel, 247-248
desktop publishing, 17-18
FreeHand, 622-623
Greg's Buttons, 258-260
Pan tone Matching System,
1156
Persuasion (palette tools),
452-453
Photoshop, 664
prin ting (QuickGraw GX),
231
Colors command (Edit
menu), 425
Colors dialog box, 248, 425
Column Width command
(format menu), 474
Column Width command
(Worksheet menu), 497
columns
PageMaker, 568
Word 6.0, 373
commands, 1142
Apple me nu
Chooser, 225, 943
Control Panels, 98,
714-715, 944
Find File, 134
Mr. File, 722-723
Recent Documen ts, 137
Scrapbook, 175
Suitcase, 712
Application menu, 96
Arrange menu
Group, 436
Simplify, 625
Balloon Help menu, 342
Clip menu, 674
Color Model menu, 425
Color Set menu, 425
Data menu, 485
Connect to External, 505
Distribution, 505
Fill, 494
New Form, 504
Regression, SOS
Sort, 486
Subtotal, 487
Database menu, 526
Defin e menu, 344
Dictionary menu, 394

d immed, 1144
Docume nt menu, 603
Edit menu, S1-52
AppleScript Formatti ng,
350
Clear, 270, 469
Colors, 425
Copy, 48, 171, 268, 494,
1143
Create Publisher, 190
Cut, 48, 1 71
Delete, 473
Down, 494
Duplicate Again, 435
Fil l, 465
Insert Cells, 473
Ma nagers, 632
Move Cells, 495
New Layout, 516
Paste, 48, 171, 269
Paste Special, 174
Publishe r Options, 191
Quick Copy, 495
Replace, 379
Right and Copy, 494
Show Clipboard, 384
Subscribe, 193
Text format, 457
Thesaurus, 577
e-mail menu, 909
Exit menu 919
Export me n u, 657
File menu, 51-52
Attach Sounds, lOS
Close Window, 324
Document Layout, 372
Find, 89, 134
Generate/Book, 583
Get In fo, 120, 125, 268,
11 48
Import, 672
Import File, 578
Libraries, 426
Locali ty, 908
Make Alias, 131, 330, 954
New, 94, 563
New Folder, 115
New Paragraph Style, 363
Open, 70,91
Open Custom Styles, 364
Open Dictionary, 348
Open Enclosing Folder,
136
Preferences, 563
Print, 203
Print One, 558
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Put Away, 121
Qu it, 101
Revert, 652
Save As, 92
Sharing, 947
Speak All, 333
Speak Selection, 334
Spelling Checker, 578
Stop Speaking, 334
Undo, 374
Voices, 333
File Sha ring, 325
Format menu
AutoFormat, 3 71, 483
Bullets and Numbering,
379
Cells, 479
Column Width, 474
Documen t, 36 1
Drop Caps, 376
Font, 3 73
Insert Header, 387
Insert Page Number, 388
Paragra ph, 575
Row Height, 47-l
Style, 379, 482
Frame men u, 365
Function menu, 496
Go To menu, 867
Graph ics menu
Scale Graph ic to Block,
602
Set Wrap Border, 388
Help menu, 82
Image menu, 657
Insert menu, 378
Label menu, 128, 250
Layout menu
Cen ter Page, 381-400
Display Master Items, 568
Set Margins, 381
Macro menu, 331-334
Membersh ip menu, 909
menus, selecting, 46-47
Messages menu, 878
mouse, selecting, 79-81
Object menu
Eflend, 449
Convert to bitmap, 449
Whiter, 449
Options menu, 426
Page menu, 59 1
Places menu, 906
Preferences menu, 549
Project menu, 677
Scripts menu, 522
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comma nds

Search menu, 135
selecting, 79-81
Selection menu, 665
Sessions menu, 883
Sets menu, 344
Show menu
Color System, 458
Guides, 458
Special menu
Clean Up, 127
Conditional Text, 584
Empty Trash, 120
Go To At Ease Setup, 102
Restart, 102, 276
Shut Down, 1109
User Greeting, 102
speech recognition, 324-326
Style menu
Bold, 349
Shade,595
Table menu
Insert Table, 580
New, 393
Table Designer, 581
Text menu, 602
Tools menu
Options, 467
Text Box, 393
Transform menu, 275-276
Translation menu, 990
Type menu
Bind to Path, 623
Create Outlines, 615
Flow Inside Path, 623
View menu
Hide Document Layout,
590
Hide Template, 610
Show, 611
Show Document Layout,
590
Slide Master, 458
Toolbars, 477
Vertical, 89
voice, ignoring commands,
329-330
Window menu, 506
Worksheet menu, 497-498,
507
commercial software, 1142
communications
ClarisWorks, 548
duplex, 1146
Microsoft Works, 557-558
software (Powerbooks),
1002-1004
WordPerfect Works, 553-554

Community Center
(eWorld), 903-904
compatibility
Easy Open (System 7.5),
61-62
PC Exchange (System 7.5),
61-62
compiler (application),
1142
compression
drives, 1044-1045
files, 726-727
lossy, 681
QuickTime movies, 681-682
utilities
AutoDoubler, 727-728
Disk Doubler, 727
Times Two, 728
CompuServe, 869
departments, 870-871
entertainment, 873
financial information, 872
Information Manager
connection settings, 876
installing, 874-876
navigating, 876-880
interface, 869-870
joining, 869-874
library, 872
Macintosh forums, 871
messages, 873-874
Navigator
installing, 880
running sessions,
883-884
Session Files, 880-883
news, 873
Powerbooks, 1009
shopping, 872
shortcuts, 884-885
software, 869-874
Information Manager,
869
Navigator, 869
travel, 872-873
computer care, 1016-1027
dust, 1019-1020
power surges, 1020
restarting, 11 31
static electricity, 1021
theft, 1022
Uninterruptable Power
Supply (UPS), 1021
Computer Center (eWorld),
894
Computing & Softwa.r e
(America Online), 862

condensed type (fonts),
1142
Conditional Text command
(Special menu), 584
configuring modems,
836-837
Connect to External
command (Data menu),
505
connecting
MIDI (Musical Instru ment
Digital Interface), 289-290
networks, 943-946
aliases, 953-954
automatically, 954-956
larger networks, 972-975
printers, 970-972
settings (CompuServe
Information Manager), 876
Consumer Reports
magazine (America
Online), 861
Contact Managers
software, 754
context-sensitive help
(balloon), 1139
continuous tone image,
1142
Control key, 1143
Control Palette
(PageMaker), 566-567
Control Panels, 243-256,
1143
Apple menu options, 256
colors, 247-248
Date and Time, 251-255
desktop patterns, 246-247
folder, 1143
General Controls, 245-246
Labels, 250-251
numbers, 255-256
Performa, 99-100
shareware, 799-802
Desktop Textures,
260-262
Greg's Buttons, 257-260
Speech Setup, 322-323
Views, 248-250
Control Panels command
(Apple menu), 98, 714-715,
944
Convert to bitmap
command (Object menu),
449
cooperative multitasking,
63

DeltaGraph Pro 3
Copy command (Edit
menu), 48, 171, 268,
494, 1143
copy protection, 297-298,
1143
copying, 47-48
1-2-3 worksheets, 495-496
Excel worksheets, 467-469
icons, 267-270
cords (Powerbooks), 1001
CPUs (Central Processing
Units), 1141
Power Macs, 31-33
RISC (Reduced Instruction
Set Computers), 30
crashes, 1051-1053
Create New Macro
command (Macro menu),
331
Create Outlines command
(Type menu), 615
Create Publisher command
(Edit menu), 190
cross-references
(FrameMaker), 583
current startup disks, 1143
cursor, 1143, 1167
Cu stom Colors command
(Color Set menu), 425
Customize dialog box, 489
customizing
Date and Time Contol Panel,
252-253
DeltaGraph Pro 3
charts, 418-419
slides, 420-42 1
Excel, 489-490
fills (Excel), 467
slides
Astound, 437-438
Persuasion, 45 1-452
PowerPoint, 428, 434
sounds, 281 -285
tools (Impact), 406-407
voice commands, 330-332
Cut command (Edit menu),
48, 171, 1143
cutting
1-2-3 worksheets, 495-496
Excel worksheets, 467-469
cylinder (disks), 1143
CYMK command (Colors
menu), 425

D
daisy chains (MIDI), 290
damaged
files, recovering, 1076-1077
noppy disks, 1082-1083
DART (Data Archive/
Retrieval Tool), 723-724
data, 1143
embedd ing, 199-202
entering
1-2-3 worksheets,
493-494
Excel worksheets,
463-464
Excel
editing worksheets, 467
filtering, 486-487
sorting, 486-48 7
subtotaling, 486-487
linking, 198-199
transferring, 170-183
Clipboard, 171-175
formats, 18 1-183
Jive, 183-184
Publish and Subscribe,
184-198
Scrapbook, 175-183
data bits (modems), 836
Data bytes (MIDI), 290
data fork, 1143
data fork (files), 270-271
Data Format command
(Preferences menu), 549
Data menu commands, 485
Connect to External, 505
Distribution, 505
Fill, 494
New Form, 504
Regression, 505
Sort, 486
Subtotal, 487
data pump (modems), 826
data speed (modems),
825-826
Database menu commands,
526
databases, 511-513, 1143
1-2-3, 504-505
ClarisWorks, 546-548
down loading, 11 45
Excel, 485-486
~i lema ker Pro, 513-525
layouts, 515-5 18
scripts, 522-523
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security, 523
setup, 513-5 15
sorting, 520-521
system requ irements, 513
nat-file, 5 12-513
FoxPro Mac, 525-539
reports, 534-535
RQBE (relational query by
example), 532-533
hierarchical, 1149
lookup fields, 1152
Microsoft Works, 556
records, 115 9
relational, 512-5 13, 1159
WordPerfect Works, 553
date (troubleshooting),
1 071
Date and Time Control
Panel, 251
customizing, 252-253
menubar clock, 254-255
time zones, 254
DateBook Pro (PIM
software), 753
dedicated server networks,
938-940
defaults, 1143
Define Button command
(Scripts menu), 522
Define Fields dialog box,
513
Define menu commands,
344
Define Script dialog box,
522
defragmenting hard drives,
1143
Delete command (Edit
menu),473
Delete command
(Worksheet menu), 497
Delete key, 1144
deleting
applications, 11 08
documents, 1108
files, 119-121
folders, 119-121
programs (Launcher), 89-90
recovering, 1078
delimiter, 1144
DeltaGraph Pro 3, 415-42 7
aligning objects, 422
bugs, 424-425
charts, 4 15-41 7
customizing, 418-419
presentations, 419-422

1176

DeltaGraph Pro 3

layering objects, 422
Layout Sets, 419-422
presentations, 424
slides
customizing, 420-421
Outline View, 422-423
Sorter View, 423-424
system requirements, 41 5
text tools, 421-422
denying a ccess privileges
(networks), 961-963
DepthMaster (shareware),
800
desk accessories, 1144
desktop, 1144
files, moving, 121-122
finder, 114
General Con trols, 245
mouse, 77-81
patterns, 61, 246-247
shareware, 256-262
software, 262-266
video
Audition, 670-684
Photoshop, 649-669
Desktop files, 1141
Finder icons, 276
rebuilding, 276
TechTool (utility), 717-718
Desktop Patterns (System
7.5), 61
desktop publishing, 15-18,
562, 1144
Aldus PageMaker, 16-17,
562-571
color, 17-18
frameMaker, 5 71-583
Mac II, 17
QuarkXPress, 16-17, 585-588
Rcady,Set,Go, 595-603
SCSI, 18
WYSIWYG (What-You-SeeIs-What-You-Get), 15
Desktop Textures
graphics utilities, 726
sharewares, 260-262
device independent,
148-149
Devora (shareware), 808
diagnostics software,
1123-1124
dialog boxes, 1144
Align,422
Autoforma t, 483
Bullets and Numbering, 379
cancel button, 1141

Chooser, 225
Color, 248
Color In fo Manager, 632
Colors, 425
Customize, 489
Define Fields, 513
Defi ne Scripts, 522
Dialog, 466
Dimensions, 518
Directory, 1131
Document Layout, 372
Download fon ts, 214
Drop Caps, 377
Edit Quick Copy, 494
Entry Options, 514
Find, 135
Font, 374
Format Cells, 480
Function Wizard, 473
General Controls, 245
Go To Special, 470
Insert Table, 365
Macro Transcript, 506
Menu, 535
Modify Frames, 369
New Field, 5 17
Object Order, 53 1
Object Transition, 449
Open, 92, 163
Pa int Style, 611
Parts Definit ion , 516
Preferences, 426
Print, 23 1
Printing, 218-222
Project, 536
Project Output Options, 678
Revision Marks, 376
RGB Color, 631
Save As, 92
Screen Code, 528
Screen Layout, 528
Script Definition, 522
Set Margins and Columns,
381
Sharing, 94 7
Sort Order, 521
Sort records, 520
Subscriber Options, 193
Subtotal, 48 7
Table structure, 525
ToolPicker, 633
Transition Effect, 424
Type Specifications, 633
Dictionary menu, 394
differential backups,
1115-1116

digital audio, 311-320
digital phone switch
(modems), 1001
digital recorders, 280
digital video
Audition, 670-684
Photoshop, 649-669
digitizer pad, 1144
Dimensions dialog box, 518
dimmed commands, 1144
dimmed icons, 1144
direct-conect modem, 1144
directories, root, 1160
Directory Dialog Boxes,
1131
Directory window, 1145
Disinfectant (freeware),
731, 816
Disk Doubler (compression
utilities), 727
Disk First Aid (utility), 722
Disk icon, 75
disk servers, 1145
DiskDup+ (shareware),
816-817
disks, 1145
CO-ROMs, 688-689
curren t startup, 1143
cylinder, 1143
DART (Data Archive/
Retrieval Tool), 723-724
DiskDup+ (shareware),
8 16-8 17
drives, 1145
fi les, transferring, 978
floppy, 1147
initializing, 11 50
networks
access privileges, 950-95 1
shared, 952-953
Norton Utilities, 720-72 1
opticals, 11 55
repair utilities, 722
sectors, 1161
storage boxes, 1026-1027
System Tools, 1164
tracks, 11 65
troubleshooting, 1065-1066
utilities, 1165
Display Master command
(Page menu), 591
Display Master Items
command (Layout menu),
568
Distribution command
(Data menu), 505

editing
Document command
(Format menu), 361
Document Folder (System
7 .5), 59
Document icon, 75
Document Layout
command (File menu),
372
Doc ument Layout dialog
box,372
Document Layout Palette
(QuarkX.Press), 590-591
Document menu
commands, 603
documents, 1145
audio notes, 281
Cla risWorks, 543-546
deleting, 1108
Fi nder, opening, 68-72
FrameMaker, 572-573
hypertext, 1150
Impact
presen tation, 412
report, 410-411
MacWrite Pro, 360-362
Microsoft Works, 556
networks, linking, 966-968
Nisus Writer, 381
opening, 137-138
Perfo rma, 9 1-94
creating, 94
opening, 91-92
saving, 92-94
System 7.5 (defaul t folder),
11 8
Word 6.0, 372-373
Word Perfect, 389-390
WordPerfect Works, 55 1
DOS (Disk Operating
System), 1145
dot-matrix printers, 209,
1145, 1150
double-clicking mouse,
114 5
Down command (Edit
menu), 494
Download Fonts dialog
box , 214
downloading
files (BBS), 842-848
fon ts, 214-218, 1145
dpi (dots per inch),
212-213, 1145
dra g a nd drop, 1146
1-2-3 worksheets, 496
Excel worksheets, 469
Notes (System, 7.5), 59

Scrapbook (Syste m 7.5), 59
System 7.5, 57
Drag.n Back (shareware),
817-818
dragging mouse, 77-86,
1146
drawing (I-2-3), 503
Drawing Preferences
command (Options
menu), 426
drawing programs
Adobe Illustrator, 608-6 19
BrushStrokes, 635-641
Canvas, 626-635
FreeHand, 619-625
QuickDraw GX, 1159
drawing tools
Adobe Illustrator, 608-610
BrushStrokes, 635-638
Canvas, 626-630
Excel, 488-489
FreeHand, 620-623
Painter, 641-644
Word 6.0, 376
WordPerfect, 391
drivers, 1146
Level 2 PostScript, 224-227
printers, 1158
drives
3.5 floppy disk, 15
4 gigabytes, 62-66
archiving data, 1043-1044
CD-ROM, 688, 693, 1031
caddies, 695
speeds, 694-695
towers, 694-695
cleaning
CD-ROM, 1114
floppy, 1113
compressing, 1044-1045
fon t storage, 213
hard disk, 1149
high-density, 978
Powerbooks, 1000
Drop Cap dialog box, 377
drop caps (Word 6.0),
376-377
Drop Caps command
(Format menu), 376
DSP chip (Digital Signal
Processor), 322
Duos (utility), 999
duplex communica tions,
1146
Duplicate Again command
(Edit menu), 435
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Duration command (Clip
menu), 674
dust (computer care),
1019-1020, 1106
Dvorak (keyboard),
1023-1025

E
e-mail, 1146
America Online, 866-867
eWorld, 892-893, 904-910
Internet, 913-914
MCI Mail, 1011
Powerbooks, 1006-1011
PowerTalk (System 7.5), 62
e-mail menu commands,
909
Easy Open (System 7.5),
61-62
Eclipse (sharew a r e), 800
Edit menu commands,
51-52, 1146
AppleScri pt Formatting, 350
Clear, 270, 469
Colors, 425
Copy, 48, 171, 268, 494,
11 43
Create Publisher, 190
Cut, 48, 171
Delete, 473
Down, 494
Duplicate Again, 435
Fill, 465
Insert Cells, 473
Managers, 632
Move Cells, 495
New Layout, 516
Paste, 48, 171, 269
Paste Special, 174
Publisher Options, 191
Quick Copy, 495
Replace, 379
Rig h t and Copy, 494
Show Clipboa rd, 384
Subscribe, 193
Text format, 45 7
Thesaurus, 577
Edit Quick Copy dialog
box,494
Edit Your Shortcuts
comma nd (Places menu),
906
editing
1-2-3 worksheets, 495, 497
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Excel worksheets, 467,
473-474
icons, 270-272
Finder, 276
tools, 273-276
musical recordings, 315-316
Pa inter, 644-645
Publish and Subscribe,
192-198
scripts, 350
Edition files (Publish and
Subscribe), 185
educational software,
757-784
Black American History:
Slavery to Civil Rights,
775-778
CD-ROM, 699-701
Learn To Speak Span ish,
771-775
Oregon Trail, 780-782
Treasure MathStorm, 782
Where in the World Is
Carmen Sandiego?,
778-780
ejecting floppy disks,
1078-1079
Electronic Funds Transfers
(EFT), 738
Electronic Not es (Syst em
7.5), 59
electronic paper (PDD), 233
Em dash (fonts), 146, 1146
Em space (fonts), 145, 1146
embedding, 199-201
EMI/RFI filters (power
surges), 1020-1024
Empty Trash command
(Specia l menu), 1 20
emulation, 1146
softwa re, 992
terminal, 1164
En dash (fonts), 146, 1146
En space (fonts), 146, 1146
enablers (System 7.5), 62
encrYJJtion, 1146
Enter key, 1146
entering
data
1-2-3 worksheets,
493-494
Excel worksheets,
463-464
formulas
1-2-3 worksheets, 496
Excel worksheets,
471-472

functions
1-2-3 worksheets,
496-497
Excel worksheets,
472-473
musical data, 295-296
entertainment
America Online, 859-860
CompuServe, 873
Entry Options dia log b ox,
514
environment (home office),
1018-1019
Epic Gothic (shareware),
809
EPS (encapsulated
PostScript), 1147
Equation palette
(FrameMaker), 583-584
Eraser tool, 275
ergonomics (home office),
1022-1026
errors, 718-719
Ethernet,942,1147
eWorld
Address Book, 90S
Arts and Leisure Pavilion,
897-898
Business & Finance Plaza,
900
Community Center, 903-904
Computer Center, 894
Learning Center, 899
library, 895
Marketplace, 899-900
navigating, 906-907
Newsstand, 902-903
Powerbooks, 1010-1011
services, 892-893
shortcuts, 906-909
signing up, 891-897
software, installing, 888-891
stocks, 900-901
Excel, 462-492
charts, 483-485
custom izi ng, 489-490
data
filtering, 486-487
sorting, 486-487
subtotaling, 486-487
databases, 485-486
drawing tools, 488-489
formatting, 478-483
AutoFormat, 483-493
cells, 480-481
defining styles, 482-483

numbers, 479-480
text, 480
macros, 487-488
outlin ing, 487
system req uiremen ts,
462-463
worksheets, 463-478
Autofi ll, 464-465
copying, 467-469
cutting, 467-469
drag and drop, 469
editing, 467, 473-474
entering data, 463-464
fi lls, 465-467
formulas, 47 1-472
functions, 472-473
Notes, 468-469
pasting, 467-469
series, 465-46 7
Special, 469-471
Status bar, 477-478
toolbars, 474-477
exchanging files, see
transferring
exercise software
(CD-ROM), 705
Exit menu commands, 919
expanded icon area, 275
expanding Macs, 19
expansion cards, 1147
expansion slot, 1147
Export menu commands,
657
exporting files
PageMaker, S7 1
Scrapbook, 180-185
extensions, 1147
shareware, 799-802
troubleshooting, 1088-1090
external CD-ROM drive,
693-694
external modems, 824

F
FAQs (Frequently Asked
Questions), 915
Fax/modem, 1147
faxes, 837-839
home office, 1031-1032
modems, 838-839
Powerbooks, 1005-1006
speed, 825-826
feedback setting, speech
recognition, 328-329

fills

fields
Filemaker Pro, 513-515
adding, 517
calculated, 515
formatting display values,
519-520
repeating, 515-539
summary, 515
FoxPro Mac, 525-531
lookup, 1152
file formats, 170-171, 1147
File menu commands, 51-52
Attach Sounds, 105
Close Window, 324
Documen t Layout, 372
l'ind, 89, 134
Generate/ Book, 583
Get Info, 120, 125, 268,
1148
Import, 672
Import File, 578
Libraries, 426
Locality, 908
Make Alias, 131, 330, 954
New, 94, 563
New Folder, 115
New Paragraph Style, 363
Open, 70,91
Open Custom Styles, 364
Open Dictionary, 348
Open Enclosing Folder, 136
Preferences, 563
Print, 203
Print One, 558
Put Away, 121
Quit, 101
Revert, 652
Save As, 92
Sharing, 947
Speak All, 333
Speak Selection, 334
Spelli ng Checker, 578
Stop Speaking, 334
Undo, 374
Voices, 333
file servers, 1147
File Sharing commands,
325
me synchronization, 1147
file transfer protocols,
843-844
Filcmaker Pro, 513-525
fie lds, 519-520
finding data, 520-521
formatting tools, 518

layouts, 515-518
adding fields, 517
formatting objects, 518
navigating, 520
parts, 516
records, n avigating, 520
scripts, 522-523
security, 523
setup, _513-515
sorting, 520-521
system requirements, 513
rues, 1147
aliases, 113 7
Apple File Exchange,
978-980
AppleScript, 139-141
Archie (Internet), 925-927
archiving, 1043-1044
backups, 817-818, 1108
compressing, 1044-1045
damaged, recovering,
1076-1078
data fork, 1143
deleting, 119-121
Desktop, 717-718
Desktop file, 276, 1144
disks, transferring, 978
Document Folder (System
7.5), 59
down loading, 842-848
e-mail, 867, 905-910
Edition (Publish and
Subscribe), 185
exporting, 180-185
Finder, 75-76
alias, 129-133
clean ing up, 127-128
finding, 134-136
h ierarchy, 110-112
icons, 276
labeling, 128-1 29
retrieving, 110-112
stationary, 133-134
storing, 110-112
forks, 270-271
Gopher (Internet), 926-927
Hierarchical File System
(HFS), 1149
importing, 177-179
inserting in folders, 117-118
invisible, 1151
locking, 126, 1066
lost icons, 1067-1068
managing utilities, 720
MFS (Macintosh File
System), 1153
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moving, 118-122
naming, 11 6
nesting, 111-112, 1154
networks, 948-950
Norton Utilities, 720-721
organization, 113-114
pack/unpack, 1155
print, 203
Readme, 1159
repairing, 1042-1043
retrieving from t rash, 121
Session Files, 880-883
sharing (networks), 946-95 1
sound formats, 285
spool, 203-206
system, 1163
tab-delimited, 1164
text, 1164
transfer protocol (In ternet),
924
transferring, 977-981
ASCII (American
Standard Code for
Information In te, 987
cable/modem, 98 1
fonts, 991
formats, 990-991
graphics, 991
naming, 985-98 7
networks, 981
sound,992
text files, 989-990
utilities, 980
translating, 981-985
applications, 982-983
Scrapbook, 178-179
util ities, 983-985
troubleshooting, 1066- 1068
uploading, 842-848
utilities
compression, 726-727
MacTools, 721-722
Mr. File, 722-723
Super Boomerang, 719
viewing, 122-128
Fill command (Data menu),
494
Fill command (Edit menu),
465
fill patterns (Astound), 443
fills, 1147
1-2-3 worksh eets, 494-495
Adobe Illustrator, 611-613
Excel worksheets, 465-467
customizing, 467
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film clips

film clips, assembling,
676-677
filters
Adobe Illustrator, 616-617
Excel, 486-487
Scrapbook, 180
f inancial information
(CompuServe), 872
financial software, 734-743,
1036
Find and Change
(PageMaker), 570-575
find and replace
MacWrite Pro, 367
Nisus Writer, 382-383
WordPerfect, 395
Find command (File menu),
89, 134
Find dialog box, 135
Find File command (Apple
menu), 134
Finder, 44-50, 67-68, 72-77,
1147
Balloon Help, 81-85
copying, 47-48
desktop, 114
files, 75-76
alias, 129-133
cleaning up, 127-128
deleting, 11 9-121
finding, 134-136
hierarch y, 110-112
labeling, 128-129
retrieving, 110-1 12
stationery, 133-134
storing, 110-112
folders, 75-76
creating, 114
deleting, 119-121
storing alias files, 131-133
hard disks, 112-122
hiding, 58
icons, 74-75, 276
labels, 250-251
menu bar, 46-47
mouse, 77-81
opening documents, 68-72
pasting, 47-48
scriptable, 354-356
System 7 Pack (shareware),
799
System 7.5 (Launcher), 139
trash, 119-121
window, 76-77
Finder command
(Application menu), 96

Finder Shortcuts command
(Ballon Help menu), 342
fi nding
FileMaker Pro data, 520-521
files, 134-136
First Things First (PIM
software), 752-753
fixed hard drives
(Pow erbooks), 1000
FKeys, 343-346, 1147
Flash-It (shareware),
800-801
flat-file databases, 512-513
floppy disks, 15-27, 1147
cleaning drives, 1113
damaged, 1082-1083
magnetic fields, 1106
m icro, 11 53
m ini, 1154
saving documents, 94
t roubleshooting
ejection, 1078-1079
initialization, 1079-1080
unreadable, 1081-1083
verifying, 1080-1081
flow charts (project
software), 750
flow control (modems), 835
Flow Inside Path menu
command (Type menu),
623
Folder icon, 75
folders, 1148
aliases, 113 7
co ntrol panels, 1143
creating, 114-11 6
deleting, 119-121
desktop, 114
files, inserting, 117-118
Finder, 75-76
fo nts, 159
locking, 60
naming, 116
nesting, 111-112
networks
access privileges, 965-966
sharing, 947-948
saving documents, 92
Speakable Items, 330
System 7.5 (default
document), 11 8
troubleshooting, 1065-1066
viewing, 122-128
Font command (Format
menu), 373
Font dialog box, 374

Font substitution, 1148
Font/DA Mover (utility),
1148
fonts, 1148
Adobe Type Manager, 152,
157-158
ATM (Adobe Type Manager),
713-715, 1137
baseli ne, 1139
Bezier curves, 11 39
bit-mapped, 147-148, 1139
cla rity, 152
condensed type, 1142
down loadable, 1145
downloading, 214-218
files, transferring, 99 1
fo lder limitatio ns, 159
formats, 147-152
freeware, 808-811
Greg's Buttons (shareware),
259-260
hard drive, 213
imagesetters, 236-23 7
lmageWriter, 1150
installing, 158-1 59
kerning, 155
laser, 1151
low-cost, 156-1 57
menus, 154
outline, 1155
Permanent set, 163
picas, 1157
points, 1157
PostScript, 148-149, 1 157
printer, 1158
priorities, 150-151
QuickDraw GX, 167
rasterizer, 150
resident, 151
resident (printing), 21 1
resource managers, 160-167
Master juggler, 165-166
Suitcase, 161-1 65
San s Serif, 144, 1160
scalable, 148
screen, 149, 1160
Serif, 144, 1161
shareware, 157-158, 808-81 1
special characters, 1133
Sui tcase (uti li ty), 712-713
terms, 145-147
troubleshooting, 1067-1071
TrueType, 150
typ e styles, 153
utilities, 715-716
Views Con trol Panel, 249

gigabytes
Word 6.0, 373-374
WYSIWYG Menus (Now
Utilities), 719
footers, 1148
foreign languages
(Ready,Set,Go), 603
forks (files), 270-271
Format Cells dialog box,
480
Format menu commands
AutoFormat, 371, 483
Bullets and Numbering, 379
Cells, 479
Document, 361
Column Width, 474
Drop Caps, 376
Font, 373
Insert Header, 387
Insert Page Number, 388
Paragraph, 575
Row Height, 474
Style, 379, 482
formats
fi les, transferring, 990-991
fon ts, 147-152
MacBinary, 1152
transferring data, 181-183
formatting
l-2-3,
numbers, 499
text, 499-501
Clipboard, 172-1 74
documents (WordPerfect),
389-390
Excel, 478-483
AutoFormat, 483-493
cells, 480-481
defin ing styles, 482-483
numbers, 479-480
text, 480
Filemaker Pro, 519-520
Nisus Writer, 380
scripts, 350-352
style sheets (PageMaker),
565-566
Word 6.0
columns, 373
documents, 372-373
forms, 746-747
formulas
1-2-3 worksheets, 496
Excel worksheets, 471-472
forums
Macintosh, 871
messages, 873-874

Four Footed Friends
(children's software), 768
FoxProMac
Browse mode, 527-539
custom screen, 527-539
databases, 525-539
fields, 525-531
menus, 535-536
programming, 537
projects, 536-539
reports, 534-535
RQBE (Relational Query By
Example), 532-539
screens, 531
system requiremen ts, 525
tables, 525-539
Fractal Design Painter, see
Painter, 641-647
fragmentation (hard
drives), 1118, 1148
Frame menu commands,
365
FrameMaker
Character Designer, 5 77
desktop publishing, 571-583
documents, 572-573
Equation palette, 583-584
graphics, importi ng, 578-580
hypertext cross-references,
583
illustrations, 5 78-580
indexes, 583-584
paragraph styles, 575-577
QuickAccess Bar, 573-575
shortcuts, 584-585
spelling, 577-578
system requirements, 572
table of contents, 583-584
tables, 580-582
thesaurus, 577-578
FreeHand, 619-625
colors, 622-623
drawing tools, 620-623
handles, 621
Layers, 622
paths, 620-623
scanned images, 624
text, 623
views
Keyline, 62 !
Preview, 621
freeware, 796, 1148
AppliWindows, 797
business, 812-816
Disinfectant, 816
fonts, 808-81 1
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games, 803-808
Glider, 803-804
Maclnterest, 813-814
Open-Wide, 797
PopChar, 801
RapMaster, 806
ScreenPlay, 799
Service Invoice, 815
SmartKeys, 802
St. Francis, 810
Tengwar-Gandalf, 811
freezing, 1065
hard drives, 1074-1075
System 7, 1070
French spacing (fonts), 147
friskets (Painter), 645-646
FSSD (sound file format),
285
ftp (file transfer protocol),
924, 1148
full backups, 1115-1116
function keys, 1148
Function menu commands,
496
Function Wizard dialog
box,473
functions
1-2-3 worksheets, 496-497
Excel worksheets, 472-473
furniture (home office),
1022-1026

G
games, 757-760, 784-793
freeware, 803-808
Lemm ings, 790-791
Populous, 792
Puzzle, 757-759
Railroad Tycoon, 791-792
shareware, 803-808
SimCity 2000, 784-788
software (CD-ROM), 703-704
The 7th Guest, 788-790
gateways (networks), 1148
General Controls (Control
Panel), 245-246
General Controls dialog
box, 245
Generate/Book command
(File menu), 583
Get Info command (File
menu), 120, 125, 268, 1148
gigabytes (System 7.5),
62-66, 1148
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Glider

Glide r (freeware), 803-804
Glossaries menu command
(Documen t menu), 603
Go T o At Ease Setup
co m mand (Special menu),
102
Go To m e n u commands,
86 7
Go To Specia l dialog box,
470
Gopher (Internet), 926-927,
1148
G ra ceLAN Asset Manager
(business s oftware), 747
gra phics, 402-403
Astound, slides, 436-450
CD-ROM, 705-706
DeltaGraph Pro 3, 415-427
files, transferring, 991
fo rmats
PICT, 1157
transferring data, 181-183
FrameMaker, 578-580
grayscale, 1148
Impact, 403-414
imported, 639
Nisus Writer palette, 382
Now Scrapbook (Now
Utilities), 719
Persuasion, slides, 450-458
PowerPoin t, 427-436
printi ng, 229
utili ties
Capture, 725-726
Desktop Textures, 726
VisualClips, 724-725
Graphics m enu commands
Scale Graphic to Block, 602
Set Wrap Border, 388
gra phs
1-2-3, 501-503
Adobe Illustrator, 61 7
PowerPoint, 430-432
graysca le (g raphics), 1148
Greg 's Buttons (shareware),
257-260
Group comn~and (Arr a nge
menu ), 436
grouping, 1149
GUI (gra phical use r
inte r face), 12, 1149
Gu ides co m mand (Show
m e nu), 458

H
handicapped use rs, 286
handles (FreeHa nd), 621
handling CD-ROMs, 709
hanging indents, 1149
hard drives
Apple HD SC Setup, 1138
defra gmenting, 1143
fragmen tation, 1118, 1148
fo nt storage, 213
musica l recordings, 315-316
organizi ng, 112-122
repai r utilities, 111 7-11 21
troubleshooting
disk will not open,
1074-1078
duplicate icons, 1074
freezing, 1074-1075
HD SC setup, 1075
start up, 1072-1074
hard ware, 1149
defa ult, 11 43
digital audio, 311-320
home office, 1027-1032
MIDI (Musical Instrument
Digital Interface), 288-289
multimedia (sound), 693
music, 316-320
networks, 940-943
speed, 691-692
troubleshooting, 1100-1101
h a rdware handshake
(mo dems), 835
Hayes-c o mpatible modem,
1149
hea d ers, 1149
h ealth software (CD-ROM),
704-705
help
America Online, 866
Apple Guide (System 7.5),
56-57
Balloon Help, 81-85, 1139
Macintosh Guide, 82-85
o n-line, 11 55
Hide Docume nt Layout
comma nd (View menu),
590
Hide Template command
(Vie w menu), 610
hiding Finder, 58
hiera rchical
databases, 1149
files, 110-112

Hierarchical File System
(H.FS), 1149
high-density drives, 978
high-profile SIMM, 1149
highlighting, 1149
home office
backups, 1041-1042
CD-ROM drives, 103 1
chi ld proofing, 1046-1047
computer care, 1016-1027
dust, 10 19-1 020
power surges, 1020
static electricity, 1021
theft, 1022
Un interruptable Power
Supply (UPS), 1021
data protection, 1041-1043
disks, 1026-1 027
drives
arch iving data,
1043- 1044
com pressing, 1044-1045
environment, 1018-1019
fax modems, 1031-1032
finan cial software, 1036
furniture, 1022-1026
hardware, 1027-1032
keyboards, 1023-1025
Macintoshes, 1029-1030
MacTools, 1043
modems, 1031-1032
monitors, 1022-1023, 1030
mouse, 1025-1026
Norton Utilities, 1042-1043
Now Menus (Now Uti lities),
1038-1040
printers, 1030-1031
schedules, 1040
screen savers, 1045-1 046
software, 1032-1047
Super Boomerang (Now
Utilities), 1038-1040
trackballs, 1025-1026
virus protection, 1041
word processing, 1034-1036
hosting BBS (Bulletin
Board Syste m), 846-847
HyperCa rd, 1149
HyperTalk, 1150
hypertext, 1150
hypertext c ross-r efe rences
(FrameMa ker), 583

Internet

I
1-b eam (m ouse pointer),
1150
icons, 1150
aliases, 113 7
clip art, 268-269
copying, 267-270
dimmed, 1144
du plicates (troubleshooti ng),
1074
editing, 270-276
Finder, 276
tools, 273-276
expanded icon area, 275
Finder, 74-75
keyboard shortcuts, 1129
lost, 1067-1068
men us, 275-276
original art, 269
past ing, 267-270
ResEd it, 270-276
resource types, 272-273
viewing, 123-125
Views Control Panel, 249
Jdea Fisher (project
software), 749- 750
illustrations (FrameMaker),
578-580
Image men u con1mands,
657
images, sizing, 6 5 5-656
imagesetters
printing, 234-239
fonts, 236-237
PostScript files, 238
ImageW riter
fonts, 1150
printing, 209-210, 218
Impa ct, 403-414
documents
presentation, 412
report, 410-4 11
models, 407-410
spell checker, 413
style bar, 404-405
system requirements,
403-404
toolbar, 405-407
word processing, 410-411
impa ct prin t e r, 1150
Import comma n d (File
m enu), 672
Import File command (File
m enu), 578

importing
files, 177-179
graphics, 578-580
In Control (PIM software),
753
income tax software,
747-748
incremental backups,
1115-1116, 1150
indenting (hanging), 1149
indexes
FramcMaker, 583-584
PageMakcr, 570
lnfoDepot (PIM software),
753
Information Manager
(CompuServe), 874-879
information services, 1150
Informed Foundation
(business software),
746-747
i nitialization, 1150
flo ppy disks
(troubleshooting),
1079-1080
string (modems), 836
inkjet printers, 210, 1150
input devices, 1151
Insar~ely Great (book),
42-43
Insert Cells command (Edit
menu}, 473
Insert command
(Worksheet menu), 497,
507
Insert Header command
(Format menu), 387
Insert menu commands,
378
Insert Page Number
command (Format menu),
388
Insert Table command
(Frame menu}, 365
Insert Table command
(Table menu), 580
Insert Table dialog box,
365
inserting files in folders,
117-118
insertion point blinking
(General Controls}, 245,
1143
Inspiration (IJroject
software}, 749

1183

installer (aJ•plication),
1151
installing
America Online, 850-853
CompuServe Info rmatio n
Manager, 874-876
CompuServe Navigator, 880
e\Vorld software, 888-891
fon ts, 158-159
Level 2 PostScript printer
drivers, 224-227
modems, 827-828
System 7.5, 56, 64-66
system software, I 091-1099
telecommunications
software, 834-837
integrated software, 1151
Audition, 670-684
ClarisWorks, 542-549
Microsoft Works, 554-559
WordPerfect Works, 550-554
Interactions (Astound),
443-444
interfaces, 23-24, 1151
CompuServe, 869-870
GU1 (graphical user
interface), 1149
IIISallely Great (book), 42-43
Maci ntosh, 42-44
Microsoft Windows 3.0,
43-44
M IDl (Musical Instrument
Digital Interface), 289
serial , 1 161
television (Powerbook), I 002
visual, 1166
internal CD-ROM drive,
693-694
internal modems, 824, 1151
Internet, 912-913, 1151
accessing, 91 3-923
America Online, 921-924
Archie, 925-927
ARPANET (Advanced
Research Projects Agency),
9 12
FAQs (Frequently Askecl
Q uestions), 915
ftp (file transfer protocol),
924, 1148
Gopher, 926-927, 1148
history, 912-913
IRC (In ternet Relay Chat),
928-930
mailing address, 9 13-9 14
Netcom , 917-921

1184

Internet

netiquette, 914-917
protocols, 1158
searching, 925-928
shortcuts, 932-933
smileys, 917-934
TCP/lP (Tra nsmissio n
Control Protocol/Internet
Protocol), 9 J3, 1164
T~lnd, 928
Usenet Newsgroups, 928,
I 165
WAlS (W ide Area
Information Services), 928,
1166
invisible files, 1151
IRC (Internet Relay Chat),
928-930
IS0-9660/High Sierra, 689

J
jagged printing
(troubleshooting),
1083-1088
Jobs, Steve, 15
JI•EG Ooint Photo&'Taphic
Experts Group), 681
jumps {Persuasion), 454-455
Just Grandma and Me
(educational software),
761-764

K
Kaboom! {sound), 284-285
Kai's Power Tools
{Photoshop), 666
Kbps {Kilobits per second),
1151
kerning, 155, 1151
keyboards
/\DB (Apple Deskto p Bus),
1137
Arrow key~ , 1138
cleaning, 1111-11 14
Control key, 1143
Delete key, 1144
Enter key, 1146
f.Keys, 343-346
fun ctio n keys, 1148
ho me office, I 023-1025
o pt ion key, 1155
Return key, 1160

shortcuts, 336-340
icons, 11 29
menus, 48
options, 1132
Sma rtKeys (freeware), 802
Keyline mode (FreeHand),
621
Keyword command (Go To
lllCllU), 867
KidPix (children's
software), 767-770
kilobytes, 1151
Kitchen Sink (XTension),
593-594

L
Label menu commands,
128,250
labeling files (Finder),
128-129
Labels
Control Panels, 250-251
removing, 250-251
landsca)Je orientation, 1151
languages
AppleScript, 348
programming, 1158
LANs (local area networks),
1152
Ethernet, 114 7
LocalTalk (Apple), 1152
laser fonts, 1151
laser printers, 210-211,
1151
paper, 229-230
PostScript compatible,
211-212
LaserWriter, 16, 214-221,
1152
lauching ap)Jlications, 1152
Launcher
adding programs, 89-90
deleting progra ms, 89-90
Perfo rma, 88-89
removing, 98-99
System 7.5, 59, 139
layering objects, 422
Layers {FreeHand), 622
Layout menu commands
Center Page, 381-400
Display Master Items, 568
Set Margins, 381
Layout Sets (DeltaGraph
Pro 3), 419-420

layouts
Filemaker Pro, 515-518
formatting o bjects, 518
navigating, 520
parts, 516
leading (fonts), 145, 1152
Learn To Speak Spanish
(educational software),
771-775
Learning & Reference
(America Online), 865
Learning Center (eWorld),
899
Lemmings (game), 790-791
Level 2 Postscript printers,
222-224
drivers, 224-227
PPD (PostScript Printer
Description), 225-226
RAM (Random-Access
Memory), 224-225
libraries, slides, 443
Libraries command (File
menu), 426
library
CompuServe, 872
eWorld, 895
Lifestyles & Interests
(America Online), 864-865
ligatures (fonts), 146
lightning (maintenance),
1105
linking networks, 198-199,
966-968
Lisa (computer), 12, 1152
List Views, 1130
viewing, 123-125
Views Control Panel,
249-250
lists, bulleted, 395
live data
Publish and Subscribe,
184-1 98
transferring, 183-184
local echo (modems), 837
Locality command (File
menu), 908
LocaiTalk (Apple), 941,
1152
locked files
(troubleshooting), 1066
locking
files, 126
folders, 60
log off BBS {Bulletin Board
System), 844-846

menus
logic board, 1152
cleaning, 1114
see also motherboard
lookup field, 1152
lossy compression, 681
Lotus, see 1-2-3
low-cost fonts, 156-157
low-profile SIMM, 1152

M
Mac icon (troubleshooting),
1056-1059
Mac II, 17-19
Mac llsi (micophones), 281
Mac, original, 13-15
Mac Plus, 18
Mac SE, 19
MacBinary (format), 1152
MacCIM (CompuServe
Information Manager),
874
MacErrors (utility), 718-719
MaclnTax (income tax
software), 747-748
Maclnterest (freeware),
813-814
Macintosh
care, 1016-1027
CD-ROM, 692
Control Panels, 243-256
fo rums, 871
home office compu ters,
1029-1030, 1043
Insanely Great (book), 42-43
interfaces, 42-44
MIDI (Musica l instrument
Digital Interface), 289
model listing, 20-22
naming (networks), 945-947
Power, 3 1-35, 1157
sound, 279-286, 295-296
third-party developers, 37
window, 49-50
Macintosh File System
(MFS), 1152
Macintosh Guide (System
7), 82-85
Macintosh User Group,
1152
MacP&L (accounting
software), 745
MacProject Pro (project
software), 749
MacRecorder, 280

Macro menu commands,
331
Macro Transcript dialog
box,506
macros, 343-346, 1152
1-2-3, 506
Excel, 487-488
speech recognition, 330-332
MacTCP, 1152
MacTools (utilities),
721-722
MacWrite Pro, 360-370
document settings, 360-362
find and replace, 367
style sheets, 363-364
system requirements, 360
tables, 365-366
text pa lette, 363
t hesaurus, 366
tools palette, 364-365
Maelstrom (shareware), 805
magnetic fields (floppy
disks), 1106
mail order
hardware, 1027-1032
software, 1033
mailing address
America Online, 852-853
Internet, 913-914
mainframes, 1153
maintenance, 1104-1107
clea ning
CD-ROM drives, 1114
floppy drives, 1113
keyboard, 1111-11 14
logic board, 1114
monitors, 1113
mouse, 1112
dust, 1106
light ning, 1105
magnetic fields (floppy
disks), II 06
power failure, 1105
schedule, 1124-1126
smoke, 1106
software updates, 1110-1111
spikes, 1104-1105
static electricity, 1105-11 06
surges, 1104-1 105
temperatures, 1107
UPS (uninterruptable power
sources), 1105
virus protection, 1121-1123
Make Alias command (File
menu), 131, 330, 954
Make Movie command
(Project menu), 677
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MauagePro (Project
software), 749
Managers command {Edit
menu), 632
Managing Your Money
(financial software),
738-742
Market Analyzer Plus
(financial software), 743
Marketplace (eWorld),
899-900
marquees, 1153
Master juggler (resource
manager), 165-166
master pages
PageMaker, 568
QuarkXPress, 591
Ready,Set, Go, 601
math coprocessor, 1153
MCI Mail (Powerbooks),
1011
Measurement Palette
(QuarkXPress), 589-590
media, removable, 1159
megabytes, 1153
Membership menu
commands, 909
memory, 1153
buffers, 1140
high-profile SIMM, 1149
low-profile SIMM, 1152
printer buffer, 1158
printing, 230
RAM (Random-Access
Memory), 1159
ROM (Read-Only Mem ory),
1159
SIMM, 1162
system heap, 1163
virtual, 1166
volatile, 1166
menu bar, 46-47, 1153
menu dialog b ox, 535
menubar clock, 254-255
menus, 1153
application, 1138
At Ease 2.0 (Performa), 107
commands, 46-47, 1142
fon ts, 154
FoxPro Mac, 535-536
General Controls, 246
icons, 275-276
keyboard sho rtcuts, 48
Now Utilities, 264-265
NowMen us (Now
Uti lities), 719
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menus

pop-up, 115 7
pull-down, 1159
System 7.5, 58, 137
tear-off, 11 64
tear-off (BrushStrokes),
635-638
tear-off menus (Canvas), 630
messages (CompuServe),
873-874
Messages menu commands,
878
MFS (Macintosh File
System), 1118, 1153
microcomputers, 1153
microfloppy disks, 1153
Microphone
(telecommunications
software), 829-830
microphones, 281
microprocessors, 1153
Microsoft Project (projects
software), 748-749
Microsoft Windows 3 .0,
43-44
Microsoft Works, 554-559
charts, 556
communications, 557-558
documents, 556
databases, 556
spreadsheets, 556
system requiremen ts, 554
MIDI (Musical Instrument
Digital Interface)
adapters, 312-313
channels, 291-292
connecting, 289-290
daisy chains, 290
data structure, 290
digi tal audio, 311-320
hardware, 288-289
in terraces, 289
Macintosh, 289
modes, 29 1-292
SCSI accelerators, 313
sound, 287-292
sound cards, 313
synthesizers, 314-3 1S
minifloppy disks, 1154
models (Impact), 407-410
modems, 824-828, 1154
acoustic, 113 7
America Online, 852
asynchronous
communication, 11 38
auto answer, 1138
Autocall, 1139

baud rate, 835-848, 1139
BBS (Bulletin Board System),
841-846
bps (bits per second), 1140
carrier detect, 1141
data bits, 836
data pump, 826
data speed, 825-826
direct-conect, 1144
duplex communications,
1146
external , 824
fax speed, 825-826
fa xes, 838-839, 1147
files, transferring, 981
flow control, 835
hardware handshake, 835
Hayes-compatible, 1149
home office, 1031-1032
initialization string, 836
installing, 827-828
interna l, 824, 11 S 1
local echo, 837
parity, 836
Powerbooks
digital phone switch,
1001
faxing, 1005-1006
remote access to networks,
840-841
speed, 825
stop bits, 836
V.34, 826
wireless, 826, 1011-1012
modes (MIDI), 291-292
Modify Frames dialog box,
369
monitoring networks,
963-965
monitors, 1154
clean ing, l 113
home office, 1022-1023,
1030
screen savers, 1110
monospace fonts, 145
moov format (Clipboard),
172
MooVs (QuickTime), 682
motherboard, 1154
see also logic board
Motorola, 1158
ntouse, 1154
ADB (Apple Desktop Bus),
1137
cleani ng, 1112
clicking, 77-86, 114 1

double-clicking, 1145
drag and drop, 1146
dragging, 77-86, 11 46
ergo nomics, !025-1026
Finder, 77-81
1-bea m (poin ter), 1150
menu commands, 79-81
pointer, 1157
pointing, 77-86
sho rtcuts, 340-342
Mouse Preferences
(Preferences menu), 549
Move Cells command (Edit
menu),495
Movie (sound file format),
285
movies
CD-ROM software, 701-702
MooVs (QuickTime), 682
Premiere (Aud ition), 671-673
QuickTime, compression,
681-682
moving
components with power on,
1109
files to desktop, 11 8-122
Mr. File (utility), 722-723
Mr. File command (Apple
menu), 722-723
Multifinder, 1154
printing, 204
MultiLedger (accounting
software), 745
multimedia, 1154
CD-ROM, 69 1-692
hardware, sound, 693
system requireme nts,
692-695
multitasking, 34-35, 1154
background executi on, 11 39
cooperative, 63
preemptive, 63
Threads Manager (System
7.5), 63
music
hard disks, 315-316
hardware, 316-320
online services, 299
printing, 296-297
software, 292-293, 298-309
CD-ROM 704
copy protection, 297-298
MYOB (Mind Your Own
Business) (accounting
software), 744

OCR (Optical Character Recognition)

N
naming
computer networks, 945-947
files, transferring, 116,
985-987
fo lders, 116
speech recognition, 327-328
nanosecond, 1154
navigating
Arrow keys, 1138
CompuServe Info rmation
Manager, 876-880
Directory Dialog Boxes, 11 31
eWorld, 906-907
windows, 1130
Navigator (CompuServe),
869, 880-884
nesting (folders), 111-112,
1154
Netcom (Internet), 917-921
netiquette (Internet),
914-91 7
networks, 937-943, 1154
access privileges, 959-963
AppleTalk, 18, 943-944, 1138
backbone, 972-975
bridges, 973-975, 1140
computers (access
privileges), 951-956
connecting, 943-946
aliases, 953-954
automaticaUy, 954-956
larger networks, 972-975
connections selecting, 944
dedicated servers, 938-940
disks
access privileges, 950-951
shared, 952-953
Ethernet, 942, 11 47
fi le server, 1147
files
access privileges, 948-950
sharing, 946-951
transferring, 981
folders
access privileges, 965-966
sharing, 947-948
gateways, 1148
GraceLA Asset Manager,
747
hardware, 940-943
Internet, 1151
LANs (local area networks),
1152

linking applications,
966-968
LocaiTalk, 941
monitoring, 963-965
n aming computer, 945-947
nodes, 1154
passwords, 948-950, 956-958
peer to peer, 938-940, 11 56
printer server, 1158
printers, 970-972
printing, 229-230
protocols, 1158
remote access, 840-841,
960-961
routers, 973-975
servers, 1145
software, 940-943
System 7 Pro, 975-976
Token Ring, 942, 1164
troubleshooting, 969-970
zone, 94-945, 1167
New command (File menu),
94,563
New command (Table
menu), 393
New Field dialog box, 517
New Folder command (File
menu), 115
New Form command (Data
menu), 504
New Layout command
(Edit menu), 516
New Paragraph Style
command (File menu),
363
news (CompuServe), 873
News & Finance (America
Online), 858-859
Newsstand
America Online, 864
eWorld, 902-903
NIC (network interface
card), 940
Nisus Writer, 379-388
Clipboard, 383-384
document layout, 381
find and replace, 382-383
graphics palette, 382
multiple undos, 384
paragraph rulers, 380
selecting noncontiguous
text, 384
system requirements, 380
thesaurus, 385
nodes (networks), 1154
None command (Lab el
menu), 250-251
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Norton Utilities, 720-721,
1042-1043
notebooks, 24-27, 995-999
notes
Electronic Notes (System
7.5), 59
Excel worksheets, 468-469
Notes (System, 7.5), 59
Notes View (PowerPoint),
434
Notify (shareware), 814
Now Contact (Contact
Managers software), 754
Now Up-To-Date (calendar),
751-752, 1040
Now Utilities, 719-720
Now Menu, 264-265, 719,
1038-1040
Now Profile, 719-720
Now Scrapbook (Now
Utilities), 719
NowSave, 719
WYSIWYG menus, 264-265
NuBus, 1154
null modem, 1154
numbers
binary, 1139
Control Panels, 255-256
formatting
1-2-3,499
Excel, 479-480

0
Object menu commands
Blend, 449
Convert to bitmap, 449
Whiter, 449
Object Order dialog box,
531
Object Transition dialog
box,449
object-oriented
programming (OOP), 1155
objects
Adobe Illustrator
filling, 6 11-613
stroking, 611-613
aligning (DeltaGraph Pro 3),
422
Filemaker Pro, 518
layering (DeltaG raph Pro 3),
422
OCR (Optical Character
Recognition), 1155, 1164
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OLE (Object Linking and Embedding)

OLE (Object Linking and
Embedding), 198-201
On The Roa d (Powerbook
software), 1004-1005
One on One command
(Membership menu), 909
online services, 1155
America Online, 850-853
CompuServe, 869
help, 1155
hosti ng, 846-847
music, 299
ZTerm (shareware), 8 19
open architecture, 1155
Open command (File
menu), 70, 91
01>en Custom Styles
command (File menu),
364

Open dialog box, 92, 163
OJien Dictionary command
(File menu), 348
Open Document (software),
39

Open Enclos ing Folder
command (File menu),
136

Open -Wide (freeware), 797
opening, 1155
applications, 137-138
documents, 137-138
f inder, 68-72
Performa, 91-92
windows, 1 130
oper a ting systems, 1155
AppleShare, 1138
CD-ROM, 690-693
DOS (Disk Operating
System), 1145
UNIX, 1165
optical char acter
r ecognition (OCR), 1155
o ptical disks, 1155
option key, 1155
o ptions, keyboard
shortcuts, 113 2
option s cards, 1155
Optio n s command (Tools
m enu), 4 6 7
Options menu commands,
426

Oregon T r a il (educat ional
software), 780-782
organizin g
files, 113-114
hard disks, 11 2-122

outlin e f o nts, 1155
Outline View
Astound, 446-447
DeltaGraph Pro 3, slides,
422-4 23
Persuasion, slides, 456
PowerPoint, slides, 432-433
o verhead projecto rs, 1013

p
p ack / u n p ack (files), 1155
Page menu com man ds, 591
page numbers (PageMaker),
5 71-575

p a ge preview, 1156
Page setup (PageMaker ),
563

Pa geMa ker (Aldus), 570-571
Aldus Additions, 570
Color Separations, 570
colum ns, 568
Control Pa lette, 566-567
desktop publishing, 562-571
exporting, 571
find and Change, 570-575
Index, 570
Master Pages, 568
page numbers, 571-575
Page setup, 563
Pasteboard, 563-564
Story Editor, 569
style sheets, 565-566
system requirements,
562-563
Table of Contents, 569-570
templates, 570-575
text, 569
Toolbox, 564-565
word processing, 569
p ages
landscape orientation, 11 51
portrait orientation, 1157
Paint Style dialog box, 611
Painter, 641-647
Cloning, 645
drawing tools, 641-644
editing, 644-645
friskets, 645-646
special effects, 644-645
Toolbox, 644
p a lettes
Adobe Illustrator, Character,
615-6 16
MacWrite Pro tools, 363-365

Nisus Writer (graphics), 382
l'ageMaker, 566-567
Painter, 641-644
QuarkXPress, 587-588
Ready,Set,Go, 599-600
Palo Alto Business Tools
(software), 746
Pan tone Matching System
(colors), 1156
paper
laser prin ters, 229-230
PO D (Portable Digital
Document), 233
portable digital document,
1157
size, 230
Paragraph command
(Format menu), 575
paragraphs
FrameMaker, 5 75-5 77
Vertical j ustifi cation
(QuarkXPress), 592
WordPerfect, 392
paralJel ports, 1156
Parameter RAM, 717-718
parity (modems), 836
parity bits, 1156
Part Definition dialog box,
516

partition (hard drives),
1156

passwords
At Ease 2.0 (Performa), 102
networks, 948-950, 956-958
Paste command (Edit
menu), 48, 171, 269
Paste Special command
(Edit menu), 174
pasteboards
QuarkXPress, 586-587
PageMaker, 563-564
Ready,Set,Go, 596-597
pasting, 47-48, 1156
1-2-3 worksheets, 495-496
Excel worksheets, 467-469
icons, 267-270
paths, 1156
Adobe lllustrator, 611-613
FreeHa nd, 620-623
patterns
cell s, 480-481
desktop, 246-247
PC (personal computer),
1156

PC Exchange (System 7.5),
6 1-62

PowerBook

PCMCIA expansion
(Powerbooks), 997-998
PDD (Portable Digital
Document), 233
PDL (page description
language), 1156
PDS (Processor Direct Slot),
1156
Peachtree (accounting
software), 744-745
peer-to-peer network,
938-940, 1156
Pentium chips, 30-31
People Connection
(America Online), 863
Performa, 1029-1030
At Ease 2.0, 100-107
assigning programs,
103-104
menus, 107
passwords, 102
saving, 104-105
shuttingdown, 105-106
sounds, 105
sta rting, 101-102
switching programs, 107
users, 102-105
Control Panel, 99-1 00
documents
creating, 94
opening, 91 -92
saving, 92-94
Launcher
adding programs, 89-90
deleting programs, 89-90
removing, 98-99
programs
backing up, 96-98
restoring, 97
starting, 96
switching between, 95
startup, 98
System Folder, backing up,
97
performance, System 7.5,
62-66
peripheral devices, 1156
Permanent set (fonts), 163
Personal Log (shareware),
814-816
Persuasion (Aldus), 450-458
autotemplates, 450-454
color palette tool, 452-453
jumps, 454-455
slides, 450-454
adding graphics, 452-453
adding text, 452-453

charts, 453-454
clip art, 454
customizing, 451-452
Outline View, 456
Slide Sorter View, 456
spell checker, 456-45 7
system requirements, 450
transitions, 455-456
PhoneNET, 1156
phosphor (CRTs), 1157
Photoshop (Adobe), 649-669
8-bit color, 650-651
24-bit color, 650-651
canvas, sizing, 657
colors, 664
images, sizing, 655-656
plug-ins, 666-667
scanners, 654
selections (Alpha Chan nel),
665-666
system requirements,
65 1-653
toolbox, 657-663
picas, 1157
PICT (graphic format), 172,
1157
PIMs (Personal
Information
Management), 751-754
pixel based programs,
607-608, 1157
Places menu commands,
906
PlainTalk (Apple), 321-322
speech recognition, 322-332
TIS (text-to-file), 333-334
plug-ins
BrushStrokes, 639-640
filters
Adobe Illustrator,
616-617
Scrapbook, 180
Photoshop
Kai's Power Tools, 666
shareware, 667
point size (fonts), 145
pointer, 1157
pointing mouse, 77-86
points (fonts), 1157
pop-up menus, 1157
PopChar (utility), 715-716,
801
Populous (game), 792
portable digital document
(PDD), 1157
portables, 24-27
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ports, 1157
disk drives, 1145
parallel, 1156
printers, 1158
SCSI, 1161
serial, 11 61
PostScript (printer
language), 16, 1157
imagesetters, 238
fonts, 148-149
interpreter, 11 57
PostScript printers, 208-211
ATM (Adobe Type Manager),
1137
compatibility, 211-212
EPS (encapsulated
PostScript), 1147
Level 2 printers, 222-224
drivers, 226-227
PPD (PostScript Printer
Description), 225-226
RAM (Random-Access
Memory), 224-225
resident fon ts, 211
troubleshooting, 1084-1086
Power Macintosh, 31-35,
1029-1030, 1157
c rus (central processing
units), 3 1-33
running Windows, 34-38
software, 33-34
SoftWindows, 34-35
third party developers, 37
upgrading, 35-37
video, 31-33
power spikes, 1104-1105
power surges, 1020,
1026-1027, 1104-1105
PowerBar (shareware), 798
PowerBook, 24-27, 995-999,
1157
America On line, 1006-1008
batteries, 1001
cases, 1000, 1027
cellular telephones, 1012
CompuServe, 1009
Duos, 999
e-mail, 1006-101 1
eWorld, 1010-1011
hard drives, 1000
MCI Mail, 1011
microphones, 281
modems
digital phone switch,
1001
faxing, 1005
wireless, 10 11-1012
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Power Book

PCMCIA expansion, 997-998
portable printers, 1002
presentat io ns, 10 12
overhead pro jectors, 1013
sound, 1014
televisions, 1013
SCSI cable system,
1000-1001
SCSI disk adapter, 1000
SCSI terminator, 1001
software, 1001-1005
surge protectors, 1026-1027
telephone cords, 1001
Trackpad (Midas), 997-998
TV /VCR interface, 1002
wireless, 1011-1012
x-rays, 1002
Power PC, 30-31, 38, 1158
PowerPoint, 427-436
graphs, 430-432
presentations, 435
Slide View, 427-430
slides
adding graph ics, 429-430
adding text, 429
Notes View, 434
Outline:: Vic::w, 432-433
Slide Sorter View,
433-434
spell checker, 435
system requirements, 427
tem plates, 427-428
views, customizing, 434
PowerStrip (shareware),
798-799
PowerTalk (System 7.5), 62
PPD (PostScript Printer
Description), 225-226
PRAM (Parameter RAM),
1156, 1071
preemptive multitasking,
63
Preferences command (File
menu), 563
Preferences command
menu, 549
Preferences dialog box, 426
Premiere (Audition)
movies, 671-673, 676-677
Projects, 673-674
special effects, 674-676
upgrade to full versio n,
678-680
presentation documents,
Impact, 4 12

presentations
Astound, 436-450
Deltagraph Pro 3, 415-427
Impact, 403-414
Persuasion, 450-458
Powerbooks, 1012-1014
overhead projecto rs, 1013
sound, 1014
televisions, 1013
PowerPoint, 427-436
Preview mode (FreeHand),
621
Print command (File
menu), 203
Print dialog box, 231
print files, 203
Print One command
(Filemenu), 558
printer buffer, 11~8
printer fonts, 1158
printer server, 1158
printers
dot-m atrix, 1145, 1150
dpi (dots per inch), 1145
drivers, 1158
home office, 1030- I 031
impact, 1150
inkjet, 11 50
LaserWriter, 16
LaserWriter (Apple), 1152
laser, 1151
networks, 18, 970-972
POL (page description
language), 11 56
ports, 11 58
PostScript (language), 16
Powerbooks, 1004-1005
spooler utilities, 1162
spooli ng, 11 58
StyleWriter (Apple}, 1163
to ner, 11 64
tractor-feed, 1165
printing, 203, 222
backgro und, 204
clone printers, 2L1-212
colo r separations, 1142
dialog boxes, 218-222
dot-matrix, 209
dpi (dots per inch), 212-213
drivers, 224-227
fonts, 214-2 18
image enhancemen t, 229
imagesetters, 234-239
lmageWriter (Apple),
209-210, 218
inkjet printers, 210

laser printers, 210-211
LaserWriter, 214-221
Level 2 PostScri pt drivers,
224-227
memory require ments, 230
MulltiFinder, 204
music, 296-297
networks, 229-230
page preview, 11 56
pages per minute, 228-229
paper, 229-230
PostScript, 208-211
PostScript Level 2 printers,
225-227
PrintMonitor, 206-208
QuickDraw (Apple), 208
QuickDraw GX, 63-64,
205-206, 230-233
recycling materials, 233-234
resident fonts, 2 11
resolutio n, 212-213
screen dump, 1160
spool fi les, 203, 205-206
StyleWriter, 218
System 6, 204
System 7, 204
Toner Tuner, 715
troubleshooting
jagged, 1083-1088
memory, 1087-1088
monito r crashes,
1086-108 7
PostScript errors,
1084-1086
PrintMonitor (utility),
205-208, 1158
programmer's switch, 1158
programming
BASIC (Beginner's AllPurpose Symbolic
Instruction Code}, 1139
FoxPro Mac, 537
la nguages, 1158
object-oriented (OOP), 1155
programs, 1158
At Ease 2.0 (Perfo rma),
103-104
Performa, 96-98
Project dialog box, 536
Project menu commands,
Make Movie, 677
Project Output Options
dialog box, 678
project software, 748-750
projects
FoxPro Mac, 536-539
Premiere (Audition), 673-674

report documents
prOJJOrtional fonts, 145
proportional spacing, 1158
protocols, 1158
public domain software,
1158
Publish and Subscribe,
1159
editing, 192-193
Edition files, 185
options, 191-192
publishing data, 189
software support, 189
subcriber information,
194-198
transferring data, 184-198
troubleshooting, 197-198
Publisher Options
command (Edit menu),
191
pull-down menus, 1159
Put Away comma nd (File
menu), 121
Putt-Putt Goes to the Moon
(children's software),
764-767
Puzzle (game), 757-759

Q
Quadra A V Macs, sound,
285-286
quantization (sound),
295-296
QuarkXPress (software),
16-17
Automatic Trapping,
592-594
color separations, 592-594
desktop publishing, 585-588
Document Layout Palette,
590-591
master pages, 59 1
Measurement Palette,
589-590
pasteboard, 586-587
Reshaping Picture or Text
Boxes, 592
shortcuts, 594-595
style sheets, 588
system requirements,
585-588
text, 592
Tool Palette, 587-588
Vertical justification, 592
word processing, 592

XTensions, 593-594
que ries, FoxPro Mac, 532
Quick Copy command (Edit
menu), 495
QuickAccess Bar,
FrameMaker, 573-575
QuickDraw (Apple), 208,
1159
QuickDraw GX (Apple),
205-206, 1159
ATM GX (Adobe Type
Manager GX), 1137
fonts, 167
printing, 230-233
POD (Portable Digital
Document), 233
Type 1 Fon t Enabler, 232
System 7.5, 63-64
Quicken (f'mancial
software), 734-738
QuickTime movies, 281,
1159
Astound, 441
compression, 681 -682
MooVs, 682
Ready,Set,Go, 602
Quit command (File menu),
101
QWERTY (keyboard),
1023-1025

R
radio buttons, 1159
Railroad Tycoon (game),
791-792
RAM (Random-Access
Memory), 1159
32-bit addressing, 1137
Level 2 printe r, 224-225
printing, 230
RAM cache, 1159
RAM disk, 1159
RapMaster (freeware), 806
rasterizer
Adobe Type Manager,
157-158
TrueType fonts, 150
Readme files, 1159
Ready,Set,Go
desktop publishing, 595-603
fo reign languages, 603
master pages, 601
pasteboard, 596-597
QuickTime movies, 602
shortcuts, 602-603

1191

Specifications palette,
599-600
style sheets, 598-599
system requirements,
596-603
text, 601-603
text blocks, 600-601
Typography Palette, 599-600
word processing, 601-603
rebooting, 1159
rebuilding Desktop File,
276
receiving faxes, 837-839
Recent Documents
command (File menu),
137
recorders, digital, 280
recording
AppleScript, 348-354
application scripts, 347
hardwa re, 316-320
music, hard disks, 315-316
music software, 292-293
records, 1159
delimiter, 1144
Filemaker Pro, navigating,
520
recovering
damaged files, 1076-1077
deleted files, 1078
recycling printing
materials, 233-234
Reference software
(CD-ROM), 697-699
Re~'Tession menu command
(Data menu), 505
relational databases,
512-513, 1159
remote Telnet (Internet),
928
remote access, networks,
840-841, 960-961
removable drives
(Powerbooks), 1000
removable media, 1159
removing
labels, 250-251
Launcher (Performa), 98-99
sounds, 283
repairing hard drives,
utilities, 1117-1121
repeati ng fields (FileMakcr
Pro), 515·539
Replace command (Edit
menu), 379
report documents, Impact,
410-411
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reports

reports, FoxPro Mac,
534-535
ResEdit (utility), 270-276,
1160
Reshaping Picture or Text
Boxes (QuarkXPress), 592
resident fonts, 151, 211
resolution, 1160
pixels, 1157
printing, 212-213
resource fork (files),
270-271
resource managers, fonts,
160-167
resources, icons, 272-273
Restart command (Special
menu), 102, 276
restarting, 1131, 1160
restoring programs,
Performa, 97
retrieving files
Finder, 110-112
from trash, 121
Return command (Exit
menu), 919
Return key, 1160
Revert command (Hie
menu), 652
Revision Word 6.0, 375-376
Revision Marks dialog box,
376
RGB Color dialog box, 631
Right and Copy command
(Edit menu), 494
RISC (Reduced Instruction
Set Computer), 30-31,
1160
ROM (read-only memory),
1159
root directory, 1160
Rotunda (America Online),
862
routers (networks), 973-975
Row Height command
(Format menu), 474
Row Height command
(Worksheet menu), 497
RQBE (relational query by
example), FoxPro Mac,
532-533
RTF (Rich-Text Format),
Clipboard, 173-174
ruler bars, WordPerfect,
389-390
Run command (Sessions
menu), 883

running, 1160
session files, CompuServe
Navigator, 883-884
Windows on Macs, 34-35

s
safety and the home office,
1016-1027
SAM (Symantec Anti-Virus
for Macintosh), 1122-1123
sans-serif fonts, 144, 1160
Save As command, 1160
Save As command (File
menu), 92
Save As dialog box, 92
Save Selection command
(Selection menu), 665
saving, 1160
At Ease 2.0 (Perform a),
104-105
documents, Performa, 92-94
NowSave (Now Utilities),
719
scripts, 353-356
scalable fonts, 148
Scale Graphic to Dlock
command (Graphics
menu), 602
Scale to Fit command (Text
menu), 602
scanned images
Adobe Illustrator, 610-6 19
FreeHand, 624
scanners, 1160
optical character
recognition, 1 155
Photoshop, 654
schedules, PIM (Personal
Information
Management), 751-754
Scrapbook, 175-183, 1160
exporting files, 180-185
filters, 180
formats, transferring data,
181-183
importing fi les, 177- 180
Scrapbook (System 7.5), 59
Scrapbook command
(A1>ple menu), 175
Screen Code dialog box,
528
screen dump, 1160
Screen Layout dialog
box,S28

screen savers, 1110, 1161
After Dark, 262-264, 728-729
Eclipse (shareware), 800
ho me office, 1045-1046
ScreenPlay (freeware), 799
screens
dpi (dots per inch), I 145
fonts, 149, 1160
FoxPro Mac custom, 527-539
startup, 11 63
Script Definition dialog
box,S22
scripts, 1161
AppleScript, 11 38
editing, 350
file management, 139-141
Filemaker Pro, 522-523
Finder, 354-356
formatting, 350-352
HyperTalk, 11 50
recording, 347-354
saving, 353-356
System 7.5, 347-354
writing, 352-353
Scripts menu commands,
Define Button, 522
Scroll bars (Finder), 76
scrolling, 1161
SCSI (Small Computer
System Interface), 18,
716-717, 1053, 1161
Powerbooks, 1000-1001
shutting down, 11 10
troubleshooting, 1099
SCSI accelerators, MIDI, 313
SCSI port, 1161
SCSI terminator, 1161
SCSIProbe (utility), 716-717
Sculley, John, 18
Search menu commands,
Selected Items, 135
searching Internet, 925-928
sectors (disks), 1161
security, 1161
Filemakcr Pro, 523
home office, child proofi ng,
1046- 104 7
locking folders (System 7.5),
60
networks
access privi leges, 959-960
passwo rds, 956-958
Powerbooks, I 002
virus protection, 11 21-1123
Selected Items command
(Search menu), 135

slides
selecting, 1161
menu commands, 46-47,
79-8 1
networks connections, 944
Selection menu commands,
Save Selection, 665
selections, PhotoshOJ>,
665-666
sending faxes, 837-839
serial interfaces, 1161
serial ports, 1161
series
1-2-3 worksheets, 494-495
Excel worksheets, -!65-467
Series dialog box, 466
serif fonts, 144, 1161
servers, 1145, 1161
Service Invoice (freeware),
815
session files, CompuServe
Navigator, 880-883
Sessions menu commands,
Run, 883
Set Margins command
(Layout menu), 381
Set Wrap Border command
(Graphics menu), 388
Sets menu cotnmands,
ClarisWorks, 344
Setup command (Database
menu), 526
Shade command (Style menu),
595
shared disks, networks,
952-953
shareware, 796, 1162
Address Book, 8 12
Beatn ik, 808
business, 812-816
CD-ROM, 706
control panels, 799-802
DepthMaster, 800
desktop, 256-262
Devera, 808
DiskDup+, 816-817
Drag. n Back, 8 17-818
Eclipse, 800
Epic Gothic, 809
extensions, 799-802
Flash-It, 800-801
fonts, 157-158, 808-8 11
freeware, 796
games, 803-808
Maelstrom, 805
Notify, 814

Personal Log, 814-816
Photoshop plug-ins, 667
PowerBa r, 798
PowerStrip, 798-799
sounds, 284
SoundStudio Lite, 818
Speedometer, 818-819
Symbionts, 802
System 7 Pack, 799
Tetris Max, 807-808
TimeTracker, 815-816
TNG Mon itors (Star Trek),
811
utilites, 797-799
ZTerm, 8 19
sharing over networks,
946-951
Sharing command (File
menu), 947
sharing data, see
transferring data, 170-171
Sharing dialog box, 947
Shoe Invisibles command
(Preferences), 549
ShopKeeper Plus
(accounting software),
745-746
shopping on CompuServe,
872
shortcuts
America Online, 867-868
CompuServe, 884-885
eWorld, 906-909
FrameMaker, 584-585
icons, 1129
Internet, 932-933
keyboard, 336-340
keyboard options, 1132
mouse, 340-342
QuarkXPress, 594-595
Ready,Set,Go, 602-603
toggle switches, 337
Show Balloons command
(Help menu), 82
Show Clipboard command
(Edit menu), 384
Show command (View
menu), 611
Show Document Layout
command (View menu),
590
Show menu commands, 458
Show Names (Prefe rences
menu), 549
Shut Down command
(Special menu), 1109
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shutdown, 1162
At Ease 2.0 (Performa),
105-106
SCSI (Small Computer
System Interface), 1110
signal-to-noise-ratio (S/ N),
1162
SimCity 2000 (games),
784-788
SIMM (memory), 1162
Simplify command
(Arrange menu), 625
SITcomm
(telecommunications
software), 830-831
Size box (Finder), 76
size boxes, 1162
sizing canvas, PhotoshOJl,
657
Slide Master command
(View merm), 458
Slide Sorter View
Astound, 44 7
Persuasion, 456
PowerPoint, 433-434
slides
Astound, 437-443
Actors, 440-441
adding graphics, 438
adding text, 438
charts, 439-440
clip art, 440
color gradient tool, 442
fil l patterns, 443
libraries, H3
Outline View, 446-447
QuickTime movies, 441
sound, 442
DeltaGraph Pro 3, 419-420
customizi ng, 420-421
Outline View, 422-423
Sorter View, 423-424
Persuasion, 450-454
adding graphics, 452-453
adding text, 452-453
charts, 453-454
clip a rt, 454
customizing, 45 1-452
Outline View, 456
PowerPoint, 427-430
adding graphics, 429-430
adding text, 429
customizing, 428
Notes View, 434
Outline View, 432-433
Slide So rte r View,
433-434
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slots

slots, 1162
Small Computer System
Interface (SCSI}, 1162
smart quotes (fonts), 146
Smart Quotes command
(Preferences menu), 549
Smartcom II
(telecommunications
software}, 831
SmartSum command
(Function menu}, 496
smileys, 917-934
smoke (maintenance}, 1106
sod format (Clipboard},
172
software, 1162
accounting, 744-747
Adobe Illustrator, 608-619
AppleScript, 139-141
backups, 1041-1042, 111 61117
BrushStrokes, 635-641
bundled, 1140
business, 743-747
Ca nvas, 626-635
C D-ROM, 695-707
business, 696-697
educational, 699-701
exercise, 705
games, 703-704
health, 704-705
movies, 701-702
music, 704
Reference, 697-699
sports, 705
children's, 759-770
ClarisWorks, 542-549
commercial, 1142
comm unications,
Powerbooks, 1002-1004
CompuServe, 869
CompuServe Informatio n
Manager, 874-879
CompuServe Navigator,
880-884
Contact Managers, 754
desktop
After Dark, 262-264
ClickChange, 265-266
Now Utilities, 264-265
diagnostics, 1123-1124
drivers, 1146
educational, 760-784
emulatio n, 992
eWorld, 888-891
fin ancial, 734-743, 1036

FrameMaker, 571-583
FreeHa nd, 619-625
freeware, 1148
games, 760, 784-793
hard d rives repairs,
1119-1121
income taxes, 747-748
integrated, 1151
mail order, 1033
Microsoft Works, 554-559
music, 292-293, 298-309
networks, 940-943
Open Document, 39
PageMaker, 562-5 71
PIM (Personal Info rmation
Management), 751-754
Power Macs, 33-34
Powe rbooks, 1001 - 1005
projects, 748-750
public domain, 11 58
Publish and Subscibe, 189
QuickDraw GX, 1159
shareware, 284, 796, 11 62
spreadsheets, 462
1-2-3, 492-508
Excel, 462-492
system, 1164
telecommunications,
828-837
updating, 1110-111 J
utilities, 711
virus protection, 1166
viruses, 729-731
word processing, I 034-1036
WordPerfect Works, 550-554
SoftWindows
multitasking, 34-35
Power Macs, 34-35
Sort command (Data
menu), 486
Sort Order dialog box, 521
Sort records dialog box,
520
Sorter View, DeltaGraph
Pro 3 slides, 423-424
sorting
data, Excel, 486-487
databases, FileMaker Pro,
520-521
sounds, 279-286
adding, 282-283
At Ease 2.0 (Performa), 1OS
Astound, slides, 442
audio notes, attaching, 281
CO-Audio, 689
•
COs, 285-286

customizing, 28 1-285
digital audio, 311 -320
digital recorders, 280
fi le formats, 285
fi les, transferring, 992
handicapped assista nce, 286
Kaboom!, 284-285
microphones, 28 1
MIDI (Musical Instrumen t
Digital Interface), 287-292
multimedia ha rdware, 693
music
copy protection, 297-298
editing, 315-3 16
hardware, 316-320
o nline services, 299
printing, 296-297
software, 292-293,
298-309
musical recordings, hard
disks, 3 15-316
Powerbooks, 10 14
Quadra AV Macs, 285-286
quantization , 295-296
QuickTime movies, 281
removing, 283
shareware, 284
speech synthesis, 286
sound cards, M1DI (Musical
Instrument Digital
Interface), 313
sound files, Now ScraJlbook
(Now Utilities}, 719
SoundStudio Lite (shareware),
818
spacing (French}, 147
spcadsheets (CiarisWorks},
546
Speak All command (File
menu), 333
Speak Selection command
(File menu), 334
Speakable Items folder, 330
special characters, in fonts,
1133
special effects
Painter, 644-645
Premiere (Audition}, 674-676
Special menu commands
Clean Up, 127
Conditional Text, 584
Empty Trash, 120
Go To At Ease Setup, 102
Restart, 102, 276
Shut Down, 1109
User Greeting, 102

System 7.5
Specifications palette
(Ready,Set,Go), 599-600
speech r ecognition, 321-332
Speech Setup control panel,
322-323
speech synthesis, 286
Speedome t e r (shareware),
818-819
sp ell checker
Astound, 447-448
Fram eMaker, 577-578
Impact, 413
Persuasion, 456-457
PowerPoint, 435
WordPerfect, 394
Spelling Checker command
(File merm), 578
Split command (Window
menu), 506
spool files, 203, 205-206
spooler (utility), 1162
spo oling (printers), 1158
sports software (CD-ROM),
705
spreadsheets, 462, 1162
1-2-3, 492-508
Excel, 462-492
formats, transferring data,
18 1-183
Microsoft Works, 556
WordPerfect Works, 552-554
St. Francis (freeware), 810
stacks (HyperCard), 1149,
1162
Standa rd mode (Power
M acs), 34-35
starting
At Ease 2.0 (Performa),
101-102
computer, 1131
programs (Performa), 96
startup
Performa, 98
troubleshooting, 1054-1062,
1072-1074

startup disk s, 1162
Startup Manager (Now
Utilities), 71 9
startup screens, 1163
static electricity, 1021,
1105-1106
s tationery fil es (Finder),
133-134
Status b a r
Excel worksheets, 477-478
WordPerfect, 390-39 1

Status bytes (MIDI), 290
Sta tus window (1-2-3
worksheets), 498
stock market
eWorld, 900-901
Market Analyzer Plus
(software), 743
Stock Market Quotes
(America Online), 859
stop bits (modems), 836
Stop Speaking command
(File menu), 334
storing
files (Finder), 110-112
alias files, 131-133
fo nts (hard drive), 213
Story Editor (PageMaker),
569
strings, 1163
stroking objects (Adobe
Illustrator), 611-613
sty! fo rmat (Clipboard), 172
style bar (Impact), 404-405
Style commands (Format
menu), 379
Style menu comma nds
Bold, 349
Shade, 595
style sheets, 1163
MacWrite Pro, 363-364
PageMaker, 565-566
QuarkXPress, 588
Ready,Set,Go, 598-599
sty les, 1163
fo rmatting (Excel), 482-483
paragraphs (FrameMaker),
575-577
Styles command (Format
menu),482
StyleWriter (Apple), 1163
prin ting, 218
Subscribe command (Edit
menu), 193
Subscriber Options dialog
box, 193
subs cribing (Publish and
Subscribe), 193-198
Subtota l command (Data
menu),487
Subtota l dialog box , 487
Suitcase (utility), 161-165,
712-713
Suitcase command (Apple
menu), 712
suitcases, 1163
summary fields (FileMa ker
Pro), 515
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Super Boomer ang (Now
Utilities), 719
home office, 1038-1040
SuperClock! (System 7.5),
60, 255, 717
Sup erDrive, 1163
surge suppressors, 1163
switching p r o gra ms
At Ease 2,0 (Performa), 107
Performa, 95
SYLK (Symbolic Link), 1163
Symantec AntiVirus, 730
Symbionts (s h areware), 802
synthesizers, M IDI (Musical
Instrument Digital
Interface), 314-315
sysops (BBS syste m
O)Jerators), 841
Sys tem 6, 1163
Font/ DA Mover (utility),
11 48
prin ting, 204
trash, 121
System 7, 1163
Disk Tools, 1053-1 054
exten sions, 114 7
freezing, 1070
Label menu, 128
Macintosh Guide, 83
printing, 204
Publish and Subscribe,
184-198
sound file format, 285
trash, 121
System 7 Pa ck (sh a reware),
799
System 7 Pro, networks,
975-976
System 7.1
Balloon Help, 82
files, 134-136
System 7.5, 56-64
accessing applications,
137-138
Apple menu, 133
AppleScript, 139-141
Balloon Help, 8 1-85
CD-ROM, 66
documents
accessing, 13 7-138
default folder, 118
files, 134-136
install ing, 64-66
Launcher (Finder), 139
locking folders, 60
menus/submenus, 137
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System 7.5

networks, printers, 972
performance, 62-66
Scriptable Finder, 354-356
scripts, 347-354
SuperCiockl, 255
system software, 1096
transferring data, 201-202
WindowShade, 123
system bombs,
trouble-shooting, 10641065

System File, Chooser, 1141
system files, 1163
System Folder, 1108-1109,
1163

system heap (memory),
1163

System Messages, MIDI,
291-292

system requirements
1-2-3, 492
Astound, 437
Audition, 670
ClarisWorks, 542
DeltaGraph Pro 3, 415
Excel, 462-463
FileMaker Pro, 5 B
FoxPro Mac, 525
FrameMaker, 572
Impact, 403-404
MacWrite Pro, 360
Microsoft Works, 554
multimedia, 692-695
networks, 940-943
Nisus Wri ter, 380
PageMaker, 562-563
Persuasion, 450
Photoshop, 651-653
PowerPoint, 427
QuarkXPress, 585-588
Ready,Set,Go, 596-603
WordPerfect, 389
WordPerfect Works, 550
system software, 1164
cleaning, 1091
installing, 1094-1097
rei nstalling, 1091-1099
troubleshooting, 1090-1099
System Tools disk, 1164

T
tab-deliJnited file, 1164
Table menu commands
Insert Table, 580
New, 393

Table Designer, 581
Table of Contents
FrameMaker, 583-584
PageMaker, 569-570
Table structure dialog box,
525

tables
AutoFormat (Excel), 483-493
FoxPro Mac, 525-.539
FrameMaker, 580-582
MacWrite Pro, 365-366
Word 6.0, 375
WordPerfect, 393-394
TCP /IP (Transmission
Control Protocol/ Internet
Protocol), 1164
Internet, 913
MacTCP, 1152
tear-off menus, 1164
13rushStrokes, 635-638
Ca nvas, 630
TechTool (utility), 717-718
telecommunications, 1164
telecommunications
software, 828-837
baud rate, 835
installing, 834-837
telephones
cellular, 1012
cords, 1001
digital phone switch,
modems (Powerbooks),
1001
televisions, Powerbooks
interface, 1002
large screen, 1013
Telnet (Internet), 928
temperature, computer
care/maintenance,
1016-1017, 1107

templates, 1164
application, 1138
DeltaGraph Pro 3, 419-420
PageMaker, 570-.575
Persuasion, 450-454
PowerPoint, 427-428
Tengwar-Gandalf
(freeware), 811
terminal emulation, 1164
test format, ASCII, 1138
testing FoxPro Mac custom
screens, 531
Tetris Max (shareware),
807-808

text
Adobe Illustrator, 614-616
BrushStrokes, 638-639

Canvas, 633-634
formats, 181-183
formatting
1-2-3, 499-501
Excel, 480
FreeHand, 623
MacWrite Pro palettes, 363
Nisus Writer, 384
Now Scrapbook (Now
Utilities), 719
PageMaker, 569
QuarlolXPress, 592
Ready,Set,Go, 601-603
slides
Astound, 438
PowerPoint, 429
word wrap, 1167
text blocks, Ready,Set,Go,
600-601

Text Box command (Tools
menu), 393
Text command (Defilte
menu), 344
text files, 989-990, 1164
TEXT format (Clipboard),
172
Text formal command
(Edit menu), 457
Text menu commands,
Scale to Fit, 602
text tools, DeltaGraph Pro
3 , 421-422

Text Translation command
(Translation menu), 990
theft, 1022
thesaurus
FrameMaker, 577-578
MacWrite Pro, 366
Nisus Writer, 385
WordPerfect, 394-395
Thesaurus command (Edit
menu), 577
third-party developers, 37
Threads Manager (System
7.5), 63

TIFF (Tagged Image File
Format), 15, 1164
time, PIM (Personal
Information
Management), 751-754
time and date, SuperCiock
(System 7.5), 60
Time magazine (America
Online), 858
time zones (Date and Time
Control Panels), 254

Type 1 Font Enabler
Timeline (Astou nd ),
445-446
T imes Two (compression
utilities), 728
T imeslips Ill (accounting
softw are), 745
TimeTr a c kcr (sharewar e),
81 5-816
t itle bar, 1164
Title bar (Fin der ), 76
TNG Monitors (Star Trek)
(shareware), 8 11
toggle sw i tches, 337
Tok en Ring net w orks, 94 2,
1164
tolerance setting, s peech
recognition, 327
toner (printe rs), 11 64
Toner Tuner (u tility), 71 5
Tool Bar, Rcady,Set,Go,
59 7-598
Tool Boxes, 1165
T ool Palette, Qu a rkXP ress,
587-588
too lbars
Excel worksheets, 474-477
Impact, 405-406
Word 6.0, 371-372
T oolba r s command (View
m enu), 4 77
Toolbox (PagcMa ker),
564-565
too lboxes
Painter, 644
Photoshop, 657-663
TooiP icker d ialog box, 633
too ls
Adobe Il lustrator
drawing, 608-610
transformation, 616
Astound, 442-443
BrushStrokcs, 635-638
Can vas, 626-630
DeltaG raph Pro 3, 421-422
drawing
Word 6.0, 376
WordPerfect, 391
editing icons, 273-276
Eraser, 275
Excel, 488-489
FreeHand, 620-623
graph ing, 430-432
Impact, 406-407
Painter, 64 1-644
Persuasion, 452-453
screens, 53 1

Tools menu commands
Options, 467
TextBox,393
tools p alette, MacWrite
Pro, 364-365
T ouchbase Pro (Contact
Man a ger software), 754
towers (CD-ROM drives),
694-695
t r ackballs, 1025-1027, 1165
trackpa d (Midas),
P owerbooks, 99 7-998
tra cks (disks), 1165
tractor-feed printer, 1165
tran sferring
data, 171-183
OLE (Linking and
Embedding), 198-201
Publish and Subscribe,
184-1 98, 11 59
System 7.5, 201 -202
files, 977-98 1
ASCII , 987
networks, 981
sound, 992
fonts, 991
forma ts, 990-99 1
graphics, 991
text files, 989-990
utili ties, 980
Publish a nd Subscribe,
Edition files, 185
Transform menu, 275-276
tra nsformation tools,
Adobe Illustrato r, 6 16
Tran sition Effect dialog
box,424
t ransit ions
Astound, 444-445
Persuasion, 455-456
t r a nslating files, 981-985
Scrapbook, 178-1 79
utilities, 983-985
T r a n slation menu
conunands, Te xt
T r a nslation, 990
trash files
retrieving, 121
Trash can/ ico n (Finder), 75,
119-121, 1165
travel, CompuServe, 872873
Travel & ShOJlping
(America Online), 860-861
T reasure MathStorm
(ed u cationa l software),
782
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triangles, viewing folders,
126-127
troubleshooting
applications, 1062-1064,
1068-1069
date, 1071
disks, 1065-1066
extensions, 1088-1090
fi les, 1066, 106 7-1068
floppy disks, 1078-1083
ejection, 1078-1079
in itialization, 1079-1080
unreadable, 1081 -1082
verifyi ng, 1080-1081
folders, 1065-1066
fo nts, 1067-107 1
hard drives, 1072-1078
disk will not open,
1074-1078
duplicate ico ns, 1074
freezing, 1074-10 75
start up, 1072-1074
hardware, 1100-1101
networks, 969-970
printing
jagged, 1083-1088
memory, 1087-1088
monitor crashes,
1086-1087
PostScript errors,
1084-1086
Publish and Subscribe,
197-198
SCSI (Small Computer
System Interface), 1099
start up, 1054-1062
ch imes, 1057-1058
d isk icon blinki ng "?,"
1054-1055
disk icon nonbli nking
"?," 1055
di sk icon "X," 1055-1056
freezing after extension
loads, 1060-1061
freez ing after Happy Mac
icon, 1058-1059
freezing at desktop,
1061-1062
Sad Mac icon, 1056-1062
System 7, 1070
system bombs, 1064-1065
system software, 1090-1099
views, 1069-1070
TrucType fonts, 150
TTS (text-to-speech),
333-334
Type 1 Font Enabler,
QuickDraw GX, 232
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Type 3 PostScript fonts

Type 3 PostScript fonts, 149
Type menu commands
Bind to Path, 623
Create Outlines, 615
Flow Inside Path, 623
type size, 1165
Type Specifications dialog
box,633
type styles (foots), 153
Typel PostScript fonts, 149
tYJJiug, 1023-1025
Typography Palette
(Ready,Set,Go), 599-600

u
Undo command
File me nu, 374
Nisus Writer, 384
Word 6.0, 374
Uninterruptable Power
Supply (UPS), 1021
Universal Enabler (System
7.5), 62
UNIX, 1137, 1165
updating software,
1110-1111
upgrading
expansion slot, 1147
Power Macs, 35-37
Premiere (Audition), 678-680
uploading files (BBS),
842-848, 1165
UPS (uninterrupta ble
power sources), 1105
Usenet Newsgroups
(Internet), 928, 1165
User Greeting command
(Special menu), 102
user groups, 1152
user assistance, At Ease 2.0
(Performa), 102-105
utilities, 711-724
After Da rk (screen saver),
262-264
ATM (Adobe Type Manager),
713-715
backups, 1115-1117
compression
AutoDoubler, 727-728
Disk Doubler, 727
Times Two, 728
DART (Data Archive/
Retrieval Tool), 723-724
diagnostics, 1123-1124

Disi nfectant, 731
Disk First Aid, 722
file management, 720
files
transferring, 980
translating, 983-985
Fkey, 1147
Fon t/DA Mover, 1148
graphics, 724-726
hard drive repair, 111 7-1121
home office, 1038-1040
INIT, 1150
MacErrors, 718-719
MacTools, 721-722
Mr. File, 722-723
Norton Utilities, 720-721
Now Utilities, 264-265,
719-720
PopChar, 715-716
Pri ntMon itor, 205-206
ResEdit, 1160
screen savers, 728-729, 1161
SCSIProbe, 716-717
shareware, 797-799
spooler, 1162
Suitcase, 712-713
SuperCiock!, 717
Symantec AntiVirus, 730
TechTool, 717-71 8
utilities disk, 1165

v
V.34 modems, 826
vector based programs,
607-608
verifying floppy disks,
1080-1081
Vertical command (View
menu), 89
Vertical Justification
(QuarkXPress), 592
video
CD-ROM, 690-693
Pla inTalk, 321-322
Power Macs, 31-33
speech recognition, 322-332
lTS (text-to-speech),
333-334
video cards, 1165
video controller circuit,
1166
Video RAM, 1166

View menu commands
Hide Docu ment Layout, 590
Hide Template, 610
Show, 611
Show Document Layout, 590
Slide Master, 458
Toolbars, 477
Vertical, 89
viewing
BrushStrokes, 638-641
Canvas, 63 1
files, 122-128
folders, 122-128
FreeHand, 621
icons, 123-125
list views, 123-1 25
PowerPoint, 434
troubleshooting, 1069-1070
Views (Control Panels),
248-250
virtual memory, 1166
viruses, 1166
Disinfectant (freeware), 816
home office, 104 1
protection, 729-731,
1121-1123
protection software, 1166
SAM (Symantcc Anti-Virus
for Macin tosh), 1122-1123
utilities
Disi nfectant, 731
Symantec AntiVirus, 730
Visa card (Quicken), 738
Vision Contents (XTension),
593
visual interface, 1166
VisuaiClips (graphics
utilities), 724-725
voice commands
ignoring, 329-330
speech recognition, 330-332
Voices & Views (eWorld),
902
Voices command (File
menu), 333
volatile memory, 1166

w
W AIS (Wide Area
Information Service),
928, 1166
warm boot, 1166
warranty (Apple), 1058

Zterm (telecommunications software)
Wealth Builder (financial
software), 742-743
Where in the World Is
Carmen Sandicgo?,
778-780
White Knight
(telecommunications
software), 8 32
Whiter command (Object
menu), 449
WiiJMaker (financial
software), 742
Window menu commands,
Split, 506
windows, 49-50, 1166
active, 1137
Directory, 11 45
Finder, 76-77
introduction, 14-27
navigating, 11 30
Power Macs, 34-38
WindowShade, System 7.5,
58, 123
wireless modems, 826,
1011-1012
Word 6.0, 370-379
AutoCorrect, 374
AutoFormat, 37 1
columns, 373
documents, 372-373
drawing tools, 376
drop caps, 376-377
fo nts, 373-374
multiple undos, 374
Revision, 375-376
tables, 375
toolbars, 37 1-372
wizards, 370
word processing, 1166
home office, 1034-1036
Impact, 410-4 11
MacWrite Pro, 360-370
Nisus Writer, 379-388
PageMaker, 569
QuarkXPress, 592
Ready,Set,Go, 601 -603
Word 6, 370-379
WordPerfect, 388-398
word wrap, 1167
WordPerfect, 388-398
bulleted lists, 395
Button Bar, 39 1
drawing tools, 39 1
Find/Change, 395
paragraph styles, 392

ruler bars, 389-390
spell checker, 394
status bar, 390-391
system requirements, 389
Thesaurus, 394-395
WordPerfect Works,
550-554
charts, 552-554
com munications, 553-554
databases, 553
docum ents, 551
spreadsheets, 552-554
system requirements, 550
work habits, 1107-1111
backing up files, 1108,
111 5-111 7
deleting applications/
documents, 1108
moving components with
power on, 1109
saving, 1107
shut down, 1109-111 0
srcen savers, 111 0
System Folder, 1108-11 09
Worksheet menu
commands, 497-498, 507
worksheets
I -2-3, 493-498
Excel, 463-478
WORM (Write Once Read
Many), 285-286
wristwatch cursor, 1167
write-protect tab, 1167
writing scripts, 352-3 5 3
WYSIWYG (What You Sec
Is What You Get), 15, 1167
WYSIWYG Menus (Now
Utilities), 719

X-Z
x-rays (Powcrbooks), 1002
XMODEM (file transfer
JlrOtocol), 844
XTcnsions (QuarkXPress)
Kitchen Sink, 593-594
Visio n Con tents, 593
YMODEM (file transfer
protocol), 844

Ze11 aud tire A rt of tire
I11ternet, 922
ZMODEM (file transfe r
1notocol), 844
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zones (networks), 944-945,
116 7
Zoom box (Finder), 76
zoom boxes, 1167
ZTcrm (sh a rewar e), 819
Ztcrm (telecommunications software), 833-834

